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MAXON Computer License Agreement for
CINEMA 4D / CINEMA 4D XL / CINEMA 4D NET

NOTICE TO USER

WITH THE INSTALLATION OF CINEMA 4D, CINEMA 4D XL or CINEMA 4D NET A CONTRACT IS
CONCLUDED BETWEEN YOU AND MAXON COMPUTER GMBH, IN THE FOLLOWING CALLED
THE “LICENSOR”, A COMPANY UNDER GERMAN LAW WITH RESIDENCE IN FRIEDRICHSDORF,
GERMANY. “YOU“ AND THE “USER“ REFERS TO THE LICENSEE.

WHEREAS BY INDICATING YOUR ACCEPTANCE BELOW, YOU ACCEPT ALL THE TERMS AND
CONDITIONS OF THIS AGREEMENT. IN THE CASE OF NON-ACCEPTANCE OF THIS LICENSE YOU
ARE NOT PERMITTED TO INSTALL THE SOFTWARE.

IF YOU DO NOT ACCEPT THIS LICENSE PLEASE SEND THE SOFTWARE TOGETHER WITH THE
DOCUMENTATION TO MAXON COMPUTER OR TO THE SUPPLIER WHERE YOU BOUGHT THE
SOFTWARE.

1. General

Under this contract the licensor grants to you a non-exclusive license to use CINEMA 4D,
CINEMA 4D XL and CINEMA 4D NET, which is software and documentation, in the following called
the ”software“. The software itself as well as the copy of the software or any other copy you are
authorized to make under this contract remain the property of the licensor.

2. Use of the Software

(1) The user of this license is authorized to copy the software as far as the copy is necessary to use
the software. Necessary copies are the installation of the program from the original disk to the mass
storage medium of your hardware as well as the loading of the program into RAM.

(2) Furthermore the user is entitled to make a backup copy. However only one backup copy may be
made and kept in store. This backup copy must be identified as a backup copy of the licensed
software. (3) Further copies ARE NOT ALLOWED; this also covers the making of a hard copy of the
program code on a printer as well as copies, in any form, of the documentation.

3. Multiple use and network operation

(1) The user may use the software on any single hardware platform, Macintosh or Windows,
available to him and must decide on a platform (Macintosh or Windows operating system).
However, should the user change the hardware he is obliged to delete the software from the mass
storage medium of the hardware used up to then. A simultaneous installation or use on more than
one hardware IS NOT ALLOWED.



(2) The use of the licensed software for network operation or other client server systems is
prohibited if this opens the possibility of simultaneous multiple use of the software. In the case that
the user intends to use the software in network operation or other client server system he has to
take care that a multiple use is not possible by employing the necessary access security or otherwise
the user has to pay to the licensor a special network license fee, the amount of which is determined
by the number of users admitted to the network.

(3) The license fee for networks will be communicated to the licensee by the licensor immediately
after the user has indicated the number of admitted users in writing. The correct address of the
licensor is given in the manual and also at the end of this contract. The network use may start only
after the pertaining license fee is completely paid.

4. Transfer

(1) You may not rent, lease, sublicense or lend the software or documentation. You may, however,
transfer all your rights to use the software to another person or legal entity provided that you
transfer this agreement, the software, including all copies, updates or prior versions as well as all
copies of the font software converted to other formats and all documentation to such person or
entity and that you retain no copies, including copies stored on a computer and that the other
person agrees that the terms of this agreement remain valid and that his acceptance is
communicated to the licensor.

(2) The user is obliged to carefully store the terms of the agreement. Prior to the transfer of the
software the user has to inform the new user of these terms. In case the user does not have the
terms at hand at the time of the transfer of the software, he is obliged to request a second copy
from the licensor, the cost of which is born by the licensee.

(3) In case of transfer the license of the former user expires.

5. Recompilation and changes of the software

(1) The recompilation of the provided program code in other code forms as well as all other types of
reverse engineering of the different phases of software production including any alterations of the
software are not allowed.

(2) The removal of the security against copy or similar safety systems is only permitted if a faultless
performance of the software is impaired or hindered by such security. The burden of proof for the
fact that the performance of the program is impaired or hindered by the security device rests with
the user.

(3) Copyright notices, serial numbers or other identifications of the software may not be removed or
changed. The software is owned by the licensor and its structure, organization and code are the
valuable trade secrets of the licensor. It is also protected by United States Copyright and
International Treaty provisions. Except as stated above, this agreement does not grant you any
intellectual property rights on the software.



6. Limited warranty

(1) The parties hereto agree, that at present it is not possible to develop and produce software in
such a way that it is fit for any conditions of use without problems. The licensor warrants that the
software will perform substantially in accordance with the documentation. The licensor does not
warrant that the software and the documentation comply with certain requirements and purposes of
the user or works together with other software used by the licensee. The user is obliged to check the
software and the documentation carefully immediately upon receipt and has to inform the licensor in
writing of apparent defects 14 days after receipt. Latent defects have to be communicated in the
same manner immediately after their discovery. Otherwise the software and documentation are
considered to be faultless. The defects, in particular the symptoms that occurred, are to be described
in detail in as much as the user is able to do so. The warranty is granted for a period of 6 months
from delivery of the software (for the date of which the date of the purchase according to the
invoice is decisive, respectively in case of shipment by the licensor the date of the invoice). The
licensor is free to cure the defects by free repair or provision of a faultless update.

(2) The licensor and its suppliers do not and cannot warrant the performance and the results you
may obtain by using the software or documentation. The foregoing states the sole and exclusive
remedies for the licensor’s or its suppliers’ breach of warranty, except for the foregoing limited
warranty. The licensor and its suppliers make no warranties, express or implied, as to
noninfringement of third party rights, merchantability, or fitness for any particular purpose. In no
event will the licensor or its suppliers be liable for any consequential, incidental or special damages,
including any lost profits or lost savings, even if a representative of licensor has been advised of the
possibility of such damages or for any claim by any third party.

(3) Some states or jurisdictions do not allow the exclusion or limitation of incidental, consequential or
special damages, or the exclusion of implied warranties or limitations on how long an implied
warranty may last, so the above limitations may not apply to you. In this case a special limited
warranty is attached as exhibit to this agreement, which becomes part of this agreement. To the
extent permissible, any implied warranties are limited to 6 months. This warranty gives you specific
legal rights. You may have other rights which vary from state to state or jurisdiction to jurisdiction. In
the case that no special warranty is attached to your contract please contact the licensor for further
warranty information.

7. Damage in transit

The user is obliged to immediately inform the transport agent in writing of any eventual damages in
transit and has to provide the licensor with a copy of said correspondence, since all transportation is
insured by the licensor if shipment was procured by him.

8. Secrecy

The user is obliged to take careful measures to protect the programs and their documentation, in
particular the serial number, from access by third parties. The user is not permitted to duplicate or
pass on the programs or documentation. These obligations apply equally to the user’s employees or



other persons engaged by the user to operate the programs. The user will pass on these obligations
to such persons. The user is liable for damages in all instances where these obligations have not been
met. These obligations apply equally to the user's employees or other persons he entrusts to use the
software. The user will pass on these obligations to such persons. The user is liable to pay the
licensor all damages arising from failure to abide by these terms.

9. Information

In case of transfer of the software the user is obliged to inform the licensor of the name and full
address of the transferee in writing. The address of the licensor is stated in the manual and at the
end of this contract.

10. Data Protection

For the purpose of customer registration and control of proper use of the programs licensor will store
personal data of the users in accordance with the German law on Data Protection
(Bundesdatenschutzgesetz). This data may only be used for the above-mentioned purposes and will
not be accessible to third parties. Upon request of the user the licensor will at any time inform the
user of the data stored with regard to him.

11. Other

(1) This contract includes all rights and obligations of the parties. There are no other agreements.
Any changes or alterations of this agreement have to be performed in writing with reference to this
agreement and have to be signed by both contracting parties. This also applies to the agreement on
abolition of the written form.

(2) This agreement is governed by German law. Place of jurisdiction is the competent court in
Frankfurt am Main. This agreement will not be governed by the United Nations Convention on
Contracts for the International Sale of Goods, the application of which is expressly excluded.

(3) If any part of this agreement is found void and unenforceable, it will not affect the validity of the
balance of the agreement which shall remain valid and enforceable according to its terms.

12. Termination

This agreement shall automatically terminate upon failure by you to comply with its terms despite
being given an additional period to do so. In case of termination due to the aforementioned reason,
user is obliged to return the program and all documentation to licensor. Furthermore, upon request
of licensor user has to submit written declaration that he is not in possession of any copy of the
program on data storage devices or on the computer itself.



13. Information and Notices

Should you have any questions concerning this agreement or if you desire to contact MAXON
COMPUTER for any reason and for all notifications to be performed under this agreement, please
write to:

MAXON Computer GmbH
Max-Planck-Str. 20
D-61381
Friedrichsdorf
Germany

or for North and South America to:

MAXON Computer Inc.
2640 Lavery Court, Suite A
Newbury Park, CA 91320
USA

We also shall be glad to provide you with the address of your nearest supplier.
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Preface
CINEMA 4D will win many more awards, because
we will keep CINEMA 4D at the forefront of
professional 3D graphics.

Much has changed since CINEMA 4D took its
first nervous steps in 1989. Back then, many
CINEMA 4D users were ambitious computer
freaks making animations at home. Today, the
software is used mainly by professionals (almost
exclusively so with the XL edition). Serving the
professional community brings with it a high
level of responsibility. We want to put at your
fingertips the tools that best help your work.

Stability is one of two things the 3D professional
artist cannot do without. Speed is the other. If
you are to feel comfortable about taking on
important jobs with tight deadlines, you need
tools that you can rely on one hundred percent.

Of course, other things are important too.
CINEMA 4D’s new radiosity and caustics help
you create the most natural lighting for your
scenes. Render quality has improved as well.

We could continue to list all the new features
but the place for that is the start of the manual
proper; here we would like to leave you with a
few tips.

Do yourself a big favor and read this reference
manual from cover to cover at the earliest
opportunity — don’t take your lead from those
who tell you they never read a manual.

Even though CINEMA 4D is exceptionally easy
to use, the sheer number of functions and
flexibility of the package means that you cannot
hope to figure out what all the buttons do
simply by pressing them. In this reference

Congratulations on purchasing CINEMA 4D XL
Release 7! We have made every effort to
provide you with as many new and useful
features as possible. We wish you every success
with the program — but before you go, we’d
like to share with you our product philosophy.

Computer graphics go hand in hand with
passion. Almost everyone working in this
profession sees their job not only as a way to
earn a living, but also as a way to enjoy working
life — the fun factor is at least as important as
the money. So that you can continue having fun
and making money at the same time, we’ve
been developing CINEMA 4D over the last 12
years with more passion than the Tifosi on
raceday.

Along the way, nothing has been more
important to us than listening to our customers.

After all, the success of the program depends on
your feedback. Once more, with Release 7, a great
many of your ideas and suggestions have been
implemented; we have tried to be your graphics
genie. Of course, we always need to hear your
wishes and so, to rub our magic lamp, please fill in
the suggestion form on our website:
www.maxon.net. It is only by telling us your needs
that CINEMA 4D can remain your program. We
can’t promise everyone three wishes, but we do
promise to keep your requests and suggestions at
the heart of our development strategy.

There is no doubt that listening to you works. Your
comments and suggestions have helped
CINEMA 4D to win award after award and best-
of-test after best-of-test. We know that
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manual you will find a detailed description of
the program functions. In places, helpful tips
and advice are included.

The only thing we couldn’t include with your
order for CINEMA 4D is ideas. But even here,
there is help. For some time now, a thriving
international community of CINEMA 4D users
has taken to the Internet. In discussion forums,
questions that go beyond technical support are
answered by other users quickly and clearly. In
the case of a problem, more often than not
you’ll receive several different solutions.

Galleries, tips, tricks, online tutorials, chat,
resource libraries and plenty more besides await
you on the Internet — check our homepage
(www.maxon.net) for some of the hottest links.

Last, but by no means least, the Internet is also
home to Plugin Cafe (www.plugincafe.com).
Here, you’ll find a host of plug-ins and
developer information.

Enough of this preface. We hope you enjoy
using CINEMA 4D. Now it’s time to work!

Best Wishes,

Team MAXON.
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1 Getting to Know CINEMA 4D
It also includes several 2D shading engines, more
than 25 different types in the noise shader alone,
with control over contrast, brightness, clipping,
procedural patterns such as tiles, hexagons, and
more. You can even mix, layer and filter shaders to
combine images, shaders or manipulate them with
other shaders and images!

Over 1000 presets are included to immediately
drop on and render.

Smells Like Almonds has built-in online help.

New Render Engine
The new render engine uses a sophisticated
adaptive oversampling which produces brilliant still
images and removes any kind of flickering in
animation. Almost too good to be true, rendering
has become even faster while maintaining, and
sometimes exceeding, the same quality level.

See 'Rendering' on page 399.

Caustics
Have you noticed those beautiful effects which
arise when light is reflected from glass, metal and
other shiny surfaces? With CINEMA 4D Release 7,
you can make these effects appear based on
standard materials. Activate Caustics for one or
more light sources and you will immediately see
the light cast onto object surfaces or, using Volume
Caustics, even within fog, smoke, water etc.

Best of all, CINEMA 4D’s rendering speed will
not make you lose your patience — optimum
rendering performance comes with all
CINEMA 4D products.

See 'OK, So What Exactly are Caustics?' on
page 422,

What’s New in 7
CINEMA 4D Release 7 marks a major step forward
in rendering flexibility, speed and quality, while
also including a host of valuable extras. Here is a
brief rundown of the new features together with
where to look in this manual for more detail.

Radiosity / Global Illumination
This advanced lighting technology simulates the
natural distribution of light such as color-bleed
between adjacent surfaces.

Regions that would normally receive no light
when raytraced are lit indirectly with global
illumination, leading to new levels of realism
through radiosity.

Although this is usually extremely processor-
intensive, CINEMA 4D XL 7 has reduced render
times dramatically to produce what is probably
the world’s fastest radiosity engine.

See 'OK, So What Exactly is Radiosity?' on page
417 and 'Illumination' on page 518.

Smells Like Almonds 2.5
The powerful Smells Like Almonds is included
with Release 7, representing a significant
enhancement to CINEMA 4D’s material system.

Smells Like Almonds includes six powerful 3D
shading engines that enable you to create
complex and realistic surface effects such as
multi-layer specularity, anisotropic metals,
volume rendered woods and stones, rusted and
blistered surfaces, even translucent backlighting.
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Multi-Pass Rendering
The new render engine enables you to render in
passes (i.e. layers). For example, you can render
illumination, specularity and transparency as
separate layers for post-editing.

CINEMA 4D XL Release 7 conveniently saves all
the layers during a single render pass as a single
file in one of the following formats: PSD, RLA,
RPF. Later on you may adjust the look of the
rendering in order to adapt it to existing real
film footage.

See 'Multi-Pass' on page 433.

Polygon Reduction
With the new PolyReduction deformer it is now
a straightforward matter to simplify your models
by reducing their polygon count to a user-
defined level.

This is great for games, web work or any task
where the speed of display is of the essence. Or
use it just for fun!

See 'Polygon Reduction' on page 268.

ExplosionFX
This new modifier is used to create realistic
explosion effects, quickly and easily. You can
explode or implode an object’s polygons with
full control over the speed, direction, range, size
of cluster, rotation and other parameters,
including gravity.

See 'ExplosionFX' on page 259.

CINEMA 4D NET 3CL
Included with CINEMA 4D Release 7 is the 3-
client version of CINEMA 4D NET, the easy-to-
use network rendering package. This allows you
to distribute the rendering of animations over a
TCP/IP network, administered with simple pages
via your favorite web browser.

See the CINEMA 4D NET manual included with
your XL 7 package.

Plus ...
In addition there have been a multitude of
improvements to the interface and workflow of
CINEMA 4D.
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Starting
To start CINEMA 4D, do one of the following:

- Double-click on the program icon.

- Double-click on a scene file.

- Use the Start menu (Windows).

Alternatively, drag-and-drop one or more
CINEMA 4D files from Explorer (Windows) or
Finder (Macintosh) on to the CINEMA 4D
application icon or directly into the program.

Template.c4d

If the CINEMA 4D root folder contains a scene
named ‘Template.c4d’, this is loaded during
startup and all the settings defined there
become effective.

Quitting
File > Quit quits the program. If any unsaved
changes are detected, a dialog asks you if you
wish to save these before quitting.

Clicking on Cancel in this dialog returns you to
the program.

Note

To save the layout automatically each time you
quit the program, enable Save Layout at
Program End  on the General tab of the General
Settings.

Mouse Techniques
CINEMA 4D gives you these extra mouse
features:

- You can simulate the right mouse button on
the Macintosh with the Command key held
down. Alternatively, use a two-button mouse
with the appropriate driver.

- If you want to drag an object onto a window
displayed as a tab but the window is
concealed, drag and hold the object over the
window’s tab. After a short delay, the window
will be activated and you can drop the object
on the target.

- If you are using a wheel mouse, you can use
the wheel to scroll sliders (such as a material’s
color and brightness sliders or the time slider).
You can also use the wheel to increment/
decrement numbers in numerical text boxes.

Hotkeys 1 to 7
To use a hotkey, hold down the key and drag
the mouse. Your default hotkeys for the view
panel are:

1 move camera

2 scale camera

3 rotate camera

4 move object

5 scale object

6 rotate object

7 scale model



8 • GETTING TO KNOW CINEMA 4D • CHAPTER 1

The GUI
The CINEMA 4D GUI has many features that
you won't find in the Windows/Macintosh GUI:

- You can dock all windows into the main
window.

- When you move a docked window, the
surrounding windows adapt to avoid empty
spaces and overlaps.

- You can display windows as tabs to conserve
display space.

Command groups Tabs

Input
boxes

Menu bar in a window

Command
palettes

Material
manager

Object
manager

Viewport

Coordinate
manager

View panel

CINEMA 4D’s GUI is freely configurable. You
can create your own icon palettes (including
folded icons) and you can even edit the menus.

You can define various layouts and switch
between them at will. For example, you may
find it helpful to create a layout for modeling
and a layout for animation since these tasks use
different managers.

A further powerful feature is that plug-ins can
be integrated into the GUI and make use of its
features.

Time
palette
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Example modeling layout

Example texturing layout

Example animation layout

A Quick Tour
This section guides you through the GUI as it
appears when you first start CINEMA 4D.

Managers

Managers are the main program elements in
CINEMA 4D. Each manager has its own window
and runs alongside the other managers. This
means that each manager can operate
independently, so that it is multithreaded. This
makes it possible — among other things — to
render an animation in the Picture manager
while you work in the view panel.

Although the managers operate independently,
each manager reacts immediately to relevant
changes you make in other managers. For
example, if you move an object in the view
panel, the object’s position values in the
Coordinate manager will update automatically.
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Windows

Each manager has its own window. You can
place windows freely or dock them into
CINEMA 4D’s main window.

In the default layout, most managers are
docked. If you change the size of a docked
window, the surrounding windows adjust
automatically to avoid an overlap or gap.

To undock a window, click on its pin icon and
select Undock. To re-dock the window, drag-
and-drop its pin icon onto the main window. A
black line will indicate the insertion position.

To change a window’s size, first move the
mouse pointer to its border; the pointer will
change into a double arrow to indicate the
direction (either vertical or horizontal) in which
you can drag the border. Drag the window as
required. The other windows in the group will
adapt to the change.

Menu Bars

Each manager has its own menu bar.

Menu bars have the following features:

- Submenus.

- Commands that cannot be selected are ghosted.

- Enabled options are indicated with a checkmark.

- All shortcuts, including any you have defined
yourself, are shown to the right of the menu
option.

If there is not enough space to show the
complete menu bar, a black triangle is shown. To
show the remaining menu entries, click on the
triangle.

Command Palettes

The default layout has two command palettes
(aka icon palettes) containing the most popular
commands as icons.

Some of the icons have a small black triangle,
indicating a folded group of commands. To
show the group of commands, click and hold
the left mouse button. Note that the icon shown
before unfolding the group is the most recently
used command. For more information on
command palettes, see page 35.

Tabs

You can display windows and command palettes
as tabs. For example, the Object manager,
Structure manager and Browser are displayed as
tabs in the default layout. This saves display
space and helps you to reach a manager or
command palette quickly.
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If there is not enough display space to show all
the tabs, one of the tabs will be torn. You can
scroll the tabs by clicking the small arrow icons
in the top right of the window.

For more information on tabs see page 34.

For details on a particular manager, please refer
to the chapter for that manager.

Context Menus

To open a context menu, click the right mouse
button (or Ctrl-click for the Macintosh).

Input Boxes

Input boxes with two arrows (one pointing up,
the other pointing down) offer the following
features:

- Click an arrow to increment or decrement the
value by one.

- Drag an arrow to increase or decrease the
value rapidly.

- Spin the mouse wheel in a numerical text box
to increase or decrease the value.

In addition, you can enter mathematical
operators into numerical text boxes. See
Appendix 1.

View Panel

The View panel is a collection of up to four
viewports and is the heart of the program. This
is where you build and animate your 3D models.

Object Manager

The Object Manager contains all your scene
elements (objects). You can group objects
hierarchically. For example, you can make a leaf a
child of a branch and the branch a child of a tree.

If you want to edit an object, you must first
select it by clicking on its name in the Object
manager. The name of the object will turn red to
indicated that it is selected.

Objects usually have tags. Tags add properties
to an object such as materials.

Material Manager

The Material manager contains all the materials
for the scene. If you double-click on a material
icon, the material editor will open so that you
can edit the material.

You can add a material to an object by dragging
the material from the Material manager onto
the object.

Browser

In the default layout, the Browser is displayed as
a tab. The Browser is a library for all files that
can be read by CINEMA 4D.

You can drag-and-drop files from the Browser
onto other managers to have them displayed
there. For example, if you drag a scene on to
the view panel, the scene is loaded; if you drag
a scene on to the Material manager, the scene’s
materials are loaded.
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Coordinate Manager

You can use the Coordinate manager for
precision modeling or manipulation. For
example, rather than scale an object in the view
panel, you can enter the exact size in the
Coordinate manager. As with all numerical
boxes, you may use mathematical operators too.

Time Palette

This palette gives you simple animation controls.
For more advanced animation, you'll need to
open the Time Line (see page 558).

Active Tool Manager

This manager shows the settings for the active
tool — the settings will vary according to the
tool being used. For a detailed description of the
options, see the relevant chapter for the tool in
question.

Snap Settings

Lots of different snap settings are supported. For
example, you can snap to the grid or snap to
other elements. For more information on snap
settings see page 375.
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X. Object-Manager

2. Views and Viewports     
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2 Views and Viewports

Edit Menu

Undo View/Redo View

Each viewport has its own Undo View/Redo
View functions (the Undo/Redo functions of the
main window do not affect editor cameras).

Note

The shortcut for Undo View is Ctrl+Shift+Z. For
Redo View, use Ctrl+Shift+Y.

Frame

Frame Selected Elements

The camera will move so that the selected
elements (e.g. objects, polygons) fill the
viewport and are centred.

Frame Active Object

The camera will move so that the active object
fills the viewport and is centred.

Frame Scene Without Camera/Light

The camera will move so that all objects, apart
from lights and cameras, fill the active viewport
and are centred.

Frame Scene

The camera will move so that all objects,
including lights and cameras, fill the active
viewport and are centred.

You can open as many view panels (aka views)
as you like. Each view panel has its own display
settings. A view panel can display up to four
viewports (views of a scene) and each of these
viewports also has its own display settings.

Viewport Icons

There are four icons at the top right of each
viewport. The right-most icon toggles the active
view (see Toggle Active View, page 26). The
remaining icons move, zoom and rotate the
camera (click-drag on the icon to see the effect).
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Frame Default

This function resets the viewport to its default
values.

Use as Render View
If this option is enabled, the active camera of
the active viewport is used for the rendering in
the Picture Viewer.

Redraw
This function redraws the scene. Usually,
CINEMA 4D updates viewports automatically.
Sometimes this is not possible, such as when
you use several CPU-intensive commands in a
short space of time.

Configure
If you choose Configure, the viewport’s
configuration dialog will open.

Active Object

Display

Display sets the display mode (e.g. Gouraud
shading, Wireframe) for the active object,
although see Use Shading Property below.

Use Shading Property

If this option is enabled, the active object will
use the display mode defined in its display tag
instead of the setting defined in this dialog.

Show Normals

If you enable this option, surface normals will be
shown when you select polygons. The normals
appear as small auxiliary lines which are
perpendicular to their surface. By convention,
the direction of a normal represents the
direction of its surface.

For example, backface culling checks the
direction of each normal to determine whether
its surface should be drawn — if the normal
points away from the camera, the surface is not
drawn (the surface is assumed to point away
from the camera, just like its normal).

X-Ray Effect

To enter x-ray mode, enable this option. If the
active object is a polygon object, it will become
semi-transparent so that you can see all of its
points and edges.

Show Animation Path

Enable this option to see the active object’s
animation path. The path then appears as a
yellow curve in the viewport. Edit the animation
path as you would a spline, i.e. drag curve
points to new positions and edit their tangents.
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Inactive Object

Display

Display sets the display mode (e.g. Gouraud
shading, wireframe) for the inactive objects in
the scene.

Use Shading Property

If this option is activated, the inactive objects
will use the display mode defined in their display
tags instead of the setting defined in this dialog.

View Settings

Projection

You can use this setting to change the projection
type (e.g. to Perspective, Bird, Dimetric).

Disable Textures

To switch off realtime texture mapping, enable
this option.

Disable Backface Culling

You can select this option to switch off backface
culling.

Note

Backface culling merely hides an object’s
concealed points and edges. If you disable
backface culling, you will still see objects behind
other objects in wireframe display mode.

Show Safe Frames

Enable this option if you want to see safe frames
in the viewport. You will also need to enable the
safe frames in the General Settings dialog (see
page 49).

Background

Show Picture

This allows you to place a background picture in
a planar view. Click the Path button and use the
dialog that opens to locate the picture. Next,
activate the Show Picture option.

You can reposition and scale the picture using
Horizontal Offest, Vertical Offset and Size. You
can use a different picture in each planar
viewport.

Note

This background picture is intended for use as a
'tracing image'. It is a modeling aid and not
intended for rendering. If you want a background
picture for rendering, use a Background object,
see page 233.
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Cameras Menu
Each viewport has its own independent camera,
called the editor camera. The editor camera is
active by default, but you can create and
activate your own cameras. Unlike the editor
camera, your own cameras are shown as objects
in the Object manager.

Scene Cameras
To activate your own camera, choose it from
this list. For more details on creating and using
your own cameras, see page 181.

Link Active Object
Choose this command to view the scene from
the origin of the active object. Your view will
point in the direction of the object’s Z axis.

This command can be useful, among other
things, for checking which objects a light source
can 'see'. Keep in mind that in some display
modes your view may be blocked by the active
object’s surfaces.

Editor Camera
This command activates the editor camera.

Projections
Here you choose the projection mode for the
camera. You can choose from over a dozen
modes. Each mode is demonstrated visually in
the following pictures.

Warning!

The camera position may alter when you change
the mode. You can avoid this by selecting the
view (e.g. View 3) from the View menu.

Perspective

This is the default projection mode for the view
panel. It shows you the scene as through you
were looking though a conventional camera.

Parallel

The vanishing point is infinitely distant. All lines
are parallel.
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Left

The YZ (left) view.

Right

The ZY (right) view.

Front

The XY (front) view.

Back

The YX (back) view.
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Top

The XZ (top) view.

Bottom

The ZX (bottom) view.

The following projections all use parallel
projection. They differ in the format and/or
viewing angle. Military, Frog and Bird projection
share the same viewing angle but use different
formats.

Military

X:Y:Z = 1:1:1

Frog

X:Y:Z = 1:2:1
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Bird

X:Y:Z = 1:0,5:1

Gentleman

This is a popular choice for architecture.

X:Y:Z = 1:1:0,5

Isometric

This is a popular choice for technical subjects
(e.g. machinery). The X:Y:Z format is 1:1:1.

Dimetric

This is similar to Isometric, but with an X:Y:Z
format of 1:1:0.5.
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Display Menu
This contains display-related options such as the
shading mode.

Note

To switch on realtime antialiasing, enable the
Antialiased Lines option on the Views tab of the
General Settings. See page 50.

Level of Detail
Choose from Low, Medium or High. The setting
affects the amount of detail shown on each
object for the selected display type – the lower
the detail, the faster the display.

Use Render LOD

If this option is enabled, the level of detail
defined in the Render Settings is used.
Otherwise, the level of detail in the Project
Settings is used.

Gouraud Shading

Gouraud shading is the highest quality display
mode for viewports. All objects are shaded with
smoothing and light sources are taken into
account.

The redraw rate is affected most by processor
speed and graphics card speed — the faster
your CPU and graphics display card, the faster
scenes will redraw. If the display update
becomes too slow, try reducing the size of the
viewport.

Quick Shading

Quick Shading is almost identical to Gouraud
Shading (see above). The only difference is that
the auto light (see page 430) is used instead of
the scene lights to calculate the shading. This
can lead to a faster redraw rate since only a
single light source (the auto light) needs to be
evaluated.
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Wireframe

Objects are shown as lines. The display is much
faster than with Gouraud and Quick Shading.
Wireframe is suitable for complex scenes,
especially with Backface Culling on (see page 24).

Isoparms

This mode displays isoparm lines for objects that
use them (e.g. NURBS objects). Other objects,
such as polygon objects, will be displayed in
wireframe. The isoparm display mode is very
fast and is particularly suited to complex scenes.

Shaded Box

This mode displays each object as a shaded box.
Each box has the same dimensions as the object

it represents. This is a fast display mode that is
suited to character animation or large scenes.

Box

This mode displays each object as a wireframe
box. Each wireframe box has the same
dimensions as the object it represents. Box is the
second fastest display mode, making it useful
for extremely demanding scenes.

Skeleton

This is the fastest display mode of all. It is only
suitable for hierarchical structures. Each object
origin is shown as a small dot and the dots are
connected according to the hierarchy.

This mode can be useful for character
animation. Not only is it extremely fast, it also
removes all non-critical lines to expose the
skeleton.
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Use Shading Property
When this option is enabled, objects use the
display mode defined in their display tags.
Objects that do not have a display tag will
continue to use the general settings (see
page 16).

Backface Culling
Enable this option to switch on backface culling.
This can speed up the display and it also makes
the scene easier to understand and edit.

With backface culling, all concealed surfaces are
hidden. A backface is a surface that points away
from the camera.

CINEMA 4D knows the direction of a surface by
looking at its surface normal. If the surface
normal points towards the camera, the surface is
a frontface. If the surface normal points away
from the camera, the surface is a backface and is
not drawn when this option is enabled. The
following picture demonstrates the backface
principle:

By convention, the normals should point
outwards from their surfaces. Objects with
inwardly-pointing normals may show display
errors. To remedy this, reverse the normals (see
Reverse Normals, page 372).

The following picture shows how backface
culling hides concealed surfaces (backfaces). The
object on the left does not use backface culling,
the object on the right does.

Textures
CINEMA 4D’s realtime texture mapping (RTTM)
allows you to see textures in the view panel in
realtime – even without an OpenGL card.

To switch on RTTM for a particular viewport,
enable the Textures option from its Display
menu. The textures will be visible only with
Gouraud Shading or Quick Shading.
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RTTM can display the following material channels:

- Color
- Diffusion
- Luminance
- Transparency
- Bump
- Alpha
- Specular

You can use a display tag in the Object
manager to switch on or switch off RTTM for
each object (File > New Tag > Display Tag).

RTTM enabled in the display tag (Use Textures)

RTTM is an approximation only of the rendered
result. RTTM may differ significantly from the
rendered result, especially with large objects that
extend towards the horizon.

Note

RTTM supports multiple textures. In other
words, if you map several textures onto an
object, all of these textures are shown in the
viewport in realtime. This applies to textures
restricted to frozen selections also.

Note

If you activate a texture tag in the Object
manager, only the texture it represents will be
shown in the viewport – no other textures will
be shown. For this reason, deactivate all texture
tags if you want to see all textures.

X-Ray
To activate the x-ray mode, enable this option.
If the active object is a polygon object, it will
become semi-transparent so that you can see
its concealed points and edges.

This is particularly helpful in polygon-based
modeling, since it enables you to see concealed
surfaces in the Gouraud shading and quick
shading modes.
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View Menu
Each view panel can have up to four viewports.
Each of these viewports may have its own:

- camera
- projection type
- display mode

Viewport Arrangement
You can choose a single-view mode or all-
views mode. The arrangements on offer are:

Single-View

2 Views Stacked

2 Views Side by Side

3 Views Top Split

3 Views Bottom Split

3 Views Left Split

3 Views Right Split

4 Views

4 Views Top Split

4 Views Bottom Split

4 Views Left Split

4 Views Right Split

4 Views Stacked

4 Views Side by Side

Each viewport may have its own camera,
projection type and display mode.

Note

These settings are saved automatically when you
save the document.

Toggle Active View
This option toggles between the single-view
mode and the all-views mode. When toggling
from all-views to single-view, select the optio-
 from the target view (the view that you wish to
see next).

View 1 - View 4/All Views
Here you can switch between the single-views
and the all-view mode.

You can change each view’s projection type via
its Cameras menu. The default projections are:

View 1 F1 perspective
View 2 F2 top
View 3 F3 right
View 4 F4 front
All Views F5 all views
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3. Configuration   
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3 Configuration
The project settings are saved whenever you
save the scene.

See page 56 for full details on the project
settings.

Viewport Settings

Here you control aspects of viewport display —
such as the shading mode used for the active
object and the shading mode used for inactive
objects. Each viewport has its own settings.

To access the viewport settings, choose Edit >
Configure in the viewport.

The viewport settings are saved when you save
the scene.

See page 29 for a full account of the viewport
settings.

Note

You can create your own default layout. To do
this, arrange the layout as required — by all
means add an extra view panel, new command
palette and so on. Then, save the scene with the
filename ‘template.c4d’

Render Settings

These settings define how the active scene will
be rendered — e.g. you can set the save path
and output resolution.

To access the render settings, choose Render >
Render Settings from the main menu.

The render settings are saved when you save
the scene.

See page 402 for full information on the render
settings.

CINEMA 4D has hundreds of functions and a
freely customizable GUI. This means that there
are many settings also.

To keep CINEMA 4D easy to use, the settings
have been placed in various, relevant parts of
the program.

This chapter shows you where the settings are
stored and how to use them. Some of the
settings are described in other chapters —
where this is the case, you will see a reference to
the relevant page.

Configuration Dialogs

General Settings

These settings control the general behavior of
CINEMA 4D. For example, you can change the
background color used by all viewports.

To access the general settings, choose Edit >
General Settings from the main menu.

The general settings are saved when you quit
CINEMA 4D.

See page 43 for a full description of the general
settings.

Project Settings

These settings apply to the active project only —
such as the frame rate.

To access the project settings, choose Edit >
Project Settings from the main menu or Edit >
General Settings from the Time Line menu.
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Import/Export Settings

These settings affect file import and file export.
For example, 3DS files can be scaled up by a
factor of ten on import.

To access the import/export settings, choose the
relevant format from Edit > General Settings
from the main menu.

The import/export settings are saved when you
quit CINEMA 4D.

See page 76 for a description of the import/
export settings.

Browser Settings

Here you can control the display of thumbnails
in the Browser — such as the size of the
thumbnails and the file formats shown.

To access the browser settings, choose Edit >
Preferences from the Browser menu.

The browser settings are saved when you save
the scene.

See page 67 for details on the browser settings.

Note

To prevent the browser loading the settings,
disable the Load Manager Settings  option in
the general settings (see page 44).

Snap Settings

These settings control the behavior of snapping.
For example, you can switch on point snapping.

To access the snap settings, choose Window >
Snap Settings from the main menu.

The snap settings are saved when you save the
scene.

See page 375 for details on the snap settings.

Configuration Managers

Command Manager

Use this manager to create or edit palettes and to
create or edit shortcuts. To access the Command
manager, choose Window > Command Manager
from the main menu. The Command manager
settings are saved when you quit CINEMA 4D.

See page 39 for details on this manager.

Note

The shortcuts will be saved when you quit
CINEMA 4D.

Menu Manager

Here you can create your own menu structure
for each manager. To access the Menu manager,
choose Window > Menu Manager from the
main menu.

The Menu manager settings are saved when
you quit CINEMA 4D. You can also save the
settings by clicking on the Save All Changes
button in the Menu manager dialog.

See page 40 for details on using the Menu
manager.

Other Settings
There are many settings in addition to those
mentioned above. For example, you can switch
on time curves in the Time Line.

These settings are always saved in the scene file.
To prevent them from loading into the
managers, disable the Load Manager Settings
option in the general settings.

Each setting is documented in the relevant
chapter.
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Before moving the window’s edge

After moving the window’s edge

Graphical User Interface
This section shows you how to configure the
CINEMA 4D GUI. Among other things, you can
tab windows, create your own command
palettes and even change the menu structure.

Resizing Windows

To change the width or height of a window, first
move the mouse pointer to a window border;
the mouse pointer will change into a double
arrow to indicate the direction (either vertical or
horizontal) in which you can drag the border.
Drag the window as required. The surrounding
windows will resize automatically to make room.
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A layout for a left-handed user perhaps?

Even setting up your scene (‘staging’) is easier with a custom
layout

Note

You can load a previously saved layout or revert
to the default layout at any time. See Working
With Layouts, page 60.

Arranging Windows

To change the position of a window, click-drag
the window’s pin icon to the new position. A
dark line will appear while you drag to indicate
the new location.

A layout for modeling: big viewport, dozens of command icons

A layout for texturing: a vertical Material manager and a large
Object manager
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Docking

New windows are undocked by default. To dock
a window, click-drag its pin icon to the docking
position. A dark line will appear while you drag
to show the insertion point.

For practice, first add a second view panel by
choosing Main menu: Window > New View
Panel. Next, click-drag the pin icon of the new
window and release the mouse button

Try adding a second 3D viewport for practice:
Select Window > New View Panel in the main
window. Drag the pin for the new window and
drop it wherever you like, e.g. between the
Object manager and the Coordinate manager
(check that you can see the dark line before you
release the mouse).

New view, still undocked

Here the new view is docked

Undocking

To undock a window, click on its pin icon and
choose Undock from the menu. The window
will become a free-standing window that floats
above the main window.

Click on Undock

Undocked window

Note

You can insert a window or a command palette
into an undocked window to form a new GUI
group. This can help in particular if you are using
more than one monitor.

Undocked windows are fully functional. The
advantage of docked windows is automatic
justification when you resize a window.
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You can remove the window by undocking it
and then closing it (click on the pin to select the
Undock and Close commands).

Rename

This function in the pin’s menu allows you to
rename the window or command palette. The
name of a command palette is visible in the
interface only when it is defined as a tab.

Tabs

Creating Tabs

You can display a window or command palette
as a tab. To create the tab, click on the pin icon
and select Make Tab.

Grouping Tabs

You can remove a tab from one group and insert
it into another group. To do this, drag the tab’s
pin and drop in on to a tab or pin in the target
group. The mouse pointer will change into a
hand to indicate when the insertion is possible.

If you drop the tab on to a pin, it will be
inserted after the tab that the pin belongs to. If
you drop the tab on to a tab, it will be inserted
before it provided that the hand icon is released
on the left half of the tab; otherwise, it will be
inserted after the tab.

Do not forget about the command palettes —
they make great tabs too!

Note

If you drop a pin on to another pin, both will
become tabs, even if the target was not a tab.

Converting Tabs into Windows

You can convert a window defined as a tab into
a freestanding window. To do this, drag the
tab’s pin slightly to the left and release the
mouse button.

Here the Object manager gets undocked

The undocked Object manager
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Command Palettes
A command palette can contain any command
that can be selected from a menu. The
command palette can show the commands as
icons, text or as both icons and text.

Command palettes help you reach important
commands quickly. You can edit the default
palettes and create completely new palettes.
You can dock new palettes into the layout.

Note

An undocked palette is a window in its own
right. For example, it can contain several
command palettes and windows. This is
particularly useful if you are using more than
one monitor.

Creating a New Command Palette

To create a new (empty) command palette,
either:

- select Window > Layout > New Icon Palette
(main window)

- click on any pin icon and select New Icon
Palette from the pin’s menu

- click the right mouse button within an existing
command palette (e.g. the default palette to
the left of the main window) and select New
Icon Palette from the context menu

New command palette, still empty

There are two ways to add commands to the
command palette. You can either drag-and-drop
commands from an existing palette (e.g. the
default palette to the left of the main window)

or you can drag-and-drop commands from the
Command manager (choose Window >
Command Manager).

You must activate the Edit Palettes option in the
Command manager before you can add
commands. Once the Edit Palettes option is
selected, drop the first command on to the
empty palette box of the new command palette.
When you drag-and-drop further commands on
to the palette, a dark line will appear to show
where the command will be inserted. To open
the context menu for the command palette,
position the mouse pointer on an icon and click
the right mouse button.

The Command manager is described in detail
later in this chapter.

This is the way that a command is added to the new palette

Changing the Sequence

To move a command to a different location in
the palette, drag-and-drop the command to the
new position (a dark line will indicate the
insertion position).
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Icons / Text

You can reach these two settings via the
command palette’s context menu (position the
mouse pointer over a command and click the
right mouse button).

If the Icons option is selected, icons will be
shown for the commands. If the Text option is
selected, text will be shown for the commands.
If both options are selected, icons and text are
shown for the commands.

Different combinations of command palettes

Vertical

You can reach this setting via the command
palette’s context menu (position the mouse
pointer over a command and click the right
mouse button).

If this setting is activated, text will be displayed
below each icon instead of to the right (provided
that Icons and Text are also activated).

Command Alignment (Horizontal vs Vertical)

You can reach this setting via the command
palette’s context menu (position the mouse
pointer over a command and click the right
mouse button).

Select Transpose to toggle the alignment of the
commands between vertical and horizontal
alignment.

Rows / Columns

You can reach this setting via the command
palette’s context menu (position the mouse
pointer over a command and click the right
mouse button).

The value you set here defines the number of
rows or columns for commands.

If you are using vertical command alignment,
this setting refers to the number of columns. If
you are using horizontal command alignment,
this setting refers to the number of rows.

Think of this as the number of lines. For example,
if you have 20 commands, setting this value to 2
will create two lines with 10 commands in each
line. A value of 3 would create three lines (this
time with 7 commands in the first two lines and 6
commands in the third line).

Alignment in rows or columns

Icon Size

You can reach this setting via the command
palette’s context menu (position the mouse
pointer over a command and click the right
mouse button).
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You can use this setting to change the size of
the command icons. The sizes you can choose
from are:

Large 32 by 32 pixels

Medium 24 by 24 pixels

Small 16 by 16 pixels

Original original icon size (see below)

The original icon sizes are defined in the icon
resource file (‘Resource/icons/c4d_icons.res’).
The original sizes usually correspond to Large
icons.

The different icon sizes

Note

If an icon is displayed at a different pixel size to
its original size, it must be resampled. This may
lead to a visible loss in picture quality.

Creating Folded Command Groups

You can group commands to form a folded
palette. To do this, ensure that the Edit Palettes
option is active, then position the mouse pointer
over a command and click the right mouse
button to open the context menu. Choose Fold
Palette.

Now, only one command is visible. This is called
the visible command. The little arrow towards
the bottom right of the icon indicates that it
contains other commands.

Next, deactivate the Edit Palettes option. Click
and hold down the left mouse button on the
visible command. The folded palette appears.

You can either release the mouse button and
then click on the required hidden command, or
you can move the mouse pointer over the
required command before you release the
mouse button. Note that the visible command is
also a hidden command.

If the Lock Icon command of the context menu
is not selected, the visible command will always
be the most recent command that you selected.
For example, if the visible command is Cube and
you select the hidden Cone command, the Cone
command will become the visible command.

The order of the commands in the folded palette
corresponds to their order before they were
folded. You should arrange the commands
before you fold them.

You can drag-and-drop a visible command on to
another palette. This enables you to use several
folded command groups within the same
palette. To create a palette with several folded
command groups: Create two empty command
palettes. Use the first palette to create a folded
command group, then drag-and-drop the folded
commands (i.e. the visible command) on to the
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second palette. Next, create the second folded
group in the first palette, then drag-and-drop it
on to the second palette, and so on. Once the
process is complete, close the redundant palette.

You can also use text-only display with folded
palettes.

Unfolding Command Groups

You can unfold a folded group of commands
into a palette of individual commands. To do
this, select Unfold from the context menu (click
the right mouse button on the visible
command).

This command can be selected only when the
Edit Palettes option is active.

Lock Icon

If this option in the context menu is not
activated, the visible command for a folded
group of commands will always be the most
recent command that you selected. For
example, if the visible command is Cube and
you select the hidden Cone command, the Cone
command will become the visible command.

If this option is activated, the current visible icon
will be locked, meaning that no matter which
tools you go on to use from the folded palette
the visible command remains the same.

This command can be selected only when the
Edit Palettes option is active.

Delete Command

You can delete a command from the palette. To
do this, move the mouse pointer over the
command that you wish to delete, then hold
down the right mouse button and select Delete
Command from the context menu.

This command can be selected only when the
Edit Palettes option is active.

Edit Palettes

You must activate the Edit Palettes command
before you can make changes to palettes. You
can reach this setting via the context menu
(right mouse button over a command) or via the
Command manager (Windows > Command
Manager in the main window).
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The Command Manager
The Command manager contains lists of all the
commands in CINEMA 4D. You can use this
manager to drag-and-drop commands in order
to create your own command palettes or
submenus (see The Menu Manager, page 40).
You can also use the Command manager to
define shortcuts.

Inserting Commands into Palettes

First, select the Edit Palettes option. Next, drag-
and-drop commands on to the palette. A dark
line will indicate where a command will be
inserted.

You can also drag-and-drop separators on to
palettes to visually separate commands into
logical groups. Separator 1 is a line, Separator 2
is a space. Simply drag-and-drop these
separators on to the palette. Again, a dark line
will appear to indicate the insertion point.

This is how you add separators to the new command palette

You can use the pop-up menu to the right of
the pin to select which command category is
displayed in the list. Each category refers to a
particular menu or manager.

You will notice that some commands do not
have icons.

Allocating Shortcuts

You can allocate a shortcut to any command so
that you can press a simple key sequence to call
the command rather than select it via a menu or
palette.

For example, if you press Ctrl-B, the Render
Settings dialog will open. You use the Command
manager to allocate the shortcuts. You can also
use the Command manager to define a second
shortcut for the same command.

This can be useful when two keys are logical
alternatives for a particular command. For
example, the delete and backspace keys are
both shortcuts for the Delete command. The
second shortcut is also useful for standard
commands which have different shortcuts under
Windows and Mac OS.

To create a shortcut:

Select the command from the list in the
Command manager by clicking on it with the
left mouse button.

Next, click on the first text box to the right of
Assign. Press the key combination that you wish
to assign to the command.
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Click on the green tick to the right of the text
box to activate it. The shortcut will appear in the
Current box. To remove the shortcut, click on
the red cross icon.

Valid shortcuts are:

- a single key

- a key + Ctrl

- a key + Shift

- a key + Ctrl and Shift

Note

Some keys are reserved and cannot be allocated
as shortcuts (e.g. left arrow, right arrow).

CINEMA 4D’s built-in hotkeys are extremely
useful. For example, if you hold down the 1 key
you can move the camera, no matter which tool
is active. These hotkeys come at a price — you
cannot use them with shortcuts, even if you
combine them with Ctrl and/or Shift.

If a shortcut has already been allocated, the
command that uses the shortcut will be displayed
below the text boxes. You should remove the
shortcut before reallocating it. (To remove the
shortcut, select the command that it is currently
allocated too, then click on the red cross icon).

It is not possible to predict the effect of pressing
a shortcut that is applied to more than one
command.

Note

The shortcuts are saved in the layout.

Warning!

Do not attempt to allocate shortcuts that are
used by OS commands, e.g. Ctrl-Alt-Del
(Windows).

The Menu Manager
You can use the Menu manager to edit
submenus and pop-up menus. You can also
create your own submenus.

The menus in the Command manager and how they ‘look’ in
the program

The Menu manager and the Command manager
allow you to configure your very own CINEMA 4D
interface, fine-tuned to the way you like to work.

The Menus

CINEMA 4D has more than 25 menus and pop-
up menus. Use the pop-up menu at the top of
the manager to determine which menu is shown
in the list.

Submenus are prefixed with Submenu. To open
or close a submenu, double-click on it.
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Inserting Commands

The Command manager contains lists of all the
CINEMA 4D commands. You can drag-and-drop
commands from the Command manager into
the Menu manager.

The mouse pointer will change form to indicate
the insertion mode.

Copy, Delete/Cut, Paste

You can use these commands to copy, delete or
paste the selected command.

Move Up, Move Down

You can use these commands to move the
selected menu entry one position up or one
position down the list.

New Submenu

This will insert a new submenu above the
selected entry. You can add commands or even
further submenus to the submenu.

Rename

You can use this command to rename a
submenu that you created. (You cannot rename
the standard menus and commands.)

Apply

The changes will be applied. You can test them
immediately.

Save All Changes

All menu changes will be saved.

Revert to Saved

Discards all settings and reverts to the last menu
definition that was saved.

Revert to Original

Reactivates the standard menu settings, which
are permanently stored in the program (factory
settings).
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The Pin’s Menu
Each manager has a pin icon towards its top left
corner.

Earlier in this chapter we explained how the pin is
used to combine and arrange managers (see
Graphical User Interface, page 31). The pin also
has a menu, the functions of which are described
below.

Undock

This function removes the current manager from
the main window. The manager will be displayed
in its own window.

Undock a tab to open a manager in a floating window

Rename

You can use this function to rename a window
or a tab.

Make Tab

This function creates a tab for the active
window or active manager.

New Icon Palette

This function creates an empty command
palette. You can use the Command manager
(see above) to add commands to the palette.

Close

This function closes the manager. To open the
manager again, select it from the main Window
menu.
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General Settings
These settings enable you to change the editor’s
appearance as well as influence the operation of
functions. You can access this dialog from the
main Edit menu.

General

High Thread Priority

If you enable this option the system assigns a
higher priority, i.e. more computing time, to
CINEMA 4D than to other running applications.
If enabled, applications other than CINEMA 4D
which are running will execute more slowly than
usual. If you want to work in other applications
while rendering in CINEMA 4D, you may find it
useful to disable this option.

Graphics Tablet

If you experience problems when using a
graphics tablet with CINEMA 4D, activate this
option.

Use HPB System

You may find this option useful if you are an
experienced animator. If this option is not
enabled, the active object will rotate about its
local axes or the world axes when you use the
mouse. However, when you play back the
animation, the object may not rotate as
planned. This is because CINEMA 4D records all
rotations using the HPB system (see World
System, page 310).

If, on the other hand, you enable this option,
the active object will rotate about the HPB
angles when you use the mouse. In other words,
you will rotate the object using the heading,
pitch and bank of the object’s parent system.
Only experienced animators should use this
option, since it requires a great deal of abstract
thought.

Link Manager Selection

When this option is enabled, the Object
manager and the Time Line are linked. The
objects you activate in one manager will be
activated in the other manager as well.

Note

Object hierarchies will not be opened
automatically in the other manager.

Display Units

Values are displayed together with their unit of
measurement by default. If this option is disabled,
the unit of measurement will not be displayed.
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Center New Objects in View

By default, CINEMA 4D creates all new objects
at the origin of the world coordinate system. If
the origin is not visible in the view, a newly
created object may be out of sight. If this option
is activated, new objects will appear in the
centre of the active view.

Use QuickTime

If you enable this option CINEMA 4D uses
QuickTime, if it is installed on your computer.
Additional file formats will then be available to
you. If this option is disabled the Browser will
work slightly more quickly as it has to check
fewer file formats.

Note

QuickTime may crash if you use damaged image
files; this is not the fault of CINEMA 4D and is
why we offer the option to disable QuickTime.

Save RTTM Textures

If you have activated realtime texture mapping
(RTTM), small temporary textures will be
created so that you can see them in the
viewports. These RTTM textures take a little
while to create and they must be created each
time you load the scene.

However, if Save RTTM Textures is activated,
the RTTM textures will be saved along with the
scene file. This speeds up the loading process,
but the file size will increase as a result.

Save Particles

Assume you have saved a scene containing
particles with the time slider past frame 0. When
you next load the scene, the particle stream will
need to be generated to match the current
frame. This can slow the loading time for the
scene.

If you enable this option, the current particle
data will be saved when you save the scene.
This speeds up loading time for the scene but it
increases the file size.

Load Manager Settings

We mentioned in the Other Settings section of
the overview that each manager also contains
settings that are not represented in the settings
dialog (e.g. the active mode for time curves).

You have the option either to load these settings
when you load the scene or to use the current
settings.

If the option is enabled, the settings that were
last used in the saved scene will be activated in
the corresponding managers.

Note

These settings are always saved in the scene file.
Whether or not you use them is up to you.

Render Materials on Loading

When you save a scene, the material preview
pictures are saved as well. When a scene is
loaded, these pictures will be used and
displayed. However, if you load a foreign 3D
data format, only the base colours of the
materials will be shown.

If this option is activated, CINEMA 4D will
create new preview pictures each time a scene is
loaded; naturally, this will slightly slow down the
loading process.

Generate Backup Copies

When you save a scene with a filename that
already exists in the destination folder, by
default the original scene will be overwritten.
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If this option is enabled, CINEMA 4D will
rename the original file before the new file is
created. The original file will be appended with
‘.bak’. For example, ‘Design.c4d’ will become
‘Design.bak’. If ‘Design.bak’ already exists, it
will be overwritten.

Save Layout at Program End

If this option is activated, the current layout will
be saved when you quit CINEMA 4D. When
you next start the program, the layout will be in
the same state that you left it in.

This may possibly lead to unwelcome effects.
For example, perhaps your usual layout is biased
towards modeling (e.g. large 3D viewport). You
decide to create a layout specifically for
texturing (e.g. large Material manager). You
save the texturing layout under its own name
and quit the program. If this option is enabled,
the texturing layout will overwrite your usual
layout.

Note

Always save a new layout using a unique name,
even if you intend for it to be your normal
layout. To save the layout, choose Window >
Layout > Save Layout as.

Undo Depth

You can use this value to determine the
maximum number of editing steps that can be
undone consecutively. (See The Undo Buffer on
page 85 for further details.)

Recent File List

You can use this value to determine the number
of recent files that are listed in the File menu
(see page 82).

Redraw Limit ... Milliseconds

Sometimes it is not possible to move an object
smoothly in the editor with full shading due to
hardware limitations such as processor speed.

CINEMA 4D uses an ingenious system that
estimates the time required for a redraw. If the
estimated time exceeds the redraw limit
specified here, a faster display mode will be
used automatically. For example, Quick Shading
will be reduced to Wireframe. If the wireframe
mode is still to slow, Box will be used instead.

This process enables you to work smoothly in
the viewports. You can configure the threshold
value to suit your needs. The default value of
600 milliseconds means that a minimum of three
pictures per second will be drawn.

If you do not want a faster display mode to be
used, set the redraw limit to a very high value
(e.g. 10000 milliseconds).

Editor : Pixel

These values specify the ratio of a pixel’s on-
screen width to its on-screen height. The pixel
ratio for most monitors is 1:1.

However, some display media use a pixel ratio
other than 1:1. This will lead to distortion unless
the pixel ratio is adjusted accordingly. For
example, circles will appear to be ellipses.

If you need to calculate the pixel ratio manually,
expand the editor window so that it fills the entire
screen. Select the side view and create a cube.
Measure the width and height of the cube with a
ruler and enter values in the corresponding boxes.
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Basic Units

Here you determine the basic unit of
measurement in CINEMA 4D. You can choose
from pixels, kilometres, metres, centimetres,
millimetres, micrometres, nanometres, miles,
yards, feet and inches.

For example, if you select Centimetre as the
basic units, all position values will be stated in
cm. Note that if you change units the numerical
values will not be converted.

However, you can enter values in different units.
For example, if the basic units are cm and you
type ‘5 km’ into a dialog, the value will be
converted to 500000 cm.

If you set the basic units to Pixel, the unit of
measurement will not be specified. It is then up
to you to decide how to interpret the values.

You can use the following abbreviations for
units when entering values:

Pixel no units specified
Kilometres km
Metres m
Centimetres cm
Millimetres mm
Micrometres um
Nanometres nm
Miles mi
Yards yd
Feet ft
Inches in

Animation Units

Here you specify the time units used for
animation. Your choice is from frames, seconds
and SMPTE time codes which use the format:
Min:Sec:Frame.

For example, 3:20:14 refers to the time 3
minutes, 20 seconds, 15th frame.

The last value in the time code is the frame
number of the current second (starting at frame
0). For example, if you are working with a frame
rate of 25fps, the frame value is in the range of
0 to 24.

If the minutes value is 0, you can omit it when
entering SMPTE time codes. For example, 15:14
means 15 seconds and the 15th frame.

You can use the following abbreviations when
you enter time values:

Frame F
Seconds S
SMPTE min:sec:frame

Color System

You can choose between the RGB model and
the HSV model. You can also choose whether
the values should be specified as a percentage,
or in steps ranging from 0 to 255, or in steps
ranging from 0 to 65535.

A good choice of colors is essential for
consistent photorealistic results. Photorealism is
often a yardstick for programs such as
CINEMA 4D.

The human eye can see several hundred
thousand colors in the spectral range between
400 nm (blue) and 700 nm (red). This color
sensitivity is the result of many thousands of
receptors on the retina. Not all of these are
equally sensitive, and not all are sensitive to the
same range of wavelengths.

Some of the receptors are particularly sensitive
within the blue range, around 440 nm; others
are far more sensitive in other ranges, while yet
others are particularly receptive in the green
range, around 540 or 580 nm.
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The eye therefore has three different types of
receptors for the primary colors red, green and
blue. The spectral sensitivity and overlapping of
the sensitive ranges make characterisation of
colors extremely difficult.

The color which the human eye perceives as
white does not contain equal parts of red, green
and blue light — this would be called chromatic
— but must, in accordance with the overlapping
sensitivity ranges, be made up of varying
proportions of these colors. Only then does the
eye see white. This is what we call achromatic
light.

Typical output devices for color are printers,
imagesetters and computer screens. The first
two use the subtractive method of color mixing
(CMY) and will not be part of our discussion
here. Most important for CINEMA 4D is the
additive method of color mixing, which is the

one used for representing colors on monitors.
CINEMA 4D characterises all colors by using
three numerical values.

Two different color models are used, which you
can easily toggle between. Probably the best
known model is RGB, which is used by most
graphics applications because it is best suited to
the hardware components for image and color
output. The most commonly used output device
is the computer screen, which has a grid
consisting of fine dots, made up from a red, a
green and a blue point. These points can be
addressed by an electron beam. By aiming the
beam at not just one color dot, but for example
the red and the green, the added color value is
yellow.

The color pigments for the screen dots have
been selected in such a way that when equal
parts are added they result in a white which
comes closest to what the human eye perceives
as a pure white.

By beaming different intensities at the three dots
it is possible not only to generate the eight basic
colors (black, red, green, yellow, blue, magenta,
cyan and white) which are the result of mixing
the three primary colors, but many, many mixed
colors.

The number of colors possible is determined by
the number of gradations in the intensity of the
electron beam.
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Using four gradations per primary color results
in 4 x 4 x 4 = 64 colors. The standard is 256
gradations per primary color, which gives 256 x
256 x 256 = 16,777,216 colors.

These colors can be represented in a three-
dimensional coordinate system.

The coordinate axes are formed by the three
primary colors. Black is at the origin. Mixed
colors between red and green form the base
plane. Moving upward, more and more blue
gets mixed in, until white is reached at the front
corner of the cube. All white shades lie on the
line connecting the origin with this corner.

Less technical, and therefore better suited for
painters and artists, is the HSV model. H is the
hue, S the saturation, V the color value. The
illustration below shows what these mean.

The six basic colors (red, yellow, green, cyan,
blue, magenta) form a hexagon around the
color white, together with the color black.

The hue is the angle: starting with 0° for red,
through 180° for cyan, to 270° for magenta.
The saturation (S) is always measured radially
towards the outside. On the inside, along the
black/white axes, it has the value 0.0, outside,
at the edge of the hexagon, it is 1.0. The
greater the saturation, the more intensive the
hue.

The value (V) is measured in the direction of the
black/white axis. At the height of white it has
the value 1.0; going downwards it decreases
until it reaches the value 0.0 for black. The color
value is used for darkening the hue.

Let’s summarise this:

- Pure color pigments sit at the edge of the
hexagon: V = 1.0 and S = 1.0.

- To add white, reduce the saturation.

- To add black, decrease the color value.
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Views

Views

Refresh Active View Only

CINEMA 4D refreshes all views simultaneously
by default. If you are working with a complex
scene using a high level of shading (e.g.
Gouraud Shading with RTTM mode activated),
the editor soon becomes sluggish.

If this option is activated, only the window in
which you carry out an action will be redrawn in
realtime. The other views will only be refreshed
once the action has been completed (e.g. when
you release the mouse button having dragged
an object to a new position).

Render Safe

If this option is activated, the boundaries of the
film format (see page 406) will be shown in the
viewport.

Note

You can set this option separately for each viewport
via the viewport settings (see Configure, page 16),
which apply to the active viewport only.

Action Safe

If this option is activated, a frame will appear in
the editor window. You can adjust the size of
the frame by entering a new percentage value in
the box to the right. The percentage is based on
the film format that is selected in the render
settings (see Render Settings, page 406 and
Render Safe above).

Action Safe marks out a region in which it is
safe for action to occur so that it will be in full
view when played back on the target medium
(monitor, TV screen, cinema screen).

You will have noticed that almost all cinema
screens have curtains at the sides. The curtains
can be pulled closer together or pulled further
apart in order to accommodate the film that is
being played. Even conventional TV screens do
not always display the entire picture.

Note

You can set this option separately for each viewport
via the viewport settings (see Configure, page 16),
which apply to the active viewport only.

Title Safe

If this option is activated, a frame will appear in
the editor window. You can adjust the size of
the frame by entering a new percentage value in
the box to the right. The percentage is based on
the film format that is selected in the render
settings (see page 406 and Render Safe above).
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Title Safe marks out a region in which it is safe
to place opening credits, final credits and other
text information so that there is a minimum of
distortion when it is played back on the target
medium.

Many television sets have a dome-shaped picture-
tube, the curvature of which increases towards the
edges. Pictures displayed on such a surface will
experience the most distortion towards the edges.
This distortion becomes particularly noticeable
with text such as film titles.

Note

You can set this option separately for each viewport
via the viewport settings (see Configure, page 16),
which apply to the active viewport only.

Scale Axes

If this option is activated, an object’s axes will be
scaled whenever you scale the object itself. You
may find, however, that relatively large or
relatively small axes make it difficult to perform
quick actions (move, scale, rotate) by dragging
on a particular axis.

If this option is disabled, the object axes retain
their size when the object is scaled.

Semi-Transparent Axes

If this option is activated, the object axes will be
semi-transparent. You can enter the strength of
the transparency in the box to the right.

If this option is disabled, the object axes will be
displayed at full brightness.

OpenGL

Use OpenGL

If the Use OpenGL option is enabled,
CINEMA 4D will use its built-in OpenGL
routines. You will be able to select further

options provided that they are supported by
your OpenGL implementation (see the
documentation for your card/software).

If this option is disabled, OpenGL support is
turned off and CINEMA 4D will use its internal
shading routines instead.

Note

OpenGL can be installed on your computer as
hardware or software. As a general rule,
software-only implementations are much slower
than their hardware counterparts.

Warning!

The OpenGL support has no effect on rendering
speed. It affects viewport shading only.

Antialiased Lines

If this option is enabled, lines will be smoothed
(antialiased) by the OpenGL implementation
provided that it supports this mode.

MIP Maps

If this option is enabled, the OpenGL
implementation will use MIP maps for texturing
in the viewports. You can use this option only if
it is supported by your OpenGL implementation.

For more details on MIP mapping, see
page 498.

Smart Window Refresh

When enabled, this option accelerates window
refresh under OpenGL if, for example, you
move an undocked manager over the viewports.
If the option is disabled, OpenGL must refresh
the entire screen each time.

Note

The Smart Window Refresh function is not
supported by all OpenGL cards. If display errors
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appear with the option enabled, your card does
not support Smart Window Refresh.

Smart Live Selection

When this option is enabled, the live selection
under OpenGL is accelerated — only the
selected polygons or points are redrawn rather
than the entire screen.

Note

The Smart Live Selection function is not
supported by all OpenGL cards. If display errors
appear with the option enabled, your card does
not support Smart Live Selection.

About Acceleration

Many of us know that 3D computer games can be
enhanced dramatically by using a 3D accelerator
card. With this knowledge in mind, many users
anticipate massive gains with professional software
too. The reality is somewhat slower and the user is
disappointed more often than not.

Simple graphics cards soon fall by the wayside
because they do not have enough graphics
memory to display complex objects in a
reasonably large editor window. A screen that is
1000 by 1000 pixels in size with 24-bit color
requires about 4MB of memory. Double this
figure to allow for screen buffering. If you also
take the depth buffer into account, the memory
required is about 10MB. If insufficient graphics
memory is available, the screen size must be
reduced. (Our calculation doesn’t even take
editor textures into account!)

Even if your card has sufficient memory, there
are other factors to consider:

3D objects are drawn on the screen as filled
triangles. There are two main stages involved.
First, CINEMA 4D must calculate the triangles.
Next, the triangles must be drawn. If no 3D

accelerator card is present, CINEMA 4D will draw
the triangles itself using the CPU. The ratio of the
time required to calculate the triangles to the time
required to draw the triangles is about 1:1. Even if
a 3D graphics card takes over the second stage
(drawing the triangles), CINEMA 4D must still use
the CPU to first calculate the triangles.

For example, if a graphics card can draw triangles
five times more quickly than CINEMA 4D, the
overall increase in shading speed is only 40%, not
the 500% that you may have hoped for.

The assumed ratio of 1:1 depends on other
factors:

- Window size

If you increase the size of a viewport, the time
required by the 3D card barely increases
(provided that the card has sufficient memory).
The CPU, on the other hand, is slowed down
to a far greater degree. For example, increasing
a viewport size from 640 by 480 to 1280 by
960 will triple the time required by the CPU.

As a result, the total shading time is doubled
(3:1 instead of 1:1).

- Number of polygons to be drawn

If a scene contains many polygons in a small
area, CINEMA 4D can often draw them more
quickly than the 3D card.

The Role of the CPU

If you are not using a 3D graphics card, the
display speed increases linearly with CPU speed.
If you double the CPU speed, the display speed
doubles as well.

If you double the CPU speed when a 3D card is
already in use, the CPU accelerates the calculation
of the triangles, but not the drawing of them. In
this case, the display speed increases by a factor of
1.5 — the faster the CPU, the less difference (as a
percentage) a 3D graphics card makes.
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CINEMA 4D and Other Programs

Some other 3D programs experience a more
noticeable acceleration with 3D cards. The
reason for this is quite simple. Such programs
are inherently slow, whereas CINEMA 4D is
highly optimised for speed.

CINEMA 4D is exceptionally fast, even before
you activate OpenGL.

Just because a 3D graphics card is used for
shading, this does not mean that shading will be
equally fast in all programs. The triangles must still
be calculated by the program itself, and this is
where CINEMA 4D excels. The result is that, even
though the same 3D card is used, CINEMA 4D has
faster shading than many other 3D programs.

The concept that makes this possible is adaptive
shading (aka adaptive blitting). This means that
CINEMA 4D will only redraw those parts of the
screen that have actually changed. OpenGL, on
the other hand, does a complete redraw every
time. The result is that CINEMA 4D sometimes
out-performs 3D cards. We told you that
CINEMA 4D is exceptionally fast!

Outlook

Until OpenGL is expanded to include adaptive
technology, a faster processor is probably more
effective than a 3D card.

A Word of Caution

Our testers have noticed that some 3D cards
switch off their OpenGL support beyond certain
resolutions and color depths. Some cards
support OpenGL only up to 1024 by 768 pixels
and 24-bits. Some even give up on OpenGL
beyond 800 by 600 and 65535 colours. Perhaps
the most alarming aspect is that in all cases the
OpenGL was disabled silently, leaving the user
in the dark.

A Second Word of Caution

Acceleration is not always supported on multi-
monitor systems (particularly under Windows 9x).
Be sure to ask about any such OpenGL limitations
before purchasing a multi-monitor system.

Textures

Use Textures

This option defines whether textures are
displayed when the Gouraud Shading mode is
activated. This setting is applied globally, i.e. it
affects all viewports.

You can define this option separately for each
viewport via the viewport settings (see
Configure, page 16), which apply to the active
viewport only.

Note

You can work more smoothly in the viewports if
you disable this option.

Perspective Correction

If you enable this option and Use Textures is
enabled as well, all material previews will be
corrected for perspective in the viewports.

Color

Here you can define the colours used in the
viewports. Select the element that you wish to
change from the pop-up and change its color
using the sliders or the system color dialog.

You will see either three color sliders or a color
table depending on the Color System setting on
the General tab. The default setting is the RGB
model with values specified as percentages.

The resultant color is shown to the left of the
sliders. If you click on this color box, the system
color dialog will open.
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If you click on the little triangle just below the
color box, a hidden menu appears. You can use
this menu to change the color model or switch
over to the color table. This setting will be
retained for as long as the dialog is open. As
soon as you close the dialog, the setting on the
General tab will be used.

Interface
This tab allows you control over the look-and-
feel of CINEMA 4D’s user interface.

Language

Here you can select a language for CINEMA 4D’s
interface from the installed language sets. After
quitting and re-launching CINEMA 4D all
messages, menus and dialogs will change to use
the new language.

Scheme

From this pop-up menu you can choose one of
the installed schemes.

Dialog

Using the Style pop-up you can set the order of
the OK and Cancel buttons within dialogs.
Windows uses OK on the left and Cancel on the
right, while the reverse is true under Mac OS.
Choose whichever you feel comfortable with on
your platform.
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Using Alignment you choose how these OK and
Cancel buttons are to be aligned in the dialogs;
aligned left, centred or aligned right.

Help Text

If the Help Text in Statusbar option is enabled, a
short explanation of the menu entries or icons
will be displayed in the statusbar (at the bottom
of the screen) whenever you go to choose a
menu item or hover over an icon.

If the Bubble Help option is enabled, some help
information appears near the mouse pointer when
you hover the mouse pointer over an icon.

Menus

Here you choose whether, in addition to the
normal function descriptions for menu items,
CINEMA 4D should also display icons (Show
Icons option enabled) and/or keyboard
shortcuts (Show Shortcuts option enabled).

Look&Feel

In this part of the dialog you can modify the
look-and-feel of the program interface to your
own taste.

Colors

First choose from the pop-up menu the interface
element you want to change. Then click in the
color box to the right and choose the new color
for this element from the system color chooser
that appears.

In addition, backgrounds of windows, buttons,
dialogs etc. can have a pattern assigned to
them. Check the Use Patterns box and then pick
a pattern from the pop-up below.

Note

You can use your own backgrounds in
CINEMA 4D. Just create a folder called ‘Pattern’

inside the CINEMA 4D Resource folder (if this
doesn’t already exist) and place your own
background image files in this ‘Pattern’ folder.

Fonts

Here you can choose the font CINEMA 4D will
use for displaying text in menus and dialogs,
etc. Choose the font type from the pop-up
menu and then click on the F button to the
right. A dialog opens in which you can choose
the font and its size.

Clicking the R button will revert to your active
system font.

Note

The font changes will be effective only after you
quit and restart CINEMA 4D.

Delays

If you are a Windows user you may have
noticed that windows and menus open quite
slowly on your desktop but rather faster in
CINEMA 4D. Now, you can use the options
under Delays to simulate this delayed reaction
for various actions within CINEMA 4D. Choose
the action from the pop-up menu. Then set the
delay for this action in the field to the right.

As you may have realised, this is not the most
serious or useful option in CINEMA 4D!

Reset to Factory Settings

Owing to the many ways that you can configure
CINEMA 4D to your needs, it can easily happen
that you lose the plot! So if you click this button
all your changes are reset to the original factory
settings.
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Texture Paths

CINEMA 4D searches for texture files and
animation files in the following locations:

- in the same folder as the scene

- in the ‘Tex’ folder of the scene folder

- in the ‘Tex’ folder of the CINEMA 4D folder

If a texture cannot be found in any of the
folders above, you can add the texture’s folder
to this dialog. You can specify up to 10
alternatives. Each is searched recursively, i.e.
sub-folders will be searched too. If a texture still
cannot be located after searching all the texture
paths, CINEMA 4D will report a texture error.

You can type the path name directly into a text
box. Alternatively, click on a Path button and
guide the dialog that opens to the folder in
question. Once you have located the folder,
click on Open (Windows) or the box at the
bottom of the dialog that contains the name of
the folder (Mac OS).

Macintosh
This tab is available under MacOS only.

Use Navigation Services

This option enables / disables the Navigation
Services under Mac OS 9.

Exchange CTRL <–> COMMAND-key

CINEMA 4D uses the Ctrl (control) key as the
default modifier key. The Command key is used
for simulating the right mouse button (hold it
down and click). If you would like it the other
way round, select this option.

Hide system menu

If enabled, the system menus are hidden while
CINEMA 4D is running.



56 • CONFIGURATION • CHAPTER 3

Project Settings
These settings refer to the active scene. To
access these settings, choose Edit > Project
Settings from the main menu or Edit > Project
Settings from the Time Line menu.

Frame Rate

Use this value to define the frame rate for the
animation project. CINEMA 4D uses this value
to calculate all animation data.

Note

You can also set a frame rate in the render
settings (see page 408). However, the frame rate
in the render settings is not used to recalculate
the animation data. If the two frame rates differ,
frames may be dropped or duplicated in the
animation, leading to a reduction in animation
quality.

Minimum

This defines the starting frame for animation
tracks in the Time Line. You can enter a negative
value or a positive value. A negative value can
be useful if you want particles to be generated
so that the stream is ready by frame 0.

This value is decreased automatically when you
drag a sequence past its boundary in the Time
Line (see page 568).

Maximum

This defines the last frame for animation tracks in
the Time Line. This value is increased automatically
when you drag a sequence past its boundary in
the Time Line.

Level of Detail

This value influences the display of all objects in
the active scene that support a reduction in
detail, such as metaballs, primitives and NURBS.

However, any objects that have their own level
of detail setting (see page 463) will continue to
use their setting.

If the value is set to 100%, the objects will be
displayed in full detail.

If the value is set to 50%, the objects will be
displayed with only half of their usual detail
(subdivision).

Note

This value affects the setting of the same name
in the Display menu of the View panel.

Use Render LOD in Editor

If you enable this option, the view panel will use
the level of detail specified in the Render
Settings (Options tab) for rendering.
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X. Object-Manager

4. Workflow   
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- You can construct a spline by creating its points
one by one. Alternatively, draw the spline and
its points will be created automatically (see
Freehand, page 131).

- There is no need to lock axes in order to move,
scale or rotate an object in one direction only.
There is a small arrow, cube or sphere at the
end of each object axis (the exact form
depends on the active tool). Click on the
arrow/cube/sphere for the required axis and
drag. Note that you can use this method to
move/scale/rotate selected points and
polygons as well as objects!

- When you need to select several adjacent
points or polygons, do not click on them one
by one. Instead, use the Live Selection tool and
paint over the points/polygons to select them.

The text above covers only a few of the ways in
which you can improve your workflow. Be sure
to read the entire manual at the earliest
opportunity, since many other workflow tips are
described along the way.

4 Workflow
The purpose of this chapter is to help you use
CINEMA 4D more efficiently. There are many
features in CINEMA 4D that can help improve
your workflow. Just a few of the features are:

- If you need to move, zoom or rotate a camera,
use the icons at the top right of the viewport
(drag the right mouse button on the icon you
require). The fourth, right-most icon toggles
the active view panel between single-view and
all-views (see Toggle Active View, page 26).

- Define shortcuts for the functions you use the
most. Also, create an icon palette and fill it
with the functions. In this way, you can reach
high-frequency functions more quickly.

- Many commands can be performed with a
quick drag-and-drop rather than a trek
through the menus. For example, to allocate a
material, drag it from the Material manager
and drop it on to an object in the Object
manager or view window.

- What if the Object manager is not the active
tab (see page 34) when you drag-and-drop a
material from the Material manager? Simply
drag the material on to the Object manager’s
tab. After a short delay, the Object manager
will become the active tab and you can drop
the material on to the required object.

- Many primitives have handles — e.g. to
control the fillet radius. You can drag these
handles to change the values interactively in
the editor rather than enter values in the
object’s dialog.

- If you need to move several keys or sequences
in the Time Line, select them all and then
move (or copy) them in one go rather than
individually.



60 • WORKFLOW • CHAPTER 4

Working with Layouts
CINEMA 4D has a wealth of configuration
possibilities. For example, you can define your
own shortcuts, create your own layouts, set
your own defaults and configure the Browser for
a specific project.

The allocation of shortcuts is described in detail
in Allocating Shortcuts, page 39. The Browser
and default values are described later in this
chapter. First, we consider working with layouts.

The golden rule for improving your workflow is
to do it in stages. Make little changes at a time,
then once they have become second nature,
make further changes. If you attempt too much
to soon, you may worsen your workflow! Begin
with just a few (e.g. five) shortcuts. Once these
shortcuts have become instinctive, create and
learn to use a few more shortcuts.

What’s the big deal about being able to create
your own layout?

Well, we admit that we are not omniscient — in
particular, we cannot know your preferred way
to work. For example, do you prefer icons or
text in the command palettes? Should the
Material manager be open or do you prefer the
Structure manager in its place?

Of course, we could activate everything, but
this would help no-one. The sheer number of
windows, icons, menus, functions and options
would almost make your monitor sag. Anyone
new to 3D would run a mile. As for workflow...

What is far more important is that you and your
colleagues can create and use your very own
layout settings. You will not have to deal with
the seemingly bizarre changes a colleague has
made to the layout, and vice versa. Anyone who
has used a colleague’s computer will know what

we’re getting at. (“Which folder did she say the
word processor was in? I need to get home
some time tonight...”).

Not only are layouts good for office harmony,
you can also create several layouts for your own
use. For example, you may find it useful to
create a layout for modeling (e.g. a large 3D
viewport) and a layout for texturing (e.g. a large
Material manager).

Start by using the default layout. As time passes
by, keep track of which commands you use the
most.

Is your mouse getting too much exercise? Is it
constantly darting between a command on the
bottom left and a command on the top right of
your 21-inch, 1600x1200 res. monitor? If so,
alter the layout! Put the commands next to each
other, within easy reach.

Previously, we learnt how to use layouts. In the
following, we take a look at the functions for
layout management. You can reach all of these
functions from the main menu bar under
Window > Layout.

Load Layout
You can use this function to load a previously
saved layout. Use the system dialog that opens
to choose the layout file (with a ‘.l4d’
extension).

Reset Layout
This function resets the layout to the factory
settings. Use this function if you get in a
muddle!
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It is also very helpful if you reset the layout
before contacting technical support. In that way,
you and the technician will be using the same
layout — it will be easier to help you locate the
problem.

Note

Remember to save the layout if necessary before
you reset it! You can save the layout with Save
Layout as (see below).

Save Default Layout
This function saves the current layout in a
special file. The next time you launch
CINEMA 4D, the layout will load automatically
as the new default.

Note

There is an option in the General Settings (Save
Layout at Program End, page 45) that, when
enabled, will save the layout each time you quit
the program.

Save Layout as
You can use this command to save the current
layout. Layout files are given the extension ‘.l4d’
automatically.

Further Menu Items
The Window > Layout submenu also lists all the
layout files (extension ‘.l4d’) in CINEMA 4D’s
‘prefs’ folder. To load a layout, select one from
the list.

The Browser

The Browser enables you to take a snapshot of
all files produced by or used in CINEMA 4D
scenes. Many of these files can be viewed as
thumbnails. So, for example, before loading a
texture image into your scene you can view it,
and any other possible textures you may need,
directly within the Browser.

More accurately, using the Browser you can
capture scenes, materials, textures, pictures,
animations, sound, time curves and even
C.O.F.F.E.E. programs (those files ending with
the extension '.cof' and '.cob', e.g. 'undo.cof').

A full list of all CINEMA 4D supported file
formats can be found in Appendix 3. This list is
extended further through the picture formats
and animation formats available when you have
installed QuickTime on your system.

Note

The Browser will recognise a move file only if
the corresponding codec is installed on your
system.
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When used correctly the Browser is a very
powerful control center and manager for your
3D objects.

It makes sense to organize your scene
information into various image catalogs (e.g.
one for sunsets, one for floor tiles and so on).
You can then add notes to these archived files;
these notes will aid in future archive searches.
Using a search with certain criteria you could,
for example, search for all of those files that are
copyright free and are able to be distributed
freely.

While working on a project you can load each of
the required catalogs into the Browser, e.g.
select suitable materials and load these directly
into the scene. We will see how this works
further on in this chapter. First, we need to
create a catalog.

Creating a Catalog

- To start with, scan a folder for all CINEMA 4D
files.

- From the File menu, select Import Folder. From
the dialog you can choose your desired folder.
For these first practice steps the ‘Tex’ folder in
the root of CINEMA 4D is recommended.

- You may also limit the search to certain file
types, perhaps only pictures or scenes. These
criteria (and more options) can be defined in
the Browser preferences.

- During the search the Browser automatically
creates small preview pictures (slides). These
give you a good idea of the actual appearance
of a picture or a scene.

Tip

If the file read by the Browser contains only one
single material (and nothing else, absolutely
nothing at all different), then the Browser will

display only material pictures as in the Material
manager (see Material Manager, page 487), In
all other cases the raytracer renders a picture of
the current view. (See also Save Material As on
page 489.)

- Once the Browser has finished cataloging the
data you are free to add personal notes,
comments, copyright notices and similar things
to the individual files.

- Select a slide (click on it so that it is framed
red) and choose Info from the Function menu.
Enter your own text into the large field. Close
the dialog with OK.

- Now move your mouse pointer over the slide
that you have added comments to and wait.
After a short time the text appears under your
mouse pointer.

- Lastly, save your whole database as a catalog
file with a meaningful name. Choose Save
Catalog as from the File menu. Again the
system dialog appears. Enter a sensible name,
such as 'Test', and the file 'Test.cat' will be
created in the selected folder. This catalog can
then be loaded into the Browser.

So far, we have seen the basic use of the
Browser. The full potential of the Browser will
become much clearer when it is used in
combination with the various CINEMA 4D
managers. Depending on where you drag a
thumbnail slide, you may create new materials,
load scenes, apply textures and so on.

Simply click on a thumbnail and keep the (left)
mouse button held down. Move the mouse
pointer over a manager and release the button.
This technique is known as drag-and-drop.

You may, of course, select several separate
slides. Keep the Shift key pressed as you select
your required slides. All selected slides are
framed in red.
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Drag-and-drop with the Browser

Pictures, Animations

- Pictures, animations in the Material manager:

Creates a new material, containing the image, or
animation, as a color texture.

- Picture, animation on an object in a viewport:

Creates a new material, as above, but assigns
this material directly to the selected object.

- Picture, animation on an object in the Object
manager:

Creates a new material, as above, using the
picture or animation as the color channel but
assigns this directly to the selected object.

- Picture on the Picture Viewer:

The picture is displayed in the Picture Viewer
window.

Tip

The texture must be located in the CINEMA 4D
texture paths otherwise the preview image
remains black in the Material manager (see
Material Manager, page 487).

Scenes

- Scene on the Material manager:

All materials (if applicable) belonging to the
scene are imported to the materials list of the
current scene.

- Scene on a viewport:

The selected scene is loaded.

- Scene on the Object manager:

The selected scene is imported into the current
scene.

Materials

- Material on the Material manager:

The material is imported into the material list of
the current scene.

- Material on an object in a viewport:

The material is added to the material list and
assigned immediately to the selected object.

- Material on an object in the Object manager:

The material is imported into the material list
and assigned immediately to the selected object
in the Object manager.

Tip

If a texture that you use in the CINEMA 4D
Browser is located outside of the texture paths,
the program asks whether you want to copy the
file to the same location as the scene. This
allows CINEMA 4D to find textures
automatically without user intervention.

If you have not yet assigned a name (and
therefore a location) to your scene, textures are
saved to the CINEMA 4D startup folder.

Sounds

- Sound on an object in the Time Line:

If you drag a sound onto an object in the Time
Line, a sound track with the associated sound
sequence is created automatically and the WAV
file is loaded into this sequence.

- Sound on a sound track in the Time Line:

If you drag a sound onto an already existing
sound sequence in the Time Line, the WAV files
is loaded into this sequence. The existing sound
is replaced by the new one.
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- Sound in the Picture manager:

If you drag a sound into this window, the wave
pattern of the WAV file is shown in detail.

Time Curves

- Time curve on a sequence in the Time Line:

The time curve is overlaid on the selected
sequence. Any time curve that already exists in
the Time Line is replaced by the new one. For
further details on the handling of time curves,
see Time Curves, page 615.

Tip

Drag-and-drop with C.O.F.F.E.E. programs will
have no effect.

Further Browser Functions

- Double-clicking on a picture file (usually a
texture) opens the Picture Viewer and displays
the picture.

- Double-clicking on an animation file calls up
the animation player of your system and plays
the animation.

- Double-clicking on a sound file calls up the
sound player of your system and plays the
WAV file.

- Double-clicking a scene file loads it into
CINEMA 4D.

- Double-clicking on a material imports and adds
it to the current scene and the Material
manager.

- Double-clicking on a C.O.F.F.E.E. program
opens your system’s default text editor (the
default under Windows is NotePAD and under
Mac OS is SimpleText) and loads the program,
ready for editing.

- Right-clicking on a preview picture will open a
context menu from which you can access

information about the selected slide and this
allows you to use the Search dialog.

Tip

Double-clicking on time curves has no effect.

Tip

To open the context menu on the Macintosh,
hold down the Command key while you click
the mouse button.

File Menu

New Catalog

Creates a new, empty catalog. Any existing
catalog in the Browser will be replaced with the
new one.

Open Catalog

Loads a previously saved catalog into the
Browser.

Import File

Loads and adds a file (scene, picture, material...)
to the current catalog. A preview picture is
generated.

Import Folder

Loads and adds the contents of a folder to the
current catalog. Depending on how the
preferences are set up, subfolders will be
searched or ignored.

Tip

It is advisable not to list the complete contents
of a CD-ROM unless your computer has lots of
spare memory. A quick calculation backs this up:
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a small thumbnail picture with a size of 80x60
pixels and a color depth of 24 bits needs around
15KB of memory. So 1,000 images on a CD
would require a minimum 16MB of memory.
And don’t forget the extra few megabytes for the
actual display of these images within the
Browser. In such cases it is simple to create a
number of smaller catalogs, which are easier to
manage.

Save Catalog

Saves the current catalog. The catalog is saved
using the name given in the Save Catalog as
dialog. This name also appears in the Browser
title bar.

If your catalog is still yet to be named (in which
case the Browser title bar will show 'Untitled'),
the Save command acts in the same way as Save
Catalog as (see below).

Save Catalog as

Save Catalog as always opens the File selector.
The name you enter here will appear in the title
bar of the Browser window.

CINEMA 4D always adds the extension ‘.cat’ to
the catalog filename.

Making Catalog Paths Relative

Normally, when storing a preview image in a
catalog, the exact location is also saved. This is
essential when using the drag-and-drop
technique to pass objects over to CINEMA 4D
for processing.

However, should you move, for example, a
texture folder from your own system to the
company’s network server, the location of the
files is no longer the same as that of the saved
catalog. Therefore the Browser will not find the
required files.

A similar situation may arise when you compile
a catalog for a CD-ROM collection (textures,
objects, scenes etc.). These collections would
normally be created locally on a computer, using
the computer’s local path definitions and drive
IDs (e.g. the drive could be D:\, or even X:\
under Windows, or possibly 2184: or 1601
under Mac OS). This system would be unusable
for catalogs, as the Browser would look for the
various devices and paths of the computer,
rather than the CD-ROM.

The solution to this is to use relative paths. This
option ensures that paths are not stored as
complete path names, but instead as relative
paths, starting from the catalog folder. Here, the
location path of files is still used, but you are
free to define where the system is to begin its
search. This anchor folder can be anywhere on a
hard disk or CD-ROM. But, starting from that
anchor folder, and moving down, the same path
hierarchy as that of the catalog folder must
exist.

Here’s an example of anchor directories. Let us
imagine that you want to list your winter
background pictures. These are located on the
system hard drive in the following folder tree:

Disk1/Texture/Backgrounds/Winter/...

So we define Texture as the anchor folder, the
relative path then reads:

Backgrounds/Winter/...

This (sub-) folder hierarchy can be now moved
to any other location e.g. to the company
server:

Server7/C4D/Resources/Tex/
Backgrounds/Winter/...
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The new anchor folder is now Tex. Starting from
this location, the hierarchy sub-items now have
the same path as before. To ensure that the
Browser finds the required files requires one
rule; the Browser catalog must always be in the
anchor folder. In the above example the catalog
would have been created in Texture and later
copied to Tex.

Let’s see a more practical example:

You need to collect together and write all of
your textures, materials, objects and finished
pictures, and all other useful items, to a CD.

Firstly, a relevant catalog for the files is created.
It is to contain all textures, objects and
materials. In addition the catalog will be located
in the root folder of the CD, so that you can
view and archive it directly.

You now create the entire archive on your
computer. On most systems you will have a
reserved hard drive partition which was defined
for such CD-ROM production. Only rarely
should you require more than the 650MB limit
of a CD-ROM for this work area.

A possible CD structure for your hard drive
might look like the following illustration.

The CD-ROM structure in the Mastering folder

So this is how the structure could look. You have
created and filled the folders with the relevant
contents. As we are just concerned with
browsing from here, only the three folders —
Mat, Obj, and Tex — are of any interest to us.
Or have we forgotten an important folder?

Of course ... we need to know where the
anchor folder is located.

Let’s look more closely. The CD will be called
C4D Tools. Thus the folder of the same name
within the mastering partition forms the anchor.
This is also where the catalog is to be located,
making it easily accessible. So, proceed as
follows:

- Start CINEMA 4D and open the Browser.

- Select File > Preferences.

- Enable the Recurse Folders option (see above)
as well as Pictures, Movies and Scenes (and,
depending on personal preference, from the
drop-down menu to the right of Scenes choose
Raytracer, which will cause a delay in catalog
creation, Gouraud Shading or Wireframe).

- Select File > New Catalog.

- Now each folder is added. Select File > Import
Folder. In the dialog select, for example, the
folder Mat. The catalog and the preview
pictures are created. Use the Import Folder
function twice more for the Obj and Tex
folders.

- Now Select File > Save Catalog as.

- In the system dialog define
‘Disk3:Mastering:C4D Tools’ as the location
and, say, ‘C4D Tools.cat’ as the name. This is
the most crucial (and also most difficult) step.
Now (and only now) does the Browser know
where it has to create relative paths.
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- Select File > Make Catalog Relative, so that
the Browser converts all information into
relative paths.

- Save the catalog with File > Save Catalog.

- You are now ready to master the CD.

To summarize:

If Make Catalog Relative is enabled, then
complete paths are no longer saved, instead
only the relative paths are used, starting from
the catalog folder. From this location the current
catalog folder and its sub-folders are scanned.

Tip

This method only works if you have named the
catalog and assigned the path with the Save
Catalog as command (see above) prior to
searching the catalog.

Close

This command closes the Browser. The current
catalog is removed from memory.

Edit Menu

Delete

Removes all selected pictures from the catalog.
The originals on the system disk remain
unaffected.

Select All

Selects all the preview pictures of the current
catalog.

Deselect All

Deselects all the preview pictures of the current
catalog.

Preferences

Thumbnail Size

This allows you to adjust (in pixels) the size of
the preview images in the Browser. The changes
are immediate, although actual recalculation
does not occur until later. The images are simply
scaled up or down.

The new calculation of all pictures is achieved by
the use of Render All from the Function menu
(see below).

Recurse Folders

If this option is checked, sub-folders are also
scanned for scene elements and displayed in the
Browser.

Pictures

If this option is active, pictures are displayed in
the Browser. All image formats unknown to
CINEMA 4D are ignored.

Movies

If this option is checked, animations are
displayed in the Browser. All animation formats
unknown to CINEMA 4D are ignored.
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Sounds

If this option is active, the waveforms of the
sound files are displayed in the Browser. All
sound formats unknown to CINEMA 4D are
ignored.

Function Curves

If this option is activated, function curves are
displayed in the Browser.

C.O.F.F.E.E. Files

If this option is activated, C.O.F.F.E.E. files are
displayed in the Browser.

Scenes

If this option is activated, scenes are shown in
the Browser. All scene formats that are not
recognized by CINEMA 4D are ignored.

You can use the pop-up menu to the right of
this option to determine whether scenes are
shaded in Wireframe or Gouraud or rendered
with the Raytracer. If Raytracer is selected,
shadows and refraction are not rendered and
only the floor and sky can be reflected.
However, each scene is antialiased.

Function Menu

Render All

Recalculates all preview pictures that exist in the
catalog.

This is necessary, for example, if you change the
picture size in the preferences or add or change
files in the directories. You can cancel the new
calculation at any time with the ESC key.

Information

Opens an information window for the current
preview and displays information, including the
complete path, picture resolution and color
depth.

Tip

This command is also accessible from within the
context menu (right-click).

You may be surprised, when you are using
relatively small textures in a scene, if the
computer alerts you to a lack of memory. It’s
easy to forget that images – and in particular,
animations – may take up far more RAM than
you would expect from their file size.

For example a compressed JPEG picture, which
on disk is just one megabyte in size, can quite
often need 10 or more megabytes of memory to
display. Using several such compressed files in
the Browser, the existing memory of your
computer melts like ice cream in a desert!

Using the information window of the Browser,
you can easily monitor the relevant values (file
size and actual memory requirement) and avoid
unpleasant surprises while working on a project.
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On the right-hand side of the information
window is an area where you can enter your
own comments e.g. copyright notes, latest
changes etc.

These comments may run to many lines and up to
255 characters. A comment can be displayed from
within the Browser itself. To do this, simply leave
the mouse pointer over a preview picture for a
couple of seconds. As with command palettes (see
Command Palettes, page 35), an information box
will open under the mouse pointer.

To begin a new text line, simply press the Enter
or Return key. This method means that this
dialog window must be closed with the mouse
by clicking on OK or Cancel.

Tip

The contents of the comment field can also be
searched (see below). The Browser thus
effectively becomes a small picture database.

Tip

If the Browser finds a text file with the name
'Readme.txt' when scanning a folder, its
contents will be automatically transferred to the
information dialog of each thumbnail picture of
the folder, space permitting.

Search For

Scans the name and/or comment fields of the
current database of the Browser for the text
entered.

Tip

This command is also accessible from the
context menu (right-click).

You may use the Browser to scan for filenames
and/or comments. Simply choose the criteria by
checking the relevant box and enter the text or
value you wish to search for in the field to the
right. All thumbnails that match the find will be
outlined in the catalog.

Sort By

Use the sub-entries of this menu to define the
sort sequence of the current catalog in the
Browser.

Alternatively you may sort according to filename
or file size. Items are always sorted in ascending
order, i.e. the list starts with the smallest images
and ends with the largest.
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Initialisation Files
CINEMA 4D loads several initialisation files
during startup. The content of these files is
integrated into the layout.

Template.c4d

During startup, CINEMA 4D checks its root
folder for a file called ‘Template.c4d’. If the file
is present, its settings are loaded and are used as
default values.

This can be very effective if you keep using the
same scene-specific settings (e.g. several
different render settings).

For an overview of all the settings which are
saved with the scene file, see page 29.

New.c4d

When you create a new file (main menu
File > New), CINEMA 4D checks its root folder
for a file called ‘New.c4d’. If the file is present,
its settings are loaded and are used as default
values.

For example, to activate antialiasing permanently,
create a new file, change the values in the Render
Settings accordingly, then save the file into the
same folder as the CINEMA 4D program using the
filename ‘New’ (the ‘.c4d’ file extension will be
appended automatically).

Template.cat

During startup, CINEMA 4D checks its root
folder for a file called ‘Template.cat’. If the file is
present, it is loaded into the Browser
automatically.

This can be useful, for example, when you are
working on a large project and wish to have all the
associated textures and/or scenes available

immediately after startup. In this case, create a
catalog which shows all the required files. Then,
save the catalog in CINEMA 4D’s root folder with
the name ‘Template’ (CINEMA 4D will append
‘.CAT’ automatically). The Browser will contain the
catalog the next time you launch CINEMA 4D.

For more information on the Browser, see
page 61.

Note

If the template catalog is very large (lots of
preview pictures), expect a short delay during
startup.

Template.l4d

During startup, CINEMA 4D checks its root
folder for a file called ‘Template.l4d’. If the file is
present, it is loaded and used as the active
layout.

You can create this file in one of two ways:

- Activate the Save Layout at Program End
option in the General Settings (see page 45).
The template layout will be created
automatically when you quit CINEMA 4D —
each time you quit, for as long as the option is
activated!

- Create the template layout manually using the
function Window > Layout > Create Default
Layout (main menu).
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5. File Menu   
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New

This command opens a new document and
makes it the active (current) document. All icons
that are selected from the toolbar, and
commands from any of the menus or managers
then refer to this new document.

Until you save the new document and give it a
name, the title bar of the document window will
show ‘Untitled’.

If you have several documents open you can
switch quickly between them using the main
Window menu.

Open

This command loads a file (a scene, a material,
etc.) from a storage device (such as a hard disk)
into memory and opens it in a new document
window. If the current document window is
empty, this is used instead.

The following formats are understood and may
be imported by CINEMA 4D:

- CINEMA 4D scenes (‘.c4d’), catalogs (‘.cat’),
preferences (‘.prf’)

- DXF to AutoCAD R12

- QuickDraw 3D (‘.3dm’) (binary only, not
ASCII)

- VRML V1 and V2 (‘.wrl’)

5 File Menu
There are several ways of starting CINEMA 4D:

- Double-click on the program icon.

- Double-click on a scene file.

- You can also drag one or more CINEMA 4D
files in the Explorer (Windows) or the Finder
(Macintosh) on to the CINEMA 4D icon (drag-
and-drop).

The File ‘New.c4d’

In the CINEMA 4D startup folder you will find a
scene with the name ‘New.c4d’; this is always
loaded into CINEMA 4D (complete with the
settings associated with it) when you create a
new file. Thus, CINEMA 4D does not use a
separate preferences file.

For example, to activate antialiasing permanently,
create a new file, change the values in the Render
Settings accordingly, then save the file into the
same folder as the CINEMA 4D program using the
filename ‘New’ (the ‘.c4d’ file extension will be
appended automatically).

The File ‘Template.c4d’

In the CINEMA 4D startup folder, there is also a
scene with the name ‘Template.c4d’; this is
loaded, together with its associated preferences,
automatically when CINEMA 4D is launched
(and only then, in contrast to ‘New.c4d’),
allowing preferences to be set at startup.
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- 3D studio R4 (‘.3ds’) (including materials, light
sources, textures and animation).

- Wavefront (‘.obj’)

– LightWave 3D (.lwo, .lws), LightWave [6]
objects (incl. textures, UV coordinates, weight
maps) and scene files (incl. lights, camera focal
length) can be loaded.

- DEM scenery files (‘.dem’)

- Illustrator paths as polygons (‘.ai’, ‘.art’, ‘.eps’)

Recognition of these formats is automatic.
Filename extensions (Windows) are superfluous,
as are types and creators (Macintosh).

You can also use this command to view images
or load other settings.

Alternatively, you can open a new file by
dragging it and dropping it on a viewport.

Merge

This command lets you add scenes, objects,
materials etc. into the active document.

Revert to Saved

This command will load the most recently saved
version. Before this happens, a dialog opens
asking for confirmation. You will lose any
changes that were made to the current
document after it was last saved.

Close

Closes the active document. If it contains any
unsaved changes, a dialog opens asking if you
want to save the scene before closing it.

Close All

Closes all open documents. If any documents
contains unsaved changes, a dialog opens
asking if you want to save the scene before
closing it.

Save

This command saves your document without
first opening the file selector. The scene is saved
using the name chosen when you selected the
Save as command (i.e. the name that appears in
the title bar). If this is the first time you are
saving a new document and it does not have a
name yet, then the Save command behaves just
like Save as.
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Save as

Save as always displays the file selector. The
filename you enter here will be displayed in the
title bar of the document window. CINEMA 4D
automatically appends the appropriate extension
(‘.c4d’ for scenes) to the filename.

Save All

This function saves all open documents. If a
scene has not yet been saved (and therefore is
untitled), the appropriate system file selector
opens for you to choose a name and path.

Save Project

Transferring scenes from one computer to
another is always particularly challenging for a
project leader. When the question of missing
textures for materials arises, you know that
these can be found automatically in your own
local texture paths (Texture Paths tab in the
General Settings dialog).

CINEMA 4D helps you build complete scenes.

Selecting this command opens the usual system
file selector for saving files. Choose a folder here-
and enter a name. CINEMA 4D creates a new
folder in the specified path and saves the scene

there. In addition, it creates a sub-folder, named
Tex, into which it copies all the pictures and
textures necessary for rendering the scene.

There is now nothing to stop you moving the
project to another system.

Export
A scene can also be exported to a foreign file
format for subsequent work in other 3D
software. The filetypes described below are
available. CINEMA 4D automatically adds the
relevant file extension to the file.

Each 3D program works differently, therefore it
is not always possible to convert all information
within a scene. Further, the result will always
differ according to the materials and lighting
used, so a manual re-working may often be
necessary.

3D Studio R4 (.3DS)

Common data format under DOS/Windows.
3D Studio was the predecessor to 3D Studio
MAX. The last freely available file format is
release 4; the MAX data format is not available
to other manufacturers.

In principle the MAX format is not generally
readable since MAX (like CINEMA 4D) uses
parametric objects, which are useless without
their associated specific algorithm. For example
a teapot is not saved with points and surfaces,
but only with the dimensions and the
subdivision rate. For recreating the surfaces (to
display the teapot on the screen) one needs to
know the internal routines of MAX. Therefore,
because of this, there is also no external
conversion tool for the MAX format.
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Direct3D / DirectX (X)

Direct3D is a Microsoft specific 3D format,
which is used by Windows (provided DirectX is
installed). This export module is particularly
useful to game developers.

DXF (DXF)

The standard exchange format for graphics files.
CINEMA 4D splines are generally written as
polylines, independent of the surface settings
for polygons.

QuickDraw 3D (3DM)

The standard format for three-dimensional
graphics on the Apple Macintosh.

VRML 1 (WRL)

The Virtual Reality Modeling Language enables
you to produce platform-independent three-
dimensional representation of objects and scenes
on the Internet. It has also proved useful as an
exchange format for CAD programs, since it
contains more file information than the often-used
DXF format.

VRML 2 (WRL)

Version 2 of the standard format for three-
dimensional graphics files on the Internet enables
you to display animation sequences. The
advantages for data exchange with CAD software
mentioned above also apply to VRML 2.

Wavefront (OBJ)

A common 3D data format in the UNIX world,
developed by Alias.

XML – CINEMA 4D XL R6

XML is a standardized language for file
exchange. This export is mainly targeted at
plug-in developers who can better integrate
their extensions into the file. If interested you
can find detailed information about this format
at www.xml.org.

Import / Export Settings

3D Studio R4

Factor

This is for specifying whether and to what
degree 3D Studio files are scaled when they are
loaded and saved.

Adapt Textures

3D Studio does not support as many graphics
file formats for textures etc. as CINEMA 4D. Its
main format is TIFF.

If you enable this option, all texture filename
extensions are changed to that which you have
specified (for example ‘frame.jpg’ becomes
‘frame.tif’).

However, you will still have to do the actual
conversion of the images yourself. This is very
simple if you use one of the graphics programs
that are provided with the package (PaintShop
Pro or Graphics Converter).



CHAPTER 5 • FILE MENU • 77

Biovision BVH

This import module is implemented as a plug-in
(Plugins/BVH folder). It enables you to use
Biovision motion data with your animations. For
an example of importing and modifying BVH
data, see page 574.

DEM

DEM files are used in geography and are often
used for the description of landscapes. This
format can be imported only.

Factor

Use this to determine whether and how much
DEM files are scaled when they are loaded.

Direct3D / DirectX

Factor

This is the scaling factor for saving the scene in
this format. When exported, the scene is
reduced by this factor.

Format

Direct3D is a text format. To facilitate manual
editing of the file, this option formats the whole
file automatically. This increases the file size
somewhat.

Save Templates

When enabled, the template header is written to
the file.

Export Textures

When enabled, all texture information is saved
for all objects. This includes creating UV
coordinates for each object.

Adapt Textures

DirectX uses mainly the PPM (portable pixel
map) graphics format, but also BMP (Windows
bitmap). CINEMA 4D does not recognise the
former, which means that textures need to be
converted.

This can easily be done using the graphics
programs PaintShop Pro or Graphics Converter,
which are provided in the package. But what
about adapting the names?

If you enable this option, all texture filename
extensions of scene materials are automatically
changed when they are imported (so that
‘image.jpg’ becomes ‘image.ppm’). This has the
benefit that you do not need to check for each
material and for each attribute whether a
change of name is required.
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Note

This really does only change the name. You still
need to convert the image!

Note that DirectX can only process graphics
measuring 2n pixels (textures need to be 2x2,
4x4, 8x8, 16x16, 32x32, 64x64, 128x128,
256x256 and so on).

Save Normals

If this option is enabled, normal vectors are
created for all surfaces. If not, calculating the
normals is left to Direct3D.

Generate Mesh

Direct3D works with two types of models;
Frame and Mesh.

Frames, as with CINEMA 4D, consist of objects
arranged in a hierarchical structure. Objects
remain encapsulated.

In a mesh, on the other hand, all objects are on
the same level. The hierarchy disappears.

DXF

CINEMA 4D can work with DXF files of all
versions. It can correctly interpret the following
elements: SOLID, 3DFACE, LINE, POLYLINE,
CIRCLE, ARC, POINT and TRACE. All three-
dimensional data is read in accurately.

All documented POLYLINE combinations as well
as height and elevation data are supported. The
same is true of element coordinate systems,
layer names and various line thicknesses.

Factor

This specifies whether and to what extent DXF
files are scaled during loading and saving.

Circle

This determines the number of polygon segments
that are used for subdividing circle segments.

Frozen Layers

Enable this option if you want to convert frozen
layers of a DXF file when loading. Many CAD
programs offer the option of freezing (i.e.
hiding) temporary or unused layers.

2D Elements

This specifies whether or not two-dimensional
DXF elements should be converted when
loading a file.

Align Normals

CINEMA 4D assumes that all surfaces of an
object are uniformly aligned. This is not
necessarily the case with DXF files.

If adjacent surfaces are differently aligned, their
normal vectors point in a different direction.
During rendering, this can result in undesirable
color jumps. CINEMA 4D uses this option to re-
align all adjacent surfaces in the same direction.

Triangulate Polygons

DXF files may contain three-dimensional polygons.
CINEMA 4D can triangulate these if this option is
enabled. This means that the inscribed surface is
generated as a 3D object. This is useful in most
cases, and it is therefore the default setting.
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Unless the option is disabled, polygon lines are
converted as such, which is useful for further
processing in CINEMA 4D.

Layer

DXF files often consist of a great number of
small elements. When this option is enabled,
CINEMA 4D attempts during a load to combine
elements of the same color (Connect by Color)
or of the same layer (Connect by Layer). If you
wish to prevent this, use Don’t Connect.

Export

The DXF standard offers several options for saving
an object. Here you can choose the type into
which the object is converted when being saved.
The choices are Polyline, Solid and 3DFace.

Illustrator

If you want a high-quality 2D vector graphic
(e.g. a company logo) to be three-dimensional,
then import it in the Illustrator format.

Also vector graphics from other programs, such
as Macromedia’s FreeHand or CorelDraw, can
be imported if they were saved in Illustrator
format.

Please also read about how to export files in the
relevant product manuals.

Factor

Use this to determine whether and how much
Illustrator files are scaled when they are loaded.

LightWave

When opening a LightWave file, not just object
geometry is imported. Also imported are the
complete scene, the camera focal length (of
particular interest to those who use 3D camera
tracking software such as MatchMover or 3D-
Equalizer), texture maps, animation sequences
and bones information. Additionally, UV
coordinates and weight maps of LightWave [6]
are imported.

Factor

This specifies whether and to what extent
LightWave files are scaled during loading and
saving. The default value is 100, since LightWave
uses a smaller construction scale than CINEMA 4D.

Textures

This lets you decide whether CINEMA 4D
should import a LightWave object’s texture
information.

Lights

This lets you decide whether CINEMA 4D
should import a LightWave object’s light source
information.

Split selections

In LightWave 3D it is possible to have so called
'double sided' polygons. When opening such an
object CINEMA 4D creates double polygons,
which can produce rendering artifacts. If you
have such objects in your LightWave scene,
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activate this option. You will end up with two
grouped objects one of which may be deleted if
you no longer require it.

QuickDraw 3D

Factor

Use this to determine whether and how much
QuickDraw 3D files are scaled when they are
loaded.

Sphere

Use this to specify whether and to what extent
QuickDraw 3D spheres are triangulated during
loading.

Cone/Cylinders

Use this to specify whether and to what extent
QuickDraw 3D cones and cylinders are
triangulated during loading.

NURBS

Use this to specify whether and to what extent
QuickDraw 3D NURBS are triangulated during
loading.

Save Textures

If this option is enabled, all objects are saved with
their textures (including any UV coordinates).

If this option is disabled, objects are saved with
their color information only (i.e. without
textures).

Maximum

CINEMA 4D allows you to use any size of
texture — provided of course that you have
plenty of memory. However, when viewing a
scene it can be irritating to wait for textures
which are very large to load.

This option lets you restrict the size of
QuickDraw 3D files. The material images are
scaled to the specified value (in pixels); the
proportions remain intact.

Note

If imported QuickDraw 3D models contain
textures you have the option when loading them
to either ignore them or to save them separately.

VRML 1

Factor

This is for specifying whether and to what
degree VRML files are scaled when they are
loaded and saved.



CHAPTER 5 • FILE MENU • 81

Optimize Hierarchy

If Optimize Hierarchy is enabled, the scene
structure will be optimized once the VRML1 file
has been loaded. Superfluous dummy objects
will be removed and the object hierarchy will be
optimized. This creates a clearer overview,
helping you to work more quickly.

Format Text

VRML is a text format. To facilitate manual
editing of the file, this option carries out
automatic formatting on the entire text file
during export.

Backface Culling

This option enables an attribute on all exported
objects which switches off drawing of the non-
visible sides of all objects in the web browser.
This gives a much faster display.

Textures

This menu specifies the action CINEMA 4D is to
take when exporting textures.

None ignores the textures and saves only color
information.

Referenced means objects are saved with the
paths to the textures.

With File saves all textures directly in the VRML
file (so-called inline textures). Any UV
coordinates are also saved.

Maximum

CINEMA 4D allows you to use any size of
texture — provided of course you have plenty
of memory. However, when viewing a scene it
can be irritating to wait for textures which are
very large to load.

This option lets you restrict the size of VRML
files. The material images are scaled to the
specified value (in pixels); the proportions
remain intact.

Note

If imported VRML models contain textures you
have the option when loading them to either
ignore them or to save them separately.

VRML 2

Factor

This is for specifying whether and to what
degree VRML files are scaled when they are
loaded and saved.

Optimize Hierarchy

If Optimize Hierarchy is selected, the scene
structure will be optimized once the VRML2 file
has been loaded. Superfluous dummy objects
will be removed and the object hierarchy will be
optimized. This creates a clearer overview,
helping you to work more quickly.
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Format Text

VRML2 is a text format. To facilitate manual
editing of the file, this option carries out
automatic formatting on the entire text file
during export.

Backface Culling

This option enables an attribute on all exported
objects which disables the drawing of the non-
visible sides of all objects in the web browser.
This gives a much faster display.

Save Animation

Enable this option if you want animation
information to be included when you save
scenes in the VRML 2 format.

Keys/Second

This defines the frequency of they keys for
animation export.

VRML2 supports linear interpolation only, so
you may need to increase the setting for greater
accuracy. Values from 5 to 25 are common.

Textures

This menu specifies the action CINEMA 4D is to
take when exporting textures.

None ignores the textures and saves only color
information.

Referenced means objects are saved with the
paths to the textures.

With File saves all textures directly in the VRML
file (so-called 'inline' textures).

Any UV coordinates are also saved.

Maximum

VRML-2 provides two options for making
textures available to their objects:

The first option is identical to the one used in
CINEMA 4D; a reference to the texture file is
saved along with the VRML scene. If you want
to go with this option, specify the value 0.

The second option integrates the graphics data
directly into the VRML-2 file.

Since the texture is written uncompressed, in
text format, a texture of 1000x1000 pixels
quickly reaches a file size of 4MB. If you wish to
avoid having such large files, you can specify a
value (larger than 0), to restrict the size of
textures. The materials are then scaled to that
value (in pixels). The proportions remain intact.

If you have a texture of 800x600 pixels and you
set a maximum value of 100, the texture is
proportionally scaled down to a size of 100x75
pixels before being saved.

Note

If imported VRML models contain textures you
have the option when loading them to either
ignore them or to save them separately.

Wavefront

Factor

This specifies whether and to what extent
Wavefront files are scaled during loading and
saving.

Recent Files
CINEMA 4D remembers the files opened last
and lists them in this sub-menu for quick access.
You can define the maximum number of
remembered files in Edit > General Settings.

Quit
This command quits CINEMA 4D.
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6 Edit Menu
The Edit menu contains some of the most
frequently used functions in CINEMA 4D – like
Undo. These functions are of such fundamental
importance that you will find them on most
local Edit menus.

In this chapter, the internal buffers and the
drawing pipeline are both explained. Please do
not skip over this theory – it is relevant because
it helps you avoid or solve certain problems.

Multiple Undo
CINEMA 4D has multiple-undo, which means
that a single undo can reverse multiple actions
that logically belong together. Confused? Here’s
the explanation:

Imagine you have 10 objects in the Object
manager, then you use the Group Objects
command to place them into a group. Internally,
12 actions are required: first a new (null) object
is created, then 10 transfer actions place the
objects into the null object, finally the null object
is activated. CINEMA 4D’s intelligent undo
recognizes that these 12 actions belong together
and it will treat them as though they were one
action, i.e. you can undo all 12 actions with a
single undo command.

Not only does CINEMA 4D have multiple undo,
it also differentiates between memory-intensive
actions and non-memory-intensive actions.

Examples of memory-intensive actions include the
deletion of an object and the movement of an
object’s points. Non-memory-intensive actions
include the activation of an object and the

renaming of an object. Non-memory-intensive
actions can be recalled 10 times more than the
Undo Depth value in the general settings.

For example, with an undo depth of 12 you can
undo either 12 delete object actions or 120
activate object actions. You can also mix both
types of action, e.g. you can undo 6 delete
object actions and 60 select object actions.

The Undo Buffer

When you perform an action in CINEMA 4D,
information about that action is written to an
area of memory referred to as the undo buffer.
The Undo and Redo functions use the
information in the undo buffer to revert the
scene to a previous state.

Example:

- Imagine that you create an object and then
change its scale to (400/400/400) units. Next,
you move the object to coordinates (100/-
300/0).

- The undo buffer would then contain the
following action history:
1. Create object at position (0/0/0)
2. Scale object to (400/400/400) units
3. Move object to position (100/–300/0)

- The buffer’s current state is step 3, the move
action. If you call the Undo function,
CINEMA 4D will undo the current state
(move), then set the current state to step 2
(scale).

- If you call the Undo function again, the scale
action is undone and the current state is set to
step 1 (create).
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- What particularly interests us here is that
throughout the process the buffer content
itself is not altered — nothing is deleted. As a
result, you can restore the undone actions with
the Redo function.

- You can use Undo to move backwards through
the undo buffer. Redo will advance you
through the buffer.

- Recall that nothing is deleted from the buffer.
There must, however, be some constraint on
the size of the buffer to prevent it taking up
too much memory. This is the purpose of Undo
Depth in the general settings — it specifies the
maximum number of actions that can be
undone (see Undo Depth, page 45).

Note

Some functions, such as Save and General
Settings, are not recorded in the undo buffer and
subsequently cannot be undone.

Undo / Undo View

This function will reverse the last change you
made, restoring the scene to its previous state. If,
for example, you move an object by accident,
Undo will put the object back into position.

You can select Undo repeatedly to continually
reverse actions. By default, you can undo a
maximum of 10 changes. We refer to the number
of actions that you can reverse as the undo depth.
You can set the undo depth in the program
settings (see General Settings, page 45).

In a viewport, Undo View operates exclusively
on the editor camera. It will not affect camera
objects. You can undo a maximum of 500 editor
camera changes.

Redo / Redo View

Redo will restore the last action that was
undone (see Undo, above). You can select Redo
repeatedly to continue restoring the actions.

You can traverse the recent development stages
of your scene by using Undo to move
backwards and Redo to move forwards.

Naturally, the number of steps you can redo
cannot possibly be greater than the number of
actions you have undone. Therefore, there is no
separate setting for the redo depth in the
program settings.

In a viewport, Redo View operates exclusively
on the editor camera. It will not affect camera
objects. You can redo a maximum of 500 editor
camera changes.

Undo (Action)

This function differs from the conventional undo
command in that it ignores selection actions.
Undo (Action) will reverse the last action that
did not involve selection.

Why would you want to ignore selection actions?

Imagine that you increased the size of an object
and then you used 10 selection actions to select
points in various locations. Suddenly, you decide
that the object is too big and you want to restore it
to its original size. This would require you to call
the conventional undo command 11 times (you
must undo the 10 selection actions and then finally
the scale action).
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If, however, you use Undo (Action), it skips over
the selection actions and reverses the scale action
in one go.

Let’s look at a few examples (A stands for a
normal reversible action, e.g. Move; S stands for
a reversible selection action):

Example 1

You’ve been editing for a while. The undo
buffer contains the following sequence.

A S A S A A A S S S S

i.e. the buffer starts with a normal action, which
is followed by a selection action, which is
followed by a normal action, and so on.

There are four consecutive selection actions at
the end of the buffer. The final, most-recent,
selection action is right-most and represents the
current state of the undo buffer.

If we call the normal undo function, the
resulting buffer is:

A S A S A A A S S S

Only the final selection has been removed —
there are still three selection actions at the end
of the buffer.

However, if we use the Undo (Action) function
instead of the normal undo we get:

A S A S A A

Can you see how it works? The first normal
action has been removed as well as all the
selections that happened to be in front of it.

Example 2

In this example the undo buffer contains
selection actions only:

S S S S

The final, most-recent, selection action is right-
most and represents the current state of the
undo buffer. If we call the normal undo
function, the resulting buffer is:

S S S

If, however, we use the Undo (Action) function
instead of the normal undo, we get:

S S S S

Nothing has been undone. Why?

The buffer contains selection actions only —
there are no normal actions. Undo (Action)
reverts the scene to its state prior to the last
normal action. So if there are no normal actions
at all in the buffer, the buffer remains
unchanged.
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The Clipboard
When you use the Cut or Copy commands, the
active object or element is copied into a
structure in memory known as the clipboard.

When you select the Paste command, the data in
the clipboard is inserted into the current scene.

For example, to copy an object from one scene
to another scene; open both scenes, activate the
scene that contains the object, copy the object,
activate the other scene and then paste.

The clipboard can hold only one data element at
a time. If you want to copy several objects,
group the objects first, then copy the group.

The size of the clipboard is determined by the
size of the data stored there. If, for example,
you copy an 18MB object, the clipboard will use
18MB of memory. Naturally, you may want to
purge the clipboard (e.g. before you render) to
free up memory. You can purge the clipboard by
cutting a null object (see Null Object, page 95) -
the null object wastes only a few bytes.

Cut

This function deletes the active object or active
element from the current scene and copies it
(including its materials) to the clipboard. The
object can be copied back from the clipboard
with the Paste function (see below).

Copy

The Copy function copies the active object or
element (including its materials) to the
clipboard. The object can be copied from the
clipboard to the active scene with the Paste
function (see below). You can paste repeatedly
to create additional copies.

Note

You can copy and paste objects using drag-and-
drop in the Object manager. Keep the Ctrl key
held down while you grab the object’s name
with the mouse and drop it elsewhere within the
Object manager. The first copy takes the name
of the original and appends ‘.1’. The first copy of
‘Apple’ will be called ‘Apple.1’, the second copy
will be called ‘Apple.2’ and so on.

Paste

This function inserts the contents of the
clipboard (i.e. the last object that was cut or
copied there) into the active scene.

Delete

This function deletes the active object or element
from the current scene without copying it to the
clipboard.
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Selection

Select All

This function selects all the objects in the scene.
If it is not possible to select all the objects
directly, the objects will be placed in a group
and the group will be selected.

If the Points tool is active (see Points, page 302)
when you call Select All, all the points of the
active object will be selected. Similarly, if the
Polygon tool is active, all the polygons of the
active object will be selected.

Deselect All

This function deselects all the active objects or
elements. If the Points tool (see Points,
page 302) is active when you invoke Deselect
All, all the points of the active object will be
deselected.

Similarly, if the Polygon tool is active, all the
polygons of the active object will be deselected.

The Drawing Pipeline
One of CINEMA 4D’s prime features is its
realtime preview, e.g. realtime deformation
editing in the viewports.

To facilitate this feature, the various actions
involved must take place in a predefined order.

Suppose that you have created a Cube object.
You then assign an expression, which distorts
the cube in a particular way. Next, you assign a
Bend deformation object to the Cube. Which
action should take place first? Should the cube
be bent first, then distorted, or should the cube
be distorted and then bent? Two entirely
different outcomes are possible depending on
which action takes place first.

Assume you have an object that is animated
from point A to point B, yet at the same time
you have given it an expression that tells it to
move to point C. The object cannot be in both
places at the same time, so who wins?

The winner is whichever one is evaluated last of
all – if the expression is evaluated first, the
animation overwrites the expression and the
object comes to rest at point B; if the animation
is evaluated first, the expression overwrites it
and the object ends up at point C.

The order in which actions are processed is what
we refer to as the 'pipeline' — actions take place
one after the other, as though they are flowing
through a pipe. Since the whole process
determines what is ultimately drawn on the screen,
the entire concept is termed 'the drawing pipeline'.

You need to be aware of the drawing pipeline so
that you can predict the outcome of applying
several functions simultaneously.
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Animation

Animation refers to any data that is stored in the
Time Line (see Time Line, page 557). Although
expressions can animate an object, expressions
are treated as a separate data type.

Evaluation Order

Tracks are evaluated from bottom to top in the
Time Line, beginning with parent objects. The
child objects (sub-objects) are then evaluated
according to the hierarchy; to see the hierarchy
in the Object manager (see Expand Object
Group, page 478), open the entire structure for
a complex object group.

The objects are evaluated from top to bottom in
the order you see here.

What happens if you have allocated two
different position tracks (e.g. one from A to B,
the other from A to C) to the same object?

The track which is top-most in the Time Line will
be evaluated last of all and will overwrite the
previous movement. So, if track A-to-B is above
track A-to-C in the Time Line, the object will
move from A to B.

Expressions

Expressions are evaluated from left to right as
they appear in the Object manager.

An expression is a behavioral property that can be
added to an object. It gives instructions to the
object. Expressions use C.O.F.F.E.E., CINEMA 4D’s
built-in programming language, and thereby have
access to all of an object’s parameters.

An expression could, for example, simulate muscle
bulge by controlling the strength of a displacement
texture according to the angle between the upper
and lower arm of a figure. Another example might
be to change the texture color used by a house
according to the state of a sun object.

Evaluation Order

Expressions are evaluated from left to right as
they appear in the Object manager.

First the parent object is evaluated, then the
order continues along the hierarchy tree; to see
this tree, open the entire structure for a complex
object group in the Object manager (see Expand
Object Group, page 478). The objects are
evaluated from top to bottom in the order you
see them.

Generators

Generators are objects that create temporary
hierarchical structures. For example, a NURBS
object generates a temporary polygon object for
display purposes. You can convert the
temporary object into a real object if required.
See Current State To Object, page 385.

Generators include NURBS objects, the particle
system, the array, the symmetry object, polygon
primitives, spline primitives, instances, metaballs
and so on.

Evaluation Order

Generators are evaluated starting with the sub-
objects, then evaluation moves up the hierarchy
tree; to see this tree, open the entire structure
for a complex object group in the Object
manager (see Expand Object Group, page 478).
The objects are evaluated from top to bottom in
the order you see them.

Deformers

Deformers are the functions listed in the Objects
> Deformation menu and include Explosion,
FFD, Bone and Magnet.

A deformer deforms the (single) object that it is
applied to. The deformation is applied to a virtual
copy of the source object so that the original
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geometry is preserved and can always be restored.
The Polygon Reduction function also performs
in this way and is therefore classed as a
deformer.

The main difference between expressions and
deformers is that expressions are processed before
the (virtual) copy is created, whereas deformers
are processed after the copy is created.

Evaluation Order

Deformers are evaluated starting with the sub-
objects, then evaluation moves up the hierarchy
tree; to see this tree, open the entire structure
for a complex object group in the Object
manager (see Expand Object Group, page 478).
The objects are evaluated from top to bottom in
the order you see them.

Here is an example to explain why the evaluation
order for deformers and generators begins at the
sub-object level:

A loft NURBS (Loft NURBS, page 163) creates a
temporary polygon object for display purposes —
it is a generator. Imagine that the splines which
describe the loft NURBS are themselves deformed
by several FFD objects (deformers). The hierarchy
tree might look as in the illustration below.

It is only possible for the FFDs (sub-objects of
the splines) to deform the splines before they
are used by the NURBS object if the evaluation
order is from the bottom of the hierarchy tree to
the top.

The Display Order

We have addressed the order in which elements
of the same data type are evaluated, but what is
the evaluation order for elements of differing
type? Again, the display pipeline works to a
strict order:

- First, all animation data is evaluated.

- Next, the expressions are evaluated.

- Finally, and with top priority, the generators
and deformers are evaluated.

It is a good idea to remember this sequence.

The drawing pipeline is evaluated each time you
perform a new action in CINEMA 4D. Although
this appears to be an overhead, it makes it
possible, for example, to apply a target
expression to an object then see it move
automatically as you move the target object
around in a viewport.

You are able to work with objects live – there is
no need to move the time slider or play back the
animation to update the scene. This is
particularly useful with inverse kinematics (see
Inverse Kinematics, page 307) since you can
work with interactive (live) targets.
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Use Animation

Use Expressions

Use Generators

Use Deformers

These functions turn on or off specific elements
of the drawing pipeline. If an element is turned
off, its data will no longer be evaluated in the
viewports. If, for example, you turn off
deformers, all objects will appear in their
undeformed state.

Example:

- Allocate a target expression to an object and
enable Use Expressions. Now you will be
unable to rotate the object manually.

Another Example:

- Assume you have created a simple position
animation (movement from A to B) using
keyframing (see page 564). You will be unable
to move the object from its path – it hops back
immediately.

- If you want the object to pass through point C
on its journey from A to B, disable Use
Animation, move the object accordingly,
record the new key for point C, the enable Use
Animation.

Tip

Should you encounter unexpected results in
CINEMA 4D, check the drawing pipeline first.

Settings

Project Settings
These are local settings which apply to the
active project only. These settings are described
in Project Settings, page 56.

General Settings

The general settings allow you to change the
appearance and behaviour of CINEMA 4D. The
numerous options are explained in detail in
General Settings, page 43.
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7 Objects Menu

Null Object

The null object might well mutter to itself “I
cannot do anything, I’m nothing”. And that’s
right ... almost.

If you call this function, CINEMA 4D creates
only an empty axis system in the 3D space. The
object contains neither points nor surfaces and
cannot be edited in the normal way.

So why use a null object?

Well, the null object can have other objects
placed within it. So it is useful for grouping
matching elements of a scene. Null objects are
also created by an automatic grouping in the
Object manager (Group Objects, page 478).

A further possible application is as a handle in IK
chains (see Inverse Kinematics, page 307). Here
you create a null object as the last part of an IK
chain. Then use the null object rather than the true
objects to move the inverse kinematics chain.

The advantage? Well, normally if you move, say,
the hand at the end of an arm of a figure by IK,
the hand itself remains rigid. This is avoided by
the use of such a dummy object at the end of
the chain.

Let’s not forget one of the most frequently used
applications of the null object; its use as a
dummy object for accurate rotation of
previously rotated objects.

As long as the axes of an object lie parallel to
those of its parent system (with newly created
objects the parent is the world coordinates
system), an object rotates around its Y axis (a
heading rotation). However, if the object, or its
local object coordinate system, is already rotated
(so that its axes are not parallel to those of its
parent), the result often astonishes even the
most experienced 3D designers.

Left: rotation with parallel axes systems, Right: with an already
rotated object system (in each case the final rotation is through
90°.

The use of a null object gives the desired result.
Here the null object and the object which is to
be rotated lie on top of each other. The axes of
the two objects have the same direction and —
quite importantly! — the object in question is
within the hierarchy of the null object.

Correct rotation behavior through the use of a null object

In addition, some actions that rely on a
particular orientation of an object in 3D space
(such as the duplicating of objects) profit from
the use of a parental null object.

You can read more on this topic in Rotation,
page 298 and in Duplicate, page 386.
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Animations with particles represent a further
problem that null objects can help with (see also
Particle System, page 235, and Particle
Animation Examples, page 245). Assume you
move an object from A to B, record this as a
position track for the object and then place this
in an emitter. What happens? The objects simply
fly from the emitter, as if they had never heard
of the phrase 'position animation'.

The solution is to use a null object. Put the
animated object into the null object and then
the null object into the emitter. The result is
that, as you intended, all emitted particles
follow the position track you defined.

Polygon Object

This creates an empty polygon object. Initially, it
is recognizable on the screen only by its origin
and its axes.

You can later fill this object with points and
surfaces (polygons). You can read more on this
in Add Points on page 353, Create Polygon on
page 359, and Import ASCII Data on page 629.

As an alternative to the null object (see above),
the polygon object can also be used for
grouping other objects.

Tip

Do not confuse the polygon object with the spline
object (see below). Both are initially empty
containers; however the former can accept only
polygon vertices (and surfaces) while the latter
accepts only spline vertices (and splines).

Primitives
All primitives within this menu are parametric,
i.e. they are created from mathematical
formulae using a number of preset values. A
consequence of this is that such an object is
initially simply a mathematical abstraction and is
not editable. In plain language this means that
such objects do not possess any points or
surfaces which you could manipulate.

To deform one of these primitives, say with the
Magnet tool (Magnet, page 366), it must first be
converted into polygons with the Make Editable
command (see Make Editable, page 353).

On the plus side, parametric means that, at any
time, you can change the parameter values of
an object (e.g. height, radius, etc.). This allows
you to play with the different parameters of an
object in order to get a feeling for how it looks,
behaves, etc.

However you choose a new object primitive, first
of all the relevant primitive is created in the scene.
The properties of such an object are reachable
within the Object manager in the parameter
dialog; double-click on the object icon to reach this
dialog (see Edit Object, page 478).

Alternatively you can double-click on the object
itself within the editor.

Often within these parameter dialogs you will
see a enable box for Segments; this allows you
to define the level of refinement of the
particular surface or solid. This is useful if you
are going to extend the object, perhaps to build
further, more complex, objects.

Consider a cylinder, out of which you would like
to form a curved rod. If this possesses only one
segment in the longitudinal direction, no
intermediate points exist between the beginning
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and the end and therefore it becomes impossible
to bend the object in this direction. The higher
the number of segments, the more smoothly the
object can be bent.

In addition, most objects are created with their
Smoothing property set (see Smoothing Tag,
page 463).

With smoothing assigned to an object it is
displayed using chamfers and this can,
occasionally, lead to unpleasant results.

In such a case you can delete the smoothing
property (but you will probably then need to
increase the segmentation), or change the
smoothing angle in the smoothing dialog until
you achieve the desired result. You may often
need to juggle segmentation and smoothing to
achieve a balance between quality and speed.

In the following illustration, the cylinder on the
left has smoothing turned on, in the center
smoothing is tuned off and on the right is the
optimized result.

In the illustration below is a curved cylinder, on the
left with 4 segments, in the center with 16
segments and to the right with 72 segments. You
can see how the increase in the segmentation
affects the softness of the deformed object.

You should always try to create an object with
as regular a segmentation as possible; this will
help the smoothing algorithm.

A parameter common to all the primitives is
Orientation; this lets you change how the object
lies in the 3D space. Thus you can quickly move
your object to lie in another direction. Notice
that the actual geometry is affected by an
orientation change, not the object axis system.

Interactive handles represent another way of
changing the object’s parameters; these are
displayed as small orange points. If you click on
one of these points, keep the mouse button
pressed and move the mouse in any direction,
the object changes its shape immediately; radii
become larger, lengths smaller, etc.

New objects are created either centred at the
world origin or centred within the viewport; this
behavior is changed in the General Settings
dialog (see General Settings, page 44).

In the following sections we will describe, in
sequence, each primitive. In each case we will
describe the options in the parameter dialog first
and then explain the behavior of the object
handles.
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Cone

This function creates a cone, whose base lies in
the XZ plane (but see below). With its various
options this object is substantially more flexible
than it appears at first sight. You want to create
a water drop? Or perhaps you need objects that
are often used in production technology, like
splined cones and cylinders (see Oil Tank, page
112). No problem — you’ll find these objects,
among many others, in the examples below.

Top Radius, Bottom Radius

These values define the upper and lower radii of
the cone. The top radius is, by default, zero i.e.
the object possesses a point here (see illustration
below, left). If this value is set higher than zero,

a truncated cone will be formed (below center).
If the top radius is equal to the bottom radius,
you will get a cylinder (below right).

Height

This value defines the overall height of the cone.

Height Segments

Defines the number of subdivisions of the object
in the Y direction.

Rotation Segments

Defines the number of subdivisions of the object
along its length. The larger this value, the more
round the cone will appear.

Cone with different subdivisions

Orientation

Choose a value from this pop-up menu to set
the cone’s initial position in space. Using this
you can turn the cone on its axis very simply
and, above all, quickly.
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Slice

Use this to slice up the cone. Think of an ice
cream bombe (well, why not), from which you
cut out a slice; the planes of section of the
remaining object are closed.

Different cone cutouts

Regular Grid

The Regular Grid option will be available if, and
only if, you have chosen to slice the object. By
enabling this option and entering a value alongside
you can control the subdivisions within the plane
of section of the sliced object. Small values
produce a fine subdivision while larger values
result in a coarse structure.

This subdividing only affects the face (the plane
of section) of the slice. You will need to use this
option only if you intend to process the object
further after slicing it.

Caps

With the option you can choose whether the
cone is capped on its top and base. If this option
is not enabled, you’re creating something like a
coffee filter.

On the left is a cone, on the right is one without caps

Cap Segments

This sets the number of subdivisions of the caps
in a radial direction. The subdivision along the
circumference of the caps is set from the value
defined in Rotation Segments (see above).

Fillet Segments

If you have chosen to fillet the top or bottom of
your cone, you can define the degree of filleting
or chamfering here. The larger the value, the
finer (or rounder) the fillet becomes. To achieve
a single chamfer, set the number of fillet
segments to 1. Below is a truncated cone whose
upper extent has been filleted. To the left is a
chamfer, in the center a rough fillet and, on the
right, a fine fillet.

On the left a fillet of 1 segment (a chamfer), in the center 3
fillet segments, on the right 10 fillet segments

Top Fillet, Bottom Fillet

Enable these according to where you want to
apply the fillet/chamfer.

Radius, Height

These values define the shape of the rounding
that is applied when filleting. If both values are
identical, the roundness is circular; if the values
are different, the roundness is elliptical.

The value for the radius here can be set up to
the value of the radius of the relevant part of
the cone; the value for the height can be set up
to the value of half the cone height.
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In the following illustration are some examples
of what one can create using the cone primitive.

Interactive editing

The cone has, initially, three handles — handle 1
(for the upper radius; initially zero) and handle 3
(for the height) lie one above the other.

The handles of the cone primitive

If you drag handle 1 you change the upper
radius. If you drag handle 2 you change the
lower radius. If you drag handle 3 you change
the cone height.

Tip

You will see that, for the height of the cone and
for the upper truncated cone radius, two handles
lie one above the other. Using the mouse alone

you can select and use the top handle; hold
down the Shift key and drag the mouse to get
the handle underneath.

If you enable the fillet options in the parameter
dialog (see above), two further handles appear for
controlling the upper and the lower rounding.

Additional handles of the cone primitive

If you drag handles 4 or 5 you change the width
of the fillet. If you drag handles 6 or 7 you
change the height of the fillet up or down.
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Cube

This function creates, by default, a cube whose
sides are parallel to the coordinate axes of the
world system. By adjusting the various options,
many arbitrary cuboids, optionally with rounded
edges, can be created.

Size — Width (X), Height (Y), Depth (Z)

The values for width, height and depth define
the size of the object. If all three are identical it’s
a cube, in all other cases a cuboid.

Segments — Width (X), Height (Y), Depth (Z)

These values for width, height and depth reflect
how finely the particular side of the object is
subdivided.

You must consider the segmentation if you
intend to edit the primitive with other tools. The
finer the subdivision, the softer later
deformations will appear.

In particular you should subdivide an object
quite finely before using boolean operations on
it — generally, though, only subdivide when
necessary.

Fillet — Size, Segments

With this option you can apply an even
roundness to all the cuboid’s edges, i.e. apply a
fillet. Fillet Size is the radius of the curvature,
while Fillet Segments defines how finely the
fillet will appear.

The more segments you specify, the more round
the object’s edges will be. If you want to create
a chamfer, instead of a rounded, filleted edge,
set this value to 1.

Different cube shapes

The radius of the fillet cannot be larger than half
of the value of the smallest of the cuboid’s
dimensions. If your cuboid possesses, say, a
width of 100 units and a height and depth of
300 units each, a maximum of 50 can be chosen
for the fillet radius.

Separate Surfaces

If you select this option then, during a later
transformation of the parameter object into a
polygon object, a separate object will be created
for each side of the cuboid and all will be
combined into a group. This is useful if you
want to be able to process elements of the
cuboid separately.
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Interactive editing

The cube has three handles.

The handles of the cube primitive

If you drag handle 1 you change the width (X).
If you drag 2 you change the height (Y). If you
drag 3 you change the depth (Z).

If you enable the Fillet option in the parameter
dialog (see above), three further handles appear.

Additional handles of the cube primitive

Drag handles 4, 5 or 6 to change the fillet
radius.

Cylinder

This function creates a cylinder, whose ends
(caps) are aligned parallel to the XZ plane.

Radius, Height

These values define the basic dimensions of the
cylinder.

Height Segments

Changes the number of subdivisions of the
object in the Y direction.
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Rotation Segments

This defines the number of subdivisions of the
object along its circumference. The larger this
value, the smoother the cylinder will appear.

Cylinder with different subdivisions

Orientation

Choose a value from this pop-up menu to set
the cylinder’s initial position in space. Using this
you can turn it on its axis very simply and,
above all, quickly.

Slice

By entering a value for Slice you can remove
parts of the cylinder. Think of a cake, from
which you’ve cut a piece. The planes of section
of the remaining object are closed. Here are
some different cylinder cutouts.

Regular Grid

The Regular Grid option will be available if, and
only if, you have chosen to slice the object. By
enabling this option and entering a value
alongside the enable box you can control the
subdivisions within the plane of section of the
sliced object. Small values produce a fine
subdivision while larger values result in a coarse
structure.

This subdividing only affects the face (the plane
of section) of the slice. You will need to use this
option only if you intend to process the object
further after slicing it.

Caps

Use this option to give the cylinder caps both of
its ends, or leave it unchecked for a hollow
cylinder.

A cylinder on the left with and, on the right, without caps

Cap Segments

This value defines the number of subdivisions of
the caps in a radial direction. The subdivision
along a cap’s circumference is as defined in
Rotation Segments (see above).
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Fillet, Radius

Assuming that the cylinder has caps you can use
this option to apply a fillet or chamfer to the join
between the cylinder body and the caps. Enter
the radius of the fillet.

Fillet Segments

With Fillet selected you can choose the degree
of the roundness with this option. The higher
the value the smoother the join will appear;
enter a value of 1 to achieve a chamfer. In the
picture is a cylinder whose upper cap was
rounded. To the left is a chamfer, then a rough
fillet and, on the right, a high-value, smooth
fillet.

On the left a fillet segment of 1 (chamfer), center fillet
segments set to 3, on the right 10

The roundness can be set as large as the cylinder
radius — the caps will then appear to be
hemispheres.

Interactive editing

The cylinder has, initially, two handles.

The handles of the cylinder primitive

If you drag handle 1 you change the radius. If
you drag handle 2 you change the height.

If you enable Fillet in the parameter dialog (see
above), a further handle appears.

Additional handle of the cylinder primitive

If you drag handle 3 you change the radius of
the cap fillet.
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Disc

This creates a circular disc in the XZ plane.

Inner Radius, Outer Radius

The value for the outer radius defines the overall
size of the disc. A value for the inner radius of
greater to zero, generates a perforated disc.
Naturally, the inner radius cannot be larger than
the outer radius.

Disc Segments, Rotation Segments

Disc Segments gives the radial subdivision,
Rotation Segments the subdivision along the
circumference of the disc.

Discs with different subdivisions

Orientation

Choose a value from this pop-up menu to set
the disc’s initial position in space. Using this you
can turn it on its axis very simply and, above all,
quickly.

Slice

Enable this option and enter a value in order to
cut chunks out of the disc, like slices from a
cake. In the following illustration are some
different disc cutouts.

Different disc cutouts

Interactive editing

The disc has two handles.

The handles of the disk primitive

If you drag handle 1 you change the outer
radius. If you drag handle 2 you change the
inner radius.
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Plane

This creates a quadrangle in the XZ plane, which
is divided into further quadrangle surfaces.

Width, Height

Defines the size of the plane.

Segments

For each dimension of the plane you can
separately adjust the level of subdivision. This is
important for subsequent modeling. The finer
the subdivision, the more smoothly you will be
able to apply tools such as the Magnet (see
Magnet, page 366).

Differently subdivided, deformed planes

Orientation

Choose a value from this pop-up menu to set
the plane’s initial position in space. Using this
you can turn it on its axis very simply and,
above all, quickly.

Interactive editing

The plane has two handles.

The handles of the plane primitive

If you drag handle 1 you change the width. If
you drag handle 2 you change the height.
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Polygon

This creates probably the most elementary
object used in computer graphics, an individual,
triangular or rectangular polygon in the XZ
plane.

Width, Height

Define the size of the polygon.

Subdivision

Allows you to change the degree of subdivision
of the object.

Orientation

Choose a value from this pop-up menu to set
the polygon’s initial position in space. Using this
you can turn it on its axis very simply and,
above all, quickly.

Triangle

Enable this option to create the polygon from
triangular shapes, as opposed to rectangular
ones. This option is set by default.

Interactive editing

The polygon has two handles.

The handles of the polygon primitive

If you drag handle 1 you change the width. If
you drag handle 2 you change the height.
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Sphere

This function creates a sphere composed of
triangles and squares. (Spheres really come into
their own when used with Metaballs; see
Metaball, page 177.)

Radius

Use this to define the size of the sphere.

Segments

Defines the degree of the subdivision of the
sphere. The sphere is divided along its latitude
and longitude. However, until you convert a
sphere into a polygon object with Make Editable
a sphere is always generated by calculation, no
matter how much you subdivide it.

On the left a sphere primitive divided into six segments, on
the right the same object, this time converted to a polygon.

Render Perfect

If you choose this option, a perfect sphere is
generated by the maths (if the sphere was not
already distorted or deformed). This type of
sphere has the advantage that it looks great,
since it is truly round and smooth. In addition it
can be rendered more quickly than a sphere
built from surfaces.

Note

The Perfect Sphere stays perfect only as long as
the object is not distorted (e.g. by scaling about
an axis). If the Perfect Sphere is distorted it is
converted into a polygonal object before
rendering. It then uses the number of segments
defined in the Properties dialog.

Type

With this pop-up menu you choose of which
surfaces, and in which arrangement, a sphere is to
be composed. With Standard the sphere surface is
made up of triangles and squares, Hexahedron
uses only squares and Icosahedron only triangles.

Interactive editing

The sphere has one handle.

The handles of the sphere primitive

If you drag handle 1 you change the radius.
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Torus

This function creates, by default, a torus (solid
ring, like a bent pipe) in the XZ plane.

Ring Radius, Ring Segments

With these values you define the size and the
subdivision of the ring. The ring is a notional
circle running round the center of the pipe.

Pipe Radius, Pipe Segments

Specify the size and the subdivision level of the
pipe. The pipe radius cannot be larger than the
ring radius.

Orientation

Choose a value from this pop-up menu to set
the torus’s initial position in space. Using this
you can turn it on its axis very simply and,
above all, quickly.

Slice

Enable this option and select a value to obtain a
portion of the torus. The planes of section of the
cutout object are closed. In the following
illustration are some different cutouts.

Different torus cutouts

Regular Grid

The Regular Grid option will be available if, and
only if, you have chosen to slice the object. By
enabling this option and entering a value
alongside the enable box you can control the
subdivisions within the plane of section of the
sliced object. Small values produce a fine
subdivision while larger values result in a coarse
structure.

This subdividing only affects the face (the plane
of section) of the slice. You will need to use this
option only if you intend to process the object
further after slicing it.
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Interactive editing

The torus has two handles.

The handles of the torus primitive

If you drag handle 1 you change the ring radius.
If you drag handle 2 you change the pipe
radius.

Capsule

This function creates, along the Y axis, a cylinder
with hemispherical caps. From this, you can
quickly create a myriad of pill shaped objects.

Radius

This value defines the half-thickness of the
object. The cap radius is automatically
generated from this value.

Height

Use this to choose the overall height (the
cylinder plus the caps) of the capsule.

Height Segments

This gives the number of subdivisions of the
capsule in the Y direction.

Cap Segments

Defines the number of subdivisions of the cap in
a radial direction. The subdivision along the
cap’s circumference is given by Rotation
Segments (see below).
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Rotation Segments

The number of subdivisions of the capsule
around its circumference. The larger this value,
the more rounded the cap appears.

Capsules with different segment values

Orientation

Choose a value from this pop-up menu to set
the capsule’s initial position in space. Using this
you can turn it on its axis very simply and,
above all, quickly.

Slice

Select and enter values to remove part of the
capsule. The planes of section of the resulting
object are closed. Here are some different
capsule cutouts.

Regular Grid

The Regular Grid option will be available if, and
only if, you have chosen to slice the object. By
enabling this option and entering a value
alongside the enable box you can control the

subdivisions within the plane of section of the
sliced object. Small values produce a fine
subdivision while larger values result in a coarse
structure.

This subdividing only affects the face (the plane
of section) of the slice. You will need to use this
option only if you intend to process the object
further after slicing it.

Interactive Editing

The capsule has two handles.

The handles of the capsule primitive

If you drag handle 1 you change the radius. If
you drag handle 2 you change the height.
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Oil Tank

This creates a cylinder along the Y axis with curved
caps. By adjusting the parameters many different
objects can be made, such as the location pins or
rivets frequently used in the car industry.

Radius

Defines the half-thickness of the object.

Cap Height

The cap height is defined as a percentage of the
radius of the oil tank. 100% will give a
hemispherical cap (a capsule, assuming the length
is sufficient compared to the radius), 0% means no
curvature (a cylinder). In contrast to the cone or
the capsule, the transition from the cylinder barrel
to the cap is always sharp; the exception being if
you have chosen 100% for this parameter.

Height

This is the overall length (the body plus the
caps) of the oil tank.

Height Segments

This value defines the number of subdivisions of
the object in the Y direction.

Cap Segments

This is the subdivision level of the caps in a
radial direction.

Rotation Segments

The number of subdivisions of the oil tank
around its circumference. The larger this value,
the more rounded the oil tank appears.

Oil tanks with different segment values

Orientation

Choose a value from this pop-up menu to set
the oil tank’s initial position in space. Using this
you can turn it on its axis very simply and,
above all, quickly.

Slice

Use this to get just a portion of the oil tank.
Here are some different oil tank cutouts.
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Regular Grid

The Regular Grid option will be available if, and
only if, you have chosen to slice the object. By
enabling this option and entering a value
alongside the enable box you can control the
subdivisions within the plane of section of the
sliced object. Small values produce a fine
subdivision while larger values result in a coarse
structure.

This subdividing only affects the face (the plane
of section) of the slice. You will need to use this
option only if you intend to process the object
further after slicing it.

Interactive Editing

The oil tank has three handles.

The handles of the oil tank primitive

If you drag handle 1 you change the radius. If
you drag handle 2 you change the height of the
oil tank. If you drag handle 3 you change the
height of the caps.

Tube

This function creates a hollow cylinder, with
walls of various thicknesses, whose ends are
aligned parallel to the XZ plane.

Inner Radius, Outer Radius

Adjust these values to change the size and the
wall thickness of the tube.

Rotation Segments

This is the number of subdivisions of the tube
around its circumference. A large value means a
smoother tube with more faces.

Tubes with different segment values
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Cap Segments

Defines the number of subdivisions of the cap in
a radial direction. The subdivision along the
cap’s circumference is given by Rotation
Segments (see above).

Height

The length of the tube.

Height Segments

This is the number of subdivisions of the tube in
the Y direction.

Orientation

Choose a value from this pop-up menu to set
the tube’s initial position in space. Using this you
can turn it on its axis very simply and, above all,
quickly.

Slice

Use this parameter to cut a section out of the
tube; enable the box and choose sensible values
for the angles of the cutout. Below are some
different tubing cutouts.

Different tubing cutouts

Regular Grid

The Regular Grid option will be available if, and
only if, you have chosen to slice the object. By
enabling this option and entering a value
alongside the enable box you can control the
subdivisions within the plane of section of the
sliced object. Small values produce a fine
subdivision while larger values result in a coarse
structure.

This subdividing only affects the face (the plane
of section) of the slice. You will need to use this
option only if you intend to process the object
further after slicing it.

Interactive Editing

The tube has three handles.

The handles of the tube primitive

If you drag handle 1 you change the outer
radius. If you drag handle 2 you change the
inner radius. If you drag handle 3 you change
the height (the tube length).
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Pyramid

This function creates a 4-sided (5, if you count the
base!) pyramid. By default the base of the pyramid
is parallel to the XZ plane of the world coordinate
system. In principle this object corresponds to a
cone with four rotation segments (see above) but
its quicker to make a pyramid with this primitive.

Width (X), Height (Y), Depth (Z)

These values give the dimensions of the object.

Different pyramids

Segments

This is the number of subdivisions applied to all
surfaces.

Orientation

Choose a value from this pop-up menu to set
the pyramid’s initial position in space. Using this
you can turn it on its axis very simply and,
above all, quickly.

Interactive editing

The pyramid has three handles.

The handles of the pyramid primitive

If you drag handle 1 you change the width (X).
If you drag 2 you change the height (Y). If you
drag 3 you change the depth (Z).
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Platonic

This function creates many different Platonic
primitives.

Radius

This value gives the size of the circumscribing
sphere into which the object is placed. All points
of the object touch the surface of this sphere.

Platonic objects placed into the circumscribing sphere

Segments

The number of subdivisions applied to all
surfaces.

Type

Here you can choose from a list of pre-defined
Platonic objects. In addition to the many
standard objects that Plato would have
recognized is the football-like C60-Buckyball.

The following illustration shows the different
objects.

Tetrahedron, Hexahedron, Octahedron, Dodecahedron,
Icosahedron and C60-Buckyball

Interactive editing

The Platonic objects have one handle.

The handles of the Platonic primitives

If you drag handle 1 you change the radius.
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Figure

This function creates a ready-to-pose figure. All
hierarchies are already defined and can be used,
for example, with the Inverse Kinematics function
(see Inverse Kinematics, page 307). In addition,
most joints possess pre-defined angle restrictions
for movement (see IK Tag, page 471).

So where is the hierarchical structure? Well, the
hierarchy will appear in the Object manager only
when you convert the figure to polygons i.e. make
it editable (see Make Editable, page 353).

Height

This gives the overall height of the figure. All
the body elements are changed (scaled)
accordingly.

Segments

The value defines the number of subdivisions of
all the surfaces of all the sub-objects of the
figure.

Interactive editing

The figure has one handle. If you drag it you
change the height (size).

The handle for the figure primitive.
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Landscape

With one press of a button, this function
produces, in the XZ plane, craggy mountains or
gently rolling countryside. More accurately, it
creates an irregularly-formed object using fractal
principles. The parameters allow versatile control
of the landscape appearance.

Width (X), Height (Y), Depth (Z)

With these values you change the size of the
landscape.

Segments

The value defines the number of subdivisions of
the surface, in width and depth. The larger the
number of segments, the finer the structure.

Landscapes with different subdivisions (on the left 10, in the
center 50, on the right 100)

Rough Furrows, Fine Furrows

Change the cragginess of the landscape with
these values. Low values result in gentle hills,
high values rough mountains. In the following
illustrations the rough furrows value is increased
from left to right and the fine furrows value is
increased from top to bottom.

Different landscapes (from left to right, 0%, 50%, 100%)

Scale

This controls the height of the fissures in the
landscape. Large values result in deep valleys,
small values give flatter landscapes.
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Different scaling (from left to the right 0.1, 1, 1.5, 10)

Sea Level

This sets the height of the water. The higher the
value, the further the landscape slips into the
sea. With 100% Sea Level you have re-created
Atlantis — and you see a simple plane.

Different sea levels (from left to the right 0%, 25%, 50%,
75%)

If you switch off Borders At Sea Level (see
below), you will see a rather different result.
After being truncated at sea level the landscape
is then lifted again to its full height, i.e. the parts
rising from the water become steeper.

Water levels with borders not at sea level (from left to the
right 0%, 25%, 50%, 75%)

Plateau Level

The value works in an inverse way to sea level.
Instead of being cut off from the bottom, the
landscape is truncated from the top, creating

flattened mountain tops. If the plateau level is
set to 0%, a plane will result. If you switch off
Borders At Sea Level then, after truncation, the
landscape is lifted again to full height, i.e. the
mountains become steeper.

Plateau with borders at sea level (100%, 75%, 50%, 25%)

If you switch off Borders At Sea Level (see
below), you will see a rather different result.

Plateau with borders not at sea level (100%, 75%, 50%,
25%)

Multifractal

If you turn off this option CINEMA 4D will use a
different algorithm for generating the landscape.
Usually, more natural scenes are generated with
multi-fractal enabled but it’s up to you.

Landscapes left with multifractal on
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Borders At Sea Level

This affects how the landscape changes where it
meets the sea. With this option turned on,
CINEMA 4D attempts to soften, or flatten, the
landscape-to-sea transition. This option is not
available if you have enabled Spherical (see
below).

Spherical

Select this option if you want to wrap your
landscape on to a sphere. The radius of this
sphere is defined by half the width value, the
height of the landscape above the surface of the
sphere is taken from the height value (see
above).

A plane landscape (left), wrapped on to a sphere (right)

Orientation

Choose a value from this pop-up menu to set
the landscape’s initial position in space. Using
this you can turn it on its axis very simply and,
above all, quickly.

Interactive editing

The landscape has, initially, three handles.

The handles of the landscape primitive

If you drag handle 1 you change the width (X).
If you drag 2 you change the height (Y). If you
drag 3 you change the depth (Z).

If you switch on Spherical, only two handles
appear.

Alternative handles of the landscape primitive

If you drag handle 4 you change the radius of
the sphere, around which the landscape is
wrapped (half the width).

If you drag handle 5 you change the height of
the mountains (height).
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Relief

This function creates an object in the XZ plane
that is similar to a landscape (page 118).
However, in this case no fractal function is used
to generate the scene, but rather a picture or
image.

The relief map interprets the different greyscales
within the chosen image as altitude values. If
you choose a color image, the greyscale is
formed from the average value of the red, green
and blue values of the bitmap picture. The
brighter a pixel of the image is, the higher its
elevation within the landscape; the darker a
pixel is, the more deeply it lies within the scene.
So, darkness defines valleys, brightness,
mountains.

Since it can be hard, initially, to see how a
coloured image will convert to greyscales, we
recommend using monochrome images until
you are more experienced with using relief
maps.

Patterns (left) for different reliefs (right)

Image

Click the button and a file selector opens from
which you select the image file to be applied to
the relief.

Note

A CINEMA 4D shader (see The Shaders,
page 520) cannot be used as an image file.

Width (X), Height (Y), Depth (Z)

These values define the size of the relief.

Segments

The value defines the number of subdivisions of
the surface, in width and depth. The larger the
number of segments, the finer the structure.

Reliefs of different subdivisions (on the left 10, centre 50, on
the right 100)



122 • OBJECTS MENU • CHAPTER 7

Bottom Level

This defines the height of the notional water.
The higher this value, the further the landscape
slips into the sea. With 100% the entire
landscape is flooded and disappears — a simple
plane results.

Different bottom levels (0%, 25%, 50%, 75%)

Top Level

The value works in an inverse way to bottom
level. Instead of being cut off from the bottom,
the landscape is truncated from the top, creating
flattened mountain tops. If the top level is set to
0%, a plane will result.

Different top levels (100%, 75%, 50%, 25%)

Spherical

Select this option if you want to wrap your relief
on to a sphere. The radius of this sphere is
defined by half the width value, the height of
the relief above the surface of the sphere is
taken from the height value (see above).

An even relief (left) wound on a sphere (right)

A general problem of this wrapping operation is
that, depending on the image used, you may
get discrepancies at the edge of the relief,
especially if you use a non-tileable texture (see
Tiles, page 548). The illustration below shows
the problem quite well. You must choose your
images carefully and be prepared to experiment.

The image used (top), the sphere relief from the front (left)
and from the rear (right)

Orientation

Choose a value from this pop-up menu to set
the relief map’s initial position in space. Using
this you can turn it on its axis very simply and,
above all, quickly.
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Interactive editing

The relief has, initially, three handles.

The handles of the relief primitive

If you drag handle 1 you change the width (X).
If you drag 2 you change the height (Y). If you
drag 3 you change the depth (Z).

If you switch on Spherical, only two handles
appear.

Alternative handles for the relief primitive

If you drag handle 4 you change the radius of
the sphere, around which the relief is wrapped
(half the width).

If you drag handle 5 you change the height of
the elevation (height).

Spline Object

This function creates an empty spline object.
Like the Polygon object, it is recognizable on
screen only by its origin and axes.

You can use this object for the construction of
your own splines.

Curves

Splines are primarily a sequence of vertices,
connected by lines, lying in 3D space. The shape
of these connecting lines (straight or curved)
defines the so-called interpolation.

Apart from the direct connection of the vertices
over straight, rigid lines, there are other kinds of
splines that use an interpolation method
whereby the lines between the vertices are
curved instead of straight. Such splines have a
soft leading edge without sharp corners.

The spline itself is infinitely thin. We add some
thickness to splines to help you visualize them
better in the viewports. However, you should
realise that you will never see a spline when
rendered with the raytracer.

The spline’s line has no three-dimensional depth,
even though it occupies the 3D space. However,
many complex 3D objects, among other things,
can be constructed out of these curves in
seconds.

After the spline is created it can be pulled along
its depth in order to make tube-like objects.

You can also rotate a spline around an axis and
make circular objects (e.g. a wineglass). Or you
can construct a skin over several splines, with
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the finished object simulating the contours on a
map. More of these spline-modeling capabilities
are discussed in NURBS, page 158.

Segments

A spline is made from several partial curves, or
segments. If, for example, you create some text
(see Text, page 142), you will see that only one
object is created, even though you typed several
letters. The text object now actually consists of
several outlines, at least one outline for each
letter.

Take for example the letter sequence in the
word ‘Test’.

The word consists of four letters; that makes
four separate segments. However, another, fifth,
segment is also present; the inside of the ‘e’ is a
further spline segment.

If this type of element is later extruded into a
3D object, CINEMA 4D will automatically punch
out a hole that is the same size and shape of the
internal segment of the ‘e’.

A spline converted to a 3D object with holes automatically
created

Holes are formed only if a spline lies completely
inside another spline and both form closed
curves. If two segments overlap in any way, no
3D object can be formed. If you nonetheless try,
then the results may well be strange.

On the left is a correct arrangement of splines and on the right
we see spline segments arranged in an incorrect order.

A spline object can be composed of any number
of segments. However all segments of a spline
must have the same settings, e.g. they should
be either all open or all closed and all have the
same kind of interpolation.

So, what is the advantage of a spline with many
segments and many separate spline objects?

As long as the element is present as a complete,
individual object then all of its points can be
modified and edited at the same time.

Let’s return to the text example above. Before
you convert the spline to a 3D object you can
bend it e.g. with a deformation object (see
Deformation, page 247). The tool affects all
vertices of all segments equally. Therefore the
spline is deformed evenly, as a whole.

Before extruding, a spline with several segments is modified
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If we have nothing but individual, separate spline
objects, then even simple deforming becomes very
difficult, if not impossible. As you can see, Splines
are an extremely important part of CINEMA 4D.

Tip

Do not confuse the Polygon object with the
Spline object. Although both are essentially just
empty containers, the former deals with polygon
vertices only while the latter works with spline
vertices (and splines).

To create a new spline curve

Create an empty spline.

Change to the Edit Points tool (Tools > Points).

Create each of the consecutive vertices of the
curve. For this point creation, keep the Ctrl key
pressed and click with the mouse in a viewport.

The first point defines the start of the spline. Each
consecutive click, if clicked further away than the
last point created, will add to the spline.

If you Ctrl-click between two previously created
points on the curve then the new point will be
positioned on the spline between these two
existing points.

If you hold down the Shift and Ctrl keys while
clicking, the new point is created at the beginning
of the spline, giving a new starting point.

If you click on the starting point, no new vertex
will be created, but the spline will be closed (see
below).

The spline is always created in the view of the
active viewport. If this is, for example, the front
view, then the created spline appears in the XY
plane, with the plan view in the XZ plane. If you
have activated one of the 3D views (e.g.
isometric or central perspective), the spline is
drawn principally in the XZ plane (plan view).

For some operations, such as the aligning of
objects along a spline (see Arrange, page 383)
or the movement of objects along a given curve
(see Align to Spline, page 581) the direction of
the spline (where it begins and ends) is
important. To this end, the spline is color-coded.

By default, from the first vertex, the starting point,
and moving outwards, the curve is coloured from
red to orange to yellow (the end point). The
colours of the start and end points can be changed
within the preferences. The colours chosen are
then changed, in a graduated fashion, between
the two points. This coloured display is visible only
when the Edit Points tool is active.

To create a new spline segment

Create a spline as described above.

Add a new point that will be the start point of a
new segment (though still connected to the last
point of the previous segment for now).

Select Structure > Edit Spline > Break Segment.
The connection to the previous segment is now
broken.

Add further vertices. All new vertices now
belong to the new segment.

Depending upon your needs, you can create
further segments.

If you wish the start point of a new segment to lie
in the same position as the end point of the
previous segment, select the snap function in step
2 (see Snap Settings, page 375) , thus setting the
new segment starting point as desired.

If a spline consists of several segments, then
new vertices are always created from the active
vertex. If no vertices are active, then new
vertices are generated at the last-created
segment. If several vertices at different
segments are active, new vertices are always
generated at the first-created segment.
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The Spline Dialog

Type

Linear

This simplest of all the spline types connects the
vertices, which define the polygon, with
straight, directly connected lines.

You can use these splines to create angular
objects or to simulate sharp jerky movements
for animation.

Cubic

This kind of spline has a soft curve between the
vertices. The interpolated curve always passes
accurately through the vertices.

Considering the two points at the top right
diagram above you can see that the curve
extends further to the above right than is
actually necessary. This behavior is called
overshooting, and it often appears with closed
curvatures. This becomes clearer when you
compare this section of the curve with the same
section of the Akima curve interpolation.

Akima

This spline type creates a soft curve between
vertices. The interpolated curve always passes
accurately through the vertices. Overshooting
does not happen with this type of curve.
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Akima interpolation adheres very closely to the
path of the curve given by the vertices but,
because of this, it can sometimes appear
somewhat hard. If this happens you should use
Cubic interpolation.

B-Spline

This kind of spline also creates a soft curve
between the vertices. The curve however does
not use an interpolation method that passes
directly through the vertices.

This produces a very smooth curve. The vertices
control only the approximate path of the curve.
Distant points have less influence on the curve
than those lying closer together.

Bézier

This spline type creates a soft curve path
between the vertices, which can be controlled
very precisely. The interpolated curve always
passes accurately through the vertices.
Overshoot does not happen.

If you activate a vertex of the spline (i.e. by
clicking on it), additional control points at the
tangents to the curve become visible.

Changing the direction of the tangent handles
controls the direction of the curve at each
vertex. To do this, click on a tangent end point
and drag it with the mouse.

By adjusting the length of these tangent handles
you can control the strength of the curvature.
Drag the tangent end point towards the vertex
point and observe the symmetrical movement of
the opposite handle.
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In the above illustrations all tangents lie
horizontally. Now the tangent of the upper
point was rotated 180°, i.e. the left tangent end
point lies now on the right, the right on the left.
You can see the result in the following
illustration.

You can define the lengths of the tangents
separately from each other; keep the Shift key
pressed as you click and drag a tangent end
point. See the following example:

You may set different tangent directions on the
right and on the left of the vertex. With this
approach you can make the otherwise smooth
path of a curve produce sharp corners and
peaks, if required. To do this hold the Shift key
down, click on a tangent end point and move it
with the mouse.

If the tangents of two neighbouring points have
zero length, the segment that runs between the
vertices will be linear. Thus, you can mix linear
segments with curved spline shapes.
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If you double-click on a Bézier vertex, a dialog
opens that allows you to accurately enter both
the position of the vertex (in world coordinates)
and the position of the tangent end points
(relative to the vertex) numerically.

In comparison to the other spline types available,
Bézier splines are the most functional, offering the
most user control. Therefore CINEMA 4D uses
Bézier splines for its animation system.

Close Spline

Each polygon can be closed or open. If a
polygon is closed, the start and end points are
connected. Although you may assume that
closing a polygon (and interconnecting the start
and end points) or simply positioning the start
and end points together will have the same end
result, there is a big difference. In the first case
the transition from the start to the end point is
soft, in the second case it is abrupt.

On the left an open spline and on the right a closed spline

You can close the spline automatically when
creating it by clicking on the start point as last
action (keeping the Ctrl key pressed).

Interpolation

Here you can define how the spline is to be
subdivided during modification. Even after you
select the Interpolation type from the menu for
the Intermediate Points, you can still make more
changes.

None

This method of interpolation uses the vertices of
the splines directly and connects them with
straight, rigid lines, using no additional
intermediate points. With None you cannot
enter values for the Number or Angle fields.
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Natural

This interpolation type subdivides the spline
with the number of points given in the Number
field. The points follow the natural course of the
spline i.e. they are positioned closer together at
the vertices and further apart when in-between
the vertices.

The resulting curve points do not necessarily
pass through the vertices. If the spline consists
of several segments then the value in the
Number field is applied to each segment.

Natural interpolation does not allow you to
enter values in the Angle edit field.

Uniform

This type of interpolation also subdivides the
spline using a number of intermediate points
given by Number but the points are positioned
at an exact equal distance from each other. The
points from this resulting curve do not
necessarily pass through the vertices.

If a spline has several segments, then the value
of the field applies to each segment. This type
of interpolation also subdivides the spline using
a number of intermediate points given by
Number but the points are positioned at an
exact equal distance from each other. The points
from this resulting curve do not necessarily pass
through the vertices.

As with the Natural method, you cannot enter
values in the Angle edit field.

Note

For Natural and Uniform interpolation the
number of intermediate points is calculated by
the formula (number of vertices + 1) * Number.

So an open spline with four vertices and a
Number of 2 will contain (4+1)*2=10
intermediate points.
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If the spline is then closed, a further (virtual)
vertex is added; then the number of
intermediate points will be (5+1)*2=12. This
ensures that a spline is not more roughly divided
when you close it.

Adaptive

This interpolation type sets intermediate points
whenever the angle deviation of the curve is
larger than the value for given in Angle. The
resulting curve has points that pass accurately
through the vertices.

If a spline has several segments, then the value
of Angle will apply to each segment.

The Adaptive method gives the best results in
rendering and, as such, is set as the default
interpolation method.

Like the preceding methods, you cannot enter
values in the Number field.

Create Spline (Curves)
Using the spline object (see above) you will
quickly create new splines from scratch.
However, for some shapes this approach can be
clumsy and unnecessary.

For this reason CINEMA 4D includes spline-
curves. These are interactive tools which will
remain active until you select another tool (e.g.
Move). You can thus create any number of
these splines without the need to select the
command each time.

Spline curves are always created in the active
view. If this is, say, the plan view, the newly
created curve will lie in the XZ plane.

Freehand

With this function you can actually draw curves
directly in the viewports.

Select the Freehand tool. Then click in a viewport
and keep the mouse button pressed. A small
crosshair appears and you can then draw the
Freehand curve for as long as the mouse button is
held down.

Releasing the mouse button will end the
Freehand spline creation and the finished spline
will appear. You can imagine how useful this
function will be when tracing patterns with a
graphic tablet.

If the start and end positions of the finished
curve are positioned close together, the curve is
automatically closed.
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Note

Freehand Splines are always created on the
camera plane when you work in the 3D viewport,
not on the construction plane, which is the case
for the Bézier, B-Spline, Cubic, Akima and Linear
splines. If you want to draw a spline onto one
plane (XY, ZY, XZ etc.) you have to switch to the
corresponding view (see View Menu, page 26).

More adjustment and control for this tool is
available in the Active Tool window.

Tolerance

This value defines how accurately the spline curve
will follow your mouse movements. The higher the
value for Tolerance, the more rounded the spline
will be and the fewer vertices will be generated.

Bézier, B-Spline, Cubic, Akima

Using these functions you can create the exact
type of curve you require. The difference
between these curves is described in detail in
The Spline Dialog, page 126.

Select the desired type of curve and the point
editing mode is automatically switched on. Now
create the vertices of your spline curve in a
viewport.

By right-clicking away from the vertices in a
viewport, the finished spline will appear. Clicking
on the starting point (with the left button) again
will show the finished spline and also close it.
After the finished spline appears, you are left in
point editing mode, ready to tweak and modify
your curve spline.

If you work in the 3D viewport, the spline is
created in the XZ plane. Then it is not possible
to set vertices above the horizon.

Note

You can’t use the right mouse button to cancel
when creating Splines; instead you should use
the ESC key.

Linear
With this function you can create linear splines
directly in a viewport.

If you choose this option, you will be placed in
point edit mode. Now set the spline vertices by
clicking in the View window until you have the
spline you want.

To finish press the ESC key. If you click (with the
left mouse button) on the start vertex, the curve
is displayed and closed automatically. When you
have completed the spline (by pressing ESC or
clicking on the first vertex) you will be in points
mode, ready to fine-tune your spline.

If you are in the 3D viewport, the spline is
created in the XZ plane. Therefore no vertices
can be set above the horizon.
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Spline Primitives
We have already seen how to create new curve
paths (splines) from scratch. However, since the
creation of such splines can be a somewhat
lengthy and cumbersome process, CINEMA 4D
gives you a generous number of pre-defined
curves.

Add to that the possibility of converting vector
based artwork files from other programs (see
Vectorizer below) and adding graphic characters
(see Text below) and you can see that you have
a large range of spline primitives at your
disposal.

All of these spline primitives are parameterized.
This means that the spline is merely the
graphical representation of a mathematical
formula built from any number of preset values.
As a result, this mathematical formula initially
has no properties to edit within the 3D window.
It has no vertices to manipulate.

To adjust the vertices with the point editing tool
(see Points, page 302), for example, requires
you to first convert the spline to a non-
parameterized, editable object using the
Tools > Options > Make Editable command
(see Make Editable, page 353). However, you
are free to modify the spline primitive with a
deformation object (see Deformation, page 247)
without such a prior conversion.

In addition to this, you may change all the
preset parameters of such an object (e.g. height,
radius, etc.) at any time. Have a play with the
different parameter values of an object to get a
feel of what is possible (just double-click on the
property icon in the Object manager). Start by
changing just single values so you can observe
the changes more clearly. Enter large values, and
then try smaller ones.

When creating a new spline object from the
Object menu, the actual spline primitive will
appear in the viewports. The properties of this
object — editable within its parameter dialog —
are accessible through the Object manager.
Simply double-click on the object icon (see Edit
Object, page 478).

Identical parameters for all spline primitives.

Interpolation

Interpolation defines exactly how finely the
vertices of a spline will be positioned. The
various choices are described on page 129.

These adjustments affect only the generators
(e.g. NURBS — see NURBS, page 158) or those
objects converted into a polygon object (see
Make Editable, page 353).

If None is chosen for the method of interpolation,
no additional vertices are created. The direct
vertices of the spine are used, with no extra
intermediate points added.

If the Natural method is used, the spline is
divided according to the number of points
entered into the Number field. These points
follow the natural path of the spline, i.e. they lie
closer together between the vertices, and do not
necessarily go through them.
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Using Uniform for interpolation divides the
spline in such a way that, once again, the
number of points entered in the Number field is
used. The points lie apart at an equal distance
and do not necessarily go through the vertices.

You can calculate the exact number of points for
natural and uniform interpolation as follows:

points = (number of vertices + 1) * Number

For example, an open spline with four vertices
and a Number of 2 creates a total of (4+1)*2 =
10 points.

If you close the spline, a further (virtual) vertex
is used. In this case, (5+1)*2 = 12 points are
used. The virtual vertex prevents the spline from
becoming too coarse.

The Adaptive interpolation method creates
additional intermediate points whenever the
angle deviation of the spline is larger than the
value indicated by Angle. This results in smooth
and accurate curves.

Plane

From within the Plane pop-up menu you may
define in which of the three planes (XY, XZ, ZY)
the spline primitive is to lie. By default the
created spline is always positioned so that it is
visible in the current active view. This means
that if the spline is created in the XZ (top) or XY
(front) view, then the spline will seen, for
example, as facing towards the XY plane in the
3D viewport.

In all of the following examples the spline
primitive has been created in the frontal view, or
the XY plane.

Reverse Points

Using this option, the points (but not the spline)
are reversed.

Reversing the points of the spline primitive not
only has an effect after the conversion into an
editable spline curve. The reversal of points will
also affect operations such as Tools > Options >
Arrange.

On the left is a spline, on the right the same spline with a
reversed point order (the second spline vertex point is
marked).

In the following sections we will detail each
spline primitive and the individual options within
its parameter dialog.

As we have already described, splines are a
preliminary stage within the production of
three-dimensional objects. In later chapters we
will see how splines can be used.
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Arc

This function creates arc elements.

Type

With this option you choose the circle element
to be used in your arc. Select from Arc, Sector,
Segment and Ring.

Arc, Sector, Segment and Ring.

Radius

Defines the circle radius, from which the circular
element is to be created.

Inner Radius

If you selected the Type Ring, this will be the
inner radius of the ring.

Start Angle, End Angle

Using these two values you can define the start
and end point of the circle element. 0° defines
the value as the positive X-axis, 90° the positive
Y-axis, 180° the negative X-axis etc. These
examples assume you are working in the XY
plane, as mentioned earlier.

Interpolation

As mentioned earlier, this function defines how
the points of a spline are produced. These
choices are described in detail on page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the spline primitive
is created.

Reverse Points

Enabling this option will reverse the point order
of the spline.
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Circle

This function creates circles, rings, ellipses and
ellipse rings. It is also suitable for the creation of
hoses or tubes using NURBS objects (see
NURBS, page 158).

Circle, Radius

By default the Circle function creates a circle
with a radius of Radius.

Ring, Inner Radius

If the Ring option is enabled, either circular rings
or ellipse rings are created. Here the internal
radius of the ring is given by Inner Radius. For
ellipse rings this value is the internal radius along
the ellipse’s X axis. The inner length along the
Y axis is automatically calculated from the outer
ellipse’s dimensions.

Ellipse, Radius, Radius Y

If the Ellipse option is activated, both Radius
and Radius Y will affect the shape, with Radius
Y defining the length of the ellipse along the
Z axis.

Ring, Inner Radius

Activating both Ellipse and Ring will result in
ellipse rings. Here the internal radius of the ring
is given by Inner Radius. For ellipse rings this
value is the internal radius along the ellipse’s
X axis. The inner length along the Y axis is
automatically calculated from the outer ellipse’s
dimensions.

Circle, Ellipse, Ring, Ellipse Ring.

Interpolation

As mentioned earlier, this function defines how
the points of a spline are produced. These
choices are described in detail on page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the spline primitive
is created.

Reverse Points

Enable this option to reverse the spline’s points
(but not the spline itself).
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Helix

This function creates a spiral-shaped wound
helix.

Start Angle, End Angle

These values specify the start and end points of
the helix. 0° here designates that the relevant
point is on the positive X axis, 90° the positive
Z axis, 180° the negative X axis, etc.

For example, if the start angle is 0° and the end
angle 720°, the helix makes two complete
revolutions. If the helix begins at 180°, there will
be only 1.5 revolutions.

Tip

You can use calculations in the value fields. In
the above example you may enter 4*360 instead

of 1440. (You can find out more about this in
Coordinate manager, page 457 and in
Appendix 1.) For the mathematicians out there:
the number of spiral threads results from the
formula: (End Angle – Start Angle) / 360°

On the left a helix with 4 revolutions, on the right a helix with
3.5 revolutions

Height

This value defines the vertical height of the
helix, in the Y direction. The pitch of the screw
results from the formula: Height / ((End Angle –
Start Angle) / 360°.

Radial Bias, Height Bias

The bias values indicate the speed with which
the end values of the helix are to conclude. The
radial bias defines the speed of the horizontal
growth, while the height bias determines the
vertical growth.
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To make this clearer, let’s see some examples.

Three spirals with ten spiral threads and an end radius of 0;
radial bias on the left is at 10%, center 50%, and on the right
of 90%.

Three spirals with ten spiral threads; height bias on the left is
10%, center 50%, on the right of 90%.

Subdivision

The creation of a helix is based on a formula.
The smoothness of this formula is defined with
Subdivision (see also Cubic Interpolation,
page 154).

On the left is a helix with five subdivisions, on the right the
same helix with 100 subdivisions.

Interpolation

As mentioned earlier, this function defines how
the points of the helical spline are produced.
These choices are described in detail on
page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the helix is
created.

Reverse Points

Enable this option to reverse the spline’s points
(but not the spline itself).
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n-Side

This command creates a regular, angular, closed
spline. It is also suitable for, among other things,
creating hoses and tubes with the Loft NURBS
function (see Loft NURBS, page 163).

Radius

The n-Side object is created within a bounding
circle. The Radius defines the size of this initial
shape.

Sides

This value defines how many sides the n-Side
spline will have.

Variation with 3, 6 and 9 sides.

Rounding, Radius

Enabling this will round off the corner angles of
the shape according to the Rounding Radius
value, creating a quasi N-Round spline.

On the left we see a regular n-Side spline, on the right the
rounded version.

Interpolation

As mentioned earlier, this function defines how
the points of the spline are produced. These
choices are described in detail on page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the spline is created.

Reverse Points

Enable this option to reverse the spline’s points
(but not the spline itself).
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Rectangle

This function creates a rectangle.

Width, Height

These values define the size of the spline
primitive. By default both width and height are
equal and a square is thus created.

Rounding

Enabling this will round all corners by the Radius
angle.

On the left a standard rectangle, on the right the rounded
version.

Interpolation

As mentioned earlier, this function defines how
the points of the rectangle are produced. These
choices are described in detail on page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the rectangle is
created.

Reverse Points

Enable this option to reverse the rectangle’s
points (but not the rectangle itself).
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Star

This function creates a star.

Inner Radius, Outer Radius

The points of the star are based around two
circles, the sizes of which are defined by the
Inner Radius and the Outer Radius.

A star, based around two circles.

Twist

Use this to twist the points of the star around its
own shape. This makes saw blade shapes very
easy to construct. The values can be between –
100% and +100%. A value of 0% represents its
base, star-like position.

The Twist value on the left is –50%, the centre 0% and on the
right it is 75%.

Points

This value defines the number of points of the
star.

Interpolation

As mentioned earlier, this function defines how
the points of the star are produced. These
choices are described in detail on page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the star is created.

Reverse Points

Enable this option to reverse the star’s points
(but not the star itself).
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Text

With this function you can add letters,
characters and any other piece of text. Simply
choose a font and type your required text into
the field within the dialog.

TrueType Font, Type1 Font

In CINEMA 4D you can choose between
TrueType or PostScript Type 1 fonts by clicking
on the appropriate button.

With TrueType fonts, a font selector window will
open, allowing you to choose a character set.

With PostScript fonts, a standard file selector
window opens, from which you can locate and
load any desired PostScript font.

CINEMA 4D works with the so-called PFB
(PostScript Font Binary) format of Type 1 fonts.
In Windows these can usually be found in the
C:\PSFonts folder. The information in the PFM
(PostScript Font Metrics) files is not considered.

Under Mac OS you will usually find all your
fonts (TrueType and PostScript) in the ‘System
Folder:Fonts’ folder.

Text Edit Field

Enter your text into the large text field. You can
enter several lines of text, pressing Return will
begin a new line. To end the text input, press OK.

Create Separate Letters

Enable this option in the Text parameter dialog.
Now choose Structure > Make Editable. A new
object is created which has a separate spline
sub-object for each letter of the text. The object
axes of the separate letter splines are placed at
the baseline of the chosen font. This option is
useful if you want to arrange text (the separate
letters) along a spline, for example.

Align Text

With the Align Text pop-up menu you may
adjust the alignment of the text object, either
Left aligned, Centered or Right aligned.

Left justified text, centred text and right-justified text
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Horizontal Spacing

With this function you can insert additional
space between the characters inside a piece of
text.

Vertical Spacing

Use this to insert additional space between the
actual lines of text.

Line Height

This value defines the height of the characters in
world units. The line height is based around the
object’s center of origin and includes any
additional text spacing/leading.

Notes

CINEMA 4D generates text objects as connected
splines. After they are created, you may add depth
to these objects using Extrude NURBS. Simply
create an Extrude NURBS object (see Extrude
NURBS, page 160), then drag the created text
spline, within the Object manager, into the
NURBS object.

Various 3D text characters

As you can see, not only character fonts can be
used but symbols too.

Some fonts are poorly designed and will have
noticeable overlapping edges. CINEMA 4D
cannot improve these faults. Always use high
quality fonts for the best results.

You can get a good result with 3D fonts by
using the Bevel command on a font object and
restricting the angle limit to approx. 20° (see
Bevel, page 355).

Tip

Kerning information is not evaluated by
CINEMA 4D. Therefore to shift individual text
letters accurately, proceed as follows:

– Convert the spline primitive with the function
Tools > Options > Make Editable (see Make
Editable, page 353).

– Activate the Points mode (see Points,
page 302).

– Activate a vertex of the desired character (by
clicking it).

– Choose Selection > Select Connected (see
Select Connected, page 322). All points in this
character object are now selected.

– Activate the Move tool (see Move, page 295)
and you can move the entire character.

Alternatively, you may create individual text
objects.

Caution

The text objects you create are created for multi-
platform use, i.e. you may take a scene
containing text spline objects over to another
platform (e.g. from a Macintosh to a Windows-
based PC). However, if the original font does not
exist on the target computer, the spline outline is
lost as soon as changes are made to the object. If
you suspect that the target machine may not
recognise any particular character(s), you will
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first have to convert the spline primitive to a
standard spline object (see Make Editable, page
353).

Interpolation

As mentioned earlier, this function defines how
the points of the text are produced. These
choices are described in detail on page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the text is created.

Reverse Points

Enable this option to reverse the text’s points
(but not the text itself).

Vectorizer

Behind this object hides a very powerful
conversion tool. Using Vectorizer allows you to
create spline outlines from bitmap pictures.

Image

Click on the Image button to open a file
selector. From here you can load the image that
you wish to convert to splines. CINEMA 4D
shaders cannot be used. It is important to
remember that only pure black (RGB 0/0/0) is
interpreted as a solid background. All other
colours will be bordered with a line. The larger
the source image, the better the results will be.
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Converting an image (color image with black background and
black image with white background)

Effect of the image size on the result (512x512 and 1024x1024
pixels)

Width

This parameter defines the size in the
X direction. The height (Y direction) results
automatically from the aspect ratio of the
image.

Tolerance

This defines the smoothing of the conversion.
The higher the value, the smoother the contour
appears. However, more and more detail will

also be lost. The smaller the value, the more
detail of the original picture will appear in the
result. This, however, can lead to the spline
showing staircase-like jaggies at its edges.

Different tolerance values lead to different precision results

Interpolation

As mentioned earlier, this function defines how
the points of a spline are produced. These
choices are described in detail on page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the spline primitive
is created.

Reverse Points

Enable this option to reverse the spline’s points
(but not the spline itself).
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4-Sided

This command creates various 4-sided primitives
such as trapeziums or parallelograms.

Type

Select the desired 4-Sided object from the Type
menu. You can choose between a Diamond, a
Kite, a Parallelogram or a Trapezium.

The various 4-Sided objects (Diamond, Kite, Parallelogram and
Trapezium).

a, b, Angle

Depending on your choice of 4-Sided object,
these values have different meanings. The
following illustrations show these:

The parameters a and b for the diamond object

The parameters a and b for the kite object

The parameters a, b and angle for the parallelogram object
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The parameters a, b and angle for the trapezium object

Interpolation

As mentioned earlier, this function defines how
the points of the spline are produced. These
choices are described in detail on page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the spline is
created.

Reverse Points

Enable this option to reverse the spline’s points
(but not the spline itself).

Cissoid

Creates various mathematical curves.

Type

This defines the type of curve created. You can
choose between the Cissoid, the Lemniscate and
the Strophoid. The Lemniscate results from a
special calculation, using a technique known as
Cassini curves.

Cissoid, Lemniscate and Strophoid.
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Width

This value defines the overall size of the curve.

Tension

This will only affect the Cissoid and Strophoid
objects. With the Cissoid, the larger the value
you enter, the more the two arcs are pulled
together on both the left and the right of the
axis of symmetry.

Various Cissoid objects with the tension values of 2, 6 and 50

Increasing the Tension value on the Strophoid
object has a similar effect to when used on the
Cissoid. The arcs are pulled up further as the
value is increased. The loop also becomes
narrower.

Various Strophoids with tension values of 2, 6 and 10

Interpolation

As mentioned earlier, this function defines how
the points of the spline are produced. These
choices are described in detail on page 129.

Plane

With this pop-up menu you choose in which of
the three planes (XY, XZ, ZY) the spline is
created.

Reverse Points

Enable this option to reverse the spline’s points
(but not the spline itself).
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Cog Wheel

This function creates a cog wheel.

Teeth

Enter the number of teeth of the cog wheel
here.

Outer Radius, Middle Radius, Inner Radius

The overall size of the cog wheel is defined by
Outer Radius, while the depth of the teeth
results from the value for Inner Radius.

For the mathematicians: Depth of teeth = (outer
radius – inner radius) / 2.

The third value, Middle Radius, gives the height
at which any bevel will start to take effect (see
Bevel below). The following illustration clarifies
the connection between the three values.

The three radii of a cog wheel.

Bevel

As already mentioned, in addition to an inner
and outer radius that define their depth, the
teeth have another value, Bevel which can be
used to create different degrees of sharpness.
This is entered as a percentage and starts from
0% = no bevel up to 100% = maximum value
(pointed teeth). The bevel starts to take effect
from Middle Radius.

Various bevel values from 0%, 50% and 100% (left to right)
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Interpolation

This function defines the partitioning of the
points of a spline. These choices are described in
detail on page 129.

Plane

With this pop-up menu you define in which of
the three planes (XY, XZ, ZY) the spline primitive
is created.

Reverse Points

Using this option, the points of the spline are
reversed.

Cycloid

This creates a sort of rolling curve. This curve is
described by a point located on the circumference
of a circle as the circle rolls along a straight line.
(This point can also be located inside or outside
the circle.)

Cycloids, epicycloids and hypocycloids are
particularly suited to rotating types of
movement, e.g. for walk movements, gear
mechanisms and planetary orbits.

Type

With this option you choose the kind of rolling
effect you want the curve to adopt. The basic
Cycloid is the rotating curve of a circle (radius r)
along a straight line.
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Parameters of a basic cycloid object

The Epicycloid is the rotating curve of a circle
(radius r), which moves outside of a second
(usually) larger circle (radius R).

Parameters of an epicycloid object

The Hypocycloid is the rotating curve of a circle
(radius r), which moves inside a second (usually)
larger circle (radius R).

Parameters of a hypocycloid.

R, r, a

With the basic cycloid (a = r), the observed
point P (that the curve forms) is on the radius of
the circle. With the shortened (curtate) cycloid
(a < r) it is inside the circle radius and with the
extended (prolate) cycloid (a > r) it is outside.

r = 2, a = 2 r = 2, a = 1

r = 2, a = 4

With the basic Epicycloid, the observed point P
(that forms the curve) is on the radius of the
inner circle (a = r). With the shortened
Epicycloid it is on the inside of the inner circle
(a < r) and with the extended Epicycloid it is
outside (a > r).

In the following illustrations you can see some
of the possible curves. Below each illustration
are the chosen values.

R = 4, r = 2, a = 2 R = 3, r = 1, a = 1
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R = 4, r = 1, a = 1 R = 4, r = 3, a = 3

R = 8, r = 2, a = 1 R = 10, r = 2, a = 5

R = 2, r = 3, a = 4

Special cases arise when the radii of both circles
are equal (known as Pascal’s curve). If, in
addition, point P is on the radius of the outer
circle (a=r), the result is known as a Cardioid.
(See the illustrations below.)

R = 2, r = 2, a = 1 R = 2, r = 2, a = 3

R = 2, r = 2, a = 2 – Cardioid

With the basic Hypocycloid, the observed point P
(that forms the curve) is on the radius of the inner
circle (a = r). With the shortened Hypocycloid it is
located inside the inner circle (a < r) and with the
extended Hypocycloid it is outside (a > r). If the
radius of the outer circle is exactly four times the
size of the inner circle, the result is an Astroid. In
the following illustrations you can see some of the
possible curves available. Under each illustration
are the chosen values.

R = 6, r = 2, a = 2 R = 8, r = 1, a = 1

R = 8, r = 2, a = 2 – Astroid R = 8, r = 2, a = 1

R = 12, r = 3, a = 6
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Start Angle, End Angle

These values define the start and end positions
of the rolling circle. There is a small, but crucial,
difference between the Cycloid, Hypocycloid
and Epicycloid values.

For Cycloid you simply define the values for the
start angle and the end angle of the rotating
circle.

With Epicycloid and Hypocycloid you define the
values for the start and end points on the fixed
circle. Although the rotating circle still begins at
0°, you can view these angles as the range over
which the rotating curve becomes visible.

Angle range on the left is 0 – 360°, on the right it is 90 – 270°

Interpolation

This function defines the partitioning of the
points of a spline. These choices are described in
detail on page 129.

Plane

With this pop-up menu you define in which of
the three planes (XY, XZ, ZY) the spline primitive
is created.

Reverse Points

Using this option, the points of the spline are
reversed.
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Formula

This function creates a geometric curve based
on a mathematical formula. A list of all
CINEMA 4D’s built-in functions, operators and
constants can be found in Appendix 1.

X(t), Y(t), Z(t)

Enter a mathematical function, with dependant
variable t, for each of these directions.

t–Min, t–Max

Specify the definition range here.

Samples

Using this value you can define how many
vertices between t–Min and t–Max are to be
created. The value you enter will specify how
many times a spline will be divided (note: it will
always calculate one vertex more than the value
you input).

In the following illustration is a standard sine
wave with a definition range of –1 to +1. Below
that we see the same function but this time with
a range of –2 to +2. Both times the number of
steps was set to 10.

The same curve using various ranges for t.

As you increase the range of values that t can
take, it may be necessary to increase the
Samples size in order to retain a smooth curve.

Cubic Interpolation

Enable this option to keep down the number of
vertices. Using cubic interpolation will add
additional intermediate values between two
vertices, effectively calculated according to the
interpolation. In the illustration below you can
again see our rough sine wave (top), and
underneath with Interpolation activated.

Effect of cubic interpolation.
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What interpolation means exactly and the
implications that it has here for the shape of the
curves are beyond the scope of this manual;
there are many good mathematics books on this
subject, should you wish to know more.

In the illustration below you can see the
differences between interpolated and non-
interpolated (true) examples of the curve.

The true and interpolated curves for comparison.

Examples

X(t) = 100 * cos(pi*t) Y(t) = 100 * sin(pi*t)

Z(t) = 100 * exp(0.25*t) t = 0 ... 15

X(t) = 100 * sin(t) / t Y(t) = 100 * log(t)

Z(t) = 100 * sin(t) t = 0.5 ... 15

Interpolation

This function defines the partitioning of the
points of a spline. (Described in detail on
page 129.)

Plane

With this pop-up menu you define in which of
the three planes (XY, XZ, ZY) the spline primitive
is created.

Reverse Points

Using this option, the points of the spline are
reversed.
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Flower

This function creates a flower-shaped object.

Inner Radius, Outer Radius

The inner radius defines the size of the inner
area from where the petals begin to grow. The
petals extend from the inner to the outer radius.

Petals

This value gives the total number of petals.

Interpolation

This function defines the partitioning of the
points of a spline. These choices are described
on page 129.

Plane

With this pop-up you define in which of the three
planes (XY, XZ, ZY) the spline primitive is created.

Reverse Points

This option reverses the points of the spline.

Profile

This function creates various profile shapes.

Type

Here you choose the profile shape.

Height, b, s, t

The relevance of the individual parameters can
be seen in the following illustrations.
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Interpolation

This function defines the partitioning of the
points of the profile. These choices are described
in detail on page 129.

Plane

With this pop-up menu you define in which of
the three planes (XY, XZ, ZY) the spline primitive
is created.

Reverse Points

Using this option, the points of the spline are
reversed.
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NURBS
NURBS objects are generators, meaning that
they use other objects to generate a new
geometry. The Hyper NURBS object uses
polygon objects or primitive objects. The
Extrude NURBS, Lathe NURBS, Loft NURBS and
Sweep NURBS use spline objects. The exception
to the rule is the Bézier NURBS, which we shall
examine later in this chapter.

All NURBS objects are interactive, which means
that as you change the source object(s), the
NURBS object changes automatically. This gives
you powerful interactive modeling.

NURBS objects have neither polygons nor
points. If you wish to edit a NURBS object in
specific regions, you must first convert it into a
polygon object with the menu command
Structure > Make Editable.

Hyper NURBS
The Hyper NURBS object uses an algorithm to
subdivide and round the object interactively — a
process termed subdivision surfaces. This is an
extremely quick and simple way to create
organic forms.

First you create a simple cube and convert it into
a polygon object (see Make Editable, page 353).
Then you can use tools from the structure menu
to extrude surfaces, bevel, knife and so on to
create a complicated mesh with great ease.

You can learn much more about Hyper NURBS
in the Hyper NURBS Modeling tutorial in the
Tutorials manual.

In principle you can use any type of object with
Hyper NURBS, including polygon objects.

The source object (cage) must be a sub-object of
the Hyper NURBS object.

Both the Hyper NURBS object and the cage object are visible

Only the cage object is visible

Double-click the Hyper NURBS icon in the
Object manager to change the appearance of
the Hyper NURBS.
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You can use the dialog to specify the subdivision
level for shading in the editor and for raytracing.
Normally the value you use for raytracing will be
equal to or greater than the resolution for the
editor. The higher you set the resolution, the
smoother the object becomes, but also the more
memory it uses and more slowly it renders.

Modeling with Hyper NURBS

Here is some general advice on what to avoid
when Hyper NURBS modeling.

- A polygon can only have one neighbour on an
edge, otherwise the surface will tear. Sometimes
it is possible to repair a torn surface with the
Structure > Optimize menu command.

Here two polygons overlap each other on the left side of the
object — as a result, the polygon on the right has more than
one neighbour and the surface tears

- Only connected polygons are rounded. To
enable which polygons are connected, select a
surface, then use Selection > Select Connected.
If you want to connect overlapping polygons,
use the Structure > Optimize command.

The sides of the cube are not connected to each other

This cube, on the other hand, is ‘one piece’

- Try to work with rectangles rather than
triangles, as they produce higher quality mesh.
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Extrude NURBS
The Extrude NURBS object extrudes a spline to
create an object with depth. The extruded
object appears as soon as you drop the spline
into the Extrude NURBS in the Object manager.

You can also use splines to cut out holes. If, for
example, a single spline object has two
segments (an outer circle and an inner circle),
the inner circle will be interpreted as a hole.
CINEMA 4D detects hole splines automatically.
Even a hole within a hole is possible and the
order of the segments is of no importance.

Note

All segments must be contained within a single
spline object — additional splines will be
ignored. To connect the splines, group them
together then select Functions > Connect.

  

Left: Hole spline. Right: Hole spline in the Extrude NURBS
object.

If you click on the Extrude NURBS icon in the
Object manager the following dialog appears:

General

This section describes the General tab in the
Extrude NURBS dialog; the Details tab is
described on page 171.

Isoparm Subdivision

This defines the number of isoparms used to
display the Extrude NURBS when the isoparm
display mode is active (Isoparms, page 23).

X/Y/Z Movement

Here you can enter the extrusion distance along
the X, Y and Z axes (based on the local axis
system of the NURBS object).

Subdivision

This setting defines the number of subdivisions
along the extrusion axis.
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Start/End, Caps and/or Rounding

You can use these two pop-up menus to add
caps and/or rounding to the start and end of the
Extrude NURBS. See Details Tab, page 171.

Flip Normals

This option flips (i.e. reverses the direction of)
the normals of the Extrude NURBS.

Usually, CINEMA 4D will point the normals in
the correct direction. However, with open
contours it is not possible for CINEMA 4D to
know which way they should point. In this case
you can control the direction of the normals
either by changing the direction of the spline or
by using the Flip Normals option.

This option does not effect the caps, since their
normals are always calculated correctly.

Hierarchical

In the Extrude NURBS dialog there is an
additional option, Hierarchical. If this option is
enabled, you can group, say, several splines
within a null object and place this group in an
Extrude NURBS. Each spline of this group is now
extruded separately.

This is important especially for a text spline
when you have enabled the Create Separate
Letters option. In this case a separate spline is
created for each letter; these splines are in an
object group. So, to extrude these letters, the
Hierarchical option must be enabled in the
Extrude NURBS dialog.

Lathe NURBS
The Lathe NURBS rotates a spline about the Y
axis to generate a surface of revolution, e.g. you
can create a wine glass from a simple profile.

The lathed object appears as soon as you drop
the spline into the Lathe NURBS in the Object
manager.

Usually the profile should lie on the XY plane
(because it will be rotated about the Y axis).

   

A profile spline       The result — a wineglass

If you click on the Lathe NURBS icon in the
Object manager the following dialog appears:
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General

This section describes the General tab in the
Lathe NURBS dialog; the Details tab is described
on page 171.

Isoparm Subdivision

This defines the number of isoparms used to
display the Lathe NURBS when the isoparm
display mode is active (Isoparms, page 23).

Angle

Here you define the angle through which the
spline is to be rotated. 360° is one complete
revolution.

Subdivision

This defines the number of subdivisions along
the rotation.

Movement

If you enter 0 for the movement, the spline
rotates on a circle. With any other value, it
moves around a helix, enabling you to create
shapes such as threads and screws. A large
angle value is required for several threads.

Scaling

As you can see in the example above, Scaling
determines the final scale of the spline.

Start/End, Caps and/or Rounding

You can use these two pop-up menus to add
caps and/or rounding to the start and end of the
Lathe NURBS. See Details Tab, page 171.

Flip Normals

This flips (reverses the direction of) the normals
of the Lathe NURBS. CINEMA 4D will point the
normals in the correct direction, however, with
open contours it is not possible to know which
way they should point. In this case you can
control the direction of the normals either by
changing the direction of the spline or by using
the Flip Normals option. This option does not
effect the caps, since their normals are always
calculated correctly.
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Loft NURBS
The Loft NURBS stretches a skin over two or
more splines (although see the Note below). The
order of the splines in the Loft NURBS
determines the sequence in which they are
connected.

The original splines

The splines in the Loft NURBS

Note

You can use a single spline with a Loft NURBS to
create a surface.

If you click on the Loft NURBS icon in the
Object manager the following dialog appears:

General

This section describes the General tab in the Loft
NURBS dialog; the Details tab is described on
page 171.

Isoparm Subdivision

This defines the number of isoparms used to
display the Loft NURBS when the isoparm
display mode is active (Isoparms, page 23).

Mesh Subdivision

This gives the number of subdivisions in the U
direction.

Note

If you are using ‘open’ splines, the number of
subdivisions generated matches the Mesh
Subdivision value exactly. However, if you are
using ‘closed’ splines, the first subdivision
coincides with the last division, generating one
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subdivision less than the Mesh Subdivision
value.

You can use both open and closed splines within
the same Loft NURBS object.

Two closed splines with an open spline in between

Organic Form

If this option is not selected, the Loft NURBS
lines pass directly though the spline points and
the distances between the lines adapt to the
spline points, resulting in a very tight form. If
the option is activated, the Loft NURBS lines no
longer pass through the spline points exactly,
but maintain equal parametric distance to each
other, creating a looser, more organic form.

Organic Form selected

Organic Form not selected

Mesh Subdivision (V Direction)

This defines the number of subdivisions created
in the V direction.

Subdivisions Per Segment

You can use this option to choose whether the
mesh subdivision is divided evenly over the
entire length of the object or evenly per
segment (a segment is the section between one
spline and the next). Activating this option gives
you more control over the object’s appearance
when splines are close to each other.
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If the option is not selected the number of
resultant subdivisions per segment is calculated
using the average distance of the segments. This
may be unsuitable for animation, but it
generates more regular objects with modeling.

Subdivisions Per Segment selected

Subdivisions Per Segment not selected

Loop

If the Loop option is active the first spline is
connected to the last spline in the V direction.

Linear Interpolation

You should select this option for a linear
interpolation between the splines; otherwise the
interpolation is soft.

Adapt UV

Adapt UV is similar to Subdivisions Per Segment
— but refers to the texture instead. The texture
must use UVW mapping (see UVW Mapping,
page 542) for this option to have an effect. It is
independent of the Subdivisions Per Segment
option. The texture is projected either per
segment (selected) or evenly over the entire
object (not selected).

Adapt UV selected

Adapt UV not selected
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Start/End, Caps and/or Rounding

You can use these two pop-up menus to add
caps and/or rounding to the start and end of the
Loft NURBS. See Details Tab, page 171.

Flip Normals

This option flips (i.e. reverses the direction of)
the normals of the Loft NURBS. Usually,
CINEMA 4D will point the normals in the correct
direction.

However, with open contours it is not possible
for CINEMA 4D to know which way they should
point. In this case you can control the direction
of the normals either by changing the direction
of the spline or by using the Flip Normals
option.

This option does not effect the caps, since their
normals are always calculated correctly.

Sweep NURBS
The Sweep NURBS requires either two splines or
three splines. The first spline, the contour spline,
defines the cross section and is swept along the
second spline, called the path, to create the
object.

The optional third spline (termed a rail spline)
can be used to modify the scale of the contour
spline over the length of the object.

Note

The contour spline should lie on the local XY
plane.

You can use splines with multiple segments, e.g.
you can sweep an entire word along the path!

This logo was swept parallel along two path splines (the final
scale is 30%)

The contour spline is swept along the path in
the direction of its (the contour’s) Z axis. If you
are using a planar (two-dimensional) path
spline, there are no further considerations.
However, the behaviour of the sweep is a little
more complicated with a non-planar (three-
dimensional) path.
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If Banking is activated the following rules apply;
the contour spline is rotated at the start of the
path spline so that its X axis is parallel to the
average plane of the path spline. The contour is
still placed with its Z axis tangential to the path
spline. All subsequent contours are placed in
such a way that the angle change from start to
finish is kept to a minimum. If necessary, the
contour is also given a rotation so that the start
and end contours meet with closed path splines.

Banking allows you to use arbitrary 3D paths.
However, it is not suitable for a precise sweep
since the contours may break up, depending on
the path.

If the Banking option is not activated the
following applies; the contour spline is rotated
for each subdivision so that on the one hand its
Z axis is always tangential to the path spline and
on the other hand its X axis is parallel to the XZ
plane of the path spline. You can use this XZ
plane to control the sweep, although you do
lose the ability to model loopings, since the
contour flips over when the path runs vertical.

Finally, there is another, much more powerful
functionality; you can use a rail spline to control
the direction and/or scale of the contour as it
runs along the path.

The path spline controls the positioning of the
subdivisions. Adaptive spline interpolation is
usually a good choice since it generates a
relatively low number of surfaces. Uniform
spline interpolation, on the other hand, is the
better choice for animation since the
subdivisions will be a uniform distance apart.

Banking selected

Banking not selected

Note

A common mistake when using rail splines is to
use a path spline with adaptive interpolation.
This can generate insufficient subdivision for the
rail to work properly — a higher resolution is
required. You can solve the problem by setting
the path’s interpolation to Natural.
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Adaptive path spline

Natural path spline

Note

For more details on spline interpolation see
Spline Object, page 123.

If you click on the Sweep NURBS icon in the
Object manager the following dialog appears:

General

This section describes the General tab in the
Sweep NURBS dialog; the Details tab is
described on page 171.

Isoparm Subdivision

This defines the number of isoparms used to
display the Sweep NURBS when the isoparm
display mode is active (Isoparms, page 23).

Scaling

This gives the size of the contour at the end of
the path. The contour is 100% at the start of
the path and the size is interpolated in between.
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Rotation

This defines the rotation about the Z axis that
the contour has passed through by the time it
reaches the end of the path.

Growth

This setting defines the size of the sweep itself.
100% means that the contour spline is swept
along the entire path. If you are using a closed
path, you can set caps when the growth is less
than 100% (although you cannot select
rounding).

Note

You can animate the growth using the parameter
track in the Time Line. For example, you can
gradually write a word by using a circle spline
(e.g. radius 4, XY plane) as the contour and a
spline in the shape of the handwriting as the
path. Next, set two keyframes for the growth
parameter — done!

Parallel Movement

If this option is active the contour is swept in a
parallel manner (i.e. it is not rotated at all).

Constant Cross Section

This option is selected by default. It is ignored if
a rail path is used. It causes the contour spline to
be scaled at hard edges in order to maintain a
constant thickness throughout the sweep. The
star-shaped path below illustrates the effect:

 

Left: Constant Cross Section not selected. Right: Constant
Cross Section selected.

Banking

If Banking is selected, the contour spline will
lean into the curves of the path spline
(CINEMA 4D will calculate the banking by
considering the curvature of the path). The
initial banking angle is set to the average plane
of the path spline, which is calculated from the
position of the path’s spline points. The banking
angle must be chosen at random for straight
lines since they cannot have a plane. In this
case, we recommend that you turn off banking.
Then, the contour will run parallel to the path
spline’s XZ plane.

Keep Segments

This setting is only used if you have changed the
value for Growth. Its effect is, by and large, only
noticeable with animated growth. If the option
is not enabled, the animation growth is smooth.
However, if you select Keep Segments, the
sweep grows segment by segment. The
positions of the segments are determined by the
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path spline’s interpolation settings. An adaptive
path spline will usually lead to a jerky growth
animation if Keep Segments is selected.

Use Rail Direction

If this option is selected the rail spline will
influence the rotation of the contour spline
about its Z axis.

Use Rail Direction selected

Use Rail Direction not selected

2-Rail

If this option is selected the contour spline will
be positioned between the path and rail;
otherwise the rail controls the rotation of the
contour about its Z axis (provided that the Use
Rail Direction option is selected).

2-Rail selected

2-Rail not selected

Use Rail Scale

If this option is selected, the rail spline can be
used to alter the scale of the contour along the
path. Note that the Constant Cross Section
option will be deactivated when you use this
option (since they are contradictory).

Start/End, Caps and/or Rounding

You can use these two pop-up menus to add
caps and/or rounding to the start and end of the
Sweep NURBS. See Details Tab, page 171.

Flip Normals

This option flips (i.e. reverses the direction of)
the normals of the Sweep NURBS. Usually,
CINEMA 4D will point the normals in the correct
direction. However, with open contours it is not
possible for CINEMA 4D to know which way
they should point. In this case you can control
the direction of the normals either by changing
the direction of the spline or by using the Flip
Normals option. This option does not effect the
caps, since their normals are always calculated
correctly.
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Bézier NURBS
The Bézier NURBS differs from the other NURBS
in the sense that it does not require any objects.
Bézier NURBS stretch a surface over Bézier
curves in the X and Y direction. The control
points for these curves pull on the surface like
little magnets (apart from the edge points, to
which the surface is fixed). Bézier NURBS are
perfect for smooth, curvy surfaces such as car
wings, nose-cones and sails.

If you click on the Bézier NURBS icon in the
Object manager the following dialog appears:

X/Y Subdivisions

These settings define the number of subdivisions
in the X and Y directions.

X,Y (Grid Points)

Here you can enter the number of control points
in the X and Y directions. The more points you
set, the more control you have over the surface.

Closed

You can use these settings to close the surface in
the X and/or Y direction.

Note

If you change the subdivision the Bézier NURBS
is ‘reset’ to its starting state. Therefore ensure
you have enough subdivisions before you start.

The Extrude NURBS Details Tab
This section describes the Details tab for the
Extrude, Lathe, Loft and Sweep NURBS dialogs.

You can use the Details tab to change the
rounding at the start and end of an object. If you
set Cap And Rounding for Start or End, you can
set the following options on the Details tab:

Rounding

You can choose the shape of the rounding using
the pop-up menu. The following picture
demonstrates all the rounding types:

From back to front and from left to right: Linear, Convex,
Concave, Half Circle, 1 Step, 2 Steps and Engraved
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Start Steps

Here you enter the number of subdivisions for
the rounding at the start of the object.

Start Radius

This determines the radius of the rounding at
the start of the object.

End Steps

This is the number of subdivisions for the
rounding at the end of the object.

End Radius

This determines the radius of the rounding at
the end of the object.

Hull Inwards/Hole Inwards

The examples below demonstrate rounding
inwards and rounding outwards. Hole Inwards
refers to hole segments — it is ignored if your
spline has no hole segments.

  

Constrain Contour

This setting determines whether the object’s
dimensions are preserved or whether the object
should be inflated by the rounding. Here are
some examples:

The thick line represents the initial spline

Note

You need to take a little care when rounding
with the Constrain Contour option selected. The
pictures below demonstrate this issue. The top
picture shows the initial contour. Rounding the
contour with a small radius produces the desired
result (middle picture). The final picture shows
what happens if the rounding is set too high.
CINEMA 4D cannot detect inappropriate settings
for you in this case. It is up to you to use a
sensible rounding radius. Rounding objects by
inflating them always works, although it does
increase the size of the hull.
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Regular Subdivision

If this option is active the surface will not be
built out of long triangles but out of regularly
spaced quadrangles whose size you can enter in
the text box to the right of Regular Subdivision.

Initially there appears to be no difference at all
between the selected and deselected option
when you render or shade. However, if you turn
off the option and deform the spline so that it is
no longer planar, artefacts will appear on the
surface. The long triangles are now visible.

You can reduce the artefacts by activating the
option. Triangles will still be created at the edge.
To reduce the number of triangles decrease the
size of the quadrangles.

This option is particularly useful if you intend to
use deformation objects.

Different materials for the hull,
caps and rounding
You can apply different materials to the hull,
caps and rounding. You can convert the object
into polygons with Structure > Make Editable,
or you can use the so-called invisible selections
(see below). For example, you can use the
Extrude NURBS to create marble letters with a
golden rounded or bevelled edge.

Note

You can use existing ‘invisible’ selections for the
caps and rounding of a NURBS object.

For example, you can apply a material to the
start cap by using the Restrict To Selection
function (see page 551). You should type in ‘C1’
to apply the material to the start cap (please use
a capital C). The possibilities are:

C1 = Start Cap (Cap 1)

C2 = End Cap (Cap 2)

R1 = Start Rounding (Rounding 1)

R2 = End Rounding (Rounding 2)
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Modeling

Array
The array object creates copies of an object and
arranges them in a spherical form and in a wave
form. The wave (amplitude) is animated.

The simplest way to understand the Array object
is to see it in action. Open the 'Array.c4d' scene,
which you can find on the CINEMA 4D CD. Play
back the animation in the view panel for a
demonstration.

The original object must be a child of the array.
The copies are placed around the array object’s
origin. Double-click on the array icon in the
Object manager to open the following dialog:

Radius

This value defines the distance of the objects in
the array (in this case, the spheres) from the
array object’s origin.

Copies

Copies defines the number of copies of the
original object. Note that the original object
remains visible, so the total number of objects in
the array equals this value plus one.

Amplitude

This specifies the maximum movement in the Y
direction.

Frequency

Use this setting to determine the wave velocity.

Array Frequency

The Array Frequency defines the number of
waves.
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Boolean
The Boolean object performs realtime Boolean
operations on primitives or polygons. This
means that you can see the result in the editor
the moment you make the two objects children
of the Boolean object (try two spheres for
testing). The default Boolean mode is
A subtract B.

Note

The Boolean object also works with hierarchies.
This means you can, for example, cut not only
one but two or more holes in an object using
A subtract B . Every further cut object has to be
a sub-object (child) of the first one. If this sub-
object overlaps with a object higher in the
hierarchy, the Boolean operation will not work
at this position.

Double-click on the Boolean icon in the Object
manager to open the following dialog:

Mode

You have four Boolean modes to choose from.
Each mode is explained below with the help of a
picture:

A union B

Object A is merged with object B:

A subtract B

Object B is subtracted from object A:

A intersect B

The volume of intersection is shown:

A without B

This is similar to A subtract B, but it is not a
genuine Boolean operation. It cuts holes in
object A, but it does not cap the holes:

Note

If you need to make a ‘cleaner’ cut (i.e. if you
can see defects), increase the number of
subdivisions for the objects.
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Instance
To create an instance of an object, select the
object in the Object manager and choose
Instance from the Objects > Modeling menu.
The dialog for the instance will not open, since
the name of the original is recorded in the
dialog’s name box automatically

 If no object was selected in the Object manager
at the time of the call, the name box remains
empty. To enter a name manually, double-click
on the Instance icon in the Object manager. A
dialog opens so that you can type in the name
of the original object.

An instance object is a special duplicate of an
object that does not have its own geometry. As
a result, instances require far less memory than
conventional duplicates, but the advantages do
not end there.

Imagine that you have created a street scene
with over 40 street lamps using conventional
duplicates rather than instances. You decide that
the lamp illumination is too bright — what now?

Well, you can double-click on a light source
icon, adjust its brightness, click on OK and then
repeat the process 39 times for the other lamps.
You’ll spend some of the most boring minutes of
your life making these changes. Once you’re
done, you render the scene and guess what?
Yes, those lights are far too yellow. “Uh-oh,
that’s another 40 light dialogs to edit...”

You can spare yourself this headache simply by
using instances rather than normal duplicates —
even a complex hierarchy can be instanced.

If the street scene contains instances rather than
normal duplicates, you can change the original
street lamp and all the instances will change as
well. You may even edit the original with the
modeling tools and the instances will follow suit.
Material properties are adopted as well. Only
the position, scale and rotation are independent
of the original.

Note

The reference to the object must have a unique
name. Duplicate names will cause reference
problems when importing or duplicating objects.
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Metaball
Think of the metaball object as an elastic skin
that can be stretched over spheres, splines and
points. The skin will become active the moment
you make such an object a child of the metaball
object (drag-and-drop in the Object manager).
If you move any of the child objects, the skin
behaves like a sticky, blobby mass!

Sticky, blobby mass is not the technical term,
however. Technically, it is referred to as the hull.
The metaball object works exclusively with
parametric spheres, splines (all types) and
polygon objects. In the case of polygon objects,
each point is interpreted as a sphere.

Polygon cube (3x3x3 segments) in a metaball object

Splines have a special feature — you may use a
second spline to control the hull thickness. This
second spline must be a child of the first spline
and it must also be of the same type (why not
copy the first spline as your starting point?).

The original circles

The circles in the metaball object

You can even use a particle emitter with a
metaball object. See page 246 for a tutorial on
particle animation with metaballs.
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Double-click on the metaball icon (Object
manager)...

...to open a dialog containing the following
settings:

Hull Value

This defines how tightly the hull is applied.
Higher values mean that the hull is wrapped
more tightly around the objects.

Editor Subdivision

This defines the number of subdivisions that are
displayed in the editor.

The subdivision is specified in distance units.
This means that you should lower the value to
increase the number of subdivisions and mesh-
smoothness. Increasing the value will reduce the
number of subdivisions.

It makes sense to use a high value here (e.g.
40), otherwise the redraw rate may slow down
noticeably.

Render Subdivision

This defines the number of subdivisions that are
rendered.

The subdivision is specified in distance units.
This means that you should lower the value to
increase the number of subdivisions and mesh-
smoothness. Increasing the value will reduce the
number of subdivisions.

You should choose a low setting here (e.g. 5), so
that the surface is rendered smoothly.

Exponential Falloff

The force of attraction of metaballs to each
other is linear by default. You can change this
with the Exponential Falloff which, if enabled,
has the effect that metaballs will melt together
not linearly but somewhat jerkily.

Metaball Tag

You can assign a metaball tag to child objects of
the metaball for further control — select the
child object that you wish to fine-tune and
choose File > New Tag > Metaball Tag in the
Object manager.

The tag gives you access to the following
settings:

Negative Influence

Normally, objects attract the metaball hull and
make it expand. However, if you activate this
option, the object will repel the hull and cause it
to shrink.

Strength

You can use Strength to define how strongly the
object affects the hull relative to the other
objects.

Radius

This value determines the radius used by the
object to affect the hull.
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Symmetry
The symmetry object is particularly useful for
polygon modeling. Imagine that you are
modeling a face. Isn’t it a real pain to have to
model two ears and two eyes? Why not model
just one eye and one ear and have them
reflected to the other side of the face? Then
adjust slightly for that authentic Van Gogh look!
The symmetry object allows you to do precisely
that.

When using the symmetry object in this way,
you should model only half of the object. Let’s
try something simple: create a sphere, convert it
into polygons with Structure > Make Editable,
go into points mode and delete the right half of
the points in the front view (select the points
using the Rectangle Selection tool). Create a
symmetry object and make the sphere a child
object.

The sphere is restored to its former glory. Note
that only the left-hand side has points — the
right-hand side is, after all, just a reflection. See
what happens if you, say, use the magnet to pull
some of the points on the left-hand side.

Useful, don’t you think? We’re not done yet,
though — double-click on the symmetry icon in
the Object manager to open a dialog containing
the following options:

Mirror Plane

This determines the plane which is used as the
mirror. ZY is the default since it is used for
objects with vertical symmetry (e.g. a face) in
the front view.

Weld Points

If this option is selected, points at the mirror’s
edge are welded automatically — two points
become one. This joins your object smoothly,
avoiding a seam along the middle. You can
enter the maximum weld radius in the box to
the right of the option. Points that are within
this distance to each other will be welded
together.

Symmetric

If this option is not selected, any point that is
slightly off the mirror axis will be mirrored to the
other side and the resultant point will not be on
the mirror axis. If you activate Symmetric, the
resultant point will be placed exactly on the
mirror axis.

Note:

When working in Wireframe mode selected
polygons are drawn over by the Symmetry
Object. Therefore, only the face normals are
visible (the little yellow line in the middle of a
polygon). To be able to see the selected
polygons you should choose to work in Gouraud
Shading mode.

  

Wireframe      Gouraud Shading
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Construction Plane
The world grid is the default construction plane.
The disadvantage of the world grid is that it
cannot be moved or rotated. When you create a
construction plane, the world grid is switched
off.

The construction plane is an aid to object
placement. You can place objects, splines and
points onto the construction plane. For example,
you can move and rotate the construction plane
so that you can place tiles straight onto a
slanted roof.

So that objects, points, surfaces etc. come to
rest on the construction plane, activate the
corresponding options in the Snap Settings (see
page 375).

For example, if you activate spline snapping and
draw the spline in the 3D viewport, it will be
drawn straight onto the construction plane.
Note that the mouse pointer must remain below
the horizon line in the process.

Double-click on the construction plane icon in
the Object manager to open a dialog with the
following settings:

Type

The construction plane can be in the local XY,
ZY or XZ plane.

Grid Spacing

This defines the distance between grid lines.

Lines

You can use this to set the number of grid lines
in both directions. 100 is the default setting.
Enter a higher number if you need to increase
the size of the construction plane.

Major Lines Every nth

Major lines are darker than normal lines. Use
this setting to determine the number of normal
lines per major line.
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Scene
Scene objects provide you with control over the
final appearance of your scene. These are:

Camera page 181

Target Camera page 185

Light page 186

Target Light page 228

Sun Light page 228

Floor page 230

Sky page 231

Environment page 232

Foreground page 233

Background page 233

Stage page 234

Camera
As well as the default camera in the 3D
viewport, you may add as many additional
cameras as you need. Each camera can view
your scene from a different perspective.

When creating a new camera the position and
focal length are not taken from the 3D viewport
but from the active viewport — which could be,
perhaps, Front or Back. So if a camera is created
in the Top viewport, Top will be set as the
Projection method in the Camera dialog.

To open the Camera dialog, double click on the
camera’s icon in the Object manager:

When placing and aligning a camera, CINEMA 4D
uses the camera coordinate system. This system
behaves in such a way that the X and Y axes
define the focal or film plane, and the Z axis
indicates the direction that the camera is pointing
and displays this view in the viewport.

In the viewports, the camera is shown as a cube
with two spools of film and a lens:
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Additional camera parameters are described
below.

Projection

To show all objects in a scene, CINEMA 4D
displays them using a central perspective
projection. By default, objects are shown from
the viewpoint of this virtual camera.

Alternatively you can select from a variety of
other types of projection (e.g. dimetric or
isometric views, which are commonly used in
technical applications).

Some examples follow: top left; central
perspective, top right; gentleman projection,
bottom left; dimetric and bottom right; isometric.

Camera Type

From this pop-up you may select from a list of
typical types of camera lens with preset focal
lengths:

Normal 36 mm
Telephoto 200 mm
Super-Telephoto 1000 mm
Wide Angle 18 mm
Fish Eye 10 mm
Super Telephoto 1000 mm

Zoom

For all camera projections except Perspective, by
definition there is no focal length, so you may
type a zoom factor into this box if required.
Values from 0.1 to 10000 are acceptable.

Typing a number in this box is the same as
zooming with the Camera tool selected.

Focal Length

The CINEMA 4D cameras, like their real world
counterparts, use a lens system. You are free to
choose from different lenses and to specify the
focal length.

Note

The camera model used in computer graphic
programs corresponds to a pinhole camera with
infinite sharpness. Therefore CG focal length is
to be understood only as a simulation and
corresponds in no way to a physical model.

Short focal lengths give a wide-angle view and
are ideal for a good overview of the whole
scene. They do, however, distort objects in the
scene — a particularly striking effect is that of a
very short focal length such as a fisheye lens.

Large focal lengths correspond to a telephoto
lens, they display a very small area of the scene
since they can capture only a small spatial angle.
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This is compensated by the fact that you can
capture far more detail with hardly any
distortion. With an extremely high value used as
a focal length, the perspective depth is lost
completely as the perspective projection
changes into a parallel projection.

Aperture Width

You can manually adjust the field of vision
(FOV) and focal ratio by typing an aperture
width into this box and/or manually adjusting
the focal length.

Depth of Field

CINEMA 4D will also let you simulate the quality
of the lens system, blurring with an increased
aperture, which is known as depth of field.

Depth of Field lets you specify which part of a
picture will be out of focus. You have a choice
of Front or Back, depending on whether you
require the objects at the front or the back to be
displayed clearly.

You can also choose to have the central range in
focus, in which case both the front and back of
the scene will be out of focus. Selecting None
will leave the settings unchanged and will
display all objects in focus.

If you use depth of field in your scene, the
following options will let you define the effect
more precisely. Depending on the settings, not
all options may be available to you.

Sharpness

Defines the distance from the camera at which
the picture will be perfectly sharp. Depending
on the Depth of Field values, the sharpness will
decrease towards the front or the rear.

Front/Rear Focus

Determines the distance from the camera to the
front and to the rear of the scene where objects
will become completely out of focus.

Note

The contrast of the grayscale depth channel is
controlled by the sharpness settings of the
camera. You will get optimum contrast if Front
Focus is set to immediately before the first
object of the scene and Rear Focus set to
immediately after the last object. The easiest
way to control these values is to interactively
adjust the camera’s handles in a viewport (see
below, Interactive control of the camera).

Note

Remember that depth of field will appear less
obvious at high resolutions.

Show Cone

If you enable this option, the volume seen by
the camera will be displayed in the 3D viewport
as a green pyramid.
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Interactive control of the
camera and its parameters
Cameras will be frequently used, so ease of use
is important. To make things simple, you can
adjust the camera parameters without having to
open the dialog — simply use the adjustable
handles in any viewport.

Follow this example to see how to manipulate a
camera in the 3D viewport:

- Create a new, empty document.

- Create a camera object and set the Depth of
Field Front and Rear values to 500 and 2000
respectively.

- Now take a look at the camera object in the
3D viewport.

Select the menu option Edit > Frame Scene.
Zoom out until you can see the camera object
completely. The camera symbol is now relatively
small, similar to this illustration (you might want
to switch to a single 3D viewport for a better
view of the scene):

We will now describe the process in more detail.

A green line runs from the camera origin,
ending in a single orange point. This is the
target point of the camera. You can grab this

point with the mouse, move it and align it to
other objects, thereby rotating the camera
around its origin.

At the same height as the target point there is a 4-
sided plane with grab points. This is the focal
length plane. At the center point of each side of
this plane is an orange handle. These handles
allow you to change the focal length interactively.

Switch to the 3D viewport, activate the camera
object and adjust the focal length. You can see
the adjustments in realtime.

There are two further, optional, planes that run
parallel to the focal length plane, one in front
and one at the back. These two planes (or just
one of them) are available only if you select a
depth of field. At the center of each plane you
will see another orange handle. Use this handle
to shift the depth of field plane interactively
along the Z-axis of the camera. Again, you can
see these real time adjustments in the viewport.

You may also adjust the focal range i.e. the area
that is shown in focus.

By holding down the Shift key while dragging
the handles you will see that the entire plane,
rather than just the focal length, can be moved
along the Z-axis.

As you see, interactive control of the camera is
very easy.

As mentioned earlier, you may create as many
cameras in CINEMA 4D as you wish. Keep in
mind that it is always the active camera that is
used for rendering.

Switching cameras during animation is achieved
using a Stage object – see page 234.
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Cameras Menu

Scene Cameras
Each view may have its own camera. The editor
camera is used by default but you may create
and use your own cameras. The Scene Cameras
sub-menu will display a list of all the cameras
you have placed in your scene, from which you
may choose one for each view.

Link Active Object
After creating a camera, the view is not initially
switched to the new camera. You can move the
camera in a viewport and see your adjustments
to the camera in the scene.

In order to view using your new camera you
must activate the view by selecting Link Active
Object from the Cameras menu of the
appropriate viewport. Now the viewport will
show the new camera view.

Note

With more than one camera in a scene, you may
assign each of the respective camera views to
your main viewport and very easily switch
between different cameras and their views.
Alternatively you can open and attach an
individual viewport for each camera object and
its view. Then you may control all the scene’s
cameras at the same time.

Editor Camera
To cancel the view from a selected camera,
detach it using this command. This removes the
view connection from a camera and shifts back
to the editor (default) camera view.

Note

Camera objects are not only used as cameras.
You can also use a camera to help you align your
scene elements and objects. This would make
sense with a spotlight for instance (see
page 190) when, like camera objects, the Z-axis
is used as the line of sight.

Target Camera
In principle, a target camera is no different to
the standard camera described above. However,
a target camera is assigned a target expression
automatically. In addition, a target object ( a
null) is created. If you move the target object,
the camera will rotate to follow it. Similarly, if
you move the camera, the camera will rotate at
the same time so that it continues to point at
the target object.
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Light
When building a new scene in CINEMA 4D a
default light is used. This light is positioned to
the left of your initial view in the Perspective
viewport.

If you want to change the default lighting setup
for all future scenes, build a new scene that
contains only the lights that you require for your
default lighting and save this scene as ‘new.c4d’.
This setup will then be opened automatically
each time you start a new CINEMA 4D scene.

Note

All other CINEMA 4D scene/environment
attributes (Sky, Floor, Environment and so on)
can be added to your default scene setup in this
way.

Note

If you try to fade out your animation, you may
notice problems with the default lighting being
switched on automatically once your scene
reaches total darkness. This happens when
CINEMA 4D detects that you have no lights set
above 0%. To prevent the autolight from
engaging, disable the Auto Light option on the
Options tab of the general settings.

Displaying Lights in a Viewport

The lighting within a scene can be easily
previewed by turning on the Gouraud shading
option. This option will update your lighting in
realtime, even adjusting the lighting and
updating your scene as you move the lights
around.

If your scene is complicated and updates too
slowly when moving your light with the Object
tool, adjust your light’s position with the Model
tool.

the Object tool and the Model tool

Name your light in the Object manager by
double-clicking on its name.

To change the properties of your light, double-
click on its icon in the Object manager.

 This opens the light dialog.
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Light Settings
This dialog provides the details of each light
source in your scene

General

Many of the light attributes that you select here
(such as Noise) have their own tab on which
you can give more detail of the particular
feature. We will give an overview of these
features here; more detail can then be found in
the section on the relevant tab, later in this
chapter.

Color

You can adjust the color of each of your lights
using the slider controls and the text input fields
for each color element (R,G,B). You may change
the color system (perhaps to HSV 0...255) using
the pop-up menu below the color box.

The brightness of each light is independent of
the light’s color and can be controlled with the
bottom slider (Brightness). By adjusting
brightness values with the slider control you can
simulate any type of light from the small glow of
a candle to the extreme brightness of sunlight.

In most cases the maximum slider value of
100% will suffice, but in extreme cases a value
of up to 1000% can be manually typed into the
adjacent text field.

It is also possible to use the color sliders to
achieve negative lighting effects, which is
discussed in detail below.

Type

You may change the type of light with this
selector. Detailed explanations of each light type
are given later in this chapter.

Shadow

Using this selector you may choose to have
various shadows generated by your light source,
or no shadows at all. Detailed explanations of
the different shadow types are given in the
Shadow tab section of this chapter.

Select None if your light is to cast no shadow.
This is a very helpful option in a scene with
many lights, allowing you to turn on shadow-
casting for the main lights only. Any real world
photographer will envy you this option and its
possibilities.

Visible Light

With this pop-up you can adjust the visibility of
the light in your rendered scene.

In nature, light normally becomes visible only if
small particles such as dust, insects, smoke or
fog are present in the air. For example, if a car
headlight shines in fog, you will see its cone of
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light quite distinctly. Detailed explanations of
these various types of visibility are given later, in
the Visible Light section of this chapter.

Noise

With this option you can make your lights
exhibit irregularities in the visible light or on the
surface lit by the light.

Effects such as animated fog or sun flares can be
achieved using this feature without needing to
resort to the use of possibly time consuming
volume shaders. Note though that lights with
this noise effect do have a small price to pay in
rendering time, as any light using the Noise
feature is slower to calculate than those
without.

No Light Radiation

If you need to see just the visible light and/or its
lens effects without the light source actually
casting light onto your objects, activate this
option. Should you need your light sources for
special effects (such as the exhaust gas of a jet
engine) enable this box, otherwise your render
times will rise.

Show Illumination

Selecting this option will show a wireframe
approximation of the light’s illumination range in
the viewports. This range can then be adjusted
by dragging the handles on the wireframe
representation.

Show Visible Light

Selecting this option will show an approximation
of the light’s visible range in the viewports, not
to be confused with the aforementioned
illumination range. It may become confusing if
both indicators are turned on in the viewport.
For this reason, this option is turned off by
default. Again, this range can be interactively
adjusted with its handles.

Show Clipping

Selecting this option shows an approximation of
the selected light’s clipping range (restriction of
the light range — see later) in the viewports and
can also be interactively adjusted with the
wireframe’s handles.

Memory

This indicator shows the amount of memory
needed for the selected light sources in your
scene.

Here is an overview of the memory
requirements for light sources:

- Hard shadows/Area shadows need memory
intensive raytracing calculations.

As more objects are added to a reflection/
refraction dependent scene, additional memory
will be required.

- a Soft-shadowed visible light will need a
Shadow Map of at least 250KB X-resolution *
250KB Y-resolution
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- Omni light sources require six times as much
memory for their shadow maps.

- When used in combination with textured
transparencies (Light Maps), up to twenty
times more memory can be needed.

Render Time

This indicator gives an approximate render time
for the selected light source.

Here is a short overview of lighting render times.

- Soft shadows are calculated much more quickly
than Hard shadows, Hard shadows being much
faster to calculate than Area shadows.

- Making a light visible in a rendered scene adds
a negligible amount to its render time. Using a
Volumetric light increases render time,
sometimes substantially, in relation to the
Sample Distance.

- Noise adds to render time, with Hard and Soft
Turbulence requiring more calculations than
basic Noise, while Wavy Turbulence roughly
doubles rendering time over that of standard
Noise.

- Using a high sample radius will increase the
render time of soft shadows.

- Tube light and Area light sources also increase
render time, although not to the same extent
as the processor intensive Volumetric light.

Types of Light

This section describes the types of light sources
you can select from the Type pop-up on the
General tab.

Omni

An Omni light source acts like a real life light
bulb — casting its rays in all directions.

Placing an Omni light into the center of your
scene will illuminate your scene evenly.
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Spot (round/square)

Spotlights cast their rays in just one direction,
which is along the Z axis by default. Once
created, they can be easily moved and rotated
to light individual objects and certain areas of a
scene. The spotlight source can project a round
or a square cone of light.

Square light cones are ideal for, amongst other
things, the simulation of projectors which
require a square picture to be cast onto a wall.

Some typical examples of round spotlights are
car headlights, torches etc.

Distant

The Distant light type is so called because it
mimics the light that is cast from an infinite
distance. Using a Distant light would, for
example, evenly illuminate the whole of a floor
object in all directions.

Since a Distant light is infinite, the light has no
actual origin. Thus the exact placing of a Distant
light, near or far, has no effect on your scene’s
objects. Only the actual direction in which the
light is facing is important with this light source.

Distant light sources are very suitable for the
simulation of sunlight.

Note

Owing to its characteristics, the distant light
source itself cannot radiate visible light.
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Parallel

Parallel lights resemble a very distant light
source. Unlike the Distant light source however,
the Parallel light has an origin and simulates a
large, single axis wall of light.

By default, all Parallel lights when created will
radiate light rays along the Z-axis. These lights
take the appearance of an infinitely large
surface, radiating parallel light in a single
direction; anything behind the point of origin
will not be illuminated.

Note

Like the Distant light, Parallel lights cannot be
rendered as a visible light.

Parallel spot (round/square)

Parallel spotlights resemble the regular spotlight
source object, but do not have light cones to
define falloff or distance. Instead, light rays are
cast along cylinders and/or bars.

The origin is important in defining which objects
in a scene will be affected by this light. The
radius of the spotlight can also be modified
using the adjustment handles.
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Tube

Tube lights do not have an exact point of origin,
but a linear one. The Tube light is represented
by a line, from which light is radiated in all
directions. When used as a Visible light, this is a
very quick and easy way to make neon tubes.

A classic example of the use of the Tube light is
of course the laser sword.

Quick tip

Tube lights are a great way to produce long-
drawn-out specular highlights.

Area

The light rays from an Area light expand from its
origin outwards in all directions. A rectangular
computer screen is a good example of such a
light.

The resultant lighting and specular effects are
somewhat different from those of an Omni
light. Specular highlights are more angular and
the surface illumination is richer. The closer the
light source is to the object, the more apparent
this becomes.

However, an Area light with a small radius that
is placed far away in a scene will hardly seem to
differ from an Omni light source.

Note

As with the Distant and Parallel lights, an Area
light cannot be rendered as a visible light source.
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Types of Shadow

This section describes the different types of
shadow you can select from the Shadow pop-up
on the General tab. The Shadow tab itself is
described on page 204.

You can combine all light source types with all
shadow types in CINEMA 4D. For example an
area light can cast not only area shadows, but
hard shadows as well. And a parallel light can
easily cast soft shadows.

There are no restrictions to this mixing of lights
and shadows, since the shadow is computed
independently of the light source.

Hard shadow

Traditionally in raytracers, genuinely raytraced
scenes contained hard shadows. As this
technique needed to compute many more
additional rays, this method increases the render
time dramatically. Hard shadows, because of
their abrupt, sharp appearance, are of particular
interest for technical illustrations. However, in
other more natural pictures they look rather

unrealistic because such hard, sharp shadow
borders are rarely found in real world
environments.

Soft shadow

In reality all objects — whether they are trees
growing in the wild, or a vase in a room — are
lit by several partial light sources. The result of
this is a gradual transition of light to shadow.

This soft edge, or umbra, can be simulated in
CINEMA 4D by using a so-called shadow map,
the Soft shadow. A shadow map is a gray scale
picture of the scene seen from the view of the
light source. Contained in this are all the objects
lit by the light source.

During the render calculation the renderer will
determine exactly which objects will fall into this
shadow of the light source.
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The major advantage of this method is the high
computing speed and the soft shadow’s natural
appearance.

However, the one downside to soft shadows is
the memory needed. Depending on the size of
the shadow map, a great deal of additional
memory may be needed. So be careful in your
allocation of shadow maps or you may find your
scenes wasting precious memory.

Area

Although Soft shadows are more natural than
Hard shadows, they are still not perfectly
natural. On careful examination you can see
that the soft edge always has the same width.

In nature this does not happen; the nearer an
object is to a surface on which it casts its
shadows, the sharper this edge will be. Area
shadows simulate this effect perfectly.

Take a look at the above illustration. Where the
shadow borders on the sphere, it has a very
hard look. As the shadow falls away from the
sphere it becomes softer.

How does this work? Quite simply really;
CINEMA 4D calculates the shadow at the origin
of the light source outwards (for all lights,
whether Omni, Spot or area). Only a hard
shadow is computed at this point. The softer
Area shadow is the result of a virtual Area light

source, which simulates the overlay of several
light sources. This provides the natural
scattering of light.

However, as usual, this method comes with a
price; high render times. The result, in many
cases, does not justify the high render time,
since the Soft shadow will often be sufficient.
Carefully assigned Area shadows, however, can
produce very impressive effects.

An example of a realistic shadow
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Types of Visible Light

This section describes the different types of
visible lights you can select from the Visible
Light pop-up on the General tab. The Visible
Light tab itself is described on page 212.

In CINEMA 4D all light sources and/or the light
cone emitted can be made visible. This kind of
effect can be seen for instance in a smoky room.

This effect is comparable to fog, which does not
diminish light, but rather adds to its brightness.

With Visible Light you can produce the most
stunning computer graphic effects. Headlights,
glowing and shimmering lights, laser beams and
atmospheric effects to name just a few.

There follows a description of the various types
of visible light, available from the Visible Light
pop-up in the General tab.

Visible

If the Show Visible Light option is enabled
(General tab), the light source will produce
visible light that passes through all objects. So

for example a visible light could be placed in the
center of a planet’s sphere to simulate an
atmosphere.

The Show Visible Light option is of special
importance to the particle system. Visible lights
(with No Light Radiation enabled) lend
themselves to a huge range of possible effects,
e.g. nebula clouds, smoke, comet tails, fires and
much more. See page 245 for details on how to
create these effects.

A simple example of visible light

Volumetric

If you have already played with the visible light
settings, you will realise that a visible light pays
no attention to objects which lie in its cone of
light. The light rays penetrate objects
unhindered, casting no shadow in the visible
light’s beam.

In order for a shadow to be cast by a visible
light, Volumetric lighting must be added. Visible
Light > Volumetric therefore must be selected in
the General tab.

The parameters for the visible Volumetric light
are taken from the light source’s shadow map
values; X-resolution, Y-resolution, Parallel Width
and the Sample Radius. The algorithm for
Volumetric light is based on the shadow map
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and needs these parameters. (These shadow
map parameters are covered in more detail
earlier in this chapter.)

This is volumetric visible light; shadows can be cast within the
light cone

Inverse Volumetric

Using the Inverse Volumetric function has the
interesting effect of inverting your volumetric
light — that is, the light is visible where the light
cone would normally be in shadow.

An explanation is in order. Imagine a company
logo, behind which you have placed an Inverse
Volumetric light source. This inverts the light’s
volumetric effect, giving the impression that the
light is radiating from the logo itself.

The quality and render time of inverse
volumetric lights could be optimized even more.
To calculate this light type a much lower Sample
Distance and less render time are needed.

With inverse volumetric lighting, the light appears to emanate
from the object

Types of Noise

This section describes the different types of
noise you can select from the Noise pop-up on
the General tab. The Noise tab itself is described
on page 217.

Illumination

You can add irregularities to your light source in
order to give it a realistic appearance.

A light’s illuminated surface is very rarely evenly
lit — particularly if dust or small particles are
present.



CHAPTER 7 • OBJECTS MENU • 197

Visibility

This option adds irregularities not to your lit
surface, but to the visible light itself.

With this you can simulate for example the
waving effect of fog, which is visible in the light
cone.

Here is one example:

Using the Noise effect, you can produce very
interesting effects, such as a supernova, simply
by setting the internal and external colors of the
visible light to yellow and red.

Both

Using this option will ensure that both the basic
light and any visible light are provided with
noise irregularities.
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Details

Using the Details tab, you can access the
individual properties of each of your light
sources.

Inner Angle

Depending on the type of light you use, this will
adjust either the Inner Angle (for a standard
Spotlight) or the Inner Radius (for a Parallel
Spotlight) of the light.

Within the Inner Angle area, the luminosity
value of the light source is 100%. From the
Inner to the Outer Angle the luminosity value
falls from 100% to 0%.

If you switch off the Inner Angle, the luminosity
of the light source in the entire light cone
amounts to 100%, resulting in a hard cone of
light; the following picture shows this.

If the Inner Angle has a value of 0, the light
source will have a soft transition spreading from
the center of the light to the light’s edge, as
shown below.

Outer Angle

Adjusting this value will define how large the
light will be in total. The Outer Angle value
indicates the limits of the light source’s
luminosity.

Aspect Ratio

This option allows you to stretch and shear the
shape of the light’s cone angle. The standard
aspect ratio value is 1; increasing the value, for
example, to 2 will double the light cone’s height
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relative to its width. Similarly, decreasing the
value to 0.5 will make the light cone only half as
high as it is wide.

Note

This effect can also be achieved by scaling the
axes of the light source using the Object tool
and/or the Object Axis tool.

Object Tool

Object Axis Tool

Brightness

This value controls the overall brightness of the
light source.

While this control may be seen as just a way of
brightening/dimming your light source, it’s also
capable of another interesting, and very useful,
effect. Using a negative value with this option
results in negative lighting. The color of your
light source (set in the General tab) is important
here. That color will not be added to the scene
where a negative light source is in effect. With
this technique you can artificially darken and
shade specific areas of your scene.

This type of lighting works even better when
used with carefully constructed environment
lighting and falloff ranges. A good
understanding of environment lighting is needed
for this and this is covered later in this chapter.

Contrast

The intensity of a light source on an object is
not dependent on the distance of the light from
the object (unless you explicitly adjust its falloff),
but rather on the angle at which its rays hit the
object.

If a ray hits a surface at an angle of 90°, the
surface is illuminated with the light’s maximum
intensity (taking any falloff into account). As this
angle (called the angle of incidence) decreases,
the strength of the illumination decreases as
well. Therefore, in an average scene, a soft
transition is normally seen on any lit surfaces.
The Contrast value controls this transition.

In the illustration you can see a series of pictures
of a planet, towards which a light is directed.
You can easily see how little the planet’s front
and sides are lit using 0% contrast. The
transition on this lit surface is not very soft; this
surface contrast is not natural for planets. If you
look at photographs of a planet you will see that
the transition of its lit surface to its shadowed
edge is hard — as illustrated further to the right
in the series of pictures.

With the contrast control you can adjust how soft
or hard you wish the lit surface transition to be.
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If you need a special overly-soft look to your
objects you may even enter negative values,
here‘s an example:

Inner Color

Independently of the light source’s color, which
was assigned in the General tab, you may assign
another color to the internal range of the light.

When used, this Inner Color is the core color of
the light source. Starting at 100% of its value,
the Inner Color spreads outwards and gradually
changes into the light source’s General color. For
the Inner Color to be used, the Falloff function
(see below) must be activated.

The Inner Distance of the Falloff determines the
expansion of the Inner Color. Click on the color
chooser to select the color properties of your
internal color.

In this illustration the light source is yellow and
the Inner Color is red. The light shows a gradual
progress of color change from red to yellow.

Colored Edge Falloff

This option is only available when using a
spotlight with an Inner Color option selected.
The normal behaviour of the inner color is to
spread in a linear direction along only the Z-axis
of the spotlight, from its origin to the light
source’s color (selected in the General tab).

If you select Colored Edge Falloff, however, the
Inner Color will also radiate outwards from the
Inner Angle through to the light source’s general
color.

In this picture Colored Edge Falloff is deactivated.

Here Colored Edge Falloff is on – you can see the inner color in
the center of the light cone.

Falloff

A normal virtual light source will illuminate its
surrounding environment with a continuous, linear
brightness. However, this is not how all lights work
in reality; real light sources will have their
luminosity absorbed. Just as in nature,
CINEMA 4D light sources are able to have their
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luminosity reduced over any distance. To achieve
this, several falloff functions are available in this
pop-up and are illustrated below.

Inner Distance

Within the Inner Distance there is no falloff. Up
to this point, the brightness of the light remains
constant. Outside of this boundary is where the
Inner Distance Falloff begins.

Outer Distance

The range between the Inner Distance and the
Outer Distance is where the brightness of the
source light changes from 100% to 0%. This
Outer Distance value indicates the maximum
range that will be illuminated by the source
light.

Near Clipping

You can use clipping to restrict the illumination
and visible light (if present) radially with an
Omni light and linearly with all other light types.
This means your light source does not have to
radiate light from its origin; the radiation may
begin, for example, five meters from the light
source’s origin.

The two values used for this effect are From and
To and signify, in metres, the distance for the
clipping effect. The larger the difference in the
two values, the softer the transition.

From = 90, To = 90

From = 90, To = 150
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Example:

- If values of 10m and 50m are used in the two
fields, it means that there will be no
illumination from the light source between 0
and 10 meters; from 10 metres the luminosity
begins, reaching full luminosity at 50 metres.

Far Clipping

Far Clipping can be used to cut off your light
source’s illumination abruptly. To use Far
Clipping, once again two values are needed.
This time the From and To values denote where
the cut off begins, and where the light source
will fully vanish. Again, the larger the difference
between these two values, the softer the
transition. Examples of clipping with point and
spotlights are shown below.

From = 300, To = 300

From = 220, To = 300

Schematic Display of the individual clipping ranges using the
example of an Omni light source

Ambient Illumination

Normally the brightness of a surface is
determined by the angle at which a ray of light
hits it. The greater the angle between the ray
and a tangent to the surface, the more the
surface will be lit by the light.

When Ambient Illumination is switched on,
however, this physical law is waived. Here the
angle does not matter. All surfaces are lit with
the same intensity. Thus a much flatter look
results. Only the material color is considered in
the lighting calculations.
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In this example picture, the light’s Falloff was
also activated.

With both Ambient Illumination and Falloff
activated for the light source, you can lighten
certain regions of your scene in a similar way to
how you darken them with Negative Lighting,
explained earlier.

No Diffuse

When No Diffuse is selected, the color
properties of an object are ignored by the light
source; only specular surfacing is produced by
the light. This can be useful for some objects
e.g. a golden signature, where you would like
some specular glints, but no lightening of the
color properties.

Writing with No Diffuse  off

Writing with No Diffuse  on

No Specular

When this option is selected, the light source
produces no specular highlights on your scene’s
objects. Imagine you have a wineglass on a
table with two or more light sources in the
scene. Your wine glass may then show too many
specular highlights, with the glass material
looking too busy. To avoid this, turn on No
Specular for some of your light sources.

This bottle is lit by two light sources, causing
several highlights to develop.

In this picture, the No Specular option is
activated for one of the light sources.
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Separate Pass

If you enable this option, separate diffuse,
specular and shadow layers will be created for
the light source when you render (provided you
have set the multi-pass parameters accordingly –
see Separate Lights / Mode, page 437).

Shadow

This attributes tab is used for the fine-tuning of
your scene’s shadow maps.

Density

Adjusting this value will vary the intensity of
your shadow. A value of 100% means the
shadow has full intensity. With 50% your
shadow will be half transparent, and at 0% the
shadow is invisible.

Color

Here you can change the shadow’s color. You
may be asking yourself why you would ever
need to do this. With a little thought, however,
you may realise that in nature a shadow is

hardly ever truly jet black. Coloring your shadow
with a shade of brown, for example, could give
a particular scene some natural, extra warmth.

Bias

Because of the particular principle involved in
the calculation of shadow maps (shadows do
not begin at the object’s origin), you may at
times find the need to adjust the shadow’s
position using the Bias value. Usually a value of
1m will suffice for most scenes. However,
sometimes an adjustment may be necessary.

When zooming the camera in on extremely
small objects, this distance between object and
shadow will become apparent (see illustration
1). Entering a lower value can correct this error
(see illustration 2). You may also at times have
too small a Bias value (e.g. with very large
objects), which can result in the object casting
the shadow on to itself (see illustration 3). In a
case like this, set the Bias value somewhat
higher.

Illustration 1
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Illustration 2

Illustration 3

Note

The smaller an object is and the more you zoom
in on it with the camera, the smaller the Bias
value must be set. This ensures no gap between
object and shadow is visible. If the object is
excessively large and unwanted self-shadowing
occurs, raise the Bias value. Generally speaking,
a value of 1m is adequate for all objects up to a
size of 10000m.

Absolute

You should leave this option activated. If you
switch it off, the distance of the shadow from the
object depends also on the distance of the light
source from the object – so-called relative bias.

With relative bias, the further the light source is
from the object, the further the shadow will be
from the object. This behavior originated in
version 5.x of CINEMA 4D and is present for
backward compatibility (i.e. for the loading of
old scenes).

Transparency

If you need your shadow maps to consider the
transparent (or genlocking) properties of your
objects, you should switch this option on. When
activated, your shadows will take into account
the transparent surfaces of your objects and
render your shadows with the correct
transparency. Transparencies can also be
computed with all other shadow types.

The Transparency  option is on

The Transparency option is off
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Note

The calculation of transparent soft shadows uses
lots of memory.

An Omni light source can sometimes use six
times as much memory as a spotlight, as six
shadow map calculations must be computed
compared to the spotlight’s single shadow map.

Clipping Influence

If you select this option, the clipping settings on
the Details tab will be applied to shadow-casting
as well.

Area Shadow

This value will set the parameter range for your
Area shadow.

Width

As described above, the area shadow is
produced by a virtual Area light source
(independently of the actual light source). This
Width value indicates the size of this surface.
The larger you make this value, the more the
light is scattered and the softer the shadow
becomes. However, as the value is increased, so
is the render time, sometimes substantially.

With large radius (300 m)

With small radius (50 m)

Samples

If you lower this value, the quality of the area
shadow is reduced, but it is calculated more
quickly.

Soft Shadow

Use this for the finer details of your soft
shadows.

Map Size

When using soft shadows, CINEMA 4D initially
sees the scene from the point of view of the
light source and calculates the complete scene
from this view. All objects seen in this view are
interpreted as shadows for the scene. This
results in Shadow Maps.

Map Size assigns memory for each shadow
map. The smaller the memory assignment, the
more pixelated the shadow will appear. This can
result in a shadow map with a jagged, staircase-
like appearance at its edges. The more memory
used for the Map Size, the smoother the
shadow and its edges, but the higher the
memory usage.
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By default, a standard size of 250x250 is used
for Map Size. Shadow map size can increase to
1000x1000 if needed, but such extreme usage is
rare and not recommended.

You can clearly see that, in order to keep your
shadow sharp and smoothly defined, your
shadow map will need to increase in size.

If you simply need to keep your shadow edge
soft, you can increase the Sample Radius (see
below). Again, this will increase render time.

Note

Rather than use a map with a doubled Map Size,
you can achieve an equivalent soft edge by
doubling the Sample Radius.

Sometimes when you have a small shadow map
created by a very distant light source, a problem
may appear with spherical objects casting
rectangular shadows.

You can enable this by viewing the scene
through your light source. A light source, like
any other scene object, can be defined as a
camera view. To do this make sure your light
source is selected and go to the Function menu
of the object editor and select Attach Camera,
or in a viewport select View > Attach Camera or
select the appropriate icon in the tool bar.

X-resolution

If the preset value of the map size is not giving
you the desired result, you may optionally adjust
the X-resolution manually. In general it is
standard to set the manual X-resolution (width)
to the same value as the Y-resolution (height)

Y-resolution

With a spotlight source, you can also provide a
non-square shadow map by manually entering a
value for the Y-resolution.

Memory Usage

CINEMA 4D automatically calculates the
maximum memory use for the shadow map,
which is shown here. This can help you in
estimating exactly how much memory will be
allocated for your light sources shadow map
calculations in your scene.
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Sample Radius

The sample radius determines the accuracy of
the shadow map. The higher the sample radius,
the more accurate the shadow is, at the expense
of a higher render time. If, for some reason, you
must use a small shadow map, selecting a higher
Sample Radius value will improve the shadow
quality. So you can trade off render time against
memory usage.

Parallel Width

This setting will only be active for Distant and/
or Parallel lights.

Here we meet a visible light setting known as a
light cube (more accurately, a light cuboid). This
light cube has its length/width dimensions set to
the Parallel Width value, the depth (z-axis) of
the light cube being infinite. Importantly, only
objects within the cube can cast shadows.

The boundary for shadow-casting is a necessity
since the scope of parallel/distant light sources is
infinite. This value cannot dynamically adapt to
your scene, as it is possible for other objects to
jump into the shadow-casting area during an
animation. Therefore, a fixed value is used,
which is entered here.

Explanation

With soft shadows you can change the size of the
shadow map. The lower this value, the more
pixelated the shadow becomes. If the parallel light
cube boundary had a dynamic value, these pixels
would appear to jump, since the shadow map
would otherwise vary dynamically in its size. In
order to prevent this, a fixed value is used, and
any such shadow jumps are eliminated.

Outline Shadow

Using this option will result in your shadow
being seen as just a thin outline, instead of a
full, darkened surface.

Note

With this option, it is recommended you use
higher values for the shadow maps resolution
and sample radius.

Use Shadow Cone

One of the main problems with Omni light
sources is that six shadow maps must be
computed in total, which can sometimes
produce small artifacts at the shadow’s edges. If
the Use Shadow Cone option is activated, the
shadow production is limited to a cone, thus
generating a single shadow map which is free
from artifacts.
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Additionally, producing these shadow maps only
where necessary will result in the saving of lots
of render time.

Soft

Activating this option will give the shadow cone
a softer edge.

This option is used to ensure that any object
which is only partially in the shadow cone area
casts a soft, fading shadow.

Angle

This value changes the vertex angle of the
Shadow Cone.

Caustics

Surface Caustics

Enable

Use this option to enable caustics for the active
light source. For general details on caustics, see
Caustics, page 420.
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Energy

This defines the total starting energy of all
surface caustics photons. Energy primarily
controls the brightness of the caustics effect. It
also affects the number of surfaces by which the
photons can be reflected/refracted.

Surface caustics with low Energy (10000)

Surface caustics with high Energy (20000)

Note

Although the Energy and Photons parameters are
independent of each other, the brightness of the
caustics effect depends on the combination of
both parameters.

Photons

The Photons value affects the accuracy of the
caustics effect – increasing the value produces a
better result. However, larger values mean
longer render times.

The value defines the number of photons to be
used for calculating surface caustics. Usually, the
best value is between 10000 and 1000000 – the
exact value depends on factors such as the
distance between the light source and the
caustics-generating object. You can enter values
up to 100 000 000, but try to use a much lower
value, otherwise the effect will take an
extremely long time to render.

Example of a low Photons setting – each photon is visible as a
point of light

Note

The render time for caustics depends largely on
the number of photons you use, so aim to use
only as many photons as your effect needs.

Note

The appearance of the caustics effect, i.e. its
sharpness, is defined on the Illumination tab of
the Material editor (see Sample Radius and
Samples, page 519).
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Volume Caustics

Enable

Check this option to switch on volume caustics
for the light source.

Note

For volume caustics, you must define the light to
be volumetric - set Visible Light on the General
page of the Light dialog to Volumetric or Inverse
Volumetric.

Energy

This defines the total starting energy for all
volume caustics photons. It affects the
brightness of the effect as well as the number of
surfaces by which the caustics can be reflected/
refracted.

Normal Energy setting

Energy setting to high

Photons

This parameter controls the accuracy of the
caustics effect. Increasing the value produces a
better effect, but higher values mean longer
render times also.

The value is the number of photons the light will
send out for volume caustics.

Depending on the Step Size, a very large
number of photon values will be calculated and
saved in the photon tree. Assume your light
source sends out 1000 photons and the effect is
100m long – 5000 photon states would be
calculated and saved in the photon tree. Try to
use as few photons as possible.

Keep in mind that an omni light sends more
photons in unimportant directions than other type
of light source. The most efficient light for caustics
is the spotlight, since you can concentrate its beam
on the caustics-generating object.

Falloff

Falloff / Inner Distance / Outer Distance

Here, set the falloff for the brightness of the
light. You can choose from the following:

None
Linear
Inv.
Inv. Square
Inv. Cubic
Step

For details on these falloff types, see page 200.

Exception

Outer Distance remains active even if you set
Falloff to None. This is to ensure a limited range
for the effect, otherwise the algorithm would
attempt to calculate the effect for infinite
distance.
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Visible Light

Falloff

This is the percentage reduction in the light’s
density. The axial falloff of the visible light is set
to a standard 100%.

This means that from the origin of the light to
its outer distance, the density of the visible light
falls from 100% to 0%. So, if a value of 10% is
entered, the outside edge will be at 90%
visibility.

 

100% Falloff        0% Falloff

Edge Falloff

Edge falloff is relevant only with Spotlight
sources. The Edge Falloff determines how
quickly the light’s density decreases towards the
edge of the light cone. If you enter a value of
0% (or leave the field inactive), you will
produce a very hard visible light. A value of
100% gives a more gradual falloff from the
inside of the light cone to its outer edge, until it
reaches 0%.

0 % Edge Falloff

100 % Edge Falloff

Custom Colors

With this option you can assign your own colors
to the visible light — independently of the
actual color of the light source (General tab) and
the inner color (Details tab).
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Outer

Use the color selector to define your light’s
outer color edge.

Inner

Use the color selector to define your light’s inner
color edge.

Colored Edge Falloff

This option is only available with Spotlight
sources and works with your selected Custom
Colors. Normally the Inner Color behaves in
such a way that it travels along the Z-axis of the
Spotlight source linearly to the Outer Color.
However, selecting Colored Edge Falloff will
cause the Inner Color to also spread outwards
radially from the Inner Angle to meet the Outer
Color.

In this picture Colored  Edge  Falloff  is off

Here Colored  Edge  Falloff  is on – you can see the inner color
within the light cone

Inner Distance

Within this value, the density of the visible light
is always a constant 100%. The falloff begins
only outside of this distance.

Outer Distance

Between the Inner Distance and the Outer
Distance the density of the visible light changes
from 100% to 0%. This value thus gives the
maximum visible range of the visible light.

Outer Distance Y

When using Omni light sources, you have the
ability to set the falloff distance for both Y and Z
axes. This option sets the distance of light falloff
for the Y axis (or height).

Outer Distance Z

This option sets the value for the Omni light’s
falloff along the Z-axis (or width).

Sample Distance

The Sample Distance is only relevant for visible
volumetric lights.

Adjusting this value defines how finely the
visible light’s volumetric shadow will be
computed. Larger values lead to a somewhat
rough (but swift) calculation, while smaller
values lead to a much finer, but more time-
consuming, result.

The value of this Sample Distance is measured in
world units. This value thus determines how
finely the shadows within a visible light will be
sampled. Values will usually be from 1/10th to
1/1000th of the light source radius. By
increasing the value your scene will render
noticeably quicker but certain parts of your
scene will be sampled very roughly, resulting in
sampling artifacts. To reduce these sampling
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artifacts requires a reduction in your sampling
value too. The smaller the value, however, the
higher the cost in rendering time.

CINEMA 4D contains an integrated antialiasing
technique for surface shine, ensuring even the
roughest surfaces render smoothly, allowing you
to set the Sample Distance value somewhat
higher than without this feature.

Sample distance tips

If you wish to produce fine shafts of light, like
that of light beams radiating through cracks or
from behind stone columns, you need to set
your sample distance relatively small. On the
other hand, a light that is completely covered
and allows no beams of light to break through
may be sampled at a much higher value.

To clarify this, let us use a small example; the
pumpkin in the picture has a radius of 150 units,
the visible volumetric light a radius (outer
distance) of 700 units.

top left

Sample Distance: 10 units
Render time: 105s
The pumpkin looks perfect.

top right

Sample Distance: 20 units
Render time: 60s
Here the rays emitting from the mouth and the right
eye are showing the first signs of artifacts.
bottom left

Sample Distance: 40 units
Render time: 35s
You can clearly see now how the rays in the visible
light are losing their fine edges.
bottom right

Sample Distance: 80 units
Render time: 23s
The picture has, quite literally, been rendered useless.

So why is volumetric lighting so time-consuming
for the renderer?

When a beam hits a light cone, it is not only the
intensity of the light that needs to be computed.
Additionally, for each part of the beam, the
program needs to enable for other objects
within the light cone that might be casting
shadows. So for every part of the beam of light,
an extra raytracer ray needs to be initiated and
emitted.

But as it is not possible to shrink segments in the
fog below a certain length, an approximation
has to be used; the length of the light cone is
subdivided into equal parts.

Let’s say the raytracer ray hits the light cone and
the distance between the entry and the exit
points of the light cone is 1,000 units. So a
sample distance of 50 units will mean that an
intensity value and a shadow beam will have to
be calculated 20 times (1000 divided by 50).

The shorter the sample distance, the longer the
calculation is going to take. Even if you have
only five subdivisions (so a sample distance of
200 in the above example) this will require a
five-fold increase per raytracer ray and per
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contact with the light cone than without
volumetric lighting. Using progressively finer
subdivisions, the processing time involved will
very quickly become astronomical.

Alas, this is an inherent problem with computer
graphics which cannot be resolved or
accelerated other than by throwing processor
power at it.

So why can’t you input a fixed value for the
number of samples?

Well, if the raytracer beam hits the light cone at
its beginning, the distance between the entry
and exit points might be, for example, 100
units. But if the beam hits the cone further from
the light source, this distance might grow to
5,000 units or more. So if you used a fixed
number of samples, at the narrow end of the
cone a lot of unnecessary calculations would be
made and later too few (which would result in
ugly artefacts).

Tips

Volumetric lighting needs a lot of calculation
time, therefore render such light sources only
when it is absolutely necessary. If you use a
volumetric light as a particle (which is perfectly
possible), then perhaps you should consider
buying a second computer which you can leave
to render that scene over a period of days.

Most importantly, take care with your Sample
Distance values. Finding a happy medium (small
for fine detail, but as large as possible for
reducing render time) is the key here.

Brightness

This value gives the brightness of the visible
light source.

Dust

With this option you can determine the darkness
of the light cone. With a Dust value of more
than 0% Brightness is not added, but
subtracted. To make sure you see the full effect
of this, lower your light’s brightness accordingly.
The difference between a normal bright light
and a dust-assigned light can be clearly seen in
the following illustration. To the left is a bright,
visible light. To the right a dark, dusty,
somewhat sooty light.

In principle, you can use an accumulation of
dust in conjunction with particles for convincing
simulation of fire and smoke. For more details,
see Particle System, page 235.

Dithering

This produces irregularities in the visible light
which, in certain cases, can help prevent
unwanted banding (or contouring) in the visible
light source.

Explanation

With certain light source combinations (e.g.
visible lights that overlap), you may find that the
24-bit picture depth of your output device is
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insufficient and it may display color gradients in
large steps. This display problem is known as
banding or contouring. To avoid this problem
use the Dithering option to give your visible
light a certain irregularity and help to smooth
the color graduations.

Adapt Brightness

This option prevents a light beam from being
over-exposed. The brightness is reduced until
the over-exposed effect disappears.

Adapt  Brightness  off

Adapt  Brightness  on

Additive

Select this option if you wish to mix the light
beam additively with other light sources.

Note

Light sources in CINEMA 4D Version 5 were
additive. This setting exists primarily for
compatibility reasons. The light beam will look
more realistic if this option is not selected.

Additive  on

Additive off
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Noise

Type

Select from four Noise types.

Simple Noise produces dark and bright areas.

Then there are three types of turbulence that
change the characteristics of the noise by
adding cloud-like effects.

Soft Turbulence:

Hard Turbulence:

Wavy Turbulence:
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Octaves

(Only relevant for the Turbulence types above.)
The Octaves value determines the graininess of
the noise. The higher the value, the more gritty
the appearance.

Velocity

Sets the speed of the irregularities.

Brightness

Using this you can raise the overall brightness of
the irregularities. You may also enter negative
percentages and reduce the brightness.

Contrast

Higher values increase the contrast of the noise,
lower values reduce it.

Use Local Coordinates

Selecting this option will ensure that the local
coordinates of the light source are nailed down. If
the light source is moved now, the turbulence/
noise will move also. In normal use you should
leave this option off, as dust and particles in the
real world move due to the forces of nature, not
because the light itself moves.

Scale

This value will determine the size of the
irregularities in relation to the scene’s absolute
Cartesian coordinates. If the noise effect is too
severe, try reducing this value.

Illumination

The general intensity of the noise.

Wind

Here you define the properties of wind for the
noise, This will add realism to your animation
since wind will appear to blow the dust.

The values of X, Y and Z give the vectors of the
wind direction in absolute Cartesian coordinates
(and/or local coordinates if this option is
enabled). Use the Velocity value to change the
wind’s strength.

Lens Effects
CINEMA 4D is a powerful tool when it comes to
producing the aberrations of real-world camera
lens systems and film material.

Basic sunbeams are brought to life with a solar
corona or a halo. A lens reflection of a low-
quality camera lens can be easily simulated, as
rainbow colored circles develop and run
diagonally across the screen. A welcome flaw in
an otherwise too perfect virtual world.

Just like the characteristics of other objects, the
smallest details of these lens effects may be
animated to give, for example, a rotating corona
or a lens flare turning from red to green.

You may remember in the General tab you had
the option to turn off light radiation (No Light
Radiation). If this option is chosen then the light
source will no longer illuminate the scene, but
all lens effects of the light will still be visible.
This is handy for example in a scene in which
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your objects are illuminated to your exact
requirements, and adding another light source
for a lens flare will result in over-lighting the
scene.

The parameters for these lens effects are many
and varied and take up three separate tabs. But
fear not, with a step-by-step approach you will
soon be comfortable with all of the possible lens
effects and their various options.

On the main Lens Effects tab you can define
your basic effect, choosing both Reflexes and
Glows separately from each other. Using the
two tabs that follow you may fine tune the most
minor details of the lens effect. To aid you in
this, a preview window will constantly update
the adjustments as you make them.

Tip

It’s very easy to build yourself a light source
library containing spectacular effects. You can
produce many types of light sources with
different effects that can then be saved as
individual objects in the Object manager. When
you require one of these specific lights for your
scene you may simply load it from your source
light library.

Note

Because of the way that Quicktime VR
panoramas are calculated, lens effects cannot be
displayed in them.

One more tip

Try not to overuse the light reflection effect; it
can very soon become a distraction. Also
remember that in the real world the cameraman
will try his best to avoid them.

So to the details of the Lens Effects tab. From
here you can quickly access a number of pre-
defined glow and reflex examples. You can also
change the basic properties of the lens
aberration from here.

Glow

From this pop-up menu you can select, from a
pre-defined library, the glow of the light source.

Reflexes

From this pop-up menu you can select, from a
pre-defined library, the type of lens reflection.

You will find a detailed overview of all the
effects at the end of this section.

Brightness S

Adjusting this value will change the global
brightness of the glow or reflex. Smaller values
will reduce the effect, values of 100% or more
will strengthen it.
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Aspect Ratio R

Change the global aspect ratio of both glows
and reflexes with this value. At the default value
of 1, both will appear circular. Smaller or greater
values will give you a squeezed/stretched
ellipse.

Scale

This value will adjust the size of the whole lens
effect (rays, glows and reflexes). This saves you
from adjusting each effect individually.

Rotation

Use this value to rotate the lens effect to any
angle.

Use Light Parameters

When this option is activated, the light source
properties defined in the General tab will also
affect the glow/reflex effects. So if the light
source color is red then the glow/reflex effect
will also appear red.

Fade if near Border

Using this option will make the lens effect fade
the nearer it is to the edge of the image. When
at the center of the screen, the lens effect will
have maximum intensity. This corresponds to a
light’s physical behaviour in the real world.

Fade if behind Objects

Using this option will determine whether light
sources that lie behind objects are still to
produce their effects or not.

Lens flares do not occur if light sources are
behind objects, but glows or radiation can
produce some rather nice effects.

Fade if approaching Objects

Normally, if a light source with a lens effect
disappears behind an object, the effects are still
at maximum strength until the light source
origin is fully behind the object. With this option
enabled, the effect’s strength will gradually fade
as the light source approaches the object.

Note

The gradual fading of the sun behind a planet,
complete with atmosphere, is a good example of
this effect.

Scale Glow with Distance

This option will scale the glow effect according
to its distance from the camera. The further the
distance from the camera, the smaller the effect
will be.

Scale Reflexes with Distance

This option will scale the reflex effect according
to the distance. The further the distance from
the camera, the smaller the effect will be.

Reference Size

With this option you can adjust the distance
value with which the glow and reflex effects are
calculated. The smaller the value the more
distant, thus smaller, the effect will appear.
While increasing the value will make the effect
appear closer, thus larger.

Normally lens reflexes have a constant size, no
matter how far removed from the camera they
are. If, however, you want to copy your favorite
space movie and to let torpedoes fly under the
camera, the lens reflexes and glows must
become larger when the camera is closer to the
torpedo.
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Glow Editor

With this tab you can tweak the lens glow to
your exact requirements. This dialog is divided
into three parts, the Glow values (top left), the
Halo/Ring (top right) and the Beam/Corona
elements (bottom left). Of major importance is
the preview window (bottom right) that updates
your effect as you modify it.

Glow properties

Glow

Select the required glow element from this
menu of pre-defined light source glows, to
change the overall shape of the light’s glow.

Type

Selecting a glow type from this pre-defined set
will change how the glow’s brightness is
distributed.

Size

Adjusting this value determines the size of the
glow’s element. The radius is shown as a
percentage, where 100% is the distance from
the center of the screen to the edge.

R (aspect ratio)

Modifying this value allows you to change the
aspect ratio of the glow. At its default size of 1
the glow will appear circular. Smaller or larger
values will shrink/stretch the glow’s aspect,
making it a horizontal or vertical ellipse.

Color

From this dialog (obtained by clicking the box to
the right of Size) you can select the color of the
surrounding outer glow.

Ring properties

Using these values will produce a ring, or halo,
around the lens effect. Adjust this effect to your
requirements by consulting the preview window
(bottom right).

Ring

From this drop-down menu you choose the halo
type you require; Inactive, Ring or Rainbow
Ring.

Size

Adjust the size of the ring from here, the value
being a percentage.

R (aspect ratio)

Adjust the ring’s aspect ratio with this value.
Decreasing the default value of 1 will flatten the
ring, while increasing it will stretch it into an
ellipse.
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Color

Choose the color for the ring from this color
picker.

With this dialog you can define the Corona of
your lens effect — the rays of light that are cast
in star-like fashion around the effect.

Change this effect until you see what you want
in the preview window (bottom right).

Beam properties

Choose your preferred Beam/Corona from this
pre-defined, drop-down set.

Type

Choose the corona type from here. Depending
on the chosen type, the pattern and number of
beams cast will vary.

Size

Use this value to determine the size of the
element. The radius is indicated as a percentage,
where 100% is the distance from the center of
the screen to the edge.

R (aspect ratio)

Adjust the aspect ratio of the corona with this
value. At the default value of 1 it will appear
circular. Smaller values will flatten the effect into
a small horizontal ellipse, while increasing the
value stretches it into a taller, vertical ellipse.

Color

Choose a color for your corona from this color
picker (click to the right of Size).

Angle

To rotate the beams of your star/corona to any
angle you want, enter a new value here.

Edit

Still not satisfied? OK, there’s more; click this
Edit button.

The Streak Editor

This glow dialog lets you adjust the light that
defines the appearance of the corona. These
values are set with four sliders and three option
fields. As usual, a preview window is updated
constantly to let you see your changes.

Thickness

Change this value to specify the width of the
beam’s rays. The smaller the value, the sharper
the beam (or streak) appears.

Beams

You can choose the number of beams produced
by your corona effect here. Up to 200 beams
can be produced by each light source.

Breaks

With this option you can insert interruptions or
breaks into your corona. These are added to the
gaps which already exist between the beams.
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Width

Adjust the size of the above breaks with this
value.

Random Distribution

Activating this option ensures that the beams
are arranged randomly, rather than in a
symmetrical pattern.

Random Beam Length

To ensure that all beams are not the same
length, activate this option. All individual beams
will then be different lengths.

Star-like

Once activated, this option will arrange the
beams in a more star-shaped pattern, thickening
the beams towards the center.

This effect is particularly effective when used
with a small number of thick beams.

Lens Editor

The final light dialog concerns the creation and
adjustment of the famous, often notorious, lens
reflections (or lens flares) to your specific needs.
Once again, all changes are shown in the
preview window to the right.

Element no.

Use this slider to select the reflection you wish
to edit. You can add or remove extra reflections
to/from the existing set by using the + and —
buttons. A maximum of 40 reflections are at
your disposal, enough to recreate any
combination of light/lens flares or aberrations.

Type

Select the shape of your reflection with this
slider. Only in the rarest case, if at all, should
different reflection types be used in a scene. For
example, apply only circular or only hexagonal
types to the one scene. Remember, your scene is
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shot through one simulated real-world lens —
these lens reflections depend upon that lens
system, not on your existing scene lights.

Here are some examples:

Pos

This value sets the positioning of the element on
the screen. The axis on which all reflections lie
travels through two points; the light source and
the center of the screen (which is also the centre
of the lens).

Here the following values apply.

0% = light source
50% = screen center
100% = 2* distance light source-center

Negative values place the reflections behind the
light source.

Size

This value determines the size of the element.
The radius is shown as a percentage, where
100% is the distance from the center of the
screen to the edge.

Color

Select the color for the element.

Real World Glows, Halos and Reflexes

Glows

Glows are a type of over-exposure to light.
When the light intensity is sufficient, this
exposure bloom includes film grain in the areas
surrounding a bright light, even though those
areas are not illuminated at all.

Halos

Halos are also caused by over-exposure, but
with added color distortions caused by the
diffraction of the film grain.

Reflexes

Lens reflections are caused by the focal image of
poor quality lenses. The colored shape produced
is an artifact of the lens surface, the shape
resulting from the shape of the lens. Large
apertures produce small reflections, small
apertures produce larger ones.

 

Default CINEMA 4D V4

 

Wide angle Zoom
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Hi-8 Camcorder

 

Floodlight Artefact

 

Star 1 Star 2

 

Star 3 Violet

 

Flash 1 Flash 2

 

Flash 3 Sun 1

 

Sun 2 Grey

 

Blue 1 Blue 2

 

Red Yellow-green 1

 

Yellow-green 2 Candle
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Making Gels
A gel is produced by assigning a material with a
transparency map texture to a light source. The
light’s colored areas are then filtered by this
texture and colored in exactly the same way as a
slide projector will project a still picture.

You can assign as many gels as you wish to each
light object. Thus you are able to produce many
complex picture effects with ease.

For example, the striped-shadow effect of a
venetian blind can be simulated, without the
complicated and time-consuming shadow
calculations normally associated with such an
effect, simply by assigning a black-and-white
striped gel (aka light map) to a light object.

Note

Lights do not take on the material properties of a
parent object

Three Point Lighting
A simple and very common lighting principle is
the three point lighting technique. This method
is excellent for lighting individual objects
correctly e.g. a character in a scene.

The object is illuminated by a main (key) light, a
fill light and a third light from the rear, known
as the backlight. Naturally all scenes and objects
are unique and require individual setups, but this
system is a good starting point for your scene’s
lighting properties.

The first light is the main light of the scene (the
key light) – often a white spotlight with a soft
shadow and the brightest light of the three. This
light is placed to the right of the camera and
aligned to your object. The radius is then
adjusted to illuminate the whole of the object.

The second light is the fill light which
complements the key light by illuminating the
parts of the scene not reached by the key light.
Changing this light to another color (e.g. yellow
or red-brown) will make the scene appear softer
and warmer. This fill light should be at roughly
50% brightness and placed to the left of the
camera and key light.
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The third of these lights is the backlight. This
spotlight provides lighting from the rear and
above in order to emphasize the outline of your
object against the background. Blue is a suitable
color here, as cooler colors are seen by the
human eye as somewhat more distant than
warmer colors, thus giving more apparent depth
to your scene.

Here is an image lit with simple, one-source
lighting ...

Now here is the same image lit with carefully-
designed three-point lighting ...

The light sources do not have to be spotlights
but the limited and more central spread of a
spotlight’s illumination means the objects won‘t
become lost in a lighter, more evenly lit
environment.
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It is also preferable to have just one light (the
key light) cast shadows. All three lights casting
shadows can become confusing. One shadow-
casting light is often more than sufficient.

Note that you should not place your light
sources too close to your object, otherwise
unwanted specularity may result. The further
away the light source is from the object, the
more evenly lit the object will be.

Target Light
When you choose Objects > Scene > Target
Light, a null object is created, containing a light
source and another null object. The latter is the
target object to which the light is tied at all
times.

The light source can be any light type of your
choosing and you simply move objects into the
hierarchy of the target object for the light to
become aligned to them.

You can edit the whole structure interactively
within the editor so, if you move the light
source, it stays aligned to the target object and,
conversely, if you move the target object the
target light follows it.

Sun Light
The sun light source is a special case of a light. It
is a light source with the type of the light
adjusted to Distant and the shadow to Hard.
These settings cannot be changed.

Additionally, the sun light source contains an
expression with which you can define the exact
time of day, the date and the geographical
latitude.

The sun is of particular interest to architects who
often want a scene illuminated with a light that
has the correct direction and color of the sun.

South is the X axis of the world coordinate
system; the sun will always be here at 12 noon.
East (sunrise) is therefore along the Z axis, West
along the negative Z axis and North along the
negative X axis.

The sun light source is placed far away from the
origin of the world coordinate system. Owing to
its distant position, it radiates parallel light. The
sun shines only if it is over the horizon (day). To
animate the sun you should therefore disable
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the Auto Light option in the render settings (see
page 430). Otherwise, the scene will be
illuminated by the auto light after sunset.

The color of the sun depends on the absorption
spectrum of the mantle of air around the Earth
and is normally yellowish during the day,
shifting into the red spectral region as the sun
nears the horizon.

The sun light is intended for users who want to
simulate realistic colors and shades at different
times of day, appropriate for landscape planning
or house building.

Sun Expression

This dialog window appears when you double-click the icon
for the sun light in the Object manager

Latitude

Enter the geographical latitude of the desired
location on the Earth’s surface. That could be,
for example, 51.3 for London, 40.5 for New
York, 35.4 for Tokyo or 50.1 for Friedrichsdorf.

Distance

Here you enter the distance of the sun light
source from the center of the world axes. The
smaller this value, the smaller the circular arc on
which the sun travels.

Time Scale

Here you determine how long the sun is in the
sky in CINEMA 4D. The world time (or real
time) in seconds is divided by the factor you
enter here.

A factor of 1 would mean that a CINEMA 4D
second corresponds to exactly one real world
second. Half a day is 43,200 seconds, so in this
case, CINEMA 4D would need 43,200 seconds
to make the sun rise and then set.

Try this – choose a factor or 1, check your watch
and enter the current time, the current date and
the geographical latitude of your location. Now
choose Play in the Time Line. The CINEMA 4D
sun should behave synchronously with the sun
outside.

If, on the other hand, you enter a factor of
43200, half a day becomes a mere second in
CINEMA 4D.

Since the preset animation length in CINEMA 4D is
exactly three seconds, this factor is set by default
to 14440; thus the sun rises and sets within three
seconds.

To calculate the factor:

Factor = 43200 / CINEMA 4D seconds

Example:

- Assume you want the sun to rise and set over
ten seconds:

- 43200 real time seconds / 10 CINEMA 4D
seconds = 4320

- So, to make the sun rise and set in 10 seconds,
enter a factor of 4320.

Hours, Minutes, Day, Month

Enter the local time and date for which the sun’s
position is to be calculated. Local summer time
or other time zone corrections are not taken into
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account, so subtract one hour from the time
during the summer months to obtain, for
example, Central European Time.

Not only Light Sources can be used as a Sun

Since the sun uses an expression (see page 475),
arbitrary objects can be used in place of the sun.
By default, when you choose Objects > Scene >
Sun Light, a standard light source is used.
However, you can click-drag the Sun expression
to any object of your choosing.

For example, you could assign the sun to a null
object and then move the null object through
the scene. Into this null object you could place,
say, any light source as a child object. In this
way you would prevent the automatic fading of
the sun light at dusk. Also, you could avoid hard
shadows by setting soft shadows within the
light child object. Or perhaps you could place a
sphere on this null object to simulate a moon.

Floor

This command creates a floor object. The floor
always lies in the XZ plane of the world
coordinate system, stretching to infinity in all
directions.

You may create as many floors as you need and
use them all at the same time in CINEMA 4D.
You could, for example, use multiple floors as
pseudo skies on to which you can add cloud
layers of differing transparency. In the following
example four floors were used, one for the
actual ground and three for the layers of cloud,
each one situated higher than the other. If the
cloud textures are animated, an extremely
realistic effect can be achieved.

As you may have realized, floors can be moved
and rotated relative to each other. This feature
can help you avoid cloud layers appearing
identical, by avoiding repeating textures.
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Sky

This command will create a sky object. In
contrast to the Floor object, the Sky is an
infinitely large sphere, whose center is the origin
of the world coordinate system.

If you want to apply a texture (e.g. the 2D cloud
shader) to the sky, you should use Spherical or
Cubic projection. If the clouds appear too large,
increase the repetition of the texture’s tiling and
ensure you switch on Seamless (see Tile, page
548).

Do the clouds seem a little artificial? The
possible reason for this is that the clouds have
the same tiling in both the X and the Y
direction. Adjusting the repetition of the tiling
on the Y-axis, making them approximately twice
as high as for the X-axis, ensures the clouds look
somewhat pulled in their width and they appear
nearer and more natural.

Alternatively, you can also use several floor
objects for the simulation of cloud layers.

For the simulation of a starlit sky, the use of the
cubic projection is recommended, as this will
avoid unwanted distortions at the poles.

Aiming the camera directly up will display a
problem — the cloud texture tends to gather at
the zenith. You can fix this by assigning Shrink
Wrapping (see page 544).

By default, only the top-most sky object in the
hierarchy is used. If you have several sky objects
in your scene, you can control which sky is to be
rendered by using the stage object (see below).

Note

With Environment Fog switched on, the sky
object’s visibility will be lost. How you create a
sky to appear with Environment Fog is explained
on page 232, Fog Tab.
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Environment
You can use the Environment object to define
several global scene parameters.

Note

By default, only the top-most Environment object
in the hierarchy will be rendered. If you want to
change the environment during an animation, use
the stage object with a parameter track.

Environment Color

This is the color of the environment light. The
environment light illuminates the scene evenly
from all sides and is meant to simulate the
background light of a daytime sky or the indirect
lighting of a room light.

The brightness slider is set to 0% by default. If
you wish to simulate environment light (aka
ambient light), increase the value of the
brightness slider to, say, 10% for architectural
scenes. Be very careful when increasing the
brightness, since it reduces the contrast in the
scene — often, you can get better results by
adding omni lights that do not cast shadows.

Note

Environment color can be useful for increasing
the color contrast — for example, you can use it
to introduce complementary colours into the
scene. Perhaps you will set a dark blue to
contrast with a warm yellow window glow as
well as to simulate night. Or imagine a moonlit
scene — you can enhance the bright yellow
moonlight by using a dark purple environment.

Fog

Use environment fog for atmospheric autumn
images or underwater scenes.

Environment fog fills the entire screen,
stretching to infinity. Use this dialog to select the
fog’s color. Distance refers to the fog’s intensity
by specifying the distance over which a light
beam will lose its intensity completely. As the
light loses intensity, the fog color is added.

If, for example, you have entered a value of 500
for Distance, a light beam that starts off with
100% intensity will reduce to 20% after
travelling 400 units; at the end of a further 100
units, the light will have faded out completely,
giving way to the fog color. The shorter the
distance, the thicker the fog.



CHAPTER 7 • OBJECTS MENU • 233

Beams that penetrate the fog beyond the limit
defined in Distance are absorbed completely by
the fog color — if you enable environment fog,
you cannot see a sky or a background image.

Note

There are further uses for the environment
object. For example, you can use it with
volumetric shaders – plug-ins such as
PyroCluster can be used in this way to create
effects like smoke and fog. Just apply the shader
to the environment object as a texture.

Foreground/Background
To render (or display in the Editor) a foreground or
background image, you may assign a textured
material to a foreground or background object,
just as you would to any other object. For
transparent areas, assign an Alpha (genlock)
channel to the material (see page 511).

The foreground object could be a cockpit and
instrument display, or simply a notice of
copyright/authorship that you wish to appear
prominently in the scene.

Taking the copyright example further, the color
texture used for the material of the copyright
message would be in the shape of the actual
message text you wish to display. This texture
must also be used in the Alpha channel property
of the material. From here, you can use either
the Alpha channel or clipping (see page 511).

The background picture might be a landscape,
into which your scene will fit.

For this you assign a material, with the
required texture in its color channel, to the
background object.

These images will be neither reflected by your
scene’s reflective objects nor lit in any way by
the scene. Nor will they change with any change
of camera settings.

The background image will show through
transparent and refractive objects but will not
change with altered camera settings.

You could compare it to a background layer
generated by the Alpha Channel feature, on
which the rendered image is then superimposed.

A CINEMA 4D object (the bridge) fits neatly into both a
foreground and a background image (scene: Joachim Hoff)

Note

As soon as you have applied a texture to a
background object, it will be displayed in the
editor. If this display distracts you, you may turn
it off by selecting the object in the Object
manager and choosing Objects > Object
Display > Editor Off (see page 477).
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Note

Any background picture (see page 17) is
normally displayed in the 3D viewport only, so
as not to distract you when working in the
planar views. However, attaching the camera to
the view in any viewport will make the
background object appear in all viewports for
that view panel. Any background picture already
displayed will then be covered by the
background object texture.

Foreground and background pictures can also
be tiled. For this effect, use the Texture
geometry dialog (see page 537).

Foreground and background pictures are scaled
to the film format during rendering (see Output
Tab, page 406). Transparent sections of the
background are ignored.

Animations and frame sequences can also be
used for foreground and background pictures. In
the case of a background object, these
sequences will also be displayed in the editor.

Note

By default, only the top-most foreground/
background object in the hierarchy will be
rendered. If you want to change the foreground/
background object during an animation, use the
stage object with a parameter track.

Stage
The stage object behaves like the director in a
film production. It determines when a camera,
an environment, a background (and so on) are
used within an animation.

So, for example, you can create many different
cameras in your scene and then use the stage
object to decide when to cut to a particular
camera. An advantage of using several cameras
and the stage object in this way is that you
don't have to render enormous amounts of
material from every conceivable perspective,
only to use half in the final production. By
already specifying the various camera cuts
within the animation itself, you can save a great
deal of time and cost.

You can also use the stage object to switch
between sky, foreground, background, and
environment objects.

You animate the Stage object using a parameter
track. First you must create such a track in the
Time Line with File > New Track > Parameter.
Then set a key by Ctrl-clicking on the track.

A dialog opens into which you can enter the
objects (camera, sky, foreground, background,
environment) which are to be active at this
frame.

Now set a second key and enter, say, another
camera. At this frame, the animation will switch
to this second camera. This is exactly how the
animation will be rendered, making it easy for
you to use cuts in your animation.
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Particle System
Have you ever wanted to create a swarm of fish,
a whole fleet of spaceships or the swirling
smoke of a cigarette? CINEMA 4D’s particle
system will do all of this for you, and much
more, in a very easy and intuitive way.

The heart of any particle system is the emitter,
which ejects a stream of particles. These
particles and their shapes can be modified by
various parameters and controls to produce,
amongst other effects, rotating, deflecting and
decelerating particles.

It’s a simple as this:

- Create an emitter (Objects > Particle Emitter)

- Press Play in the Time Line window and view
the default particle system in the editor
window.

- Drag an object into the emitter (a basic small
sphere is suitable for now).

In CINEMA 4D any object at all can become the
particle. Not only simple spheres but also
complex, grouped objects with hierarchies may
be used (e.g. a jointed bird or a car).

Even light sources can be used as particles.
Together with the visible light function you can
create fantastic fire or smoke effects very easily
and particles can even cast lights and shadows.

All objects in the emitter can be fully animated
to create, for example, flying birds and
swimming fish. Important: the animation of
each object starts when the particle is emitted.
This is done automatically. This helps give your
swarm-like movements a more erratic, natural
and much less uniform movement.

Your particle stream can also contain mixed
random particle objects (e.g. a variety of
different birds). Simply drag the different objects
into an emitter. These particles are then emitted
in the same quantitative proportion.

You can also use a metaball. This can help you
achieve otherwise difficult effects such as
bubbling liquids.

Note

There are two mini-tutorials at the end of this
chapter, one for light sources as particles, the
other for metaballs as particles.
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The particles now move in a straightforward
fashion until they arrive within the range of a
modifier. Then they are diverted, slowed, or
rotated etc. These modifiers work, by default, in
the z-direction of their coordinate system (e.g. the
wind blows in this direction); if this is not the case,
it will be explicitly pointed out in the text below.
Modifiers can be embedded in other modifiers.
Thus a turbulence modifier within a wind modifier
results in very realistic smoke effects.

Almost all the properties of an emitter and the
modifiers can be animated using a parameter
track (see page 593). This can be used to
simulate intermittent gusts of wind for instance.

Some good advice

If you would like to actually see the rendered
particle animation within your lifetime :-) make
sure you disable the light emission and shadow
casting from any particle light sources. Hundreds
of such particles are possible within a scene and,
with the wrong options set, this will slow even
the most powerful computer to a crawl.

Tip

Emitters themselves cannot be used as particles.

Bake Particles

Under certain conditions it may become
necessary to use the bake function for particle
streams. What does this mean?

Under normal conditions particle streams are
rendered dynamically and sequentially, i.e. the
position of a particle in next frame depends on
its position in the previous one. But this can
cause problems in two ways ...

First of all let’s consider rendering within mixed
networks. With the optionally available
CINEMA 4D NET software, the rendering of an
animation within a network can be distributed

over several computers. For this type of network
rendering a variety of different platforms can be
combined, e.g. Power PC, AMD and Pentium
processors. Since the floating-point units (FPU)
of these processors work slightly differently, the
sequential nature of the particle rendering can
produce different results on the different
platforms. The final output could be a non-
continuous particle stream. Baking is the answer.

The second case occurs when using several
independent particle systems in a scene. In
principle all modifiers will always affect all particles
of a scene, no matter what the source. If this is not
what you want, remedy it by baking the particles.

When baked, a particle stream will become
frozen in its present condition, i.e. the position,
rotation and size for each particle for each frame
of the animation is fixed (also in the Time Line,
although you won’t notice it). All computers in a
CINEMA 4D NET network will now render the
particles correctly. Further modifiers may then
be added after baking a particle stream and
these will no longer affect the neighbouring
particles.

As it is an object property rather than an object,
the Bake Particles command is in the Objects
menu of the Object manager. It is referred to again
in the Object Manager chapter on page 480.

Tip

As you might expect, these extra particle options
are not without a cost; high memory
consumption. For each particle and for each
animation frame the data, such as position,
speed, situation, lifetime etc. must be saved. You
can therefore quite easily build a scene that
requires several megabytes of memory. You may
check the memory consumption of the baked
objects at any time with the function Object
manager: Objects > Information (see page 478).
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Emitter

Particle Tab

Birth Rate (Editor)

Defines how many particles per second are to be
created in the editor. The particles are emitted
randomly from the entire surface of the emitter.
This rate is also used when starting a calculation
in the 3D window of the editor.

Birth Rate (Rendering)

Defines how many particles per second are to be
created and rendered with the final calculated
scene. The particles are emitted randomly from
the surface of the emitter.

Visibility

Here you can enter how many of the particles
should be visible. At first glance, this appears to
offer no more than the birth rate settings.
However, on principle it is not possible to
animate some of the parameters in the particle
system, such as the birth rate settings. If you
wish to vary the intensity of the particle stream
over time, use Visibility. You can animate it via
a parameter track in the Time Line (see
page 593).

Start Emission / Stop Emission

You can use these values to define when (in
frames) the particle emission should begin and
end.

Lifetime

Gives the length of time a particle will be visible.
So if flying sparks, for example, are set to be
visible for 20 frames, the particles will disappear
after this time. This value also controls the
length of the animation sequence in the time
line.

Variation adds a deviation factor to the Lifetime
value; i.e. the individual particles can live for a
longer or shorter time, according to the size of
the Variation value.

Speed

Indicates the movement speed of the individual
particles. The speed is shown in units per second
(see Edit > General Settings). The larger the
value, the longer the particle line displayed in
the editor is.

Variation controls the deviation factor of the
speed. A value of 100% can make the particles
twice as fast, or twice as slow.
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Tip

A speed of 0 is allowed. With this value set, the
emitter leaves a particle trail behind itself when
the emitter is moved. Negative values can also
be used. The emitter will then emit the particle
stream in the negative z-direction.

Rotation

Specifies the value at which the particles will
revolve around a spatial axis.

Variation will add a deviation factor to the
value.

End Scaling

Defines the final size of the particles relative to
their starting size. A value of 0.5, for example,
will shrink the particles to half of their initial
size.

Variation (in the second column) defines a
deviation factor for the scaling so that the
particles are sometimes larger or smaller at the
end of the animation.

Seed

Seed is used to create the pattern of the particle
stream. If you copy an emitter, you will notice
that both emitters generate exactly the same
pattern. This may or may not matter depending
on the nature of your scene. To ensure that each
stream is unique, enter a different seed value for
each emitter. For example, a seed value of 1 will
create a completely different stream to a seed
value of 0.

Tangential

The trajectory of the individual particles may be
curved by selecting this option. If this option is
activated, the Z-axis of the particles is aligned
along the trajectory of the emitter; you would

need this to simulate exhaust gases emitting
from the engines of an aeroplane flying on a
curve, say.

Tip

This option takes additional render time and
should be disabled for objects with no direction
(e.g. spheres or light sources).

Tip

You should only use one of the Rotation or
Tangential options at a time. For obvious
reasons, these two are mutually exclusive.

Show Objects

You can choose the way in which a particle is
displayed.

If this option is deactivated, the particles are
displayed in the editor as lines. The direction
and length of each line indicates the direction of
flight and the current speed of the respective
particle - the longer the line, the faster the
particle.

If this option is activated, the particles will be
displayed in the editor as real objects. Please
note that this display mode can slow down the
redraw rate considerably, especially with
complex objects.

Tip for Animations in the Editor

Particle effects will only be displayed accurately
when played at a constant rate in the Time Line.
If you go backwards in time or move more than
one frame forward then strange things may
happen on the screen.

These odd effects happen because the new
position of a particle is calculated from the
previous position. Therefore you should reset the
time slider of the Time Line to the starting
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position whenever you place new modifiers in
the particle stream.

When playing back you should also use the
option Time Line > Navigation > Frame
Rate > All Frames .

When the scene is finally rendered with the
raytracer this does not matter, since the scene
will then be calculated frame by frame from start
to end.

Emitter Tab

Emitter Type

Indicates whether you want the particles to emit
in either a cone shape or a pyramid shape.

X Length, Y Length

Indicates the size of the emitter.

Horizontal, Vertical

Sets the value of the emission angle of the
particle stream. At a value of 0° the particles are
emitted parallel to the Z-axis of the emitter, with
a value of 180° the particles can exit in the XY
plane of the emitter (Z=0).

A radial emitter can be created with the
following values:

X-length = 0; Horizontal = 360°

Y-length = 0; Vertically = 0°
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Modifiers

Attractor

The Attractor is a radially symmetrical
gravitational force. With this modifier you can
capture particles in a similar way that the sun
captures individual planets. You can also create
water whirls with this function.

Outside of the range of the Attractor, the
particles will move in a linear fashion.

Strength

Indicates how strong the gravitational force will
be. This value can also be negative, which
produces a repulsion. So for example the
different magnetic poles can be simulated.

Speed Limit

To prevent the particles travelling too quickly in
a scene when using large values, you may
define a speed limit with this function.

Size

Defines the spatial dimensions of the Attractor
in all three directions.

Gravity

Gravity is familiar to us all, since the first time
you ever dropped your buttered toast on the
floor. The gravitational modifier will simulate
this natural pull of the earth.

The gravitational force acts in the negative Y
direction only (unlike the Attractor above). In
the editor a small, downward pointing arrow
indicates this.

Acceleration

Defines the strength of the acceleration force.
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Size

Defines the spatial dimension of the gravity
modifier in all three directions.

Deflector

A Deflector modifier is used to physically deflect
particles. A realistically animated billiard table
could quite easily be created with just five
deflectors (one for the surface plus four
cushions). The emitter creates just one particle
(a sphere for the ball) which never leaves the
table, rebounding nicely off the cushions.

Elasticity

Indicates how bouncy the deflectors should be,
i.e. the degree of rebound. With a value of
100%, the angle of exit is equal to that of the
entry angle. The smaller the elasticity value, the
more the particle’s energy is absorbed by the
deflector and the more the motion proceeds
along the direction of the deflector.

Size

Defines the spatial dimensions of the deflector
in X and Y directions.

Split Beam

Activating this option will divide the particle
stream at the deflector. Half of the particles will
be deflected, while the other half simply passes
through unaffected, as if it were not there.

Note

The calculation of the division only works with a
fixed deflector and not with particles moving at
high speed. Imagine a simple particle, moving at
a high velocity of 200 units per frame. In the
first frame it is 100 units in front of the
deflector. However, in the next frame it has
moved to 100 units behind the deflector. The
deflector algorithm simply does not see the
particle and has no chance to influence it.
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Obviously it is possible to define a larger
influence radius for the deflector, but this would
mean the particles would sometimes be
influenced 100 units before reaching the
deflector. This is a problem common to all
particle simulations currently available.

To a certain extent the use of the bake function
may help here, by defining a higher Samples per
Frame rate, e.g. 10 samples per frame instead of
only one. This will ensure that the entire
animation and in particular those frames
involving particle calculations are rendered with
a higher time rate (in this case it would be 10
times higher). The deflector now has a chance of
seeing, and thus influencing, the particle.

Here is another example billiard table:

Friction

Friction reduces the speed of the particles, even
bringing them to a complete standstill.

Friction

Gives the strength of the friction, thus affecting
how the particles are slowed down. After
leaving the modifier the particles continue
moving at a constant (but reduced) speed. The
friction coefficient can also use a negative value;
in this case the particles accelerate.

Size

Defines the spatial dimensions of the friction
modifier in all three directions.
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Rotation

Rotation adds a tangential acceleration to the
particle movement. This rotation occurs around
the Z-axis. The radius is half the size of the smaller
dimension of the modifier in the X and/or Y
direction. Interesting effects can result if you place
the modifier with its Z-axis parallel to the direction
of the starting point of the particles. A spiral-
shaped helical movement is then produced.

Angle Speed

Gives the speed with which the particle stream is
to be rotated around the Z-axis.

Size

Defines the spatial dimensions of the rotation
modifier in all three directions.

Turbulence

The Turbulence modifier will add a swirl effect
to your particle stream. Interesting effects can
be made with an elongated modifier as this
would create a realistic, twisting smoke effect.

Strength

Indicates the strength of the Turbulence and
thus how much the particle stream will be
influenced.

Size

Defines the spatial dimension of the turbulence
modifier in all three directions.
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Destructor

With the Destructor modifier you can destroy
(i.e. remove) particles from the particle stream.

Random

Affects how many particles will survive.

  0% =All particles are destroyed.

  x% = x% of the particle stream remain.

100% = All particles pass through the
Destructor.

Size

Defines the spatial dimension of the turbulence
modifier in all three directions.

Important Note

So that the Destructor has a definite effect, i.e.
that of destroying particles, it must have a
minimum thickness that is greater than the
length of run of a particular particle from one
frame to the next. Otherwise a particle cannot
be caught and thus cannot be destroyed.

Wind

Wind diverts and disrupts the particle stream in
a particular direction. The direction of the wind
is displayed in the editor as a windmill-like (or
fan-like) object with a small arrow showing the
wind direction.

Wind Speed

Gives the strength of the wind and, thus, how
much the particle stream will be diverted.
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Size

Defines the spatial dimensions of the wind
modifier in all three directions.

Tip

The wind modifier is represented by a cube with
a fan-like object on one of the cube’s faces. The
fan shows the direction in which the wind is
blowing (away from the face); the rotation rate
of the fan is an indication of the wind strength.

Examples
Here, as promised at the beginning of the
chapter, are two mini-tutorials for particle
animation with light sources and metaballs. We
hope you enjoy them.

Particle animation with light sources

We are going to create a comet tail in this
tutorial. Real comet tails are up to 200 million
kilometres in length, even though the core of ice
and dust is ‘only’ a few kilometres in diameter.
We will not be working to scale for this one :-)

Start by creating a light source with the
parameters listed below. Only the values which
you need to change are listed - please leave the
other values set to their default. For more
information on light sources, see page 186.

General tab
Color R 100%, G 50 %, B 0%
Visible Light Visible
No Light Radiation activated

Visible Light tab
Outer Distance 10 m
Outer Distance Y 10 m
Outer Distance Z 20 m
Additive activated

Next, create an emitter and change the
following values (again, leave the values that
are not listed set to their default):

Particle tab
Speed Variation 50%

Emitter tab
X Length 30 m
Y Length 30 m
Horizontal 30°
Vertical 30°

Drag-and-drop the name of the light source
onto the name of the emitter in the Object
manager. This will make the light source a child
of the emitter. Move the time slider some way
into the animation, then render the picture.

You could refine the tail by animating the light
source parameters. For example, the particles
could start with a yellow color, changing to
orange then black over time. You could also add
a particle modifier or two. The sky’s the limit!
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Particle animation with metaballs

CINEMA 4D allows you to combine the properties
of particles and metaballs. We explain the process
below. As with the first mini-tutorial, we list only
the values that you need to change. Please leave
values that are not listed set to their default.

Create a metaball and change its values to:
Hull Value 70%
Editor Subdivision 15 m
Render Subdivision 5 m

Next, create an emitter with the following
values:

Particle tab
Birth Rate (Editor + Rendered) 15
Lifetime 100 F; Variation: 50%
Speed 500 m; Variation 50%
End Scaling 0; Variation 100%

Drag-and-drop the name of the emitter onto
the name of the metaball in the Object
manager. This will make the emitter a child of
the metaball. Note that, in this case, you do not
need to make an object a child of the emitter.

Move the time slider some way into the
animation, then render the picture. Please
experiment with the settings - you can create
some wonderful effects with this technique!

Note

You must render in the Picture Viewer
(Render > Render to Picture Viewer) in order to
see the ‘smooth’ version of the metaballs - this
smooth version relates to the metaball’s Render
Subdivision value.
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Deformation
The deformation objects deform the geometry
of other objects. You can use deformers on
primitive objects, NURBS objects, polygon
objects and splines.

In the following, we call the object that is to be
deformed the recipient object.

To have an effect, the deformer must either be
on the same hierarchy level as the recipient or a
direct child of the recipient.

You can use several deformers on the same
recipient. Their order of evaluation is from top
to bottom in the Object manager. The
evaluation order matters — a twist followed by
a bend produces a different result to a bend
followed by a twist!

The deformer can only work with what you give
it. For example, if you wish to twist the recipient
smoothly, ensure that it has a sufficiently high
number of segments/subdivisions along the
twist axis.

All deformers apart from bones are activated
automatically when you create them. If a
deformer is activate, you will see the following
icon in the Object manager:

To deactivate the deformer, click on the green
tick. The icon changes into a red cross:

A deformation object has no effect when it is
deactivated.

There are two ways to activate or deactivate all
deformers at once. You can either toggle the
Use Deformers option from the Edit menu
(main window) or you can use the drawing
pipeline icon shown below. For information on
the drawing pipeline, see page 89.

Turn on/off deformers in the drawing pipeline

To animate a deformer, use a parameter track in
the Time Line (see page 593). For example, you
can vary the strength of a wind deformation
over time.

You can restrict a deformer’s influence using
vertex maps and polygon selections — see page
253 for an example with bones. You can learn
how to make vertex maps on page 325, and
polygon selections on page 320.

Very important note!

Activate UVW mapping before you deform
objects. This will prevent textures from
‘slipping’. See page 542 for more details on
UVW mapping.



248 • OBJECTS MENU • CHAPTER 7

Bend
This deformer bends an object. The deformer
has an orange handle on its top surface. Drag
the handle to control the bend interactively in
the editor.

Cube with 5x5x5 segments

The same cube with a bend deformation

To open the dialog for the bend deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:

Size

You can use the X, Y and Z values to change the
deformer’s dimensions.

Mode

There are three modes for bend deformation.

Within Box

Surfaces within the cyan box are bent. Surfaces
outside the box remain exactly where they are
(they are unaffected).

Limited

The entire object is affected. Surfaces within the
cyan box are bent and the other surfaces move
and rotate if necessary to accommodate the
bend.
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Unlimited

The entire object is bent.

Angle

This value is the bend angle. To change this
value interactively, drag the orange handle in
the editor.

Direction

This value defines the direction of the bend. 0°
corresponds to the deformer’s local X axis.

Keep Y Axis Length

If you activate this option, the object will
maintain its original length throughout the bend
deformation.

Bone

Modeling characters and moving their limbs and
clothes realistically is one of the most
challenging and rewarding tasks in 3D.

One approach is to divide the character object
into several objects and apply inverse
kinematics. Unfortunately, this method involves
unattractive splits in the joint areas.

A better solution is to mimic nature by placing a
skeleton (i.e. a hierarchy of bones objects) inside
a single character mesh. The character is then
posed by moving the bones.

The skin (i.e. the surface) bends and stretches as
the bones are moved. This approach avoids the
problem of split joints. Furthermore, since the
bones are completely separate to the object
itself, you can use the same skeleton time and
again with other characters.

Bones can be used with all object types, e.g.
parametric objects, NURBS objects, polygon
objects, splines. You can even apply bones to
other deformation objects!

Hyper NURBS and Bones

You can apply bones to a Hyper NURBS object
(see page 158). There is no need to convert the
Hyper NURBS object into a polygon object.
Rather than work with a high-poly object, you
can apply the bones directly to the low-poly
cage of the Hyper NURBS. The bones will
deform the cage, which in turn will deform the
Hyper NURBS object. The object is smoothed
after the deformation.
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This method saves you the polygon errors, torn
mesh and kinks that are associated with high-
poly characters. You simply animate the cage
and the result is a perfectly-formed, clean, kink-
free Hyper NURBS object. In addition, it is much
easier and more flexible to work with a low-poly
object when using limited radii or even vertex
maps.

Laying out the bones hierarchy

In this section we are going to create a hierarchy
for a Hyper NURBS leg. First we need the leg.
We have included one for you on the
CINEMA 4D CD. Load the Hyper NURBS leg.
We need to create three bones; thigh, lower leg
and foot. We shall start with the thigh bone,
since it needs to be at the top of the bones’
hierarchy (the bones’ hierarchy will be created
automatically, so it is important to start with the
topmost bone).

Create a bone object by selecting
Objects > Deformation > Bone. Initially, the
bone points in the direction of the Z axis. You
can rotate the bone by dragging the little
orange circle (handle) at the tip of the bone.
Change into the side view and rotate the bone
into the knee.

We are going to create the second bone (lower
leg) by pulling it out of the thigh bone. Hold
down the Ctrl key and drag out a new bone
from the orange handle of the thigh bone. Let
go of the mouse once the new handle reaches
the ankle region of the leg. Change into the
front view and enable that the new bone really
is in the middle of the lower leg. If necessary,
adjust the direction of the new bone by
dragging its handle. When a new bone is
created in this way (pulled out from an existing,
parent bone) it becomes a sub-object of the
parent bone automatically.

We need just one more bone, the foot bone.
Pull the foot bone out from the lower leg bone.
Move into the top view and enable that the
bone is in the middle of the foot.
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Note

The bone may spin around the Z axis when you
pull on its handle. In this case you should rotate
the bone about the Y axis of the world
coordinate system using the Rotate tool,
otherwise problems may occur later when the
bone is animated.

Using the Limit Radius option

It is important to restrict a bone’s influence. For
example, we do not want the thigh to be
deformed when we move the foot bone. There
are three ways to restrict the influence of bones
— the first and most simple way is to use the
Limit Radius option, which is explained on
page 255, The Bone Dialog.

Double-click on the icon for the topmost bone
(the thigh bone) in the Object manager. Then,
in the dialog that appears, select the Limit
Radius function. Set Min. Radius and Max.
Radius to, say, 30 and 50 — the exact values do
not matter since we shall adjust them
interactively in the editor. What is important is
that you enter a value greater than 0 for Min.
Radius, otherwise its handle will not appear in
the editor. Click on OK to close the dialog. Now,
limit the radii for the other two bones as well.

You should see two capsule-shaped cages in the
editor surrounding whichever bone is selected.
You can enlarge or scale down the cages by
dragging their little orange handles. When using
a Hyper NURBS object you can often set both
radii to the same value, since the points of the
Hyper NURBS cage are usually so far apart that
a soft transition will occur automatically. If you
would like to see the points of the Hyper NURBS
object cage, take the cage out of the Hyper
NURBS and change the display mode to
wireframe — do not forget to put the cage
back.

Select the foot bone. The radii for the foot
should appear. Adjust the radii so that they
enclose the foot completely.
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Now adjust the radii for the lower leg bone until
they enclose the entire lower leg and part of the
foot. Next, adjust the radii for the thigh bone so
that they enclose the entire thigh and part of
the knee.

Slight overlaps are fine. What is important is
that all parts of the leg are influenced by at least
one bone, otherwise the leg will tear when the
bones are animated.

Now we are ready to apply the bones, so drop
the bones hierarchy onto the Hyper NURBS
cage in the Object manager.

Finally, we need to fix the bones; click once on
the topmost bone in the Object manager to
select it, then choose Objects > Fix Bones. A
requester appears, asking if sub-objects should
be included (fixed). Click on OK.

The position in which the bones are fixed is their
starting position. You can return the bones to
their starting position at any time by selecting
Objects > Reset Bones in the Object manager.
Resetting the bones deactivates their influence
at the same time, i.e. they will no longer be
fixed. You can fix the bones again in the usual
way (Objects > Fix Bones in the Object
manager).

In this way you are able to change the starting
position of the bones (move the bones to their
new starting position before fixing them again).

You can tell if a bone is active by its activation
icon in the Object manager:

Important

Bones are activated automatically when you fix
them. However, just activating the bones will
not fix them! You must fix the bones before
activating them. Once you have fixed the bones,
you can activate and deactivate them as
required. You may be wondering what happens
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if you activate a bone before it is fixed. The
answer is simple — the default fixing values of
0,0,0 will be used as the starting position and
the object will be deformed accordingly
(probably not a pretty sight!).

Try rotating the bones using the Rotate tool. If
you notice that some parts of the leg are not
moving properly, it is more than likely that you
need to enlarge the radii for one or more of the
bones. You can change the radii interactively
even though the bones are fixed. Even if the leg
is moving properly, try changing the radii to see
how easy it is to adjust them in this way.

The bend at the knee isn’t quite right. This is
because the function is set too soft (see
page 255). Change the Function value for the
top bone to 1/r^10. There, perfect!

You can learn how to apply inverse kinematics
to bones and how to animate the leg on page
307.

Restricting bones using polygon selections or
vertex maps

In the preceding section we used the Limit
Radius option to restrict a bone’s influence.
Bones can also be restricted using polygon
selections or vertex maps. Exactly how you
create polygon selections and vertex maps is
beyond the scope of this section — instead, see
pages 320 and 325. That section describes how
you can allocate an existing selection or vertex
map to a bone.

You can use polygon selections and vertex maps
to restrict the effect of any type of deformation
object (e.g. bend, bulge). The procedure is
described in this chapter since restriction is used
primarily with bones.

In the previous section we were able to restrict
the bones in a leg quite effectively using radii.
However, most conventional life-forms have at
least two legs — as you can see in the picture
below, the radii spill over onto the right leg,
causing problems when the legs are animated.
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You can solve this problem by defining either a
polygon selection or a vertex map for each leg.
There is no need to define a restriction for each
part of the leg — it is sufficient to restrict each
leg as a whole.

For our example, a polygon selection per leg is
adequate, since the points in the Hyper NURBS
cage are spread out. If, on the other hand, you
are using an object with a high point density,
vertex maps are the better option in order to
obtain a smooth transition at the edges of
bones. In any case, the procedure for both
methods is identical, i.e. the following
description applies to vertex maps as well as
polygon selections.

The polygon selection will restrict each leg as a
whole. This means that we still need to use
limited radii (see above) to further restrict each
bone, e.g. so that the foot bone of the left leg
will only influence the foot region of the left leg.

We can use our Hyper NURBS leg from the
previous section. The bones already use the
limited radii that we require. Mirror the surfaces
of the leg (see page 368) to create a second leg.
Now, select the surfaces of the leg which
contains the bones, then choose Selection > Set
Selection. Name the selection ‘left leg’.

Now for the really important part — the
allocation of the restriction tag to each bone.

In the Object manager, select File > New
Tag > Restriction Tag. The following window
appears:

You can use this dialog to specify all the polygon
selections and vertex maps that the bone should
influence. The strength percentage allows you
to weight the bone for each selection or vertex
map. In our example, we use just one selection,
left leg. Type ‘left leg’ into the first line of the
dialog. You can leave its strength setting at
100%. Once you have clicked on OK, the
following icon appears in the Object manager,
to the right of the bone:

Copy the restriction tag onto the other bones
(drag-and-drop the restriction tag with the Ctrl
key held down). This will ensure that the bones
influence the left leg selection only.
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The allocation procedure is identical for vertex
maps. You can find an example of vertex map
restriction on the CINEMA 4D CD.

The Bone Dialog

If you click on the bone icon in the Object
manager the following dialog opens:

Length

Here you enter the length of the bone. The
length extends from the origin of the bone’s
coordinate system to the orange handle.

Function

The function defines how loose or tight the
bend at the joints should be. The higher the
power of 1/r, the greater the pull on the
surrounding points, as shown in these examples:

Function 1/r^2 Function 1/r^10

This illustrates how the bend becomes tighter in
the joint region with increasing power for the
radius setting.

Lower settings are more suited to tube-like
objects such as snakes; higher settings are more
suited to anatomical joints such as elbows.

The function must be defined in the bone at the
top of the hierarchy (topmost in the Object
manager). This will define the function for all
the bones in the hierarchy, regardless of the
function value set in those bones.

Limit Radius, Min. Radius, Max. Radius

If the Limit Radius option is not selected, a
bone will influence all the object’s points. In
order to prevent, say, the head moving when
you move the little toe, you can use the Limit
Radius option to restrict a bone’s influence.
Min. Radius defines the volume within which all
points are transformed completely by the bone
(1:1).

Points between the minimum and maximum
radii are transformed softly, generating a
smooth stretch. If both radii are equal, the
points at the edge tear abruptly.
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Bone with Limit Radius Min.: 35, Max.: 95

The pictures above and below show how, in
view of the original horizontal position of the
bone:

- the volume within the minimum radius is
rotated but not distorted;

- the volume between the minimum and
maximum radius is rotated and distorted;

- the volume outside the maximum radius is not
influenced at all.

Starting object; plane with bone

Soft transition at the edge (Min. Radius = 0) — all points
within Min. Radius are transformed softly

Hard edge (Min. Radius = Max. Radius) — All points within
Max. Radius are transformed completely

Note

If you restrict the bones using the Limit Radius
option the radii must, on principle, be restricted
for all sub-bones too.

As a general rule, restrict all of the bones, or
none at all.

Strength

This lets you specify the influence that a bone
exerts on a point in comparison to all other
bones.

Scale Strength with Length

If the length of a bone is animated, it can be
useful to change its strength proportionately. If
you require this, activate this option.
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Fixing tab

You can use this tab among other things to
define an irregular scale for a bone, e.g. to
create irregular bone radii. Proceed with caution
— the sub-systems will be distorted, which can
lead to unexpected results (see page 304).

Bulge
This deformer makes an object bulge or
contract. The deformer has an orange handle on
its top surface. Drag the handle to control the
bugle interactively in the editor.

Cube with 5x5x5 segments

The same cube with a bulge deformation

To open the dialog for the bulge deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:
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Size

You can use the X, Y and Z values to change the
deformer’s dimensions.

Mode

There are three modes for bulge deformation.

Within Box

Surfaces within the cyan box bulge. Surfaces
outside the box remain exactly where they are
(they are unaffected).

Limited

The entire object is affected. Surfaces within the
cyan box bulge and the other surfaces move
and rotate if necessary to accommodate the
bulge. In the example, the result is the same as
Within Box. However, the effect differs when
the bulge deformer is moved or rotated.

Unlimited

The entire object bulges.

Strength

This is the strength of the bulge. To change this
value interactively, drag the orange handle in
the editor.

Curvature

This value affects the curvature of the bulge.
The higher its value, the more curvy the bulge.

Fillet

If you select this option, the deformation is
softened near the top and bottom.
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ExplosionFX
This modifier object helps you create realistic
explosion effects. The explosion is easy to
animate — simply record the Time parameter.

Dozens of other settings let you slow down or
reverse the explosion, give volume to exploding
clusters, simulate gravity and so on.

To see your changes in the view panel in
realtime, enable the Preview option.

Explosions

Strength

Here, enter the force used to accelerate the
clusters. The value needed for a good effect
depends on the size and density of the clusters.

Use Decay to set falloff for the Strength. 0%
means no falloff, 100% means the Strength falls
to 0 by the time it reaches the edge of the blast
range.

Use Random to vary the Strength for each
cluster. 0% means no variation, 100% means
the Strength can vary from zero to double its
entered value.

Direction

This sets the direction in which clusters can be
accelerated — along all axes, along two axes, or
along one axis only.

Use Random to vary the direction of each
cluster. This helps you avoid uniform shapes to
the explosion.

If you have set Direction to a single axis, enable
Linear if you want equal force applied to all
clusters.

Blast Time

Like Strength, this affects the amount of force
applied to the clusters. Change this value only if
the maximum Strength value is insufficient.

Blast Speed

Here, enter the speed of the blast (in metres per
second). A cluster remains in place until the
blast (green radius) reaches it. If you set Blast
Speed to 0, all clusters are accelerated
immediately.

Decay sets falloff for the Blast Speed. 0% means
no falloff, 100% means the Blast Speed falls to
0 by the time it reaches the edge of the blast
range.

Note

If the gravity range (blue radius) is larger than
the blast range (red radius), the Decay value
refers to the gravity range instead.

Use Random to vary the Blast Speed value.
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Blast Range

Object surfaces outside this range (red radius)
are not accelerated by the blast.

Note

Surfaces accelerated from within the blast range
can continue travelling beyond the blast range.

The blast position shown as a white line for illustration
purposes only – usually, the blast position is shown as a green
radius.

Clusters

Thickness

Enter a value here to give exploding clusters
volume. The volume is achieved by extruding
the cluster surfaces in the direction of their
surface normals. To reverse the direction of the
extrusion, enter a negative value.

Density

Here, enter a density so that the weight of each
cluster can be calculated and taken into
account.

Note

If you want the explosion to ignore cluster
weight, set Density to 0.

Cluster Type

This defines how clusters are formed from
polygons. Choose from:

Polygons

Each polygon forms a cluster.
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Use Selection Tags

Each polygon selection forms a cluster. The
unselected polygons form a single, ‘unselected’
cluster. To prevent the unselected cluster from
moving, enable Fix Unselected.

However, if you type the name of a selection
under Mask, only two clusters will be formed –
one cluster for the named selection, the other
cluster for all remaining polygons.

Selections + Polygons

Each polygon selection forms a cluster. Each
unselected polygon forms a cluster.

However, if you type the name of a selection
under Mask, a cluster is formed for that
selection and a cluster is created for each
remaining polygon.

Disappear

Enable this option if you want the clusters to
shrink and eventually disappear during the
explosion.

You can enter the Start and Duration as a
percentage of time or as a distance in meters.

Gravity

Acceleration

This defines the acceleration due to gravity. By
default, this is set to Earth’s value of 9.81. A
value of 0 means no gravity.

Direction

This defines the direction of the gravity effect.
To switch off gravity, choose No.

Range

This (blue) radius defines the area in which
gravity has an effect. However, all clusters inside
the blast range (red radius) will be affected by
gravity regardless.

Use Random to prevent a perfect sphere of
gravity.
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Beyond the red radius, only gravity accelerates the clusters.
Gravity is limited by the blue radius.

Rotation

Rotation

Here, define a rotation for the clusters. A
negative value reverses the direction of rotation.

Decay controls falloff for the Rotation value. 0%
means no falloff, 100% means the Rotation
value falls to 0 as the clusters reach the edge of
the blast range.

Use Random to vary the rotation for each
cluster.

Rotation Axis

By default, each cluster rotates about its center
of gravity. Here, you can make clusters rotate
around the X, Y or Z axis only of the world
system. This is useful for special effects, logo
animation and so on. Use Random to tumble
the clusters.
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Specials

Wind

This value defines the strength of the wind
effect. The wind blows in the direction on the
exploding object’s Z axis.

Use Random to vary the wind for each cluster.

Note

Wind does not take object weight into account.

Twist

Use this to twist the clusters about the Y axis of
the exploding object.

Use Random to vary the twist for each cluster.

Animating ExplosionFX

To animate the explosion, record keys using a
parameter track. Before you record each key,
move the Time slider in the ExplosionFX dialog
until the explosion is in the required state for the
key.

Explosion

Note

This object is included for backwards
compatibility only. For a more realistic
explosion, use ExplosionFX – see page 259.

The explosion deformer explodes an object into
its constituent polygons. The recipient object
explodes from the deformer’s origin. Drag the
orange handle to control the state of the
explosion interactively in the editor. To animate
the explosion, use a parameter track in the Time
Line (see page 593). For a complete explosion,
set Strength for the first key to 0% and Strength
for the second key to 100%. To reverse the
explosion (an implosion), swap the keys around.
Implosion is particularly useful for logo
animation.

 A normal sphere

The same sphere with an explosion deformation
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To open the dialog for the explosion deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:

Strength

This value defines the state of the explosion.
0% is the start of the explosion, 100% is the
end of the explosion. To change this value
interactively, drag the orange handle in the
editor.

Speed

This value defines the speed of the polygons
during the explosion.

Angle Speed

This value defines the angle through which each
polygon rotates during the entire explosion.

End Size

This value defines the relative size of each
polygon at the end of the explosion. If the value
is set to 1, the polygons will remain the same
size throughout the explosion. If the value is set
to 0, the polygons will disappear by the end of
the explosion. If the value is 2, the polygons will
double in size.

Randomness

This value defines the percentage by which the
speed and angle speed may vary.

Note

Currently the Explosion Object does not support
vertex maps
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FFD
The FFD deforms objects freely using any
number of grid points. Each grid point pulls on
surfaces like a little magnet.

Note

In contrast to the other deformers, you must edit
the FFD in point mode (there are no handles to
move, only grid points to manipulate).

To animate an FFD deformer, use either morph
targets or PLA (see Special Effects, page 583).

Cube with 5x5x5 segments

The same cube with an FFD deformation

To open the dialog for the FFD deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:

Grid Points

You can use the X, Y and Z values to define the
number of grid points in the respective
directions.

Grid Size

You can use the X, Y and Z values to change the
deformer’s dimensions.
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Formula
The formula object uses mathematical formulae
to deform other objects. Drag the handles to
control the size of the deformer. All surfaces
including those outside the cyan box are
affected. The default formula creates circular
waves.

Plane with 40x40 segments

Another formula example
cos(4*sqrt(x*x+z*z)-2*t)/sqrt(1+4*sqrt(x*x+z*z))

This formula creates damped circular waves. The
time parameter (t) has been introduced so that
the waves are animated automatically over time.

To open the dialog for the deformer, double-
click on its icon in the Object manager.

The dialog contains the following settings:

Size

You can use the X, Y and Z values to change the
deformer’s dimensions.

Effect

This value defines how the formula deformation
should be applied.

- Manual. You can enter separate formulae for
X, Y and Z. This enables you to combine
several formulae.

- Spherical. The effect radiates from the
deformer’s origin outwards.

- Cylindrical. The effect starts from the
deformer’s Y axis and travels along its X and Z
axes.

- X Radial. The effect starts from the deformer’s
origin and travels along its X axis only.

- Y Radial. The effect starts from the deformer’s
origin and travels along its Y axis only.

- Z Radial. The effect starts from the deformer’s
origin and travels along its Z axis only.

d(u,v,x,y,z,t)

This line is used for all effects apart from
Manual.

X(x,y,z,t), Y(x,y,z,t), Z(x,y,z,t)

These three lines apply to Manual only.



CHAPTER 7 • OBJECTS MENU • 267

Melt
The melt deformer has no cyan box. The
recipient object melts radially from the
deformer’s origin. Drag the orange handle to
control the state of the melt deformation
interactively in the editor. To animate the melt
deformation, use a parameter track in the Time
Line (see page 593). To melt the object
completely, set Strength for the first key to 0%
and Strength for the second key to 100%. To
reverse the melt effect, swap the keys around.

The recipient object will melt onto the Y plane
of the deformer’s origin. Consequently, the melt
deformer is usually placed at the bottom of the
recipient object.

Cube with 5x5x5 segments

The same cube with a melt deformation

To open the dialog for the melt deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:

Strength

This defines the state of the deformation. If set to
0%, there is no melting. If set to 100%, the object
is fully molten. To change this value interactively,
drag the orange handle in the viewport.

Radius

Surfaces within the Radius setting will melt
more slowly than the other surfaces.

Vertical Randomness

This value defines the variation in downwards
motion.

Radial Randomness

This value defines the variation in outwards
motion.

Melted Size

This value defines the final width of the recipient
object relative to its original width. The default
value is 400%. Imagine a melting ice cube — the
width of the puddle left behind is much larger that
the original width of the ice cube.

Noise Scale

The higher you set this value, the more irregular
the surface becomes during melt deformation.
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Polygon Reduction

The CINEMA 4D Polygon Reduction deformer
(PolyReduction) enables you to reduce the
number of polygons of any CINEMA 4D
geometric object and operates in a flexible and
intuitive way.

PolyReduction is available from the Objects >
Deformation menu and behaves like any other
deformer – just choose PolyReduction and place
the resultant object into the Object manager
hierarchy of the object that you want to effect.

Why use polygon reduction?

Many 3D tasks demand models that use as few
polygons as possible. Unfortunately, the various
techniques used to create models often means
that more polygons are created than are
necessary. Worse still, without polygon
reduction tools, these models must be reduced
by hand.

Here, a few examples to show the importance
of polygon reduction:

- modern 3D games need characters with low
polygon counts for smooth animation in
realtime

- models for the Internet, in formats such as
VRML, need a low polygon count for quick
download

- models created by 3D scanners often have an
extremely high number of polygons; reducing
the number of polygons makes these objects
easier to handle.

To summarize: reducing the number of polygons
means faster render times and lower memory
requirements.

What does PolyReduction do?

The CINEMA 4D PolyReduction deformer works
hard to reduce the number of polygons in the
chosen object quickly and accurately – this is its
mission in life.

It always tries to reduce the polygon count
according to your wishes and provides many
options for user control.

Note

PolyReduction works with triangles (not quads)
and, if necessary an automatic triangulation of
the object will be performed before reduction.

CINEMA 4D’s PolyReduction is great for
simplifying an object mesh, taking care of any
resultant mesh inconsistencies (e.g. fold-overs,
boundary cracks) but it does not create a
dynamic map of this process (for multiple LODs
– levels of detail).

Note

PolyReduction manages and diminishes the
number of polygons in an object but it cannot
take care of the exact number of points in the
object!
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Using Polygon Reduction

To apply CINEMA 4D’s polygon reduction to an
existing object, proceed as follows.

- Choose PolyReduction from the Objects >
Deformation menu. This creates a new object
in the root of the Object manager, named
PolyReduction.

- Rename this object if you wish.

- Now move this object into the hierarchy of the
object that you wish to affect; you can place
the PolyReduction object anywhere within an
object’s hierarchy – polygon reduction will take
place on this object and all its children. It works
as a deformer.

While the polygon reduction is taking place,
information on the process (including the
original and the expected final polygon count)
will appear in CINEMA 4D’s status bar (bottom
left).

- To change the amount of reduction and to
access options for any particular use of
PolyReduction, double-click its icon in the
Object manager.

The Polygon Reduction Dialog

Polygon Reduction Strength

You can use the slider to vary the amount of
polygon reduction that takes place when the
dialog is confirmed. The reduction is expressed
as a percentage of the original number of
polygons (triangles, remember) in the object so
that if you choose 50% for an object with 500
triangle polygons, the tool will attempt to
reduce the object to 250 triangle polygons.

Do not expect this to be an exact science; there
may be further reductions due to, for example,
any co-planar areas (i.e. faces with polygons all
in the same plane) which are always reduced as
far as possible. But the percentage slider is a
great way to quickly reduce or increase the poly
count.

There are a number of options that allow you to
adjust the trade-off between the speed and the
accuracy of the reduction. These are now
described.

Object Mesh Quality Factor

The value assigned here affects the final result
of the optimization by determining how much
fold-over checking is done; a low value reduces
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the number of checks made whilst the mesh is
reduced, a high value increases the number of
checks.

You can enter any value between 0 and 20000;
use a high value if you have a complex mesh
with a high reduction strength, a low value
should suffice for simple meshes and/or low
reduction values. In general, the value you
choose does not affect the speed of the
reduction process with the exception that a
value of 0 will lead to a faster reduction, since
this turns off any checks.

As with other options the checks work during
the entire reduction process and monitor the
appearance of overlapping polygons in the mesh
of the object.

Here is an example that shows how an
overlapped (i.e. folded over) mesh can result
from a bad reduction decision and therefore
why such checks are necessary.

The triangle (polygon) C has overlapped the A
and B polygons of the mesh:

or, perhaps more clearly, (with the neighbor
triangles of the collapsed edge being vi, vj):

where, a normal reduction should result in:

or, in 3D:

�

So, start with the default value for the Object
Mesh Quality Factor, which should work fine for
the majority of objects, and, if you encounter
problems, increase the value until the problems
disappear.

—Co-planar optimization

This option, when enabled, will speed up the
work of the reduction process for objects, such
as cubes, that have many co-planar areas.

When you turn on this option PolyReduction
employs a special, fast method to optimize co-
planar areas (areas that have polygons in the
same plane) irrespective of the reduction
strength factor.

If this option is off a different method is used for
co-planar areas.

As an example, create a cube with 50 segments
along each side and then use PolyReduction on
the cube, once with Co-planar optimization
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checked and again with it unchecked. You
should find that the cube reduces considerably
faster with the option checked.

—Boundary Curve Preservation

Check this option to preserve the boundaries of
certain non-manifold objects (like the Landscape
for example) from collapsing during the
reduction process. This prevents any disruption
in the boundary curve of the object but will slow
down the reduction process slightly.

—Polygon Quality Preservation

This option, when checked, monitors the
appearance of sliver polygons (i.e. triangles with
an angle smaller than 15˚) within the object
mesh during the reduction process and tries to
eliminate them, if possible.

Here is an example of the appearance of sliver
triangles as a result of the reduction process:

Enabling this option usually leads to a much
better distributed mesh. On the other hand be
aware that this check will preserve any already
existing sliver triangles (from the original mesh)
to the highest levels of reduction.

A more thorough explanation and some advice
on how to work with these options is given in
the Hints and Tips section below.

Further Usage Advice

Remember that PolyReduction acts as a
deformer i.e. you place it within your object
structure in the Object manager – it will reduce
the polygons of its parent object and all its

children. You can use PolyReduction on any
geometric object (HyperNURBS, Object
Primitive, Array etc.).

If you apply the deformer to a HyperNURBS
object make sure that it is placed at the same
hierarchical level as the HyperNURBS object, not
within the child of the HyperNURBS object.
Also, since the HyperNURBS operates on the
first sub-object in its hierarchy, make sure that
PolyReduction is placed below that sub-object.
The following screenshots illustrate this.

a HyperNURBS object before applying PolyReduction

the incorrect placing of the PolyReduction deformer within the
HyperNURBS sub-object leads to a strange result
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the correct placing of the PolyReduction deformer

As with other deformers you can turn
PolyReduction on and off using the tick icon
alongside the PolyReduction object in the
Object manager. You can do this at any time
that PolyReduction is part of the object’s
hierarchy.

the PolyReduction deformer turned off

the PolyReduction deformer turned on

Converting the Final Object

While you are working with PolyReduction to
obtain a reduced polygon count that suits your
purposes, the deformer maintains the original
mesh and re-calculates as you experiment.

When you are fully satisfied with your new
object you should select it in the Object
manager and use Functions > Current State to
Object to produce a new object without the
original mesh – then you can delete the original
object.

Hints and Tips

Or how to combine the options according to the
base mesh of the object.

Quality First

Using Boundary Curve Preservation always
gives good results if you want to preserve the
original mesh boundaries of non-manifold
objects i.e. objects that are not entirely closed.
For a manifold object (sphere, capsule, cube
etc.) it makes no difference if this check is on or
off since the algorithm detects manifold objects
automatically and then deactivates boundary
checks if they are on.

Using the Polygon Quality Preservation check is
very helpful with objects which have co-planar
faces (faces with polygons in the same plane),
such as cubes or planes. The result of using this
option is that the generated mesh is very well
distributed and this leads to a substantially faster
reduction process, as long as no clustering-
points (points which have a large number of
neighboring edges) appear in the reduction
process.
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Tests show that using sliver checks (Polygon
Quality Preservation) gives a better mesh when
applied to objects with no co-planar faces and a
major improvement in the mesh when working
with co-planar faces.

Note

With some objects like a cone, a sphere, a circle
etc., which have one or more central points in
the mesh, around which there are many edges, it
is normal for the algorithm to keep the clustering
as high as possible at this point, because the
point is not generated during the process of
reduction, but exists in the base mesh.

Here is an example of sliver triangles generated
as a result of the reduction (if the Polygon
Quality Preservation option is not used):

and sliver triangles preserved when this option is
on, due to their existence in the original object
mesh:

Such preservation results from the fact that the
algorithm detects that collapses in the area of
the slivers will lead to other slivers and therefore
postpones the reduction.

As you can see, adjusting these quality factors
can influence very strongly the way in which the
reduction process proceeds.

In some rare cases the accumulative nature of
these options can lead to prevalence of some
checks over others, with the result that no
perfect decision for the reduction can be made.
This can be observed in some special cases when
the sliver check and/or the boundary check
prevails over the fold-over check and so the final
mesh shows some fold-overs. What happens is
that the algorithm reaches a point at which it
has to decide either to generate a fold-over, to
break the object boundary, or to generate a
sliver. So it takes the user-defined quality factor
into account and calculates the ‘better’ decision.
In such a case, in order to avoid the fold-over, a
higher Object Mesh Quality Factor should be
used.

Speed First

Generally, all checks will slow down the speed of
simplification to a greater or lesser extent. This is
because, for every potential edge collapse, each
check has to take into account the face areas,
vector angles, orthogonal plane distances etc.
for every one of the neighboring polygons.

Here is some universal advice about the use of
PolyReduction’s options:

General Advice

- On an object with co-planar faces use Co-
Planar optimization. This will speed up the
simplification significantly.

- On co-planar objects, if not using Co-Planar
optimization, check Polygon Quality
Preservation. This will generate a really well
distributed mesh and will work more quickly
than with option turned off.

- Leave the Boundary Curve Preservation option
on. It will keep the boundaries of non-manifold
objects alone and will not interfere when the
object is manifold.
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Here are some results generated with
PolyReduction:

A 3D head with 6876 triangles, reduced to 3437 triangles

The head rendered with 6876 triangles, 3437 triangles and
1715 triangles

A 3D plane with 998 triangles (front) and 20 000 triangles
(rear)

The same 3D planes showing the object mesh
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A reduced sphere with 528 triangles (front) and the original
sphere with 8448 triangles (rear)

A 3D co-planar object with a complex boundary – originally
with 1792 triangles (rear); reducing with the Co-planar
optimization on results in 20 triangles (front)

An example of reduction applied to a non-manifold plane object with complicated boundaries
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Shatter
The shatter deformer has no cyan box. The
recipient object shatters into individual polygons
which then fall to the ground. Drag the orange
handle to control the state of the shatter
deformation interactively in the editor. To
animate the shatter deformation, use a
parameter track in the Time Line (see page 593).
To shatter the object completely, set Strength
for the first key to 0% and Strength for the
second key to 100%. To reverse the shatter
effect, swap the keys around.

The shattered polygons will fall onto the Y plane
of the deformer’s origin. Consequently, the
shatter deformer is usually placed at the bottom
of the recipient object.

Cube with 5x5x5 segments

The same cube with a shatter deformation

To open the dialog for the shatter deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:

Strength

This value defines the state of the shatter
deformation. 0% is the start of the shatter effect
(no shattering), 100% is the end (pieces
shattered and lying on the ground). To change
this value interactively, drag the orange handle
in the editor.

Angle Speed

This value defines the angle through which each
polygon rotates during the entire shatter
deformation.

End Size

This value defines the relative size of each
polygon at the end of the shatter deformation
(when Strength is 100%). If the value is set to
1, the polygons will remain the same size
throughout the deformation. If the value is set
to 0, the polygons will disappear by the end of
the shatter effect. If the value is 2, the polygons
will double in size.

Randomness

This value defines the percentage by which the
speed and angle speed may vary.

Note

Currently the Shatter Object does not support
vertex maps.
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Shear
This deformer shears an object. The deformer
has an orange handle on its top surface. Drag
the handle to control the shear deformation
interactively in the editor.

Cube with 5x5x5 segments

The same cube with a shear deformation

To open the dialog for the shear deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:

Size

You can use the X, Y and Z values to change the
deformer’s dimensions.

Mode

There are three modes for shear deformation.

Within Box

Surfaces within the cyan box are sheared.
Surfaces outside the box remain exactly where
they are (they are unaffected).

Limited

The entire object is affected. Surfaces within the
cyan box are sheared and the other surfaces
move and rotate if necessary to accommodate
the shear.
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Unlimited

The entire object is sheared.

Strength

This is the strength of the shear. To change this
value interactively, drag the orange handle in
the editor.

Direction

This value defines the direction of the shear. 0°
corresponds to the deformer’s local X axis.

Curvature

This value affects the curvature of the shear. The
higher its value, the more curvy the shear.

Fillet

If you select this option, the deformation is
softened near the top and bottom.

Taper
This deformer narrows or widens objects
towards one end. The deformer has an orange
handle on its top surface. Drag the handle to
control the taper deformation interactively in
the editor.

Cube with 5x5x5 segments

The same cube with a taper deformation

To open the dialog for the taper deformer,
double-click on its icon in the Object manager.
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The dialog contains the following settings:

Size

You can use the X, Y and Z values to change the
deformer’s dimensions.

Mode

There are three modes for taper deformation.

Within Box

Surfaces within the cyan box are tapered.
Surfaces outside the box remain exactly where
they are (they are unaffected).

Limited

The entire object is affected. Surfaces within the
cyan box are tapered and the other surfaces
move and rotate if necessary to accommodate
the taper.

Unlimited

The entire object is tapered.

Strength

This is the strength of the taper. To change this
value interactively, drag the orange handle in
the editor.

Curvature

This value affects the curvature of the taper. The
higher its value, the more curvy the taper.

Fillet

If you select this option, the deformation is
softened near the top and bottom.
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Twist
This deformer twists objects about its Y axis.
The deformer has an orange handle on its top
surface. Drag the handle to control the twist
deformation interactively in the editor.

Note

A deformer can only work with ‘what you give
it’. If you wish to twist the recipient smoothly,
ensure that it has a sufficiently high number of
segments/subdivisions along the twist axis.

Cube with 5x5x5 segments

The same cube with a twist deformation

To open the dialog for the twist deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:

Size

You can use the X, Y and Z values to change the
deformer’s dimensions.

Mode

There are three modes for twist deformation.

Within Box

Surfaces within the cyan box are twisted.
Surfaces outside the box remain exactly where
they are (they are unaffected).

Limited

The entire object is affected. Surfaces within the
cyan box are twisted and the other surfaces
move and rotate if necessary to accommodate
the twist.
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Unlimited

The entire object is twisted.

Angle

This value is the angle through which the
recipient object is twisted. To change this value
interactively, drag the orange handle in the
editor.

Wind
This deformer generates waves on an object.
The wind blows in the deformer’s positive X
direction. The wind deformer is animated
automatically (click on the play button).

Drag the orange handle on the Z axis to change
the amplitude of the waves interactively in the
editor. Drag the orange handle on the X axis to
change the size of the waves in the X and Y
directions.

Flag with wind deformation

To open the dialog for the wind deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:
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Amplitude

This value defines the size of the waves in the Z
direction. To change this value interactively,
drag the orange handle on the Z axis.

Flag

If you activate this option, all points along the
deformer’s Y axis remain still (fixed). For
example, you can use this to simulate a flag on
a pole — one end of the flag flaps freely in the
wind, while the other end is fixed to the pole
and does not move (place the deformer’s Y axis
along this end of the flag).

Flag activated — the wind deformer’s Y axis is located at the
left end of the flag. The left end of the flag is fixed

Flag deactivated — the entire flag flaps freely in the wind. The
left end is no longer fixed

Note

If you have attached a flag to a rope (see picture
below), place the wind deformer in an object

group with the rope and flag. Then, both the
rope and flag will move in the wind.

Size

This value determines the size of the waves in
the X and Y directions.

Frequency

The frequency determines the speed of the
waves.

Turbulence

This setting creates secondary waves which run
in the direction of the deformer’s Y axis. The
percentage defines the size of these secondary
waves relative to the main waves.

fx

This value determines the number of waves in
the X direction.

fy

This value determines the number of turbulence
waves in the Y direction.
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Wrap
This deformer wraps objects into a cylindrical or
spherical shape. The wrap deformer and the
recipient should be placed as shown in the
picture below. This is because the recipient is
wrapped around the deformer’s axes.

The wrap deformer has a flat surface and a
curved surface. The curved surface represents
part of the sphere or cylinder around which the
recipient will be wrapped. The straight surface
represents the area which will be wrapped
around the curved surface exactly. If the
recipient is larger than the flat surface, it will
wrap onto and beyond the cyan curved surface.
If the recipient is smaller than the flat surface, it
will wrap onto and within the curved surface (it
will not cover the entire curved surface).

Drag the orange handles on the X and Y axes to
change the dimensions of the flat surface
interactively in the editor. Drag the handle on
the Z axis to change the radius of the sphere or
cylinder.

Text in an Extrude NURBS

The same text with a wrap deformation

To open the dialog for the wrap deformer,
double-click on its icon in the Object manager.

The dialog contains the following settings:

Transform Area

These settings define the width and height of
the flat surface. If the recipient is larger than the
flat surface, it will wrap onto and beyond the
cyan curved surface. If the recipient is smaller
than the flat surface, it will wrap on to and
within the curved surface (it will not cover the
entire curved surface). To change the transform
area interactively, drag the orange handles on
the X and Y axes.
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Radius

This value defines the radius of the cylinder or
sphere (see below) around which the recipient is
wrapped.

Wrap

You can use this value to determine whether the
recipient is wrapped around a sphere or a
cylinder.

Cylindrical wrap

Spherical wrap

Longitude

These angles define the horizontal span of the
curved surface about which the recipient is
wrapped. If Start is set to 180° and End to 360°,
the curved surface forms half of the cylinder or
sphere in the horizontal direction.

Latitude

These angles define the vertical span of the
curved surface about which the recipient is
wrapped. If Start is set to -45° and End to 45°,
the curved surface forms the middle half of the
cylinder or sphere in the vertical direction.

Movement

You can use this value to specify a movement in
the Y direction. This causes the object to wrap in
a spiral fashion. You can use a positive value to
spiral up or a negative value to spiral down.

Scale Z

Use this value to simulate the flattening effect that
often occurs when a real-life flexible object is
stretched. If you enter 50% instead of 100%, the
object will be flattened by 50% in the Z direction.
You can enter values greater than 100% if you
would like the object to expand on wrapping.

Tension

This setting enables you to define the strength
of the wrap effect. You can set values from 0%
to 100 %. To animate a wrap deformation, use
a parameter track in the Time Line (see page
593). To wrap the object completely, set Tension
for the first key to 0% and Tension for the
second key to 100%. To reverse the wrap effect,
swap the keys around.
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Sound
No, you have not mis-read and you are not in
the wrong manual; CINEMA 4D offers you
sound within your scenes. Two different options
are available: 2D Sound Rendering and 3D
Sound Rendering.

With 2D sound rendering you use the Time Line
of CINEMA 4D like a multi-track audio mixer (as
in many video editing programs). You can create
any number of sound tracks, assign WAV files to
them and adjust the timing, the volume and the
balance, depending upon your requirements.
This procedure is suitable for the classical tasks
of synchronisation (e.g. lip-synch, footsteps, a
slamming door, an explosion etc.).

3D sound rendering takes a quite different
approach. With this you work with virtual
acoustic sources (loudspeakers) and pickups
(microphones) as objects. These virtual objects
can be positioned freely within the 3D space
and also can be animated. CINEMA 4D
calculates the appropriate sound data then later,
on the basis of the spatial position of these
objects, the speed and the preset sound
parameters. You can merge this data afterwards
with surround sound data in an external
program.

The 3D sound rendering is a most versatile
method of sound production and offers many,
almost infinite, applications. From a car driving
from left to right up to an enormous spaceship
battle with laser beams and explosions in Dolby
surround sound; everything is feasible.

Loudspeaker
This function creates a loudspeaker object,
which is needed for the calculation of 3D sound
rendering (see page 596-597). You can assign a

WAV sound file to a loudspeaker object in the
Time Line and later record the sound
information emitted by the loudspeaker with
one or more microphones.

Loudspeaker objects are displayed in
CINEMA 4D as genuine 3D objects (a simplified
loudspeaker shape), but they are not visible
when rendered.

Like light sources, there are several handles on
the loudspeaker object with which you can
interactively change the playback characteristics
of the acoustic source (adjustment, range, etc.).

More extensive and exact attributes of the
playback characteristics of the loudspeaker are
available in the Loudspeaker dialog; to see this,
double-click on the loudspeaker symbol in the
Object Manager or on the object itself.

Show Cone and Falloff

With this option you can decide whether, in the
editor, the effective range (cone and falloff
range) of the loudspeaker as well as the
associated handles are displayed. This option is
on by default. Switch the option off to avoid
cluttering up complex scenes.
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Cone

The cone defines the falloff range of the
loudspeaker and can be compared with the cone
of a spotlight source.

Inner Angle

With this value you can define an inner falloff
angle. Within a cone which has this angle as its
vertex, the emitted sound has maximum
volume; it then gently quietens, until it reaches
the surface of the cone defined by the outer
angle, where the volume is zero. The permissible
values for the inner angle lie between 0° and
180°, but cannot exceed the value for the outer
angle (see below).

Tip

In order to define an inner angle, you must have
already set the Outer Angle option.

Outer Angle

Check this value to limit the falloff of the
loudspeaker within a cone defined by this angle.
The permissible values for this angle lie between
0° and 180°, but cannot fall below the value of
the inner angle.

Falloff

The optional falloff values for the loudspeaker
define the linear range of the emitted sound.
Additionally a type of falloff can be selected.

Type

This changes how the sound is to decrease over
the falloff distance.

None

The volume of the loudspeaker does not
decrease with distance. This behavior is not
particularly realistic and is only included for the
sake of the completeness. This option is
unsuitable for inclusion in surround sound
information, since no spatial data can be
calculated from it.

Linear

Generates a even, linear reduction of the
volume over distance. The falloff begins at the
Inner Distance value and decreases constantly,
until it reaches 0 at Outer Distance.

Inverse

Creates a quick falloff to 0%. This leads to a
gentler pickup characteristic, if a microphone is
placed within the falloff range of the
loudspeaker.

Inverse Square

(Preset value)

This is the most natural kind of falloff, which
best reflects reality. It is even softer than
Inverse.

Inverse Cubic

Creates an extremely gentle falloff, which
reaches maximum volume only briefly after
Inner Distance.
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Inner Distance

This value defines the position at which falloff
begins. Within this radius the emitted sound has
maximum volume. The inner distance is zero by
default, so that the falloff begins at the
loudspeaker.

Outer Distance

This value defines the outer radius of the falloff.
At this distance the volume of the loudspeaker is
zero and silence prevails.

Tip

The type of falloff is only effective over the
range between Inner Distance  and
Outer Distance .

Mono
This function creates a mono microphone
object. Microphones are used for the recording
of emitted sound information. In order to create
3D sound data, at least one microphone object
must be in your scene. The parameters of the
microphone object resemble those of the
loudspeaker object. So you can define a conical
effective range and regulate the falloff (and the
sensitivity).

Microphones are displayed in CINEMA 4D as
genuine 3D objects (a simplified microphone
shape), but are not visible when rendered. As is
the case for lights and loudspeakers, there are
several handles with which you can interactively
change the pickup characteristics of the
microphone.

More extensive and exact changes to the pickup
characteristics of the microphone can be made
in the appropriate dialog; double-click on the
object property symbol of the microphone in the
Object manager or on the microphone itself.

Show Cone and Falloff

With this option you can define whether, in the
editor, the effective range (cone and falloff
range) of the microphone, as well as its handles,
are displayed. This option is on by default.
Switch off the option to avoid clutter in complex
scenes.

Cone (Pickup Pattern)

The cone defines the pickup area of the
microphone and can be compared with the cone
of a spotlight.

Inner Angle

With this value you can define, optionally, the
inner pickup angle. Within the cone defined by
this angle the recorded sound has maximum



288 • OBJECTS MENU • CHAPTER 7

volume, thereafter it recedes gently until it
reaches the edge of the cone defined by the
outer angle. The permissible values for this
angle lie between 0° and 180°, but cannot
exceed the value for the outer angle (see
below).

Tip

In order to define an inner angle, you must first
enable Outer Angle.

Outer Angle

Activate this value to limit the pickup area of the
microphone within a cone. The permissible
values for this angle lie between 0° and 180°,
but cannot fall below the value for the inner
angle.

Sensitivity Falloff

The optional falloff values of the microphone
define the range of the pickup area. Additionally
a type of falloff can be selected.

Type

This value sets in which way the sensitivity of
the pickup is to decrease over distance.

Tip

The type of falloff is only effective between
Inner Distance and Outer Distance.

None

Means that the pickup sensitivity of the
microphone does not change with distance. This
option is the default value for microphones.

Tip

If you choose Falloff > None for both
loudspeakers and for microphones, it is not
possible to calculate 3D sound data. You should

therefore choose this option only if your
loudspeakers already have a falloff behavior
assigned.

Linear

Generates an even, linear falloff of the pickup
sensitivity. The falloff begins at Inner Distance
and decreases constantly until it reaches zero at
Outer Distance.

Inverse

Creates a quick falloff sinking to 0%. Thus leads
to a gentler pickup characteristic, if the
microphone enters the falloff range of a
loudspeaker.

Inverse Square

This is the most natural kind of falloff, which
best reflects reality. It is even softer than
Inverse.

Inverse Cubic

Creates an extremely gentle falloff, which
reaches maximum pickup sensitivity only briefly
before Inner Distance.
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Inner Distance

This value defines the radius of the inner falloff
range. Within this radius the recorded sound has
maximum volume. The inner distance is, by
default, zero so that the falloff begins directly at
the microphone.

Outer Distance

This value defines the outer radius of the falloff.
At this value the pickup sensitivity of the
microphone is zero and silence prevails again.

Doppler Effect

This option activates the calculation of a
Doppler effect (see page 596). Change the
percentage value to adjust the strength of the
Doppler effect.

Tip

As this effect depends on the speed of travel of
the loudspeakers (and the microphones), it may
be necessary to use values over 100% to reveal
the Doppler effect more clearly.

Stereo Microphone
Use this to create a stereo microphone, with
which sound information for the left and right
sound channel can be rendered automatically.

The stereo microphone object exists primarily to
create stereo sound data quickly and easily and
differs therefore from the mono microphone
described above and also from the pre-defined
groups of microphones described below. The
distance between the two sound channels

(stereo) can only be defined for this special
microphone object. This generates a single
stereo file as its output.

Naturally you can also use the Stereo group (see
below) with two mono microphones. However
you then get two separate mono files (one each
for the left and right channel), which you have
to mix with an external sound program to get a
stereo sound.

Stereo Basis

Double-clicking on the Headphone object brings
up a simple, Stereo Basis, dialog. This defines
the distance between the two, virtual
microphones; 200 is the default. You can also
change the stereo basis with the appropriate
handles, interactively, in the editor.

Stereo
This function creates a group of objects, which
contains two conventional, spatially shifted
mono microphones.

- Microphone_L (for the left stereo channel)

- Microphone_R (for the right stereo channel)

You can make individual adjustments to the
characteristics of both microphones (see Mono,
page 287).
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A stereo microphone comprises two mono microphones,
spatially shifted

Tip

The Stereo microphone, as well as the following
surround sound microphones, are not objects in
the conventional sense, but pre-defined groups
of objects with several mono microphone
objects contained within them. In principle you
could create these objects manually, by grouping
many mono microphones by hand.

DTS 5.1
The DTS 5.1 (Digital Theatre System) function
creates automatically a group of objects which
contains six conventional, spatially-shifted mono
microphones.

- Microphone_L (for the left front loudspeaker)

- Microphone_C (for the central loudspeaker)

- Microphone_R (for the right front loudspeaker)

- Microphone_SUB (for the bass channel,
subwoofer)

- Microphone_LS (for the left, rear surround
loudspeaker)

- Microphone_RS (for the right, rear surround
loudspeaker)

The WAV files created with subsequent 3D
sound rendering can be mixed later in an
external sound program for the generation of
surround sound data in the DTS 5.1 format. You
can define individual values for the pickup
characteristic etc. of all microphones (see Mono
above).

Tip

DTS 5.1 is a standard recording format for many
cinema productions. The first number refers to
the five sound channels. The front three (left,
center, right) use the frequency range from 20Hz
to 20kHz and the two surround channels the
range from 80Hz to 20kHz. The rear channel is
the subwoofer, which uses only low frequencies
in the range between 20Hz and 80Hz.

DDS EX 6.1
The DDS EX 6.1 (Dolby Digital Surround)
function creates, automatically, a group of
objects, which contains seven conventional,
spatially-shifted mono microphones.

- Microphone_L (for the left front loudspeaker)

- Microphone_C (for the central loudspeaker)

- Microphone_R (for the right front loudspeaker)

- Microphone_SUB (for the bass channel,
subwoofer)

- Microphone_LS (for the left, rear surround
loudspeaker)
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- Microphone_S (for the middle, rear surround
loudspeaker)

- Microphone_RS (for the right, rear surround
loudspeaker)

The WAV files created with subsequent 3D
sound rendering can be mixed later in an
external sound program for the generation of
surround sound data in the DDS EX 6.1 format.
You can define individual values for the pickup
characteristic etc. of all microphones (see Mono,
page 287).

Tip

DDS EX 6.1 is a new method from Lucasfilm
TXH and Dolby Laboratories Inc. It uses an
additional middle surround channel to offer the
listener a particularly good localization of
auditory perspectives. Otherwise it is compatible
with Dolby digital 5.1. The first number refers to
six available channels. The front three (left,
center, right) use the frequency range from 20Hz
to 20kHz and the three surround channels the
range from 80Hz to 20kHz. The rear channel is
the subwoofer, which uses only low frequencies
in the range between 20Hz and 120Hz.

SDDS 7.1
The SDDS 7.1 (Sony Dynamic Digitally Sound
System) function creates, automatically, a group
of objects which contains eight conventional,
spatially-shifted mono microphones.

- Microphone_L (for the left front loudspeaker)

- Microphone_L (for the left center loudspeaker)

- Microphone_C (for the middle center
loudspeaker)

- Microphone_R (for the right center
loudspeaker)

- Microphone_R (for the right front loudspeaker)

- Microphone_SUB (for the bass channel,
subwoofer)

- Microphone_LS (for the left, rear surround
loudspeaker)

- Microphone_RS (for the right, rear surround
loudspeaker)

The WAV files created with subsequent 3D
sound rendering can be mixed later in an
external sound program for the generation of
surround sound data in the SDDS 7.1 format.
You can define individual values for the pickup
characteristic etc. of all microphones (see Mono,
page 287).
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Tip

SDDS 7.1 works, in principle, like Dolby digital
5.1. Additionally, however, the number of center
channels is increased from 1 to 3. This makes a
better sound distribution possible with the large
and broad projection screens in cinemas.
Otherwise it is compatible with Dolby digital
and DTS. The first number refers to the seven
available channels. The front five (left, left
center, center, right center, right) use the
frequency range from 20Hz to 20kHz and the
two surround channels the range from 80Hz to
20kHz. The rear channel is the subwoofer, which
uses only low frequencies in the range between
20Hz and 120Hz.
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8. Tools Menu   
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8 Tools Menu
If, on the other hand, you select the object
coordinate system, the cuboid moves along its
own (the object’s) X axis, which results in a quite
different behavior as you can see.

Both can be useful but you should always be
aware which you are currently using (check on
the Tools menu).

The X, Y and Z icons allow you to lock certain
axes. This can be useful, for example, when you
have constructed an object that is at floor level.
If you now move it in one of the perspective
views, it automatically changes its Y value and
could, in the worst case, end up below the floor.

By taking the precaution of locking the Y axis
the object remains on the floor and moves only
in the other directions.

A left/right movement of the mouse while
holding down the mouse button moves the
object horizontally on the screen.

Move

This command will let you place the active
object or element anywhere in a viewport,
subject to other options like snap, the mouse
grid, whether certain axes are locked etc.

When moving objects, CINEMA 4D
distinguishes between the world coordinate
system and the local object coordinate system.

This distinction is particularly noticeable when
movement takes place in different axial systems
and only the X axis is activated, say.

Let’s assume you are moving a cuboid which is
positioned somewhat askew relative to the
world coordinate system and you have locked
the Y and Z axes for movement (see below). If
you move within the world coordinate system
the cuboid moves parallel to the X axis of the
world system.
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An up/down movement moves it vertically.
Keeping the right mouse button depressed
(Macintosh users Command-click) while moving
the mouse right and left moves the object into
the screen and out of it.

When editing textures, mouse movements have
a somewhat different effect. A left/right
movement of the mouse moves the texture
along its X axis, an up/down movement moves
the texture along its Y axis.

Tip

Objects or selected elements (polygons, points)
can be moved by dragging one of the axes. If
you click on the tip of the X-axis the object or
elements can be moved only in the X direction.
You don’t have to lock the other axes if your
object or elements need to be moved in a
specific direction.

If you want to move an object across a plane hold
down the Shift key and click on the axis
perpendicular to this plane. For example, if your
object needs to be moved across the XY plane,
drag the Z-axis while holding down the Shift key,
and so on.

Scale

With this function you can resize the active
object or element.

When in Scaling mode, CINEMA 4D
distinguishes between the world coordinate
system and the local object coordinate system.

The difference between the systems becomes
particularly clear if you activate only the X axis.
Imagine you scale a cuboid, which lies inclined
in the world coordinate system. If you choose
the world coordinate system for scaling, the
cuboid becomes larger/smaller parallel to the
X axis of the world coordinate system and is
therefore distorted.

If, on the other hand, you select the object
coordinate system of the cuboid when scaling,
the cuboid becomes larger/smaller along its own
X axis and does not distort.
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Scaling is performed by left/right movement of
the mouse. You can hold down either mouse
button.

When editing textures, mouse movements have
a somewhat different effect. A left/right
movement of the mouse resizes the texture
along its X axis, an up/down movement rescales
it along its Y axis.

Tip

When modeling objects, use the Model tool
when you want to scale. This is because scaling
with the Object tool can distort the object axis
system, leading to problems when the object is
animated later on.

The default size of any axis in the object system
is 1.0. If for example you resize the X axis from
1.0 to 2.0, the object doubles its size along the
X axis. This results in a distortion of the object
system, making precise construction more
difficult since all local positions are now also
distorted and no longer correspond to the
length units of the world system.

We recommend therefore that you do not scale
using the Object tool during the modeling
process.

Tip

Objects or selected elements (polygons, points)
can be scaled by dragging one of the axes. If you
click on the tip of the X-axis the object or
elements can be scaled only in the X direction.
You don’t have to lock the other axes if your
object or elements need to be scaled in a specific
direction.

If you want to scale an object across a plane
hold down the Shift key and click on the axis
perpendicular to this plane. E.g. if your object
needs to be scaled across the XY plane, drag the
Z-axis while holding down the Shift key, and so
on.

Note

Scaling along an axis or plane using Object and
Model Tool only works for polygon objects. The
parametric objects can only be scaled along an
axis using the Object Tool (see also page 304 for
the difference between these two tools).
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Rotation

This command will rotate the active object or
element.

When rotating objects, CINEMA 4D
distinguishes between the world coordinate
system and the local object coordinate system
and you can choose to rotate in either system.
As long as the object lies parallel to the axes of
the world coordinate system you will not notice
a difference when you rotate in either system.
But when the object is askew, there can be large
differences between rotating in the world or
object systems - see above for more details and
consider carefully what you need.

A left/right movement of the mouse while
holding down the left mouse button will rotate
the object around its Y axis. An up/down
movement rotates it around its X axis, while
holding down the right mouse button causes
rotation around the object’s Z axis (Macintosh
users use the mouse button with the Command
key pressed to simulate a right mouse button).

The behavior of the rotation is totally different
if, in General Settings, you have switched on the
HPB system (see General Settings, page 43). A
left/right movement will now change the
heading, an up/down movement changes the
pitch and holding down the right mouse button
while moving left or right will change the bank
(Mac users, remember the Command key). The
HPB angles here refer to the object’s parent
system i.e. if the object which is to be rotated
lies within a hierarchy, the parent object
functions as the world coordinate.

Example:

- You want to rotate a cube, already tilted in
space, 360° around its Y axis.

- Create a cube, with default values, then enter,
in the Coordinates Manager under Rotation at
B (Bank), an angle of 30° and click on the
Apply button.

- In the Time Line, disable the Position and the
Scale icons so that only Rotation is active and
then click once on the Record button. A new
rotation sequence with a key is created.

- Move the position marker to frame 50 and
click the Record button again. A new key is
added to the rotation sequence.

- Double-click on this new key. In the edit field
that opens enter, under Value at H, an angle of
360°, then close the dialog with OK.

- Start the animation by clicking on the Play
button. The object turns but not, as you
probably thought it might, around its Y axis
(the heading). Why is that? As described
above, the HPB system looks to the object’s
parent for reference. In this case the parent is
the world coordinate system and its axis does
not lie, like that of the cube, banked at 30°.
So, how you can turn the tilted cube around its
own Y axis?

- First, open the input windows of the two
rotation keys in the Time Line and change the
B value from 30° to 0°.

- Create a null object and move the cube, using
drag-and-drop, into the null object. Now the
null object is the cube’s parent.

- Select the null object and enter, in the
Coordinates Manager under Rotation at B, an
angle of 30°; then click on the Apply button.
Play the animation again. The cube turns now
around its Y axis since the null object replaces
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the world system as the cube’s parent. Even if
you rotate in absolute world coordinates, the
actual rotation takes place around the parent
object or axis origin, respectively.

- Use the rotation grid (see Quantize Tab,
page 341) for greater precision. This will allow
you to rotate the object in steps of, say, 10˚.

Tip

Objects or selected elements (polygons, points)
can be rotated by dragging one of the axes. If
you click on the tip of the X-Axis the object or
elements can be rotated only around the X-axis.
You don’t have to lock the other axes if your
object or elements need to be rotated around a
specific axis.

Note

If you are using HPB for rotating (see Use HPB
System, page 43) the rotation axes behave
according to the HPB designators (see page 310).

Navigation with the Mouse and Keyboard

Moving, Scaling and Rotating with the Mouse

You can use the mouse for moving, scaling and
rotating. A left/right movement manipulates the
X axis while a back-and-forth movement
controls the Y axis. For the Z axis you have to
use the right mouse button.

Macintosh users; as usual, use the Command
key to simulate the right mouse button.

You can toggle instantly between the left and
right mouse buttons. If you are currently
pressing the left button, press the right one
before releasing the left and vice versa.

Moving, Scaling and Rotating
with the Cursor Keys

On the keyboard, use the cursor keys for
moving, scaling and rotating:

Cursor right + X axis

Cursor left - X axis

Cursor up + Y axis

Cursor down - Y axis

Shift + cursor right or cursor up + Z axis

Shift + cursor left or cursor down - Z axis

If you are working with the Camera tool
selected (see page 300), it is the camera that is
affected. In all other cases the object currently
selected is moved, scaled or rotated.

Moving, Scaling and Rotating
with the built-in Hotkeys

Using the built-in hotkeys you can edit objects,
the editor or the active object camera
independently of the chosen tools. Use the
following keys:

1 - Move the view/camera

2 - Scale (zoom) the view/camera

3 - Rotate the view/camera (3D viewport)

4 - Move the active object

5 - Scale the active object

6 - Rotate the active object

Tip

If you want to zoom but not change the focal
length, use the 1 key (move camera) as opposed
to the 2 key (zoom camera).
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Virtual Rotation Circle

When rotating an object you can also use the
virtual rotation circle. It is displayed as a yellow
circle which is always parallel to the view plane.
While pressing the left mouse button and
dragging inside the circle you can rotate the
object in any direction. When clicking and
dragging outside the circle or moving the cursor
out of it the object can only be rotated around
the axis perpendicular to the current view plane.

Magnify

Use the Magnify command to zoom in on a
particular region of the work area. To define
that area, drag a rectangle around it.

Alternatively, click once using the left mouse
button. This will magnify the work area by 25%.
If you wish to zoom out, hold down the Ctrl key
while clicking.

These are the keyboard shortcuts for the
Magnify function:

+ Zoom In

- Zoom Out

Camera

With this command you can edit the camera in the
active viewport. All subsequent actions affect this
viewport. In the planar viewports (XY, ZY, XZ) you
can move and magnify the displayed area; in the
3D viewport you can change the Editor camera or
the Object camera. Using the mouse, you can
move in the following ways.

Move
The camera always moves in the opposite direction
to the mouse. For example, when you move to the
left, this will shift the camera to the right, thus
causing the objects to move left. This is the most
intuitive method and easiest to learn. Since mouse
movement is restricted to two dimensions,
CINEMA 4D needs to make use of the right mouse
button. This modifier allows you to control not
only left/right and up/down movements, but also
depth movements (backwards and forwards). If
you hold down the right mouse button while
moving left or right, this will be interpreted as
going back and forth. You can alternate between
the left and right mouse buttons at any time.

Macintosh users press the Command key and
click to simulate the right mouse button.

Movements, scaling and rotation processes may
be canceled at any time by pressing the ESC key.

When moving objects you can choose which
axis system you wish to use. Normally, this will
have no effect, since the X, Y and Z symbols are
all selected. However, if you switch certain axes
on or off, you will observe that certain actions
will show different results. If for example you
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have activated the X symbol only and you are
working with the world coordinate system, the
camera will move parallel to the X axis of the
world system. If on the other hand the object
system is selected, the camera will move left and
right within its own camera coordinate system.

No grid is applied for the camera or the visible
section of the document so that you can reach
any position, even if a motion grid is active.

Scale
The visible section of the scene can be resized.
You do this by moving the mouse left/right
while holding the left or the right mouse button
down (in this case it does not matter which).

In the planar viewports the zoom factor, (which
initially is set to 1.0) is changed. In the 3D
viewport it is the camera’s focal length that
changes. Its default value is 50mm. The shorter
the focal length, the greater the distortion.

If you wish to avoid distorting your scene, do not
change the focal length, instead move the camera
further away from the scene. Do this by selecting
Move and then right-dragging the mouse to the
left. (Try it out to see the difference.)

Rotation
Rotation makes sense only if you are working in
the 3D viewport. The planar (2D) viewports
cannot be rotated.

When rotating the 3D viewport, certain mouse
movements affect particular rotational axes. For
example, if you hold down the left mouse
button and move left or right, this results in a
rotation around the Y axis of the camera’s
coordinate system. An up/down movement with
the left mouse button held down rotates the
camera around the X axis of the camera’s
coordinate system.

If on the other hand you hold down the right
mouse button, the camera will rotate around its
Z axis. What is special about this function is that
the selected coordinate system (world or object)
has a somewhat different meaning from that
which you might expect: the rotation is always
around the camera’s axis and not around the
world’s axis.

Macintosh users press the Command key and
click to simulate the right mouse button.

If an object is active, the camera also changes its
position while it rotates. This occurs in such a
way that the centre of the active object remains
in the same position on the screen. This feature
is extremely useful when you wish to move
around an object. If no active object exists, the
rotation is around the world origin.

Object

Selecting this allows you to edit an object as a
whole. You can move a house, rotate a spline or
align a light source. The current position of the
active object in space is shown in the Coordinate
manager. That is where you can change any of
the values individually. Changing objects is
performed by manipulating their coordinate
axes. Scaling, for example, scales the object axes
as opposed to the surfaces. For further details,
please see The Difference Between the Object
and the Model Tool on page 304.

Tip

Use the object tool for animation.
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Points

By selecting this tool you can edit the points of
an object. All subsequent actions will affect the
points. In addition, the Delete function in the
Edit menu now refers to the points of the object
rather than to the object itself.

As soon as the tool is selected, all points of the
object are represented by small squares.
Selected points are highlighted in color.

It is possible to select individual points by clicking
on them. If several points are visually on top of
one another, only the topmost is selected. The
selection may be extended by Shift-clicking. If you
want to select several points use one of the four
selection options (see pages 318-321). To deselect
points, select them again by Shift-clicking.

All points can be selected with the menu option
Edit > Select All. With Edit > Deselect All the
complete selection can be deselected again.

To set new points, use Ctrl-click or use the Add
Points tool (see page 353).

If the object you are editing is not a 2D/3D
object but a spline, the following rules apply:

- Ctrl-click to add a point to the end of the spline.

- Shift-Ctrl-click to add a point to the start of the
spline.

- Ctrl-click on the connection line between two
existing control points to add a new point
between them.

To move a point, grab it with the mouse and
drag it to the new position.

To delete the active point, use the Delete
command from the Edit menu or use either the
Del key or the Backspace key.

If you are editing a Hermite spline and you
activate a point, the associated tangent will be
displayed. You can edit the tangent’s ends by
dragging them with the mouse. Holding down
the Shift key allows you to edit them
independently of each other.

You can also edit a point by double-clicking on
it. A dialog opens in which you can change the
position of the point. If you are working on a
Hermite spline, you can also edit the tangent
values here. Alternatively you can edit the
points with the Structure manager (see Mode
menu, page 632).

To summarize:

- Points can be placed dynamically.

- Holding down Shift lets you extend the selection
or reduce it.

- The Selection tools allow you to select in various
intuitive ways.

- Ctrl-click (or Ctrl-Shift-click) creates new points.

- The Delete command, the Del key or the
Backspace key may be used to delete points.

- Hermite tangents appear when you click on a
point.

- Hermite tangents can be edited dynamically.

- The two ends of a Hermite tangent can be
edited independently by holding down Shift.

Tip

Tools which are useful for editing points can also
be called through a context menu. Simply right-
click on a point. Macintosh users should keep
the Command key pressed while clicking with
the mouse to pop-up a context menu.
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Polygons

There are polygons with three vertices (triangle
polygons) and polygons with four vertices
(rectangle polygons).

Editing polygons hardly differs from editing points.
As soon as you activate the Polygon tool, the
polygons of the chosen object are displayed. Select
a polygon by clicking on it with the mouse;
selected polygons are shown in a brighter color.

You can select several polygons at once by holding
down the Shift key while selecting each polygon in
turn. If you Shift-click on a polygon a second time,
it is deselected. All other (active) polygons remain
unchanged. Another way of selecting several
polygons at once is to use one of the four selection
options (see pages 318-321).

To create new polygons, selects Objects > Polygon
Object. Now add points to this polygon with
Structure > Add Points or import them into the
Structure manager with File > Import ASCII Data.
You can read more about creating polygons on
page 96.

To delete active polygons, use either the Delete
command from the Edit menu, or the Del key or
the Backspace key.

Tip

Tools which are useful for editing polygons, e.g.
one of the many selection options, can also be
called through a context menu. Simply right-
click on a polygon. Macintosh users should keep
the Command key pressed while clicking with
the mouse to pop-up a context menu.

Object Axis

The Object Axis tool enables you to modify the
axes of the active object without affecting the
object’s points or polygons. Reasons why you
may want to do this include (to name just a
few):

- to help you navigate the active object easily
(the camera rotates around the origin of the
active object’s axis system)

- to define the center of rotation for an IK object
(IK objects rotate around the origin of their axis
system)

- to define the center of an object for mirroring
(the Mirror command can mirror points based
on the position of the object axis system’s
origin)

Only a few possibilities are named above
because there is no need to learn them — they
will suggest themselves as you become more
familiar with CINEMA 4D.

The current position of the axes of the active
object is shown in the Coordinate manager,
where you can change all values individually.

When rotating or moving the axes of a
hierarchical object, all axes of the sub-objects
will be changed. If these sub-objects have
animation tracks, errors will occur in the
animation, since the axes of the parent system
will have changed. This is why, before creating
the animation, it is so important to first define
the axes.
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Scaling object axes is a rather special case. Here,
it is not only the axes that are resized, but also
the points and the textures of the active object.
This is the only method for creating a size
animation. In contrast, model scaling changes
points and textures, but does not resize the
axes.

Note

Use the Object axis tool if you want to set move
and rotation points for Inverse Kinematics or to
align objects created with Duplicate or to create
a Lathe NURBS object with a spline contour.

Model

Selecting this allows you to edit an object as a
whole. For example, you can move a house, rotate
a spline or align a light source. The current position
of the active object in space is shown in the
Coordinate manager. That is where you can
change any of the values dynamically. If the Model
tool is selected and you scale the object, the
object’s points (rather than its axis) are scaled. To
understand the importance of this, please read on.

Tip

Note that if you scale an object to zero in any
direction by using the Model tool, this operation
cannot be undone.

If the active object contains sub-objects, these
are also changed. If you wish to restrict the
change to the active object, modify the action
by holding down the Ctrl key.

Use the Model tool during the modeling
process.

The Difference between the Object and the
Model Tool

It is important that you understand which tool
to use for modeling and which tool to use for
animation, otherwise your models may not
animate as you expect them to.

Example:

- Consider a scene with two objects, a (polygon)
sphere and a cube. The cube is a child (sub-
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object) of the sphere. The axial length of both
objects is 1/1/1.

- Now we choose the Object tool (Tools >
Object) and scale the sphere with the
Coordinate manager only in X direction to, say,
2/1/1 (ensure that Scale, rather than Size, is
selected in the pop-up at the bottom of the
Coordinate manager). As to be expected,
sphere and cube are distorted.

- Now rotate the cube around its Z axis (lock the
X and Y axes and rotate the cube). During the
rotation you will see an up and down pump-
like distortion.

- The points of the cube no longer obey a
circular trajectory while they are rotated in the
XY plane. Instead, the distorted parent system
causes this movement to be elliptical.

- And that is where the problem lies. It invariably
occurs when objects exist in a distorted parent
system.

- Effects of this type are encountered by each
and every 3D application, since it is a
fundamental problem. Many resolve it by
implementing separate editors for modeling
and animation. In this way, you do not see the
problem but, instead, you have to keep
changing editors.

- To prevent this problem:

Use the Model tool for scaling the sphere.

If the damage is already done, choose
Functions > Reset System and select the two
options, Normalize Axes and Offsets.

- In each case you will then get the required
result when rotating the cube:

Tip

If you are still unsure of which tool to use,
please simply observe the following rule: Use
the Model tool for modeling; use the Object tool
for animation.
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Texture

This allows you to edit the active texture. As soon
as you choose this tool the texture of the object is
represented by blue grid lines. Or, if you have
activated Real Time Texture Mapping (Display >
Textures in the viewport Window menu) you will
see the texture displayed on the object. The
chosen projection type is taken into account (see
Projection, page 539).

If the texture is displayed with grid lines, their axes
are labelled in color (X and Y). Since the texture is
in two dimensions only (the image has no depth
information), there is no Z axis. The grid lines are
drawn according to the kind of chosen projection,
e.g. spherical mapping is shown with a spherical
blue grid. An exception is UVW mapping. Here
the blue grid is displayed over the entire editor
window. The axes are not shown in RTTM mode.

The texture axes of the object are shown with an
envelope on whose surface the texture can be
moved by using the familiar Move and Scale
functions. The texture itself cannot be rotated (but
see Texture Axis below).

A left/right movement of the mouse will move the
texture along its X axis, an up/down movement
will move it along its Y axis.

The Scale function uses the same principle, only
here the texture does not get moved but resized.

The data for X and Y referring to positioning and
dimensions of the texture in the Coordinate
manager are always given as percentages, since
the actual size is not relevant. A size of 100% for
both coordinates means that the texture covers
the cylinder, the sphere or the area completely.

Texture Axis

This tool allows you to edit the texture axes of
the active texture. As soon as you select this
tool, the texture with its envelope is displayed.
In RTTM mode you will see the texture itself.
You can move, scale and rotate the envelope in
the usual fashion.

The difference between Edit Texture and Edit
Texture Axes is illustrated by the following
pictures. In both cases, the movement is along
the X axis; in the upper picture using the Edit
Texture tool the texture is moved on its
envelope, while in the lower picture by using
Edit Texture Axes the envelope itself is moved.
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Inverse Kinematics

This tool enables you to place hierarchical objects
interactively using inverse kinematics (IK). For
example, you can grab the hand of an arm and
move it to the required position. The arm will
follow automatically, obeying any rotation
restrictions you have applied to the joints.

This tool is not only for animation – it is also
useful for posing characters. You will need to
arrange the objects into a hierarchy and assign
IK tags (see IK Tag, page 471)

If you select an object at the end of a hierarchy
and move the mouse, CINEMA 4D calculates
the distance between the joints automatically
and keeps it constant. This prevents the chain
(e.g. an arm with several joints) from falling
apart.

CINEMA 4D’s Figure object is perfect for
experimenting with the Inverse Kinematics tool.
To create the figure object, choose Objects >
Primitive > Figure. Next, select Structure >
Make Editable — this converts the figure into

polygons with separate limbs, an existing
hierarchy and all the tags you need to get
started.

When setting up an IK chain, you can specify
angle constraints to prevent limbs moving
beyond certain angles (see Restriction Tag,
page 465).

You can also define objects to be anchors. These
objects cannot be moved using the Inverse
Kinematics tool (see Anchor Tag, page 471).

The IK always refers to the active object. The IK
chain is pulled from the object’s origin or, if the
object has child objects, from the origin of the
first child.

Multi Target Kinematics
Multi Target Kinematics (MTK) makes it possible
to use more than one target object in an IK
chain. So you can for example define a target
object for the knee, one for the ankle, and one
for the foot tip — as illustrated in this picture:

The small crosses are the target objects for the
IK limbs. These three target objects give you
exact control over the IK chain.
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Let’s take a closer look at the IK chain.

The above picture shows the leg hierarchy —
from Parent Object to Toe. An anchor tag is
applied to the parent object to prevent the
whole body from whirling around at each leg
movement. Angle constraints are assigned to
Upper Leg, Lower Leg, Joint and Foot to ensure
an anatomically correct movement.

This tag sets the angle constraints for an IK limb

You can find more information about how to
use IK tags and angle constraints on page 471.

Lower Leg, Joint and Toe are each assigned an
IK expression (in the Object manager menu:
File > New Expression > IK Expression).

IK Expression

Type into the IK Expression dialog the name of
the target object that you want to control this IK
limb. If you want to prevent the IK limb from
moving when assigning the expression, set the

target object at exactly the same position as the
limb’s object axis — or temporarily switch off
expressions.

This symbol of the drawing pipeline lets you switch on or off
expressions in a viewport.

Knee-Target belongs to the IK limb Lower Leg.
This means the object axis of Lower Leg always
tries to reach the position of Knee-Target. It
succeeds only as far as the IK constraints make it
possible. So don’t over-exert the knee by
putting Knee-Target too far out of reach. For a
smooth movement it is best to have the target
objects within reach of the IK limbs.

Joint is assigned the target object Joint-Target. It
enables you to control the position of the ankle.
But since the knee has its own target object, the
joint is not able to influence Upper Leg. This is
where the MTK comes in. The IK is processed
hierarchically — a target object can influence
the IK chain only up to the next parent target
object.

To prevent Toe from fidgeting, it is also assigned
a target object (Toe-Target). With this one you
are able to control the alignment of the foot.
Also, to make it even easier to position the foot,
Toe-Target has been placed into Joint-Target as
a sub object. So you need to move only Joint-
Target — Toe-Target follows automatically. You
only have to move Toe-Target separately if really
needed.

Animation with IK
Several steps are involved in using the Inverse
Kinematics tool to animate an object group or a
hierarchically-arranged bone skeleton.



CHAPTER 8 • TOOLS MENU • 309

Note that the IK refers solely to the manner is
which hierarchies are handled — this type of
animation works in a completely different way
to the Inverse Kinematics track in the Time Line
(see Inverse Kinematics, page 582).

To animate an IK chain:

- Activate the following tools in the Time
Manager icon palette: Position, Rotation and
Hierarchy.

Ensure that the time slider is set to the start of
the document.

Select the entire figure in the Object manager,
then click on the Record icon. This defines a
starting position that you can return to at any
time.

1 Move the time slider to a different time point.

2 In the Object manager, select the last link of an
IK chain (e.g. ‘Left Hand’, ‘Right Foot’).

3 Activate the Inverse Kinematics tool and move
the hand. The entire IK chain moves as a result.

4 Activate the top object in the IK chain — this is
the object with the anchor icon (e.g. ‘Upper
Body’).

5 Record the position and rotation for the
hierarchy once more.

- Repeat steps 1 to 5 until you reach the end of
the document.

- Drag the time slider back to the start of the
document, select a new IK chain (e.g. ‘Right
Hand’) and start again from step 1.

Animation

Selecting this tool lets you edit the animation
path of the active object and the tangents of the
position keys. Click on a key to display its
tangents, which you can then edit. If you wish
to edit both ends separately, hold down the
Shift key.

You can also edit a key by double-clicking on
the key itself. This opens a window in which you
can change the position and the tangent values
of the key.

Alternatively you can edit a key directly in the
Time Line.

If no keys are activated you can move, rotate
and/or scale the animation path as a whole.
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The Axes

 X Axis / Heading

 Y Axis / Pitch

 Z Axis / Bank

These three tools allow you to lock movement,
scaling or rotation along certain axes.

With a rotation you have the option of locking
each axis separately. If, in General Settings (see
page 43), you have enabled Use HPB System,
the HPB designators apply. (The letters HPB
stand for heading, pitch and bank.)

For each type of operation, CINEMA 4D
remembers the state of the axes (locked or
unlocked). If for example you have made a
movement along the Y axis while X and Z were
locked, and subsequently change to Rotate, all
axes are unlocked again. When you change
back to Move, the program remembers that
only the Y axis was unlocked.

World System

Here you decide in which coordinate system an
operation will take place. Not all options work
with both systems.

Scaling of object axes for example can occur
only within the object coordinate system. The
object coordinate system is the local system of an
object, shown in the viewports by the coloured
axes; X (red), Y (green) and Z (blue). Every object
has its own object coordinate system.

The difference between the coordinate systems
is very important to animation.

If you chose the HPB system in the settings (see
page 43), HPB angles will be used for the rotation,
independently of the chosen axis system.

Internally CINEMA 4D works exclusively in the
HPB system. HPB is an abbreviation for heading,
pitch and bank.

You may have come across the terms heading,
pitch and bank in connection with flight
simulators. An aeroplane turning left or right
changes its heading; when it tilts upwards or
downwards it changes pitch; when rolling it
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changes its bank. So when you are changing
angles you may find it helpful to think of an
airplane.

You might ask why we cannot just take the
rotation angles around the three object axes X, Y
and Z. The answer has to do with mathematics.
Seen mathematically, the rotations around the
object axes are a non-commutative group, in other
words there is a difference whether you first rotate
around X and then Y, or vice-versa. Using the
same rotation angles will get you different results.
This makes this method unsuitable for animations.

On the other hand, in the HPB system the angles
are disassociated. You can first change the heading
and then the pitch, or the other way round.
Moreover, the HPB angles create naturally
interpolated movements which are particularly
useful for aeroplanes, cars or cameras.

When you rotate around a particular axis in the
XYZ system this may cause all three HPB
components to change. The result is a tumbling
animation. With the HPB system this cannot
happen.

Nice as the HPB system is for animation, it is
useless when it comes to constructing objects.
HPB angles are specified relative to the parent
system, which demands a high level of
abstraction.

So CINEMA 4D offers you the choice. For
rotations in the 3D viewport you have the HPB
system and the (local or global) XYZ system.
You will find this option on the General tab in
the General Settings dialog. Note, however, that
even if HPB is deactivated, all numeric input in
dialog boxes and in the Coordinate manager is
in HPB.

Why use Euler Angles (HPB) at all?

We want to explain here the necessity for the
HPB system using a plausible example. You may
want to skip this section if you are not
mathematically minded or simply don’t want to
hurt your brain!

Many users have the problem that rotations
around the Z axis (the bank angle) are
performed in the object system whereas
rotations around Y and X axes (heading and
pitch) are always made in the world system.
With animation, even switching to XYZ rotations
doesn’t help since CINEMA 4D is using the HPB
system internally.

The HPB system is a so-called Euler system
where the HPB angles do not refer in principle
to the axes of the object itself.

Consider this example:

- Take an object whose angle system is initially
0/0/0. First make a rotation of 30° around
heading, so that the X and Z axes of the object
system are now rotated compared to the X and
Z axes of the world system. Call these new
axes X’ and Z’ (Y’ is identical to Y).

- A pitch of 20° now causes the object system to
be rotated upward around the world system’s
X’ axis. Z’ becomes Z’’ and Y’ becomes Y’’
(now X’ and X’’ are identical).

- Lastly, we rotate around a bank angle of -45°.
This rotation causes the rotated object system
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to be tilted around the Z’’ axis. X’’ becomes X’’’
and Y’’ becomes Y’’’ (this time Z’’ and Z’’’ are
identical).

- The object has now achieved an angle system
of 30/20/-45 by consecutive rotations around
H, P and B on a system in each case already
rotated. HPB rotates thus neither around object
nor around world axes. That bank is identical
to a rotation around an object axis is purely
coincidental. There are several different Euler
systems, each one with a particular rotation
order.

Perhaps you find this all rather impractical, and
we agree that it feels like we’re being boring to
beat on about it. But we must stress that the
Euler system has a major advantage; rotations of
objects are decoupled from one another as
much as possible, which is not the case with
rotations around object axes. Heading does not
affect bank, bank does not affect pitch. Imagine
that the X position of an object would always
affect the Y and Z position ... now that would
be really boring!

A further example clarifies the decoupling
problem:

- Let’s pretend that CINEMA 4D does not use
Euler angles. Imagine a point on the X axis in
position 100/0/0.

- Rotate the point 90° around the Y axis. It then
lies exactly on the Z axis at 0/0/100. Now
keep rotating, this time for 30° around the
X axis. The point now lies in the ZY plane at 0/
87/50.

- So far, so good! Now however you reverse the
rotation order. The point at 100/0/0 is still at
the position 100/0/0 after a rotation of 30°
around the X axis. Subsequently, you rotate
again around the Y axis for 90°. The point is

now at 0/0/100, a completely different
position.

- So, due to the mathematical properties of
rotations, the sequence of rotations around the
object axes is not ‘commutative’ (i.e. rotation
A plus rotation B does not equal rotation B plus
rotation A). This leads to an unpleasant and
unpredictable behavior with animation.

- Hopefully, this example should have made
clear why CINEMA 4D cannot do without the
Euler system. We are sure, however, that you
will be able to use this system, after getting
used to it, just as reliably and easily as any
other system.

And Finally

If this part of the chapter seemed complicated to
you, then you are quite right, it was. The angle
systems are not easy to understand.

However, CINEMA 4D is one of the very few
programs to fully integrate both object hierarchies
and local coordinates. Other programs tend to
compromise on functionality; either they do not
have real object hierarchies, or they have a
separate modeler and animator with limited
integration, or they have difficulty in creating
complex, hierarchical animation.

Our approach takes its cue from state-of-the-art
products running on SGI hardware and benefits
from our long experience with modelers and
rendering products. We feel that we have
managed to create a completely integrated
product, thus providing you with a multitude of
fascinating possibilities and features which leave
other programs well behind.

But we leave it up to you to experiment and try
them all out!
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9. Selections   
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9 Selections
This is not a problem if the points are planar —
i.e. if they all lie on the same plane...

The quadrangle is no longer a rectangle. However, all the
points are on the same plane — the quadrangle is still planar.

If the quadrangle’s points are not on the same
plane, the quadrangle is said to be non-planar. In
the diagram below, point B has been moved into
the depth plane. Now, CINEMA 4D must render
this polygon as two triangles. This is dealt with
internally without any negative effects.

Point B has been moved into the depth plane. Now, the
polygon is non-planar.

The tools on the Selections menu allow you to
select and deselect points or polygons in diverse
ways. There are also commands for you to hide/
reveal points or polygons.

Fundamentals
CINEMA 4D works with polygons (surfaces) and
points. There are two types of polygons in
CINEMA 4D: triangles and quadrangles.

Polygons

A polygon is a triangle or a quadrangle. A
triangle has the points A, B and C; a quadrangle
has the points A, B, C and D.

So-called perfect polygons, like the one shown
below, are not that common, since the points
may lie anywhere in 3D space...

A ‘perfect’ polygon
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If the angle at points B or D is greater than
180°, problems can occur when rendering —
this is because the polygon overlaps itself...

The angle at point B is greater than 180° — the polygon
overlaps itself.

Another problem arises if all of the polygon’s
points are on the same line. In this case, a
surface normal cannot exist and the polygon is
called a degenerated polygon...

All the points for this polygon are on a line.

Polygon Coordinate System

There are a few other things you should know
about polygons. For example, polygons in
CINEMA 4D have their own coordinate system.

You cannot see this system in the viewports, but
it is important to be aware of it when using
modeling tools such as Matrix Extrude — more
about this later on.

The origin of the polygon coordinate system is
located at the centre of the polygons. The X axis
is along the line between A and B. The Z axis is
the normal. The Y axis is perpendicular to the
XZ plane.

Making Parametric Objects Editable

CINEMA 4D works almost exclusively with
parametric objects – objects that can be defined
mathematically. Such objects include the
primitives, spline primitives and NURBS objects.
These objects have neither polygons nor points.
Instead, the surface is defined mathematically and
is only converted to polygons when rendered.

Note

Splines do, of course, have points, but you can
only access these once you have made the spline
editable.

In order to make parametric objects editable, i.e.
to convert them into polygons or points, choose
Structure > Make Editable. Alternatively, click
on this icon:

Click this icon to make an object editable.
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An icon like this in the Object manager means the object is a
polygon object.

An icon like this in the Object Manager means the object is a
spline.

Quadrangles for Modeling

In general, quadrangles are best for modeling and
triangles are best for animation. You are free to use
triangles, but be particularly careful when using
them with HyperNURBS — triangles can cause
irregularities. Only quadrangles generate a totally
clean HyperNURBS.

Here, triangles are responsible for the poor quality of the
mesh.

Selection Menu
You can use the tools in this menu to select the
active object’s points or polygons. The following
applies:

- To select an element click the (left) mouse
button.

- To remove an item from your selection, hold
the Shift key down while left-clicking on the
already selected item.

- To add to your selection, hold the Shift key
down while left-clicking on a new, unselected
item.

- To select points/polygons with the rectangle,
freehand, polygon and live selection tool:

Select with the (left) mouse button down and
dragging.

- To add to your selection, hold the Shift key
down while applying the relevant tool to your
new, unselected items.

- To reduce the items in your selection, hold
down the Ctrl key while applying the relevant
tool to the already selected items.

In the viewports

- In the polygon mode selected surfaces are
framed in red and shown more brightly than
unselected surfaces.

- In the point mode selected points are shown in
light red while unselected ones are colored
dark red.
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Rectangle Selection
If you choose this selection tool you can frame
polygons and points with a rectangle-shaped
marquee. Hold the left mouse button down and
drag; all items that are fully enclosed within the
resulting rectangle will be included in your
selection.

Active Tool Manager

Tolerant Selection

This option makes sense only in polygon mode.
Enabling this option means that polygons are
selected as soon as a corner point of the polygon is
within the selection marquee. If this option is not
active, a polygon is included only if all corner
points of the polygon are within the marquee.

Only Select Visible Elements

If this option is active only items which are not
hidden by other items are selected. For example,
with a surface sphere you could select only
points or polygons at the front of the sphere.

It does not matter whether the back of the
sphere is visible in the screen mode or not. As
soon as a polygon and/or point lies over
another, the latter element is invisible as far as
the selection tool is concerned.

With backface culling on (see page 24) the
backs of objects are always invisible and cannot
be selected even if you turn off the Only Select
Visible Elements option.

Of course, elements are also invisible if they
have been made invisible with Selection > Hide
Selected or Selection > Hide Unselected
commands. Then again they cannot be selected
even if you turn off the Only Select Visible
Elements option.

The same applies to objects which have a red
visibility switch (see page 477). Naturally, the
polygons and points of such objects cannot be
selected.
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Freehand Selection
Freehand selection behaves like a lasso. Using
the mouse with the left button pressed you pull
a loop around all the elements that you want to
select. The loop does not have to be closed.

Active Tool Manager

Tolerant Selection

This option makes sense only in polygon mode.
Enabling this option means that polygons are
selected as soon as a corner point of the polygon is
within the selection marquee. If this option is not
active, a polygon is included only if all corner
points of the polygon are within the marquee.

Only Select Visible Elements

If this option is active only items which are not
hidden by other items are selected. For example,
with a surface sphere you could select only
points or polygons at the front of the sphere.

It does not matter whether the back of the
sphere is visible in the screen mode or not. As
soon as a polygon and/or point lies over
another, the latter element is invisible as far as
the selection tool is concerned.

With backface culling on (see page 24) the
backs of objects are always invisible and cannot
be selected even if you turn off the Only Select
Visible Elements option.

Of course, elements are also invisible if they
have been made invisible with Selection > Hide
Selected or Selection > Hide Unselected
commands. Then again they cannot be selected
even if you turn off the Only Select Visible
Elements option.

The same applies to objects which have a red
visibility switch (see page 477). Naturally, the
polygons and points of such objects cannot be
selected.
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Polygon Selection
With this selection tool you set the corner points
for an n-Side that frames the elements which
are to be included. The first mouse-click defines
the starting point of the n-Side. All further
mouse clicks define further corner points.

The selection ends either with a right-click of
the mouse (Macintosh: Command-click) or by
clicking again on the starting point of the n-
Side.

Active Tool Manager

Tolerant Selection

This option makes sense only in polygon mode.
Enabling this option means that polygons are
selected as soon as a corner point of the polygon is
within the selection marquee. If this option is not
active, a polygon is included only if all corner
points of the polygon are within the marquee.

Only Select Visible Elements

If this option is active only items which are not
hidden by other items are selected. For example,
with a surface sphere you could select only
points or polygons at the front of the sphere.

It does not matter whether the back of the
sphere is visible in the screen mode or not. As
soon as a polygon and/or point lies over
another, the latter element is invisible as far as
the selection tool is concerned.

With backface culling on (see page 24) the
backs of objects are always invisible and cannot
be selected even if you turn off the Only Select
Visible Elements option.

Of course, elements are also invisible if they
have been made invisible with Selection > Hide
Selected or Selection > Hide Unselected
commands. Then again they cannot be selected
even if you turn off the Only Select Visible
Elements option.

The same applies to objects which have a red
visibility switch (see page 477). Naturally, the
polygons and points of such objects cannot be
selected.
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Live Selection
This selection tool behaves somewhat differently
from the others. Live selection functions like a
paint brush with which you can paint over your
objects. The painted elements are included in
the selection set.

You can choose a radius for this tool from the
Active Tool Manager. During the live selection
you can increase this radius with the ‘+’ key and
make it smaller with the ‘-’ key. With a trackball
the radius can be changed with the wheel.

Active Tool Manager

Radius

This determines the radius of the selection
brush.

Only Select Visible Elements

If this option is active only items which are not
hidden by other items are selected. For example,
with a surface sphere you could select only
points or polygons at the front of the sphere.

It does not matter whether the back of the
sphere is visible in the screen mode or not. As
soon as a polygon and/or point lies over
another, the latter element is invisible as far as
the selection tool is concerned.

With backface culling on (see page 24) the
backs of objects are always invisible and cannot
be selected even if you turn off the Only Select
Visible Elements option.

Of course, elements are also invisible if they have
been made invisible with Selection > Hide
Selected or Selection > Hide Unselected. Then
again they cannot be selected even if you turn off
the Only Select Visible Elements option.

The same applies to objects which have a red
visibility switch (see page 477). Naturally, the
polygons and points of such objects cannot be
selected.

Vertex Painting

Live selection can be used not only for selecting,
but also for the interactive painting of vertex
maps or vertex weights. More about these
functions can be found under Set Vertex Weight
on page 325. The Enabled option, when
enabled, activates the vertex map paint mode.

To paint a vertex map for a polygon object you
must be in point mode. To see the coloring the
view has to be set to Quick or Gouraud Shading.
In the Active Tool window you can choose if the
Live Selection should paint with a chosen
percentage value or if it should be lightened or
darkened for this value (see Set Vertex Weight).

If there is no vertex map defined for the active
object in the Object manager or no existing map
is selected, a new one is created as soon as you
start painting. To paint on an existing vertex
map you have to select this before painting.

Note

By its very nature the Live Selection tool has a
high memory requirement when you turn off
Only Select Visible Elements. Therefore you
should switch off this option only if it is
absolutely necessary.
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Select All
With this command you can select all points or
all polygons of an object. If you are in polygon
mode only the polygons are selected; in point
mode only the points are selected. Hidden
elements are not selected.

Deselect All
With this command you can deselect all points
or all polygons of an object. If you are in
polygon mode, only the polygons are
deselected; in point mode only the points are
deselected.

Invert
This command inverts a selection. All selected
elements are deselected and all deselected
elements are selected. If you are in polygon
mode, only the polygon selection is inverted; in
point mode only the point selection is inverted.
Hidden elements are not inverted.

Select Connected
Polygon objects and splines often consist of
several segments which are not connected by
polygons or spline curves. If you wanted to
select one of these individual segments
completely you might encounter problems if this
segment overlapped with other segments; it can
be difficult to see which elements belong to this
segment.

So CINEMA 4D comes to the rescue; select just
one point or polygon of the required segment
and then choose the Select Connected
command. All points or polygons which are
connected to the selected element are then also
selected. If you are in polygon mode, only
connected polygons are selected; in point mode
only connected points are selected.

First select one polygon, then Select Connected...

All connected polygons are now also selected
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Grow Selection
With this command you can add to a selection.
All adjacent points or polygons (depending on
which mode you are in) are added to the current
selection.

The initial selection

Adjacent polygons are now also selected

Shrink Selection
This command reduces the selection. All
polygons or points (depending on which mode
you are in) on the outside of the current
selection are deselected.

If the polygon is closed (such as a sphere is) and
you select all polygons, the selection cannot be
made smaller because there is nowhere to start
(there are no elements that can be considered to
be on the outside).

The initial selection

The outside polygons deselected



324 • SELECTIONS • CHAPTER 9

Polygon Selection From Points
This selects the polygons which border on the
points that are already selected. Polygon mode
will then be entered automatically. Only
polygons that have all their corner points
selected are included.

Point Selection From Polygons
This selects the points which belong to the
polygons that are already selected. Point mode
will then be entered automatically.

Select Adjacent Polygons
This command affects only polygons and only
makes sense when you are in point mode. It
selects polygons which directly border the
existing chosen set of points.

You will be switched to polygon mode when
you use this command.

The initial selection

The polygons bordering on the selected points are selected

Hide Selected
This makes all selected points or polygons
invisible. If you hide selected polygons, the
associated points are also hidden. However, in
point mode, only the selected points are hidden,
not the polygons attached to them.

Hiding of elements is useful if you want to
concentrate on a particular area of an object
during modeling; hide the bit in which you are
not interested.

Hide Deselected
This command hides all elements which are not
selected. If you hide deselected polygons, the
associated points are also hidden. However, in
point mode, only the deselected points are
hidden, not the polygons attached to them.

Unhide All
This command makes all hidden elements visible
again. In polygon mode only hidden polygons
are made visible, in point mode only the hidden
points.

Invert Visibility
The visibility of all elements is inverted. Visible
elements are hidden and hidden elements are
made visible. In polygon mode only the visibility
of all polygons is inverted whereas in point
mode only the visibility of all points is changed.
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Set Selection
Here you can freeze selections for the long term.
You can freeze either polygon or point
selections. You can then manipulate frozen
selections at any time using these icons in the
Object manager:

Frozen point selection Frozen polygon selection

More information can be found under Frozen
Selections in the Object Manager on page 326.

Warning

If a Polygon Selection tag is active in the Object
manager (shown by a red frame) when you call
this command, the tag is replaced with the new
selection. If you do not want to lose your old
selection tag in this way, make sure it is not
active!

Information on how to apply separate material
properties to these frozen selections is in Restrict
To Selection, page 551.

Frozen selections are important for deformation
objects as well. See Restricting Bones using
Polygon Selections or Vertex Maps, page 253.

Note

Although it is possible to freeze more than 10
selections for an object, many tools will operate
on the first 10 only. For example, if you
subdivide the object, only the surfaces in the
first 10 selections are subdivided. For bones, up
to 50 frozen selections can be assigned.

Set Vertex Weight

This tool is almost indispensable for working
with deformation objects. You can use it to
restrict a deformation object’s influence with
absolute precision. For example, you can use it
so that a twist deformer twists the head of a
figure only, not the entire body.

The most powerful application for this tool is to
create vertex maps or weight maps for bones.
Therefore, the steps involved in using vertex
maps is described in the section on Bones,
Restricting Bones Using Polygon Selections or
Vertex Maps, page 253.

To Create a Vertex Map

First, activate the points or polygons mode then
select the points or polygons you wish to apply
a certain weight to.

Next, choose the Set Vertex Weight command.
The Set Vertex Weight dialog opens.

There are three modes from which to choose:

Set

The weight specified in the Value box is applied
to the points.

Brighten

The weight specified in the Value box is added
to the points.
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Darken

The weight specified in the Value box is
subtracted from the points.

Points that have been weighted are coloured.
The entire object will be coloured as well,
although you will see the color only in the Quick
and Gouraud Shading display modes (see page
22). Yellow indicates 100% influence, red
indicates 0% influence.

The vertex map is represented by a Vertex Map
tag in the Object manager:

To blend out a deformation object’s influence
smoothly, simply create a ramp from yellow to
red. The following picture shows such a ramp:

The first row of points is set to 100%, the second to 50% and
the third to 0%. There is a soft course from yellow to red.

Frozen Selections in the
Object Manager
If you froze one or more selections (see Set
Selection, page 325) some useful functions are
now available to you in the Object manager.
These are hidden behind particular small icons
which are associated with the active object:

Frozen point selection Frozen polygon selection

Frozen Point Selection

A double-click on this icon opens a dialog which
contains the following choices:

All actions are performed as soon as you click on
the relevant button.

Name

Enter a name for the selection; press OK to
confirm or Cancel to lose the name change.

Restore Selection

This restores the frozen selection. All other
elements of the object are deselected.
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Select and Hide Others

Restores the frozen selection and makes all
other points of the object invisible.

Select Points

The points of the frozen selection are added to
the existing selection.

Deselect Points

All points of this frozen selection are deselected.

Hide Points

All points of this frozen selection become
invisible.

Unhide Points

All hidden points of this frozen selection become
visible.

Frozen Polygon Selection

Double-click on this icon to open a dialog which
contains the following choices:

All actions are performed as soon as you click on
the relevant button.

Name

Enter a name for the selection; press OK to
confirm or Cancel to lose the name change.

Restore Selection

This restores the frozen selection. All other
elements of the object are deselected.

Select and Hide Others

Restores the frozen selection and makes all
other polygons of the object invisible.

Select Polygons

The polygons of the frozen selection are added
to the existing selection.

Deselect Polygons

All polygons of this frozen selection are
deselected.

Hide Polygons

All polygons of this frozen selection become
invisible.

Unhide Polygons

All hidden polygons of this frozen selection
become visible.
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10. Structure Menu   
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10 Structure Menu
Arrays will always be duplicated along the
object axes of the selected object. Connected
surfaces are coherently duplicated. If no surfaces
or points are selected or if you are not in the
surface or point mode, all surfaces and points of
the active object are duplicated.

If just points alone are selected then they will be
duplicated without their adjacent surfaces.
When using Array with the points of an object
you will be supplied with a point matrix which
you can then use to fill between two objects
e.g. with the Bridge tool.

Imagine a blade of grass. You could easily use
the Duplicate tool from the Functions menu to
copy the blade of grass and then randomly
distribute these copies with the Randomize
function. The disadvantage of this method is the
many individual objects that result from it. With
the Array tool you duplicate just the surfaces (or
points), and not the complete object. Thus you
can produce a complete meadow from a single
blade of grass.

Functions selected from the Structure menu take
effect on the selected object — any sub-objects
remain unchanged.

With most functions the object is modified if a
function can be applied to the current selection.
However, some of these menu functions will not
be available if you are not in Point or Polygon
mode or if no elements are selected.

Hidden elements are therefore not modified (see
Frozen Selections in the Object Manager,
page 326).

Remember to use Structure > Make Editable
before trying to use the following tools on
primitive, parametric objects.

Edit Surface

Array
An array is a list — an even arrangement of
elements.

Using Array you can duplicate the selected
surfaces or points of an object (in the following
this selection is referred to as an element) and
distribute them more or less evenly in the X, Y
and Z directions. You can vary the size and
rotation of the duplicated elements around their
axes.

With these options you can duplicate the array
of elements in a perfectly even manner or
alternatively produce a more random, scattered
surface or point order.
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Clones

Defines the number of clones along the
respective object axis.

This value also includes the original element. So
if you enter the value of 2 for all three axes, it
results in a total number of 2x2x2=8. In effect,
however, only 7 actual clones are produced.

Note

If copies are only to be created in the XZ plane
and not in the height plane then you need to set
the value for Y to 1. This would be the correct
approach for the above blades of grass example
(since these normally grow on the ground and
do not float around in the air!).

Holes

This value adds a random factor to the number
of elements to be created. You may enter values
between 0% and 100%.

0% means the complete number of elements
that has been input is created. With 50% only
half of the elements are created — which
elements are omitted is selected randomly.

With 100% no new elements will be created.

Offset

Defines the size of the array. You can enter
different values for each of the X, Y and Z
directions. These values are absolute — they
refer to the entire size of the array (including the
start element).

Move Variation

These input fields define how the positions of
the duplicated elements vary. This arrangement
lets you assign either accurate or uneven
positioning.

If the values for all axes are set to 0 then an
accurate position is assigned to each duplicated
element. If you set the X value to 100, however,
the individual elements can deviate from -100 to
+100 units from their position in the X direction.

Scale Variation

Defines the variation of the element size. The
values are shown as a percentage.

100% means that the size is not affected.
Entering, for example, 50% for the X value
results in the X size of the individual elements
varying between 50% and 100%. With 0% the
size varies between 0% and 100%. Should you
enter 200% then the variation will be between
100% and 200%.

Uniform Scale

If this option is selected then the chosen
percentage values for X, Y and Z will also be
used for relative scaling.

Example:

- X = 200%, Y = 100%, Z = 50%

- results in a relation of 2:1:0.5. The individual
elements can then be scaled only according to
this relational scaling. If this option is
deactivated, the axes of the individual
elements can be scaled independently.

Rotation Variation

Each element is assigned its own virtual axis.
The elements may then be rotated randomly.
The values, in degrees, which you enter for each
rotation axis define the maximum positive and
negative rotation around the appropriate axis.

45° would mean that the element can rotate in
a radial zone from -45° to 45° in each case.
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Below are two array examples — you can see
the values from the dialog boxes illustrated
above each example.

Clone
This tool enables you to duplicate the surfaces
or points of an object and optionally rotating
around the object axis. Additionally you may
also choose an offset that is used to move the
duplicated elements along the object axis.
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Only selected elements (surfaces or points) are
cloned. In point mode the selected points are
cloned individually without their adjacent
surfaces. If no elements are selected or if you
are not in point or polygon mode, the complete
object geometry is cloned.

With this method you could, for example, create
a spiral staircase ...

... simply by creating a cube, converting this to a
polygon object (see Make Editable, page 353),
scaling it (e.g. to X = 200, Y = 30, Z = 80, see
page 301), moving its object axis in the X direction
and then using Clone with these values:

Clones

Defines the number of clones. This value does
not include the start element.

Holes

With this percentage value you can define the
number of cloned elements that you want to be
omitted from the total. With 0% the full
number of clones is created. With 50% only half
will be created. The omitted elements are
randomly selected. With 100% no new
elements at all would be created.

Axis

Defines the object axis around which the clones
are to be rotated. For a spiral staircase this
would be the Y-axis of the cube. And for a
realistic spiral staircase the object axis should be
positioned a little way outside the cube.

Offset

The offset value gives the distance from the
start element to the last clone along the selected
object axis. All intermediate clones are
distributed evenly over this distance.

Scale

Use this value to determine the size of the last
clone. If you choose 200%, the last clone is
twice as large as the first element. With 50% it
would be half the size. With 100% the size is
not changed at all.

Rotation

Defines the total angle that the clone should be
rotated around the object axis. With 180° the
object would rotate half a revolution from start
to finish, with 360° a full rotation is made.
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Move Variation

By default, all clones are assigned a fixed
position that depends on the above settings.
You may vary these positions using Move
Variation. If you choose, for example, a value of
10 for the Y move variation of the individual
clones, this says that the clones can deviate
between -10 and 10 units in their Y position.

Scale Variation

Defines the variation in the clone’s size. The
values are shown as a percentage. At 100% the
size is not varied. Entering 50% for the X value
means that the X size of the individual elements
can vary between 50% and 100%. With 0%
the size varies between 0% and 100%. If you
enter 200% then the value will vary between
100% and 200%.

Uniform Scale

If this option is selected, the entered percentages
for X, Y and Z are used for relative scaling.

Example.

- With Uniform Scale checked, X = 200%, Y =
100%, Z = 50% results in a ratio of 2:1:0.5;
the individual elements can then be scaled only
according to this ratio. If this option is
deactivated, the axes of the individual
elements can be varied in scale independently.

Rotation Variation

Each element is assigned its own virtual axis.
The elements may then be rotated randomly
around its axis with values entered here. The
value, in degrees, which you enter for each
rotation axis defines the maximum positive and
negative rotation around the appropriate axis.

45° would indicate that the clones can vary in their
radial rotation from -45° to 45° at each clone.

Crumple
Very often you will find the need for a certain
roughness and irregularity in your objects as
opposed to the smooth, too-perfect appearance
that can be generated with standard objects.

Using the Crumple function, selected points of
the object are moved randomly so that the
surface is crumpled. If no points are selected or
point mode is not activated, then all points are
crumpled.

Crumple can also be applied to splines and FFD
objects; in this case, however, the Along
Normals mode (see below) is not available.
Since splines and FFD objects do not have
surfaces, this mode is not relevant.
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Mode

Adjusts the type of movement.

Along Normals
the points are moved only in the
direction of their normals (therefore
you can only enter one value for the
movement, that being the X Radius).

Axial the points are moved along the object
axes of the object.

Radial moves the points radially, from the
origin of the object.

Note

Since object normals are contained within the
surfaces of an object rather than at the
individual points, these must be interpolated
when moving. If only two points are selected,
for example, then CINEMA 4D must create an
average value from the directions of the normals
of the adjacent surfaces when moving.

Inside and Outside

By switching off this option you can tell the
Crumple function to move only in a positive
direction outwards, up to the maximum value.
With this you can ensure, for example, that a

ball is only crumpled in an outwards direction,
and not inwards. Not so good for craters,
though.

Note

The Inside and Outside  option cannot be used
in the Axial mode.

X Radius

Defines the value for the axial movement along
the X-axis. In the modes Along Normals or
Radial the X Radius is the only one used.

Y Radius

Gives the value for the axial movement along
the Y-axis.

Z Radius

The value for the axial movement along the Z-
axis.

Example:

- In the following illustration the points of the
sphere were moved by 50 units in the axial
mode:
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X-Radius = 50, Y-Radius = 50, Z-Radius = 50

- If you enter a value of 0 for both X Radius and
Z Radius, then the points are moved only in
the Y direction:

X-Radius = 0, Y-Radius = 50, Z-Radius = 0

Disconnect
Surfaces, either individual or connected surfaces,
can be split from an object. Select some surfaces
of an object and choose disconnect to see the
results. The separated surfaces will still be at the
same position, but physically they are no longer
connected to the object. The original object still
contains the points of these separated surfaces,
so the geometry is not destroyed.

This tool normally needs a selection of polygons
and polygon mode.

A good example of using Disconnect would be
to cut a hole into an object and keep the
disconnected surface to use as a cap.

Note

At the seams of the disconnected surfaces, the
Phong shading disappears and a ridge appears,
since now there are two edges. (See also
Smoothing Tag, page 463.)

This tool can also be applied to splines. In
contrast to the Break Segment tool, the start
and end points of the disconnected segment are
duplicated (as is the case with polygon objects)
and are not deleted from the original spline.
Thus the order of the spline remains intact both
before and after disconnection.

When using Disconnect on splines, a selection
of points and point mode are needed.

Preserve Groups

This option is selected by default. With this
option the surfaces are disconnected in one
piece from the object (as long as they were
connected to begin with). If this option is
switched off then each active surface is
separated individually and independently from
all other active surfaces.
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Explode Segments
Using this tool enables you to split the individual
segments of a spline into separate objects. An
individual spline object is created from each
segment of the original. Only the first segment
of the original spline remains. You do not need
to have a selection and you do not need to be in
point mode. The new spline objects become
sub-objects of the original spline and are
assigned the names ‘<object name>.<number>’.

So for example, a text spline object can easily be
split into individual letters. (Bear in mind,
though, that certain letters, such as ‘e’, may be
exploded into two or more segments because of
holes in their structure. You may want to group
these segments to re-create the entire letter.)

Matrix Extrude
The Matrix Extrude tool is similar to Extrude, but
with one difference; as many extrusion steps as
you want can be made at one time — this is
achieved by defining a relative value for move,
rotation and size which is then applied at each
step.

Matrix Extrude can be applied to surfaces of an
object. If you have not selected any surfaces or
if you are not in polygon mode, then all surfaces
of the active object are automatically used.

Surfaces are always extruded individually —
connected groups of surfaces are broken apart.

Example:

- You have selected a side of a cube and then
apply the Matrix Extrude function with the
following values ...

- The result looks like this:

- The side was extruded a total of eight times.
With each extrusion step the surface was
moved 50m in the Z direction. Furthermore it
was also scaled by a factor of 0.8 on each axis
with each step. Additionally, at each step it was
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rotated by 10° around the H axis (Heading).
Not too impressed yet? Then read on...

- Create a standard sphere with 36 segments.
Change this into a surface sphere with
Structure > Make Editable; Matrix Extrude will
then be applied to all 36 surfaces, so there is
no need to change into polygon mode.

- Select Matrix Extrude from the menu — you
will now see a dialog with numerous settings.
No need to panic, in the next section these
values are fully explained in detail. For now
simply enter the following values:

- After clicking on the OK button the sphere
should look like this:

- As you can see, it is this easy to create a
complex hairy sphere.

Steps

Defines the number of steps of the extrusion.

Note

In the hairy sphere example it is important to
note that, with just six steps, the initial 36
surfaces of the sphere become 15,768 surfaces
— in other words, the number of polygons, and
the memory requirements to handle them, can
rise substantially. Therefore always be careful
and consider the effects of increasing this value.

Polygon Coordinates

Earlier we saw how Matrix Extrude depends on
the polygon coordinates system if this option is
activated.

The values X, Y and Z and H, P and B refer to
the coordinate system of each individual
polygon. This is defined by the order of the
corner points in each polygon. If you wish to
change this order, select the Move Down
Sequence or Move Up Sequence tool from the
Structure > Edit Spline menu (see page 343).
These tools were originally intended for splines,
but can also be applied to polygons, helping you
to control the direction of the Matrix Extrudes
for one or more polygons.

If the option Polygon Coordinates is not
checked, the world coordinates are used for
each extruded surface.

Polygon coordinates inactive
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Move

Defines the movement of the surface for each
extrusion step. The Z-axis is the direction of the
normal.

Scale

Sets the scale factor for the extruded surface for
each step. 100% indicates that the size on this
axis is not changed. Values smaller than 100%
result in smaller scaling and values larger than
100% increase the surface size along the
appropriate axis.

Rotation

Use these input fields to control the rotation of the
extruded surface around the individual axes. The B
axis (bank) is the normal. If you enter the value of
10° for B for example, the surface is rotated
around its normal by 10° for each extrusion step.

Variation

This pop-up menu allows you to vary the values
of move, scale and rotation.

None no variation is added.

Initial the variation for each extrude step is
defined once for each surface at the
start of the extrusion. This random
value then applies to each step.

Per Step new random values are defined for
the surface at each step of the
extrusion.

Move Variation
using the Min and Max values you
can choose the minimum and
maximum deviation from the move
values selected above.

Example: enter the value 50 for the
movement on the Z-axis. If you
activate variation with Min at 50%
and with Max at 100%, the surface
can be moved randomly between 25
and 50 units on the Z-axis.

With Min at 50% and Max at 160%
the surface can be moved between 25
and 80 units.

Scale Variation
gives the minimum and maximum
deviation of the scaling factors
selected above.

Example: for scaling on the Y-axis
enter the value 50%. For Min enter
50% and for Max 160%. The
resulting extrusion can now vary
between 25% and 80%.
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Rotation Variation
defines the deviation from the
rotation angles selected above using
the Min and Max values.

Example: for the H axis enter 10°. For
Rotation Variation choose 50% for
Min and 160% for Max. Now the
angle will vary between 5° and 16°.

Quantize
If, during the building of an object or a spline,
the points have not been aligned to a grid (see
Snap Settings, page 375), the Quantize tool can
achieve this afterwards.

All selected points (or the points of selected
surfaces) are snapped onto grid points. If no
elements are selected and you are not in point
or polygon mode, then all points of the object
are used.

Important note

Points will be quantized within the local
coordinate system of the object.

Tip

Quantize can be also applied to the points of
FFD objects.

The grid width for the X, Y and Z direction can
be specified in the dialog.

X, Y, Z

Chooses the directions that are to be used for
Quantize.

If, for example, the points are to be quantized in
only the X and Z direction, but not in Y direction
(height), ensure that Y is disabled.

Enter the width of the quantize grids for each
direction into the input boxes.

Set Value
Use this tool to set surface and point positions
to a common value. Set Value can be applied to
polygon objects, splines and FFD objects.

All selected surfaces and/or points are
considered. If no elements are selected or if you
are not in polygon or point mode, the complete
object geometry is considered.

X, Y, Z

X, Y and Z define the axes which are to be
considered.

Leave the values of the selected elements
are not changed along this axis.

Set all selected elements are set to the
input value, relative to the chosen
coordinate system (see Coordinate
System below).
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Center all selected elements are centered to a
common value, which is determined
from the point weighting of all
elements.

Coordinate System

Object the set value refers to the object axis
system.

World the set value refers to the world axis
system.

Screen the set value refers to the virtual axis
system of the current view.

The screen axis system is no different from the
(virtual) axis system of the camera, which is
shifted to the place of the object axis. The XY
plane is parallel to the projection plane. The Z-
axis is perpendicular to this.

Example:

- If you have a flat XZ plane which has points
that are not all precisely on one level, this can
be resolved quite easily in, at least, two ways.

- Firstly you could select just the points that are
out of level and use Set Value to set their Y
values to the Y value of the rest of the plane.

- Or, more simply, you could select all of the
plane’s points and, using Set Value, set Y to
Center. In either case choose Object or World
for the coordinate system.

Before using Set Value (left) the points of this plane are not
at the same height. After Set Value (right) all points are
positioned on the Y axis, set to a common value, and are
now at the same height.

Example:

- Sometimes it can be more meaningful to align
surfaces or points parallel to the current
camera perspective. In this case select Set or
Center for Z and Screen for the coordinate
system. If you select Set you can enter a value
for Z. This value will be the distance from the
camera to the origin of the object axis.

Split
The Split function differs very slightly from the
Disconnect function; the difference is that, when
using Split, the disconnected surfaces leave a
separate object behind. The original object is not
changed.

This tool generally needs a polygon selection
and polygon mode.

Note

If you wish to delete the separated part from the
original object, you can choose Delete directly
after the split as the selection is still active (this
works only if you are in polygon mode).
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This tool can also be applied to splines. A
separate spline is created from the separated
segment (as with polygon objects) and placed in
the Object manager directly below the active
object.

When splitting splines a point selection and
point mode are required.

Weld
Using this tool enables you to weld several
points of an object or a spline into one point.
You must be in point mode and more than one
point must be selected. The coordinates of the
first point are taken as the base of the
operation. Any polygons that become
redundant are deleted automatically.

When editing spline objects only points within a
particular segment can be welded. Naturally,
however, you may have several selections on
several segments, all of which can be
individually welded.

Edit Spline

Note

If you are working with spline primitives, do not
forget to convert these into editable splines first
(see Make Editable, page 353).

Hard Interpolation
This function switches all selected points to hard
interpolation. If no points are selected, all points
of the spline are automatically changed over to
hard interpolation.

Hard interpolation means that the tangents of the
appropriate points are set to a length of zero.

before

afterwards

Note

This function can be applied only to Bézier
Splines. All others have preset interpolation
characteristics which cannot be changed.
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Soft Interpolation
This function switches all selected points to soft
interpolation. If no points are selected, all points
of the splines are changed automatically to soft
interpolation. Soft interpolation means that the
tangents of the appropriate points are set to a
standard length and direction.

before

afterwards

Note

This function can be applied only to Bézier
Splines. All others have preset interpolation
characteristics which cannot be changed.

Equal Tangent Length
This option adjusts the individual lengths of the
tangent handles of the active point to make
them the same length. The right-sided tangent
handle is always adapted to the tangent handle
on the left. If no points are selected, all points
are automatically included in the action.

before

afterwards

Note

This function can be applied only to Bézier
Splines. All others have preset interpolation
characteristics which cannot be changed.
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Equal Tangent Direction
Normally the tangent handles of a point lie on a
straight line. If you decide, however, to bend
one of the tangents (by holding the Shift key
down when interactively editing the tangent) to
produce a hard break in the spline, you may
repair that change using this option. The
tangents of the selected points are aligned to
each other with this adjustment, so that they lie
in a straight line once again. If no points are
selected, all points are included automatically.

before

afterwards

Note

This function can be applied only to Bézier
Splines. All others have preset interpolation
characteristics which cannot be changed.

Join Segment
A spline can consist of several unconnected
segments (take a look at a text spline for
example). If you want to connect two segments,
select a point, or several points, of each of these
segments and use the Join Segment tool.

The start points of each spline are joined to the
end points of the other spline. If you directly
select the end points of the two segments,
however, these are also joined. If these end
points have the same position, one of them will
be deleted when joining.

before

afterwards
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You can join either two or all segments at the
same time. If more than two segments are
selected then only the first two are joined. If no
points are selected, all segments of a spline are
joined.

Break Segment
With this function you can create a new spline
segment. Select one or more points which you
wish to separate. After using Break Segment you
will have a new segment and all points on either
side of the separated segment will become a
new segment. If the selected points are not
consecutive, a number of spline segments will
be created, one for each of any consecutive
points and one from the remaining points.

To add a new segment to an existing spline
requires you first to produce the first point of
the new segment. Before the break it is still
connected to the old segment. If you now use
Break Segment then the new segment will start
here; you can now add new points using the
Add Points command described below.

Note

This function needs a point selection and
functions only in point mode.

Reorder First Point
When you choose this function the selected
point of a spline is defined as the new start
point of the spline, around which all points of
the spline are re-sorted accordingly. If there are
several segments within the spline you can
select a point or points within each segment;
then each segment will be re-ordered according
to the chosen point(s) within it.

If more than one point per segment is selected,
the first point within the spline order is defined
as the start point.

Remember that the start of a spline is colored
yellow while the end is reddish in color.

Note

This function needs a point selection and works
only in point mode.

Reverse Sequence
To reverse the point order of a segment (i.e.
make the first point the last point, the last point
the first point and re-order all intervening
points), select one point or several points of this
segment and select Reverse Sequence. You can
also apply this option simultaneously to several
segments by shift-selecting the points of these
segments.

If no points are selected, the sequence of the
complete spline (and all segments) is reversed.

Move Down Sequence
This moves the selected point towards the end
of the segment and re-orders all other points
accordingly; so the first point becomes the
second point, the second moves to third place
etc. The last point will become the first point. It
really doesn’t matter which point you select, of
course.

You may also apply this option simultaneously
to several segments by shift-selecting points of
these segments. If no points are selected, all
points of the spline (and all segments) are
down-shifted.

Note

Although included as a bonus feature, this is
nonetheless useful. Indeed, this tool can also be
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applied to the polygons of a polygon object; as
explained in the polygon coordinate system
section, the Matrix Extrude tool uses this
coordinate system for alignment and this
depends on the order of the points (A, B, C and
D) of a polygon. You can change this order with
Move Down Sequence (and also Move Up
Sequence). More details on this can be found in
the section about the Matrix Extrude tool,
page 338.

Move Up Sequence
This moves the selected point towards the start of
the segment and re-orders all other points
accordingly; so the first point becomes the last
point, the second moves to first place etc. It really
doesn’t matter which point you select, of course.

You may also apply this option simultaneously to
several segments by shift-selecting points of these
segments. If no points are selected, all points of
the spline (and all segments) are up-shifted.

Note

This function is also useful for polygon objects
(see Move Down Sequence).

Chamfer
Chamfer is an interactive tool. This means you
control the tool directly with the mouse; first
select the tool then drag the mouse to the left/
right while holding down the left mouse button.

Chamfer converts each selected point into two
points with a soft interpolation between them.
Using this you can, for example, round the
corners of a square by chamfering the points
once or even several times.

Only the selected points are chamfered. If no
points are selected, all connected points of a
spline are chamfered. For a non-closed spline

the start and end points will not be included in
the chamfer. If a point possesses tangents then
these will be set to zero before chamfering.

Options

Radius

Defines the radius of the chamfer.

Flat

If enabled, the chamfering is linear.

Example:

Flat switched off — each new point has a tangent created to
round the chamfer

Flat switched on — no tangents are created and the spline
runs linearly between the two new point
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Create Outline
This tool also works interactively; first select the
tool then drag the mouse to the left/right while
holding down the left mouse button. This
creates an outline around the original spline, like
a copy of it.

before

after

This function works on the entire spline.

All points of the spline should, if possible, be on
one plane.

If the original spline is closed then the outline is
created as a new segment with a reversed point
order compared to the original. If the spline is
not closed the new spline will be, by default,
connected to it, thus creating a closed spline.

Options

Create New Object

If this option is enabled, the original spline is not
changed. The outline is created as a new spline
object. The original spline will remain active.

Distance

Defines the distance of the outline from the
original spline.

Since only the vertices are duplicated, the
outline cannot always be kept accurately
parallel, particularly in the case of 3D splines,
which may contain points that are not on the
same plane.

Note

Linear and Bézier splines are the best choice for
this function.

Cross Section
With this interactive tool you can create cross
sections from a group of splines.

Important

The splines must be grouped in the Object
manager (see Group Objects, page 478) and the
group of objects must be selected.
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Look at the following illustration:

These four splines (called ‘Rail Splines’ in the following
example) were grouped together in an object group

The cross sections are always created at a right
angle to the current view. You should therefore
select a view in which you can see the rail
splines directly from the side.

If you activate the Cross Section tool you can
draw a line with the mouse at the point where a
cross section is to be created; to do this click
with the mouse at the position where you
require a cross section to be created then,
holding the mouse button down, draw a cross
section line over the rail splines and release the
mouse button. In the following illustration three
cross-sections were created:

The cross sections are seen as lines

If you now change to the perspective view, you
will see that this has created circles (more or
less) which are wrapped around the four rail
splines:

These cross sections are new splines with Bézier
type interpolation, so that editing the spline
shapes at a later stage is easy.

These cross sections are particularly useful for
Loft NURBS objects. Simply create the first rail
spline and then put the cross sections into a Loft
NURBS object (see page 163).

The sequence of these rail splines within the
group is important. If you work with more than
two rail splines, make sure that these are placed
in the right order within themselves in the
Object manager, because CINEMA 4D uses this
object order when creating the cross sections. So
the start point of the cross section spline is
located on the first rail spline and the end point
on the last.

If the rail splines wind around themselves (see
example picture below), giving a cross section
spline that overlaps with the rail splines, then
CINEMA 4D selects the first intersection in the
direction of travel of the spline.
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Options

Constrain Angle

Defines a relative value for the angle within
which the cross section line is to engage. If you
enter 45°, for example, a cross section can only
be produced at 45°. To be able to use this
option you must keep the Shift key pressed
when drawing the cross section line. Otherwise
this angle is not considered.

The angle is always increased from the east (east
refers to the current view). In the following
illustration a value of 80° was selected:

This allows you to work very precisely with the
cross section tool.

Line Up
Sequentially selected points are aligned to a
straight line using this function. The points are
aligned between the two outer points of the
selection (on the basis of the spline point order). If
no points are selected, the entire spline is aligned.

before

after

Note

Best results are produced with linear and Bézier
splines.

Round
Sequentially selected points of a spline can be
rounded and subdivided with this function. If no
points are selected then all points of the spline
are rounded.
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Points

The number of points that are to be created for
each connected group of points of a spline.

Interpolation

The type of interpolation (see page 129).

Project
This function makes it possible to project splines
onto object surfaces.

Consider a simple helix and a sphere. You can
project the helix onto the sphere’s surface then,
with a Sweep NURBS object, create a half-
peeled orange skin.

After you select the Project function, a dialog
appears in which you select the type of
projection. CINEMA 4D projects the Spline onto
the surface of all visible scene objects, although
you can exclude certain objects by making them
invisible (see page 477).

Project automatically converts procedural splines
to editable splines. Please note that this step is
not reversible (although you can of course use
the Undo function).

Each point of a spline is individually projected. If
a point cannot be projected (e.g. because no
surface is available for it), then it will remain at
its original position. With Bézier splines the
tangents are adapted as well as possible.

Important

The quality of the projected spline will depend
on two factors: how finely the spline is
subdivided (the Project function does not add
new points) and the alignment of the splines to
the surface. Bézier splines can usually be
projected better than other spline types.

Projection

View projects the points according to the
current view in the editor window. If
several projection possibilities exist for
one point with this projection, the
surface that lies the furthest away in
front of the camera is selected. Below
you can see the projection of spline
text on to a plane with projection
viewed from another camera.
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XY, ZY, XZ Plane
the spline is projected according to the
selected plane (the points are moved,
perpendicularly to the plane, onto the
objects). Here text is projected,
perpendicularly to the XY plane, onto
a cylinder:

XY, ZY, XZ Radial
projects in a cylindrical manner. Here
the projection is cylindrical, from the
object coordinate origin of the spline.
If several intersections are found, then
the furthest one is selected.

An example: XZ Radial projects
outwards from the center of the
object coordinate system in the X and
Z direction. The Y values of the spline
points (in the object coordinate
system) are not changed. Below is a
helix projected in the X and Z
directions on to a cylinder

Radial

With Radial the spline is projected
spherically, outwards from the object
coordinate origin of the spline. If
several intersections are found, then
the furthest one is used. Below a helix
has been projected on to a sphere
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Make Editable

Polygon and spline primitives in CINEMA 4D are
initially created parametrically (see page 96).
This means that they contain neither point nor
polygon information that can be modified. To
edit the primitives at point or polygon level
requires you to use the Make Editable function.

After selecting this command, the active
parametric object is changed to either a polygon or
a spline object according to its type. Now you can
add new points or polygons to the object and
further edit these.

Tip

You can use the Undo function to change the
converted object back into a parametric one. If
Undo fails or you have saved the object, you
cannot return the object into its parametric form.

Add Points
Using this interactive tool you can add new
points to objects. Point mode must be active for
this to work.

A selection is not necessary.

To add a point to a surface select Add Points
and then simply click with the mouse on the
surface at the position where the new point is to
be created. Any connecting lines are drawn
automatically, using the corner points of the
surface to which the point is being added,
together with the new point. So, adding a point
to a face of a cube will result in four triangles.

To create a new, connected, point on an edge of
a surface hold down the Shift key when clicking.
The point is then created on the edge nearest to
the mouse and the adjacent surfaces are
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automatically subdivided. This is a necessary
step since, otherwise, pentagons would be
formed and CINEMA 4D does not allow these.

If you want to create a point in empty space,
keep the Ctrl key pressed when clicking. A
solitary point, not connected to any actual
object, is then added to your scene.

This tool also works with splines. This is how to
proceed with an empty spline object...

- Select Objects > Spline Object. This creates an
empty spline object with a preset Bézier type
of interpolation. (More information about the
different types of interpolation and their
characteristics can be found on page 129.)

- With point mode activated, hold down the Ctrl
key and click where the points of the spline are

to be set. If you move the mouse while holding
down the mouse button (and that Ctrl key)
then a soft interpolation tangent is created for
the current point. The new points are always
created at the end of the spline.

- To create a point on an already existing curve,
select the Add Points function and click
directly with the mouse on the curve. You can
now keep the mouse button pressed to drag
the point around, before letting it drop by
releasing the mouse button in its final position.
The shape of the curve does not change, since
the tangents are adapted automatically
(although when using the Cubic, Akima and B-
Spline types of interpolation, by their very
nature, the shape of the curve unfortunately
cannot be precisely maintained).

- If you wish to insert a new point into a curve
and simultaneously affect the shape of the
curve (with Bézier you can affect only the
tangents and with the other types of
interpolation you can only affect the position
of the point itself), hold the Ctrl key down
while clicking directly on the spline. Moving
the mouse with the mouse button pressed will
now change the curve.

Note

In principle you can also set points while
pressing the Ctrl key in the move, scale or
rotation mode.
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Bevel
The Bevel tool is a mixture between extruding
and 'inner' extruding. This tool functions only in
polygon mode. It extrudes the selected surfaces
and adds edges to them.

If no surfaces are selected then all polygons of
an object are used. You can define the strength
of the beveling interactively with the mouse by
dragging the mouse left or right while holding
the button down.

Example of use:

Here’s how to create a faceted sphere: create a
sphere, make it editable, switch to polygon
mode with no polygons selected, select
Structure > Bevel, disable Preserve Groups (in
the Active Tool window) and then Apply ...

  

Before the beveling    After the beveling

Options

Maximum Angle

If Preserve Groups (see below) is selected, all
polygons not exceeding this angle relative to
each other will hold together. If the polygons
should exceed this angle to each other then
they are broken apart when beveled.

Extrusion

Defines the height of the bevel (the distance of
the beveled surfaces from the surface of the
original object).

Variance (Extrusion)

Defines a percentage value for the variation of
the extrusion height of the bevel operation. This
option is available only if Preserve Groups is
inactive.

0% No deviation from the selected
extrusion value.

60% All active surfaces are beveled
between 40% and 100% of the
extrusion value.

100% All active surfaces are beveled
between 0% and 100% of the
extrusion value.

180% All active surfaces are beveled
between -80% and 100% of the
extrusion value.

So you can see that the value you enter is
subtracted from 100% to give the variation range.

 

Variance 0% Variance 60%
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Inner Offset

Defines the internal extrusion — the length the
edges of the surfaces are to be inwardly shifted).

Variance (Inner Offset)

Indicates the percentage value for the variation
of the inner offset. This option is available only
if Preserve Groups is inactive.

0% No deviation from the offset value.

60% Edges of the active surfaces are
inwardly beveled between 40% and
100% of the inner offset value.

100% Edges of the active surfaces are
inwardly beveled between 0% and
100% of the inner offset value.

180% Edges of the active surfaces are beveled
between -80% (outward) and 100%
(inward) of the inner offset value.

 

Variance 0% Variance 60%

Preserve Groups

If enabled, connected surfaces are not broken
apart, provided they don't exceed the angle set
under Maximum Angle, relative to each other.

Preserve Groups active         Preserve Groups inactive

Apply

Use this button to execute the bevel function.
Alternatively you can use the mouse to bevel
interactively; just hold the mouse button down
and drag.

Note

The values entered in Extrusion  and Inner
Offset  also play an important role when
interactively beveling with the mouse. In this
case there are no absolute values, so they then
indicate values relative to each other. If, for
example, you give the value 1 to Extrusion  and
the value 5 to Inner  Offset , each element is
moved exactly five units inward for each unit
outward movement, and vice versa.

Tip

Negative values can be used to bevel inward.

Another tip

You must be careful if you want to bevel several
connected polygons and want to keep them as a
group. In the following example only the outer
edges of the selection are inwardly shifted. The
edges of the inner surfaces of the selection are
not affected.

 

Before the beveling       After the beveling — only the
      outer edges shifted

You should therefore be aware that this can lead
to problems when starting from a certain inner
offset value, since the outer edges can possibly
overlap with the internal ones.
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In the above illustration we see the problem that
arises from starting with an inner offset value
that is set too high. Select a smaller inner offset
to remedy this.

Bridge
The Bridge interactive tool behaves in point
mode in a similar way to the Create Polygon
tool. In polygon mode however it behaves
somewhat differently. The main use for Bridge is
to create connections between unconnected
parts of objects. Have a look at the following
illustration:

Both of these cubes were grouped and
connected with Functions > Connect to form
one object. They are however not physically
connected.

You now want to interconnect the two active
groups of surfaces. To achieve this you select
the Bridge tool and click (in polygon mode) on
any corner point of the active surfaces of the
right cube. You can then draw the auxiliary line
by clicking on the appropriate corner point of
the active surfaces on the left cube. Remember
that the surfaces to be connected must be active
before you start. You can also switch to the
camera, change your view and then come back
to connecting the cube; the surfaces you
selected will still be in the same state.

Note

To see the reverse side of the cubes you should
switch the display mode to Wireframe mode.
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Here is the auxiliary connection line

And here’s the result:

The original surfaces are connected to each other by four new
surfaces

The original surfaces are deleted automatically,
as necessary.

So what would happen if a differing number of
surfaces were selected?

In the following illustration four surfaces are
selected on the right cube and two surfaces on
the left cube. These two selections are now to
be interconnected.

Draw a line from one of the upper points of the
right cube to the appropriate point on the left
cube. CINEMA 4D must now connect the two
points of the right cube with the one point of
the left cube. Therefore the new surfaces must
be triangulated.

Let us now see how it works in point mode:

Above is an empty object which contains just six
individual points and is our example object To
interconnect all these points you could use the
Create Polygon tool, but as you will see the
Bridge tool is an ideal alternative to this.

Firstly, click on the left point. Then draw the
auxiliary line by clicking on the point above it; it
should locate automatically on the point.

After releasing the mouse button the two points
are colored red. Now repeat the whole routine
again on the two points alongside. Click again
on the lower point and draw the auxiliary line to
the upper point and release the mouse button.
You have now produced the first surface.
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To create the second surface from the middle
and right points does not require you to select
the middle points again. Simply click once again
on the lower point and draw the auxiliary line
on to the upper one. After releasing the mouse
button you will have created the second surface.

If you click in the wrong place, you can quickly
reset the Bridge tool by pressing the ESC key.

Options

Triangulate if Necessary

If this option is enabled, non-planar squares are
triangulated during creation.

Create Polygon
With this interactive function you can create
whole new surfaces. You do not need a
selection; you need only to be in point mode. In
addition you need points, which are to serve as
corner points for the new polygons.

In the following illustration is an object which
contains six individual points. These will act as
corner points for the new polygons.

To create a closed surface automatically from
these six points requires that you click the points
sequentially.

If you begin with the upper left point, follow
this by clicking on the point right beside it etc. If
you look closely you will see a thin black line,
ending in a cross. This acts as the auxiliary line
and indicates which points have already been
selected. Additionally these points are also
colored red upon releasing the mouse button.
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If all points have been selected, click once more
on the start point and the surface is
automatically closed. You can also double-click
on the last point to close the surface.

In this example only squares were produced,
since the points were regularly arranged. You
can of course also close irregularly arranged
points to a surface. In this case however you
may find that triangles are created. CINEMA 4D
permits squares only if the surface is even. With
the more irregular type of partitioning you
cannot directly influence whether squares or
triangles are used.

If you really need to control exactly when a
square and when a triangle is to be created, and
where the connecting lines lie, then you should
create each polygon individually. Even better,
use the Bridge tool instead (see above), which is
more suitable in such a case.

Options

Keep Quadrangle

If this option is enabled, squares are still
produced even if a polygon is not co-planar. If
this option is not checked then two triangles will
be created instead.

Note

If the points are selected in an anti-clockwise
direction, the normals of the created surfaces
point away from you and you see the surfaces
from the reverse side. Then, with backface
culling activated (see page 24), the surfaces
cannot be displayed. In this case deactivate
backface culling, or reverse the normals (see the
Align Normals and Reverse Normals sections on
pages 371 and 372).

If you select the points in a clockwise direction,
the normals point towards you and you view the
surfaces from their front.
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Extrude
This interactive tool functions only in polygon
mode and extrudes the selected surfaces.

If no surfaces are selected, all polygons of an
object are extruded.

You can define the offset (see below) of the
extrusion interactively with the mouse by
dragging left or right with the mouse button
held down.

The extrusion will take place along the normals
of the selected surfaces; the average value is
evaluated from all normals to be extruded.

 

Before extrusion        After extrusion

Options

Maximum Angle

If Preserve Groups (see below) is selected,
polygons not exceeding this angle to each other
are kept together. Polygons exceeding this angle
are broken apart during extrusion.

Offset

Determines the height of the extrusion (the
distance of the extruded surfaces from the
original object surface). This affects the
extrusion when you press the Apply button.
When using the mouse interactively (see above)
this value is irrelevant.

Variance

Defines a percentage value for the variation of
the height of the extrusion. This option is
available only if Preserve Groups is inactive.

0% No deviation from the selected offset
value.

60% All active surfaces are extruded
between 40% and 100% of the offset
value.

100% All active surfaces are extruded
between 0% and 100% of the offset
value.

180% All active surfaces are extruded
between -80% and 100% of the
offset value.

So you can see that the value you enter is
subtracted from 100% to give the variation
range.

  

          Variance 0%         Variance 60%
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Preserve Groups

If this option is active then the connected
surfaces will not be broken apart during
extrusion, assuming they do not exceed the
Maximum Angle you chose above, relative to
one another.

 

Preserve Groups active Preserve Groups inactive

Tip

If you want to extrude along an axis using the
object or world coordinates system, and not
along the normals, perform a numeric extrusion
(i.e. using the Active Tool window to input
values, not using the mouse) with an offset
(height) value of 0; then move the new surfaces
with the move tool:

To extrude in the Z direction, simply lock the X
and Y axes:

  

Extrude Inner
This interactive tool behaves in a similar way to
the Extrude tool. Like Extrude, it functions only
in polygon mode. However, in contrast to the
Extrude tool, the selected surfaces are extruded
inwards, or optionally outwards. If no surfaces
are selected then all surfaces of the object are
included in the extrusion.

You can define the offset (see below) of the
inward extrusion interactively with the mouse by
dragging to the right while holding the button
down; if the mouse is moved to the left, the
extrusion will be outwards.

 

Before extruding inwards        After extruding inwards

Options

Maximum Angle

If Preserve Groups (see below) is selected,
polygons not exceeding this angle to each other
are held together. If the polygons exceed this
angle they are broken apart with Extrude Inner.
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Offset

Defines the width of the internal extrusion (the
distance of the edges of the extruded surfaces
from the edges of the original surfaces). This
affects the extrusion when you press the Apply
button. When using the mouse interactively (see
above) this value is irrelevant.

Variance

Indicates a percentage value for the variation of
the width of Extrude Inner. This option is only
available if Preserve Groups is inactive.

0% No deviation from the selected offset
value.

60% All active surfaces are inward extruded
between 40% and 100% of the offset
value.

100% All active surfaces are inward extruded
between 0% and 100% of the offset
value.

180% All active surfaces are extruded
between -80% (outward) and 100%
(inward) of the offset value.

 

Variance 0% Variance 60%

Preserve Groups

If this option is active then the connected
surfaces will not be broken apart during
extrusion, assuming they do not exceed the
Maximum Angle you chose above, relative to
each other.

 

Preserve Groups active       Preserve Groups inactive

Note

You must be careful if you wish to use Extrude
Inner on several connected polygons and also
keep them as group. In this case only the outer
edges of the selection are moved inward. The
edges of the inner surfaces of the selection are
not affected.

 

Before extruding inwards      After extruding inwards — only
     the outer edges are moved

You should therefore be aware that this could
lead to problems when starting from a certain
offset value, since the outer edges may overlap
with the inner.

Above you can see the problem that arises when
starting from too high an offset. Select a smaller
offset to remedy this.
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Knife
As the name suggests, you can use this tool to
literally cut through surface objects and splines.
The object will be subdivided at the cut so this is
not quite like cutting a loaf of bread with a
bread knife but it does define a cut line so that
you can tear off the slice of bread later with the
Disconnect tool.

Note

You must be in point or polygon mode to use
the Knife tool.

Options

Constrain Angle

Enter a relative angle in this field that will affect
the Knife line’s calculation. Entering 45°, for
example, ensures that all cutting can only be
made at 45°.

To use this option you need to keep the Shift
key pressed when drawing the cutting line,
otherwise this angle is not considered.

The angle is always increased from the east (east
refers to the current viewport). In the following
illustration a value of 80° was selected:

This gives you the ability to work very precisely
with the Knife tool.

Restrict To Selection

This option is switched off by default. So the cut
line, by default, pays no attention to any selected
surfaces (or with splines, to any connected point
selections). If this option is active, only areas of
any selected elements are cut. If you cut through
polygon objects along a constant polygon row
you will get an exact cut:

 

If, however, you do not cut along such a constant
polygon row, CINEMA 4D must distribute adjacent
surfaces as necessary and, since only triangles and
rectangles may result from the cut (no pentagons
or other such n-sides are allowed), this will result in
a far less precise cut:
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Normal Move
Selected surfaces are moved along their normals
with this interactive tool.

You must be in polygon mode to use this
function.

You may use this tool interactively with the
mouse by moving left or right while pressing the
mouse button. You can also use this tool with
numeric input (see below).

If no surfaces are selected, all surfaces are
moved. If the surfaces selected for movement
contain divided points, CINEMA 4D will
calculate how these elements are changed.

Before After

Options

Value

The value for the move.

Apply

Confirms the numeric input.

Normal Scale
Use this interactive tool to scale selected
polygons along their normals.

You must be in polygon mode to use this
function.

You can use this tool interactively by moving the
mouse left or right while pressing the mouse
button. You can also use the tool with numeric
input (see below).

If no surfaces are selected, all surfaces are
scaled. If the surfaces selected for movement
contain divided points, CINEMA 4D will
calculate how these elements are changed.

Before After

Options

Value

The value for the scale. 100% means the
surfaces are doubled in size.

Apply

Confirms the numeric input.
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Normal Rotate
The selected polygons are rotated around their
normals. The normals of each individual surface
are used as the rotation axes.

You must be in polygon mode to use this
function.

You can use this tool interactively by moving the
mouse right or left while pressing the mouse
button. You can also use the tool with numeric
input (see below).

If no surfaces are selected, all surfaces are
rotated. This tool is mostly suitable for individual
polygons. If the surfaces selected for movement
contain divided points, CINEMA 4D will
calculate how these elements are changed.

Before After

Options

Value

The value for the rotation.

Apply

Confirms the numeric input.

Magnet
With the interactive magnet tool you can pull
sections out of polygon objects (and also
splines).

You must be in polygon or point mode to use
this function.

If you have a selection active, only those points
or polygons are modified. If no selection is
active, all points or polygons of the object are
included.

Click anywhere on the object and drag the
mouse. The surrounding points follow the
mouse pointer to a certain distance — the
further they are from the mouse pointer, the
weaker the influence of the magnet on them.

Options

Nearest Point Method

If this option is inactive (default), an object is
deformed only if you click within the radius of
influence — see below (this also applies to
polygon mode). This becomes the starting point.

If you click beside it (i.e. outside the radius of
influence), nothing is deformed. If this option is
active, however, deformation of the object will
occur, starting from the point nearest to the
mouse pointer.
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The first method is far more precise. You will also
benefit from the fact that points on the opposite
side of the object will not be modified accidentally
with this first method. Only those points, which
are not covered, by other points and surfaces can
be selected.

However, if the Nearest Point Method is enabled,
points which are also located on the back of the
object can be selected (unless these have been set
to invisible by Backface Culling or a red visibility
switch in the Object Manager). This makes it
possible to work from the inside of objects with
the magnet.

Radius

Gives the radius of the range of influence of the
magnet.

This radius can be increased or decreased
interactively by pressing the ‘+’ or ‘-’ key while
holding the mouse button down and dragging.
Users of a wheel mouse can change the radius
interactively with the wheel.

Type

Select between several types of function curves
for the magnet:

 

   Constant          Linear

 

   Dome          Bell

 

   Circle          Needle

Width

This parameter determines how soft or hard the
influence of the magnet is to be.
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Mirror
Using the Mirror tool, points and surfaces of an
object can be mirrored. This tool functions in
point or polygon mode. In point mode only the
selected points are mirrored (without their
surfaces). If no points are selected, all points are
mirrored. In polygon mode the selected surfaces
are mirrored. If no surfaces are selected, all
surfaces are mirrored.

Mirror can also be applied to splines. The
selected points are mirrored as a new segment.

Mirror functions interactively. This means you
can control the mirroring directly with the
mouse; to select the axis for mirroring, simply
click and drag until you see the axis you want,
then let go of the mouse button.

Options

Coordinate System

Selects the coordinate system for the function.

In all the modes below remember to keep the
mouse button pressed. You will then be able to
choose the mirror axis by dragging it with the
mouse to where you want the mirroring to
occur. When you release the mouse button, the
mirroring is applied.

Object In this mode the object is mirrored
over the object axes. You can set the
mirror axis using the mouse by
clicking directly on a point of the
object. The mirror axis automatically
locates itself on the nearest point. The
object is then mirrored exactly over
this point.

You do not necessarily have to be in
point mode; the points are also
located in this way in polygon mode.

The object mode also allows the input
of numeric values (see Value below).

World This mode behaves exactly like the
object mode, except that the element
is mirrored over the selected world
axis.

Like the object system, the world
mode also allows the input of numeric
values (see Value below).

Screen In this mode the object is mirrored in
the current projection plane. If you
first click in the area of the upper or
lower window border, you get a
horizontal mirror axis. If you first click
in the area of the right or left window
border, you get a vertical mirror axis.
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Mirror Plane

This mode is only available for the world and
the object coordinate system. You can select the
XY, ZY or XZ plane. Depending upon the
selected coordinate system (see above) the
mirror plane refers either to the world or to the
object axis.

Weld Points

This option is quite important if you mirror, for
example, a cube over one of its edges and
Duplicate Points is active. After mirroring there
may be some points which occupy the same 3D
space, and lie on top of each other:

If Weld Points is active, these duplicate points
are welded after mirroring.

In the adjacent input field you can enter a
distance; any point that has a duplicate point
within this distance will be welded into one
single point.

Value

Use this to position the mirror axis numerically.
This works only with the object and world
coordinate systems and allows you to freely
define the distance of the mirror axis from the
axis origin.

Duplicate Points

If this option is inactive, the selected elements
are simply mirrored. If this option is active, the
selected elements are first duplicated and then
mirrored. So you obtain a mirrored copy of all
the selected elements.

Duplicate Tag Selection

If this option is enabled in the Active Tool
window, existing frozen selections or vertex
weight tags (see the Selection Menu, page 325)
are used when mirroring.

Snap To Points

When using interactive mirroring in the editor,
this defines whether the mirror axis is to snap to
the points of the object (in screen mode) or not.
If this is active the mirror axis is then positioned
automatically to the point nearest the mouse
pointer. With this function you can, for example,
mirror a cube precisely over one of its edges.

When using the object or world coordinate
systems Snap to Points is turned on
automatically. The mirror axis must be placed at
a point of the object. That is, you cannot freely
determine the mirror axis interactively when in
the object or world coordinate system. You can
get around this though — see Value above.

Apply

Use this button to confirm your numeric input.
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Smooth Shift
Smooth Shift is comparable to the Extrude tool.
With Smooth Shift, however, the connected
surfaces can only be extruded coherently.

The direction in which the surfaces are extruded
with Smooth Shift is determined not only from
the normals of the active surfaces, but also from
the normals of the adjacent (inactive) surfaces.
This makes it easy and quick to extrude lumps
out of surfaces accurately.

This interactive tool can only be applied to
surfaces. If no surfaces are selected, or you are
not in polygon mode, then all surfaces are
considered.

Smooth Shift is an interactive tool. This means
that you are able to determine the offset of the
extruded surfaces directly with the mouse (hold
down the mouse button, drag left or the right,
then release the mouse button).

Options

Maximum Angle

This is the maximum angle that surfaces may lie
to each other to ensure that no additional
surfaces are created with Smooth Shift.
Rectangles (and in some cases also triangles) are

inserted in these critical places where the angle
is exceeded, ensuring that the surfaces are not
torn apart.

The marked surfaces are those which had to be additionally
built and inserted, because the Maximum Angle was exceeded.

Note

These triangles should be avoided if you want to
use an object for Hyper NURBS, otherwise the
Hyper NURBS surface may display uneven
shading properties.

Offset

This input field is relevant only if you do not
choose the offset interactively with the mouse.
Using this value you may determine the offset
of the extruded surfaces numerically. Use the
Apply button to confirm the input and
accomplish the Smooth Shift.
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Align Normals
When creating surfaces (see above) you may
sometimes inadvertently create surfaces with
normals pointing in the wrong direction or
opposite directions. Such a problem is easily fixed
with this function. When you use Align Normals
CINEMA 4D will adjust and re-align the incorrect
surface normals to the correct direction.

CINEMA 4D adjusts the orientation of the
normals according to the normal direction of the
first surface of the currently selected group of
surfaces. If no surfaces are selected then all
normals are aligned.

CINEMA 4D does not recognize an object’s
inner and outer surface. A basic sphere has an
inner and an outer side, but only one surface
level, which can be confusing. We need a better
definition.

Let us define this single surface level to have an
inner and an outer property. Outer designates,
in principle, the direction in which the surface
normals point and inner is therefore the
opposite direction. This plays a role with texture
projection, where you can project textures from
only the front or the back (see Texture Mapping,
page 537).

So, if there is an equal number of normals
pointing one way as point the other way how
do we decide which is the outer surface? We
could either choose randomly or, perhaps, look
at the first polygon in the sequence and use its
normal as the basis of our calculation —
CINEMA 4D does the latter.

Why exactly are these normals needed?

As described above, the direction of the normals
defines the interior and the exterior of an object.
This is important, among other things, for
displaying an object in the editor.

Occasionally, when building certain objects, a
situation can arise in which some polygons seem
invisible. This can happen if backface culling is
on and the reason is as follows.

To save on processor performance you may
have, sensibly, enabled backface culling (see
page 24) for your scene; this is where only the
polygons visible from the front of an object are
displayed in the editor. The polygons positioned
directly at the back of an object are not drawn.

When displaying a sphere and other volume
objects in the Gouraud Shading mode you may
notice no difference, simply because you do not
see the back of the sphere anyway. But should
you select all the polygons of this sphere and
reverse the normals (see next section), you will
now see only the back of the sphere; the front is
now transparent since you now have inverted
the sphere. The inside is now the outside, and
this becomes invisible because of the backface
culling.

Should you find yourself inadvertently in a
situation like this you should switch off backface
culling and reverse the normals of these
polygons.

The adjustment of these normals also plays an
important role with tools such as Smooth Shift,
Extrude, etc. These model tools always move in
the direction of the normals by default. If you
should need to move several surfaces with
different normal alignments using Smooth Shift
you will obtain useless results, since the surfaces
are moved in their own respective, and
opposite, directions.
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Another important factor is smoothing with
angle limit active (see Smoothing, page 463).
CINEMA 4D calculates whether edges are to be
rounded or not by considering the angle of the
surfaces to each other. If two surfaces with
differently aligned normals lie next to each
other, CINEMA 4D calculates the wrong angle
information — thus causing unwanted, often
ugly, results when smoothing.

Additionally, when using Displacement mapping
(see page 517), the angle of the normals plays
an important role.

Reverse Normals
This function is similar to Align Normals. Here,
however, the normals are reversed. If no
surfaces are selected, all the normals of a
selected object are reversed. With an active
selection only the normals of the selected
surfaces are considered.

Note

Reversing the normals is achieved by changing
the point sequence in a polygon (see also
Structure Manager, page 627).

Optimize
If you were to build an object from many
individual triangles and rectangles, for example by
using the Connect function (see page 385), very
often some points and surfaces will be duplicated.
For example, the parametric primitives can contain
some duplicate points after being converted into
polygon objects. You can eliminate these double
elements with the Optimize function. The
appearance of the object will not change, or only
slightly change, when using this function.

Caution is required with objects that intentionally
contain these double points in certain places. Such
points can be intended, for example, to produce
hard edges despite an active smoothing tag (see
page 463) or in connection with a Hyper NURBS
object (see page 158).

The selected elements to be optimized can be
points or polygons. If you select polygons, then
the associated points are also considered. If you
select points only, then just the points are
considered.

This tool can be applied also to splines. In this
case, however, only the points can be optimized,
since a spline does not possess surfaces.

Polygons

When enabled this will eliminate one- or two-
point surfaces.
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Unused Points

Enable this to delete isolated points — those
which are not connected with any object
geometry.

Points

Specifies whether duplicated points are to be
eliminated.

Tolerance

When eliminating points you may enter a
tolerance value. This defines the maximum
distance that must lie between the two
coinciding points for them to be deleted when
optimizing. If points are closer to each other
than this value, then they are merged into one
point. If polygons should become redundant
(e.g. if all three corner points of the polygon
occupy the same point), then CINEMA 4D will
automatically delete these.

Subdivide
With this option you can partition polygon
objects or splines. If there are no polygons
selected when subdividing a particular polygon
object, then all polygons are partitioned.

Subdivision

The number of subdivision steps to be applied.
Caution — do not make this value too large.
The number of surfaces (or the number of
points), and therefore the storage requirement,
for any object rises dramatically with each
increase in this value. With each extra
subdivision step a surface is divided into four
surfaces. So, if your object initially has three
surfaces, a single subdivision results in 12
surfaces, a second subdivision results in 48, a
third in 192 etc.

HyperNURBS Subdivide

With this option active the object is subdivided
using the HyperNURBS formula (see page 158).
Point positions that already exist are modified to
round the structure of the surface. If this option
is not active, existing point positions are
maintained and the surface is not smoothed
when subdividing.

HyperNURBS Subdivide is a common method of
modeling on a polygon basis — you start with a
low detail basic model which you can quickly
and easily modify. You then subdivide, modify it
again, subdivide again etc.
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Note

With HyperNURBS Subdivide on triangles are
divided into three rectangles — with normal
subdividing you would get four triangles.

Maximum Angle

Defines the maximum angle that the surfaces
may be at to each other in order to be
smoothed. If the angle is larger than this value,
a hard edge remains.

Triangulate
Triangulate converts all the rectangles of an
object into triangles.

When editing polygon objects you should try to
work with rectangles whenever possible.
Rectangles are computed more quickly than
triangles, use less memory and give better
results with Phong Shading and with
HyperNURBS.

Untriangulate
If you have an object built only of triangles (e.g.
exported from another program), CINEMA 4D
can try to convert the triangles into rectangles.
This works only as long as the triangles that you
want to convert will result in a planar rectangle.
Triangles that cannot be converted are left in
their original state.

Untriangulate works only for triangles which
result in planar quadrangles. If Evaluate Angle is
disabled CINEMA 4D tries to convert all
triangles into quadrangles. This can result in
unwanted edges and shading errors. If this is the
case enable Evaluate Angle.
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Structure Context Menu
There is no need to move your mouse all the
way up to the Structure menu. Instead, click the
right mouse button (Macintosh: Command-
click) and a context menu will open containing
all the modeling functions.

You can choose Frame Selected Elements from the
context menu. This will zoom and center the active
view in relation to the selected elements. This can
improve your workflow, since it removes the need
to use the standard navigation tools.

You can also choose Undo from this menu.

Snap Settings
It is often useful to be able to force a construction
item to a particular place in your 3D modeling
space. Of course, we have the Coordinate manger
that allows precise positioning but sometimes what
we need is to be able to constrain the movement
of an item to a grid or, indeed, to another item —
this is called 'snapping'.

With snapping turned on you can snap elements
to other elements automatically, e.g. one point
can snap to another point. Or a spline point can
snap to the axis origin of another object.

The snap will happen whenever the point (let’s
called it the 'source' from now on) lies at a
certain distance from the target; you have
control over this radius of attraction.

For example, you can make the lowest point of
a sphere snap to the center of the highest
surface of a nearby cube — so two objects can
be positioned in relation to each other precisely,
easily and quickly. There’s no doubt that
architects need this feature but every modeler
will find a use for snapping.

The Construction Plane option and the World
Grid tab (see page 379) are independent of
snapping and can be changed whether or not
snapping is on.

Enable Snapping

Enable this to turn on snapping; all the snap
settings now become active.
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Construction Plane

This option allows you to enable/disable the use
of a construction plane.

What’s the idea of a construction plane?

It’s a modeling aid that allows you to constrain
the creation of points and splines to a particular
construction plane of your choosing.

In the Objects > Modeling submenu you will find
the Construction Plane object (see page 180). You
can have many of these in your scene, if you wish.
If no construction plane is present, the world grid
(if active) is considered to be a construction plane.
If several construction planes exist in a scene, the
first visible one (i.e. with its traffic light not at stop)
in the Object manager is used (see Object Display,
page 477).

The construction plane is relevant only in the
3D, parallel and isometric views (i.e. all non-2D
views). When the Construction Plane option is
active, newly set points or newly drawn splines
(including their tangents) are created within the
construction plane (not above or below it, no
matter where you click). The points can then be
moved only on the construction plane. This
applies until the points are moved from the
working plane by another tool or by disabling
the Construction Plane option.

The Construction Plane option is enabled by
default and thus allows you to draw splines
comfortably in the 3D view. (With this option
turned off splines will be drawn freely in space.)

There is always an exception, of course. If the
horizon is visible in the 3D view (see Projections
on page 18 for a discussion of the different
views) then as long as you move a point
beneath the horizon it remains on the
construction plane. However, if you move the
point above the horizon, it will no longer be

fixed on the working plane and is free to move
in height (this is a limitation forced on us by the
technical aspect of projection).

This option is not linked to the Enable Snapping
setting.

Options

Type

There are three Type settings which give a great
deal of control over the snapping process.

Snap 2D In this mode the source point is
snapped only if it is at same height as
the target point, as well as being
within range of the target. In this case
height is dependent on your selected
viewport as follows:

In the frontal viewport the Z values of
the elements must agree; in the side
viewport the X values must agree; and
in the plan viewport the Y values must
agree. In the case of use of a
construction plane the local Y values
in this object system must agree. Also
in all non-planar viewports the Y
values (related to the virtual projection
plane) must agree.

Snap 2.5D
The snapping takes place visually in
the current viewport. Snapping will
happen if the source lies visually in the
current viewport within the snap
radius of the target. In contrast to the
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2D snapping the points do not have
to have the same X, Y or Z values.

If you make a 2.5D snapping in the
3D viewport and then switch to
another viewport you will see that,
after the snapping, the points do not
necessarily agree with their snap
targets in the new viewport. The point
has been snapped only parallel to the
viewport, not moved in depth.

Snap 3D The source is snapped directly to the
target. 3D snapping works like 2.5D
snapping — with the difference that
the point is actually moved to the
target, giving accurate, natural
positioning.

Examples:

- Suppose you have activated a World Grid with
a grid spacing of 100 units and you have a
selected point at (53/62/91) that you wish to
snap to and you are working in the frontal (XY)
view. Also, only the Grid Point snapping option
(see below) is active and the snap Radius is 30.

- Snap 2D: If you move the point, it is never
snapped to the nearest grid point since the
neighboring grid points lie at (x/y/0) and (x/y/
100) and therefore have different Z
coordinates from our source point. Since the Z
component never agrees, it will never be
snapped. This would be different if the source
point had a Z coordinate of 100, for example.

- Snap 2.5D: If you move the point, it is snapped
to the neighboring grid points when they come
within range. However, since it is moved, in
this mode, only perpendicularly to the camera,
it keeps its Z component. The snapped point is
moved, for example, to the coordinates (0/0/
91), (100/0/91), (100/100/91) or (0/100/91).

- Snap 3D: In this mode the source point snaps
within the complete 3D space. The point can
therefore be moved for example to the
coordinates (0/0/100), (100/0/100), (100/
100/100) or (0/100/100).

Radius

This is the radius of attraction for the particular
target you have selected. The larger this radius,
the more quickly the source will be snapped to
the target as the source is moved towards the
target. You could say that targets with a high
radius are more attractive!

Point

If this option is enabled, the source is snapped
to the points of the active or other objects. All
visible, polygonal objects and splines in the
scene are considered. As primitives (see
page 96) have no points, they cannot be
considered as snap targets for this option.

Edge

With this option enabled the source is snapped
to polygon edges. All visible, polygonal objects
in the scene are considered.

Note

Points have higher snapping priorities than
edges.

Polygon

Enable this option and the source is snapped to
the surface of the target polygon. All visible,
polygonal objects in the scene are considered.

This is particularly well suited to drawing splines
on to polygon objects, for example. To do this
you should deactivate all other options and use
Snap 3D. If you now create (or move) the points
of the splines, they are snapped automatically to
the polygons lying behind the spline.
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Polygon Center

With this option enabled the source will be
snapped not to the surface of the polygon but
to the center of the target polygon.

Midpoint

Use this option together with other options to,
for example, snap to the midpoint of a polygon
edge or to the centre of the spline distance
between two points.

Spline

With this option on the source will snap to any
part of a visible spline curve.

Tangent

This option makes sense only if you want to let
a source spline curve at a point just edited snap
tangentially on to another, target, spline. This
option can be very time-consuming.

Perpendicular

Here the source is not snapped if the source and
target spline curves are tangential to each other,
but only if the curves are perpendicular to each
other. This option can be very time-consuming.

Spline Grid

If you enable this option you can effectively use
an existing spline as a snap grid and snap to the
nth part of the spline; here nth part means the
total length of the spline divided equally into n
elements. You choose this value in the box
below the option.

For example, if the spline is 200 units long and
you have entered a Spline Grid of 5, the
snapping will be to the nearest 40 unit segment
(independent of the actual spline points).

Note

Be careful not to have too many snapping
options active at the same time. For example, if
you want to draw a spline on the surface of an
object (see above) and both Polygon and Point
are active, the new points may often disappear
behind the surface since snapping is considering
all points — including those on the back of the
target object.

Object Axis

Enable this to snap to the object axis origin of
any visible object.

Grid Point

With this option on the source is snapped to the
grid points of the construction plane.

Grid Line

Turn this on to snap the source to the grid lines
of the construction plane.

Snapping in Different Modes

Snapping works in the following modes; object,
model, texture axis, point, polygon, animation
for keys.

Say you have selected several points (or
polygons) and want to move them with
snapping activated, when does the snap
happen? In other words which point/polygon
out of all those selected is taken to be the
source item, the one that when it gets within
the range of the target will snap to it?

It works like this — the item that is closest to
the mouse pointer when you start to move the
selection is taken to be the source item; when
that gets within range of the target it is snapped
to it and all other selected points/polygons
move accordingly.
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This turns out to be a natural way of doing
things so that, if you want the edge of a
selection to snap, simply place the mouse
pointer outside the selection before moving. It’s
best to try this out to see how it works.

Notes

Snapping overrides any set mouse grid (see
below under Quantize). Snapping works when
moving elements, not when scaling or rotating
them.

World Grid
This is where you choose the properties of the
world grid which is also the default construction
plane (see below) and is shown in all views.
When enabled, this gives you a working grid
within the various 2D and 3D viewports which
can be an excellent tool for precise modeling. It
also shows the world axes (which the
construction plane object does not).

Enable

This enables/disables the world grid. Remember
that you may have one or more construction
plane objects in your scene as well, in which
case you will still see a grid on your display even
if the world grid is turned off.

Grid Spacing

This is the distance of the grid lines from each
other.

Lines

This allows you to choose the total number of
grid lines (stretching over the X and Z axes); the
default is 100. When you choose a higher value,
the grid nears the horizon. This setting is only
relevant in the non-planar views.

Major Lines Every nth

The grid contains major interval lines which
stand out from the others by their darker color.
With this option you can choose when these
interval lines should occur.

Dynamic Grid

With this option you get always an optimal grid
width on the screen, independently of the
chosen grid spacing. This applies only to the 2D
viewports.

Using the pop-up menu you choose, with which
factors the dynamic grid is to work.

If you select None the grid is not dynamic and
the grid spacing (with its default value of 100)
remains constant, no matter how much you
zoom in or out.

But if you select, say, 1...10 the grid is adjusted in
steps of 10 as you zoom in or out. If you zoom in
and the spacing becomes too wide for the view,
CINEMA 4D first switches automatically to a grid
spacing of 10. If you zoom in still nearer, it is
changed to 1. If you zoom out from the default
grid and the grid width of 100 becomes too dense
for clarity, it is first switched to a grid spacing of
1000 and then up as necessary. There are no
restrictions up or down.
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1..5..10 means that grid widths of
100*5^10*n and 100*10^10*n can
be achieved.

1..2..5..10
means that is switched in steps by 2, 5
and 10. The grid can then have the
values such as 0.1; 0.2; 0.5; 1; 2; 5;
10; 20; 50 etc.

You can also choose 1..2.5..5..10, the meaning
of which is left as an exercise for the reader.

Note

If the Grid Spacing of the world grid is too large
in relation to the object, this can result in jumps
when moving it or its elements. In this case set
the Grid Spacing to a smaller value.

Quantize
The settings on this tab affect the mouse
sensitivity when modeling and editing objects,
points, surfaces etc.

Move

When positioning objects, points, surfaces and
other elements a small mouse movement can
often result in a change larger than the one you
wanted; so, for example, the element which is
to be moved by a couple of units jumps from
position 10,374 to position 10,694.

To prevent this, use the Move grid. It is not
shown as lines in the view but has the effect
that you can only move an object to positions
which are a multiple of the chosen value. A free
or unintentional movement of objects is then no
longer possible.

It is a local grid — it is always relative to the
current position. If you entered, for instance, the
value 10, an object will always move in units of
10; an object with the position (5,6,90) moved
along the X axis would then move to (15,6,90),
(25,6,90), (35,6,90) etc.

Scale

If this option is enabled, the relative scaling
factor changes only by the value entered here
when scaling objects, point quantities, surfaces
etc.

Rotate

When this option is enabled the chosen element
can be rotated only in steps, as set here. Thus a
value of 10° allows a rotation of the element in
steps of 10°, 20°, 30° etc.

Texture

This is a percentage which, when enabled, gives
the increment by which you can move and scale
textures.

Tools

This setting is relevant to all the interactive tools
in the Structure menu. If you enable this option,
change the value to 10 and then extrude a
surface — the extrusion will take place in steps
of 10. Together with the various modeling tools
this allows for extremely accurate control over
the modeling process.
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11. Functions Menu   
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11 Functions
The Functions menu contains tools that change
the position, scale and/or direction of objects
(e.g. Randomize). The one exception is the
Connect command, which converts an object
group into a single object.

Arrange

This command lets you arrange an object group
along a spline. Only the first level of child
objects are arranged along the spline — all other
children remain with their parent.

The order of the objects along the spline is
determined by their order in the Object
manager — the topmost object in the Object
manager is placed at the start of the spline and
the bottom-most object is placed at the end of
the spline.

Let’s take a concrete example. Imagine that you
have created a group of three-dimensional
letters, ‘CINEMA 4D’, using the Text command
from the Objects > Spline Primitive menu. The
topmost letter in the Object manager is the ‘C’,
the bottom-most is the ‘D’.

You have also created an s-shaped spline that
will function as the path — this is the spline
along which the text will be arranged.

If you use the Arrange command, the first letter
‘C’ is placed at the start of the spline and the
last letter ‘D’ is placed at the end. The other
letters are placed between, as indicated in the
diagram below.

Path

Use Path to specify the spline along which the
objects should be arranged. You may also
choose which object axis (Y, Y or Z) should be
tangential to the path.

Keep Parallel

If the Keep Parallel option is selected, the
objects will not be rotated (see diagram below);
otherwise, each object will be rotated so that it
is tangential to the spline.
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Center

This function centers objects in 3D space. It
requires an object group to be selected in the
Object manager. All child objects are affected.

As a first step, CINEMA 4D calculates the size of
the object group. Think of this as a three-
dimensional cuboid which encloses all the
objects.

The Center command lets you specify where the
objects should be placed in terms of each axis of
the cuboid. You can affect how this command
works using the various pop-ups in the dialog.

Positive, Middle, Negative

Negative and Positive represent the two ends of
the corresponding cuboid axis, Middle
represents the center of that axis, while
choosing the dashes deactivates centralization
for the particular axis.



CHAPTER 11 • FUNCTIONS • 385

Connect

CINEMA 4D’s Group Objects command (see
page 478) enables you to place objects into a
group. The Connect command converts an
object group into a single object. For example, a
fence consisting of hundreds of individual planks
can be connected to form just a single fence
object.

Connect requires an object group to be selected
in the Object manager. All child object
parameters, such as tags, are lost.

Use this command only if you are certain that
the object will not need separating later;
although you can split the object into its original
parts manually, it is a time-consuming process.

Note

Only polygons or splines can be connected.
Other objects such as light sources will be
ignored and are not included in the new object.
You cannot connect spline objects and polygon
objects.

Tip

You can speed up render time by connecting any
groups that contain lots of objects. The reason
for this is that a single object can be rendered
more quickly than a few hundred objects that
contain exactly the same polygons.

Current State To Object

This function creates a polygon copy of an
object’s current shape. For example, if you are
using several deformers on an object, you can
copy the resultant shape into a normal polygon
object (the deformers will not be required for
the copy). Or perhaps you have defined an
animation (e.g. using PLA, see page 586) and
you wish to create a polygon copy of the shape
at a particular frame — simply move the time
slider to the required frame and choose this
option.

The copy takes the name of the original object
and appends it with the current animation time.
For example, the polygon copy for ‘ball’ is
named ‘ball 14 F’, ‘Ball 1.033 S’ or ‘ball
00:01:01’ depending on which animation units
you have specified in the general settings (see
Animation Units, page 46).

This function is particularly useful for fine-tuning
morph animation manually.

Example:

- Create and animate an object, e.g. with PLA.

- Move the time slider (Time Line) until the
object is in the state that you wish to copy.

- Choose Functions > Current State To Object.

Note

Child objects are ignored — the function must
be called separately for each child object that
you require.
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Note

Animation data is not copied to the new object.
The original object (including its animation data)
is preserved.

Note

If the original object is parametric the function
creates a polygon copy (taking into account any
deformers and hierarchies).

Duplicate

This command enables you to create as many
duplicates of an object or object group as you
like. It also lets you specify movement, scale and
rotation values for the duplicates.

Copies

Copies specifies the number of duplicates.

Generate Instances

If Generate Instances is activated, CINEMA 4D
will create instances (see page 176) rather than
actual copies.

Move

The Move settings let you place the duplicates a
regular distance apart. The values you enter here
refer to the total length (the distance between the
first and last copy), not the distance between
consecutive copies. The X,Y and Z directions refer
to the world coordinate system.

Tip

To move the duplicates along the object axes
rather than along the world axes, first create a
null object (see page 95). Next, use Functions >
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Transfer  so that the null object adopts the
position and rotation values of the object to be
duplicated. Make the object a child of the null
object (drag-and-drop in the Object manager)
and choose the Duplicate function (the object
must be selected, not the group). The duplicates
will be moved along the object axes.

Scale

You can use the Scale values to change the scale
of the duplicates. The object axes are used for
the scaling. For example, if you set the X scale
value to 0.5, the final copy will be half the size
of the original object in the X direction. The
scale is interpolated for objects between. So four
copies with an X scale value of 0.5 will mean
that each consecutive copy is reduced by 0.5 /
4 = 0.125 in the X direction.

The object is scaled from its origin; therefore the
position of the origin is important. The scaling
can also be affected if any of the axes have
been scaled independently of the object (Object
Axis tool, see page 303).

The following picture shows three cubes of size
X 200, Y 100 and Z 50. The first cube is
unchanged in that its origin is still in the center;
the second cube had its origin moved to the left
using the Object Axis tool while the third cube
had its object axes scaled to 0.5, again using the

Object Axis tool. We wish to create four copies,
each with a scaling of 0.5 and a movement of
420 units along the Y axis.

The first cube is scaled towards its center, since
that is the location of its origin. The second
cube’s origin is on the left, so it is scaled towards
the left. The third cube has been scaled twice as
much as the other cubes, due to the previous
manipulation of its object axes.

These three examples demonstrate why it is
important to place the origin correctly and know
the size of the object axes. To be safe, use the
Model tool rather than the Object tool (see
page 301).

Rotation

You can use the Rotation values to rotate the
duplicates about their axes.

The objects are rotated about their origin,
therefore the position of the origin is important.
In the following picture, the first two cubes from
the previous example have been used (origin
central and origin to the left respectively). The
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Heading value has been set to 90° for both
cubes. See page 310 for more details on the
HPB system.

The first cube is rotated about its center, since
that is the location of its origin. The second
cube’s origin is on the left, so it is rotated about
a point to the left. As with scaling, it is
important to position the origin correctly.

Randomize

You can use this command to place a number of
objects in a random fashion. For example, you
can use it to create an asteroid field by letting
CINEMA 4D place the asteroids in random
positions. You can also randomize scale and
rotation. Randomize is especially useful for large
numbers of objects, saving you the time it
would take to position them manually.

Randomize requires an object group to be
selected in the Object manager. Only the first
level of child objects are randomized — all other
children remain with their parents.
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Move

The maximum values by which the objects may
be moved. For example, values of (100,0,0)
allow the objects to move by up to 100 units
from their original positions in the X direction,
but there will be no movement in the Y and Z
directions.

Scale

The maximum values by which the objects may
be scaled. For example, values of (3,1,1) allow
the objects to be scaled by up to three times
their original sizes along the X axis, but there
will be no scaling in the Y and Z directions.

Note

The objects are scaled from their origins,
therefore the position of the origin is important.
The scaling can also be affected if any of the
axes has been scaled independently of the object
using the Object Axis tool. To be safe, use the
Model tool rather than the Object tool (see page
301).

Rotation

The maximum values by which the objects may
be rotated. For example, values of (0°,85°,0°)
allow the objects to be rotated by up to 85°
about the pitch axis, but there will be no
rotation about the heading and bank axes.

Note

Check that none of the objects overlap after
being randomized. This tends to occur when the
original objects are close together before the
Randomize command is used. You may need to
move or rotate such objects manually.

Reset System

This command lets you restore the object
coordinate system. Please check that you
understand the differences between the Object
and Model tools (see page 304) before reading
this section.

Normalize Axes

Resets the lengths of the object axes to 1/1/1.

Align Orthogonally

Resets a distorted system to conventional
perpendicular axes.

Offsets

If the Offsets option is enabled, only the axes
are restored, not the points — the points remain
in their distorted state.

Note

Primitives, light sources and all other non-
polygonal objects can only be partially reset
with the Offsets option, or possibly not reset at
all.
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Reset Sub-Objects

Resets the axes for all child objects as well for
the parent. This function can be difficult to
understand until you see it in action:

Example:

- Create a cube and a sphere. Make the cube a
child of the sphere (drag-and-drop in the
Object manager).

- In the Coordinate manager, ensure that Scale is
selected (middle pop-up menu).

- Select the Object tool and scale the sphere by
2 units in the X direction.

- Select the cube and rotate it about its Z axis.
Note how the cube distorts.

- Now we are ready to see the Reset function in
action. Begin by enabling only the Normalize
Axes option. The sphere and the cube are no
longer distorted.

- Undo the last step.

- Take the cube out of the sphere hierarchy so
that it is no longer a child (drag-and-drop in

the Object manager). The X and the Y axes no
longer form a right angle.

- Now, enable only the Align Orthogonally
option. The cube is straightened out. However,
it has not been restored to its normal size, since
the Normalize Axes option was not enabled.

- Undo the last step.

- Select the cube once more and enable the
Align Orthogonally and Offsets options. This
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time, only the axes are corrected. The object’s
points remain exactly where they were. Transfer

Sometimes it is useful for an object to adopt the
position, scale and/or rotation of another object.
After selecting this command, select which of
these properties you wish to copy to the object.

Note

The axes of the object that is being copied are
used as a reference for the scale. Unlike, say, the
Duplicate command, the axes must be larger or
smaller to bring about a change in scale.
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12 Plug-ins
supplied with your plug-in. If there is no special
information to be found in the documentation, a
plug-in will probably be found in the Plug-ins
menu.

Note

Due to an incompatibility with the C interface,
you cannot add new plug-ins while CINEMA 4D is
running, Instead, quit CINEMA 4D first, then
install the plug-ins. When you next start
CINEMA 4D, the plug-ins will load automatically.

Execute Last Plug-in
Use this menu option to gain quick access to the
plug-in you used last.

Sub-folders
If you have many plug-ins in the Plug-in menu,
things may become rather confusing. So we
allow the creation of sub-folders within the
Plug-in menu structure.

To do this, simply create (using the Macintosh
Finder or Windows Explorer) a sub-folder of any
name within the Plug-in folder and copy the
desired plug-ins into this folder (please take into
account the particular naming conventions of
your operating system).

After restarting CINEMA 4D you will see the
new structure in the Plug-in menu.

Plug-ins are auxiliary modules which extend the
function range of a program. In CINEMA 4D,
plug-ins are able, for example, to automate
particular functions, to make new tools available
(perhaps for modeling or animation), to extend
import and export filters or to add new shaders.

For this purpose CINEMA 4D includes an
efficient programming language, C.O.F.F.E.E.,
available to both developers and end-users.

C.O.F.F.E.E. is a completely object-oriented
programming language whose syntax is closely
related to C++ and Java. Further information on
the development of plug-ins can be found in the
C.O.F.F.E.E. SDK (Software Development Kit) on
our website (www.maxon.net); there you will
also find links to different plug-in vendors.

Note

Plug-ins can be developed freely by anyone and
offered for sale. However, MAXON Computer, as
the manufacturer of CINEMA 4D, has no
influence on the quality of these plug-ins and you
should assure yourself as to the value-for-money
and usefulness of a plug-in before purchase.

Of course, we give as much support as possible
to all vendors and developers of plug-ins —
however, if a problem should arise with one of
these products, please contact the manufacturer
of the plug-in directly. Please understand that
MAXON Computer can give no information on,
or provide technical support for, products from
other manufacturers.

As already mentioned, plug-ins can solve many
diverse tasks and therefore after installation your
new plug-in may appear in different places within
the CINEMA 4D menu structure. Please always
consult the vendor’s documentation that was
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13 Rendering
Render View

Use this function to render the scene in the
active viewport. A render progress bar will
appear in the bottom left corner of the view
panel. To cancel rendering, press ESC or click the
mouse button.

To access the options that control rendering,
choose Render > Render Settings from the main
menu (see page 402).

Note

If you want to save the picture/animation, you
must render to the Picture Viewer instead — see
Render to Picture Viewer, page 400. If an alert
appears when you render, see Render Alerts
above.

Render Active Object

This function renders the active object and its
sub-objects only in the active viewport. All other
objects will be ignored for the rendering. A
render progress bar will appear in the bottom
left corner of the view panel. To cancel
rendering, press ESC or click the mouse button.

To access the options that control rendering,
choose Render > Render Settings from the main
menu (see page 402).

The Render menu contains all the options you
need to render a picture or animation. You can
define several render presets, e.g. for preview
and for final rendering; in this way you do not
have to constantly change lots of settings across
half-a-dozen tabs. Using the render settings,
you can also switch on effects such as radiosity,
caustics and multi-pass rendering.

Render Alerts

Missing textures

If CINEMA 4D is unable to find any textures
when you render, an alert will appear. If you
choose to continue rendering, the materials will
be used without the missing texture maps.

CINEMA 4D searches for textures in the
following locations:

- in the scene’s folder

- in the scene’s 'Tex' folder

- in CINEMA 4D’s 'Tex' folder

- in the Texture Paths (and sub-folders) specified
in the General Settings

Missing solution file for radiosity or caustics

If this alert appears when you render radiosity or
caustics, CINEMA 4D has been unable to find a
solution file in the scene’s 'Illum' folder. To
remedy this, go to the Radiosity and/or Caustics
tab of the render settings. There, enable Save
Solution and set Recompute to First Time or
Always. For more information on using solution
files, see pages 417 and 421.
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Note

If you want to save the picture/animation, you
must render to the Picture Viewer instead — see
Render to Picture Viewer below. If an alert
appears when you render, see Render Alerts,
page 399.

Render Region

Use this function to render a region in a
viewport. Once you have chosen the function,
drag a box in a viewport to define the region. A
render progress bar will appear in the bottom
left corner of the view panel. To cancel
rendering, press ESC or click the mouse button.

To access the options that control rendering,
choose Render > Render Settings from the main
menu (see page 402).

Note

If you want to save the picture/animation, you
must render to the Picture Viewer instead — see
Render to Picture Viewer below. If an alert
appears when you render, see Render Alerts,
page 399.

Render to Picture Viewer

This function renders the scene in the Picture
Viewer. If you want to save the picture/
animation, enter a filename in the Render
Settings dialog (Save page) before you use this
function — see Path, page 408.

Once rendering starts, a progress bar appears at
the bottom left of the window. The bar shows
the time elapsed since the render started. If you
are rendering an animation, the bar also shows
you the current frame number and the total
number of frames. To cancel the rendering,
press ESC.

To access the options that control rendering,
choose Render > Render Settings from the main
menu (see page 402).

Note

If an alert appears when you render, see Render
Alerts, page 399.

Note

The Picture Viewer includes display options such
as the ability to switch off specific color channels
and the ability to change the viewing size. For
information on these options, see page 637.

Batch Rendering

This command enables you to queue up to ten
scenes for rendering. The scenes will be
rendered one after the other automatically.

When you select the command, the Batch
Rendering window opens. Either type the paths
into the text boxes or click the Job buttons one
at a time to choose the folder and file. Once
you have added all the files, click OK to start
rendering

Warning!

Before you batch render, ensure each scene has a
save path in its Render Settings. Also, render
each scene individually as a precaution — you
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can abort each test as soon as the picture starts
to appear. This is to check that no alerts (such as
the missing textures alert) will interrupt batch
rendering.

To cancel the rendering, press ESC.

To access the options that control rendering,
choose Render > Render Settings from the main
menu (see page 402).

Note

If an alert appears when you render, see Render
Alerts, page 399.

Render Settings

A project can have several render settings. This
command opens the active settings (indicated
by a tick on the Render menu). The render
settings are described in detail on page 402.

For details on multiple settings, see New Render
Settings, below.

New Render Settings

You can use this function to create new render
settings. The Render Settings dialog opens.

Enter a name for the new settings in the Name
box on the General page — choose a meaningful
name (e.g. 'modeling') so that the new settings
will be easy to distinguish from any others.

Once you have finished creating the settings,
the new name will appear in the lower section
of the Render menu.

You can create settings for a variety of purposes.
Perhaps you will create settings with low
antialiasing, no reflections and no shadows for
preview rendering called 'Preview'. You may
also create settings with high antialiasing,
reflections and shadows called 'Final Rendering'.
You can create as many settings as you like.

To choose which settings are active, select the
corresponding name from the Render menu. The
active tick will then appear in front of that name.

Note

To add default render settings, create the
settings using New Render Settings , then save
the otherwise empty scene in CINEMA 4D’s
root folder under the name 'template.c4d' (see
Initialisation Files, page 70).
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Delete Render Settings

This function deletes the active render settings
(the active settings are indicated by a tick in the
Render menu). The name of the settings will be
removed from the Render menu.

Flush All Cached Solutions
If you enable Save Solution on the Caustics or
Radiosity pages, files are saved in the scene’s
'Illum' folder so that subsequent renders can
reuse the data. Choose Flush All Cached
Solutions to delete these files.

Render Settings Dialog

General

Name

Enter a name for the settings. This name will
appear in the Render menu so that you can
switch between different settings. Choose a
meaningful name like 'Animation Preview'.

Note

The render settings are saved automatically
when you save the scene.

Antialiasing

Choose the antialiasing mode. More antialiasing
settings are on the Antialiasing page.

Filter

This sets the filter mode for antialiasing. You can
set the filter on the Antialiasing page also — see
page 412 for a description of each filter.
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Transparency

None

If you activate this option, transparency and
alpha channels will not be rendered.

No Refraction

Transparent materials will be rendered without
refraction. If you are working with alpha channels,
use No Refraction — otherwise, the surfaces will
be opaque when rendered.

With Refraction

Select this option if you want transparent
materials to refract. Refraction is essential for
realistic glass and water. Any refraction in the
render will increase the render time. If there is
no refraction in the render, the render time will
not increase, even though this option may be
selected.



404 • RENDERING • CHAPTER 13

Reflection

None

If None is selected, reflections will not be
rendered.

Floor & Sky Only

If Floor & Sky Only is selected, only the floor
and sky objects in the scene will be reflected.
This option is rendered extremely quickly and is
a good compromise for time-critical projects.

All Objects

If you select All Objects, all the objects in the
scene can be reflected. If there are no reflective
objects in the scene, the render time will not
increase, even though this option may be
selected.
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Shadow

None

If None is selected, shadows will not be
rendered. As a result, the scene may lack
contrast and appear flat.

Soft Only

If you have selected Soft Only, soft shadows will
be rendered. Soft shadows render extremely
quickly and look natural — often more natural
than hard shadows, which take longer to render.

All Types

If All Types is activated, soft shadows, hard
shadows and area shadows will be rendered.
Additional rays must be calculated for hard
shadows and area shadows.
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Output

The settings on the Output page refer to
rendering in the Picture Viewer only. These
settings have no effect on rendering in the
viewports. You must render to the Picture
Viewer if you want to save the rendered image.

Resolution

Use this setting to define the size of the image.
Choose the resolution from the pop-up menu or
enter your own values in the two input boxes to
the right. The pop-up menu lists common video
formats.

If you enter custom values, the pop-up menu
setting will automatically change to Manual.
(You do not have to select Manual yourself.)

Film Format

The film format corresponds to an image’s X:Y
ratio. Photographic studios, the movie industry
and the TV industry often use ratios that differ
from that of a computer screen.

Choose the film format from the pop-up menu
or enter your own values in the two input boxes
to the right. The pop-up menu lists common
video formats.

If you enter custom values, the pop-up menu
setting will automatically change to Manual.
(You do not have to select Manual yourself.)

The Resolution and the Film Format settings are
linked. If you change Film Format, Resolution
will be adjusted automatically in the Y direction.

Example:

- Select a resolution of 320 x 240. This is the
same as a computer’s 4:3 ratio.

- Change the film format to 70 mm (cine
format) — the resolution changes to 320 x 145
automatically (it is scaled in the Y dir ection to
match the format).

The default setting for the film format is
Automatic. This means that images will be
rendered in the specified resolution
independently of any particular ratio.

Two lines will appear in the 3D viewport to
frame the area that will be rendered.

See page 441 for a list of common film formats.

Pixel

The two values specified here define the ratio of
a pixel’s on-screen width (left box) to its on-
screen height (right box). The pixel ratio for
most monitors is 1:1, so usually you do not need
to change this setting.

However, some display media use a pixel ratio
other than 1:1 and the setting must be adjusted
to avoid distortions such as circles appearing as
ellipses.

If you need to calculate the pixel ratio manually,
expand the side viewport so that it fills the
entire screen and create a cube. Measure the
cube’s width and height with a ruler and enter
those values in the corresponding input boxes.
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Frame

Manual

If you wish to render a frame sequence, but not
the entire animation, enter the first frame for
the sequence in the left text box and the last
frame in the right box.

The Frame pop-up menu will change to Manual
automatically. (You do not have to select
Manual yourself.) If you wish to save the
animation, you must enter a save path on the
Save page.

Warning!

You cannot interrupt the rendering of an AVI or
QuickTime movie and pick up where you left off
next time. All the frames will be lost and you
must start the rendering from the beginning.
Alternatively, render short sequences and
assemble the clips in a suitable video editor.

Current Frame

If you select this option, only the current frame
will be rendered.

If you wish for the frame to be saved
automatically after it has been rendered, enter
the save path on the Save page.

All Frames

All the frames will be rendered, either as a
picture sequence or as a movie (AVI,
QuickTime).

If you wish for the animation to be saved, you
must enter a save path on the Save page.

Warning!

You cannot interrupt the rendering of an AVI or
QuickTime movie and pick up where you left off
next time. All the frames will be lost and you
must start the rendering from the beginning.

Alternatively, render short sequences and
assemble the clips in a suitable video editor.

Preview Range

Only the preview range (see page 562) will be
rendered. The frames are rendered either as a
picture sequence or as a movie (AVI,
QuickTime).

If you wish for the animation to be saved, you
must enter a save path on the Save page.

Warning!

You cannot interrupt the rendering of an AVI or
QuickTime movie and pick up where you left off
next time. All the frames will be lost and you
must start the rendering from the beginning.
Alternatively, render short sequences and
assemble the clips in a suitable video editor.

Field Rendering

You can obtain smoother animation when
working with video technology by using field
rendering.

With field rendering, each frame is split up into
two fields. The two fields are interlaced, with
one field containing the odd lines (the odd field)
and the next field containing the even lines (the
even field).

PAL video (used in e.g. Europe) runs at 25
frames per second, which equals 50 fields per
second. NTSC video (used in e.g. USA) runs at
30 frames per second, which equals 60 fields
per second.

Do not use field rendering for stills — it is
intended for video output only.

Warning!

There is no point using field rendering unless
you use a non-lossy compressor or no
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compression at all. Lossy compressors (e.g. JPEG,
M-JPEG) blur the fields and the result is far from
satisfactory.

None

Only complete frames are rendered. This option
should be activated without question if you are
rendering stills or movies which will not be
viewed on a video system.

Even Field First

The even field will be rendered before the odd
field. Check which setting your video system
requires.

Odd Field First

The odd field will be rendered before the even
field. Check which setting your video system
requires.

Frame Rate

This is where you set the frame rate for the
render. This setting is independent of the frame
rate defined in the project settings.

The number of frames that will be rendered is
shown to the right of the text box.

Save

Save Image

Enable this option if you want the image to be
saved to the file specified under Path.

Path

Choose the folder and filename so that the
picture/animation can be saved automatically
after rendering.

You can type in the entire path or you can click
on Path to open a system dialog for selecting
the folder.

If you enter a name without a path, the picture/
animation will be saved in the active scene’s
folder.

Format

CINEMA 4D supports a large number of
common picture formats. The still formats
supported are TIFF, TARGA, BMP, PICT, IFF,
JPEG and Photoshop PSD.

The animation formats on offer depend on your
operating system:

Windows:

- AVI Movie Small: the Intel INDEO codec is
used.
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- AVI Movie Big: the Cinepak codec is used.

- AVI Movie: after selecting this for mat, click on
Options to open a dialog. Choose your codec
from the dialog.

Windows and Macintosh:

- QuickTime Movie Small: a special variant of
the Cinepak codec is used. This pr oduces
compact movies of reasonable quality.
However, you cannot play the movie
backwards, nor can you convert the movie into
individual pictur es (the movie is time-
compressed).

- QuickTime Movie Big: a special variant of a
non-lossy codec is used. This pr oduces high-
quality QuickT ime movies, although they are
comparatively lar ge in filesize and r equire a fast
hard drive for playback.

- QuickTime Movie: after selecting this for mat,
click on Options to open a dialog. Choose your
codec from the dialog. If the dialog doesn’ t
open when you click the Options button it
probably means you have an old version of
QuickTime installed. Please check you have the
latest version installed (www .quicktime.com)
before seeking further assistance.

QuickTime 4 upwards supports the following
single picture formats: BMP, Photoshop PSD,
SGI, JPEG, PICT, PNG, TIFF and QuickTime
Image. It also supports any new codecs you
have added to it.

You can create QuickTime VR panorama and
object movies under both Windows and
Macintosh.

Note

If you are using Windows, you must install
QuickTime to take advantage of these features.

Options

You can select this option if you have set Format
to AVI Movie (Windows) or QuickTime Movie
(Windows and Macintosh). A dialog will open so
that you can choose your codec and adjust its
default settings.

If the dialog doesn’t open when you click the
Options button it probably means you have an
old version of QuickTime installed. Please check
you have the latest version installed
(www.quicktime.com) before seeking further
assistance.

Depth

This defines the bit depth per color channel.

Name

Many editing programs accept picture
sequences. Unfortunately, many of these
programs use different naming conventions.

Some programs expect the filename to end with
a number, others an extension. Some programs
can cope only with three-digit numbers.
CINEMA 4D removes this headache by
providing a menu from which you can choose
the sequential numbering and/or lettering style
required by your editor.

0000 represents any sequential number, TIF
represents any three-letter extension.

Name0000.TIF produces e.g. Test1234.JPG
Name0000 produces e.g. Test1234
Name.0000 produces e.g. Test.1234
Name000.TIF produces e.g. Test123.TGA
Name000 produces e.g. Test123
Name.000 produces e.g. Test.123
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DPI

You can use this setting to choose the DPI (dots
per inch) for the following picture formats: BMP,
TIF, PICT. The DPI affects a picture’s print size.

The DPI setting does not affect a picture’s
Resolution (Output tab); the picture’s pixel
dimensions remain the same, only the
calculation regarding how many of those pixels
(dots) should be printed per inch is changed.
This has no effect on how the picture will
appear on a computer monitor or video screen.

Example:

- You render a picture that is 720 x 900 pixels.

- If you save the picture with 72 DPI, the print
size will be 10in x 12.5in (25.4cm x 31.75cm).

- If you save the picture with 300 DPI, the print
size will be 2.4in x 3in (6.1cm x 7.62cm).

- So you divide the pixel dimensions ( Resolution
on the Output page) by the DPI setting to get
the print size in inches; multiply the inches by
2.54 to get the print size in centimetr es.

Alpha Channel

If you enable this option, a pre-multiplied alpha
channel will be calculated during rendering.

The alpha channel is a grayscale image of the
same resolution as your color picture. Pixels in
the alpha channel are either white or black. A
white pixel in the alpha channel indicates the
presence of an object in the corresponding pixel
of the color image. A black pixel in the alpha
channel indicates no object in the corresponding
pixel of the color image.

You can use the alpha channel for compositing
in video programs.

Imagine that you have scanned a photo of an
airfield and you wish to render an aircraft and
place it on the runway. Render the aircraft with an
alpha channel in CINEMA 4D then use that alpha
channel in your compositing program to cut out
the non-aircraft parts of the render so that the
airfield shows though. The edges of the alpha
channel picture are antialiased so that there is a
soft transition in the composited picture.

Pre-multiplied alphas have one particular
shortcoming — please study the image below.

On the left the rendered image, in the middle the alpha
channel and on the right the result

Do you see the dark seam caused by the alpha
channel? This arises because both the picture
and the alpha channel were rendered with
antialiasing. By definition, the color picture and
the alpha channel must be multiplied and so the
black is calculated twice.

You can avoid this dark seam by using the
Straight Alpha option. Note that straight alphas
are suitable only for compositing, they are
unusable as conventional pictures.

Warning!

The entire alpha channel will be masked if you
use a sky, floor, foreground or background object
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in your scene! Do not use any of these objects if
you need the alpha channel.

Alpha channels are integrated automatically for
TARGA, TIFF, PICT, PSD and QuickTime Movie.
If you have activated Separate Alpha or if you
have chosen a different picture format, the
alpha channel is saved separately to the color
picture. These files are indicated by an 'A_'
before the filename, e.g. 'A_room.tif'. Separate
alphas are saved in the TIFF format.

The alpha channel can be integrated into a
movie only if it is supported by the chosen
codec.

Straight Alpha

You can use this option if straight alphas are
supported by your compositing program. This
avoids the dark seam associated with pre-
multiplied alphas. Note that straight alphas are
suitable only for compositing, they cannot be
used as conventional pictures.

On the left the rendered image, in the middle the alpha
channel and on the right the result

Warning!

The entire alpha channel will be masked if you
use a sky, floor, foreground or background object

in your scene! Do not use any of these objects if
you need the alpha channel.

Alpha channels are integrated automatically for
TARGA, TIFF, PICT, PSD and QuickTime Movie.
If you have activated Separate Alpha or if you
have chosen a different picture format, the
alpha channel is saved separately to the color
picture. These files are indicated by an 'A_'
before the filename, e.g. 'A_room.tif'. Separate
alphas are saved in the TIF format.

The alpha channel can be integrated into a
movie only if it is supported by the chosen
codec.

Separate Alpha

Alpha channels are usually integrated into
TARGA, TIFF or PICT pictures — that is, they are
saved as part of the image file. If you wish to
save the alpha channel as a separate file, enable
this option.

In addition to your color picture (e.g. 'room.tif'),
you will also have a file containing the alpha
channel (e.g. 'A_room.tif'). Alpha channels are
always saved in the TIFF format.

24 Bit Dithering

Dithering is a process that adds a random
pattern to colors to prevent color banding.
Although dithering enhances image quality, it
increases file size also. For web graphics in
particular, you may want to disable dithering to
reduce image file size.
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Antialiasing

Antialiasing removes jagged edges from your
images.

Antialising works by breaking down each pixel
into subpixels; rather than calculate just one
color for a pixel, several color values are
calculated and then averaged to produce the
final color for the pixel.

For object edges, a grid of 16x16 subpixels is
used for each pixel. For color edges, you can set
the size of the subpixel grid under Min/Max
Level (you can set values from 1x1 to 16x16).

Increasing the Min/Max Level produces better
antialiasing but also longer render times.

Antialiasing

Select the antialiasing mode from:

None

This switches off antialiasing. Render times are
extremely fast but edges will be too jagged for
final output.

Geometry

This is the default antialiasing mode. It ensures
object edges are smooth when rendered.

Best

This switches on color antialiasing. Color
antialiasing softens color contrasts such as
shadow edges. Object edges are also smoothed.

From left to right: no antialiasing, PAL/NTSC filter, 'Best'
antialiasing

Filter

Choose a filter here to suit your needs. The
antialiasing will be blurred or sharpened
according to your choice. Unless you have
special requirements met by another filter, select
Animation or Still Image.

Still Image

This is the default filter. It ensures sharp edges
and is best suited to still images.
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Animation

This blurs the antialiasing to produce smooth
results for film/video.

Blend

Choose this filter if you want to decide the
softness of the antialiasing yourself. Once you
have chosen Blend, enter a value from 0% to
100% in the Softness text box.

Sinc

Sinc is mathematically the best filter. It produces
better antialiasing than Still Image, but it takes
longer to render.

Area

Area 10%, Area 100%

This filter calculates an area (defined by
Softness) around the current pixel that is used
to calculate the antialiasing.

Cone

Cone 10%, Cone 100%

Cone filter: set the size using Softness. The
antialiasing is of a lower quality than Still Image,
Animation, Blend and Sinc.

Catmull

This produces lower-quality antialiasing than Still
Image, Animation, Blend and Sinc.

PAL/NTSC

This very soft filter is suitable for VHS.

Note

For S-VHS, use the Animation filter.
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Softness

Depending on the filter chosen, you can set a
softness here for the antialiasing. See the entries
for the Blend, Area and Cone filters, above.

Threshold

Neighboring pixels that differ in color by the
Threshold value or more or antialiased.

The default Threshold value is 10%. Depending
on your scene, you may need to lower the
Threshold to about 3%.

Min / Max Level

CINEMA 4D uses adaptive antialiasing — pixels
that need slight antialiasing use the Min Level
Setting; pixels that need strong antialiasing use
the Max Level setting.

The default values for Min and Max level are
1x1 and 4x4 respectively.

Note

If artefacts appear (e.g. small shadows become
absorbed), either reduce the Threshold or
increase the Min Level.

Use Object Properties

If this option is enabled, you can specify the
Min/Max Level and the Threshold separately for
each object using render tags.

MIP Scale

Use this to scale the MIP/SAT strength globally.
For example, a MIP Scale of 200% doubles the
MIP/SAT strength for each material.

Radiosity

Radiosity is controlled from two dialogs. There
are the global radiosity options on the Radiosity
page of the Render Settings. There are also the
individual material Global Illumination settings
on the Illumination page of the Material editor
(see page 518).

For a general discussion on radiosity and an
explanation of the terms used, see OK, so what
exactly is Radiosity? below.

Radiosity

Enable this option to switch on radiosity. The
option is disabled by default.

Strength

This controls the strength of the radiosity effect.
A value of 0% means no radiosity effect. You
can enter values above 100%, but high values
overexpose the scene.

From left to right: low, medium and high strength radiosity.



CHAPTER 13 • RENDERING • 415

Accuracy

This controls the general quality of the radiosity
effect. Aim for a good balance between the best
quality (a shading point for each image pixel)
and the fastest result (a low number of shading
points). You can set values from 0% (least
accurate) to 100% (most accurate).

Left: a poor result with 3% Accuracy; right: a good result with
70% Accuracy

Note:

The radiosity quality is optimized by
Min. Resolution  and Max. Resolution  — see
below.

Prepass Size

When you render a radiosity scene, a prepass
image showing the shading points as dots is
rendered first. This setting defines the ratio of
the prepass image size to the final render size.
The default value is 1/1 — always use 1/1 for
final rendering. Lowering the setting reduces
render time but it also lowers the render quality.

Diffuse Depth

This setting is the number of generations of
stochastic samples to be created. You can enter
values from 1 to 100, but the default of 3 is
efficient for most scenes.

Diffuse Depth of 2

Stochastic Samples

This defines the number of stochastic samples to
be sent out from each shading point. The default
value of 300 is usually more than sufficient.

Stochastic Samples set to 3 for illustrative purposes — for a
realistic radiosity effect, you will need to use a much higher
value, such as the default of 300



416 • RENDERING • CHAPTER 13

Min. Resolution / Max. Resolution

Min. Resolution and Max. Resolution optimize
the Accuracy setting (see Accuracy, above).

Without optimization, an unnecessarily high
number of shading points would be created. For
example, with an Accuracy of 100%, a shading
point would be created for each image pixel.

CINEMA 4D optimizes accuracy by
concentrating shading points where they are
needed most. Min. Resolution sets the number
of shading points for the least important areas,
while Max. Resolution controls the number of
shading points for the most important areas.

The critical areas are always where surfaces
meet each other or where strong contrasts exist.
In the example image below, notice how the
shading points are concentrated where the
sphere curves away from the floor.

The higher you set Min. Resolution and
Max. Resolution, the better the result but also
the longer the render time. Ideally, use the
lowest values that give the required quality.

Left: Max. Resolution set too low; right: a good Max.
Resolution setting

Note

If your rendered image shows radiosity artefacts
such as dark patches, gradually increase Accuracy
and Max. Resolution . Once the values are
sufficiently high, the artefacts should disappear.

Note

To simulate the famous ARNOLD renderer, use
the following settings:

Accuracy = 100%
Prepass Size = None
Diffuse Depth = 2
Stochastic Samples = 16
Min. Resolution = 1
Max. Resolution = 1
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An ARNOLD-style image, copyright Bernd Seeger

Save Solution

If you enable this option, the radiosity data is
saved in the scene’s 'Illum' folder when you
render — the folder will be created if it does not
already exist. Depending on the Recompute
setting (see below), the saved data can be
reused to speed up future renders.

Warning

If you change the scene significantly, make sure
you recompute the radiosity data (set Recompute
to Always). Otherwise, the radiosity effect will be
inaccurate.

Recompute

This controls when CINEMA 4D recomputes
radiosity. Choose from:

First Time

This calculates the scene’s radiosity for the first
render only — future renders will reuse the data.

It works by checking the scene for an 'Illum'
folder each time you render. If there is no such
folder, the folder is created, radiosity is
calculated and the radiosity data is saved in the
folder.

Always

Radiosity data is always recalculated when you
render. This is the default setting since it ensures
a correct effect.

Never

Radiosity is not recalculated when you render.
Instead, CINEMA 4D reuses the data in the
scene’s 'Illum' folder. If this folder does not
exist, an alert will appear. To remedy, set
Recompute to First Time or Always.

OK, so what exactly is Radiosity?

Radiosity is an option you can enable to improve
the photorealism of rendering. It works by
calculating more realistic lighting for your scene.

Copyright Andreas Calmbach

Although radiosity produces better images, it
increases render time as well. For this reason,
radiosity is disabled by default.

To understand radiosity, you need to know the
difference between direct light and indirect light:

- Direct light is light an object r eceives directly
from light sources. If other objects block the
light, the object is in shadow and it r eceives no
direct light.

- Indirect light is light r eflected onto an object by
other objects. In nature, almost all objects
reflect light. It is this r eflected light that gives
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an object its color — an apple is gr een because
it reflects green light.

With conventional raytracing (i.e. with radiosity
disabled), direct light is calculated but indirect
light is ignored. When you enable radiosity, both
direct light and indirect light are calculated for a
more realistic image.

Most of this scene is illuminated by indirect light

Consider the following example where a wall
meets a floor.

In the left image (radiosity disabled), there is no
indirect light at all. In the right image (radiosity
enabled), the white areas show a color tint near
the join (please see the PDF manual on your
CINEMA 4D CD for color images). This is due to
indirect light from the color bands. The white
bands reflect light as well — look closely and
you will see the color bands are bleached near
the join.

Look once more at the wall and floor example
above — the right image is slightly brighter than
the left image. This is because conventional
raytracing calculates direct light only but
radiosity adds indirect light to the direct light.

The next image shows a fantasy creature. Here,
no light source objects were used at all — the
lighting was created solely by the luminous
material on the pedestal.

Copyright Andreas Calmbach

For the next image of the fantasy creature, a
luminous material was again used — this time,
the luminous material was placed on a sky
object.

Copyright Andreas Calmbach
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The Radiosity Algorithm

Radiosity works in a similar way to raytracing.
First, rays are sent from the camera into the
scene.

At each point where a camera ray hits an object
surface, a shading point is created.

Next, a number of special rays, called stochastic
samples, are sent out from each shading point.
The stochastic rays are sent in various directions,
spreading out from each shading point in a
dome shape.

From each point hit by a stochastic sample, a
new dome of stochastic samples is sent out. This
second generation of stochastic samples can in
turn trigger a third wave of stochastic samples.

This chain reaction of events continues with
further generations of stochastic samples
created until a limiting factor has been reached
— as specified in the radiosity settings.

At this point, the various surfaces hit by the
stochastic samples are taken into account to
calculate the indirect light for the shading
points. (The shading points are those points hit
by the camera rays — the points that created
the first generation of stochastic samples.)

Finally, the values for the shading points are
interpolated to calculate the indirect light for
each image pixel.
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Caustics

Caustics are controlled from three dialogs. There
are the global radiosity options on the Radiosity
page of the Render Settings. There are also the
individual material Caustics settings on the
Illumination page of the Material editor (see
page 519) plus the individual Caustics settings
for lights in the Light dialog (see page 209).

Surface Caustics

Enable this option to switch on surface caustics.

Surface caustics — from top to bottom: low Strength; normal
Strength; high Strength

Volume Caustics

Enable this option if you want volume caustics
to be calculated.

Volume caustics with normal Strength (left) and high Strength
(right)

Important

Make sure your caustics light source is volumetric.

Strength

This sets the general brightness of the caustics
effect.

Step Size (Volume Caustics only)

With volume caustics, photons are saved in the
photon tree at regular intervals as defined by
this value.

Keep in mind the photon tree values will be
interpolated later to calculate the effect. For
example, if the volume caustic effect is 100m
long, you might set Step Size to 5m so that 20
different values are saved for each photon.

Note

Lowering the Step Size  increases the accuracy of
the effect, but it increases the render time also.

Note

A lower the Step Size  produces a brighter effect.
This is because more values are saved in the
photon tree for the same distance.
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Sample Radius (Volume Caustics only)

This specifies the distance over which values in
the photon tree are interpolated. Higher values
are usually more realistic, but they take longer
to render.

Note

If you see individual spots/dots in the render, try
increasing the Sample Radius .

Sample Radius set too low — no interpolation means that
individual photons are visible

Samples (Volume Caustics only)

Samples represents the number of photons
within the sample distance that are considered
for the calculation of the volume caustics. As a
general rule, higher values mean a more
accurate effect (but a longer render time also). If
Samples is set too low, individual photons can
be seen — as small dots.

Left: Samples set to 1; right: Samples set to 30

Save Solution

If you enable this option, the caustics data is
saved in the scene’s 'Illum' folder when you
render — the folder will be created if it does not
already exist. Depending on the Recompute
setting (see below), the saved data can be
reused to speed up future renders.

Warning

If you change the scene significantly, make sure
you recompute the caustics data (set Recompute
to Always). Otherwise, the caustics effect will be
inaccurate.

Recompute

This controls when CINEMA 4D recomputes
caustics. Choose from:

First Time

This calculates the scene’s caustics for the first
render only — future renders will reuse the data.

It works by checking the scene for an 'Illum'
folder each time you render. If there is no such
folder, the folder is created, caustics is
calculated, and the caustics data is saved in the
folder.

Always

Caustics data is always recalculated when you
render. This is the default setting since it ensures
a correct effect.

Never

Caustics is not recalculated when you render.
Instead, CINEMA 4D reuses the data in the
scene’s 'Illum' folder. If this folder does not
exist, an alert will appear. To remedy, set
Recompute to First Time or Always.
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OK, so what exactly are Caustics?

Caustics are formed by light that is reflected or
transmitted by a number of specular surfaces
before interacting with a diffuse surface.

The transparent sphere focuses light onto the tile to create a
caustics effect (in this case, a bright spot)

Caustics can be created by transparent surfaces
or by reflective surfaces. The metal ring below
shows a caustics effect generated by a reflective
surface.

CINEMA 4D differentiates between two types of
caustic effects: surface caustics and volume
caustics:

– A surface caustics effect shows up on object
surfaces only — examples are the transparency
sphere and the ring above (in both cases, the
effect shows up on the floor surface).

– Volume caustics are visible as they pass
through 3D space — they do not need a
surface to illuminate. See image below .

The bright ‘tail’ extending from the sphere is a volume caustics
effect

The Surface Caustics Algorithm

For surface caustics, you need:

- A light source to send out photons — enable
surface caustics (on the Caustics tab in the
Light dialog);

- An object with a material that generates
surface caustics — the material must be
transparent and/or reflective. The object must
be curved in a way that focuses light;

- An object to receive the surface caustics.

Caustics are calculated in a very different way to
radiosity and raytracing. Radiosity and
raytracing send rays from the camera into the
scene. With caustics, photons are sent from the
light source into the scene. Each photon is given
a starting energy. A photon’s energy is reduced
as it passes through the scene and is reflected or
refracted by object surfaces.
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A photon refracted by a sphere

When a photon hits a reflective or transparent
surface, the photon is reflected/refracted. The
photon loses some energy in the process and
the material properties are taken into account.
For example, if the surface reflects/refracts blue
light only, the photon’s color changes to blue.
Provided the photon still has energy, it then
continues to fly through the scene.

When the photon hits a surface that is neither
reflective nor transparent, the photon ends its
journey there and its values are saved in a data
structure called a photon tree — later, the values
in the photon tree will be interpolated to
calculate the caustics effect.

Note

You can prevent a material from receiving the
surface caustics effect. Photons that hit such
surfaces end their journey there and their values
are not saved in the photon tree — this prevents
a caustics effect from appearing on the material.

Once all photons have ended their journey in
one way or another, the values in the photon
tree are interpolated to calculate the surface
caustics effect for the image.

Note

Double-caustics are possible. This happens when
an object focuses caustics onto another caustic-
generating object. See the example picture
below.

An example of double-caustics

The Volume Caustics Algorithm

Volume caustics are calculated in a similar way
to surface caustics. First, you need the
following:

- A volumetric light sour ce to send out photons
— enable volume caustics (Caustics tab in the
Light dialog);

- An object with a material that generates
volume caustics — the material must be
transparent and/or reflective. The object must
be curved in a way that focuses light.

When a photon hits a reflective or transparent
surface, the photon is reflected/refracted. The
photon loses some energy in the process and
the material properties are taken into account.
For example, if the surface reflects/refracts
green light only, the photon’s color changes to
green. Provided the photon still has energy, it
then continues to fly through the scene.
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In contrast to surface caustics, with volume
caustics, the photons are saved into a photon
tree at regular intervals.

When the photon hits a surface that is neither
reflective nor transparent, the photon ends its
journey there.

Once all photons have completed their journey,
the values in the photon tree are interpolated to
calculate the volume caustics effect for the
image.

Troubleshooting Caustics

The best settings depend on factors such as the
distance between the light source and the caustics-
generating object. One way to get good results is:

- On the Caustics tab in the Light dialog, set
Energy to a high value (e.g. 100000%) and set
Photons to a low value (e.g. 100). This enables
you to see individual photons as points of light
and helps you decide if enough photons (if any
at all) reach the desired area. If you see no
photons at all, check the following:

Does the light point in the cor rect direction?

Are the caustics options enabled in the Render
Settings (Caustics tab), Light dialog (Caustics
tab) and Material editor (Illumination tab)?

Does the caustics-generating object have a
reflective and/or transparent material?

Do the surface normals of the caustics-
receiving object point in the dir ection of the
light source? (if not, remedy this with the
Reverse Normals command)

- Once you can see the photons, increase the
Photons value (and perhaps the Energy) until
you achieve a good caustics effect. To fine-
tune the sharpness, adjust Sample Radius and
Samples on the Illumination tab (Material
editor).

Effects

This tab controls which post effects are
rendered. To choose a post effect, click the Post
Effect button (top right of dialog) and pick the
desired effect from the drop down list.

There are two commands on this list for
removing effects: Remove Selected and Remove
All. To increase the selection, Ctrl-click or Shift-
click on the name of an effect in the scrolling
range. Note also that you can enable/disable
effects in the scrolling range using the check
boxes.

Note

The order of the post effects in the scrolling
region is important. For example, if you sharpen
before you soften, the result is different to
softening first.

Depth of Field

If this option is enabled, depth of field will be
rendered if it is used by any of the cameras. You
may wish to switch off depth of field for
preview rendering. This is a post-processing
effect, it will not be visible until after the image
has been fully rendered.
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Lens Effects

If this option is enabled, lens effects (see Lens
Effects, page 218) will be rendered if they are
used in your scene. You may wish to switch off
lens effects for preview rendering. This is a post-
processing effect, it will not be visible until after
the image has been fully rendered.

Object Glow

If this option is activated, glow effects (see Glow
Editor, page 221) will be rendered if they are
used in your scene. This is a post-processing
effect, it will not be visible until after the image
has been fully rendered.

Note

Glow effects are post processed effects, they are
applied only after the picture is fully rendered;
so you cannot see glow effects in reflections or
through transparent objects.

Color Correction

Use this to change the gamma, contrast and
brightness of the image to be rendered.

Soft Filter

Each pixel is balanced with its neighbor to yield
a softer transition. Use Strength to increase or
decrease the effect.

Sharpen Filter

This filter emphasizes transitions in the picture.
This reinforces the edges. Use Strength to
increase or decrease the effect. Try using the
filter with 30% strength for stills.

Median Filter

This rids your image of unflattering peaks in
pixel color values. Use Strength to increase or
decrease the effect.

Remote

Here, specify an application for the rendered
picture/animation to be passed on to. For
example, you can redirect animation frames to a
video editing program for post-editing.

If you are using Windows, you can use a batch
file with command parameters. If you are using
a Macintosh, use AppleScript.

Click on Remote to open a system dialog so that
you can select the program.

Comic Renderer

This enables you to render in a cartoon style.

Color

If this option is disabled, objects will usually be
rendered with black outlines on a white
background.
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When Color is enabled, all objects will be
rendered using a reduced color palette and black
outlines on a black background. This gives the
rendered subjects a cartoon-like feel.

Note

The render time increases linearly with the
number of polygons, even though the mode is
heavily optimized.

Illumination

If this option is enabled, the shading of objects
will be affected by the illumination. Shadows
will also be rendered cartoon-style.

If Illumination is disabled, the average color
value of the top texture layer (the right-most
texture in the Object manager) will be used to

render the objects. As a result, each object has a
monotone color. Also, shadows will not be
rendered with the option disabled.

Note

This option has an effect only when Color  is
enabled.

Outline

When enabled, this option will draw an outline
around the silhouette of objects. If both the
Color option and the Outline option are
disabled, all you will see the background color!
With Color enabled, the outline will bring out
the individual objects and give them a cartoon-
like feel.

Note

The outline is drawn around the silhouette of
individual objects only. For example, if you have
connected an object group to form an individual
object, only the overall silhouette will be
outlined. You can change the color of the outline
using Edge Color .
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Edges

If this option is enabled, all polygon edges will
be outlined in black, creating a shaded
wireframe feel. You can change the color of the
edges using Edge Color.

Edge Color

Use this to change the color used by Outline
and Edges — even if the Color option is
disabled.

Background Color

This changes the background color when Color
is disabled. When Color is enabled, the option
has no effect.

Scene Motion Blur

With a real-life camera, motion blur arises when
an object flies past the camera at great speed
(object motion blur) or when the camera pans
rapidly (scene motion blur). This motion blur
helps to create the illusion of real motion rather
than a sequence of still pictures and so it is of
great use to animation software. Animation
software does not use real shutters and real film,
so the motion blur must be faked.
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You can activate Scene Motion Blur (SMB) to
simulate a camera panning swiftly. With SMB,
intermediate images are calculated and
overlapped in the corresponding frame with
varying brightness.

Choose the number of intermediate images for
each frame using the pop-up menu. The higher
you set this value, the longer it takes to render.

Note

Scene motion blur will also blur shadows,
reflections and so on. Object motion blur, on the
other hand, does not blur these things.

If the motion is very rapid, you may need to use
a high setting to avoid a stroboscope effect (see
illustration below).

Scene motion blur is coupled with oversampling.
For example, 5-times SMB corresponds to at
least 2x2 Always antialiasing. In the same way,
9-times SMB corresponds to 3x3 Always
antialiasing and 16-times SMB to 4x4 Always
antialiasing.

Stationary elements in the frame are antialiased
perfectly, whereas moving elements are not
antialiased. Usually, objects in motion do not
require antialiasing — consider a 16-times
motion blur where there are 16 intermediate
frames; in this case, the missing antialiasing
makes no visible difference. You can, of course,
add antialiasing, although with a motion blur of
9-times or higher it is not necessary and does
little but increase the rendering time.

You can enter the strength of the motion blue in
the Strength box. The following pictures were
rendered with 25-times SMB with Strength set
to (from left to right) 20%, 40%, 60%, 80%
and 100%.

Warning!

Think carefully before using field rendering and
scene motion blur together, since the field effect is
often nullified. Not only that, but the quality of
the automatic SMB antialiasing is better without
fields, and you will save render time to boot!
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Dithering

You can use this option to dither the scene
motion blur. This helps you to avoid stroboscope
effects and you can often use a lower SMB
setting as well. The dithering may create a slight
noise, though. You can reduce the memory
requirements for rendering by deselecting
dithering (set the value to 0%).

Object Motion Blur

The advantages of object motion blur (OMB)
are that the effect is rendered quickly and there
are no stroboscope effects. For an object to
have motion blur in the render, this setting must
be activated and the object must have a motion
blur tag (see page 461).

Please note that this is a post-processing effect
— it will not be visible until after the normal
image has been rendered.

Note

Use scene motion blur if you wish to blur
shadows, reflections and so on. Object motion
blur does not blur these features.

Use the Object Motion Blur value to define the
intensity of the blur for all objects. The value
can range from 0% to 200%.

There a few limitations associated with object
motion blur. For example, only position, scale
and rotation animation can be blurred (so a
beating wing animated using bones cannot have
motion blur applied to it). Also, anomalies may
appear at the frame’s border and the animation
may flicker.

Object motion blur is limited to a maximum
frame size of 2000 x 2000 pixels and is
automatically disabled at resolutions higher than
this.

Also note that particles (see Particle System,
page 235) cannot be blurred. Furthermore,
avoid using OMB with post-processing effects
(e.g. lens flares), since this may lead to
unexpected results.

These limitations notwithstanding, motion blur
can create a very natural effect with its
analytical blurring. Object motion blur can
create superb results with stills and well as with
animation.
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Options

Active Object Only

When this option is enabled only the active
object (the currently selected one) will be
rendered in the Picture Viewer.

Auto Light

If there are no lights in your scene CINEMA 4D
will use the auto light (a standard light source)
when rendering so that you can at least see the
objects.

Log File

If this option is enabled the render log will be
recorded in 'Renderlog.txt' in the CINEMA 4D
folder.

The render log contains a complete history of
the render process including system resource
information. Check this log if you need to
identify problems that occurred while rendering.

The information in the log file is not overwritten
by subsequent renders. Rather, new log
information is appended. As a result, this file can
grow to a fair size over time. You may wish to
delete the file manually every now and then —

a new file will be created the next time the log is
recorded. (You will not confuse CINEMA 4D by
deleting the file.)

Textures

With this function you can enable or disable
textures when rendering. So, for example, you
can disable the textures for a test render or
when using the Comic Renderer.

If this option is enabled, textures will be
rendered. If Textures is disabled, the average
color value of the top texture layer (the right-
most texture in the Object manager) will be
rendered. 

Cancel if Texture Error

If CINEMA 4D cannot find a texture when
rendering the scene, an alert dialog will appear.
If this option is not enabled and you confirm the
alert, the rendering continues without the
missing texture.

If you enable this option, rendering will be
cancelled after the alert. If you are rendering
several scenes (batch rendering), the next render
task will be started.

Blurry Effects

Use this option to enable/disable the blur effect
for the Reflection and Transparency material
channels.

Volumetric Lighting

Enable this if you want shadows to be cast in
visible light. Since the effect is processor-
intensive, you may want to speed up test-
renders by disabling the option.
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Ray Depth

The Ray Depth value determines how many
transparent objects (or areas made invisible
using the alpha channel) can be penetrated by
the renderer. The lower you set the ray depth,
the fewer the number of objects that can be
seen through. Those areas that cannot be
penetrated are rendered black.

A ray depth of 1 means that calculations are
finished for that pixel once a ray hits something
in the scene. Transparencies and alphas
therefore will not be visible.

A value of 2 means that after a ray has hit a
surface a second ray is calculated for the
transparency.

The higher the ray depth, the further rays are
followed into the scene and the results rendered.

The scenes below contain transparencies and
alphas and have been rendered with ray depths
of 2, 4 and 8.

Reflection Depth

When a ray is sent into the scene, it can be
reflected by reflective surfaces. With certain
arrangements, e.g. two mirrors opposite each
other, it is possible that a ray will be reflected
forever, trapped between the mirrors, and the
raytracer would never finish rendering the
picture. In order to prevent this, you can set the
maximum number of reflected rays.

You can also use Reflection Depth to limit the
render time for the picture. Often, only the first
generation of reflection is important. Further
rays tend to add very little to the image quality
but increase the render time considerably.

A reflection depth of 1 means that calculations
for a pixel are finished once a ray hits something
in the scene. Reflections therefore will not be
visible.

A value of 2 means that after a ray has hit a
surface a second ray is calculated for the
reflection.

The higher the reflection depth, the further rays
are followed into the scene and the results
rendered.

The following scenes contain reflective objects and
have been rendered with reflection depths of 2, 4
and 8.
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Shadow Depth

Calculations are made to see if a surface point
lies in the shadow of another object; additional
shadow rays are sent from the surface in the
direction of the light source.

The value you enter for this setting determines
for which generation of rays shadows are
calculated. For example, if you reduce the value
to 2, shadows will not be rendered for reflected,
transparent or refracted rays.

The following scenes contain reflective and
transparent objects and have been rendered
with shadow depths of 2, 4 and 8

Threshold

This value helps to optimize render time. With
complex scenes, particularly those containing
many reflective and transparent surfaces, 90%
of the processed rays contribute less than 10%
to the general picture brightness and color. With
a threshold value of, for instance, 15%, the rays
stop their movement from the camera into the
scene as soon as their brightness falls below this
critical value.

What exactly does this mean?

When a ray hits a surface, the values for
transparency and reflection are calculated. If, for
example, the threshold is set to 15% and the
surface has a material with 10% reflection
(Brightness slider), the material will not reflect.
In order to render the reflection in this case, the
threshold must be lowered to 9% or below, or
the reflection of the material must be raised to
16% or above.

Sometimes it is useful to increase the threshold
to prevent minor details being reflected.
Although minor details are calculated correctly,
too much detail in reflections can distract the
viewer. However, if you wish to calculate all
rays, set the threshold to 0%.

Level of Detail

This value influences all objects in the active
scene that support a reduction in detail, such as
metaballs, primitives and NURBS. However, any
objects that have their own Level of Detail
setting (see Display Tag, page 463) will continue
to use their setting.

If the value is set to 100%, the objects will be
rendered with full detail. If the value is set to
50%, the objects will be rendered with only half
their usual detail.

Note

If you render to a viewport, its level of detail
value (Display menu) will be used in preference.
It is only when you render to the Picture Viewer
that the value in the render settings is used.



CHAPTER 13 • RENDERING • 433

Multi-Pass

Multi-pass rendering saves your render into
layers for easy post-editing of shadows,
reflections, highlights and so on in compositing
programs like After Effects and Combustion. You
can save the layers in RLA, RPF, Photoshop
(PSD) and BodyPaint 3D (B3D) format.

Image properties such as reflection, shadow and
specular can be saved as separate layers or
combined freely as blended layers.

You can create separate layers for each light
source. Among other things, this makes it
possible for you to render alternative light
setups in the same file --- when you post-edit,
keep the best setup and delete the other layers.

Note

It is quicker for you to render light setup
alternatives as layers rather than as separate
projects.

Enable Multi-Pass Rendering

Use this option to enable or disable multi-pass
rendering.

Channels/Selection List

Ambient and Specular in the selection list

The selection list shows the layers to be included
in the multi-layer rendering. Use the Channels
drop down list to add layers to or remove layers
from the selection list. The items on the
Channels drop down list are:

Add Image Layers

Adds all image layers to the selection list. These
layers are:

Ambient, Diffuse, Specular, Shadow, Reflection,
Transparency, Radiosity, Caustics, Atmosphere,
Atmosphere (Multiply).

Add Material Layers

This command is useful to plug-in developers
only.

Add All

This command is useful to plug-in developers
only.

Remove Selected

Removes the selected layers from the list.

Note

To select a layer, click on its name in the
selection list. To increase the selection, Shift-
click or Ctrl-click.
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Remove All

Empties the selection list.

Blend Channel

Creates a blended layer. For example, you can
blend Shadow, Radiosity and Caustics as a single
layer.

After choosing the Blend Channel command,
the following dialog opens:

Enable the channels you want to blend, then
click OK.

Object Buffer

This creates a mask layer for objects that use a
specified ID number in their render tags. The
Object Buffer dialog opens:

Enter the ID number, then click OK.

Note

To give an ID to an object, use a render tag.

In this example, the sphere appears in both object buffers
because its render tag has two IDs (ID=1 and ID=2)

RGBA Image

Adds a layer for the complete RGB image. An
alpha masked will be included also if an alpha
channel option is enabled on the Save tab
(Render Settings dialog) — ensure also that your
chosen save Format supports the alpha channel.
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Ambient

Adds a layer showing the illumination generated
by your scene’s environment object.

Diffuse

Adds a layer for diffuse color.

Specular

Adds a layer for specular information.

Shadow

Adds a layer for shadows.

Reflection

Adds a layer for reflections.
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Transparency

Adds a layer for transparency.

Radiosity

Adds a layer for radiosity.

Caustics

Adds a layer for caustics.

Atmosphere

No fog, no visible lights for the example, so a totally black
layer.

Adds a layer for environment fog and volumetric
effects such as volumetric light.
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Atmosphere (Multiply)

To be used optionally with Atmosphere, above,
— adds a multiplied atmosphere layer to help
conceal the objects behind the volume effects.

Material Channels

All items with the 'Material' prefix are for plug-
in developers only.

Illumination

Adds a layer for the color and brightness of light
falling on surfaces.

Depth

Adds a depth map — object surfaces are shaded
in grayscale according to their distance from the
camera. The closer a surface is to the camera,
the darker its shading.

Save Multi-Pass Image

Enable this option if you want the multi-pass
image to be saved when you render.

Note

You can view the layers in the Picture Viewer
using the Channels menu.

Multi-Layer File

Enable this option if you want the layers to be
saved as a single layered file. Also, ensure
Format (see below) is set to RLA, RPF, PSD or
B3D.

If the option is disabled, each layer will be saved
as a separate file.

Separate Lights / Mode

Each light source can have its own layer or
layers for Diffuse, Specular and Shadow.

Use Mode to control how the diffuse, specular
and shadow information is layered for each light
source:

- Channel: Diffuse+Specular+Shadow — adds
one blended layer for Dif fuse, Specular and
Shadow.

- Channels: Diffuse+Specular,Shadow — adds
one blended layer for Dif fuse and Specular,
one layer for Shadow.

- Channels: Diffuse,Specular,Shadow — adds
one Diffuse layer, one Specular layer, one
Shadow layer.

Use Separate Lights to choose which light
sources have separate layering:

None

No separate layers

All

Separate layering for each light source in the
scene

Selected

Separate layering for each light source that has
Separate Pass enabled on its Details tab.
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Path

This is where you set the save path for the file.

Note

Multi-layer files soon fill up storage space ---
especially animation files. Ensure you have
sufficient free space before rendering.

Format

Here, choose the file format. For a multi-layer
file, choose RLA, RPF, PSD or B3D.

Options

If this button is unghosted, click it to access
options for the file format specified under
Format.

Depth

Use this to set the channel depth to 8 bits or 16
bits.

Layer Name as Suffix

If your chosen format (see above) does not
support multi-layers, this option adds the layer
name as a suffix for each file.

Quicktime VR

You can use the options on this tab to create
your own QuickTime VR panoramas and
QuickTime VR object movies. Perhaps you have
already seen this technology in use (e.g. the
‘Star Trek Technical Guide’).

QuickTimeVR technology combines the frames
of a 360° horizontal pan in such a seamless
fashion that you can freely move around in the
virtual scene that is created. You can even zoom
in and out.

It is possible to create these images using real
photos. However, the images must be of the
highest quality and positioned exactly, otherwise
the result is distorted.

This is painstaking work and it requires an
expensive, high-precision camera for good results.

Unless, of course, you create the scene in
CINEMA 4D and let the program do the hard
work of creating the QuickTimeVR film for you.

Some terminology

A panorama is a 360° all-round view of the
environment as seen from the camera. The
QuickTimeVR movie lets the viewer spin around
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his or her own axis, looking around the
panorama freely. The camera can even tilt up
and down.

The rings in the panorama are usually between
10° (36 steps) and 30° (12 steps) apart. The
more steps there are, the smoother the
transition will be. If you wish for the viewer to
be able to tilt the view, several rings must be
rendered. So you need seven rings for full tilting
at 30° intervals (one at 90°, 60°, 30°, 0°, -30°, -
60° and -90°).

A QuickTime VR object movie enables you to
rotate an object interactively using the mouse.
For a smooth object movie, try 36 horizontal
steps from 0° to 360° and 19 vertical steps from
90° to -90°. This gives you good coverage of
the object and allows free rotation.

Note

Lens effects cannot be used with QuickTimeVR
movies.

Horizontal Settings

Here you can use Steps to specify the number of
frames for a single ring. You can also set the
range of the camera pan or rotation using Start
Angle and End Angle. The normal settings are
36 steps, a start angle of 0° and an end angle of
360°.

Vertical Settings

Here, Steps specifies the number of rings. A value
of 1 is sufficient for a simple panorama or simple
object rotation. However, if the viewer should be
able to tilt the view, use more rings. Usually, an
odd value is best, since it generates as many rings
above the horizon ring as below it.

To specify the tilting range, enter values in the
Start Angle and End Angle boxes. The
maximum range is -90° to +90°.

Note

There are two built-in resolutions for QuickTime
VR on the Resolution pop-up menu (Output tab):
1248 x 384 QTVR and 2048 x 768 QTVR. Choose
Automatic for the film format. You can type in
your own resolution using the text boxes to the
right of the Resolution pop-up menu. Ensure that
the values you enter are divisible by 4.

Generate File

VR Movie

CINEMA 4D creates a ready-to-view QuickTime
VR panorama or object movie which you can view
in QuickTime as soon as it has been rendered.
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Intermediate Files

CINEMA 4D creates a panoramic picture or
individual object film pictures which you can, say,
edit further using Apple’s QuickTime VR tools.

Both

CINEMA 4D creates a ready-to-view QuickTime
VR film as well as a panoramic picture or individual
object film pictures which you can process further
using Apple’s QuickTime VR tools.

X / Y Default Resolution

With X/Y Default Resolution you can define the
output resolution of the QuickTime VR movie
that you want to render. The default value is
320x240 pixels.

The resolution of the original material from
which the QuickTime VR movie is finally
rendered is defined by the Resolution setting on
the Output page (see page 406).

Apple recommends:

These are Apple’s recommended settings (from
‘The QuickTime FAQ’):

- Use focal lengths of 15mm, 28mm or 35mm.

- Do not use fish-eye lenses.

- For interior shots, use a 15mm lens. This gives
you a vertical visibility range of 97 °.

- Use a 15mm lens. This lets you r educe the
number of shots in one pan to 12.

- If you are using 35mm lenses, create additional
rings for the view upward and downward.

- For determining the number of frames in a
horizontal ring, two adjacent frames should
overlap by 30% to 50%.

Note

For a QuickTime Object Movie, place the object
at 0,0,0 (world coordinates) and ensure the
object is active in the Object manager.

If Generate is set to VR or Both, you will create a
QuickTime Movie of all frames in the sequence.

Note

When you render QTVR panoramas and QTVR
movies, the following limitations apply with
regard to antialiasing:

- the Max Level parameter determines the
maximum antialiasing for colors and edges.

- the Max Level cannot be exceeded, even if
higher settings are specified in render tags.
Render tags work within the Min Level to Max
Level range only.

- the render time depends heavily on the Max
Level setting. For this reason, avoid using a
setting higher than 4x4.
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Movie Formats
Common movie formats are listed below.

Computer playback:

Resolution Description Film Format Pixel (X to 1) Frame Rate Fields

160x120 draft

320x240 NTSC MPEG1 4:3 1 (29.97) (even lower)

348x288 PAL MPEG1 4:3 1 (25) (odd upper)

TV playback (video):

Resolution Description Film Format Pixel (X to 1) Frame Rate Fields

640x480 NTSC 4:3 1 29.97 even

720x486 D1 NTSC 4:3 0.9 29.97 odd

768x576 PAL 4:3 1 25 odd

720x576 D1 PAL 4:3 1.067 25 odd

1920x1080 HDVS 1080I 16:9 1 24, 25, 30 none, odd,
even

Film playback:

Resolution Description Film Format Pixel (X to 1) Frame Rate Fields

1920x1080 HDVS 24P 16:9 1 24 none

1800x972 WIDESCREEN 1:1.85 1 24 none

2048x872 SCOPE 2.35:1 1 24 none

2048x1536 SCOPE ANAMORPH 8:3 2 24 none

Sources: Filmwerk, ARD — Technical Guidelines, Sony HDVS, Kodak Cinesite and Gürtler — Film Transfer Department.
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14. Window Menu   
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14 Window Menu
Load Layout

If you have set up your working environment to
your satisfaction and saved it (as a ‘.l4d’ file),
you can reload that configuration with this
command.

Reset Layout

This command resets your CINEMA 4D layout
to the original, preset layout. This is particularly
useful if you need to call our support team since
you and they then have a common interface
from which to work. Your own customized
layouts can increase your workflow enormously
but when searching for an elusive problem a
common, standardized layout is essential.

Save as Default Layout

Use this to save the visible working environment
as the default layout (‘layout.l4d’). When you
next start CINEMA 4D this is the layout that will
be used.

Note

In the General Settings you can choose to save
the layout automatically when quitting the
program. However, if you have slaved for hours
creating the perfect working environment and
want to be sure that the layout is saved
immediately, you should use Save as Default
Layout. After all, power cuts have an uncanny
knack of happening when you have not saved
your work!

Most of the following menu entries activate a
window or a manager. If the particular window
or manager is already present in the layout, but
not in the foreground, the call will cause it to
come to the front. If the selected item is not in
the layout or if an additional view panel, icon
palette or status bar is opened, this appears first
in a new window. With the drawing pin (see
page 42) this window can then be placed
elsewhere within the layout.

Layout
Under this menu entry are some functions that
allow you to modify your work environment to
suit your own preference. More information on
this can be found in Workflow, page 59.

New Icon Palette

This opens a new, empty icon palette in its own
window. You can then populate this palette with
icons from the Command manager (see
page 39).

Edit Palettes

If you choose this command, the Edit Palettes
mode is activated and the Command manager
opens. The icons are surrounded by blue frames,
indicating that you may edit them — e.g. you
can drag icons from the Command manager and
drop them onto any of the palettes.

There are two ways to exit the Edit Palettes
mode — either close the Command manager or
disable this option.
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Save Layout as

This command lets you save your layout under
its own name so that you can create as many
named setups as you need; e.g. one layout for
modeling and one for texturing. Layout files
should have the extension ‘.l4d’.

Default Layouts

So that you can access different layouts quickly,
all the ‘.l4d’ layout names that are present in the
‘CINEMA 4D/Prefs’ folder will be listed here.

New View Panel
CINEMA 4D allows you to open as many
viewports on a scene as you want (see Views
and Viewports, page 15). This is where you
create a new view panel; when it first appears it
uses the standard 3D viewport. Each view panel
can contain up to four viewports.

Object Manager

This opens the Object manager. In this manager
you can activate an object (even if it is not
visible in a viewport), change the object
hierarchy and manipulate the various properties
of the objects. The Object manager is described
in detail on page 461.

Material Manager

This opens the Material manager which holds all
the materials and textures present in a scene
and also shows material previews. You can
assign a material to an object using drag-and-
drop; simply drag the material onto the name of
the appropriate object in the Object manager, or
drag it onto an object in a viewport.

The Material manager is described in detail on
page 487 while the different texture projections
are discussed on page 539.

Time Line

Choose this to open the Time Line – the control
center for animation in CINEMA 4D.

The Time Line is described in detail in Chapter
19, page 557.
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Picture Viewer

This opens the Picture Viewer (also known as
the Picture manager). When you perform a final
render, the picture appears in this output
window instead of in the viewport. You can
view image files (e.g. textures) directly in this
window and you are even able to convert them
to other formats.

Multi-Pass Manager
Opens the Multi-Pass manager. For details on
multi-pass rendering, see page 433.

Coordinate Manager

Use this to open the Coordinate manager. This is
a universal tool for the numeric manipulation of
elements within your scene. The Coordinate
manager is described in detail on page 457.

Structure Manager

Opens the Structure manager. The Structure
manager shows how an object is constructed
out of points and polygons and enables you to
edit this structure. You can work numerically on
all individual points and surfaces of an object,
even on its UVW coordinates.

The Structure manager is described in detail on
page 627.
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Browser

Here you open the Browser. The Browser is an
enormously powerful tool for the administration
of your project data and libraries. Whole folders
can be scanned to create a catalog and can be
saved with a preview as well as with further
information. Instead of searching long and hard
in the murky depths of your hard disk, use the
Browser to get your chosen textures, objects or
scenes with just a few mouse clicks.

The Browser is described in detail on page 61.

Global Status Bar
This opens the Global Status Bar, which displays
information such as the render time.

Active Tool Manager
The more complex tools (for example, the
selection tools) within CINEMA 4D have various
parameters (such as the radius of selection)
which are shown in the Active Tool window;
here you can also adjust them as necessary.

The adjustable parameters are described within
the appropriate chapters for the individual tools.

Selection Info

This function opens an information window
which gives immediate information about the
selected object. Here the number of points,
polygons and spline segments are shown.

Note

Only selected polygonal objects, splines or
Bézier NURBS will have information shown in
this window. The Selection Info window remains
empty for an active parametric object, a modifier
or other such objects; these usually have their
own parameter boxes.

Structure Info

This opens a window that gives you information
about the structure of the selected object. In
addition, you can use the ‘+’ and ‘-’ buttons to
select or deselect the different parts of the
structure, e.g. all the quadrangles.
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Note

Only polygonal objects or splines can have their
structure shown in this window. If you have
selected a parametric object, a modifier or other
such object, the Structure Info window remains
empty.

Snap Settings

This opens the dialog for changing the snap
tools. This is where you choose whether objects
move freely or snap to various points, surfaces
etc. while modeling. Snap is a very powerful
construction tool.

You will find more information on using the
snap settings on page 375.

Console
The Console window is used for the output and
control of C.O.F.F.E.E. programs. C.O.F.F.E.E.
print commands are displayed here, as are any
errors. In the case of errors, the number and
program position are shown.

Command Manager

This function opens the Command manager
which contains a list of all the functions and
commands that exist in CINEMA 4D, including
the various icons and keyboard shortcuts. Here
you can arrange your own icon palettes or
change the shortcuts to suit your own needs.

There is a more detailed description of the
Command manager on page 39.
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Menu Manager

You can use this manager to rearrange
CINEMA 4D’s menu structure. The use of the
manager is self-explanatory. If you get in a
tangle, you can restore the structure with the
Revert to Original button.

Other Scene Windows
CINEMA 4D is able to hold several scenes in
memory at the same time. At the bottom of the
Window menu you will find a list of all the
currently open scenes, enabling you to switch
quickly between them. The sequence in the
menu corresponds to the order in which the
scenes were opened.
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15. Help Menu   
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15 Help Menu

Help (CINEMA 4D)
This opens the online manual copied to your
hard drive during the standard installation
process.

MAXON Online
This menu item will open the MAXON website
homepage provided that you have an Internet
browser installed and an Internet connection.
The MAXON website is the place to visit for the
latest CINEMA 4D information as well as service
updates.

Personalize
This opens the Registration dialog so you can
enter your final serial number. You will receive
your final serial number once you have returned
your registration form to Maxon Computer or to
your local Maxon Computer distributor.

Warning

Your initial CINEMA 4D serial number will expire
after six months of use, after which you will no
longer be able to use the program. Please send in
your registration form as soon as possible.

Info
This opens the same info screen that appears while
the program loads. Use this screen to check the
version number of CINEMA 4D — please quote
this number when you contact technical support.
To close the window, click on it.
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16. Coordinate Manager   
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16 Coordinate Manager
The size or scale is also specified in world
coordinates, although along the local axes. For
example, if a cube with a side length of 100 lies
askew in 3D space, it still has a size of 100 units
in world coordinates.

You can also enter relative values. CINEMA 4D
has a parser which enables you to include
mathematical operators. For example, you can
append +100 to an existing position value. The
active element will then move 100 units relative
to its initial position. CINEMA 4D supports many
other functions — see the Appendices for a
complete list of valid operators, functions and
constants.

As previously mentioned, the type of information
displayed in the Coordinate manager depends on
the active tool. For example, if the camera tool is
active, you can enter the focal length for the lens
instead of its size.

Some values must be entered as relative ones,
e.g. for the rotation of points. This is because
points do not have their own coordinate system,
so the program cannot keep track of previous
rotations.

Note that you may be changing the axes of sub-
objects unintentionally when you change the
axes of the parent.

Try to avoid using world coordinates for
animated rotation. CINEMA 4D converts all
world coordinates into local coordinates, which
can lead to unexpected behavior if you do not
use local coordinates in the first place.

The Coordinate manager allows you to
manipulate objects numerically. It displays
information relating to the tool you are using.

For example, if you are using the move tool, the
position, size and rotation values of the active
element are shown.

Once you have made changes to the values you
can update the element by clicking on Apply.

You can use the pop-up menu at the bottom left
to determine how the values are interpreted. If
the menu is set to Object, all the values relate to
the object’s (immediate) parent system. If the
menu is set to World, the position and rotation
values are converted into world coordinates.

The rotation values always use the HPB System
(see page 311).

The pop-up menu below the middle coordinates
column specifies which object size is shown. Size
shows the size of the object (not including sub-
objects). Size+, on the other hand, shows the
size of the active object including all sub-
objects. Scale shows the axis length for each
axis of the object coordinate system — the
default values are 1/1/1.
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17. Object Manager   
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17 Object Manager
You can collapse and open hierarchies, just as
you can on your computer desktop. You can use
drag-and-drop to re-group or copy objects. You
can identify an object’s type (e.g. HyperNURBS)
by its icon. Objects are discussed in Objects
Menu on page 95.

The narrow column running down the center of
the Object manager contains up to three
visibility switches for each object. These
switches are described in detail later in this
chapter.

To the right of the switches are the object tags
(e.g. texture tag, smoothing tag). You can use
drag-and-drop to move or copy these tags to
other objects. Again, the tags are described in
detail later in this chapter.

You can use context menus in the Object
manager. To do this, click the right mouse
button within the manager (Macintosh: hold
down the Command key and click the mouse
button to simulate the right mouse button).

When you select a command in the Object
manager, it is applied to the active object.

Drag-and-drop in the Object Manager

Drag-and-drop is the technique of clicking on an
object, holding down the mouse button and
dragging the object to another position; when
the target location is reached, you release the
mouse button and this will drop the object
there. Depending on the target location, this
may have different results.

The Object manager is the center of object
administration in CINEMA 4D. You can use it to
activate objects, change object hierarchies or
manipulate tags. On the left side of the
manager is a list of all the objects in the scene.
Hierarchies are shown as a tree structure.
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To Re-arrange Objects in the Object Manager

There are many ways that you re-arrange
objects in the Object manager and these are
described below. The icon on the left shows
what the mouse pointer will look like while you
are doing the action described on the right.

Drag an object between two others or to
the end of the list.

If you wish to move a duplicate, rather
than the original, use Ctrl-drag.

To change the object hierarchy, drag the
object on top of an existing one in the list.
This makes the dragged object a child of
the other.

If you wish to create a duplicate and
make it a child of another object, use Ctrl-
drag and move the mouse pointer over an
object.

You can also drag-and-drop tags. To
transfer a tag from one object to another,
drag the tag icon on to the line of the
other object.

If you wish to create a duplicate, use Ctrl-
drag.

If an operation is not available, this icon
appears.

Each object in CINEMA 4D has a type, e.g.
polygon object, spline object.

To open an object’s dialog, double-click on its
type icon. These dialogs are described in Objects
Menu on page 95.

You can apply tags to objects (e.g. texture tag,
smoothing tag). Double-click on a tag icon to
open its dialog.

Mouse Actions in the Object Manager

Function Action

Activate object Click on object

Rename object Double-click on object
name

Activate object type Click on type icon

Activate tag Click on tag

Edit tag Double-click on tag

Move active Drag-and-drop
object or tag

Copy active Drag-and-drop with
object or tag Ctrl key

Open/close Click on icon left of
object hierarchy the object name

Activate previous / Up / down
next object cursor keys

Context menu Right-click on name,
type icon or tag
(Macintosh:
Command key and
mouse button)



CHAPTER 17 • OBJECT MANAGER • 463

File Menu

New Tag
You can use this menu to select a tag. The tag
will be added to the active object.

Plug-in Tags

Here you can choose from tags installed by
plug-ins.

Display Tag

Display, Backface Culling, Use Textures

These settings have the same effect as their
counterparts in the View menus (see page 15),
although the effect of a tag is limited to an
object and any children it may have.

The display tags enable you to mix display
modes within a viewport. For example, some
objects may use Gouraud Shading, the others
Wireframe. The main purpose of this is to
reduce the strain on the processor so that the
redraw rate remains fast.

If your scene is becoming sluggish, try a simpler
display mode for objects of lesser importance.

Note that Display > Use Display Property must
be activated in a viewport for the display tags to
have an effect there (the option is activated by
default).

Level of Detail

This has the same effect as the command of the
same name in the Project Settings (see page 56).
You can use it to control the level of detail for
generators and deformers.

The tag’s value is used in preference to the value
in the Project Settings. For example, you can set
the Level of Detail in the Project Settings to
50% and allocate a display tag with Level of
Detail set to 100% to the object that you are
currently working on.

If the tag’s Level of Detail option is activated, it
is always used in a viewport, even if Use
Display Property is not selected there.

Protection Tag

This tag does not have a dialog. An object with
a protection tag cannot be moved, rotated or
scaled. If you wish to make changes to a
protected object, you must first remove its
protection tag.

Smoothing Tag

              

Smoothing is an extremely important tag. It
gives object surfaces a rounded appearance.
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The picture below left shows a sphere before a
smoothing tag is applied; on the right a
smoothing tag has been applied.

If you look closely, you will see straight lines
around the right sphere’s silhouette. Smoothing
does not increase the number of polygons. You
can think of it as an illusion that loses its effect
around the silhouette. If you wish to smooth the
silhouette region, you must use more subdivisions.

You can use the dialog to specify the maximum
smoothing angle. To do this, activate the Angle
Limit option and type the required angle into
the text box.

The following pictures demonstrate the effect of
the smoothing angle. The cylinder on the left
has smoothing with no angle limit specified (i.e.
all angles are smoothed), the middle cylinder has
an angle limit of 89.5° and the cylinder to the
right has no smoothing at all.

When CINEMA 4D calculates the smoothing, it
assumes that the surface normals are aligned. If
this is not the case, shading anomalies may
appear. All primitive objects are aligned by
default.

Smoothing is a good way to reduce render time
and save on memory. Without the smoothing
tag, an object would require a far greater
number of polygons in order to appear smooth.
Note that smoothing can only take place across
connected surfaces (surfaces that share points).

How smoothing works

During rendering, the program creates a normal
for each surface. Each normal is perpendicular to
its surface. The color and brightness of a point is
determined by the angles which the normal
forms with the rays of the camera and the light
sources.

Without smoothing, two connected surfaces will
have a hard transition, since each surface has its
own normal. This will cause brightness bands.

If a smoothing tag is activated, the normals will
be interpolated. There will be a soft transition
between one normal and the next (provided
that the surfaces are connected).

If a smoothing tag is not applied, there will be
no interpolation.
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The top-left picture shows three connected
surfaces. The middle surface is not aligned to
the other surfaces (you can tell by the normals).
The bottom-left picture illustrates how the
normals are interpolated for smoothing. The
light bar shows the hard transition caused by the
non-alignment.

The top-right picture shows the same three
surfaces, but this time they are aligned. Notice
how the interpolation (bottom-right picture) is
much smoother this time. The light bar is
smoother as a result.

These pictures illustrate why it is important for
surfaces to be aligned. The convention for the
alignment direction is that the normals should
point outwards from the object. For example, if
you have an apple, the normals should point
outwards into the world, not inwards towards
the core.

This convention does not matter for smoothing
in CINEMA 4D — the important point is that
they must be aligned, i.e. point in a consistent
direction. However, it is best to follow
convention. For example, the normal direction
plays an important part in decal mapping (see
page 545). All primitive objects are created with
aligned normals (you do not need to edit their
normals — they will be correct).

Note

To see the normals, select their polygons. For
example, create a sphere, then choose
Structure > Make Editable in the main window
(this will convert the sphere into polygons).
Next, activate the polygon tool and select some
polygons using one of the selection tools (or
choose Edit > Select All in the Selection menu).
To align normals, choose Structure > Align
Normals  in the main window.

Restriction Tag

You can use this tag to restrict a deformation
object’s effect to a selection of points. For more
details see Deformation on page 247 and Frozen
Selections on page 326.

You can enter up to six selections for the tag
and you can define the strength of the
deformation in each case.
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Render Tag

This tag contains several options that affect
rendering.

Cast Shadows

Sometimes it is useful to prevent objects from
casting shadows — especially for technical
illustrations. To turn off shadow-casting, disable
this option.

Receive Shadows

Sometimes it is useful to prevent shadows
appearing on an object — especially for
technical illustrations. To turn off shadow-
reception, disable this option.

Seen by Camera, Seen by Rays

You can use these options to create vampires in
your scene — according to legend, a vampire
has no reflection in a mirror. Joking apart, there

are instances where it can be useful to make a
visible object have no reflection. It can also be
useful to make an object invisible yet have it
cast a shadow.

If Seen by Camera is enabled, the object will be
visible in the render. If the option is disabled, the
object will be invisible.

If Seen by Rays is enabled, the reflection and
refraction of the object will be visible in the
render. If the option is disabled, the reflection
and refraction will be invisible.

You can combine these two options.

For example, you can create a visible object
which casts no shadow, receives no shadows,
has no reflection and cannot be seen behind
glass; or perhaps an invisible object which casts
a shadow, can be reflected and can be seen
behind glass.

Normal object

Visible object
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Invisible object

Seen by GI

Enable this option if you want the object to
generate radiosity. If you disable the option, the
object will not generate radiosity.

Note

To enable/disable the effect globally, use the
Radiosity option in the Render Settings
(Radiosity tab).

Compositing Background

This option will cause the object to be self-
illuminated yet still receive shadows.

Example:

- You are creating a cartoon character for your
website. Your website uses a white background
and you need to render the character so that it
appears to cast a shadow on to the webpage.

- You create a floor with a white material (with
the RGB values matching the white color of
the web page), but when you render the
picture, the floor is not of the correct
brightness.

- To solve the problem, create a render tag for
the floor and activate Background
Compositing. The floor will now illuminate

itself evenly and with full brightness yet it will
still receive the character’s shadow.

Note

The object in question (in our example, the
floor) must have its own material.

GI Accuracy

Radiosity accuracy is controlled globally by
Accuracy in the Render Settings (Radiosity tab).
To override the global value, enable the GI
Accuracy option here, then enter the desired
value in the text box.

Force Antialiasing, Min/Max, Threshold

Antialiasing is defined globally in the Render
Settings (Antialiasing tab). To override the global
settings, enable Force Antialiasing, then set
Min/Max and Threshold to the desired values.

For details on antialiasing — including
descriptions of Mix/Max Level and Threshold —
see Antialiasing on page 412.

Note

The threshold you enter here is used only if it is
lower (i.e. more accurate) than the value in the
Render Settings. Otherwise, the threshold in the
Render Settings is used. This ensures the object
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always uses the most accurate Threshold .
Likewise, the best Min/Max  levels are used.

Note

The settings have an effect only if Use Object
Properties  is enabled in the Render Settings
(Antialiasing tab).

Add to Object Buffer

Use this region to specify up to six object buffer
IDs for the object.

For details on object buffers, see page 434.

Texture Tag

This command creates a new texture geometry.
Initially, no material is assigned. To assign a
material, type its name into the Search for input
box. This dialog is described in detail on page 537.

Note

If you allocate a material to an object, a texture
tag will be created automatically. As a result,
you rarely need to use this menu item.

You can assign as many texture tags as you like
to an object. This allows you to apply several
texture layers to the same object. The texture
priority increases to the right in the Object
manager. This means that the right-most texture
will be the top layer and the left-most texture
will be the bottom layer. The top layer will cover
the object completely unless it is limited in size
or has an alpha channel activated.

Note

If a child object has no texture tags applied to it,
it will use the texture tag(s) of its parent.

Warning!

The note above does not apply to light sources
i.e. if a light object has no texture tag and is a
child of another object it will not inherit its
parent’s texture tags. This is to prevent child
lights receiving gels automatically.

Metaball Tag

This tag tells an object that it is inside a metaball
object. For details on metaballs, see page 177.

Negative Influence

The object will repel the hull rather than attract it.

Strength

This defines the size of the meta-hull. A strength
of 100% means that the meta-hull is as large as
the original object; 50% means that the meta-
hull is half the size of the original object; 200%
means that the meta-hull is double the size of
the original object.

Radius

Metaballs are not restricted to spheres only —
you can use polygon objects and splines too. A
meta-sphere will be created for each object
point. For example, if you use a cube with eight
points, eight meta-spheres will be created, one
for each corner of the cube. Radius defines the
radius for these spheres.
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Stick Texture Tag

This tag sticks all textures of an object onto its
surface. This works for polygon objects as well
as for primitives and NURBS. So the textures
follow any deformation when using deformers
(Bone, Bend etc.).

Until now you have had to use UVW
coordinates to fix textures (see page 481). This
is a question of memory usage and this method
had an unwanted effect when used in
combination with HyperNURBS. In the following
pictures the eye area has been modeled with
only a few points. It was put into a
HyperNURBS object to make it a smooth
surface. Now map a texture using e.g. flat or
cylindrical projection — and see what happens:

A so called 'cage object'. The eyelids consist of far more points
than the surrounding area.

Flat projection

Flat mapping converted to UVW — where areas with many
points meet areas with few points the texture is distorted.
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There are not enough points for the texture to
stick properly, so it becomes distorted in these
problematic areas when converting to
HyperNURBS.

Is there a solution to this problem?

Unfortunately, this is a fundamental problem.
UVW coordinates can’t be used on an object
that has only a few points without causing
distortions in some areas when subdividing it
using a HyperNURBS object.

However, with the Stick Texture Tag you no
longer need to use UVW to attach textures to
an object. If you are modeling such an object
and if you intend to pose the object later using
deformers, first use a generic mapping type (for
a head e.g. flat or cylindrical). Then adjust the
texture.

From the Object manager menu choose File >
New Tag > Stick Texture Tag. If you now deform
your object the texture will be deformed as well.

Flat mapping on a HyperNURBS object fixed with
Stick Texture Tag and deformed by a Bend object.

In this way you can work around the texture
distortions with HyperNURBS.

How does this work exactly?

If a Stick Texture Tag is created CINEMA 4D
checks if the object uses a generic projection type
(e.g. flat, cylindrical, spherical… everything except
UVW and frontal) and if it is deformed in any way.
It can be deformed by any deformation object. Is
this the case the texture projection is calculated
automatically using a point copy which is stored
inside the Stick Texture Tag. The texture is
projected through onto the HyperNURBS surface
without any of the distortions mentioned above.

If you click on the Stick Texture Tag icon in the
Object manager the following dialog opens:

Active

Here you can temporarily disable the stick
function without losing the stored reference
object and its mapping data.

Record

This button enables you to record the current
point positions and defines them as a new
reference shape.

Reset

This button resets the object to its original state
which is stored in the Stick Texture Tag.

Note:

Only polygonal objects can be reset and recorded.
The point copy is directly created. All other
objects (NURBS, primitives etc.) cannot be reset or
recorded because they do not consist of any
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points or polygons. Only if deformed are they
internally converted to polygonal objects which
can then be deformed. The point copy for the
Stick Texture Tag is created from this internal
polygon object.

Important note:

As soon as you add points to a polygonal object
the stored point copy becomes invalid! When
using deformation objects this is not a big
problem because before every deformation a
new reference copy is automatically stored in
the Stick Texture Tag. The Stick Texture Tag has
an interesting side-effect: If you put a polygon
object inside a symmetry object and texture one
half, the texture is automatically mirrored to the
other side! So, for example, you could paint half
a face, project it using flat mapping, and
CINEMA 4D will do the rest. If you do not want
this behaviour (since not all faces are
symmetrical) just put the texture onto the
symmetry object itself.

Anchor Tag

This command does not have a dialog.

When you use inverse kinematics (IK), you may
not want all the objects in the hierarchy to be
affected. The anchor tag will prevent an object
from being moved under IK. The objects above
it in the hierarchy will remain stationary
(anchored) as well. CINEMA 4D’s built-in figure
(Objects > Primitive > Figure) has an anchor
tag applied to the upper body (make the figure
editable, otherwise you will not see the separate
body parts and tags). If you move one of the
hands under IK, the upper body itself remains
stationary.

IK Tag

You can use this tag to specify angle restraints
for the object when using inverse kinematics
(IK). For example, a real knee can bend only
through about 160°. Angle restrictions can also
prevent objects from intersecting each other.

You can specify the restraint by entering a
Minimal and Maximal value for the heading H,
pitch P and bank B. You can also specify a
damping factor. The higher you set Damping,
the stiffer the joint becomes. Parts of the IK
chain with a lower damping factor will move
more readily.

Example:

- Change into View 2 (XZ plane) and create a
bone object (Objects > Deformation > Bone).
Move the view so that the bone object is near
the bottom of the view.

- Click on the X axis icon to lock the X axis. Use
Ctrl-drag to drag a new bone out of the
orange point until it is about the same size as
the original bone.

- Next, Ctrl-drag a new bone out of the second
bone until it is the same size as the others. The
advantage of dragging out bones in this way is
that the hierarchy is created automatically in
the Object manager.
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- Create two nulls (Objects > Null Object).
Move one of the nulls along the Z axis to the
end of the bones chain and rename it 'end
effector'. Make 'end effector' a child of the last
bone in the Object manager.

- Rename the other null 'anchor', then make the
entire bones chain a child of 'anchor'.

- Your chain should look like the picture below.

- Click on the X axis icon to unlock the X axis.
Choose Tools > Inverse Kinematics to activate
IK mode.

- Select 'end effector' in the Object manager,
then move it around in the view window. The
IK mode ensures that all objects maintain the
same distance from each other. However, the
movement is unrestricted — it is quite possible
to make the bones intersect each other.

- Create an IK tag for the first bone. Activate H,
P and B and leave the values as they are. Use
Ctrl-drag to copy the IK tag to the other bones
in the Object manager. Select 'end effector'
and move it around in the view. Try changing
into View 1 as well.

- The bones are now restricted. For example,
they cannot intersect each other any more.

However, the bones can still move in all three
directions.

- Delete two of the IK tags in the Object
manager. Double-click on the remaining IK tag
and enter 0 for the minimal and maximal P and
B values. Use Ctrl-drag to copy the IK tag to
the other bones in the Object manager. Select
the 'end effector' object and move it around in
the view.

- Try changing into View 1 as well. This time the
movement is restricted to one plane.

- Lastly, try entering different damping values
for the tags. Start with 80% for the first bone,
60% for the second bone and 40% for the
third bone. You will notice that the third bone
moves the most readily, while the first bone is
the most stubborn. Recall that increasing the
damping will increase the stiffness.

- Use the Figure object for further
experimentation. Choose Structure > Make
Editable so that you can access the body parts
and tags.

Note

The HPB angles refer back to the object’s parent
system, i.e. if the object is in a hierarchy, the
parent system takes the place of the world
system. One easy way to set the values is to
activate the object and read its coordinates in
the Coordinate manager. You can then add and
subtract to calculate the minimal and maximal
values for the IK tag.
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Motion Blur Tag

You can use this function to apply motion blur
to an object. Ensure that Object Motion Blur is
enabled in the Render Settings (it is enabled by
default), otherwise the effect will not appear in
the renderer.

Strength is the degree of blurring. A value of
100% will blur the object for the entire time
between one frame and the next. To reverse the
direction of the motion, enter a negative value.
For extra blurring, enter a value greater than
100%.

URL Tag

You can assign a URL to an object. This is useful if
you are creating VRML files for the Internet. These
VRML files (.wrl) contain complete 3D scenes and
can be viewed in web browsers provided that you
have an appropriate VRML plug-in.

The viewer can click on a 3D object that has a
URL tag in order to link to an Internet address.

URL contains the link address. Take care to enter
the complete address (do not forget http://,
ftp://, https://). You can use Info to define the
text that will appear when the mouse pointer
moves over the object in the web browser.

Stop Tag

This tag prevents the object and its children
from being affected by generators higher up in
the hierarchy. For example, assume you have a
group of objects nested one inside the other.
You place this group inside a HyperNURBS
object. Without the stop tag, the HyperNURBS
object affects all objects in the group. Place a
stop tag somewhere in the hierarchy, though,
and the effect of the HyperNURBS is stopped
from that point in the hierarchy.

C.O.F.F.E.E. Error Tag

When loading a scene which includes tags
created by plug-ins and CINEMA 4D cannot find
a plug-in (for whatever reason), a question mark
will be displayed instead of the tag icon. The
same happens with C.O.F.F.E.E. errors. Please
contact the plug-in author in such a case.

C.O.F.F.E.E. error tags

New Expression
Expressions are dependencies between objects.
For example, you can move an object and have
another object track it automatically. Expressions
are particularly useful for automating behaviour.
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There are two types of expressions in CINEMA 4D;
the built-in expressions and C.O.F.F.E.E.
expressions. The latter are more complex to use,
but they are also very flexible and powerful.

Expressions are evaluated in the editor in
realtime.

C.O.F.F.E.E. Expression

This is the most powerful and flexible expression
tool in CINEMA 4D because you can use it to
create your very own complex expressions. For
example, you can use control objects to close a
character’s eye or open its hand.

C.O.F.F.E.E. expressions can create any type of
dependency. For example, you can have an
object’s texture change according to the
brightness of a light source. You will need to
learn C.O.F.F.E.E. before you can create your
own expressions.

Fixing Expression

This expression fixes an object’s position to the
specified coordinates. You can rotate and scale a
fixed object, but you cannot change its position.

IK Expression

You can use this expression to set an IK target.
The IK chain will try to reach the target. For the
following example, we created four nulls (one
for each hand and each foot). We placed the
foot nulls on the floor and the hand nulls on the
bar.

Then we typed in the name of the IK target for
each expression. Now, if the figure’s body moves,
the hands and feet remain in position. If a null is
moved, the corresponding hand or foot moves.
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Sun Expression

You can use this expression to simulate the
position of the Sun. The expression is applied
automatically when you create a Sun Light object
(Objects > Scene > Sun Light). See page 228.

Target Expression

If you apply this expression to an object, the
object will point at another object automatically.
For example, you can make a figure’s eyes
follow a target; you can have a spotlight follow
a clown. Do not confuse this expression with the
IK expression. If you need to set an IK target,
use an IK expression. If you merely want the
object to rotate in order to point at another
object, use the Target expression.

Target Camera and Target Light (Objects >
Scene) use target expressions.

Restore Selection

In this submenu the point and polygon selections
are displayed and can be activated by selecting
them. The selections are displayed only in point

mode (see page 302) or polygon mode (see
page 303). If you are working with a different tool
this menu remains empty.

If your selections are unnamed they will be
numbered and displayed as 'selection<number>'.
If you select one of the selections displayed the
points or polygons stored inside this selection are
selected.

This function can also be accessed by clicking on
each selection tag (see page 325).

Load Object
You can use this command to load a file containing
object information (e.g. DXF, CINEMA 4D,
Illustrator path, etc.). The objects and materials in
the file will be loaded into the scene.

Save Object as...
This function saves the active object. The
standard system dialog for saving files will open.

Display Tags
You can use this option to switch on or off tag
display in the Object manager.

Close
This function closes the Object manager.
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Edit Menu

Undo
This function reverses the last change (action)
that you made, restoring the scene to its
previous state. You can select Undo repeatedly
to continue reversing the actions.

Redo
Redo restores the last action that was undone.
You can select Redo repeatedly to continue
restoring the actions.

Cut
This function deletes the active object and
copies it (including its materials) to the
clipboard. The object can be copied back from
the clipboard with the Paste function (see
below).

Copy
The Copy function copies the active object
(including its materials) to the clipboard. The
object can be copied from the clipboard to the
active scene with the Paste function (see
below). You can paste repeatedly to create
additional copies.

Paste
This function inserts an object from the
clipboard into the scene.

Delete
This function deletes the active object or the
active tag without copying it to the clipboard.

Select All
You can use this function to group all the
objects in the Object manager into a null object.
The null object is selected, including its child
objects.

Deselect All
This function deselects all active elements (i.e.
objects, tags, etc.).
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Objects Menu

Object Display
The items in this menu control the editor and
renderer visibility for the selected object.
Alternatively, you can change the visibility using
the visibility switches in the middle column of
the Object manager:

Both switches are coloured grey by default. The
top switch controls editor visibility, the lower
switch controls render visibility. Each can have
one of three states: grey, green and red.

Editor Unchanged / top switch grey

The object adopts the viewport visibility of its
immediate parent. If the object is on the top
hierarchy level (i.e. has no parent), it will be
displayed as normal. Editor Unchanged is the
default setting for new objects.

Editor On / top switch green

The object will be visible in the viewport, even if
the hierarchy parent is invisible (red).

Editor Off / top switch red

The object is not displayed in the viewport, even
if the hierarchy parent is visible (green).

Note

An object that is invisible in the viewport will
nonetheless be visible in the render.

Renderer Unchanged / bottom switch grey

The object adopts the renderer visibility of its
parent. If the object is on the top hierarchy level
(i.e. has no parent), it will be rendered as normal.
This is the default setting for a new object.

Renderer On / bottom switch green

The object will be visible in the render, even if
the hierarchy parent is invisible (red).

Renderer Off / bottom switch red

The object is not displayed in the render, even if
the hierarchy parent is visible (green).

Note

To apply a status to all child objects, Ctrl-click
on the switch for the parent object. The status
will be transferred to all child objects.

Object Activation
Generators and deformers are two of the most
important object types in CINEMA 4D. Generators
use other objects or data to create a new body.
Generators include most NURBS types.

Deformers modify an existing object. Deformers
include not only those listed in the Objects >
Deformation menu, but also Hyper NURBS,
metaballs and the symmetry object.

All generators and deformers have the two
standard visibility switches (see Object Display
above) in the Object manager. In addition, they
have a third switch for Object Activation.
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The activation switch is represented as either a
tick (enabled) or a cross (disabled). You can use
this switch to turn on or off the effect of the
generator/deformer.

Example:

- You have placed several splines into a Loft
NURBS.

- If you wish to edit the splines extensively, you
can see them more clearly if you turn off the
skin of the Loft NURBS (just turn off the
activation switch for the Loft NURBS). Note
that the NURBS object is not invisible; rather, it
is not having an effect.

Another example:

- Create a cube and make it a child of a Hyper
NURBS object. The cube will be deformed into
a sphere. If you deselect object activation, only
the cube (the original object) will be shown.

Note

If you have an object in the scene that uses
deformers, you can increase the redraw rate by
deselecting object activation for each deformer.

Edit Object
You can use this function to edit the object type.
A dialog will appear. For a detailed description
of the type dialogs, see Objects Menu on
page 95. You can also call this function by
double-clicking on the object’s type icon.

If an object type cannot be edited (e.g. a
polygon object), the Rename Object dialog will
appear instead.

Rename Object
You can use this function to change an object’s
name. You can also call this function by double-
clicking on the object’s name.

Group Objects
You can use this function to group several
objects in the Object manager. When you select
this function, the mouse pointer changes into
crosshairs. Use the crosshairs to drag a box over
the objects that you wish to group. Child objects
will also be incorporated into the group —
existing hierarchies will be preserved within the
new group.

Expand Object Group
This function is the reverse of Group Objects. It
removes all objects from the group and places
them on the same hierarchy level as the group
parent. Existing hierarchies within the group will
be preserved.

Information (Object)

This function displays the following information
about the active object (including its children):
size in kilobytes, number of points, number of
polygons and number of objects.

Note

Polygons that are created by generators will not
be included in the number of polygons.
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Information (Scene)

This function displays the following information
about the scene: size in kilobytes, number of
points, number of polygons and number of
objects.

You are not required to select an object before
using this command.

Note

Polygons that are created by generators will not
be included in the number of polygons.

Search Active Object
You can activate an object by clicking on it in a
viewport. You may then wish to find the object
in the Object manager. However, it may not be
visible immediately. You may need to unfold a
very long IK chain, for example, or perhaps
there are thousands of objects in your scene.
Searching for objects manually can be time-
consuming.

If you select this command, the active object will
be shown in the Object manager. The manager
will scroll and the hierarchy tree will be opened
if necessary.

Fold All
This command collapses all hierarchies. In this
state, objects take up the least amount of space
in the Object manager.

Unfold All
This command is the reverse of Fold All (see
above) — it expands all hierarchies. In this state,
objects take up the most space in the Object
manager. The advantage is that all objects will
be visible (although you may need to use the
scroll bar).

Warning!

Unfold with caution if your scene is very large. It
may be wiser to unfold the hierarchies by hand.
Large projects often have more than 1000
objects. The display speed will be just as slow as
if 1000 files were to be displayed hierarchically
in your operating system’s window. You can
query the number of objects in your scene by
selecting the Objects > Information (Scene)
command.

Fix Bones
Once you have finished positioning bones, you
must 'fix' them before you use them. This tells
CINEMA 4D the fixing (starting) position of the
bones. To fix the bones, simply call this function.

The Object Activation switch (see above) will be
turned on automatically for the bone and all its
child bones.

Reset Bones
This function resets the bones to their fixing
(start) position. The object will return to its state
at the time of the fixing.

The Object Activation switch (see above) will be
turned off automatically for the bone and all its
child bones.
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Bake Particles
Baking particles means freezing the particle
stream, including all its modifiers. This can be
useful for several reasons:

- In extreme cases, very fast particles may
behave unexpectedly due to processor
inaccuracies (they may pass through
deflectors). Baked particle streams avoid this
problem since they are calculated much more
accurately.

- You may wish to mix several particle streams
but prevent modifiers affecting particles in the
other streams. To do this, create one particle
stream and its modifiers and bake the stream.
Delete the modifiers before you start the next
stream and continue in the same manner.

- If you are using CINEMA 4D NET to render
across a network, jumps may occur in particle
streams due to differences between the CPUs.
To remedy this problem in CINEMA 4D NET,
bake the particles.

Example:

- Please ensure you are familiar with the section
on the Particle System (starting on page 235)
before proceeding with this example,
otherwise you may find it difficult to follow.

- Start a new scene and create an emitter and a
few modifiers. Ensure that the emitter is
selected in the Object manager, then choose

the Bake Particles command. The dialog shown
below opens.

- Use the From and To values to mark the period
over which the particles will be baked (the
default values cover the entire document
length).

- Click on OK once you are ready to bake the
particles — a Baked Particles icon will appear in
the Object manager to the right of the emitter.

Important note

You cannot edit the settings that were used to
bake the particles. If you need to re-bake the
particles (e.g. because you have increased the
document length), first delete the Baked
Particles icon in the Object manager, then bake
the particles afresh.
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Tags Menu

Edit Tag
You can use this function to edit the active tag.
The tag’s dialog will open. You can also access
this dialog by double-clicking on the tag.

Copy Tag to Children
If you select this function, the active tag will be
copied to all child objects of the active object.

If a child object already has a tag of the same
type, its tag will be overwritten with that of the
parent. There is one exception, the texture tag.
This tag is still copied, but the child will keep its
own tag as well (an object can have more than
one texture tag).

Proceed with caution when using this function
with complex scenes.

Delete Tag from Children
This function does the reverse of Copy Tag to
Children (see above). Delete Tag from Children
will delete the active tag from the active object
and its children.

Proceed with caution when using this function
with complex scenes.

Texture Menu

Generate UVW coordinates
You can use this function to generate UVW
coordinates. This is particularly useful for imported
objects that do not have UVW coordinates. UVW
coordinates prevent a texture from 'slipping' when
you deform the object.

Proceed as follows:

- Create a texture and allocate it to the object.

- Set the required projection type (e.g. spherical,
cylindrical, etc.).

- Generate UVW coordinates.

- Deform the object.

The effect of UVW coordinates is shown in the
picture above. The object to the left uses cubic
mapping. The texture slips when the object is
deformed. The texture for the object to the right
does not slip since its original cubic mapping has
been fixed with UVW coordinates.

You may use more than one UVW geometry to
texture an object. To do this, give the object a
new texture tag and set the required projection
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type, e.g. flat mapping for a label. Next, choose
Generate UVW coordinates. A new UVW
geometry will be created and the active texture
tag will switch over to UVW mapping so that
the texture is fixed to the object surface.

For more details on UVW mapping see
page 542.

Assign UVW coordinates
This function enables you to texture an object
with several different projection types using a
single UVW geometry and a single texture tag.

Proceed as follows:

- Create a sphere and convert it into a polygon
object with Make Editable.

- Create a new material with a texture, e.g. the
Checkerboard shader, and allocate it to the
sphere.

- Change the projection type from UVW
Mapping to e.g. Flat.

- Activate the polygon tool and select several
polygons.

- Select Texture > Assign UVW Coordinates in
the Object manager.

If you are in RTTM mode, you can see
immediately that the selected polygons use flat
projection while the unselected polygons
continue to use the normal UVW mapping. If
you deform the object, the texture remains fixed
in the selected region as well.

Note

Selective UVW mapping is intended for you to
optimize projection for a single texture. If you
wish to use more than one texture, use Restrict
To Selection — see page 551.

If the object has no UVW coordinates (i.e. no
UVW tag), new coordinates are created
automatically.

Fit to Object
If you select this function, the texture will be
made to cover the object completely — the
texture will have a length of 100% in both the X
and Y directions.
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Fit to Image
You must apply your texture with flat projection if
you wish to use this function. Type the name of an
image into the dialog. CINEMA 4D calculates the
image’s X and Y resolution and scales the texture
image accordingly. You can use this function to
ensure that your texture uses the correct
proportions, thereby avoiding distortion.

Fit to Region
You must apply your texture with flat projection if
you wish to use this function. Use the mouse to
drag a box. CINEMA 4D will set the projection so
that the size of the texture matches the specified
region exactly.

Adapt to Object Axis
This function rotates the texture axes in such a
way that they are parallel to the object axes.

Adapt to World Axes
This function rotates the texture axes in such a
way that they are parallel to the world axes.
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Adapt to View
This function rotates the texture axes in such a
way that the texture is perpendicular to the
viewing perspective. For a 3D viewport this is
the camera plane; for all other viewports it is the
work surface.

Mirror Horizontally
This function flips the texture horizontally. This
effect is the same as if you were to view the
texture’s reflection in a real mirror.

Mirror Vertically
This function flips the texture vertically. This
effectively turns the texture upside-down.
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18. Material Manager   
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18 Material Manager

Use the Material manager to create materials for
the objects in your scene. Good materials and
lighting are essential for photo-realistic images.

The Material manager contains all the materials
and 3D shaders that belong to the active scene.
A preview picture and a name is shown for each
material. Names too long for the display space
are shortened with a full-stop.

The material preview shows how the texture
looks when placed on a sphere, in front of a
striped background. This helps you determine
how the material will look when applied to an
object. You can choose between three different
preview sizes.

When an object is active, all the materials it uses
are shown indented. This makes it easy for you
to tell which materials are used by an object.
From now on, if we say that a material is active,
we mean that its icon is shown indented, or
sunken, in the Material manager.

If an individual texture tag (rather than the
object itself) is active in the Object manager,
only that corresponding material is shown
indented.

You can apply a material to an object using
drag-and-drop from the Material manager. You
can drop the material on to the object in the

Object manager, or you can even drop it directly
on to the object in a viewport (see Texture
Mapping, page 537).

If you drop a material on to a texture geometry
tag in the Object manager, this material will
replace the previous one and the existing
texture geometry will be used.

If instead you drop a material on to an object
name, a new texture geometry is created. Any
existing texture geometry tags remain intact so
that you can layer textures. You can read more
about layering, material administration and texture
geometry in Texture Mapping, page 537.

In addition to any materials that are active, you
can also select a material. Only one material can
be selected at any time. The selected material
has its name highlighted with red text. All menu
functions in the Material manager operate on
the selected material.

You can select a material using the mouse (click
once on the preview). You can also use the
cursor keys to change which material is selected.

To edit a material, double-click on its preview.
This opens the Material editor window, which
has its own preview picture so that you can see
easily see the effects of your changes. You can
read more on the Material editor on page 492.

You can access many of the menu commands
via the context menu. Please note that the
context menu is accessible only if you have at
least one material in the scene. If you are using
a Windows operating system, you access the
context menu by clicking the right mouse
button in the Material manager. If you are using
a Macintosh, hold down the Command key and
click in the Material manager.
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File Menu

New Material
This function creates a new material with the
default material values (white with specularity).
The new material will be placed at the start of
the material list.

You can also access this function via the context
menu.

New 3D Shader
CINEMA 4D has several 3D shaders such as Fog
and Wood. Most of these shaders can be loaded
in the Material editor in the same way you
would load a conventional texture. However,
there are a few 3D shaders (Fog and Terrain)
that cannot be used in this way — these shaders
must be loaded using New 3D Shader (choose
the shader from the pop-up menu that appears).

Shaders (aka procedural textures) are more
sophisticated than conventional textures.
Shaders are computed using mathematical
formulae whereas conventional textures are
pixel-based. One advantage of shaders is that
they do not become pixelated when viewed
close-up.

CINEMA 4D distinguishes between two-
dimensional and three-dimensional shaders. 3D
shaders take an object’s volume into account,
whereas 2D shaders and standard textures are
simply applied to the object’s surface. 3D
shaders are independent of the object’s
geometry and the texture projection type (an
exception is that UVW projection can be applied
to volume shaders).

The difference between conventional textures
and 3D shaders is particularly apparent when
applying them to an object with a section cut

out. With conventional textures, you can see
the edges of the cut very clearly. With 3D
shaders, the cut is taken into account.

The following picture compares a 2D texture
with a 3D shader. Note how the 3D shader
seems to flow into the hollow.

A 2D shader (top) in comparison with a 3D shader

3D shaders can do even more. For example,
the Fog shader fills a volume with fog clouds.
Shaders are often used with simple objects
(such as a cube) to create computer-generated
landscapes.

Note

CINEMA 4D computes 3D shaders using SAT
Mapping (see page 495).

For a detailed description of the 2D and 3D
shaders supplied with CINEMA 4D, please see
page 520, The Shaders.

Load Materials
This function loads materials, adding them to
any materials already in the scene. You can
also import materials from another scene by
loading the scene file.
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A word of caution regarding textures; when
CINEMA 4D renders the scene, it must locate all
the textures. CINEMA 4D will look for the
textures in the same folder as the scene, as well
as in a sub-folder called 'Tex'. In addition, you
can specify up to 10 alternative texture paths
(see Texture Paths, page 55). When the scene is
to be used on another computer (perhaps by a
colleague) we strongly advise that you save the
scene using Save Project (see page 75). This will
ensure that all of the textures are saved in a
'Tex' sub-folder along with the scene.

Save Material as
This function saves the active material. The
standard system dialog for saving files will open.
Once you have saved the material, you can
reload it using Load Materials.

Save All Materials as
This saves all the materials in the active scene.
You can use this function to create your own
material libraries. Use Load Materials to import
the materials.

Close
This function quits the Material manager and
closes its window.

Edit Menu

Undo
Undo will undo the last change that you made
to a material. Keep selecting this command to
continue undoing (multiple undo). You can set
the maximum number of undos using Undo
Depth in the General Settings (see page 45).

Note

The functions Remove Duplicate Materials and
Remove Unused Materials cannot be undone. If
you delete a material, any objects which used
that material will use the default material
instead. Although it is possible to undo the
deleted material, it will not be reapplied to the
objects; you must do this manually.

Redo
Redo undoes an undo. You can set the
maximum number of undos using Undo Depth
in the General Settings (see page 45).

Cut
Cut removes the active material from the
Material manager and copies it to the clipboard.
You can use the Paste function to retrieve the
material from the clipboard, even if you have
changed the active scene (i.e. you can paste
between scenes).

Copy
This copies the active material to the clipboard.
Use the Paste function to retrieve the material
from the clipboard. Note that you can paste
more than one copy; each new copy is added to
the start of the material list.
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Note

You can quick-copy materials by using drag-and-
drop with the Ctrl key held down. Drop the copy
at the required position in the material list. The
first copy will be called 'name.1', the second
copy will be called 'name.2' and so on.

Paste
The Paste function inserts the last material that
you copied (or cut) to the clipboard. The copy
will be placed at start of the material list. The
first copy will be called 'name.1', the second
copy will be called 'name.2' and so on.

Delete
This function deletes the active material.
Alternatively, use the Delete or Backspace key.

Small, Medium, Large Icons
Select one of these three settings to determine
the size of the material previews (the default is
small). Small icons are 45x45 pixels, medium
icons 60x60 pixels, large icons 90x90 pixels.

Function Menu

Render Material
This function redraws the preview picture of the
active material.

When you create a new material, it is rendered
automatically. Why, then, would you need to
use this function? Because when you save a
scene, the preview pictures are compressed to
reduce the file size. As a result, when you load a
saved scene, you may notice artifacts with some
materials.

Also, preview pictures are not rendered
automatically when importing foreign formats
such as DXF or 3D Studio R4.

If only the base color is shown after rendering
the material, it means CINEMA 4D could not
find the texture(s).

When saving scenes for use on another
computer, you can ensure that all textures are
included by using Save Project (see page 75).

If you cannot find a texture, select an alternative
texture or delete the name on the appropriate
page of the Material editor.

Render All Materials
This function redraws the preview pictures of all
the materials (see Render Material above).

You can cancel the process with the ESC key. If
you are using a Macintosh, you can also cancel
with the standard Command-dot keypress.
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If, however, you drop the material on to the
object name, a new texture geometry is created
for the material.

Texture geometry is described in detail on
page 537.

Note

Hold down the Shift key if you do not want the
Texture Geometry dialog to open.

Rename
Use this function to change the name of the
active material. It is also possible to rename a
material by double-clicking on its name, which is
just below its preview picture.

Remove Unused Materials
This deletes all materials which have not been
applied to objects in your scene.

This function is particularly helpful when using
material libraries as it will remove the (possibly
many) unused materials.

Note

The Remove Unused Materials function cannot
be undone.

Note

Materials used in a texture track are not deleted
(see Texture, page 590).

Remove Duplicate Materials
This deletes all materials of the same name
which have identical parameters.

Note

The Remove Duplicate Materials function
cannot be undone.

Sort Materials
This will arrange the material list in alphabetical
order. You can also sort materials manually using
drag-and-drop. This lets you position the materials
in any order you like.

Drop the material in the position of your choice.
The insertion is right-justified, which means it
will appear to the right of the material that you
drop it on. If the target position of the material
is outside the visible range of the Material
manager, you can scroll by moving the mouse to
the upper or lower edge of the window.

Edit
This function opens the Material editor if it is
not already open, and the Material editor will
become the active window. You can use the
Material editor to change the properties of the
active material.

You can also open up the Material editor by
double-clicking on a material’s preview picture.
For more full details on the Material editor see
page 492.

Apply
Apply creates a texture geometry for the active
object. The active material is applied to the
texture geometry.

You can alternatively apply the material with
drag-and-drop. If you drop the material on to
an existing texture geometry tag ...

... the previous material in the tag is replaced by
the new one.
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The Material Editor

Use the Material editor to change a material’s
properties.

Open the Material editor by double-clicking on
a preview in the Material manager. The Material
editor is a non-modal window, which means
that it does not have to be closed before you
can edit another material. Simply click once on
another material in the Material manager and it
will appear in the Material editor. This helps
speed up your workflow.

You do not have to close the window in order
for the parameter changes to be remembered.

If you do not like the changes that you have
made and wish to revert the material to its
previous state, click on the Undo button. This
function is for the active material only. You can
restore other materials by using the Undo menu
function.

Click on the Refresh button to reshade the
objects in the editor window (an automatic
refresh would take up too much CPU time).

The Material editor is divided into up to five
panes. The material display is at the top-left.

There are also 14 parameter pages. The settings
on the parameter pages combine to form an
overall material property. The entire settings for a
parameter page can be enabled or disabled using
the corresponding checkmark below the material
preview. Do not be daunted by the sheer number
of settings! Each parameter page operates in a
similar way and the control elements are located in
the same place. To access a parameter page, click
on the parameter name.

Property What it controls

Color Surface color

Diffusion Irregularities in surface color
(works by lightening and
darkening the color channel)

Luminance Luminescent color (light-
independent color)

Transparency Transparency (including
refraction index)

Reflection Ability to reflect other objects

Environment Environment reflection (simulates
reflection)

Fog Fog effect

Bump Virtual bumps on a surface

Alpha Localized texture invisibility

Specular Highlight

Specular Color Highlight color

Glow Halo around an object

Displacement Authentic bumps on a surface

Illumination Radiosity, caustics, illumination
model
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The Color Pane
Most parameter pages have a color that you can
adjust. Depending on your General Settings (see
Color System, page 46), you will adjust the color
using either a color table or sliders. The meaning
of each slider also depends on the General
Settings. You can use either the HSV color system
or the RGB color system and you can choose
whether the units should run from 0-100%, 0-255
bits, or 0-65535 bits.

Use the Brightness slider, which is below the
three color sliders (R red, G green, B blue or H
hue, S saturation, V value), to adjust the overall
brightness of the color. Note that if you are
using the HSV system, the Brightness slider has
the same effect as the V slider (i.e. you do not
have to use the Brightness slider; you can leave
it at 100%).

The resultant color is shown just to the left of
the sliders. Click on this color box if you want to
open the color dialog for your system.

Earlier we said you can change the color system
by using the General Settings. You can also
change the color system by clicking on the
small, right-facing triangle just below the color
box. A pop-up menu will open for you to select
your color system. The Material editor will use
the new system (or color table) for as long as it
is open. The moment you close the Material
editor, it will revert to the color system that is
selected in the General Settings.

The Texture Pane
Use the texture pane to select a two-
dimensional picture or a shader. Your selection
will be used as a texture. CINEMA 4D
recognizes these formats: JPEG, IFF (ILBM), TIFF,
TGA, BMP, PICT, Photoshop PSD, MOV, AVI. All

formats supported by QuickTime are recognized
also — provided that QuickTime is installed on
your system.

Once you have selected a texture, its preview
will appear to the right with three numbers
immediately below. These numbers tell you the
width, height and color depth of the texture.
You can copy a color from the preview to the
color pane by clicking within the texture
preview; this acts like a color picker.

Image

Use the Image button to load a texture into the
texture pane. Use the system dialog to load an
image file from either your scene’s folder, your
scene’s 'Tex' sub-folder, or a texture path that
you have specified in the General Settings (see
page 55). A dialog will warn you if the image
file is not in a search path and you will be asked
if you wish to copy the image to the document’s
folder or, if your scene does not have its own
folder yet, to the CINEMA 4D root folder.

Once you have loaded a texture, its path name
appears in the input box. To the right you can
see the texture’s preview picture.

Note

CINEMA 4D searches for textures in the
'CINEMA 4D/Tex' folder, the scene’s folder, the
scene’s 'Tex' sub-folder, and the texture paths
specified in the General Settings (including sub-
folders).

If CINEMA 4D cannot find a texture when
rendering, a message will appear to tell you
which textures are missing and which materials
use these textures. You can still render the scene
(just click on OK); the materials concerned will
still be used without the missing textures.
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You can load a shader into the texture pane by
clicking on the small, right-facing triangle to the
right of the image button. Select your shader
from the pop-up menu.

You can copy and paste shader settings from
one material channel to another by using Copy
Channel and Paste Channel. Therefore it is just
a few clicks to adjust e.g. the bump channel to
the color channel. Of course, this works only for
channels which accept textures and shaders.

You can also use the small, right-facing triangle
to reload the image. This is useful if you have
changed the texture in an imaging program and
the preview is now out of date. Reload the
image by selecting the top entry, Reload Image.

Note

You cannot reload a texture while it is in use
(e.g. during rendering).

Sampling

Use Sampling to change the method by which a
texture’s pixels are interpolated.

There are many ways to guess, and so there are
several sampling types. Each type is explained
below using an example picture. In particular, we
pay special attention to MIP and SAT mapping.

The texture we used was a mere 16x16 pixels in
size and was placed on to a floor object.

None

When the sampling type is set to None, the
original texture values are used without any
interpolation. This method is very fast but often
gives poor results. Textures tend to become
pixelated. You can try to compensate for the
pixelation by using a high antialiasing setting.

Generally, avoid using this sampling type unless
you are sure you need to use it.

Circle

Circle sampling uses a circle of texture pixels
(those that surround the intermediate value).
Textures that are enlarged at render time tend to
look more natural than with the None type.
However, as the picture demonstrates, straight
lines are a problem.

The lines seem to be frayed at the edges. The
texture also appears very jagged near the
horizon.
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Circle sampling is, however, well suited to very
small textures (e.g. 3x3 pixels), since it helps the
pixels to blend softly.

Square

Square uses a square of texture pixels (those
that surround the intermediate value). This leads
to a softer transition between texture pixels
than with None. The picture quality is good.

Alias 1, Alias 2, Alias 3

Alias 1, Alias 2 and Alias 3 blend the texture
more strongly than Circle and Square. Alias 3
blends the most, Alias 1 the least.

In the picture above, the texture is difficult to
recognize with Alias 3 because it is so small
(16x16). Alias 3 can give smoother results than
Alias 1, but it also takes longer to calculate.

Even Alias 3 cannot prevent flickering near the
horizon.

MIP

MIP stands for multum in parvo, which is Latin
for ‘many things in a small place’. When many
texture pixels effectively lie within a single
screen pixel, an approximation is made based on
the (known) texture pixel values.

This results in very smooth blending. MIP is the
default sampling type.

SAT

SAT stands for summed area tables and it does
an even better approximation than MIP
mapping. As with MIP mapping, the
approximation is based on the texture pixels
that lie within a single screen pixel.

SAT is the highest-quality sampling type.

Note

SAT mapping works with textures up to
4000 x 4000 pixels. CINEMA 4D will use MIP
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mapping automatically if you try to use SAT
mapping with larger textures.

O (Blur Offset), S (Blur Strength)

MIP and SAT mapping only approximate the
optimum computation, since a precise
computation would increase the render time
greatly. SAT mapping is more accurate than MIP
mapping. But sometimes these approximations
can make a texture too blurred or too sharp.
The options enable you to blur or sharpen the
mapping.

O (Blur Offset) softens a texture. The illustration
below shows how you can use this setting to
blur a texture.

S (Blur Strength) fine-tunes the strength of the
MIP/SAT mapping. A positive value increases
the blur; a negative value weakens it.

A strong value blurs detail but helps prevent
flickering during animation. A weaker value
brings out more detail but increases the risk of
flickering.

Note

With floors, try a positive blur strength of about
+20%. Floors tend to suffer most from perspective
distortion, so they require special treatment.

Mix

Use this to mix the color and texture panes using
one of four modes. The default mode is Normal,
apart from the Environment page which uses
Multiply as the preset. Not all pages have Mix
settings.

If you load a texture or a 2D shader, it is placed
on a layer above the color (i.e. the texture is
placed on top of the color). Enter a value in the
text box to set the mixing proportion between
the texture and color panes.

Normal

In normal mode, the value in the text box sets the
opacity of the texture. If the value is set to 100%,
then you see the texture only (remember, the
texture is the top layer, so if it is opaque, you will
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not see the color underneath). If the value is set to
70%, the result is 70% of the texture and 30% of
the color.

Let’s take an example: if a texture pixel of RGB
255/0/0 (red) is used with a color value of RGB
255/255/0 (yellow) with the Mix value set to
50%, the resultant color is 255/128/0 (orange).

Add

The texture’s RGB value is added to the colour’s
RGB value. Color channel values cannot exceed
the maximum of RGB 255. So if a texture pixel
of RGB 0/255/255 (cyan) is added to a color
value of 255/255/0 (yellow), the result is 255/
255/255 (white).

Subtract

The colour’s RGB value is subtracted from the
texture’s RGB value. Thus if a texture pixel is
RGB 255/255/255 (white) and the color value is
255/0/0 (red), subtracting with the Mix value
set to 100% gives the result 0/255/255 (cyan).

Multiply

The RGB value of the texture is multiplied by the
RGB value of the color. Multiply takes as its result
the lowest R value, the lowest G value and the
lowest B value of the texture and color. For
example RGB 255/128/0 (orange) multiplied by
RGB 0/255/0 (green) results in RGB 0/128/0 (dark
green).

Edit

If you have loaded a shader into the texture
pane, you can access its parameters by clicking
on the Edit button.

If instead you have a movie in the texture pane
(QuickTime, AVI or a frame sequence), click on
the Edit button to access the time controls for
the movie.

Movie Data

Use this pane to choose which frames you want
to use from the original movie. You also need to
set the frame rate of the original movie.

If you click on Calculate, CINEMA 4D sets the
From and To values for you (from the start of
the movie to the end of the movie). However,
the Frame Rate will be set to 30 frames per
second (FPS) by default. Change the frame rate
if your movie does not run at 30 FPS (perhaps
the movie is 25 FPS for PAL).

Example:

- Let’s say your movie (QuickTime, AVI or frame
sequence) has 600 frames (from 0 to 599) and
a frame rate of 15 FPS.

- To use frames 70 to 119, enter these numbers
as the From and To values. To play the movie
backwards, set From to 119 and To to 70.

Movie Sequence

Use this pane to tell CINEMA 4D how to play
back the animated texture.
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Mode sets the general playback mode: Simple
will play the movie once from start to finish;
Loop will play the movie from start to finish
repeatedly; Ping-Pong will play the movie from
start to finish to start repeatedly. With Loop, the
texture remains on the last frame of the movie
once it has finished playing.

Use Timing to set the timing of the movie. Exact
Frame will use one frame of the movie per frame
of your animation. No frames will be dropped. If
the movie and your animation use a different
FPS setting, the movie will play back either more
slowly or more quickly than the original. Exact
Second matches each second of the movie
against each second of your animation, which
ensures that the movie will be played back at
the same speed as the original. If you select
Area, CINEMA 4D will play the movie once over
a specified frame range (From and To) of your
animation. Use this option if you do not want
the texture to start playing immediately.

You can use Loops to repeat the movie a finite
number of times. If you set Loops to 1, the
movie will be repeated once.

Example:

- You want to play a movie (QuickTime, AVI or
frame sequence).

- Select the movie in the Texture pane of the
Material Editor.

- Click on the Edit button to open the Time
Controls.

- Click on Calculate.

- Close the Time Controls window.

- Result: the movie is played back once and is
second-synchronized.

Example:

- You want to play a movie from frame 25 to
frame 350 of your animation, forwards and
backwards (ping-pong) twice.

- Select the movie in the Texture pane of the
Material Editor.

- Click on the Edit button to open the Time
Controls.

- Click on Calculate.

- Set Mode to Ping-Pong.

- Set Timing to Area.

- Set Start to 25 and End to 350.

- Set Loops to 1 (with one loop, the movie will
be played twice).

- Close the Time Controls window.

- Result: the movie is played forwards and
backwards, then backwards and forwards
using frame 25 to frame 350 of your
animation.

MIP / SAT mapping tips
MIP and SAT mapping are very important for
top-quality rendering. MIP mapping is the
default sampling type.

The next two pictures demonstrate MIP/SAT
mapping. The first picture was rendered with
the antialiasing set to Always with 2 x 2
oversampling. The tiled texture used Circle
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sampling. Although the quality is relatively
good, you can see how it falls apart near the
horizon.

This effect is caused by perspective distortion.
Each screen pixel representing the floor near the
horizon contains perhaps hundreds or even
thousands of texture pixels.

MIP and SAT mapping approximate a value
using these pixels. Only an approximation is
made, since calculating the exact value would
increase render time greatly.

The picture below shows Edge antialiasing with
2 x 2 oversampling. The material used SAT
sampling. Now even the reflection in the sphere
looks great.

SAT and MIP mapping give you superb render
quality. As with most things wonderful, there is a
price to pay; MIP and SAT mapping love memory.

MIP mapping needs an extra byte of memory
per texture pixel. SAT mapping is even greedier,
consuming an extra 12 bytes per texture pixel.

So, although SAT mapping gives you higher
render quality than MIP mapping, MIP mapping
needs far less additional memory. Because of
this, MIP mapping is CINEMA 4D’s default
interpolation type.

As a rule of thumb, use MIP mapping initially,
then switch over to SAT mapping if required.

Interestingly, CINEMA 4D’s shaders use SAT
mapping automatically without consuming
additional memory.

MIP and SAT mapping will affect your render time.
On the one hand, MIP and SAT mapping take
longer to render. On the other hand, you may be
able to reduce the antialiasing setting. Sometimes
you can even work with just Edge antialiasing. In
any case, the superior render quality more than
makes up for a slight increase in render time.

MIP Falloff (Bump page)

Use MIP Falloff to help enhance the MIP/SAT
mapping effect for bump maps. This will reduce
the strength of the bump map with increasing
distance from the camera.
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The Material Editor Pages

Color
You use the Color page to set the basic color of
the material, e.g. RGB 255/0/0 (red).

If you want to create a more complicated
material (such as a chequered pattern using
several colors), use the Texture pane. The
texture is layered above the color. If you want to
see the color only and not the texture, set the
Mix value to 0%.

Note

If you set the Mix slider to 0%, the texture is not
loaded into memory since no calculation is
required.

Diffusion
The Diffusion page lets you darken and lighten the
material in specific areas using a diffusion map.
One reason why you might want to use a diffusion
map is to add dust or dirt to the material, helping
you achieve a more natural look. The diffusion
property is a must for photorealistic results.

You use either a conventional texture or a
shader as the diffusion map. (If the texture is
colored, it will still be treated as a grayscale
map.) The darker a pixel in the diffusion map,
the darker the corresponding region of the
material.

Select the Luminance option if you want to use
a diffusion map with the luminance property.
The darker a pixel in the diffusion map, the
darker the corresponding region of the
luminance. This helps you add irregularities to
the luminance to achieve a more natural look.
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The Specular option applies the diffusion map to
the specular property as well. This will reduce
the material’s specular values where the
diffusion map is dark. This option is selected by
default, since it enhances the realism
considerably.

Select Reflection if you want to apply the
diffusion map to the reflection and environment
properties for an even more natural look. The
darker a pixel in the diffusion map, the darker
the corresponding region of the reflection.

Luminance
A luminescent object can be seen even when
there are no lights in the scene. It is self-
illuminated.

You can use the Image button to load an image
that is to act as a luminance map. The brighter a
pixel in the luminance map, the more luminescent
the corresponding region of the material.

If you have chosen a Luminance Color and loaded
a texture (luminance map) as well, the color will be
added at 100% strength to the texture. If you
want to see the result without the chosen color
you can set the Mix slider to 0%.

Luminescent materials are used to help simulate
objects that seem to be self-illuminated in the
real world, e.g. the windows of an office block
late at night, neon writing, a TV screen.
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Transparency
You use this page to make a material transparent
or semi-transparent.

If your material also has a color, the color is
automatically reduced with increasing
transparency.

The equation is: color percentage +
transparency percentage = 100%

So a white material with 0% transparency is
white (100%). A white material with 50%
transparency is 50% white (gray). A white
material with 100% transparency has no color.

If you select the Additive option, the color
strength is not reduced automatically and unless
you take care the material will look unnatural.

Transparency is similar to a light filter; black lets
no light through, white lets all light pass.

You can use a texture as a transparency map.
The brighter a pixel in the transparency map,
the more transparent the corresponding region
of the material.

To control the transparency via the Transparency
Color only, set the Mix slider to 0%.
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A transparency texture is similar to a photographic
slide. Red parts of the slide allow only red light to
pass through; white parts allow all the light
through. With black, no light can pass through the
slide.

You can use a transparent material with a light
source to create a light map or gel. If a
transparent texture is assigned to a light source,
the light will be filtered according to the
texture’s coloration, just like a real gel. You can
use this effect to simulate disco lights, light cast
from a monitor and so on.

You can also simulate the refractive index of a
material by setting the n value on the Refraction
pane. There is, of course, no point setting the
refractive index unless the material is transparent
or semi-transparent.

Objects that are not closed (such as a hemisphere
without a cap) can give unexpected results with
refraction:

When a ray hits a surface with transparency and
refraction, the ray is bent to simulate refraction.
The bent ray is considered to be inside the
object. When the ray reaches another surface of
the object (the exit side), it is bent back as in
real life. If, however, you are using an open
object, the ray may not hit a second surface of
the object.

The raytracer will think that the ray is still inside
the object (e.g. the open hemisphere), because
it never meets an exit surface (which would
bend the ray back as in real life).

Avoid using open surfaces with refraction,
otherwise you may get unexpected refraction
results. In the example, you could effectively
close the open hemisphere with a second wall or
a cap; the important thing is to make sure there
is an exit surface, otherwise the ray still thinks it
is inside the object.

If you activate the Fresnel option, the viewing
angle (i.e. the angle between the camera and
the surface) will affect the transparency and
reflection values. If in real life you look at a pane
of glass with your eyes parallel to the pane (i.e.
with a 90 degree viewing angle), you will notice
that the pane barely reflects; almost all light
passes through. However, look at the pane from
a narrow viewing angle and you should see that
it reflects much more of its surroundings. The
transparency and reflection values are
dependent on the viewing angle. The Fresnel
option simulates this phenomenon for you.
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For example, if you have transparency with RGB
values 80%, 80%, 80%, the material is 80%
transparent and 0% reflective with a viewing
angle of 90 degrees. With a very low viewing
angle, the material is approximately 0%
transparent and 80% reflective.

If you have entered a reflection value in addition
to transparency, the reflection value is added to
the angle-dependent reflection.

If Fresnel is not selected, the transparency and
reflection values are used as they are,
irrespective of the viewing angle.

Note

If there are a large number of overlapping
transparent objects in your scene, you may
notice that some of the overlapping areas are
black when rendered instead of transparent. In
this case you need to increase the Ray Depth
value of the Render Settings (see page 431). You
may also encounter problems with the Threshold
default value of 15% (see page 432). Try
lowering the Threshold value to 0%.

Blur

Use these settings to blur the transparency.

Dispersion

This defines the strength of blur for the
transparency. 0% means no blur. Increase the
value to increase the strength of blur.

Accuracy

This affects blur accuracy by controlling the
number of samples per shading point. With a
value of 100%, the number of samples defined
under Max Samples will be used. Lower the
value to reduce the number of samples used.

Note

Increasing the Accuracy value gives a more
accurate blur but a longer render time also.

Left: low Dispersion value; right: high Dispersion value
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Min Samples / Max Samples

CINEMA 4D uses samples to create the blur effect.
Rather than take samples at even distances,
CINEMA 4D concentrates the samples where they
are most needed. Max Samples defines the
number of samples used for the most critical areas.
Min Samples defines the number of samples used
for the least important areas.

Note

Increasing Min Samples and/or Max Samples
means a higher quality blur, but a longer render
time also.

Some useful refraction values

Material n

Vacuum 1.000
Air 1.000
Ice (H2O) 1.310
Water 1.333
Glass 1.440 — 1.900
Obsidian 1.480 — 1.510
Onyx 1.486 — 1.658
Acrylic glass 1.491
Benzene 1.501
Crown glass 1.510
Jasper 1.540
Agate 1.544 — 1.553
Amethyst 1.544 — 1.553
Common salt 1.544
Amber 1.550
Quartz 1.550
Sugar 1.560
Emerald 1.576 — 1.582
Flint glass 1.613
Topaz 1.620 — 1.627
Jade 1.660 — 1.680
Sapphire 1.760
Ruby 1.760 — 1.770
Diamond 2.417 — 2.419

Reflection
Use the Reflection page to set a material’s ability
to reflect. The color that you set determines the
color of the reflection.

You can also use a coloured texture in the
texture pane — this is known as a reflectivity
map. The color of a pixel will affect the color
that is reflected from the corresponding area of
the material.

To control the transparency via the Reflection
Color only, set the Mix slider to 0%.
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The picture below shows some reflectivity
effects including a reflectivity map. The flask has
a simple reflective material. Note how the
reflection of the rod is distorted as you would
expect in real life.

Look closely and you will see that the flask itself is
reflected on the tiles. Look even more closely and
you should see that the flask is reflected on the
tiles but not on the joints, even though the tiles
and joints are part of the same tiled material.

This effect was created by using a grayscale
reflectivity map. The reflectivity map was based
on the original tile and joint texture. In the areas
covered by a tile the reflectivity map is white. In
the joint areas the reflectivity map is black. The
resultant map means that only the tiled areas,
not the joints, are reflective.

This is just one example of how you can
combine several properties to create more
realistic materials.

Note

If there are lots of reflective objects in your
scene, you may notice that with some of them
shadows do not appear in the reflections. To
make the shadows appear, increase the Shadow

Depth value of the Render Settings (see page
432). Similarly, you may notice that subtle
reflections are missing. In this case set the
Threshold value in the Render Settings to 0 (see
page 432).

Blur

Use these settings to blur reflections.

Dispersion values of 85% (left), 0% (back) and 65% (right)

Dispersion

This defines how diffusely the object reflects. In
other words, this defines how blurred reflections
are. 0% means no blur. Increase the value to
increase the strength of the blur effect.

Accuracy

This affects the accuracy of the blur — it works
by controlling the number of samples used per
shading point. If you enter a value of 100%, the
number of samples defined under Max Samples
will be used. Lower the value to reduce the
number of samples used.

Note

Increasing the Accuracy value gives a more
accurate blur but a longer render time also.
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Min Samples / Max Samples

CINEMA 4D uses samples to create the blur
effect. Rather than take samples at even
distances, CINEMA 4D concentrates the samples
where they are most needed. Max Samples
defines the number of samples used for the
most critical areas. Min Samples defines the
number of samples used for the least important
areas.

Note

Increasing Min Samples and/or Max Samples
means a higher quality blur, but a longer render
time also.

Environment
The Environment page uses a texture to
simulate reflection. Here, in contrast to the
other pages, the Color and Texture are
multiplied by the Mix mode (i.e. not added).

Why would you want to use the environment
property instead of reflection? One reason is that
your scene may not have enough objects in it to
produce good results with reflection. Another
reason is that the environment property renders
more quickly than the reflection property.
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Environment reflections are very useful for
simulating metal surfaces, which typically have
soft transitions from black to white.

The environment property is independent of the
projection type of the material. The environment
is always placed spherically around the object,
parallel to the world axis. Use Tiles to set the
number of tiles in the X and Y directions. Note
that these tile settings are used instead of the
tile options in the texture geometry (see page
548). The latter settings are ignored for the
Environment property.

Note

Environment reflections are rendered very quickly,
since the raytracing mode is not required.

The reflections on the BNC connectors were simulated using
the environment property only

Fog
With these parameters you can simulate fog or
gas clouds. Objects with such materials are
translucent but weaken the light that shines
through them, depending upon their density.

If a light ray penetrates into the fog, it is
weakened. You can control this weakening with
Distance. The larger this value, the thinner the
fog. Distance indicates at which distance a light
ray is completely weakened.

You can also color the fog and this also affects
its visibility. The further you look into the fog,
the less the objects are visible and the more the
fog color becomes visible.

The fog color therefore also depends on the
distance value. If you choose, say, a Distance of
500 units, a light ray of originally 100%
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intensity has an intensity of 50% after a
distance of 250 units while after a further 250
units it is extinguished completely.

The shorter the distance, the thicker appears the
fog. In addition to this effect, after 250 units
half the fog color is added to the light and after
500 units the full fog color is added.

You can use fog objects for the simulation of
smoke and vapor in mountain valleys or for
clouds, among many other things.

Fog objects should be always closed volume
objects. Non-closed objects can lead to
physically incorrect results since a light ray,
having once entered the object never again
emerges from the object. The raytracer then
assumes that the light ray is still lost in the fog.

In the illustration above the scene was placed
into a square filled with fog. Because of this it is
still possible to see any existing background
picture. If you use the Environment object
instead, you will not see the background picture.

Note

Fog uses the refractive index defined in
Transparency and disables the transparency. Fog
and transparency are thus never rendered
together, you can render either fog or
transparency.

Bump
Activate this option to produce a bump map, or
relief map, for your material.

When you select Bump you must always choose
a texture since it is only from the grayscales in
such an image that a bump map (a height or
relief map) can be calculated.

You can change the strength of the bump map
with the Strength slider. This value controls how
far the normal vectors of the object to which the
material is applied change when the bump is
calculated at render time. The higher the value,
the rougher the surface.

However, apply large values carefully since a
material can look pretty unrealistic with high
bump values due to the large jumps in lighting.
If you move the slider to the left, you can
choose negative values. If the strength is
negative, the bump effect is reversed; bright
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pixels within the map cause the material surface
to indent and darken while darker pixels elevate
the height of the normals.

Note

You can type in values over 100% (up to 500%).
This can be meaningful and useful if you are using
MIP or SAT mapping since, in those cases, the
bump map is rendered somewhat flatter than
usual.

Here is an even surface, viewed from the side.

Since during the lighting of such an even surface
the same normal vector is used, the surface shows
a uniform brightness. But if you use a bump
texture, CINEMA 4D interprets the brightness
values of the picture as height values for the
surface, as you can see in the following picture.

These height values are converted into a profile,
whose height affects the inclination of the
normal vectors. Although the surface is actually
smooth, through the change in the normal
vectors an apparently three-dimensional surface
with a bump-like structure is created at render
time; this is shown in the picture below.

You can strengthen the MIP/SAT mapping effect
when using bump mapping by enabling MIP
Falloff. The bump mapping effect is then
reduced more strongly with increasing distance
from the camera.

Left without, right with MIP Falloff
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Alpha
With the parameters of this page you can mask
particular parts of a texture by selecting an
image to apply to the material. There are two
ways to do this:

1 Use clip mapping to mask particular areas with
a color value.

2 Use alpha channels to mask areas softly and
more accurately.

The idea is to define areas of your material that
effectively become non-existent so that any
underlying materials show through.

The difference between the two modes is that
with clip mapping color seams can be visible
around the masked texture.

Using soft alphas this can be avoided. Further,
using soft alphas you can fade textures and
materials from one to another, which gives you
even more ways of creating realistic-looking
objects.

If you switch off Soft, you can choose the color
that is to be masked (this is what is known as
clip mapping); alternatively you can click on the
texture preview picture and pick any particular
color that exists in the material’s color.

By setting values for dr (delta red), dg (delta
green) and db (delta blue) you can define extra
color deviations; in this way the color seam
around the masked color can be adjusted.

Similarly, alpha masking is often attempted with
texture images that are antialiased; this produces a
bright border around an object caused by the
antialiasing of colours between the main texture
and the alpha color; by adjusting the deviation
sliders you can remove this border.

With Soft enabled (the default setting) the color
and delta sliders lose their meaning. The texture
map is now used to decide which ranges should
be faded. A white texture pixel within the image
means that here the material is to be 100%
opaque. If the texture pixel is black the
underlying material shines through 100%.

With Image Alpha checked you can use any
existing alpha channel of the loaded image.

The alpha channels of the image formats TIF,
TGA, PICT, Photoshop PSD and QuickTime
MOV are supported (as well as all QuickTime
supported formats).

If no alpha channel is present, the option Image
Alpha will be ignored.

Use the Invert function to invert the result of
your alpha operation without having to rework
the texture in your image processor (e.g.
Photoshop, PaintShop Pro).

Note

Many of the built-in shaders have built-in alpha
channels (see Shaders below).
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The simple clip mapping does not work with
MIP and SAT mapping — only if you work with
alpha channels can you use MIP and SAT
mapping.

If many alpha materials are present on an
object, it can happen that some underlying
materials are not calculated at render time or are
rendered partly with black areas. If this is the
case, increase the Ray Depth option in the
Render Settings (see page 431).

Likewise, the preset Threshold value of 15%
(see page 432) can lead to unexpected jumps in
the rendering of animations. If that is the case,
you can avoid it by reducing the threshold value
to 0%.

If clip mapping or alpha mapping affects a part
of the surface, then the underlying material
becomes visible. If the object does not have an
underlying material, the object will be non-
existent at this point.

Example:

- If you want to place, say, a scanned picture of
a tree into a scene, you will create a material,
enable the Color channel, choose a picture of a
tree as the color texture/image and then assign
this material to, perhaps, a rectangular
polygon.

- If you render this scene you should see the tree
on the rectangle polygon. However the area
around the tree is probably not transparent but

may well be blue, if the scanned picture has a
blue sky background.

- So now edit your tree material, check the
Alpha option, switch to the Alpha page and
load the tree texture there as well.

- Now simply use the mouse to choose the color
which you want to mask — in our case the
blue sky around the tree.

- CINEMA 4D immediately sets the color sliders
to this color and masks according to the
picture.

- You should now see only the tree without
surrounding background (yes, in the viewport,
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assuming you have Gouraud Shading or Quick
Shading on).

- You can now select a slightly different color on
the Alpha page, click Refresh and see the
effect immediately.

- However it may happen that there is still some
background left around the leaves, branches
and the trunk. So the result is not quite right
yet.

- To obtain a more accurate result, create an
alpha channel in your favorite image processor
(e.g. Photoshop, PaintShop Pro) and integrate
this into your tree image — for details on how
to do this consult you image processor manual.

- Then load that picture into the Alpha page and
check Soft and Image Alpha. Now the texture
is masked cleanly.

In the illustration below two materials have
been used, a reflecting gold and a matt wood.
To make the wood visible, one of the two
colours was cut out (i.e. genlocked) from a
scanned black-and-white graphic.

The section on texture mapping describes the
handling of several materials in detail, starting
on page 537.



514 • MATERIAL MANAGER • CHAPTER 18

Specular

Here you can adjust the width, height and falloff
of the specular, or highlight.

If you want a matt surface you should select
broad and low specular values; for polished and
shiny surfaces, however, narrower and higher
values are appropriate.

You can also choose between three lighting
models for the surface:

With Plastic the color of the specular is
independent of the color of the material i.e. it
will normally appear white. This mode is
particularly useful for materials such as plastics,
glass or wood.

With Metal the color of the specular is
calculated from the material color. This lighting
model is well suited to matt (i.e. not highly
reflective) metal surfaces such as silver, brass
and gold.

Note

You can enter values over 100% (up to 1000%)
for the height of the specular to achieve almost
any result you want. To do this you must enter
the values, numerically, into the box and not use
the slider. High values can be very effective if
you are using the Metal mode.

With Colored, you influence the specular
diffusion. See the description for the Specular
option on page 501.
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Specular Color
Here you can select the color of the specular.
The strengths of the Color page and the
Specular Color page are added together.

The total color here is multiplied with the
normal color of the highlight. If, for example,
you have a white plastic highlight, you can
define its color here directly.

The intensity of the specular is affected by any
chosen texture image (color or grayscale). The
brighter a pixel in the image, the more evident
the highlight is at that point.

We have found that, with metallic effects in
particular, any highlight color other than white
adds to the realistic appearance of the material.
The example above of a spaceship surface
shows this quite clearly.
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Glow
This property enables you to create a glow, a
kind of halo that emanates from the object and
surrounds it.

Inner Strength specifies the intensity of the glow
above the material surface; Outer Strength is
the intensity of the glow at the edges.

The Radius determines how far the glow is to
extend from the object. This value is rendered
relative to the distance of the object from the
camera. The further the object is, the smaller the
glow and vice versa.

If a random percentage is defined, the intensity
of the glow in each animation frame is increased
and decreased in a random pattern, as follows:

0% No change

100% Maximum change

Frequency specifies how often you wish the
glow to change. The amplitude of the change is
given by the Random value.

1Hz the glow reaches a new random value
after 1 second

25Hz the glow has a new value for each
frame (for 30 fps), which causes a
flicker

Selecting Use Material Color causes the glow to
be calculated on the basis of the material color,
rather than from the color specified here. If this
option is turned off, the object color and the
glow color will be mixed; green objects, for
example, will appear yellowish under a red glow.

Above are two examples of using glow. For the
neon advertisement, only an outer glow was
used. The charcoal the glowing areas were
created with Use Material Color.
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Notes

The glow you specify here does not act as a
light; other parts of the scene will not be lit by
the glow, nor will any shadows be cast.

Glows cannot be seen through transparent
objects, nor in reflections.

Glows are restricted to a maximum image
resolution of 4,000 x 4,000 pixels.

When object motion blur is in use, applying
glow to lights may result in an unwanted
overlapping of colors.

Displacement
Displacement is similar to Bump, the difference
being that here the object is actually (not just
apparently) deformed.

This difference is best seen at the edges of
objects. Look carefully at the illustration below.
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A bump texture has been applied to the left half
of the sphere, a displacement texture to the
right. The bump region is characterized by a
smooth edge, the displacement region has
distinct deformities; as a consequence of the
actual deformation, the shadows on the inside
of the sphere’s surface have changed slightly.

Adjust the strength of the displacement with the
Strength slider. Under Maximum Height you
specify a distance from the object surface which
may not be exceeded whatever the Strength.

The illustration above shows that complex
models can be created using relatively simple
means.

Experiment with objects that have different
subdivisions, although keep in mind that it is
easy to go over the top and create an
unnecessarily large scene.

Note

It is in the nature of the displacement effect that
objects must be finely subdivided for this effect
to work (see page 373).

Since the displacement mapping moves the
points of an object this material property does
not have any effect on parametric objects.
Displacement works only with objects that
possess points.

Illumination
Use this page to control aspects of material
illumination. Here, you can switch on/off
radiosity and caustics for the material (both are
switched on by default). You can also change
the illumination model used for shading.

Global Illumination

Generate

When the option is enabled, the material will
generate radiosity. Use the input box to set the
strength of the radiosity — you can enter values
from 0 to 10000%. 100% represents normal
strength.

Receive

If this option is enabled, the material will receive
radiosity. The value in the input box defines the
strength of the radiosity effect.
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Caustics

Generate

Use this option to enable the generation of
caustics by the material. The input box defines
the strength of the caustics generated.

Note

The material must be transparent and/or
reflective in order to create a caustics effect.

Receive

This enables/disables the reception of surface
caustics by the material. Use the input box to
set the strength of the effect.

Note

The receive option has no effect for volume
caustics.

Sample Radius

In order to calculate the brightness of the
caustics effect, photons within a certain distance
of the pixel to be rendered are interpolated to
calculate the brightness. The Sample Radius
defines this distance.

Sample Radius = 1; individual photons can be seen as points of
light because they are not interpolated together

Sample Radius = 10

Sample Radius = 100

Samples

This defines the maximum number of photons
within the Sample Radius that are used for
calculating the effect. For example, if you enter
a value of 100, up to 100 photons will be
evaluated — any photons beyond this number
are ignored.

Samples and Sample Radius both affect the
quality of the effect. To summarize:

More samples per sample radius means a more
accurate image. Increasing the sample radius
means more blur, but a longer render time also.
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Illumination Model

The illumination model — aka the shading
model — controls the way the material is
shaded (e.g. it controls the nature of highlights).
You can affect image quality by changing the
illumination model — some models are more
realistic than others for certain types of surface,
e.g. Oren-Nayar is a good choice for textile-like
surfaces.

Model

Here, choose the illumination model for the
material.

Phong is suitable for smooth surfaces

Blinn is suitable for smooth surfaces; creates
rounded highlights, making it a better choice
than Phong for shiny objects

Oren-Nayar is suitable for textile-like surfaces

Diffuse Falloff

Controls the falloff of diffuse reflection for the
illumination model. The default value of 0%
means normal falloff.

Diffuse Level (Oren-Nayar only)

Controls the strength of diffuse reflection. The
default of 100% means normal diffuse reflection
— enter a lower value to reduce the amount of
reflection.

Roughness (Oren-Nayar only)

Defines the roughness of the reflection. The
default setting is 50%.

The Shaders
Shaders (aka procedural textures) are more
sophisticated than conventional textures.
Shaders are computed using mathematical
formulae whereas conventional textures are
pixel-based. One advantage of shaders is that
they do not become pixelated when viewed
close-up.

CINEMA 4D distinguishes between two-
dimensional and three-dimensional shaders. 3D
shaders take an object’s volume into account,
whereas 2D shaders and standard textures are
simply applied to the object’s surface. 3D
shaders are independent of the object’s
geometry and the texture projection type (an
exception is that UVW projection can be applied
to volume shaders).

Most of CINEMA 4D’s shaders can be loaded in
the Material editor in the same way you would
load a conventional texture. However, there are
a few 3D shaders (Fog and Terrain) that cannot
be used in this way — these shaders must be
loaded using New 3D Shader — see page 488.
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2D Channel Shaders
2D shaders are always flat and are applied to an
object using a particular type of projection (see
page 539).

2D shaders are loaded in the Material editor in
place of image textures or movies. To open a 2D
shader click on the right-facing triangle, which is
to the right of the Image input field in the
Texture pane. This opens a pop-up menu from
which you can select the appropriate shader.

To edit a 2D shader, click the Edit button in the
Material editor.

Brick

This shader generates brick patterns. The Brick
shader has an alpha channel which you can use
within the Material editor on the Alpha page.

Color 1 determines the color of the brick.

Color 2 determines the color of the joints.

Joint is the width of the joint relative to the size
of the brick.

Bevel defines the width of the sloping edge
between joint and brick, as a percentage of the
brick width; this gives a fuzzy edge to the brick.

Note

You change the number of bricks using the
texture tiling.
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Checkerboard

This shader creates checkerboard patterns.

Color 1 and Color 2 determine the colours of
the two tiles.

U-Frequency and V-Frequency determine the
size of tiling, the fineness of the structure, in
two independent directions. Higher values result
in a smaller tiles and vice versa. If you use
unequal values such as 1/2, instead of square
tiles you’ll get rectangular ones.

Cloud

This shader simulates simple cloud structures. The
Cloud shader has an alpha channel which you can
use within the Material editor on the Alpha page.

Color 1 determines the color of the sky.

Color 2 determines the color of the clouds.

U Frequency and V Frequency determine the
fineness and shape of the structure. Thus 1/1
results in rather regular cloud structures, 1/0.25
rather rectangular clouds and the higher the
value, the finer (less wispy) the clouds.

Clouds affects the number of clouds in the sky.

Note

Effective Cirrus-like clouds can be created with
asymmetrical UV parameters (e.g. 0.25/1).
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Cyclone

This shader simulates a cyclone. The Cyclone
shader has an alpha channel which you can use
within the Material editor on the Alpha page.

Color 1 and Color 2 define the start and end
colours for the color transition.

T Frequency defines the timing of the cyclone
rotation, the strength of the storm.

Rotation determines the effective density of the
cyclone, the higher the value the more spirals in
the storm.

Clouds affects the number of clouds (Color 1
areas) in the cyclone.

Flame

This shader simulates a single flame, such as a
candle. The Flame shader has an alpha channel
which you can use within the Material editor on
the Alpha page.

T-Frequency is a scaling factor that affects the
speed of flicker, how quickly the flame changes.

Turbulence determines how violently the flames
break up in a notional wind. A setting of 2
doubles the wind; a setting of 0 suppresses all
wind.
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Fire

This shader simulates a wall of flame. The Fire
shader has an alpha channel which you can use
in the Material editor on the Alpha page.

U-Frequency and V-Frequency determine the
fineness of the structure. Thus 1/1 results in
regular flames, 1/0.25 rather elongated flames.
T-Frequency affects the speed of the flicker, how
quickly the flames change — the higher the
value, the higher the faster the flicker.

Turbulence determines how violently the flames
break up in a notional wind. A setting of 2 doubles
the wind; a setting of 0 suppresses all wind.

Note

The wall of flames stretches infinitely in the U
direction. Good flame materials can be created
by using this shader both in the Alpha channel
and the Transparency channel (in the Alpha
channel, dr/dg/db should be set relatively high,
to approx. 30%).
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Galaxy

This shader simulates a galaxy with spiral arms.
The Galaxy shader has an alpha channel which
you can use within the Material editor on the
Alpha page.

Color 1 is the color of the star clouds.

Angle is the degree of rotation of the spiral
arms.

Spiral Arms is the number of spiral arms.

Gradient

This shader creates a smooth gradient between
two colours.

Color 1 and Color 2 specify the start and the
end colours for the transition.

Mode gives the type of the gradient. Axial is
color gradient along a line, the orientation of
which is defined by Angle (see below). Radial is
a radially expanding gradient starting from the
center of the texture.

Angle gives the direction of the (axial) color
gradient. 0° is the X axis, 90° is the Y axis, etc.
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Marble

This shader creates marble structures.

Color 1 and Color 2 determine the marble
coloring.

U-Frequency and V-Frequency determine the
fineness and shape of the structure. Thus, for
example, 1/1 results in a radial-like pattern, 1/
0.25 rather elongated shapes. The higher the
value, the higher the frequency, or detail, of the
pattern.

Turbulence gives a static factor that adds a
certain amount of noise to the detail. 0% = no
turbulence.

Neptune

This shader has no dialog. It simulates the planet
Neptune with its typical colouring and cloud
structure.
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Noise

This shader creates a random pattern that can
be used, for example, for sun surfaces and stone
reliefs.

By overlapping several Noise shaders with
different amplitudes and frequencies, you can
create masses of interesting patterns (this is like
signal synthesis).

Color 1 and Color 2 determine the start and end
colours of the transition.

U-Frequency and V-Frequency determine the
fineness of the structure. Thus, for example, 1/1
results in a radial-like pattern, 1/0.25 rather
elongated shapes. The higher the value, the
higher the level of detail in that direction.

Saturn

This shader has no dialog. It simulates the planet
Saturn with its typical coloring and cloud
structure.

The texture is cyclic in the U direction.

Tips

Because of its fast rotation speed (a mere 10
hours) Saturn has an elliptical shape. If you want
an astronomically accurate representation of the
planet, you will need to flatten any sphere to
which this shader is applied — in other words its
Y axis should be scaled by about 0.85.

If you mix the Saturn shader with, say, a brown
color (50% shader/50% brown color) you can
simulate many rock formations which you can
then project on to a Landscape object.
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Saturnring

This shader has no dialog. It creates, for use
with the Saturn shader, an astronomically
correct simulation of the rings around Saturn —
the D, C, B, A, F and G rings, with the Cassini
and Encke gap.

The Saturnring shader has an alpha channel
which you can use within the Material editor on
the Alpha page.

Tips

Saturn is approximately one third as wide as the
width of the ring structure.

So that stars shine through between the rings,
you should activate the alpha channel of any
material to which this is applied.

You may want to make the rings quite
transparent since in reality these rings are
millions and millions of tiny rock and ice
particles which allow the light from beyond to
shine through.

Stars

This shader creates a star-filled wallpaper.

Color 1 is the color of the wallpaper.

Color 2 is the color of the stars.

Points is the number of star tips or points.

Inner Radius and Outer Radius determine the
dimension of each star, given as a percentage of
a U/V unit.

Stars is the average number of stars per UV
unit.

Although we use the term U/V unit above
accurately, you may want to think of the
preview as an element that is one U/V unit in
each direction — this will help you visualize the
changes you make.
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Starfield

This shader has no dialog and simulates a starry
night. The number of stars can be controlled by
tiling the texture.

Note

The stars are always computed with a
continually varying size. In addition, the
brightness of the stars varies. Thus you should
have the impression that some stars are closer
than others.

Tip

If you project the Starfield shader with spherical
projection on to the sky object, you will obtain
an accumulation of stars at the North and South
Pole of the sky, since the shader is compressed
here. You can avoid this if you use cubic
projection instead.

Sunburst

This shader generates sun flares and eruptions.
The Sunburst shader has an alpha channel which
you can use within the Material editor on the
Alpha page.

R Frequency determines the radial frequency; a
value of 0 yields a lovely aurora.
A Frequency gives the angular disturbance; 0
gives individual layers.
T Frequency defines the speed of the sunburst;
2 doubles it, 0 prevents all movement.
Turbulence changes the appearance of the
eruption; the higher the value, the more
fragmented this region appears.
Radius defines where the eruption begins, as a
percentage of the overall size.
Height defines the width of the eruption region
relative to the radius.
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Turbulence

This shader creates colored, fractal turbulence.

Color 1 and Color 2 specify the ends of the
color transition.

U Frequency and V Frequency determine the
fineness of the structure. 1/1 creates a radial-
like pattern, 1/0.25 elongated shapes. The
higher these values, the greater the detail (or
frequency) in the relevant direction.

Steps is the number of iteration steps for
generating this fractal turbulence.

The more steps you have the more added detail
you obtain. With a setting of 1 the Turbulence
shader is almost identical to the Noise shader;
there is no point in setting this value too high since
only a certain amount of detail can be added.

An example of using the Turbulence shader on a cube

Uranus

This shader has no dialog.

It simulates the planet Uranus with its typical
colouring and cloud structure.
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Water

This shader generates water surfaces and is ideal
for use in a material’s Bump channel for
simulating water surfaces perturbed by wind. It
can simulate slight turbulences (ripples) and
more significant ones (waves).

U Frequency and V Frequency determine the
fineness of the structure. 1/1 creates radial-like
wave patterns, 1/0.25 rather elongated wave
fronts. The higher the values, the higher the
effective wave detail in that direction.

T Frequency is the speed at which the water
moves in the U direction (0 means no
movement, 2 doubles the speed of movement).

Wind specifies the amplitude of a wind that
breaks up the water — the higher this value the
more the wind disturbs the water surface.

3D Volume Shaders
3D shaders are also known as volume shaders
because they penetrate the volume of the object
and emerge on its surface.

Most of CINEMA 4D’s 3D shaders can be
loaded in the Material editor in the same way
you would load a conventional texture.
However, Fog and Terrain must be loaded using
New 3D Shader — see page 488.

A 3D shader will always adapt to the size of (or
grow on) the 3D object to which it has been
applied. There will be no edges or seams. Since
they exist throughout an object’s volume, 3D
shaders can give much more realistic results
when applied to objects that have areas cut out.
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Color

This colourful shader uses sine functions to cycle
through the RGB color range.

X-Frequency, Y-Frequency and Z-Frequency
specify the behaviour of the colours: e.g. high
values mean more detail in that direction,
different values for X, Y and Z give asymmetrical
behavior.

Earth

This simulates an Earth-like planet with mountains.

Sea Level determines the color for areas which
have a height of less than zero.

Land Level is the color for middle height terrain.

Mountain Level is the color for high terrain.

Bump gives the degree of bump mapping —
0% means a smooth surface with only patches
of color. Note that water is always smooth; only
land areas should be covered with a relief.

Frequency adjusts the level of land detail. 0% is
practically all water; 50% is equal parts of land
and water; 100% is practically all land.

Specular is the specular factor, which appears
only on water surfaces. 0 is none; 1 is large; 50
is small; 150 is very small
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Fog

This shader simulates a volumetric fog.

General pane

Samples defines the average number of samples
that need to be computed per raytracing ray.
The higher this number, the greater the quality
of the fog but the longer the calculation time.

Tip

Start with low numbers, say 6 or 8. Increase this
value only if you get disturbing artifacts or if the
detail is not good enough. After a certain point
(depending on what’s in the scene) higher
sample values will not produce better images.

Volumetric is the ultimate performance killer. If
the option is switched off, the basic color of the
fog is all pervading. Light sources have no
effect. This is normally sufficient to simulate fog
in a fractal valley. With Volumetric switched on,
all light sources (including the type of the light
source) will be taken into account. If the light

sources cast soft shadows and there are objects
in the beam, these will cast shadows even in
fog.

X-Frequency, Y-Frequency and Z-Frequency
determine the appearance of the fog: double
the values to get twice as much detail, use
different values for X, Y and Z for asymmetry.

Fog pane

Color is the color of the fog. The pop-up allows
you to control the fog intensity over distance.
Linear decreases the fog intensity along the Y
axis of the texture axes. Exponential decreases
the fog intensity along the Y axis of the texture
axes. None means constant fog density.

Thickness: the lower this is, the thinner the fog.

Decrease: the lower this value, the lower the
volume (or depth) of fog that is generated.

Turbulence pane

In addition to the above parameters you can
also create turbulent fog patches. Turbulence
specifies the degree of whirl within the fog (0 =
no turbulence). Amplitude specifies the average
size of the rotating turbulence cells  (rolling fog).
T-Frequency controls the speed of the swirling
fog (0 = no movement).
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Marble

This shader generates 3D marble structures.

Color 1 and Color 2 specify the marble coloring.

Reflection is the degree to which the
environment is reflected in the marble. To see a
weak reflection you will need to switch on
reflection in the Render Settings and possibly
reduce the Threshold from its default 15%.

Specular determines the factor for the
specularity. 0 is none; 1 is large; 50 is small; 150
is very small, etc.

X-Frequency, Y-Frequency and Z-Frequency
determine the detail of the marble in those
directions (e.g. double values mean twice as
much detail). Use different values for X, Y and Z
for asymmetry.

Turbulence changes the overall complexity of
the marble.

Metal

This shader simulates metallic surfaces.

Color specifies the color of the metal.

Bump and Frequency define the roughness of
the surface. The surface is reflective and
optionally takes a metallic specular.

The strength of the reflection is determined by
the Reflection setting.

Specular is the strength of the specularity.
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Rust

This shader simulates rust on metal surfaces.

You choose the colours for the metal and the
rust using the Metal and Rust color boxes.

Rust specifies the percentage of rust on the
metal surface.
The rust is initially flat. It can be raised by
optionally using the Bump (relief) setting.
Frequency determines the degree of jaggedness
of the rusty areas.
You define the degree of reflection of the clean
part of the surface with the Reflection setting.
The rust-free areas are reflective and may be
enhanced by an optional metallic specular.
Specular defines the size of this specular.

Terrain

This shader generates virtual, fractal landscapes
featuring mountains and valleys. The pop-up
menu at the top allows you to select from a list
of predefined types of terrain or to start from
scratch with user-defined.

Using the buttons below the pop-up menu you
can assign colors to different heights of terrain.
The values are percentages of the fractal height.

Height defines the vertical dimension of the
fractal within a 3D object. With a value of 50
the fractal covers half the object (assuming the
texture is adapted by size to the object).

The Terrain shader is not infinitely large. Its
maximum size is determined by the size of the
texture geometry. If this is smaller than the
object on which the shader is used, the shader
does not fill the object. If necessary adapt the
size of texture geometry to the object.



536 • MATERIAL MANAGER • CHAPTER 18

Venus

This shader simulates a gaseous planet with
cloud structures whirled around by the Coriolis
stream.

Color 1 and Color 2 define the colours of the
clouds and the background sky.

Rotation determines the degree of whirl or
turbulence caused by the Coriolis stream.

X-Frequency, Y-Frequency and Z-Frequency
determine the fineness of detail in those
directions.

Wood

This shader simulates wood patterns. The pop-up
menu at the top allows you to choose some pre-
defined wood types (which you can then change)
or go for a user-defined wood from the beginning.

Color 1 and Color 2 change to color of the
wood and its grain.

X-Frequency, Y-Frequency and Z-Frequency
affect the look of the wood. X and Y change the
frequency of the rings in those directions (high
values lead to fine detail) while Z affects the
grain — for example, values of X=0.5, Y=1 and
Z=1 will produce elliptical rings.

Turbulence determines the degree of growth
irregularity (0% = even concentric annual rings,
100% = a more natural, uneven ring
appearance).
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Texture Mapping
You can apply a texture to an object in the
following way:

- First, make sure that you can see the object in
the Object manager. Then, hold down the left
mouse button while you drag the material
from the Material manager and drop it on to
the name of the object in the Object manager.
The Texture geometry dialog will open for you
to enter details of how to apply the texture.
This dialog can be skipped if you hold down
the Shift key while dragging the material on to
the object.

The mouse pointer will change during this
process to indicate the add state.

- You do not have to use drag-and-drop, you
can also use the following method: first,
activate the object in the Object manager, then
activate the material in the Material manager.
Now select Function > Apply in the Material
manager. The Texture geometry dialog will
open for you to enter details of how to apply
the texture. Once this dialog is OK’d the active
material will be allocated to the active object.
(This dialog can be skipped if you hold down
the Shift key while dragging the material on to
the object.)

- You can drop a new material on to an existing
texture geometry. The new material will
replace the old one but will inherit the existing
geometry settings.

If the material does not use texture maps (pure
glass, for example) or if it a 3D shader, you will
not need to change any settings in the Texture
dialog; you can click on OK to close the dialog
immediately. Such materials do not use the
texture geometry settings.

If, on the other hand, your material does use
texture maps, you will need to set the Texture
geometry dialog to specify the projection type,
the position of the texture and so on.

Texture Geometry Dialog
The Texture geometry dialog opens when you
allocate a material to an object. The settings in
this dialog tell CINEMA 4D how to apply the
material.

For example, you may want the texture to be
tiled (i.e. repeated), or you may want to place
the texture in a specific region of the object. You
can also have the texture mapped on one side
only (decal mapping). In this chapter we will
explain all the options in the Texture geometry
dialog.
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Note

Remember, to prevent the Texture geometry
dialog opening hold down the Shift key when
you apply the texture. This is particularly useful
for 3D shaders or materials that do not use
textures, since they do not use the texture
geometry settings.

Search for

The first text box contains the name of the
material that is being applied. If you type in the
name of a different material, CINEMA 4D will use
the new material instead of the previous one for
this texture geometry. Also, note that you usually
need type only the first few letters of the name,
since CINEMA 4D will complete the rest of the
name for you in the area to the right of Name.

Comment

Perhaps you are wondering why you must type
in the material name rather than select it from a
list. Imagine that you have started a new project
and you have loaded your standard material
library, which contains 100 woods, 50 marbles,
20 relief textures, 30 backgrounds and so on.
You want to add one of the mahogany textures
to an object. Up pops the selection window and
“OK, it’s down here somewhere... Down a bit
more... Oops, missed it. Back a bit...”

Once you have become accustomed to typing in
material names (and giving your materials
sensible names), you should find this a much
more efficient way to work.

Offset, Length, Tiles

These settings are to be found towards the
middle of the dialog. Offset and Length set the
position and size of the texture respectively on
the texture geometry. You can also change these
values interactively in the viewports with the
Texture tool active (see page 306).

Offset defines the position of the texture on the
texture envelope (the texture geometry). You
can use Length to increase or decrease the size
of the texture on the texture envelope. The
Offset X and Offset Y values are given as
percentages, since the actual size is irrelevant.
100% for both means that the texture covers
the envelope completely.

The Tiles X and Tiles Y values define how many
times the texture fits on to the texture envelope
in the X and Y directions. Hold on a moment,
isn’t that the same as changing the length? Yes,
exactly. You can change the length either in
terms of tiles (Tiles) or as a percentage of the
texture envelope (Length). Either way, changing
one will cause the other to change too.

Using the Tiles X and Tiles Y settings does not
mean that the texture will be repeated (tiled)
automatically. This only happens if you activate
the Tile option.

You can read more about the Tiles and Tile
settings on page 548.

Position, Size, Rotation

These settings appear near the bottom of the
dialog window. You can also change these
values interactively in the viewports with the
Texture Axis tool selected (see page 306).

The following pictures show you the difference
between the Texture and the Texture Axis tools.
Both pictures demonstrate a movement in the X
direction. In the first picture, the texture is moved
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about the texture envelope (Texture tool, Offset).
In the second picture, the texture geometry itself is
moved (Texture Axis tool, Position).

The texture geometry can be shown either as a
texture grid or as a realtime texture. You can set
this option globally (enable Display > Textures
in the viewport), or you can give the object its
own (local) Display tag with this option on or off
(see page 463).

Projection (Mapping Types)

The Projection setting determines how the
texture is projected or mapped on to a surface.
The projection surface is independent of the real
surface of the object, although often it has the
same basic shape.

UVW mapping (which is explained in more
detail later) fixes the projection on to the surface
points of an object so that, when the object
surface is deformed (like a flag would be in the
wind), the texture deforms with it.

The best mapping type to use depends on the
shape of the object to which you apply it.

First let’s take a look at some examples for the
first three mapping types (spherical, cylindrical
and flat) and then we’ll describe the others with
fewer examples.

You can change the mapping type using the
Projection pop-up menu in the Texture
geometry dialog.
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Spherical

Spherical mapping projects the texture on to the
object in a spherical form.

Spherical mapping applied to a plane

Spherical mapping applied to a cylinder

Spherical mapping applied to a sphere

Spherical projection is rarely suitable for flat
objects. There is distortion with cylindrical
objects too.

Cylindrical

This mapping type projects the texture on to the
object in a cylindrical shape.

Cylindrical mapping applied to a plane

Cylindrical mapping applied to a cylinder

Cylindrical mapping applied to a sphere

Cylindrical projection is rarely suitable for flat
objects. It also leads to distortion when used
with spherical objects. Notice how the pixels
near the top and bottom of the texture map are
pulled inwards on the caps. You should apply
separate textures to the caps.
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Flat

Flat mapping projects the texture on to the
object in a planar direction.

Flat mapping applied to a plane

Flat mapping applied to a cylinder

Flat mapping applied to a sphere

Flat projection tends to be used with flat objects
only. The texture is soon distorted when applied
to a sphere or cylinder, as the examples
demonstrate.

Cubic

Cubic mapping projects the texture on to all six
sides of a texture cube.

Cubic mapping applied to a cuboid

We have halved the size of the texture above
left so that you can see the mapping more
clearly. In the rendered picture the texture
length has been restored to 100%.

Frontal

The texture is projected from the camera
position on to the object. This ensures that, it
you project the texture on to a polygon object
and on to a background object, the two textures
match exactly (assuming the texture geometry
for both objects use the same offset and length
values).

Frontal mapping applied to a cuboid

Frontal mapping can create spectacular effects.
You can even perform compositing directly in
CINEMA 4D (more later). The picture above
shows how the cube blends into the background
using frontal mapping — only the cube’s shadows
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are visible. You have probably seen science fiction
films where characters or spaceships gradually
disappear into the background or are only partially
visible. It’s easy when you know how!

For another interesting effect, try removing the
background object, then move the cube around.

Spatial

Spatial mapping is similar to flat projection.
However, with spatial mapping, the texture is
pulled up and to the right as it passes through
the object.

The difference between flat and spatial mapping

On the left, notice how flat projection can lead
to unattractive stripes. The picture on the right
shows how spatial mapping solves this problem.

Spatial mapping does, however, cause some
distortion and as such it is not suitable for
photographic images. Spatial mapping is more
suitable for structure textures (e.g. marble,
plaster, ...).

UVW Mapping

If an object has UVW coordinates you can select
them as the projection type. In this case the
texture geometry is fixed to the object surface
and is subject to all subsequent movement and
deformation applied to the object.

A classic example of UVW mapping is the page
of a book as it is being turned. First you must fix
the texture (e.g. ornate text and a pretty

picture) to the page using UVW mapping. Next,
you animate the turn of the page with a
deformation. The texture bends with the page.

All of CINEMA 4D’s primitive objects and
NURBS objects have UVW coordinates. If you
apply a new texture to these objects, the
projection type in the texture geometry will
default to UVW mapping.

All polygon objects with UVW coordinates
display a UVW coordinates icon in the Object
manager.

In the illustration above, flat projection was used
for the object on the left, UVW mapping for the
one on the right. Notice how the UVW texture
has been deformed along with the object.
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Primitive objects and NURBS objects have
internal UVW coordinates and do not display a
UVW icon in the Object manager. You can still
use UVW mapping with these objects. If you
convert a primitive object or a NURBS object
into a polygon object, a UVW coordinates icon
will appear in the Object manager.

You may be wondering why there are three
coordinates (UVW). What is the third coordinate
for?

Conventional textures have two coordinates,
one for the horizontal position X, and one for
the vertical position Y. In order to make it clear
that the coordinates refer to a texture, X is
renamed U, and Y is renamed V.

Two coordinates (U and V) would be sufficient
were it not for 3D shaders. These are three
dimensional textures (see The Shaders,
page 520), and as such they require a third
coordinate (W) in order to be fixed to the
object.

You can apply more than one UVW texture
geometry to an object. Create a new texture
geometry for the object, then set the projection
you require, e.g. flat mapping for a label
texture.

Next, create new UVW coordinates for the
active texture by selecting Generate UVW
Coordinates in the Object manager. The active
texture geometry will be set to UVW mapping
and will deform together with the object.

Your object will now be able to cope with the
worst enemies of texture mapping (magnet,
bones...).

What is the structure of UVW coordinates?
Imagine a grid divided into a U direction and a
V direction.

The UV range starts at 0,0 and ends at 1,1. For
an upright polygon 0,0 describes the top left;
0,1 the bottom left; 1,0 the top right and 1,1
the bottom right. A texture is stretched out
between these four coordinates.

But where is the W coordinate in this system?
Recall that conventional textures are two-
dimensional — the W coordinate is created only
when it is needed. Once created, the W
coordinate behaves in the same way as the UV
coordinates.
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Selective UVW mapping

CINEMA 4D has two ways of allocating texture
projections to polygon selections (rather than to
the whole object as described above). The first
method is described below. The second method,
Restrict to Selection, is described on page 551.

Selective UVW mapping allows you to apply a
different projection type to several regions of
the object using the same texture geometry.

Proceed as follows

- Create a sphere and convert it into a polygon
object using Make Editable.

- Create a new material with a texture, e.g. the
checkerboard shader.

- Change the projection from UVW mapping to
Flat.

- Activate the Polygon tool and select several
polygons in various locations.

- Select Generate UVW Coordinates from the
Texture menu (in the Object manager).

If you are in RTTM mode you can see
immediately that the selected polygons use flat
projection while the unselected polygons
continue to use the normal UVW mapping. If
you deform the object, the texture remains fixed
in the selected region.

Note

Selective UVW mapping is designed to allow
you to allocate an optimum projection type to
specific areas. If you want to use different
materials in these areas you should use Restrict
To Selection — see page 551.

Shrink-Wrapping

With this projection type the center of the
texture is fixed to the north pole of a sphere and
the rest of the texture is stretched over it. The
advantage of this mapping type is that the
texture meets itself at the south pole only. This
avoids a seam running between the poles.

Only a circular section of the texture is used,
with the center of the circle corresponding to
the center of the picture. The remainder of the
picture is discarded.

In the illustration above, notice how the texture
meets itself at the south pole.

Camera Mapping

You cannot select camera mapping from the
Projection pop-up menu. Rather, this is an effect
you can create using frontal mapping. So what
is camera mapping?
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Assume you want to use a photo and have it
interact with your models, e.g. perhaps you
want a 3D figure to walk between some of the
objects in the photo. You can create such an
effect with camera mapping.

First you must create a background object. Then,
load the photo into the luminance channel of a
new material. Next, apply the material to the
background object with frontal mapping.

Now you reconstruct (model) any objects in the
real picture which are required for the interaction.
For example, if you want a 3D figure to walk
behind a crate that is in the photo, you build the
crate in 3D (it can be very simple — it is just a
screen for the crate texture). Next, project the
background texture on to the reconstructed
objects (e.g. the crate) using frontal mapping.
Now, your figure can walk behind the crate.

You will usually want to move the camera
around the scene a little. To this end, you should
first fix the textures to the objects. Click once on
the texture geometry in the Object manager.
This causes the icon to be framed in red. Next,
select Generate UVW Coordinates from the
Object manager’s Texture menu. The texture
will be fixed to the object geometry. You can
then move the camera.

Note

Please do not expect miracles from camera
mapping. You cannot, for example, expect to
rotate a full 360° around a building. The photo
is usually already distorted by perspective so, at
certain angles, you will get a distortion of a
distortion (not always a pretty sight).

Side (Decal Mapping)

Unfortunately, the term decal means different
things in different programs. Therefore we need
to be clear on CINEMA 4D’s definition.

Imagine that you project a texture on to a
rectangle with flat mapping. If you move the
camera around the rectangle to look at the
other side of the surface, you will still see the
texture, but it will be the wrong way round. You
can solve the problem by using a decal — a
material that is projected on one side of a
polygon only.

It is very important for you to understand how
decal mapping works. The direction of the
surface normals for each polygon (see page
371) plays a pivotal role in deciding to which
side of the polygon the texture is mapped.
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Front is in the direction of the surface normals
and Back means in the opposite direction to the
surface normals.

Example:

- You wish to place a label on a tube. With flat
projection this ought to be simple enough. You
have adjusted the settings (see page 537) and
you render the tube. Hold on a moment, that’s
not right... the texture also appears on the
reverse side of the tube:

What has happened? With flat projection a
texture is projected from the front through to
the back of an object. As a result, the texture is
also visible where it is not wanted. Decal

mapping comes to the rescue — change Front
and Back in the texture geometry to Front. Now
render the tube again. This time the label is
visible on the front side only:

The explanation is simple. If the viewing angle
(i.e. the camera angle) and the surface normal
form an angle of less than 90° to each other, the
polygon is a front polygon; otherwise it is a back
polygon.

The only exceptions are for flat and spatial
mapping. Here there is an additional criterion:
the direction of the texture projection’s Z axis. If
the texture’s Z axis points in the opposite
direction to the surface normal, and if the
viewing angle and surface normal form an angle
of less than 90° to each other, the polygon is a
front polygon; otherwise it is a back polygon.
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Front and Back

If you choose Front and Back the texture is
projected in the direction of the surface normals
and also in the opposite direction.

Front

If you have selected Front you see the texture
where the surface normals point towards the
camera, otherwise the material is invisible.

Back

If you project the texture from the back you will
see the texture only where the surface normals
point in the opposite direction to the camera.
The material is otherwise invisible.

A practical example of decal mapping
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Tiles

Sometimes we need to do more than merely
project the texture on to an object. Imagine you
are texturing a brick wall. Do you really want to
create a texture for an entire facade and four
walls? There is a much easier way.

All you need is a seamless texture, which you
project, perhaps with cubic mapping and a
suitable number of tiles.

You can use the Tile X and Tile Y settings to
define how many times the texture picture is
repeated, i.e. you use these settings to specify
the number of tiles.

CINEMA 4D calculates the size of an individual
tile from the current texture size. For example, if
you have scaled the texture so that it has a
length of 25% in the X direction and 50% in the

Y direction, the texture fits four times in the X
direction (1.0/0.25) and twice in the Y direction
(1.0/0.5) on the surface.

If you change the Tile X or Tile Y settings, the
Length settings change automatically. For
example, if you change the number to 3, the
texture shrinks from 50% to 33.33%. You can
see this immediately if you leave the window by
clicking on OK.

Tile

If you enable this option the texture picture will
be repeated endlessly on the surface.

The effect becomes visible when you scale down
the texture (see page 296), or when the texture
geometry has not yet been fitted to the object (see
Fit To Object, page 482). Otherwise, the texture
map fills the entire texture geometry once.
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If this option is disabled, the texture map will
not be repeated on the surface.

Any materials that are underneath will show
through in the parts not covered by the texture
tile.

Note

If you select the Tile option for a 2D or 3D
shader it is not, strictly speaking, tiled, but
instead fills the entire object seamlessly. There
may or may not be a repeating pattern
depending on the programming of the shader.

Seamless

If the Seamless option is enabled, tiles are
mirrored to prevent visible seams. This is
particularly useful for objects that are not
seamless, although typically it generates a
butterfly pattern.

Note

Seamless is generally of little use for
photographic textures, although you can
generate some interesting patterns. This option
is better suited to pictures with a pattern, such
as wood, stone or marble.

Mix with other Textures

CINEMA 4D lets you use as many materials and
texture geometry tags on an object as you like.
Think of a suitcase with travel stickers — there is
a base material (e.g. the leather of the suitcase)
and many materials on top (e.g. the stickers).

You cannot see the original suitcase material
(leather) in those places where there are stickers.
Also, when there are many stickers on the
suitcase, they overlap each other. The stickers
on top cover those underneath. Where several
stickers share the same space, only the top
sticker is visible. If you want to see one of the
old stickers, you must either remove one of the
newer ones or make a hole in it.

This analogy can be related closely to
CINEMA 4D’s behaviour. Your object has a base
material. You have additional materials on top of
the base material. In order to see the base
material, the overlying materials must be scaled
down and not tiled. You can do this by scaling
down the texture geometry and at the same
time turning off the Tile option (see below,
Putting a Label on a Bottle). If two materials
overlap and you want to see the bottom one,
you must make a hole in the top one. You can
do this using the alpha channel or clip mapping
(see page 511).

Only one question remains unanswered: how
does CINEMA 4D know which layer a material is
on?

The answer is quite simple. When you apply
several materials, each new material is placed on
top of the previous one. The order of the
texture tags in the Object manager (see page
468) defines the layer — the right-most material
is the top layer, the left-most is the bottom
layer.
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You can change the layering order simply by
swapping the positions of the texture icons
using drag-and-drop.

Note

The Transparency material property does not
allow the next layer to show through. Instead,
use alpha or clip materials.

In the example above T1 is a wall material, T2 is
a plastic material (scaled down, no tiling) and T3
is graffiti (with alpha mapping to remove the
non-graffiti parts of the texture).

The order of the materials in the Object
manager (from left to right) is: T1-T2-T3.

The graffiti (T3) is the top material layer.
However, it uses the alpha channel to remove
the non-graffiti parts, thereby exposing the next
layer down, the plastic material (T2). Even
though the plastic material (T2) is on a layer
above the bricks (T1), the bricks can still be seen
because the plastic has been scaled down and is
not tiled (i.e. the plastic does not cover the
entire surface).

Additive Textures

In the previous example a wall material was
created using a color channel and a bump
channel. The bump channel creates the illusion
that the wall has joints. Now we want to add a
second bump map to the wall without changing
the texture itself. How can this be done?

The powerful function that makes this possible
is called Mix With Other Textures and, no prizes
for guessing, you can use it to mix textures
together. The material properties are added
together, hence the term additive textures.

For example, the sum of the colours 100/0/0
(red) and 0/100/0 (green) is 100/100/0
(yellow). If the green color has a brightness of
50%, then only 50% of the color is added. The
result in this case would be 100/50/0 (orange).

However, the result cannot exceed the
maximum color values. Adding 100/0/0 to 100/
100/0 does not produce 200/100/0, but 100/
100/0.

Some channels cannot be added meaningfully,
e.g. two materials with a refractive index of 1
would result in a material with a refractive index
of 2, which is probably not what you intended.
So in such cases the value of the additive
material is used (provided that the channel is
active).

Notes

You can add together as many textures as you
wish.

Only the following properties are additive:
Color, Transparency, Reflection, Relief,
Displacement and Luminance.

Only active properties are evaluated.

The alpha channel marks the parts of the
additive material that should not be added.
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An additive texture (option ticked) must be to
the right of the texture to which it should be
added in the Object manager.

All textures to the right of the first additive
texture, up to but not including the next non-
additive texture, are added.

The Transparency property does not expose the
next material layer. Use alpha mapping instead.

It’s time we returned to our example:

Now you can see the second bump map (T2) on
the wall in addition to the original bump (T1).

Mixed Textures

By now you should know how to use several
material layers and how to add materials
together.

Let’s combine these two techniques to place
several materials on the same object and add
some of them together.

Our example graffiti wall uses five materials.
Their order in the Object manager (from left to
right) is: T1-T2-T3-T4-T5. T1 (wall), T2 (poster)
and T4 (graffiti) are normal materials. T3 (50%
bump of T1) and T5 (100% bump of T1) are
additive. T4 (graffiti) uses alpha mapping to
remove the non-graffiti parts of the texture.

T3 is added to T2, giving it an additional bump
texture. Since T2 is not tiled, T1 is visible. T5 is
added to T4, giving it an additional bump map.
T4 uses an alpha channel to expose the lower
layers, hence you can see T1 and T2.

Restrict to Selection

The function enables you to use different
materials on different parts of the same object.
This is a convenient way to add, for example,
labels to objects. First of all you need a selection
tag.

Proceed as follows:

- Activate the object and select the Polygon tool.

- Select several polygons using the selection tool
(if you selected a primitive object, you must
convert it to polygons first, use Structure >
Make Editable).

- Choose Set Selection from the selection menu.
A polygon selection tag appears in the Object
manager to represent the selection. (See
Selection Menu on page 317 for more details
on selections.)

- Double-click on the polygon selection tag.
Enter a name for the selection in the dialog
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that appears, then click on OK to close the
dialog.

- If your object does not have a texture yet,
apply a new texture (drag the material from
the Material manager and drop it on to the
name of the object in the Object manager).
The Texture geometry dialog opens. Enter your
settings (e.g. the projection type, tiles, etc.),
then enter the name of the selection in the
Restrict to Selection box. Close the Texture
geometry dialog by clicking on OK.

Tip

When you are positioning a texture on a
selection you may find it helpful to hide the
unselected surfaces. You can hide them using
Selection > Hide Unselected.

Putting a Label on a Bottle
By now you know how to apply textures, how
to tile (or not tile) them, and how to prevent
seams. How, though, can you put a label on a
bottle?

This is what you need to do:

- Open the Texture geometry dialog.

- Disable the Tile option.

- Ensure that only one tile is being created in the
X and Y directions.

- That’s it! OK, the texture probably covers the
entire object (that’s one big label) but now you
can scale it down.

Usually, the quickest way to scale your textures
(and, for that matter, to position them) is to
work in RTTM mode. Select the Scale tool, then
select the Texture Axis tool. You can use the
mouse to reduce the scale of the texture. Next,
select the Move tool and place the texture
wherever you like on the object surface.

The texture is often slightly out of proportion
after scaling. However, we have a little trick for
you. Open the Texture geometry dialog and
adjust the size of your texture in the Length
input boxes.

Since the length cannot exceed 100%, you may
need to divide both values. For example, if your
texture is 800 x 600 pixels, you might set the
lengths as follow:

X Y Conversion Factor

80 60 / 10
8 6 / 100
32 24 / 100 x 4 etc.
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Different materials for the hull,
caps and rounding
You can apply different materials to the hull, the
caps and the rounding of an object. You can
either convert the object into polygons with
Structure > Make Editable, or you can use the
so-called invisible selections. For example, you
can use Extrude NURBS to create marble letters
with a golden, rounded or bevelled edge.

Note

You can use existing invisible selections for the
caps and rounding of a NURBS object. For
example, you can apply a material to the start
cap by using the Restrict to Selection function
(see page 551). You should type in 'C1' to apply
the material to the start cap (please use a capital
C). The options are:

C1 = Start Cap (Cap 1)
C2 = End Cap (Cap 2)
R1 = Start Rounding (Rounding 1)
R2 = End Rounding (Rounding 2)
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19. Time Line   
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19 Time Line
composition, instead of different notes, keys are
used instead. If you have ever worked with a
computer music program you might have used a
sequencer, which is quite similar in use to
CINEMA 4D’s Time Line.

With the Time Line, you have at your disposal a
very powerful tool for controlling and playing
animations created within CINEMA 4D.

In the Time Line, just like on a sheet of music,
the timing of all the animated elements of your
scene is represented horizontally. However, to
define the type of each element of your

Tracks

Layer system

Objects

Status bar

Sequences
and keys

Time Line
Ruler

Powerslider

Selection handles
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Each horizontal line on the Time Line is called a
track. These tracks control particular aspects of
how an object is to be animated. This can range
from a simple change of position or rotation up
to complex special effects such as a pulsating,
morphing etc.

A track can contain one or more sequences.
These dictate over what time (how many
frames) the animation is to take place for that
track. So you can, for example, limit certain
animation effects to a certain time.

A sequence is then filled with keys at positions
of your choosing. These define the detail of how
an Time Line change or effect is developing over
time, e.g. a change of position from the first key
to the second key. Some effects need only one
key (e.g. Pulsate) while others require two or
more (e.g. a change of position).

Each object may have as many tracks, sequences
and keys as desired. As in the Object manager
for any particular object, the vertical position of
a track decides the priority of the animation. So
if a spline animation for a dog’s tail is placed
before a position animation, the tail is animated
along the splines first.

You can also define your own effective ranges.
So you may deliberately create dead or
undefined sequence ranges for a track, and
CINEMA 4D will try to automatically evaluate
the parameters of the next track and sequence
(see below, influence range of sequences).

The Time Palette
Users of older versions of CINEMA 4D will
probably remember the Time Manager. This was
a small, solitary window that contained some
important navigation and recording tools for the
control of animations.

In the course of the evolution of CINEMA 4D,
and through the modern, fully configurable
interface, the Time Manager has become a
simple tool palette into which the most
frequently needed navigation and recording
tools of the Time Line are integrated. Among
many other things, one advantage is that you
can dock the Time palette completely, or in parts
in the Time Line, or in any other part of the
CINEMA 4D interface.

The Time palette is, by default, in the lower region
of the main CINEMA 4D window and contains just
the conventional tool icons and a slider for
adjusting the current time value.

Time Palette Icons
Playing

Goto Start Previous Frame

Back Stop

Forwards Next Frame

Goto End
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Recording

Record Autokeying

Position Keys Scale Keys

Rotation Keys Parameter Keys

Hierarchy PLA

Options

When you click on the Options icon, an Options
menu opens containing the following items:

Hard Interpolation

Hard interpolation does not create any tangents.
The space curve (see below) consists of straight
segments. Thus the object moves rather
mechanically.

Medium Interpolation

Medium interpolation is a mixture of soft and
hard. The tangents are slightly cracked in some
cases to compensate for the overshooting.

Soft Interpolation

Soft interpolation is required in most cases in
order to produce a soft, smooth movement. The
tangents are always straight so there will never
be a kink in the curve. However, this method
produces overshooting of the space curve if
values change drastically over a short period of
time, which can be unwanted since the object
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moves slightly backwards before the position
change in case of a position track. This means,
even if two successive keys have exactly the
same position values, the object moves slightly
between these two as if to gather momentum.

All Frames

This setting ensures each frame is shown when
the animation is played in a viewport. Normally,
frames are skipped when the computer is not
fast enough to play the animation at the frame
rate in the project settings. With the All Frames
option enabled, all frames will be played.

Project

This is the default setting. It ensures that the
viewport frame rate is the same as the frame
rate in the project settings. Note that some
frames will be skipped if the computer is not fast
enough for the defined frame rate.

Others

The lower portion of the Options menu enables
you to select from a number of playback rates.
Note that some frames will be skipped if the
computer is not fast enough for the selected
frame rate.

Working in the Time Line
As we said before, the Time Line is a powerful
tool for the creation and editing of animations.

Layer System

In the upper left area of the Time Line window
are the controls for the layer system of the Time
Line, in three rows of icons. Using this system
arbitrary elements of the scene can be combined
in layers, with the ability to be hidden or to be
locked.

Positioned on the top row are eight colored
buttons, which represent the individual layers.

The second row contains another eight buttons
that give you the option to switch the layer from
visible to hidden and back. If a layer is hidden
then all elements belonging to this layer are
invisible in the main Time Line window.

On the third row you see the buttons for locking
and unlocking layers; the icon used is a small
padlock. If the padlock of a layer is closed then
all objects of this layer are locked and cannot be
selected or edited in the Time Line.

You may assign each element of your scene
(keys, sequences, tracks and objects) to a
particular layer.

To assign one or more elements to a layer,
simply select the appropriate elements in the
Time Line and choose one of the layer color
entries from the Time Line menu Layer > Color
Selection.
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Alternatively you may assign a layer to selected
elements by clicking on the appropriate layer
color button while holding down the Ctrl key.

A further useful function is the automatic
selection of layers. Select one of the layers from
the Time Line menu Layer > Select Layer.
CINEMA 4D now automatically selects all
elements in the Time Line belonging to this
layer. Alternatively, to select all the elements of
a layer, you can click on the appropriate color
button while pressing the Shift key.

The use of layers offers many advantages and
often saves much clicking and searching in the
Time Line. Try to become accustomed to this
layer system, especially when working with
complex animations.

As an example; you could place all objects that
have complex inverse kinematics assigned to
them to a specific layer and switch the
remaining parts of the animation to hidden to
arrange the work in a clearer fashion.

Tip:

It is possible to hide or lock layered elements
without having any effect on the elements that
depend on them.

Here is an example. Say you have a sequence with
several keys. The sequence is part of Layer 1. The
keys related to the sequence are however part of
Layer 2. If you now hide Layer 1, only this
sequence is hidden, not the keys. The keys are
hanging in empty space, but are still moveable
within the range of the hidden sequence. The
same is true for the locking of layer elements.

The colored layering of keys and sequences
alone offers a great advantage, as the layers are
of substantial visual assistance (perhaps different
layers for different morph stages within
character animations, for example).

By default all new elements are placed within
the first layer (layer 1) and are visible and
unlocked.

Note

You may choose the eight layer colors in the
General Settings of CINEMA 4D. These colors
are also used for the markers.

Note

Throughout the following sections we will often
refer to the ‘current time’ or to a ‘time value’.
We use the word time as a convenience to
readability to mean the position within the
animation; this may be expressed in seconds,
frames or SMPTE units. This depends on the
setting you have chosen for Animation Units in
the General Settings (see page 46).

Powerslider

At the top of the Time Line window, to the right
of the layer controls, is the powerslider. With the
help of this horizontal, two-tone gray bar and its
colored slider controls (we’ll call them tags from
now on) the visible range of the Time Line can
be moved and scaled quickly and easily. The
powerslider is above the Time Line Ruler which
is described below.



562 • TIME LINE • CHAPTER 19

- By manipulating the darker bar (you may see
only this dark bar to start with) and its tags (the
slider controls) you can adjust the Powerslider
itself and, hence, the display in the Time Line
window.

- By moving the rectangular gray tags at the
beginning and end of the bar you can scale the
powerslider and thus scale the view in the Time
Line. The left tag moves the origin of the Time
Line window while keeping the finish point
constant; the right tag does the converse of this.

- If you hold down the Shift key during scaling,
both tags move and the display is moved
around the center of the bar (centered scaling).

- If you double-click on the brighter range of the
powerslider, the actual time is set to the clicked
position.

- If you double-click on the darker range of the
powerslider, the powerslider is maximized or set
again to the last condition before maximizing.
Thus, the lighter gray bar disappears.

- If you double-click on the tag at the left of the
darker range of the powerslider, the powerslider
is maximized only on the left or set again to the
last condition before maximizing. This also
applies, in a similar manner, to the tag at the
right side of the bar.

The two vertical blue lines in the darker area of
the powerslider mark the adjustable preview
range.

Time Line Ruler

Below the powerslider you can see a ruler with
animation units laid out horizontally (depending
on what you chose for Animation Units in the
General Settings this can be frames, seconds or

in the SMPTE format; see page 46). As with a
physical ruler, the dividing lines are at regular
intervals to mark the appropriate units.

The green tag marks the current position in the
animation and as such is used for actual
navigation. You can move the tag with the
mouse or alternatively you can double-click the
green tag on the Time Line ruler or the green
tag on the powerslider to enter a position value
numerically.

Preview Range

The range between the triangular blue pointers
on the Time Line ruler defines the preview
range. You can adjust this preview range by
dragging the blue pointers with the mouse or by
manually entering an exact value after double-
clicking on the one of pointers.

Markers

CINEMA 4D also has the ability to set arbitrary
markers on the Time Line ruler. These are handy
for, among other things, simplified navigation
within the Time Line. You can use as many
markers as you wish and assign an individual
name to each marker. Note that these markers
are not only used for visual guidance, they also
work in a magnetic way for positioning and
alignment. Keys or sequences can therefore be
positioned very accurately at these magnetic
marker lines.

Note

The colors of the markers are identical to those
of the layer system in the Time Line (which is
determined in the General Settings under
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Window > Color) and can be switched to hidden
or locked just like all other layered elements of
the Time Line.

Setting Markers

To set a marker by hand requires that you
simply click, with the Ctrl key pressed, at the
position within the Time Line ruler where you
wish to create a new marker. By default,
CINEMA 4D assigns the second layer color to all
new markers and numbers these automatically
and consecutively throughout. Alternatively you
may also select File > New Marker from the
Time Line menu and manually enter the
position, your choice of name and your
preferred color.

Deleting Markers

To delete a marker you simply click on the
appropriate triangle symbol of the marker and
drag it upward or downward until the pointer of
the mouse is outside the Time Line ruler. As
soon as the mouse pointer takes the shape of a
simplified trashcan you can release the mouse
button to delete the marker. This system of
deletion resembles the tab control used in most
word processors.

You can also delete all markers of your project at
once by selecting Edit > Delete All Markers
from the Time Line menu.

Edit Markers

Existing markers can be freely positioned on the
Time Line ruler by moving them with the mouse.
To adjust the position of an existing marker
numerically, or to change its name or color,
simply double-click on the appropriate marker. A
small dialog appears allowing you to change the
appropriate values and select a color for the
marker.

Time

This value determines the position of the marker
on the Time Line ruler.

Name

In this field you can enter any name for the
marker. This makes navigation much easier,
especially for those projects with many markers.

Color

In this pop-up menu you may select one of
eight pre-defined colors which is to be assigned
to the marker.

Magnetic Markers

As already mentioned previously, a further
helpful use of markers is that they can
magnetically affect the mobile elements of the
Time Line. If you move a sequence or a key in
the Time Line and it approaches a marker, the
appropriate element will be snapped accurately
to the position of this marker. This can be very
useful, for example, if you want to position
many different keys to a certain timeframe.

Navigation with Markers

In the menus of the Time Line are various
functions that enable you to navigate the Time
Line with the help of existing markers. This can
ease your workflow dramatically, especially with
complex animations.

So you could, for example, center the view of
the Time Line on a certain marker simply by
selecting the function View > Frame Marker
from the Time Line menu (see below for details
on how to do this). A similarly useful function is
Navigation > Goto Marker, which sets the
current Time Line position to the exact position
of a chosen marker.
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Creating Tracks, Sequences and
Keys

In CINEMA 4D there are several possible ways
of creating animation tracks and animation
sequences for a certain object. The simplest
method is the keyframing technology, in which
keyframes are created for you when you choose
to record them.

Note:

You may notice problems when animating small
changes over a very long period of time. For
example, you may see a pulsating effect if an
object initially at rest starts to rotate with
constant acceleration over a period of 2500
frames. Such problems are due to the insufficient
processor accuracy of the modern CPU.
However, this tends to affect extreme cases only.
If the problem does arise, break down the
animation into several smaller animations.

Keyframing with the Help of the Record
Function

When using keyframe recording, CINEMA 4D
creates tracks, sequences and keys within the
Time Line, according to some settings of your
choosing. For the object currently selected in the
Object manager, you can record its position,
rotation and size together with other parameters
plus the structure of a group of points (point
level animation). In addition you can also define

whether the entire hierarchy of the selected
object is to be included in the keyframing or
not.

You can define which of these characteristics are
to be keyframed by activating the appropriate
icons in the Time palette ...

... or by selecting the entries from the Time Line
menu Navigation > Record. As usual, if an
option is activated you will see a small check
symbol against its menu entry. The activated
option is also shown in the time manager tool
palette with its icon depressed (pushed-in).

To start a keyframe recording from within the
Time Line you can click either on the
appropriate record icon in the Time palette ...

... or select the menu function Navigation >
Record. In both cases the appropriate tracks,
sequences and key are created at the currently
selected timeframe (as indicated by the green
pointer in the Time Line ruler) for the object
currently selected in the Object manager.
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Example:

- Assume you want to animate a cube from
position A (at frame 0) to position B (at frame
30).

- Ensure the slider at frame 0.

- Place the cube in the starting position for the
animation. Ensure the Position Keys option is
enabled.

- Click the Record button. This creates a key at
frame 0. A position sequence will be created if
it does not already exist.

- Drag the slider to frame 30.

- In the viewport, move the cube to the position
it should reach by frame 30. Click the Record
button.

- Done. You have just created an animation in
which the cube changes its position

continuously over 30 frames. The yellow
animation path should be visible in the
viewport — this is the path followed by the
cube.

- The cube sequence in the Time Line looks as
follows:

- To play the animation, click the Forwards
button.

Autokeying (Automatic Record)

As an alternative to this manual recording of
keyframes you can switch on the autokeying
mode either by selecting Navigation >
Autokeying from the Time Line menu or by
clicking on the Autokeying button in the Time
palette.

This function tells CINEMA 4D to record
keyframes automatically, as soon as any
animatable change in the scene is made.
CINEMA 4D creates these keys in an intelligent
manner and creates keyframes only for those
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objects for which a change took place. This
saves you a large amount of work, especially
when keyframing objects within a complex
hierarchy.

But be warned; if you should forget to switch
off this option, you will very quickly create not
only an enormous amount of new keys, but the
animation you so laboriously created can easily
be ruined. Therefore you should use this
function only with extreme care and
consideration.

Despite the appeal of automatic keyframing, the
possibilities can be quite restricted within
keyframe recording and it is often necessary to
create the appropriate elements using the good
old fashioned manual technique.

Example:

- Ensure the slider is at the 0 position.

- Place the cube in the starting position for the
animation. Ensure the Position Keys option is
enabled.

- Click the Autokeying button to switch on
autokeying mode.

- Click the normal Record button.

- This creates a sequence and a position key. The
autokeying mode is still active.

- Drag the slider to frame 30.

- In a viewport, hold down the mouse button
and drag the cube to the desired position. As
soon as you release the mouse button, a
position key is created.

- The cube sequence looks exactly the same as
the sequence from the previous example. The
advantage of autokeying is that you no longer
need to click the Record button each time you
change the object’s position — the recording
process becomes automated. With autokeying
mode, the procedure is to first move the slider,
then position the object. Autokeying helps
improve your workflow.

Note:

Autokeying mode does not work for Inverse
Kinematics. For example, you cannot record the
movement of a human arm IK chain by moving
the hand in autokeying mode.

Note:

Remember to switch off autokeying when you
are finished with it, otherwise you may lose your
perfect animation! Autokeying mode continues
to record changes until you switch it off.

How to Create Animation Elements
Manually

To assign a new track manually to an object,
ensure that the chosen object is selected in the
Time Line (on the left-hand side of the Time
Line) and then select a track type from the Time
Line menu File > New Track.

Now a new entry with the name of the track
(e.g. Position) appears alongside the object
name.
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CINEMA 4D automatically creates a new
sequence to the length of the animation range
preset for the current project (see Minimum,
Maximum on page 56).

You may assign as many tracks as you wish to
an object. A track can also contain as many
sequences as you like which can contain (you
guessed it) as many keys as you like.

When using several sequences in a track you
need to consider that certain restrictions may
come into force when using automatic repetition
(looping). A sequence can be only be looped so
many times until it collides with the next
sequence of the track. Therefore it is advisable
to create animations which are intended to be
uniformly looped on separate tracks.

To set a key within a sequence hold down the
Ctrl key and click the mouse at the position
where you wish the new key to be created.
Alternatively you may use the function
File > New Key from the Time Line menu. In
both cases, after the creation of the key, a
dialog appears which allows you to adjust values
that will depend on the track type (with a
position track, for example, this would be the
coordinates and tangents).

Example:

- Assume you want to animate the cube once
more — this time, using the manual method.
This may seem like a slow method, but it is
often the easiest way for complex animation.

- Create a position track: In the Time Line, move
the pointer over the object name (Cube) and
hold down the right mouse button
(Command-click on 'Cube' on the Mac). From
the drop down list choose New Track >
Geometry > Position. (Alternative, select New
Track > Geometry > Position from the Time

Line menu.) The following position track is
created.

- Hold down the Ctrl key and click anywhere on
the position track. The Values and Tangents
dialog opens.

- In the Value pane, enter a value of 0 for X and,
since the animation should begin at frame 0, a
value of 0 T also.

Note

This dialog also includes values for the active
key’s tangents. Usually these values are of little
importance unless you have a particularly
abstract mind, in which case you may be able to
make use of these additional tangent editing
options. In most cases you will edit the tangents
in a viewport. Of far greater importance are the
X, Y, Z and T values in the Value pane; these
define the position of the object at the specified
time.
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- Hold down the Ctrl key and click in a different
place on the position track. In the Value pane
enter 700 for X and 30 for T. Click OK.

- Done. You have just created an animation in
which the cube moves from position X=0 to
position X=700 over a period of 30 frames.
Here also a yellow animation path appears in
the viewports. The cube sequence is identical
to the two previous examples.

Selecting Elements
The Time Line offers a host of selection options.
The simplest of these is the selection of an
individual element. For this you simply click on
an object, a track, a sequence or a key. The
appropriate element (including all child tracks,
sequences or keys, as relevant) is then colored
or bordered in red.

You can also select several elements by clicking
them in succession, with the Shift key held
down. To deselect one of severally selected
elements, click on it once again with the Shift
key held down.

Region Select

An even simpler method for multiple selection
of keys and sequences within the Time Line is to
use rectangle selection.

To achieve this simply click with the mouse on
an empty place within the track/sequence
section of the Time Line and drag a rectangle
around the elements that you wish to select
(remember to hold the mouse button down
when dragging — sorry, computer experts). If
you hold the Shift key down while doing this
you can extend any existing selection. If you
hold down both the Shift key and the Ctrl key
during the rectangle selection, the new selection
is removed from the existing one.

Further types of selections, like freehand and
polygon selection, are described below.

Note

The Time Line selection tools Rectangle,
Freehand and Polygon work with sequences and
keys. A multiple selection of objects and tracks is
therefore only possible if these are selected
while holding down the Shift key.

Moving and Copying with
Drag-and-drop
CINEMA 4D enables you to move or copy
elements within the Time Line quickly and easily
using drag-and-drop.

As a basic guideline, to change from the
standard move mode into copying mode during
all drag-and-drop operations in the Time Line,
keep the Ctrl key held down.
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Always pay attention to the form of the mouse
pointer when using drag-and-drop. For
example; a mouse pointer that includes a small
'+' sign signals that copying mode is active.

If you try to move an element of the Time Line
into a forbidden area, the mouse pointer
changes into a small no-entry sign. If you finish
the drag-and-drop operation here, CINEMA 4D
will ignore the entire action.

You can of course, as an alternative to drag-
and-drop, use the Cut, Copy and Paste
functions from the Edit menu of the Time Line
for moving and copying elements. However
these do have certain restrictions (see
page 598).

Moving Animations Hierarchically

To transfer all existing tracks, sequences and
keys of an object to another object, simply
select the appropriate object in the Time Line
and then drag-and-drop on to the desired target
object. All animation characteristics of possible
sub-objects are also moved i.e. you can transfer
even complex, hierarchical animations with this
single action from one object to another.
Remember this is a move operation; the selected
characteristics of the original object are
removed.

If the object hierarchy of the target object
deviates from that of the original object,
CINEMA 4D will try to achieve the optimum
assignment.

For example: if you transfer the run movements
of a spider with eight legs to a fly with six legs,
CINEMA 4D ignores the tracks and sequences
for the missing legs of the fly when copying. If
you reverse the example and transfer the
movements of the fly to the spider, the two
additional legs will remain untouched.

Moving Tracks, Sequences and Keys

Tracks, sequences and keys are the actual
mobile elements of the Time Line. So you can
transfer, for example, one or more selected
tracks, including associated sequences and keys,
with drag-and-drop from one object to another.

In principle, this also applies, within certain
limits, to all sequences and keys. So the
sequences and keys of a position track, for
example, can be transferred to other position
tracks.

Of course it is not possible to move sequences
or keys of different track types (e.g. the
sequence or key of a position track to a rotation
track).

Example:

- You have created a more complex position
animation with a dummy object. (This should
have the same dimensions as the final, lavishly
modeled complex object.) Next you want to
transfer the position track to the complex
object.

- In the Time Line, drag the name Position from
the dummy object to the complex object.

Selection handles

For moving and scaling sequences and keys you
can also use the red selection handles in the
Time Line Ruler (see page 562). Grab the left or
right selection handle to move the selection.
Grab the left or right selection handle while
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holding down the Ctrl key to scale the selection
over time. With keys, the time distance in
between is scaled.

If you have a multiple selection (of keys and
sequences) and grab the left or right selection
handle while holding down the Shift key, only
the sequences are scaled. However you can
scale them only as far as the first / last key limits
a sequence.

Note

When simultaneously copying or moving several
elements in the Time Line with drag-and-drop
(e.g. sequences or keys) it is the sequence
representation within the Time Line, and not the
hierarchical layout of the objects, which is
decisive in the distribution of the individual
elements.

Sequences Sphere of Influence

From CINEMA 4D Release 6 onwards there are
two options in the sequence dialog (double-click
on a sequence to see this dialog); Right
Influence and Left Influence. To better explain
the use of these new options it will be useful to
look back at the sequence procedure of earlier
versions of CINEMA 4D.

Since a sequence may be as long or as short as
you like, the question arises; what should
happen within the undefined ranges of the
track, where no sequence exists?

A small example; say you create a rotation track
for an object and define a sequence range from
frame 30 to frame 60. Within this range a
rotation of the object from 0° to 180° is defined.
But the entire span of your animation covers the
range from 0 to 90 frames. This means that
undefined ranges result both at the beginning
and at the end of the animation. What angle
value (rotation) should the object possess at the
first frame? Or at the 89th frame?

The problem had always been solved thus:
CINEMA 4D simply extended the sequences
internally until they reached the beginning or
end of the animation or hit another sequence on
the same track. This sequence extension is called
the extended sphere of influence.

When applied to our above example these
spheres of influence would have defined the
angle value for frame 0 to 29 as 0° and for
frame 61 to 90 as 180°. This method is still
available and is active by default.

But, starting from CINEMA 4D Release 6, you
can now also apply these spheres of influence
visually. They are indicated by a thin dark grey
line, leading outwards from the sequences to
the left or to the right.
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There are certain times, however, when it can be
more helpful to switch off the spheres of
influence. Back to our previous example...

So what would actually happen if you were to
now assign an additional align track to the
object with the rotation track mentioned above?
Say this align track produces identical rotation
parameters to that of our rotation track, except
with a different beginning and end. The object
rotates. Which of the two tracks is CINEMA 4D
to give priority to? Up to Release 6 the rule was
only one track at a time i.e. only the values of
the first track (in this case the rotation track)
were evaluated. So, even within the undefined
ranges of the rotation track, the extended
sphere of influence ensured that the sequences
of the align track were not considered.

You can change this now, by switching off the
left and/or right sphere of influence in the
sequence dialog window. Now real, undefined
ranges are possible so that CINEMA 4D can also
evaluate the secondary tracks and sequences.
For our example that would mean that, within
frames 0 to 29 and 61 to 90 the sequences of
the align track can be evaluated (if there are any
such sequences, of course).

Motion Sequencing and
Motion Synthesizing
CINEMA 4D offers you a completely new and
easy-to-use way of grouping and combining
complex animations. We call this motion
grouping, where all existing position, rotation
and scale animations of an object (including
sub-objects) are combined into just one track.

This new combined motion track can again
contain its own sequences, in which you may
later define the strength and weighting of the
respective animation.

Note

Since only the position, rotation and scale tracks
are considered in motion grouping, you will
need to ensure that those movements created
with the aid of other animation tracks (e.g.
inverse kinematics) are converted accordingly. In
most cases the Bake Object function from the
Objects menu of the Time Line will help you.
This function converts your animation tracks (as
far as possible) to real position, rotation and
scale tracks, which you can then combine
afterwards to a motion group with no problems.

Combining Animations in a Motion Group

Imagine you have several hierarchically-
developed objects with multiple animation
tracks, sequences and keys. How should you
best deal with this animation?

In such a situation it is very easy to lose the
overview in the Time Line. To prevent this you
can fold the animations by selecting the
appropriate object in the Time Line and then
calling the command Sequences > Group
Motion from the Time Line menu. CINEMA 4D
now combines all animation parameters of the
object to just one motion track. The sequence
on this track now contains all animation
parameters and can be edited. So it is possible
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to shift the entire animation and begin it at a
later time, for example, by simply moving the
sequence.

Using the function Sequences > Ungroup
Motion allows you to unfold grouped
animations at any time, enabling you to further
edit the data, for example.

Note

After using the Ungroup Motion function all
keyframes set on the motion track will be lost.

Mixing Several Motion Groups

To create realistic and convincing animations it is
often necessary to combine several movements
with each other or to fade smoothly from one
movement into another. Especially in the area of
character animation, which is undoubtedly the
most impressive of all animated computer
graphics, it is a fact that countless 3D graphic
artists encounter such problems.

Here’s a simple example; a human figure is
required to be running, then perform a forward
roll and then return to the previous running
motion. For an experienced animator a simple

run movement or a forward roll is no big
problem. However the transitional phase
between the two movements can cause real
difficulties and, under normal conditions, the
animator would be forced to study these in-
between motions before laboriously transferring
them manually to the character animation.

With CINEMA 4D many of these problems are
gone. For example you can now easily fade
arbitrary animations smoothly from one to
another (motion sequencing) or, by overlaying
different animations, you can create completely
new movements (motion synthesizing). These
cross fades are controlled by simple keyframes
which you define on the appropriate motion
sequences.

Application Types for Character Animation

The major use of motion sequencing and motion
synthesizing is the possibility of smoothly
merging as many further adjustable hierarchical
animations as you like, one with another.

The principle use and meaning of motion
sequencing and motion synthesizing can be
roughly divided into the following procedures.

The first, in a similar way to that used in video
editing, involves the arrangement of two
animation sequences using overlaps and the
fading in of transient areas of one motion track
while the other track is being faded out at the
same time. This method is generally called
motion sequencing.

The second, and substantially more complex
procedure, is motion synthesizing. Here, for
example, several animation tracks with arbitrary
weightings are fully overlaid, so that a
completely new movement develops or is
synthesized. The handling of these two methods
is identical in CINEMA 4D, since they both take
the same approach.
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Motion Synthesizing

So how now does the whole process work in
practice?

Let us look first of all at a very simple task. Two
sphere objects will be created and animated
using different movements. Initially, the first
object moves upwards, the second moves from
left to right. With the help of motion sequencing
technology we can now overlay the two
movements in such a way that we end up with a
diagonal movement from the lower left to the
upper right.

- First, create a sphere by selecting Objects >
Primitive > Sphere in the main menu.

- In the Object manager, double-click on the
object properties of the sphere and, in the
parameter dialog, change the radius of the
sphere to 50 units. Close the dialog window by
clicking on the OK button.

- Duplicate the first sphere (perhaps with
Edit > Copy, Edit > Paste in the Object
manager) and rename the two objects A and B
(double-click on their names in the Object
manager).

- Now go to the Time Line and select sphere A.
Create a new position track for this sphere by
selecting the command File > New Track >
Geometry > Position from the Time Line
menu.

- With the Ctrl key pressed, click with the mouse
on the beginning of this position sequence
(position 0) to create a new key. Leave the
values for X, Y and Z at 0 and close the
position key dialog by clicking the OK button.

- Create, on the same sequence, a further key at
time frame 90 with position values of X=0,
Y=500 and Z=0 (you can type in 90 against

the T value in the dialog to ensure a time
frame of 90).

- Now drag the position track in the Time Line,
while holding down the Ctrl key, to drag-and-
drop this track from object A to object B. This
copies the position track of object A to object B.

- Double-click on the second key (at time frame
90) of the position sequence for object B and
change the position values to X=500, Y=0 and
Z=0.

- Now click on the play icon in the Time Line.
The two spheres should move in different
directions.

- Select the two objects A and B in the Time Line
by successively clicking on their names with
the Shift key pressed.

- From the Sequences menu of the Time Line
select the entry Group Motion. The two
position tracks are now combined into two
motion tracks.

- Choose Edit > Deselect All and then drag the
complete motion track of object B on to object
A, so that both of the tracks are assigned to
object A.
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- Click on the two '+' icons on the left next to
the motion tracks to show the mixing areas.

- Create keyframes for the two motion
sequences at time frame positions of 0 and 90
and adjust the value to 100% for all four keys.

If you now play your animation, sphere A
should move as planned diagonally from lower
left to upper right.

Motion A       Motion B Result

This movement happens because both
animations are synthesized with one another to
the same proportions. This is why, in the
illustration above, the sphere appears to leap to
half the distance. Motion A tells the sphere that
it should move to X=500, Motion B tells it to
remain still with regard to movement along the
X axis. Since the two motions are mixed equally
at the same time, only half the distance remains.

If, instead of 100%, you enter another equal
value to all the keys you will obtain the same
result. Interesting effects result if you use
unequal values.

Experiment a little, e.g. with two ramps moving
in opposite directions (in this case, the
weighting of the animation of object A
decreases constantly, while the weighting of
object B increases).

Motion Sequencing

In this section we will learn about the challenges
of motion sequencing and motion capture data
and how to rise to them.

First, what is motion sequencing anyway?

Motion sequencing enables you to combine a
set of motions (position, rotation, scale) by
mixing or by fading them into one another. Say
you have two motions, recorded by a motion
capture system, and now these motions need to
be lined up one after the other without any
visible transition. The following example is going
to illustrate this using two motions from the
PowerMoves LifeForms Studio package.

First, the motion data is exported as Biovision
data. (Some example files are in the Motion
Sequencing folder on the CINEMA 4D CD —
'Box.bvh' and 'Kick.bvh'.) Then we simply load
them into CINEMA 4D.

CINEMA 4D automatically creates a bone
skeleton when importing Biovision data. Press
the play button and you’ll see the skeleton
move — doing either a kick or a box punch. You
might have noticed already that these motions
each have a similar start and end positions.

At this point let us take a look at the limitations
we must consider — this will avoid a lot of
frustration and work later on. Generally, with
motion sequencing we can mix any motion, but
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we need to take care that the start and end
positions fit together as best as possible. Mixing
a running person with one who lies down will
not produce a reasonable result. It is also
necessary that each skeleton has an identical
hierarchy.

Both of these requirements are fulfilled by our
example files.

The basic procedure with motion sequencing is
to group the existing sequences and keys in a
motion group. Although it is displayed in one
single sequence for the whole object hierarchy, a
motion group still contains all the raw data.

- So load the 'Kick.bvh' and 'Box.bvh' files into a
new CINEMA 4D scene. (Open one, then
select Files > Merge to import the other into
the same scene.) Both hierarchies will be
named 'Skeleton'.

- In the Time Line, unfold the hierarchies and
feast your eyes on all those keys (Objects >
Unfold All). Motion capturing always creates a
gluttony of keys like this — for each object and
frame, one key is created.

- We shouldn’t let the apparent complexity
confuse us. Let’s clean things up with some
motion groups.

- In the Time Line, activate the first skeleton’s
hips and create a motion group (Sequences >
Group Motion).

Note

You can create a motion group only if the active
object contains a position, scale or rotation track.
Motion grouping works with these animation
types only, other tracks remain untouched.

- Do the same for the second skeleton.
Everything should look a bit clearer now; only
two sequences are now displayed.

- These can be named by clicking the little + sign
and double clicking in the empty area below
the sequence.

- To line up both animations we need a little
more space in the Time Line. Select Edit >
Project Settings and type in a total length of
100 frames for our animation. Drag the
powerslider to the very right of the Time Line
to view the whole length of the animation.

- Now drag the Kick motion group into the
other Skeleton and drop it below the Box
sequence.

- In the Object manager, hide the now
motionless Skeleton as it is no longer needed.
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In the viewports, your remaining Skeleton may
appear slightly strange; this is one of the
aforementioned challenges that we must live
with.

- To continue, drag the Kick group to the right
until both motions overlap just a little bit and
create keys for the sequences.

Now, when moving the time slider through the
transition area, we see the skeleton doing some
strange contortions.

Why does this happen?

It’s another of those challenges, created by the
motion capture system. You see, when playing
an animation it makes no difference if a leg has
an angle of 0º or 360º, the visual position of the
leg is the same in both cases.

But for motion sequencing CINEMA 4D will
calculate the median value of two overlaying
keys. So if a rotational key of 0º is overlaid with
another key of 0º, the result is 0º, which is fine.
If, however, a key of 0º is overlaid with a key of
360º, the result is a median value of 180º, not at
all what we want.

What can be done to prevent this? Well, a good
eye to manually correct the problematic areas
will certainly come in useful, but let’s step back
a bit and take a closer look at the motion
capture data.

- Throw away the scene we just created, it’s only
use was to demonstrate this particular motion
sequencing challenge to us.

- Open 'Box.bvh' again and unfold the complete
hierarchy in the Time Line. Select Window >
Space Curves from the main menu and select
the rotation track for 'Head'.

- Use View > Frame All to show all three curves.
As you can see, the curves for the Y and Z
rotations are near the zero line; the red curve
for the X rotation, however, is at about 360º.
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This is the root of the problem, because in the
'Kick.bvh' file the X rotation is near the zero
line:

We need to bring some system into all this, we
need all curves to run in the same range of
values.

First, let’s divide the Space Curve diagram into
three ranges.

Green is the main range (from about –180º to
+180º); most curves should be in this range.
Yellow is the tolerance range (about 70º above
and below the main range); curves can be here,
too, but there is a risk that they may challenge
us later on. However, this will depend on the

project in hand; we can’t make a general
decision if curves have to be moved out of here
or not.

Red is the danger zone (starting from 250º
below or above the zero line); curves are
banned from this area.

And this is how we do it: Immediately after
loading both Biovision files into the same scene,
we switch to Space Curves mode and clean all
the rotation tracks following the principles
described above.

For example, in our illustration above we would
select the red curve (drag a box around it, or
hide the other curves and select Edit > Select
All). Now, using Curves > Move we can move
the whole curve down at once (enter –360 into
the input box).

We should keep an eye on the blue curve. The
green curve, however, will not challenge us.

OK, this sounds like a never-ending task, but
with a little practice this job shouldn’t take us
any longer than a few minutes. It will help
speed things along if we create a small
command palette in the Time Line containing
the most frequently needed commands.
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A special case can occur if the Motion Capture
system produces rotational jumps of 180º or
360º, which looks like this in the Space Curves
window:

This can be easily solved using the same
technique described above except we move just
a part of the curve. Fortunately this is not the
case for our example files.

You can try out this procedure on the example
motion capture data, or if you prefer use the
prepared file 'Kick_Box_cleanedup.c4d' (also in
the Motion Sequencing folder). Simply create
two overlapping motion sequences as described
earlier — et voilà!

Motion Tracks Tips and Tricks

The successful use of motion sequencing or
motion synthesizing, especially in areas like
character animation, relies on your ensuring that
the appropriate hierarchies and arrangements of
the objects to be animated are as identical as
possible.

The reason for this is easily explained. Assume
you have two animated human figures, with
fundamentally different hierarchical structures,
that you are combining in their animation.
CINEMA 4D tries to interpolate the entire
animation structure from the first to the second
object. Now, assume the arms and legs were
exchanged in their hierarchical arrangement; the
arms would try a run movement, while the legs
stroll comfortably at the hip. The resulting
animation would probably resemble a character
from Monty Python’s Ministry of Silly Walks.

Missing parts of the hierarchy are usually less
dramatic. If, for example, you try to transfer the
animation of a hand with five fingers to a hand
with only four fingers, the animation of the
remaining finger will be ignored by
CINEMA 4D. If you reverse this example, the
last finger assigned in the hierarchy will contain
no animation data.

When considering this overlay of hierarchical
animations it is important to note that even the
non-moving parts of an object are included in
the synthesizing procedure, if they have their
own animation tracks. Again using the above
example of the two animated human figures;
human A possesses a run movement, of which
only the legs move. The arms hang down
motionless beside the body but do contain the
required hierarchical keyframing animation
tracks.

Human B likewise has legs provided with blank
animation tracks, but lifts the arms up (a
rotation of 180°). If you now completely overlay
the animations of human A and human B using
motion synthesizing, you obtain the following
result; the figure makes only half the number of
steps as before but also lifts the arms to only the
height of the shoulders (90° rotation).
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The reasons behind this are the semi-redundant
animation tracks of the objects that we
mentioned before. In motion synthesizing,
which uses an even overlay, these tracks drag
their appropriate animated counterparts, for
example, by 50% into their own movement.
This results in the halving of the animation
values seen above. This effect can strengthen
further as each new animation object is included
in the computation.

Put simply; if you have two figures, one with
arms that keep still, while the other one has
arms that rotate upward by 180° the result
would be only a 60° rotation — a third of the
original value.

You can avoid this problem in many cases by
simply deleting the redundant animation tracks
of the non-moving parts of your object from the
hierarchy before creating the motion groups. As
soon as these animation tracks are gone, then
these parts of the object can no longer have any
influence on any further combined animations.

File

New Track

Geometry

Position

Using this track type you can animate the
position of an object in 3D space. After you
invoke this command CINEMA 4D creates a
new position track and a related sequence.

In the dialog of the position key you define the
appropriate X, Y and Z values for the spatial
position of the object. Additionally you can
define tangents that affect the movement of the
animation in a similar way as for splines (see
Spline Objects, page 123).

The X, Y and Z values for Left Tangent and
Right Tangent define the position of the tangent
handles. This enables you to edit the tangents
numerically. However, usually you will want to
edit the key’s tangents directly in a viewport
(select the Move tool and drag).
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The TX, TY and TZ values are the spatial lengths
of the tangents.

Scale

Using this track type enables you to animate the
size of an object. CINEMA 4D creates a new
scale track as well as a related sequence.

In the dialog of a scale key you may define the
appropriate X, Y and Z values for the spatial
dimensions of the object. Additionally you can
define tangents that affect movement of the
animation.

Rotation

Use this track type to animate the rotation of an
object. After you choose this command
CINEMA 4D creates a new rotation track and a
related sequence.

In the dialog of the rotation key you can define
the appropriate H, P and B values for the
rotation of the object. Additionally you can
define tangents that affect the movement of the
animation.

Motion

This function creates an empty motion track
without any related sequence. Motion tracks are
used for animation sequences developed via
motion grouping (see page 571, Combining
Animations in a Motion Group).

The function is present only for the sake of
completeness since, under normal conditions,
corresponding motion tracks are created
automatically when combining animations into
motion groups.

However, it can be useful should you need to
assign motion sequences of other previously
created objects to a new object with an empty
motion track.
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Align To Path

When you have created an animation path for
an object (say, an aeroplane) — a position track,
in other words — it is rather tedious to have to
set the position of the object so that it is always
tangential to the defined path by using a
direction track.

The Align to Path track has the effect that the
object will always follow the animation path you
have created, either via the position track or via
keyframes, with its Z axis parallel to the tangent
of the path.

Without an Align to Path track

With an Align to Path track

Of course, this assumes that you do not already
have a rotation track for the object; if you do,
the rotation track data will override the Align to
Path track.

The object’s X axis always stays parallel to the
XZ world coordinates. Thus, the camera follows
the natural motion path.

In addition, you can specify a bank Angle which
will allow the object to rotated around its Z axis
by this value throughout the animation. You
need to define two keys here — for example a
key at frame 1 set to 0º and a key at frame 120
set to 180º.

With the Look Ahead value you can choose how
many frames should be considered when
working out the orientation of the object.

Align To Spline

If you wish to define an animation path for an
object, we recommend that first of all you create
the path as a spline object. This has an
advantage over the keyframe method in that
you can create B-spline paths and use tools such
as the magnet.

You can also use completely closed splines for
creating a cyclic motion. This would be difficult
to do with the keyframe method.
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In the spline key window simply enter the name
of the required spline object. Your object now
follows the path of the spline for the duration of
the sequence.

In the spline key window you can optionally
check Tangential to Spline. The effect of this
function is similar to that of the Align-to-Path
track i.e. the appropriate object’s Z axis is kept
parallel to the spline’s tangent at all times
(assuming your object does not already have a
rotation track, which will override this effect).

This effect needs only a single key. However,
you may use as many keys as you like with
different spline parameters within a sequence.
CINEMA 4D interpolates the movement as
necessary.

Note

If a spline has its intermediate points set to be
Uniform, this is also taken into account for the
spline animation. It will have the effect that the
object follows the spline at a constant speed.

—Railspline Animation

What if the spline object defined in the spline
key has a spline as a child object? This is termed
a railspline animation: the object’s X axis will
align to the child spline while it follows the first
spline. Not only at the origin of the child spline,
but at the corresponding position according to
the time. So the X axis follows the child spline.

Inverse Kinematics

With an Inverse Kinematics (IK) track, all
objects, starting from an anchor, follow a
particular target object that you specify. To do
this, you enter the name of the object to be
followed in a key. CINEMA 4D then tries to
have the object and all its hierarchically linked
parent objects pursue this object, while obeying
the laws of IK and the specified angle limits.

You could, for example, define an inverse
kinematics track for the hand of a figure,
specifying an aeroplane as the target object. The
hand will then automatically keep pointing at
the aeroplane.
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Depending on the object hierarchy, it could
happen that the object with the inverse
kinematics track reaches the target only
approximately or not at all. An arm, for
example, can be moved only within the range
defined by its joints. Even this range of
movements may not be fully available, since IK
always attempts to generate soft movements.

Before defining an inverse kinematics animation
for an object, make sure you record the position
and direction of all IK objects at or before the
first keyframe. This is the only way to ensure
that the object has a precisely defined position
at a particular time and that the animation is
reversible.

This effect needs only a single key. However,
you can use as many keys as you like within a
sequence, perhaps with different target objects.
CINEMA 4D interpolates these movements
accordingly.

Note

You can also calculate IK animations with the
help of IK Expressions. For this you must assign
an inverse kinematics tag to the appropriate
objects in the Object manager (see IK Tag,

page 471) and then animate the target objects
which are controlled by the tags.

Target

An example of when you might use target is
when you have a camera that you want to
follow the movement of an object so that the
targeted object always remains in the center of
the picture. For this, create a Target track; you
only need to set one key, entering the name of
the object which is to be followed.

The Z-axis of the selected object then follows
the other object automatically.

Objects can also be aligned mutually to each
other. So for example the camera can be aligned
to an object and the object to the camera.

Something that is not possible is the mutual
alignment of hierarchically connected objects
(e.g. an object to its sub-object).

This effect needs only a single key. However,
you can use as many keys as you like within a
sequence, perhaps choosing different objects to
which the current object is to be aligned.
CINEMA 4D interpolates these movements
accordingly.

Special Effects

Many of the Version 5 special effects have become
the way more flexible Deformation Objects (see
Deformation, page 247). This means that the
former special effects from Version 5 don’t appear
as sequences in the Time Line of Release 7.
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For the following special effects new animations
have to be created when importing Version 5
scenes into Release 7: Bend, Boole, Explosion,
Formula, Melt, Shatter, Taper, Twist and Wind.

Deformation Objects are animated using a
parameter track (see page 593).

Morph

This special effect changes (morphs) an object
into another object. You can use Morphing with
polygon objects and spline objects; you cannot,
however, morph primitives or spline primitives.

You can only morph between objects that have
the same number of points. For example, you
cannot morph a sphere into a cube when the
sphere has many more points.

Rather, you should morph between modified
duplicates of an object. For example, if you use
the magnet or another modeling tool to fashion
a copy of a sphere into a cube, it is possible to
morph between a sphere and a cube.

Before you can morph an object you need to
create target objects (duplicates of the original
object).

Note

Target objects are copies of the original object.
The original state of the object to be morphed
must also exist as a target object.

Note

If, when creating the target objects, you want to
scale the copies of the original object along an
axis, be sure to use the Model tool and not the
Object tool.

Perhaps morphing is best explained with an
example:

- Create a sphere and convert it into a polygon
object by making it editable (see Make
Editable, page 353).

- Next, create the first copy (Edit > Copy,
Edit > Paste or Ctrl-drag within the Object
manager). This is the first target object.
Rename it 'Target1'.

- Activate the magnet and set the type to
Needle (use the Active Tool tab for this).
Working in either the point or polygon mode,
deform the object to create a droplet shape.

- Make another copy of the original sphere and
name this copy 'Target2'. (You can hide
'Target1' to give yourself a better view in the
viewport — see Object Display, page 477).
Scale the sphere along the Y-axis as shown in
the following picture:

- Next we need a puddle! To this end create a
third target object by copying the original.
Name this new object 'Target3'. This time,
scale the target to flatten and widen it into a
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puddle shape. By all means create a few
irregularities by tugging at the edges of the
puddle with the magnet.

- The target objects are now ready to be used.
Hide the targets in the Object manager (see
Object Display, page 477). Keep the original
sphere visible.

- Now, only the original sphere is visible. Open
the Time Line and assign a Morph track to the
sphere.

- Create the first key at the start of the sequence
and enter 'Target1' in the text field. Create the
second key in the middle of the sequence and
enter 'Target2' in the text field. Add a third key
at the end of the sequence and enter 'Target3'.

- Now play the animation. You can, of course,
fine-tune the morph. You are free to remodel
the target objects.

Note

Target objects are copies of the original object.
The original state of the object to be morphed
must also exist as a target object.

Note

If strange deformities occur during morphing,
they may be the result of the algorithm looking
past the next key. To remedy this, double-up the
next key — hold down Ctrl and drag the copy
one frame to the right.

Note

Release 7 handles morphing objects differently
to Version 5, therefore it is no longer possible to
define the actual base object as a target object.

Example:

- You have created an object and want to morph
it. The morph should start with the current
state of the object and change from there on.

- For this purpose you first have to create a copy
of the object and rename it to e.g. 'base
object' and the copy to 'shape_1'.

- Create further copies of 'shape_1' and modify
them.

- Give all these shapes unique names, such as
'shape_2', 'shape_3' and so on.

- Create a morph sequence for the base object
and make the first key refer to 'shape_1', the
second to 'shape_2' and so on.
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Point-Level Animation (PLA)

This special effects track lets you animate
polygon objects and splines at the point-level.
Primitives and spline primitives must be made
editable before you can use them with point
level animation (see Make Editable, page 353).

Use a key to record the positions of all points
belonging to the active object. This method of
recording points is considerably more flexible
than the morphing method, since PLA does not
require target objects.

Load the example file 'pla.c4d' from the
CINEMA 4D CD Examples folder. The example
shows a textured face. The texture was nailed
to the face using UVW mapping so that it
moves with facial animation (see UVW
Mapping, page 542).

Change into polygon mode, then select the
surfaces of the eyebrow.

You do not have to be in point mode in order to
use PLA. After all, polygon mode allows you to
effectively move points (those points that
belong to the selected polygons).

First we need a starting key to record the
current position of the eyebrow’s surfaces.
Select a PLA track (File > New Track > Special
Effects > PLA). If you create a key with the Ctrl
key held down, the current position of the
eyebrow at this frame will be recorded.

The process is even easier if you activate the
PLA icon:

Now you can either record keys automatically
(autokeying) for the active object...

....or set the keys manually using the Record
button.

In both cases, a PLA track will be created the
moment you record a key.

Let’s create the first key. The eyebrow is in its
starting position.
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Before you set the next position and record, you
need to move the blue time slider to the
required frame, e.g. frame 30.

Once you have moved the time slider, move the
eyebrow surfaces up a little (i.e. raise an
eyebrow), then record a new key.

You can play back the animation in the viewport
thanks to the realtime texture preview (see
Textures, page 24).

You could also use PLA to open and close the
mouth, turn up the nose and so on. PLA opens
up countless animation opportunities.

Note

If strange deformities occur during morphing,
they may be the result of the algorithm looking
past the next key. To remedy this, double-up the
next key — hold down Ctrl and drag the copy
one frame to the right.

Before we leave PLA, bear in mind that you can
animate spline points as well.

Pulsate

You can use this effect to change an object’s
size, position and orientation cyclically. You can
use Pulsate with all object types — from
primitive objects to deformation objects and so
on. This track requires one key only.

Here’s a very quick example to demonstrate
pulsate; create a sphere, allocate a pulsate track
to it and create a key. Use the key’s default
values, then play back the animation in the
viewport.

Note

This effect works with absolute position. So that
you can still move the object freely, make it a
child of a null object and move the null.

- Position

Use Position to enter the maximum positive and
negative position values for the object along its
X, Y and Z axes.

- Scale

Scale defines the maximum scale of the object
along each axis using factors. A factor of two
means that the object will pulsate between
double and half the size of the original object.

- Rotation

You can also animate the object’s orientation.
Set the maximum angle of rotation for each
axis.
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- f in Hz

The frequency f defines the frequency of the
position, scale and rotation settings.

Example:

- Pulsating individual objects is child’s play.
However, things start to get interesting with
text! If each letter is a separate object, you can
allocate a pulsate track to each letter.

- You can prevent the letters from wobbling in
synchronisation by setting the keys at different
frames. You can do this quickly by dragging
and dropping the first sequence including its
key onto all the other letters one by one,
dropping the sequence some distance to the
right in each case.

- Here is part of the Time Line for the text object
pictured below.

- These are the settings used to make the text
wobble — the scale along the Y axis changes
cyclically:



CHAPTER 19 • TIME LINE • 589

- Here is another example of wobbly text — the
Y positions of the letters are animated
cyclically:

- To round off, here is a final example of wobbly
text:

Sound

This function creates a new sound track, as well
as an appropriate sequence, for the object
selected in the Time Line. Using sound
sequences you can apply WAV sound files to
any objects. You will need to do this to use the
2D and 3D sound rendering abilities of
CINEMA 4D (see pages 595 and 596).

—Applying a Sound File

To apply a sound file to a sound sequence, first
unfold the appropriate sequence by clicking on
the + symbol to the left of the word Sound.
Now double-click in the empty field that
appears beneath the sequence or select the
function Edit Data from the Sequence menu.

Alternatively you can insert a sound file directly
into a sound sequence using drag-and-drop
from the Browser (see page 61). In the dialog
that appears select a sound file by clicking on
Load Sound. You can then play the file by
clicking on Play. Additionally, the following
information is shown for the loaded sound file:
Size, Frequency, Length, Channel and Bits.

For playing sound files, CINEMA 4D uses the
default playback program of the operating
system (e.g. Media Player under Windows or
QuickTime on the Macintosh.)

CINEMA 4D supports uncompressed WAV files
at 11, 22 and 44 kHz as well as 8-bit, 16-bit,
mono and stereo sound formats. Labels in the
files are accepted.

Unfortunately many sound programs on the
market (shareware editors, QuickTime etc.) do
not always conform to the WAV file format
guidelines when writing files. So if a file cannot
be loaded by CINEMA 4D or loads incorrectly,
please try to convert the sound file with a
different sound editor.

Other programs often load incorrectly-written
data quite happily, since they have very little or
no control mechanisms to check the format.
CINEMA 4D, on the other hand, interprets the
sound data, efficiently and correctly. This is
important, since otherwise CINEMA 4D’s
Browser could crash, or at least behave very
strangely, with such incorrectly-written files.
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—Changing the Volume and Stereo Balance

If you intend to use 2D sound rendering you can
adjust the volume and balance of any sound
sequence by adding keys to the sound sequence
(in a similar way to video editing programs).
When you add a key (Ctrl-click on the sequence
as usual) a dialog will appear in which you can
change the volume and balance values (see
below). Once you have added a key, a black
curve will appear below the sequence (when it is
unfolded) to show the changing levels.

Volume

This is the volume of the appropriate sound file.
Values between 0% (minimum volume, silence)
and 100% (maximum volume) are permissible.
By default, the volume is set to 100%.

Balance

This value gives the stereo balance of the
appropriate sound file. Values between -100%
and 100% are permissible. Negative values
cause a shift of volume to the left channel,
positive values to the right channel. By default,
the balance is set to 0% (equal balance between
left and right channels).

Tip

With 3D sound rendering the balance is ignored
since volume and balance information comes
from the 3D sound parameters, distances and
movements. You can, however, still change the
volume level.

Texture

You can use this special effects track to animate
as many of the materials used by an object as
you like (material morphing). The order of the
texture tracks in the Time Line must correspond
to the sequence of the texture geometry tags in
the Object manager; the topmost track in the
Time Line must refer to the right-most texture
geometry in the Object manager, the next track
down in the Time Line must refer to the next
texture geometry to the left and so on.

For example, if you want to animate the third-
from-top material of an object, you must create
three texture tracks and animate the third track
only. Since you do not want to animate the top
two layers, you should leave the first two
texture tracks empty.

All of the texture’s parameters can be animated.
You can, for example, make a texture grow by
animating its scale; perhaps you will animate the
texture by rotating it.

You can also morph between materials. Specify
different materials in two texture keys and
CINEMA 4D will automatically morph between
the materials. You can get blood from a stone if
you like!



CHAPTER 19 • TIME LINE • 591

Example:

- Create any primitive you like, e.g. a sphere.

- Create two new materials in the Material
Manager. In the first material, load the
Checkerboard shader on the Color page (click
on the little triangle to the right of Image and
select the shader). Rename the material
'checks'. For the second material, load the
Marble shader on the Color page and rename
the material 'marble'.

- Drag-and-drop 'checks' on to the primitive in
the Object manager, holding down Shift during
the process (this prevents the texture dialog
from opening).

- Open the Time Line. The object should be
selected already (its name should be
highlighted with red text). If the object is not
selected, click once on its name. The object’s
name will turn red. Create a texture track using
File > New Track > Special Effects > Texture. A
Texture track and sequence will appear.

- Hold down the Ctrl key and click near the start
of the sequence. The Texture dialog opens. It
already contains the 'checks' material. These
settings are fine, so click on OK to close the
dialog. Now create a key at the end of the
sequence. This time, change the texture from
'checks' to 'marble' (type 'marble' in place of
'checks'). Before you close the dialog, enter an
X offset of 100%. Then, click on OK to close
the dialog.

- Hold down the Ctrl key and press the 'B' key.
This handy shortcut opens the Render Settings
(see page 402). On the Output tab, set Frame
to All Frames. On the Save page, set Format to
either AVI Movie Small or QuickTime Movie
Small.

- If you now start rendering in the Picture
Viewer you will see how the 'checks' material

morphs into the 'marble' material. Note also
that the texture rotates. The rotation effect is
made possible by using the offset value with
UVW mapping (see UVW Mapping, page
542).

—Animate Shader Parameters

You can now animate shader parameters.
Example: first, allocate the fire shader to
frame 1. Next, allocate the fire shader to
frame 30 but with different parameters. Click on
the '+' icon next to the texture to make the
names of the two shaders appear. Double click
on the empty space between the two shaders to
open the Texture Sequence dialog.
(Alternatively, select the sequence then choose
Sequences > Edit Data.) In the Texture
Sequence dialog, disable the Morph Materials
option.

This completes the steps required. Now, the
shader parameters will be interpolated during
rendering, i.e. the shader will be animated.

If the Morph Materials option is enabled there
will be a blend transition between the two
shaders instead. If your materials contain color
information or textures only, leave Morph
Materials enabled.



592 • TIME LINE • CHAPTER 19

—Animated Textures

There are many reasons why you may wish to
animate a texture. Perhaps you want to play a
video on a TV screen.

If you want to use a picture sequence as an
animated texture, you need to incorporate the
logical number into the filenames, e.g.
'Picture0001', 'Picture0002' and so on.

You need to create two materials. Set the color
texture of the first material to the name of the
first picture in the sequence (e.g. 'Picture0001').
Set the color texture of the second material to
the name of the last picture in the sequence
(e.g. 'Picture0127').

Next, click the Edit button. In the Time Controls
dialog that opens, click Calculate. CINEMA 4D
should then recognise the picture sequence
animation. However, you still need to enter the
frame rate manually.

Next, create a texture track and morph from the
first material to the second one. CINEMA 4D
will calculate the intermediate pictures.

You can also animate a picture sequence using a
single material. In this case load the first picture
('Picture001') into the color page of the material
and click on the Edit button to open the Time
Controls dialog (see page 497). You can use the
Time Controls dialog to control the playback.

You do not have to use picture sequences for
animated textures; you can use AVI or
QuickTime films too. Load the film into the
material’s color page and adjust the settings in
the Time Controls dialog (see page 497).

Note

CINEMA 4D searches for textures in:

- the CINEMA 4D/Tex folder

- the scene’s folder

- the scene’s Tex sub-folder

- the texture paths specified in the General
Settings (including sub-folders)

If CINEMA 4D cannot find a texture when
rendering, a message will appear to tell you
which textures are missing and which materials
use these textures. You can still render the scene
(just click on OK) — the materials that are
affected will be used without the missing
textures.

Vibrate

Computer animations are often too static and
predictable. The Vibrate effect can help you add
a random vibrating effect to your animation. If,
for example, you are simulating a car chase, try
vibrating the camera for a far more realistic
effect. Ask your viewers to sit down first before
they watch the animation, though.

This effect can be used with all object types
including primitives and deformation objects.
Only one key is required.

Note

This effect works with absolute position. So that
you can still move the object freely, make it a
child of a null object and move the null.

—Seed

Enter a start-value (seed). This helps the random
number algorithm, since computers cannot
generate truly random numbers. The same seed
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will generate the same vibrational behaviour.
Change the seed value for a different vibrational
pattern.

—f in Hz

f is the frequency value. It determines the speed
of vibration.

—Position

You can set maximum and minimum values for
the object’s position along its X, Y and Z axes.

—Scale

Scale defines the maximum scale for the object
along the individual axes.

—Rotation

You can also vary the object’s orientation. Enter
the maximum rotational angle for each axis.

Visibility

This effect can blend objects into and out of the
scene. The strength of the visibility is defined as
a percentage.

This effect is not visible directly in the viewport;
you must render to see the effect.

Plugin Tracks

Any plug-ins which relate to the Time Line will
be listed in the submenu.

Parameter

Using this track type enables you to animate the
characteristics of most types of parametric
objects (e.g. cameras, light sources, parametric
primitives and deformation objects). Depending
on the type of object, the appropriate object

parameters may be entered into the key dialog
for the respective object type, thus achieving an
animated effect. So you can create a parameter
track for a camera object then change the
settings of the camera at each keyframe, as
desired. CINEMA 4D then interpolates — if it
makes sense to do so — between these different
keys.

Areas of parameter tracks that are animatable
would be, for example, animated depth of field
effects, falloff angles of spot lights or
deformations.

Note

Not all object types support parameter
animations. In such a case the menu entry of the
parameter track cannot be selected and no track
will be created when recording.

Example:

- It’s easy to create an animated pie chart in
CINEMA 4D.

- First, create a cylinder — for example use a
parametric cylinder with the settings X=800,
Y=50, and Z=800.

- This creates the flat disc shape, but at the
moment it spans the complete 360º. Let’s say
want the disc to grow from 0º to 270º.
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- In the Time Line, create a parameter track for
the cylinder (File > New Track > Parameter).

- Ctrl-click on the Time Line in the parameter
sequence at frame 1. The parameter window
for the cylinder opens.

- Enable the Slice option and enter 0 into both
of its input boxes. This sets the cylinder to its
starting state.

- Ctrl-click on the parameter sequence at about
frame 50. In the parameter window that
opens, enable the Slice option and enter 270
into the right-hand input box. (Leave the left-
hand input box set to 0.)

- Done. That’s all there is to it. If you click on the
Play icon in the Time palette the pie chart
segment will unfold from 0º to 270º.

New Sequence

Use this function to create a new sequence on
the active track. It opens a dialog, allowing you
to enter the start and end time of the sequence.
To the right of these values the overall length of
the sequence is shown.

Additionally you can make this sequence loop a
number of times. You can determine the overall
length of the loop period or alternatively the
number of loops. These two values are linked to
one another and will change according to each
other’s value.

Looped sequences can be recognised in the
Time Line by the fact that the end part of the
sequence is displayed in a darker grey. This
range is the automatically generated loop and
cannot have further keys added to it.

By checking the Soft option you can additionally
define whether CINEMA 4D should softly
interpolate between the individual loop sections.
When checking the Soft option always bear in
mind that the last key should not be directly at
the end of the sequence, otherwise CINEMA 4D
will not have sufficient time for the
interpolation. Therefore, to avoid sudden jumps,
always leave some space at the end of the
original sequence.

Note

New sequences can also be created directly in
the Time Line. For this simply hold down the
Ctrl key and click with the mouse within the
track. Keep the mouse button pressed and drag
the pointer to the right or left to define the
sequence.

New Key

Use this function to create a new key on the
active sequence. It opens a dialog, allowing you
to enter the time position of the key.
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You can edit the key data afterwards, either by
double-clicking on the key or by calling the
function Sequences > Edit Data from the Time
Line menu (see below).

You can also directly create new keys in the
Time Line. To do this simply hold down the Ctrl
key and click with the mouse in the sequence at
the position that you want to add the key. The
new key is created at this timeframe position
and its data dialog window opens immediately.

New Marker

This function creates a new marker (a
downward-pointing colored triangle) on the
Time Line ruler. Markers are ideal for simplifying
the look and navigation of the Time Line (see
above). After calling this function a data dialog
window appears allowing you to define the
timeframe position and the name and color of
the marker.

You can also create new markers directly on the
Time Line ruler. To do this hold down the Ctrl
key and click with the mouse on the Time Line
ruler. The new marker is created at this time
position. Markers which are created by such a
mouse-click have no name assigned by default

and will be given the color of the second layer.
To change a marker’s attributes, simply double-
click on the marker to open its data dialog.

2D Sound Rendering

With this function you can render 2D sound
data. CINEMA 4D creates a single, coherent
WAV sound file, based on the sound sequences
in the Time Line. Any volume and balance
information in the appropriate keys is also
included in the file.

With this feature you are, in effect, in front of a
multi-track recording machine, with which you
can cut together and mix many sound files
individually and non-linearly.

Tip

CINEMA 4D creates uncompressed stereo WAV
files in 16 bits @ 44.1 kHz.

Path

Enter the desired file path and name for the
WAV sound file you want to create. The files are
automatically given the extension '.WAV'.

Range

Use this to choose over how many frames 2D
sound rendering is to be performed.

Document

Performs 2D sound rendering for the entire
length of the scene.
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Preview

Performs 2D sound rendering for the part of the
document marked as a preview range (see
page 562).

Raytracer

Performs 2D sound rendering for the number of
frames defined in the render settings of the
document (see page 407).

Play Sound when Ready

Check this option for the result of the 2D sound
rendering to play automatically after the
completion of rendering.

Tip

CINEMA 4D uses the default playback program
of the operating system (e.g. Media Player under
Windows or QuickTime on the Macintosh) for
playing sound files.

You can interrupt the calculation of the sound
data at any time by pressing the ESC key or the
Command key + '.' (Macintosh only).

3D Sound Rendering

With this function you can render 3D sound
data. For that CINEMA 4D creates, for each
microphone object in the scene, an appropriate
WAV sound file. CINEMA 4D calculates the

volume and pitch of each sound file according
to the position and speed of all cameras and
microphones in the scene.

If, for example, you have a loudspeaker emitting
the thruster noise of a spaceship passing the
camera and you position two microphones to
the right and left of the camera, you will
generate sound files in which the sound (as in
reality) moves from left to right. If the spaceship
(loudspeaker) moves away from the camera, the
sound will become quieter; if it moves closer, the
sound becomes accordingly louder.

If, in addition, you turn on Doppler effect, the
pitch of the spaceship will change according to
whether it flies towards or away from the camera.

Naturally you can also adjust all of this by hand
in a sound program. However, as soon as you
change something in the way the objects in the
scene animate, you have the problem of having
to update all the sound data accordingly. The
3D sound rendering of CINEMA 4D is thus far
more flexible than using conventional methods.

Note

CINEMA 4D creates uncompressed mono WAV
files in 16 bits @ 44.1 kHz.

Path

Enter the desired file path and name for the
WAV sound file you want to create. The actual
names of the files are built up as follows:

'Filename from dialog'_'object name.WAV'

For example, if you enter 'C:\temp\test' as the
file path and there are two microphones with
the names 'MicroA' and 'MicroB' in the scene,
CINEMA 4D creates in the folder 'C:\temp' two
new files with the names 'test_MicroA.WAV'
and 'test_MicroB.WAV'.
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Range

Use this to choose over how many frames 3D
sound rendering is to be performed.

Document

Performs 3D sound rendering over the entire
length of the scene.

Preview

Performs 3D sound rendering over the part of
the document marked as a preview range (see
page 562).

Raytracer

Performs 3D sound rendering over the number
of frames defined in the render settings of the
document (see page 407).

You can interrupt the calculation of the sound
data at any time by pressing the ESC key or the
Command key + '.' (Macintosh only).

Close
This function closes the Time Line. The
animations created in the Time Line will remain.

Edit

Undo

This function is used to undo the last change
made to the animation.

If you use this function several times, one after
the other, first the last change you made will be
undone, then the editing prior to that change is
undone and so on. By default, CINEMA 4D
saves the last ten edit steps internally and all of
these steps may be undone.

You may change the number of undo steps in
the General Settings (see Undo Depth,
page 45).

Redo

If you should use the Undo function a little too
vigorously and undo too far back then you can
quickly reverse the undone steps with the Redo
function.

Basically, with Undo you go backwards through
the edit history of your scene, with Redo you go
forwards.

The number of these restorable steps
corresponds to the number of Undos (see
above) and therefore cannot be separately
changed.
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Cut
This function copies the keys and the sequence
data that are currently selected in the Time Line
into the clipboard and deletes it from the Time
Line. Elements stored in the clipboard may be
inserted into the Time Line again with the Paste
function (see below).

Note

When several sequences and keys are selected in
the Time Line, CINEMA 4D always cuts the
elements of the first selected line, top to bottom.

Copy
This function copies the keys and the sequence
data that are currently selected in the Time Line
into the clipboard. Elements in the clipboard can
then be inserted again into the Time Line with
the Paste function (see below).

Note

When several sequences and keys are selected in
the Time Line, CINEMA 4D always copies the
elements of the first selected line, top to bottom.

Paste
Inserts the stored elements from the clipboard
into the active document. In the case of the
Time Line the pasted elements stick to the
mouse pointer and must be given a position in
the Time Line. Do this by moving the mouse
arrow to the position where you wish to paste
the elements and click to paste them.

Delete
Deletes the animation elements selected in the
Time Line. To delete all animation parameters of
a certain object select the appropriate entry on
the left. Objects themselves cannot be deleted
with this command.

Delete All Markers
Use this function to delete all existing markers
from the Time Line, in one step.

Select All
This function activates or selects all visible and
invisible elements of the Time Line (objects,
tracks, sequences, keys).

Deselect All
This function will deactivate or deselect all
elements of the Time Line (objects, tracks,
sequences, keys).

Invert All
Inverts the entire selection in the Time Line. So
all selected objects will become deselected and
all deselected objects selected.

Region Select
The selection tools described below work only in
connection with sequences and keys. By using
the Shift key and the mouse you can extend
existing selections. Use Shift and Ctrl during the
selection process to subtract the appropriate
elements from an existing selection.
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Rectangle

With this selection tool you select elements of
the Time Line by holding down the mouse
button and drawing a rectangular frame with
the mouse.

Freehand

Use this selection tool to select elements of the
Time Line by holding down the mouse button
and drawing a free hand selection with the
mouse.

Polygon

With this selection tool you select elements of
the Time Line by holding down the mouse
button and clicking with the mouse on
consecutive points of the Time Line, thus
drawing a selection polygon. To finish the
process simply click in the proximity of the
starting point. Alternatively you can close the
polygon by pressing the right mouse button or,
on the Macintosh, press the Command key
while clicking with the mouse.

Snap to Frame
This function (active by default) helps you to
position keys and sequences accurately to
frames when moving them with the mouse. If
this option is deactivated all keys and sequences
can be positioned freely between frames,
without the use of time steps.

Note

When you add a key to a sequence, the new key
may replace an existing key, regardless of
whether you place the key manually or whether
you use autokeying. For example, say a
sequence has an existing key at frame 12.23 and
a new key is placed at frame 12. The original key

(12.23) will be deleted and the new key will be
snapped to frame 12.

CINEMA 4D also snaps sequences and keys
when moving or scaling keys. This prevents keys
from resting on non-integral positions such as
3.476532. However, keys can be lost in the
process, as demonstrated in the following
example:

Create a sequence of just 10 frames in length
and create a key for each frame.

Next, scale down the sequence so that it is only
four frames long (hold down Ctrl while you drag
the red selection handle).

Now scale up the sequence so that it is 10
frames long again.

As you can see, the sequence now has just four
keys, the others have been lost. The reason why
is that when the sequence was scaled down
they keys were snapped to integral frame
numbers.

Thus you can work on a frame basis or a time
basis (as is necessary when converting a scene
from PAL to NTSC).

Project Settings
This function opens the dialog window for the
Project Settings (see page 56).
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View

Frame All
Using this function enables you to frame (or
view) the entire animation within the visible
work area of the Time Line. If necessary the
view will be scaled horizontally.

Frame Selection
Use this function to frame the selected elements
(sequences and keys) within the visible work
area in the Time Line. If necessary the view will
be scaled horizontally.

Frame Start
This function frames the visible work area in the
Time Line from the beginning of the document.
The view is not scaled.

Frame End
Frames the visible work area in the Time Line to
the end of the document. The view is not
scaled.

Frame Active Time
This frames the visible work area in the Time
Line starting at the current position of the green
time pointer. The view is not scaled.

Frame Time
This function frames the visible work area in the
Time Line starting at a numerically entered time
value. The view is not scaled.

Frame Marker
This function frames the work area in the Time
Line starting at a selected marker. The view is
not scaled.

Frame Right Marker
Frames the work area in the Time Line starting
at the nearest right hand marker (the selection
of the marker is based on the current view in the
Time Line). The view is not scaled.

Frame Left Marker
Frames the work area in the Time Line starting
at the nearest left-hand marker (the selection of
the marker is based on the current view in the
Time Line). The view is not scaled.

Zoom in
Increases the scale of the view in the Time Line
by a factor of 2.

Zoom out
Decreases the scale of the view in the Time Line
by a factor of 2.

Curves

Tangents

This command activates or deactivates the
display of all curve tangents in the time control
and space control modes.

Crosshairs

This activates or deactivates the display of the
crosshair pointer in the time control and space
control modes.
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Activates or deactivates the display of the
background grid in the time control and space
control modes.

Range

This function activates or deactivates the display
of the effective range in the time control and
space control modes. The effective range is
indicated by two dark red vertical lines.

Space Curves

X Curve, Y Curve, Z Curve

These commands activate or deactivate the
display of the X, Y and Z curves in the space
control mode.

Time Curves

Path, Velocity, Acceleration

These activate or deactivate the display of the
path, velocity and acceleration curves in the
time control mode.

Navigation

Record
All the functions in the Record submenu may be
switched on or off. For each active track type
option CINEMA 4D will attempt to create, for
the object that active in the Object manager, the
appropriate tracks (including sequences and
keys, if these do not already exist), when the
Record function is next used.

If an object does not support one of the selected
track types then no appropriate tracks for this
object are created when keyframe recording.

Position, Scale, Rotation

Activate these options to create position, scale
and rotation keys when keyframe recording.

The dialog windows of the position, scale and
rotation keys are very similar. In the upper range
of the window you change the appropriate X, Y,
Z or H, P, B values.

In the tangent fields you can also change the
shape of the animation curve (see Spline Curves
on page 131 for a general discussion of these
curves).

Point Level Animation (PLA)

When using the Point Level Animation track,
CINEMA 4D saves all information for the points
or the polygons of an object into single keys.
This method, among other things, produces a
very efficient and easy way of creating animated
deformations. So you can edit, for example, a
face with the magnet tool and record the
intermediate stages with PLA keyframing. When
you play the animation your object will be
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animated using these intermediate
transformations and can change from a happy,
smiling individual to a grouch.

At first glance this technology has strong
similarities to that of the morph track, which
also allows an object to transform through
several stages. However ...

Note

When using PLA animation you should note that
the complete geometry data of the animated
object is needed for each key; therefore you
should use this method only with smaller
objects. Imagine animating a huge, 20 megabyte
dinosaur with PLA. With only ten keys created
for the beast you would already have a scene
needing approximately 200 megabytes, even if
the dinosaur just blinked! In cases like this you
should use other animation techniques such as
bones or morph tracks instead.

Parameter

Activate this option to create parameter keys
when keyframe recording. CINEMA 4D creates,
if possible, the appropriate tracks and keys with
the current parameters of the selected objects.

Hierarchy

This option defines whether the sub-objects of
the selected objects will also receive keys when
keyframe recording. This can make sense, for
example, when animating a character. You
simply adjust your figure into your chosen pose
and select the main object of the hierarchy. If
you now start keyframe recording CINEMA 4D
will create tracks, sequences and keys for the
main character and all child objects.

Interpolation

Hard Interpolation

Hard interpolation does not create any tangents.
The space curve consists of straight segments.
Thus the object moves rather mechanically.

Medium Interpolation

Medium interpolation is a mixture of soft and
hard. The tangents are slightly cracked in some
cases to compensate for the overshooting.
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Soft Interpolation

Soft interpolation is required in most cases in
order to produce a soft, smooth movement. The
tangents are always straight so there will never
be a kink in the curve. However, this method
produces overshooting of the space curve if
values change drastically over a short period of
time, which can be unwanted since the object
moves slightly backwards before the position
change in case of a position track. This means,
even if two successive keys have exactly the
same position values, the object moves slightly
between these two as if to gather momentum.

Record (Function)
This command adds a keyframe recording at the
current time. When keyframe recording
CINEMA 4D automatically creates tracks,
sequences and keys for the selected object in
the Object manager. Exactly which track types
are to be created can be changed in the Record
menu of the Time Line.

Autokeying
With the Autokeying command you can switch
to fully automatic keyframe recording.
CINEMA 4D will then add a new keyframe
recording after each noticeable change in the
scene.

This can result in an efficient recording system
with swift results, especially with less complex
animations. You simply change, for example, the
time, move your object and CINEMA 4D notes
the new position and records it with the
appropriate keys. You then repeat this process
until you are happy with the animation. There is
no simpler way to animate.

Note

You can move forward and backward in time
quite freely when Autokeying. Note, however,
that keys that already exist can easily be
overwritten.

Play Mode

Preview Range

Using this function you can play the section of
the animation that is currently defined as the
preview range in the Time Line (see above,
Preview Range). This option can be switched to
one of three playback modes: Simple, Cyclic or
Ping Pong.

Simple

This system of playback plays the animation
from the start to the end and then stops.

Cyclic

This system of playback repeatedly plays the
animation from beginning to end again and
again. You can end the playback using Stop.

Ping Pong

With this type of playback the animation plays
forwards and then plays in reverse. You can end
the playback with Stop.
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Frame Rate
This menu allows you to choose the playback
speed of your animation. The values are the
number of frames per second (fps).

Note

The playback speed here has nothing to do with
the real frame rate of the document or the
raytracer, it is used only for the playing back of
animations within the viewport.

All Frames

This option takes priority in the Frame Rate
menu. Unlike the other values in the menu, this
option does not define a certain number of
frames per second, but forces the display of
each and every frame during playback. This can
be very helpful, especially when dealing with
complex animations, as you are able to view
quick movements that could otherwise not be
seen due to a slow screen update.

Note

If possible always select this option when using
particles, as only then will you see the animation
in the viewport as it will appear when raytraced.
If you do not choose this option for particles,
CINEMA 4D may miss the occasional frame
when trying to keep to the selected frame rate.
This can lead to the particles in the viewport
being displayed inaccurately. For the raytraced
rendering, however, this function will have no
effect. The raytracer always renders the particles
correctly!

Project

This option changes the playback speed to the
value defined in the Project Settings (see
page 56).

1 to 500

Select the frame rate from a number of rates,
within the range of one frame to 500 frames per
second.

Play forwards
Use this command to play the animation
forwards in the viewport.

Play backwards
Use this command to play the animation
backwards in the viewport.

Stop
Use this to stop the playback of the animation in
the viewport.

Goto Start
This command will set the current time position
to the beginning of the animation.

Goto End
This will set the current time position to the end
of the animation.

Goto Frame
This displays an input dialog into which you can
manually enter any timeframe. After confirming
the dialog the current time position is set to this
timeframe.

Goto Marker
This displays an input dialog into which you may
manually enter the name of an existing marker.
After confirming the dialog the current time
position is set to the position of this marker.
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Goto Next Frame
This moves the time position forward by one
frame.

Goto Prev Frame
Moves the time position backward by one
frame.

Goto Next Key
Moves the current time position to the next key.

Goto Prev Key
This command moves the current time position
to the previous key.

Objects

Rename Object
This allows you to rename the object currently
selected in the Object manager. It is identical to
the other ways of renaming an object (such as
double-clicking its name).

Search Active Object
This command allows you to search the Time
Line for the object currently selected in the
Object manager. This can be helpful when an
object is hidden deep within an object hierarchy.
The hierarchy of this object is unfolded to the
point where the selected object is visible.

Unfold All
This function unfolds all hierarchies in the Time
Line. This action is also applied to invisible and
locked objects.

Fold All
This folds all open hierarchies in the Time Line.
The folding is also applied to invisible and
locked objects.

Bake Object
This function will convert animations which
were not created using position, scale or
rotation tracks (but nonetheless refer to the
position or size of the object) into real position,
scale or rotation tracks. As an example, you
could convert a movement created with a
spline-based inverse kinematics track into a
rotation animation with appropriate keyframes.
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This is necessary, for example, when editing
animations using motion sequencing (see
page 571). Another application would be the
export of an animation into a file format such as
VRML, which does not recognize geometry
effects such as aligning to or inverse kinematics.

Note

Bake Object creates keys at regular intervals,
paying no attention to any necessity for the
positioning of the keys; very many keys are
created. Therefore you should use this function
sparingly and economically. You can try to
reduce the keys of the animation afterwards
with the help of the Simplify Curve function (see
page 622).

Also note that not all types of animation can be
baked. You can convert into real keys, for
example, only those movements that alter the
position, scaling or rotation of an object.

Expressions are also exempt from conversion,
since they are only evaluated when drawing the
scene (see The Drawing Pipeline, page 89) and,
as such, are not contained within the animation.

Position Track to Spline
This converts a keyframe based position
animation into a spline animation.

First, select the object that you wish to adjust.
Then call up Position Track to Spline.
CINEMA 4D will now create a new spline that
corresponds to the movement path of the
object. You can edit the spline and assign this to
the object again with Spline to Position Track.

Tip

This command can be useful, for example, when
editing an animation path that was created by
keyframing with tools such as the magnet.

Spline to Position Track
This converts a spline-based animation into an
animation that is based on keyframes. This can
be useful, for example, if you wish to adjust
certain path points of the animation to be
accurate time frame positions.

First, select the object you wish to change. Then
select Spline to Position Track. In the dialog
enter the name of the appropriate spline and
click the OK button. CINEMA 4D now creates a
new position track for the appropriate object.

Note:

This function should not be used with a B-
Spline, since a position track has to be
interpolated from control vertex to control
vertex. This differs considerably from the original
B-Spline shape. So you should rather use Spline
types where the curve runs through the control
vertices. The Bézier Spline works perfectly for
this purpose. The resulting position track is
nearly identical to the original Spline.

The position track from a B-Spline

The position track from a Bézier Spline
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Sequences

Edit Data
This has the same effect as double-clicking on
the (unfolded) data area of a sequence or a key
in the Time Line; it opens the appropriate dialog
in which you can change the values of the
selected element.

Edit Time
Enables you to edit the time values of a
sequence or a key. This allows you, for example,
to manually enter a timeframe at which a key is
to be set.

Edit Sequences

This makes it possible for you to change the
values of one or several selected sequences at
the same time. So you can simultaneously move
or scale several sequences, for example.

It is important to note that, within this dialog,
only those values which are active (those that
are checked) are applied to the selected
sequences.

An example: if you want to switch the Soft
option on or off for all selected sequences, first
activate the left checkbox for the Soft option to
tell CINEMA 4D that changes to this value are

to be made. Now use the adjacent checkbox to
determine whether the Soft option is to be on
(ticked checkbox) or off (empty checkbox).

It is the same with the other values; if a value is
not activated, it is also not changed. So you
could quickly change, for example, the end of
all selected sequences to 60F by deselecting all
options except To and entering a value of 60
alongside the To box.

Note that, if the action cannot be performed
(perhaps a key exists beyond the value to which
you are trying to set the end of the sequence)
nothing will happen.

From

This value defines the starting point (at the left)
of the sequence(s).

To

This value defines the end point (at the right) of
the sequence(s).

Length

This value determines the length of the
sequence(s).

Soft

This option defines whether the Soft option is
switched on or off for the selected sequences
(this is important for loop sequences).
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Insert Preview Range

Using this command you can insert a gap that is
the same size as the adjusted preview range
between the selected sequences (remember, the
preview range is the range between the two
blue triangles on the Time Line ruler).
CINEMA 4D divides the sequences at the
beginning of the preview range and moves the
separated parts to the right and to the end of
the preview range.

Tip

This function is very useful for creating extra
space later on at a certain timeframe of a
complex animation.

Delete Preview Range

This command resembles the function Insert
Preview Range described above. However the
appropriate range is actually deleted from the
selected sequences. Keys that lie within in this
range are therefore lost.

Adjust

This adapts the length of the selected sequence
to the first and last keys of the sequence. Any
overlapping parts of the sequence are cut off.

Tip

This can be helpful when you need to bring
some order into the scene or to create further
space for extra sequences.
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Connect

Using this you can combine several individual
sequences. You can connect as many sequences
of a track as you like. The sequences must be
positioned next to each other, but do not have
to touch (i.e. there can be a gap between the
sequences but not another sequence).

Tip

This function can be useful when you require to
loop a movement that is combined from several
sequences.

Divide

With this function you can split one or more
sequences into two halves by defining a time
value. The sequence(s) will then be divided into
two separate sequences positioned either side of
the time value entered.

Markers from Selection
This function will create new markers based on
the time values of the selected keys as well as
the start and end positions of the selected
sequences on the Time Line ruler.

Note

Some sound editing programs add markers to the
sound file. If a sound track should contain a sound

file with such markers or labels then these will be
converted into real CINEMA 4D markers when
using the function Markers from Selection.

Move/Scale

With this function you can simultaneously Move
and/or Scale one or more selected sequences to
a certain value.

Move

This value indicates how many units or frames
the selected sequences are to be shifted to the
right. Negative values will cause a shift to the
left.

Scale

This value indicates the size factor that the
sequence is to be scaled by. Example: if the
value is 1, the sequence remains unchanged.
With 2 it doubles the length and with 0.5 it is
half as long.

Quantize
This function rounds down selected sequences
or key positions to whole time frames. This can
be helpful if, for example, the keys or sequences
were moved to odd values by scaling
procedures.

Tip

In certain cases this function can eliminate errors
in courses of motion caused from scaling
procedures (e.g. with motion capture data).
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Group Motion

Using this function allows you to group or fold
the complete animation of an object to only one
motion group.

Note

The Grouping also functions hierarchically, i.e. if
you group a complex figure with many animated
sub-objects, then all such groupable animation
tracks of these sub-objects will disappear.

For grouping, select the appropriate object and
call the function Group Motion.

You will obtain a new motion sequence
containing all animation information of the
object, which can be moved or scaled quickly
and easily. You can also assign several such
motion groups to an object and mix together
the different movements with the keys on the
motion sequences (see page 571).

You can group position, scale and rotation
tracks. You should therefore convert movements
which were created with the help of other track

types (such as Inverse Kinematics) into these
types of tracks by using the Bake Object
function.

Note

Please do not confuse motion grouping with the
Unfold All and Fold All functions from the
objects menu, which simply fold the view of the
object hierarchy in or out.

When creating motion groups no information is
lost. You can re-establish the original un-
grouped layout at any time by using the
Ungroup Motion function.

Ungroup Motion
This function ungroups any motion group back
into its original form. Simply select the
appropriate motion track and call the function.

Get Time Curve from

Use this function to assign an already existing
time curve of another sequence to one or more
selected sequences. Select one or more
sequences and then call this function. A
question mark will appear at the mouse arrow.
Now simply click the sequence that should
receive the chosen time curves.
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Curves
The description of the Curves menu is handled
here somewhat differently from the previous
sections on the Time Line. To be more
meaningful, we have split up the description
into sections on Space Curves and Time Curves.

Space Curves
The Space Curves window is available from
within the Time Line. Here the data of the
position, rotation and scale keys of the selected
sequence are displayed as space curves. Among
other things this has the advantage that you can
see the tangents directly and you can edit the
curves interactively using the mouse.

Call up the space curves window by selecting
the Window > Space Curves menu option from
within the Time Line.

Now you may find these diagrams rather
daunting initially; but perhaps you remember
those space-time graphs from your physics
lessons? Well the space control window is really
just a space-time graph with some added
processing options which, together with the
Time Curves (see page 615), allow a huge
degree of control over how your animation
turns out.

Navigating

The Space Curves display shows space-time
curves for any number of active sequences.

A green vertical line indicates the current frame
of the animation; you can move this to other
frames by dragging the green box at the top of
the line.

The various ways of framing the window using
the powerslider at the top of the window and
the View menu are discussed earlier in this
chapter; they work identically here.

Within the Space Curves window you will see
two small icons towards the top left of the
window:

These allow vertical control over the window.
You can move the window display up or down
using the icon on the left or scale it using the
icon on the right; position the mouse pointer
over the icon, click and drag up or down.

Editing

In order to give you a feeling of how to use the
Space Curves features we’ll run through a short
tutorial.

First, create a short animation. Keep it simple;
perhaps a sphere moving along the X axis from
the origin to (200,0,0).

To do this create a sphere, hit the Record
button, move the animation slider to say 30
frames, move the sphere to (200,0,0) (use the
Coordinate manager or lock the Y and Z axes
and move it interactively) and hit the Record
button again.

If you have difficulty creating such an animation
please have a thorough read of this chapter and
also see the Tutorial manual.
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If you save the scene now, you can use it for the
following Time Curves section.

Now select the position sequence in the Time
Line by clicking on the sequence. Switch into
space curve window (Window > Space Curves)
and look at the diagram. A reddish-brown line
(representing the X axis) shows how the position
of our object has changed over time along the X
axis. The green and blue lines (for the Y and the
Z axis) are both constant on the zero line.

Now move the time slider to the middle of your
animation (about frame 15 in the above
example), go back to the viewport and move
the sphere up along the Y axis (again, either use

the Coordinate manager or lock off the X and Z
axes, activate the Y axis and interactively move
the sphere). Record this new position, so
creating a new keyframe.

As you will have noticed, assuming all windows
are visible, the green curve within the Space
Curve window (movement in the Y direction)
changed immediately — it became a small hill!

In addition all three lines have an additional key
now (the small point in the center).

Click on one of these keys with the mouse —
immediately the tangent of this point becomes
visible. You can now move the point and edit
the tangents with the mouse. The tangents
behave exactly the same as the tangents of
Bézier splines and you can read more about
those in Spline Curves, page 131.

Now move the points and tangents a little and
you will very quickly have a feeling for what you
can do with these diagrams.

Note

The individual keys can be moved vertically
completely independently. However in the
horizontal direction (along the time axis), all
points are moved together; the three values for
X, Y and Z are kept in one key.
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Moving keys vertically is how you specify the
position, direction or size of an object at a
particular point in time and separately for each
of the three curves.

Moving keys horizontally is how you specify
when an object will be at a particular position, in
a particular direction or have a particular size.

In many cases you will see only a particular
section of the animation or of the sequence. It is
of course possible to fit the animation into the
window using the power slider and other
methods, described elsewhere. However, this
can sometimes make the display small and
difficult to work with.

So CINEMA 4D has a convenient way of
scrolling the display. Click in the free region of
the inner graph window. Hold the mouse button
down and drag, left and right or up and down.
This will move the window contents in real time.

You can also add new keys within the Space
Curves window. Hold down the Ctrl key while
clicking in the inner graphics area. This will add
a new key automatically.

Curves Menu

Tangents

The curves here behave, as far as possible, just
like the Bézier splines of the Objects menu
(more exactly they are Bézier Splines — but not
used for object construction).

With this menu option you can select between
hard or soft interpolation for the tangents.

—Hard Interpolation

Hard Interpolation sets the tangent length to
zero, giving a hard transition at this key.

—Soft Interpolation

Soft Interpolation produces tangents of equal
length and of such a length as to produce as
soft as possible a course for the curve:

—Unify

For any of the space curve keys you can change
each tangent arm independently of the other by
holding down the Shift key while dragging the
tangent around; just like you can for any Bézier
spline.
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The Unify command evens things out again; it
makes both tangents of the selected keys the
same length and aligns them in a straight line, in
opposite directions. The right tangent is the one
that is modified to adapt to the values of the left
tangent.

—Flat

Use this to align all tangents of the selected keys
horizontally (the length of the tangents will not
be affected).

Edit Data

Selecting this option allows you to edit the
position and tangents of a point numerically.
You can achieve the same thing by double-
clicking on a point.

Move

If you want to move one or more points by a
particular value, you can use this command to
enter the (X,Y) values directly. Of course you
can also move the points by hand (or, more
accurately, mouse).

Scale

This function ensures for the fact that both the
position of a point quantity and their tangent
lengths and distances to each other can be
scaled a freely selectable factor in X and Y
direction. Origin of the scaling is always the first
key from the left.

X Axis / Y Axis

By checking/unchecking these options, you can
limit the movement of keys and their tangents
so that they can be moved with the mouse only
horizontally or only vertically or both or not at
all. This only affects movement using the
mouse; the Edit Data command ignores these
settings.

Mirror X / Mirror Y

This option mirrors the selected key values
including the tangents about a horizontal
(Mirror Y) or a vertical (Mirror X) axis. This
option needs at least two selected points.

Cycle

With this option you can group a number of
selected keys and have them repeat cyclically.
Here the first key of the selection steps to the
position of the second key, the second key to
the third key and so on. This option needs at
least two selected keys (not points on the same
key).

Cycle With Offset

This command is similar to the Cycle command
described above. This time, though, the first
point stays where it is and is not repeated. The
remaining points are repeated, and each repeat
is offset. The size of the offset is determined by
the vertical distance between the first and
second points of the original selection. This
command requires at least two points to be
selected.

For example, if the starting key has a starting
position of 200, then the first key of the
repetition will have a position value of 400, the
next one of 600 etc.
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Bake Curve

Perhaps you’ve already given your curve the
basic correct form with the help of the tangents,
but you would like to fine tune it in some
places, adding some detail or variation?

With Bake Curve you can provide the curve with
as many extra keys as you need. For Frequency
enter at which frames CINEMA 4D should insert
new keys automatically (1 for every frame, 2 for
every other frame etc.).

The form of the curve will remain unchanged
but the new keys inserted will allow fine tuning
to take place as desired.

Simplify Curve

This function does roughly the opposite of Bake
Curve. If a curve has too many keys in places
where these are not needed at all, these
superfluous keys can be eliminated, with
separate controls for both horizontal (frame)
and vertical (position etc.) data.

This is useful when working with motion capture
data. There you normally have to cope with
thousands of (mostly unnecessary) keys. With
Simplify Curve you can reduce this to a bearable
number and thus make the motion capture data
much easier to work with.

Example:

- If keys are to remain every 10 frames, you
should enter for X a value of 10F.

- If keys are to remain only when a change of
position is more than 50 units from the
previous key or to the following key, you enter
a value of 50 for Y.

- Naturally, you can set both values at the same
time.

Note

Use this function with extreme caution.
Carefully adjusted curves can be ruined easily
with an indiscriminate use of Simplify Curve. So,
approach your optimal curve slowly and reject
over-simplified results with the Undo function.

Time Curves
We’ll begin this section with a little theory.
Please make sure you read through these pages
because, although the time control is easy to
use, it is also exceptionally powerful. A little
understanding now will help you create
stunning animation later.

You should already know how to give an object
motion, animate light parameters, animate
camera parameters and so on. In each case, the
first step is to create a track and sequence for
the object. Next, you need at least one key for
the sequence. A key is like a snapshot in time —
it contains the values for that exact moment
(frame). Sometimes, dozens of keys are used for
a sequence.

Good timing is essential for top-quality
animation. Not only is it difficult to create
smooth animation (e.g. ease-in ease-out) using
Time Line keys alone, it is not a very flexible
way to work — altering one key may affect the
entire sequence.

There is, however, a wonderful solution; time
curves. As soon as you apply a time curve to a
sequence, the time curve takes control of the
timing and the comparatively clumsy frame
positions of the original keys no longer matter.
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You can tell if a sequence has a time curve by its
appearance:

We will explain time curves with the help of a
practical example. We shall use the sphere
scene, which you may remember from the
Space Curves section above (a quick reminder, a
sphere moves along the X axis, from left to
right. There are two keys, one at the start and
the other at the end of the position sequence).

Change into the time curve view (select
Window > Time Curves). The graph is empty to
begin with.

Why is the graph empty? The answer is simple;
sequences do not usually have a time curve
because their Time Line keys are interpolated
linearly. This is in contrast to space curves, which
always show graph readings. Make things easy
on yourself and, even if you do not understand
why, accept that the space curves and the time
curves have almost nothing to do with each
other.

The most important menu for time curves is,
unsurprisingly, Curves > Time Curves. We will
explore this menu in detail. The remaining menu
items have the same functionality as their
counterparts in the space curves and are
covered towards the end of this chapter.

Path, Velocity, Acceleration

There are three modes for working with time
curves; path mode, velocity mode and
acceleration mode. You should work in the

mode relating to the values you want to control.
For example, if you want to control the object’s
acceleration, you should work in the
acceleration mode.

Note

No matter which mode you are in, the curve that
you edit is a master curve in the sense that if you
change modes, the master curve will then be
applied to that mode. For example, if you create
a time curve in velocity mode, the master curve
is a velocity curve. However, change into
acceleration mode, and it becomes an
acceleration curve. The shape of the master
curve remains the same when you switch modes.
You can only edit the master curve, since all
three curves are interdependent. The result of
the master curve can be seen by playing back the
animation in realtime in the viewport (you can
even keep the animation playing while you edit
the master curve!). Note that the curve is
approximated for realtime playback — you must
render in order to see the exact results.

Tip:

Within the Time Curve window it is possible to
assign a time curve to multiple selected
sequences simultaneously. You can e.g. apply a
synchronized acceleration to both position and
size change in the Time Curve window by
selecting Position and Scale and creating a new
time curve in velocity mode. This then applies to
both sequences.

Ramp Up

Let’s get back to our sphere scene (see Space
Curves, Editing, page 611). Select Curves >
Time Curves > Ramp Up. Notice how a red
curve appears on the graph. As the red P on the
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graph suggests, the red line represents the path.
The path curve rises linearly, with a key at either
end.

Note

The graph’s vertical units refer to an abstract
percentage (%). 0% equates to the values of the
first key in the Time Line sequence. 100%
equates to the values of the final key in the Time
Line sequence. In other words, 0% refers to the
initial state of the sequence, 100% refers to the
final state of the sequence.

Play the animation in the viewport. Nothing
seems to have changed, at least not visibly. OK,
drag the right key on the time curve down to
the 50 (%) value. If you like, you can leave the
animation playing while you do this — you can
edit keys in realtime! Notice how the sphere
only reaches the halfway mark now. The sphere
travels at half the original velocity as well, since
it now covers half the distance over the same
time period.

Move the right key up to 200 (%). Now the
sphere travels with twice the original velocity. As
a result, it has already reached its destination
midway through the animation. The sphere
remains stationary throughout the second half
of the animation.

Hang on a moment, something doesn’t add up!
How can the time curve have a value greater
than 100%? No matter what the time curve
suggests, only values between 0 and 100% can
be evaluated. So, when the path exceeds 100%,
the sphere remains stationary.

Did you notice how the green velocity curve
changed? The velocity curve often runs parallel
to the time axis apart from near the start and
end (for ease-in ease-out behaviour). The

greater the distance in units between the
velocity curve and the null line, the greater the
velocity.

Now, change into velocity mode, then select
Ramp Up. This makes the velocity increase
linearly. A linear increase in velocity means
constant acceleration — falling objects, for
example, experience constant acceleration. If
you fancy a challenge later on, try creating
constant acceleration without time curves —
good luck!

Ramp Down

Change into path mode, then select Curves >
Time Curves > Ramp Down. The red path curve
now decreases linearly and the green velocity
curve is below the null line. The sphere is
travelling backwards. Now you really can turn
back time!

Note

You can use this type of reverse behaviour to
create eye-catching effects. For example, you
can turn an explosion into an implosion or
unmelt a melted object! Oh, did we forget to tell
you that you can use time curves with any type
of sequence?

Ridge

Select Curves > Time Curves > Ridge, then play
back the animation. The result is not exactly
spectacular. Change into velocity mode.

Now, the object accelerates at the beginning of
the animation and decelerates at the end. This is
ease-in ease-out behaviour. Look at the blue
acceleration curve on the graph. Acceleration
curves can be a little tricky to understand at first
— it may take a while to sink in.
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Lastly, select Curves > Tangents > Soft
Interpolation. The ridge becomes a smooth
arch. Now is a good time to experiment. Try
moving the tangents for the keys. Try working
in some of the other modes, and be sure to
create some new keys (Ctrl-click).

Fit Path End to 100%

Sometimes you may notice that an object is not
reaching its destination at the correct time.
Perhaps its velocity is too high or too low (in
which case the red path will end above or below
the 100% mark respectively).

If you select Fit Path End to 100%, CINEMA 4D
will ensure that the curve reaches 100% exactly.

Note

In some instances you do not want the path to
end at 100%! (e.g. when you have used Ramp
Down to reverse the sequence).

Formula

Mathematicians will have a field day with the
Formula function. This lets you enter a formula
to generate a time curve. Even if you are
hopeless at maths, don’t run away — we’re
going to show you some very useful formulae
that anyone can use.

You enter the formula in the s(t)= field. You can
also set the number of intermediate points using
the Keys field.

The Sine Function

Let’s return to our old friend, the sphere scene.
Change into path mode, then select the Formula
function. The s(t)= field contains the default
formula: sin(t*pi*2.0)*0.5 +0.5

'sin' stands for sine and describes a sine curve.
The expressions in the brackets define the
amplitude and frequency of the sine curve. The
letter 't' stands for time. Don’t worry if the
formula means nothing to you.

Enter the formula 'sin(t)'. The result is rather
uninspiring — a shallow curve which reaches
100 (%). We can make the curve more
interesting by using a scaling factor. We’ll use
2*pi, which to many mathematicians suggests
one oscillation. Though we shall use Pi, you can
use a number as a scaling factor (after all, Pi is
only a number; 3.141... — we hope
mathematicians are not offended by the use of
the word only).

Anyway, let’s try a scaling factor — enter the
value 'sin(t*2*pi)'. Sure enough, the result is a
sine wave.

Notice how the sphere only moves during the
first half of the sine curve. Recall that a path
value can only be evaluated when it lies
between 0 and 100%. The sine curve values
range from -100% to 100%. The negative
values cannot be evaluated, and so the sphere is
stationary for the second half of the sine curve.

How, then, can we adjust the sine curve so that
it can be evaluated in full? We can see what
needs to be done — the curve should be shifted
up and scaled to fit between 0 and 100%. The
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amplitude currently runs from -100 to 100%, so
we need to halve it, i.e. divide it by 2. Dividing
by 2 is the same as multiplying by 0.5.

Here is the final formula ...

sin(t*pi*2.0)*0.5 +0.5

Play back the animation and give yourself a
well-deserved pat on the back!

The Exponential Function

Let’s try the exponential function. Start by
entering 'exp(t)', then select View > Frame All
so that you can see the curve in full.

The curve begins at 100% and rises exponentially.
Add a scaling factor by entering 'exp(t*2)', then
select View > Frame All. The curve is much
steeper now. Change the scaling factor to '*0.5'
— this should give you a more shallow curve.

Let’s try a negative scaling factor! Enter 'exp(t*-
2)', then select View > Frame All. Now the

curve decreases exponentially towards (but
never quite reaches) the null line.

Play back the animation and notice how the
sphere slows down exponentially. Very nice, but
don’t sit back just yet — we have something
special lined up.

The Exponentially Damped Sine Curve

In this section we’re going to use the functions
we’ve just learnt (sin and exp) and put them
together for something special; the
exponentially damped sine curve.

Believe it or not, damped sine curves are very
common. If you need convincing, grab your
computer mouse by the tail, swing it and then
keep your hand still. That’s a damped sine curve.
If you can’t conduct our mouse experiment
because you have the cordless variety, grab your
monitor cable instead and, ... on second
thoughts, leave your monitor exactly where it is!

We need to combine our sin and exp formulae
and add a few more oscillations for good
measure:

Enter 'exp(t*-2)*sin(t*8*pi)*0.5+0.5'

Sit back, watch the animation, and don’t forget
to close your mouth.

Very important note

You can use a formula with any type of
animation including parameter and special
effects sequences.
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Offsets

This is where things get mathematical. If maths
is not your cup of tea, stay for the ride anyway
— we’re almost done.

You can use this function to set an integration
constant.

Before we continue, recall that the path, velocity
and acceleration are interdependent. The
acceleration is the differential of the velocity,
which in turn is the differential of the path. Put
another way, we can integrate the acceleration
to arrive at the velocity, and we can integrate
the velocity to give the path. Passionate
mathematicians will know that every integral
has an integration constant which shifts the
curve up or down the graph.

If you didn’t quite understand that, the main
point is that you can use an offset to give an
object an initial velocity or start it from
anywhere you like along the path. A positive
value shifts the curve up the graph. A negative
value shifts the curve down the graph. If you are
unable to select both entries, you are in path
mode. If only Path is active, you are in velocity
mode.

This is because, as discussed earlier, we can
integrate the acceleration to calculate the
velocity, which in turn can be integrated to
calculate the path. The path is the end of the
road, which is why you cannot use offsets in
that mode (an integration constant can only be
used when you integrate and the path does not
integrate into anything meaningful).

The Remaining Menu Items

In this section we cover the remaining menu
items. All of these items are used in the space
curves too — you can skip this section if you
have already read the space curves section.

Navigation

The section on Space Curves navigation
(page 611) showed you how to use the Time
Line’s View menu. The Time Curve’s View menu
operates in the same way.

The Time Curves window has two icons to the
left of the graph. You can use these icons to
move or scale the graph (click on the icon you
require and then drag the mouse).

Curves Menu

Tangents

The curves here behave, as far as possible, just
like the Bézier splines of the Objects menu
(more exactly they are Bézier Splines — but not
used for object construction).

With this menu option you can select between
hard or soft interpolation for the tangents.

—Hard Interpolation

Hard Interpolation sets the tangent length to
zero, giving a hard transition at this key.
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—Soft Interpolation

Soft Interpolation produces tangents of equal
length and of such a length as to produce as
soft as possible a course for the curve:

—Unify

For any of the space curve keys you can change
each tangent arm independently of the other by
holding down the Shift key while dragging the
tangent around; just like you can for any Bézier
spline.

The Unify command evens things out again; it
makes both tangents of the selected keys the
same length and aligns them in a straight line, in
opposite directions. The right tangent is the one
that is modified to adapt to the values of the left
tangent.

—Flat

Use this to align all tangents of the selected keys
horizontally (the length of the tangents will not
be affected).

Edit Data

You can use Edit Data to change a point’s
position and tangent values. You can access the
same dialog by double-clicking on the point.

Move

This lets you move one or more points by the
distance you enter. You can, of course, move
the points manually.

Scale

This function lets you scale the selected points.
The left-most point marks the origin of the scale
operation.

X-Axis/Y-Axis

You can use these options to enable or prevent
movement along the X and Y axes. For example,
you can deselect X-Axis if you want to move a
key vertically only.

Mirror X/Mirror Y

These commands mirror the selected points
(including their tangents) horizontally or
vertically. These commands require at least two
points to be selected.

Cycle

Cycle repeats the selected points. The last point
of the selection is not repeated but shifted to
the end of all the cycles. This command requires
at least two points to be selected.
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Cycle With Offset

This command is similar to the Cycle command
described above. This time, though, the first point
stays where it is and is not repeated. The
remaining points are repeated, and each repeat is
offset. The size of the offset is determined by the
vertical distance between the first and second
points of the original selection. This command
requires at least two points to be selected.

Bake Curve

Imagine you have used the tangents to form the
general shape for your time curve, and now you
want to add small details that require extra
points.

You can use Bake Curve to add as many points
as you like. Frequency defines the distance
between each point. The new points will fit the
existing curve shape.

Simplify Curve

This command has the reverse effect of the Bake
Curve function in the sense that it removes
points. Imagine that you have too many points,
making it difficult to make smooth changes. You
can remove points using the Simplify Curve
command. You can set a horizontal and/or
vertical tolerance value. Points that are closer
than the tolerance value(s) are removed.

Example

If you want the keys to be at least 10 frames apart
from one another, set the X value to 10. If, on the
other hand, you want keys to be at least 15%
apart from each other, set the Y value to 15.

Note

Use this function with caution! If your tolerance
value is too large, your new curve will lose its
shape.

Layer

Color Selection
With this menu you can assign one of the eight
pre-defined colors to the elements (objects,
tracks, sequences, and keys) selected in the
Time Line.

Select Layer
Choose one of the eight layer entries from the
Select Layer menu to select all elements related
to this layer in the Time Line.

Toggle Layer
Choose one of the eight layer entries from the
Toggle Layer menu to both lock and switch to
invisible the appropriate layer. Another call to
the same layer toggles the layer to visible and
unlocks it.

Solo Layer
Choose one of the eight layer entries from the
Solo Layer menu to switch all layers except for
the selected one to invisible and locked.

All Layers
Using the menu functions Visible, Invisible,
Unlock and Lock allows you to toggle on or off
and lock / unlock all layers at once.
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Window

Sequences
Changes the Time Line window into the
standard mode in which you can edit the
sequences and keys of your animations.

Space Curves
Changes the Time Line window into the space
curve mode in which you can edit the single
space curves of your animations (see page 611).

Time Curves
Changes the Time Line window into the time
curve mode in which you can edit the single
time curves of your animations (see page 611).
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20. Structure Manager   
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20 Structure Manager

The Structure manager resembles a spreadsheet;
both can process data directly within cells which,
in turn, are divided into lines and columns.

Within CINEMA 4D’s Structure manager, various
attributes of the active object are displayed and
can be edited directly in the cells. The points
and polygons of an object and its UVW
coordinates can all be displayed (if relevant) by
selecting from the Mode menu; by default, an
object’s points are displayed.

Values in the cells can be edited directly, lines
can be moved by means of drag-and-drop and
cut, copy, paste is supported. Larger quantities
of data can be processed rapidly, even if the
object has a large number of points or polygons.
The selection frame (a red frame around an
active box) shows you which data you are
working on; navigating around the table is thus
very simple.

Note

If you are working on one of the basic objects or
on a spline primitive, you will not necessarily
see anything when you choose the Structure
manager. There’s no need to panic and call
technical support; the solution is quick and
simple. Initially, basic objects do not possess a
defined point set, but that can be changed by
simply converting the object into polygons or
into a spline object using Tools > Make Editable
— see page 353.

Navigation Within the
Structure Manager

Selection

Clicking on one of the line numbers to the left
of the table selects this line and highlights it.

If you keep the Shift key pressed while clicking
(known as Shift-clicking), several lines can be
selected at the same time; Shift-clicking an
already-selected line will deselect that line.

To select all the lines of a particular attribute
(such as all the points) click directly in the
relevant name field (e.g. Point). Shift-clicking a
selected set will deselect the set.

Selection frame

When you first open the Structure manager, the
selection frame is over the cell at the top left of
the display (the first column of the first line).
Single-clicking on a particular cell moves the
selection frame to this cell, i.e. makes it active.
You can also move the selection frame with the
cursor keys.
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Using the Tab key moves the selection frame
left-to-right and top-to-bottom over the cells;
Shift-Tab reverses this.

The Home key moves the selection frame to the
very first cell of the table while the End key
moves it to the last cell.

Note

If your Apple USB Keyboard does not have an
End key. Please use the ‘+’ key on the numeric
keypad instead.

Page Up and Page Down move the selection
frame a page at a time, back and forward
respectively.

Double-clicking on a cell moves the selection
box there and enters edit mode, where you can
modify the value of the cell. While in edit mode
you can use Tab and the cursor keys as
explained above and you will remain in edit
mode.

The Return key acknowledges input and
switches between editing and selection modes.

If you press the ESC key, the previous value of
the cell is restored and you revert to selection
mode; assuming, of course, that you have not
already pressed Return!

Drag-and-drop

By means of drag-and-drop you can re-order
one or more lines and thus modify, say, the
point order. Click at the left of the display, over
a line number, hold the mouse button down and
drag; a red line appears to show where the
selected row(s) will be moved. The row(s) will
be inserted at the position of the red line and all
rows above will be shuffled up.

Re-sorting of points is useful with a spline object
that you created from another object. Here the
point sequence is often not correct; by re-
ordering you can recover that. Re-sorting the
points of a polygon is less practical.

Additionally you can transfer the contents of an
individual cell to another cell; simply click on a
cell and move the mouse with the left button
held down until you the pointer is over the
target cell. Release the mouse button and the
value of the original cell is copied here.
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File Menu

New Line
A new line is inserted into the table, below the
selection frame.

If you are in the point mode (default), a new
point is added to the object. This is created at
the world origin (X=0, Y=0, Z=0). By the input
of suitable X, Y and Z coordinates, you can
change the spatial position of the point. If the
active object is a Bézier spline, you can also
enter values for the tangents.

If you are in the polygon mode, New Line adds
a new polygon to the object. The new polygon
will not be visible yet, since it has not been
allocated suitable points (see Mode). You must
do this point allocation by hand.

If you are in UVW mode, New line creates a
new UVW coordinate. Since CINEMA 4D equips
basic objects with UV or UVW coordinates
automatically and UVW coordinates can also be
subsequently created easily (see Generate UVW
Coordinates, page 481), you may find little use
for this function.

Import ASCII Data
CINEMA 4D is able to import point data,
polygon data and UVW coordinates into the
Structure manager. The data to be imported
must be present as an ASCII file and have the
following format:

Point X Y Z
1 <Coordinate> <Coordinate> <Coordinate>

2 <Coordinate> <Coordinate> <Coordinate>

3 <Coordinate> <Coordinate> <Coordinate>

Here’s a real Point mode example for a cube:

Point X Y Z

0 -100 -100 -100
1 -100 100 -100
2 100 -100 -100
3 100 100 -100
4 100 -100 100
5 100 100 100
6 -100 -100 100
7 -100 100 100

The ASCII file must start with a header (the
‘Point X Y Z’ in the example above) and requires
line numbering as shown. The values within
each line may be separated with a TAB
character, a comma, a semicolon or a
combination of these. Each line must end with
the ASCII LF (linefeed) character or the CR
(carriage return) character, or a combination of
both. Thus it does not matter whether the ASCII
file was created on a Macintosh, Windows or
Unix computer.

If data already exists in the Structure manager,
the imported data is inserted before the line
containing the selection frame.

Note

A ‘cloud’ of points does not define a 3D object;
you must describe the required polygons
manually. To find out how to do this see Create
Polygon, page 359.

Export ASCII Data
CINEMA 4D can export the Structure manager
data so that you can use it within, say, a text
editor or some other 3D program or perhaps
import it into a spreadsheet for analysis.

In Point mode, the X, Y and Z coordinate for
each point is exported. If the object is a Hermite
Spline, then the tangent values are also
exported.
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In Polygon mode, the coordinates of each three
or four point polygon are exported.

In UVW mode the UVW coordinates of each
polygon (defined so far) are exported.

Close
Exits the Structure manager, closing the window.

Edit Menu

Undo
This cancels the last action that changed the
object and restores the previous values to the
cells. The undo level (i.e. how many actions are
remembered) is set in the General Settings
(Undo Depth, see page 45).

Redo
Undoes or cancels the last undo. The redo level
is the same as the undo level, set in the General
Settings (Undo Depth).

Cut
Removes the selected line(s) from the table and
copies to the clipboard. Use Paste to insert back
into the table, below the selection frame.

Copy
Copies the selected line(s) from the table into
clipboard, without deletion. Paste will insert
line(s) from the clipboard back into the table,
below the selection frame.

Paste
Insert any data already copied or cut into the
clipboard back into the table, below the
selection frame.

Delete
Deletes the selected lines from the table.

Select All
All lines within the table are selected.
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Deselect All
All selected lines of the table are deselected.

Invert All
All the not-selected lines of the table are
selected and the selected lines are deselected.

Select Area
The mouse pointer changes into a crosshair and
you can now draw a selection area with the
mouse. All lines within the area you draw are
selected. If lines that you want to select are
outside the visible area, move the mouse outside
the Structure manager window in the direction
that you want the window to scroll; the window
will then scroll until you move the mouse back
within the window.

View Menu

Jump Last Selection
The selection frame moves up to the last active
line.

Jump Next Selection
Move the selection frame down to the next
available line.

Jump Page Up
Display the previous page of information (if it
exists) in the table and move the selection frame
to the first column of the first line on the page.

Jump Page Down
Display the next page of information (if it exists)
in the table and move the selection frame to the
first column of the last line on the page.

Jump Home
The selection frame moves to the first column of
the first line in the table.

Jump End
The selection frame moves to the first column of
the last line in the table.
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Mode menu

Points (default)
In Point mode, the spatial coordinates of the
individual points of the object are displayed in
the Structure manager. If the active object is a
Hermite Spline, the tangent values are also
displayed. The display is organised as follows:

X Y Z

show the coordinates of the respective point in
the world system. No unit is displayed; the unit
of measurement is selected in the General
Settings and is assumed here.

<-X <-Y <-Z

is the position of the end of any left tangent. No
unit is displayed; the unit of measurement is
selected in the General Settings and is assumed
here.

X-> Y-> Z

is the position of the end of any right tangent.
Here no unit is displayed. It corresponds
however to the unit selected by you in the
General Settings.

Polygons
If you are in Polygon mode, the number of each
defining point is displayed, as follows.

A, B, C, D (which could be blank) correspond to
the respective point numbers of the three (or
four) corner points of the polygon.

Note

If C and D are identical, CINEMA 4D interprets
the polygon as a triangle.

UVW
In UVW mode, the UVW coordinates of the
polygons of the object are displayed as follows:

U[A], U[B], U[C], U[D]

are the U coordinates of the corner points of a
polygon.

V[A], V[B], V[C], V[D]

are the V coordinates of the corner points of a
polygon.

W[A], W[B], W[C], W[D]

are the W coordinates of the corner points of a
polygon .

Note

All modes operate independently of the tool that
you are using in the viewport. So you can process
points in the Structure manager, while working on
polygons in the viewport. If you want to see in the
viewport the items that you have selected in the
Structure manager, you must change to the
appropriate tool in the viewport.

Vertex Map
If you are in Vertex Map mode, the weighting
values for the points are shown. The value for a
point ranges from 0 to 1.

Note

All modes work independently of the tool that is
currently active in the viewport. If you wish to
see the elements in the viewport, you must
activate the corresponding tool (see Points and
Polygons on pages 302 and 303).
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21. Picture Viewer   
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21 Picture Viewer

File Menu

Open
This function opens an image file and displays the
image in the Picture Viewer. All 2D image formats
supported by CINEMA 4D can be loaded. For a list
of these formats, please see page 643.

Save Picture as
You can use this to save the picture to hard disk
— the following window opens.

Format

Here, specify the file format for the picture.

Note

Depending on the installed QuickTime codecs,
the list of file formats may vary.

The Picture Viewer (also known as the Picture
manager) is the external output window of
CINEMA 4D. This is where the render is
displayed if you have chosen Render to Picture
Viewer from the Render menu (see page 400).

But the Picture Viewer is able to do more. For
example, it can display textures if they have one
of the known formats (TIFF, JPEG etc.). Other
Picture Viewer functions are described below.

Note

You must use the Picture Viewer when rendering
a picture or animation to hard disk.

Move and Scale Icons

These two icons are in the top-right corner of
the Picture Viewer. Click-drag the move icon to
move the picture. Click-drag the scale icon to
zoom in or out of the picture.
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Options

If the file format you have chosen supports
extra options, access them by clicking the
Options button.

Depth

This sets the bit-depth for each channel in the
file (some file formats allow you to use 16-bit
channels — this corresponds to 48-bit color).

DPI

Here, enter the DPI for the picture. For more
details, see DPI, page 410.

Save Multi-Passes

Enable this option if you have rendered a multi-
pass image and you want to save all the layers.

Alpha Channel

If this option is enabled, the alpha channel will be
saved with the image — provided the file format
you have chosen supports the alpha channel.

Stop Rendering
This stops the rendering of the scene. All picture
data is lost in the process; you cannot restart
from where you left off, hence you will need to
start the next render from the beginning.

If you stop an animation rendering, the frame
being rendered (and all subsequent frames) are
lost. The animation can be played up to the time
it was stopped.

Note

You can also stop rendering by pressing ESC.

Close
This closes the Picture Viewer.

Edit Menu

Copy
This copies the image in the Picture Viewer to
the clipboard. You can then paste the image into
another program, e.g. an image editor.
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Channels Menu

Use this menu to control which image channels
are shown in the Picture Viewer. The menu lists
all channels contained in the image — layers are
listed also if you have rendered a multi-pass
image.

Multi-Pass Manager
This opens the Multi-Pass manager.

Multi-Layer Display
When this option is enabled, you can enable as
many of the channels in the Channels menu list
as you like — these enabled channels are
combined to form the image in the Picture
Viewer.

If Multi-Layer Display is disabled, you can
enable — and see — one channel at a time only.

Image
If this option is enabled, the composite image is
shown in the Picture Viewer.

Alpha
This option appears only if the image has an
integrated alpha channel.

If the option is enabled, the Picture Viewer
displays the image’s alpha channel instead of the
image itself.

Components Menu

Red, Green, Blue
CINEMA 4D renders all images in the RGB color
system. Using these three options you can filter
out these separate colors. This allows you to
check the red separation of a render without
needing to launch a separate image editor.

Grayscale
If you enable this option, the image will be
displayed not in color but in grayscale. This
function is useful for checking certain aspects of
the render, perhaps to evaluate the contrast of
an image for monochrome printing.
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View Menu

Fit to Size
If Fit to Size is activated, the displayed image is
scaled automatically to the size of the Picture
Viewer window, assuming the window is smaller
than the image itself. The aspect ratio is kept
constant. Fit to Size is recommended if the
Picture Viewer is docked to other parts of the
CINEMA 4D interface.

Zoom Factors
You can display the image in different
predefined zoom factors from 12.5% to 800%.
At 100% the image is displayed actual size.

Zoom In, Zoom Out
Use these to zoom in or out of the image,
stepping through the predefined zoom factors.

Show Renderline
Use this option to switch on/off the renderline.
The renderline is a white line that appears
during rendering to indicate the progress.
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Appendices

Formulas
You can type in a formula for the Formula spline
primitive and the Formula time curve. In fact,
you can type in a formula wherever CINEMA 4D
accepts a value, e.g. in the Coordinate manager.

This appendix lists all the units, operators,
functions and constants that you may use in
your formulae.

You may enter values using any of the units
listed below (examples in brackets) - regardless
of the basic units defined in the general settings
(CINEMA 4D will convert the units for you).

km kilometres (23 km, 0.125km)
m metres (13.23 m, 1000m)
cm centimetres (11.5 cm, 328.275cm)
mm millimetres (14 mm)
um micrometres (678 um)
nm nanometres (3.867 nm)
mi miles (12.5 mi)
yd yards (17.9 yd)
ft feet (512 ft)
in inches (0.125 in)
F frame number (0 F)

Note

If you change the basic units in the General
Settings, e.g. from metres to millimetres, only
the measurement units are changed, not existing
numerical values. For example, if an object has a
width of 10 metres, but you then change the
basic units to millimetres, the object will then
have a width of 10 millimetres. If you wish to
scale the objects to reflect the change in units,

group all the objects and scale the group using
the Coordinate manager.

The function parser has the most important
arithmetic operators built in (examples in
brackets):

+ addition (144 + 14 = 158)
- subtraction (144 - 14 = 130)
* multiplication (144 * 2 = 288)
/ division (144 / 12 = 12)
MOD modulus (123 mod 4 = 3)
^ power (12 ^ 2 = 144)
( open bracket ( 3 + (4 * 2) = 11 )
) close bracket ( (3 + 4) * 2 = 14 )
ABS absolute value (abs(-123) = 123)
SIN sine (sin(30) = 0.5)
COS cosine
TAN tangent
ASIN arc sine
ACOS arc cosine
ATAN arc tangent
SINH sine hyperbola
COSH cosine hyperbola
TANH tangent hyperbola
LOG10 logarithm to base 10 (log10(100) = 2)
LOG logarithm to base e (log(e) = 1)
EXP exponential function (exp(5) = 148.413)
SQRT square root (sqrt(144) = 12)
SQR square (sqr(12) = 144)

Note

Function arguments must be bracketed. The
number of open brackets must equal the number
of close brackets. Functions may be embedded:
sin(sqr(exp(pi)))

The argument of a trigonometric function is
always interpreted in degrees. sin(2*pi) does not
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mean the computation of sin 180 degrees,
merely approx. sin 6.283 degrees.

Two of the most important constants have been
built in:

PI Pi (3.142)
E Euler’s number (2.718)

With all the above you should be able to define
even the most complex operations in a very
precise way. You can combine them freely. For
example:

2km+exp(sin(4mm*pi))/((sin(14cm))^2
+(cos(14cm))^2)

Programming Plug-ins

The C.O.F.F.E.E. Programming
Language
C.O.F.F.E.E., CINEMA 4D’s plug-in language, is
not based on macros or scripts but is a complete
and powerful programming language in its own
right. It closely resembles C++ and Java so that
if you are already familiar with these languages
you will immediately feel at home with
C.O.F.F.E.E. You simply have to learn the various
functions implemented by CINEMA 4D.

To start programming you will need to get hold
of the SDK (Source Development Kit) directly
from MAXON; this can be obtained from
MAXON Computer’s web page at
www.maxon.net.

So what is the advantage of programming in
C.O.F.F.E.E.?

Well, apart from the ease of integrating new
functionality into CINEMA 4D, as you know,
CINEMA 4D is a multi-platform program; at the

time of writing, versions of CINEMA 4D exist for
the Apple Power Macintosh (Mac OS 7 and
above), for Intel PCs (Windows) as well as for
DEC Alpha, while it is planned to produce
versions for Silicon Graphics, other UNIX
platforms and The BeOS. Writing plug-ins in
C.O.F.F.E.E. means that your new CINEMA 4D
function will work immediately on all those
platforms, with no annoying re-compilation or
reprogramming.

So that CINEMA 4D can find its C.O.F.F.E.E.
programs and load them automatically, they
must be placed in the Plugins folder which
should be in the root CINEMA 4D folder. If you
check the contents of this folder, you should
find some examples already there.

However, you can also store C.O.F.F.E.E.
programs elsewhere on your hard disk. If you
want to load such a program into CINEMA 4D
just use the File > Open menu command —
such a file cannot be automatically integrated
into CINEMA 4D’s menu structure.

So how do you create such a program?

Simply write your C.O.F.F.E.E. programs in any
editor (perhaps that supplied with your
computer) or word processor and save it as a
regular ASCII text file; CINEMA 4D will happily
process regular text, with no high-ASCII
characters.

The API
Perhaps you do not want to use C.O.F.F.E.E. as
your programming language?

As usual, CINEMA 4D allows you the flexibility
to do it the way you want to; if you like, you
can write your applications with any C/C++
compiler. Here you have access to the
functionality of CINEMA 4D through pre-
defined interfaces. These interfaces are in the
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form of an API (Application Programming
Interface) library which is part of CINEMA 4D’s
SDK.

Note, however, that if you use an external
compiler (as opposed to C.O.F.F.E.E.) this will be
platform dependent and you will need to re-
compile your program for each platform on
which you want you plug-in to work. You may
also need to do some reprogramming.

C.O.F.F.E.E. Support
Support for CINEMA 4D developers is available
exclusively on MAXON Computer’s website:

www.maxon.net

There you will find, among other things, the
SDK. This contains the C.O.F.F.E.E. compiler and
detailed descriptions of the programming
language and the interface libraries. It is, of
course, possible for commercial plug-in
manufacturers to keep their source code secret
and proprietary.

Our developer support is not static; the
interfaces to CINEMA 4D and their functionality
are constantly being extended. You should
always, therefore, pay attention to the relevant
announcements on the Internet.

File Formats
While working with CINEMA 4D there will be
occasions when a particular graphic format will
not load or a 3D file will prove difficult to
convert. There are so many formats and sub-
formats for images, animations and 3D files that
CINEMA 4D cannot even dream of coping with
all of them.

The following sections contain summaries of all
formats that CINEMA 4D supports. If you need
more detailed information, you should refer to
the relevant technical information for that
format.

Image Formats

TIFF

Bit depths

1, 4, 8, 24, 32

Compressions

Uncompressed, RLE compressed.

Notes

Only Baseline TIFF is supported. Exotic formats
such as CMYK images are not supported, nor are
files that have been LZW compressed (this is due
to licence rights). It is of course not possible to
give an exhaustive list of non-supported formats,
since such a list in a sense could never be
definitive.

With QuickTime installed LZW compressed
images and other variants are also imported.

IFF-ILBM

Bit depths

1, 4, 8, 16, 24

Compressors

Uncompressed, RLE compressed.

Notes

IFF images are read only if they conform to the
Commodore/Electronic Arts specifications.

EHB, HAM-6 and HAM-8 modes are supported.
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TARGA

Bit depths

24, 32

Compressors

Uncompressed.

Note

Only TGA-1 is supported. With QuickTime
installed other variants are also imported.

PICT

Bit depths

4, 8, 16, 24, 32

Compressors

Uncompressed, RLE compressed.

Note

With QuickTime installed all PICT variants are
imported (as long as the QuickTime compressors
are available).

BMP

Bit depths

1, 4, 8, 16, 24

Compressors

RLE-4, RLE-8.

JPEG

Bit depths

24

PSD

Bit depths

1, 8, 24, 48

Color Formats:

Indexed Color, RGB, not CMYK.

Notes

For writing, alpha channels are supported.

With QuickTime installed, all QuickTime
formats are supported i.e. PNG, SGI and
QuickTime image.

Animation Formats

AVI

Only 24-Bit formats are supported. If you have
selected AVI System and the message 'Unable to
write file' appears it is most probably caused by
a codec which does not support 24-Bit data
(such as 'Microsoft RLE').

Notes

This format can be read and written only under
Windows. Using QuickTime, AVI animations can
also be used on the Macintosh, depending on
the codec.

When using AVI animations as textures, only the
first video track is evaluated; all others (e.g.
music) are ignored.

If the first video track contains data other than
images these are also ignored.

QuickTime

All codecs that are installed in the operating
system are supported.
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Notes

When using QuickTime animations as textures,
only the first video track is evaluated; all others
(e.g. music or QuickTime VR) are ignored.

If the first video track contains data other than
images these are also ignored.

Caution

Alpha channels are integrated directly into the
animation only if the compressor supports this.
For the QuickTime format these are the
compressions Animation and None (i.e.
uncompressed).

In both cases, the number of colors must be set
to Million Colors +.

RLA/RPF

Save your multi-pass files in RLA or RPF format
if you want to post-edit in compositing
programs like After Effects and Combustion.

RPF is an extension of the older RLA format.
RPF supports all the channels listed below (RLA
supports the channels from 'Z' to 'Coverage):

Z

Information on camera <-> object distance.
Useful for depth-of-field effects.

Objects

Material IDs. Enables different materials to be
used in post-editing.

UV Coordinates

Information on UV coordinates so that new
textures can be mapped correctly during post-
editing.

Normal

Direction information regarding objects and
textures.

Non-Clamped Color

Information on object color. Can extend beyond
RGB gamut.

Coverage

Antialiasing information for object edges.

Object ID (RPF only)

Enables the clear identification of objects.

Color (RPF only)

Object color information.

Transparency (RPF only)

Object transparency information.

Subpixel Weight

Information on the color of subpixels.

Subpixel Mask

Information that links subpixels to their objects.

3D Formats

DXF

CINEMA 4D offers complete support for DFX
files written by AutoCAD (up to and including
version 12) or by the export filters of other
applications, provided they are 100%
compatible.
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LightWave

Although CINEMA 4D can convert LightWave
files and scene descriptions completely
(including PSD animations and bone structures),
it is sometimes necessary to post-edit light
source settings and texture placements.

3D Studio Import

– These files are loaded:
3DS (regular 3DS files)
PRJ (3DS project files)
MLI (3DS materials libraries)

– The object hierarchy is copied 1:1, referenced
objects are duplicated in CINEMA 4D.

– The following material channels are imported:
environment light, specular color, specular
settings (are recalculated), transparency,
luminance, color texture, specular texture,
transparency texture, environment texture,
relief (bump) texture, luminance texture.

CAUTION!

The 3DS transparency texture is the exact
opposite of the transparency mode in
CINEMA 4D. In 3DS materials are more
transparent the darker a texture pixel, whereas
in CINEMA 4D they are more transparent the
lighter the pixel.

– UV mapping is copied.

– Animation.

– Position, scaling, rotation and light sequences
are adjusted to suit CINEMA 4D.

– Textures can be renamed automatically on
loading.

– So-called target objects loaded from 3DS (from
cameras and light sources) become axes (null

objects) and are given the extension ‘t’, which
is added to their object name.

– 3DS files are binary files and are not recognised
by their extensions but by their identifier.

3D Studio Export

– All polygon objects, light sources and cameras
are exported, NURBS objects are transformed
into polygon objects.

– Material export:
color, luminance, transparency, environment,
specular, specular color, relief (bump), all with
any defined textures. The mean value of the
texture channel is exported with the shader.

Note

Regrettably, 3D Studio can cope only with
filenames consisting of eight characters plus a
three-letter extension. Therefore texture
filenames will be truncated to conform with this
restriction.

3D Studio accepts only one UV coordinate per
point. Therefore texture mapping may appear
different after exporting in this format.

QuickDraw3D Import

– Light source and camera information cannot
be read.

– The following objects are ignored:
Torus, TriMesh (new with QD3D v1.5); NURBS
can cause problems in certain cases.

– References (both internal and external) are not
read.

– UV coordinates are not read.

– Textures are not read.
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QuickDraw3D Export

– Light source and camera information cannot
be written.

– UV coordinate export is supported.

– Texture export is supported.

– ASCII 3DM files cannot be written, only binary.

Note

QuickDraw 3D accepts only one UV coordinate
per point. Therefore texture mapping may
appear different after exporting in this format.

DEM Landscape Import

– CINEMA 4D does not support the new DEM-
SDTS format.

– The VistaPro DEM format (binary) is
supported.

– Files to be imported need to have the
extension '.DEM' because the file itself
contains no information about its origin. DEM
files without this filename extension cannot be
read by CINEMA 4D.

Direct3D Export

– Typical extension *.x, ASCII Format, MESH and
FRAME format.

– Zoom factor for entire scene, automatic
indenting.

– Rename texture name to any extension.

– Texture information (UV coordinates and
texture names)

– Texture channels:
color, luminance, specular, specular color,
transparency, environment.

Note

For all scenes to display properly with a
Direct3D Viewer it is necessary for all textures to
have an edge length of a power of 2 (i.e. 2, 4, 8,
16, 32, 64, 128, 256, 512, 1024, …).

VRML V1.0c and 2.0 Import

– ASCII format.

– Creating all basic objects (cuboid, sphere, cone,
cylinder).

– Polygon objects of any size and number of
vertices (n corners are triangulated).

– Perspective cameras, light sources (direct,
point, spot).

– Material tags:
ambient color, diffuse color, specular color,
emissive color, shininess.

– WWW Links are created as a CINEMA 4D
attribute (WWW tag).

– WWW Inline Nodes are not supported.

Note

Object names in VRML files must not contain
any special characters (not even +, –, *, /). This
may be the only reason that CINEMA 4D is
refusing to load a file!

VRML 2.0 Import

– Animation import, scenes in a line (references
to scenes are automatically loaded).

VRML1.0c and 2.0 Export

– ASCII format (optionally formatted).

– Hierarchical saving of all objects: NURBS are
converted to polygon objects.

– Object names are converted, special characters
are filtered/converted.
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– Textures:
If there are any textures, the program looks for
the color texture, the luminance texture and
the environment texture (in that order). Color
textures, even inline textures, are saved as files.

– WWW links/addresses are saved: when an
object is selected in the web browser, the
program branches to that link.

VRML 2.0 Export

– Additional available animation export option.

Wavefront OBJ Import

– ASCII format.

– Polygon objects are loaded.

– Objects are given a dummy material.

– UV mapping is supported.

– No object hierarchy can be created.

– Files to be imported need to have the
extension '.OBJ' because the file itself contains
no information about its origin. OBJ files
without this file name extension cannot be
read by CINEMA 4D.

Wavefront OBJ Export

– ASCII format.

– Polygon objects; NURBS are converted to
polygon objects, UV coordinates.

Sound Formats

WAV Import

- Only uncompressed Wave files are supported.

- Markers included in the WAV files are
imported into CINEMA 4D.

Support
What can you do when you are stuck and the
manual does not appear to help? - You may
want to contact technical support.

MAXON Computer, and its distributors
worldwide, will help you with any technical
problems you encounter. So that we can help
you as efficiently as possible, please keep in
mind the following:

Please contact us (or your local distributor) in
writing if possible, preferably by email.

We have telephone lines, of course, but
problems with a package as complex as
CINEMA 4D may take time to solve — it is not
always possible to solve the problem while you
are on the phone. With email, however, our
technicians can consult with colleagues for
assistance — even the programmers if necessary
— and get back to you as soon as possible.
Email is also convenient for attaching an
example of the problem and, likewise, it may be
helpful for us to send you a scene.

Please keep support enquiries separate to other
enquiries, orders etc.

Orders are dealt with by our busy Sales staff, so
your support question is unlikely to be passed
onto a support technician.

Please allow for a reasonable response time.

We operate on a queuing system basis only. Our
customers are equally important and we will
respond to you at the earliest opportunity.

Please supply your telephone number and
times when we may contact you on that
number.

Occasionally, we may need to contact you for
further details.
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Please send an example scene to demonstrate
the problem, if applicable.

“When I click this button, I get a mess”. It is
difficult to solve problems with such limited
detail and sometimes we need to examine the
problem scene. After all, we and our hard-
working beta testers, have tested the functions
many-a-time without finding a fault.

Please keep any example scenes as small and
as relevant as possible.

For example, if only an alloy wheel is required to
demonstrate the problem, please delete the rest
of the car — it merely gets in the way. This
saves our time and in turn we can respond to
your problem sooner.

Please supply us with a complete description of
the relevant steps leading up to the problem.

Ideally, we would like a little ‘recipe’ that
generates the problem consistently. Please keep
the 'recipe' concise.

Include rendered images if relevant.

Please tell us which settings you used.

Please tell us which programs you have running
at the same time as CINEMA 4D. If you are
using Mac OS, please let us know which
system extensions are loaded.

Sometimes, another program or a system
extension (Mac OS) may cause a problem
indirectly.

Please include details of your hardware
configuration.

“I have a Macintosh/PC” is of little help on its
own. Also, please let us know which version
(e.g. 6.3) of CINEMA 4D you are using. If you
have Internet access, please use the support
form on our website (www.maxon.net). Tell us
what other programs and system extensions you
are running concurrently with CINEMA 4D.

If the program crashes, it will display an error
message. Please let us know the exact message.

If you are using Windows, you will see many
other details listed. Please ignore these extra
details — they are as enlightening as the
infamous Macintosh message 'Application
Unknown has quit unexpectedly because of
error -1'...

Please let us know CINEMA 4D’s message.

If you have Internet access, please check the
FAQs on our website before you contact
technical support.

Often, you will find the answer in the FAQs.

Our service is limited to technical support only.
We cannot undertake subcontracting.

“Can you build my spaceship model, please?”

We must concentrate our resources on helping
customers with genuine problems that are
within the bounds of technical support.

However, there are numerous web addresses
where you can find additional help. Please visit
our website (www.maxon.net) for links to these
valuable resources.

Glossary
Alpha channel, Alpha buffer

Used for fades with 2D images or movies. This
channel determines at which points and to what
extent an underlying picture will be visible.
Alpha channels are usually greyscale images; the
darker a pixel the more intensely the underlying
picture comes through.
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Ambient

This refers to the surrounding light which causes
the scene to generally appear brighter. In
CINEMA 4D this property is set in the
environment object.

Animator

This refers to the environment (with all its
functionality) in which the objects are animated.
Many programs have two distinctly separate
components, an Animator and a Modeler, which
forces the user to constantly change between
them. This is not the case in CINEMA 4D.

Antialiasing

Method for reducing the undesirable zig-zag
effect along object and colour edges. It is
achieved by generating intermediate points from
colours of adjoining pixels. Images that have
had antialiasing applied normally appear
somewhat blurred.

Backup

Security copy of data or of files.

Bevel, Beveling

Slanting or rounding of edges, to achieve
smoother transitions.

Bitmap

Two-dimensional pixel graphic.

Blob

Object (usually a sphere), with a surrounding
gravity field, which attracts objects or parts
thereof.

Boole

B. George, English. mathematician (1815–1864),
founder of logical algebra.

Boolean operation

Combining two or more elements according to
Boolean algebra. In 3D programs it is the linking
of two objects. This enables e.g. the forming of
holes by subtraction (drilling).

Browser

Application that lets you manage and view files.

B-Spline

Beta spline. Method for achieving soft, curved
spatial curves.

Bump Map

Relief texture. The surface is seemingly
indented. Usually greyscale images. The darker a
pixel, the more strongly the object is indented.
CINEMA 4D also lets you reverse this behaviour.

CAD

Computer Aided Design.

Caustics

Caustics are formed by light that is reflected or
transmitted by a number of specular surfaces
before interacting with a diffuse surface.

Constraints

In CINEMA 4D this refers to restricting the angle
of a joint. Useful particularly in connection with
Inverse Kinematics, to prevent, for example, a
rotation of the upper with the lower arm.

CPU

Central Processing Unit, the heart of the
computer. Without it, nothing works.

Drag-and-drop

This is the technique of grabbing an object on
screen with the mouse and keeping the mouse
button depressed while moving it to another
position. When the target is reached, the mouse
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button is released and the object ’dropped’. This
may trigger other actions (like launching a
program).

Extrude, Extrusion

A three-dimensional object is generated by
pulling a contour into a particular dimension,
therefore creating depth. In addition,
CINEMA 4D can create covers with and without
bevelling or rounding.

Global Illumination

A special type of illumination that is very
natural.

Gouraud Shading

This shading algorithm smooths the edges of
objects. Without it, objects usually look faceted,
i.e. the individual surfaces are visible.

Halo

Refractive and reflective effects around a light
source.

HSV

One of the colour models — Hue-Saturation-
Value.

Inverse Kinematics

Using ordinary Kinematics on a hierarchically
structured object you can for example move the
shoulder of a puppet. The upper and lower arm
and hand will automatically follow that
movement. IK will allow you to move the hand
and let the lower and upper arm go along with
the movement. Without IK the hand would
come off the model and would move
independently in space.

Keyframe

Key image within an animation. The user defines
certain key positions for objects at given points
in time. The program automatically calculates
the intermediate positions.

Label

This is usually a non-tiled texture, analogous to
the labels that you find on bottles.

Lathe, Lathing

Generating a 3D body from an envelope curve.

Lens Flares

When photographing or filming light rays may
fall into the lens, causing smaller or larger
coloured rings on the exposed material. Such
flares can be the result of air bubbles or lenses
that are not completely tight. One normally tries
to prevent this disturbing effect, however, in
photorealistic computer graphics it is sometimes
desirable to use them as a design element (this
is sometimes overused).

Local Coordinates

Every object has its own origin, which is
subordinate to the world coordinate system (or
other objects that are higher in the hierarchy).
Local coordinates are useful for determining
positions of subordinate objects.

Mapping

The way in which a texture is projected onto an
object. Also refers to the technique that is used,
such as Bump Mapping, etc.

Mesh

Synonym for wireframe.

Model

Complex 3D structure consisting of one or many
(hierarchically structured sub-) objects.
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Modeler

Refers to the environment (with its complete
functionality) in which objects are created and
modified. In many programs Modelers and
Animators are separate entities, so you have to
switch between them. Not so in CINEMA 4D.

Motion Capture

Special sensors are used to record particular
movements of humans and animals (such as
swimming, running, dancing …). This data can
then be assigned to 3D computer models.

Multi processor system

Computers working with multiple central
processors. This can be used to work on several
processes simultaneously or to have several
processors tackling one task. Applications need
to support this type of processing in order to
benefit from it.

OpenGL

The standard, developed by Silicon Graphics, for
exchanging 3D data between applications and
graphics cards.

Phong Shading

This Shading algorithm smooths the edges of an
object. Without it, objects may look faceted, i.e.
each individual surface is clearly visible.

Pixel

Picture element. The size of a pixel depends on
the resolution of the output device. Monitors
usually have 72 or 96 pixels per inch (dpi), laser
printers 600.

Plug-in

Separate add-on which is integrated into the
main application at launch and is then called
from within it. Plug-ins are not normally
autonomous, i.e. they do not work outside an
application.

Polygon

3D models consist of (control) points and
connecting lines. The area that is formed is
called a polygon.

Primitive

Basic element of a (graphics) program. In 2D
programs these are circle, line…, in 3D
programs sphere, surface… CINEMA 4D has a
large set of primitives.

Procedural textures

Mathematically generated textures (2D and 3D).
Their advantage is that they are largely
independent of the projection type.

QuickTime

Apple graphics standard. There are QuickTime
movies and images as well as the VR (virtual
reality) walkthroughs.

Radiosity

Special rendering method which takes into
account not just the light that is radiated from
light sources but also light that is reflected from
other objects. This process is very CPU-
intensive.

RAM

Random Access Memory: Data may be read and
written to this memory in a non-sequential
manner. When you switch off the computer, the
contents of this type of memory are deleted.

Raytracing

Computes the course of a light beam in space.
In non-scientific computer geometry it is not
light rays that are being traced but visual rays,
i.e. rays that emanate from the viewer’s eye
rather than from a light source).
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Rendering

Refers to the computing of images. The method
used (raytracing, scanline ...) is irrelevant. These
days, the application of filters to 2D images
(such as brightening and sharpening) is also
called rendering.

RGB

The colour model Red/Green/Blue. Mixing
varying parts of these three colours produces
the intermediate colours.

Rotation

A three-dimensional object is generated by
rotating a contour around an axis. In addition,
CINEMA 4D can automatically form covers with
or without bevelling or rounding, as long as the
rotation angle is less than 360 degrees.

Scanner

Device for reading images (from books, photos
etc.) into the computer. Useful for creating
realistic textures. With a 3D scanner it is even
possible to capture three-dimensional objects
and convert them into models.

Scene

Refers to the whole of a 3D computer model,
consisting of objects, light sources, cameras, etc.

Shadow buffer

Buffer for storing information which allows
objects to cast a shadow. These buffers are used
particularly for generating soft shadows.

Texture

Usually a two-dimensional image, which can be
used as a label, a tile, or in its full format for
defining material attributes. There are also
three-dimensional textures, which are normally
generated with the help of mathematical

algorithms. These are normally referred to as
procedural textures (see separate entry) or
shaders.

Tile textures

These are textures which can be joined
seamlessly (tiling). However, when looked at
from a distance, distinct repetitions can be
visible in the pattern, if you cover a large area
with small tiles. If you want to avoid this, use a
mathematically generated ’infinite’ texture.

User interface

Appearance of a program allowing interaction
with the user. Includes all graphical elements,
such as menus, pop-ups, buttons, etc.

Vertex

A node. Vertices are the intersections of two
lines in a wireframe model and of three edges in
a surface model. In CINEMA 4D vertices are
edited in Point mode.

Virtual Reality

Another fashionable term, just like ’multimedia’.
No accepted definition exists, but what is
generally meant is an artificial, computer-
generated three-dimensional world (which you
can produce with CINEMA 4D).

Volumetric Lighting

Special lighting technique, which calculates
shadows within visible light.

Voxel

Volume element. Originally, the expression was
used in medicine, in analogy to pixels, when
scanners were able to read in three-dimensional
objects. They were the smallest spatial unit that
a medical scanner was able to resolve.
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Wireframe

Most common way of representing objects in a
viewport. Objects are shown as wire structures.
Often, this is the only possible representation,
but CINEMA 4D also supports Gouraud
Shading, Flat Shading, Cuboid, Skeleton and
Invisible.

Z buffer

Is used for computing quick previews, that take
no account of shadows or surface detail.
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edit with object tool  301
frame (in camera)  15
frozen selections  326
IK tool  307
information  478
link view to  18
move  295
quick navigation  299
render  399
resize  296

rotate  298
save  475
search for  479
search timeline  605
select all  89
setting display of  16
shading property of  16
X-ray mode  16

Active Tool Manager  12

Adaptive interpolation  131

Add Points  353

Additive textures  550

Akima Spline  126

Align
objects centrally  384

Align Normals  371
in DXF files  78

Align to Spline  581

All Frames
in Time Line  604

Along Normals  336

Alpha Channel  511
in brick shader  521
in cloud shader  522
in cyclone shader  523
in fire shader  524
in flame shader  523
in galaxy shader  525
in picture manager  636
in RTTM display  25
in Saturnring shader  528
in sunburst shader  529
omit from render  403
render with  410
separate alpha option  411
when rendering  403

Ambient Illumination  202

Anchor Tag  471

Animated Texture  497

Animation  309
and IK  308
animation path  16
creating a track manually  566
drag-and-drop  63

field rendering  407
frame rate in the editor  604
in the browser  67
interpolation  559
number of frames  407
options  559
spline path  581
time units  46
using keyframes  564

Animation Formats  644

Animation Path  581
displaying  16
editing  16

Animation Units  46

Antialiasing  467
during rendering  412
filter  412
lines with OpenGL  50
mode of  402

API
for C.O.F.F.E.E.  642

Area Light  192

Area Shadows  194

ARNOLD rendering  416

Arrange
icon palettes. See Command

Manager
materials. See Sort Materials
objects along a path  383
objects along a spline  383
view  26
windows  32

Array  331

Array Object  174

Artefacts
radiosity  416

ASCII Cloud
load  629

Attractor
of particles  240

Auto Light  228, 430

Autokeying
in Time Line  565, 603
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AVI  644
animation format  644

Axes
normalize  389

Axes Tools  310

Axis
lock  295

B
B-Spline  127

tolerance  132

Back Light  227

Backface Culling  16, 24
disabling  17
display tag in Object Manager  463
invisible polygons  371
option for VRML 1  81
option for VRML 2  82

Background
and alpha channels  512
color  427
compositing  467
grid, in space control  601
grid, in time control  601
object  233
object, with camera mapping  545

Background Picture  17

Backup Copies
automatic  44

Bake Object
in Time Line  606

Bake Particles  236

Bank  310
axis  310
changing with the mouse  298
with IK tag in Object Manager  471

Banking
with Sweep NURBS  167

Basic Units  46
overriding  641

Batch Rendering  400

Bend Object  248

Bevel  149
option for brick shader  521

Bevel Tool  355

Bézier Curves
tolerance  132

Bézier NURBS  171
grid points option  171

Bézier Spline  127

Bias
height  137
in light shadow tab  204
radial  137
relative vs absolute  205

Biovision  77

Birth rate
of particles  237

Bit depth
of image  409

Blinn shading  520

Blur
of transparency  504
reflection  506
render settings  430
to soften a texture  496

BMP  644

Bone
and IK tag in Object Manager  471
fixing  257, 479
joint  255
length  255
reset  479
strength  256

Bone Object  249–292

Bones
with hyper NURBS  249

Boolean Object  175

Bounding Box. See also Marquee

Break Segment  346

Bridge
parts of objects  357

Brightness
of light  199

Browser  61–69
and C.O.F.F.E.E.  68
creating a catalog  62
drag-and-drop  63
importing into  64
information window  68
introduction  11
movies  67
new catalog  64
open catalog  64
opening from the Window Menu

448
preferences  67
relative catalog paths  65
render all pictures  68
saving from  65
scenes  68
search  69
select all images  67
settings  30
sorting  69
use of catalog example  66

Bubble help  54

Buffer
object  468

Bulge Object  257

Bump Map. See also Relief Map
for materials  509

Bump Texture  510

C
C++

and C.O.F.F.E.E.  642

C.O.F.F.E.E.
and plugins  395
and the Console Window  449
API  642
error tag  473
expressions  90, 474
in the Browser  68
programming  642
SDK  642
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Source Development Kit (SDK)
395

support  643

C.O.F.F.E.E. Expression  475

Camera  181–292
and objects  466
depth of field  183
edit  300
editor  18, 185
focal length  182
focus  183
frame scene with  15
frame scene without  15
framing  15
interactive control  184
lens effects  218
mapping  544
motion blur  427
move  300
move hotkey  7
rotate  301
rotate hotkey  7
scale  301
scale hotkey  7
scene  185
target  185
target animation  583
tool  300
undo/redo view  86

Camera Mapping  544

Camera Tool  300

Cameras
in View menu  18

Cancel
button  53
render  400

Caps
cone  99
cylinder  103
materials  173, 553
with Extrude NURBS  161
with Lathe NURBS  162
with Loft NURBS  166
with Sweep NURBS  170

Capsule Object  110

Cartoon Render  425

Catalog
delete pictures  67
example of use in Browser  66
making paths relative in Browser

65
new in Browser  64
open in Browser  64
save in Browser  65

Caustics  209
and materials  519
generate  519
photons  210, 211
prerequisites  422
receive  519
render settings  420
surface  209
surface vs volume  422
volume  211

Center
objects  384

Chamfer  347

Channel Shader  521

Channels
in picture manager  637

Checkerboard  522

Chromatic  47

CINEMA 4D
starting up  73

CINEMA 4D NET  236

Circle
interpolation  494

Circle Object  136

Cissoid  147

Clip Mapping  511

Clipboard  88

Clipping
of light  188, 201

Clone  333
when duplicating using array  332

Close
all  74

file  74
on the Pin menu  42
spline  129
the Browser  67
the document  74
the Material Manager  489
the Object Manager  475
the Structure Manager  630
the Time Line  597

Close All  74

Close Spline  129

Clouds  522

Co-planar
optimization when reducing polys

270

Cog Wheel  149

Color
background  427
material  493
of interface element  54
of lighting  187
used in viewport  52

Color Depth
information  68
of texture  493

Color System  46

Comic Render
settings  425

Command
changing sequence in a palette  35
number of rows/columns  36
text or icon  36
text position  36

Command groups
unfolding  38

Command Manager  30, 39, 449

Command Palettes  35
introduction  10
new  35

Commands
grouping  37

Compositing Background  467

Cone
caps  99
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light  190
shadow  208

Cone Object  98

Configuration
managers  30
of interface  53
of textures  52

Configure
menus  54

Connect
an object group  385
parts of objects with bridge  357
select polygons/splines  322
use with Add Points  354

Connect Function  385

Console Window  449

Construction Plane  180
grid spacing  180

Context Menus
introduction  11

Contrast
of light  199

Convert to polygons  353

Coordinate
reset system  389

Coordinate Manager  457
relative/absolute values  457

Coordinate system
polygons  316
world  310
world/object  295

Coordinates
generate UVW  481

Coordinates Manager
introduction  12

Copy  41
active object  88, 476
cells in Structure Manager  630
image in picture manager  636
keys/sequences  598
material  489
object shape  385
object with duplicate  386
tag to children  481

to Clipboard  88
with drag-and-drop on Time Line

568

Create
new polygons  359
outline  348
spline curve  125

Credits
opening and final  49

Crumple  335

Cube Object  101

Cubic Mapping  541

Cubic Spline  126

Current state to object  385
in poly reduction  272

Cursor Keys  299
in the Structure Manager  627

Cut  41
active object  88, 476
cells in Structure Manager  630
keys/sequences  598
material  489
spline with knife  364
to Clipboard  88

Cycloid  150

Cylinder  80
caps  103

Cylinder Object  102

Cylindrical Mapping  540

D
DDS microphone  290

Decal Mapping  545–552

Default
settings  70

Deflector
of particles  241

Deformations  90

Deformers  90, 247–292
and level of detail  463
and point level animation  601
and restriction tag  465
and the Drawing Pipeline  92

and UVW coordinates  481
and UVW mapping  247
bend  248
bone  249
bulge  257
explosion  263
explosionfx  259
FFD  265
formula  266
melt  267
polygon reduction  268
set vertex weight  325
shatter  276
shear  277
taper  278
twist  280
wind  281
with magnet  366
wrap  283

Delete  41
active object  476
all markers in Time Line  598
animation elements  598
cells in Structure Manager  630
material  490
object  88
palette command  38
points  302
render settings  402
tag from children  481
Time Line marker  563
unused points  373

DEM  77

Depth
of undo  85

Depth Channel. See Alpha Channel

Depth of Field
for cameras  183
option in Render Menu  424

Deselect
frozen points  327
frozen polygons  327
hide elements deselected  324

Deselect All
active objects  89
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cells in Structure Manager  631
elements in Time Line  598
points/polygons  322
preview pictures  67

Destructor
of particles  244

Detail
level of  56

Diffusion
material  500

Direct light  417

Direct3D Format  76, 77, 647

DirectX Format  76, 77

Disc Object  105

Disconnect
surfaces  337

Displacement
material  517

Display
and the Drawing Pipeline  91
background picture  17
of lights in editor  186
of objects, control of  477
of particles  238
tag in Object Manager  463

Display Mode
for active object  16
for inactive objects  17
introduction  22
options  22–25

Display Tags Option  475

Display Units  43

Distant Light  190

Dither
when rendering  411

Dock
windows  10, 33

Dolby  290

DPI  410
in Picture manager  636

Drag-and-Drop
in the Object Manager  461

Drag-and-drop
in the Browser  63
on Time Line  568

Drawing pipeline  89

DTS microphone  290

Duplicate
materials, remove  491
object  386
surfaces/points with array  331
surfaces/points with clone  333

Dust
in visible light  215

DXF  76, 78, 645
circle option  78

E
Edges

filter  425

Edit
2D shader  497
animation path  16, 309
camera  300
glows  221
in View menu  15
lens effects  223
magnet  366
markers in Time Line  563
material  491, 492
menu in Browser  67
menu in Material Manager  489
menu in Object Manager  476
menu in Structure Manager  630
menu in Time Line  597
model  304
object  301, 478
object axis  303
object tag  481
palette  30, 38, 445
parametric object  316
points  302
polygons  303
primitive objects  353
splines  343
streak  222
surfaces  331

text  142
texture  306
texture axis  306

Edit Material. See Material Editor

Edit Spline  343

Editing
materials  500–520

Editor
camera  18, 185

Effects
caustics  209

Ellipse  136

Emitter  237
of particles  239

Empty Spline  123

Environment
color  232
fog  232
material  507

Environment Object  232

Epicycloid  150

Errors
undoing  85

Evaluation
of expressions  90

Even/Odd fields  408

Examples
of particles  245

Execute last plug-in  395

Expand Object Group  478

Explosion Object  263
grid points option  265

Explosions  259

Export
scene  75

Expressions
and C.O.F.F.E.E.  90
fixing  474
IK  308
in the Object Manager  473
new  473
sun  229
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Extending CINEMA 4D  395

External Compiler
for C.O.F.F.E.E.  643

Extrude
matrix extrude  338
surfaces  361
with smooth shift  370

Extrude Inner  362

Extrude NURBS Object  160

F
Factory settings  54

Falloff
diffuse  520
of light  200

FFD Object  265

Field rendering  407

File
applying a sound file  589
close  74
close all  74
export  75
import  74
import ASCII into Structure

Manager  629
import into Browser  64
initialization  70
layout  446
logfile example  430
menu in Browser  64
menu in Material Manager  488
menu in Object Manager  463
menu in Structure Manager  629
menu in Time Line  579
new  73
open  73
paths for WAV files  596
quit  7
recent files  45, 82
revert to saved  74
save  74
save all  75
save as  75
save project  75

Fill Light  226

Film Formats
for render  406
list of  441

Filter
antialiasing  412
edges when rendering  425
in picture manager  637

Fire  524

Fixing
bones  257, 479
expression  474

Flame  523

Flip Normals  161, 162, 166, 170

Floor
and reflections  404

Floor object  228, 230

Flower Object  156

Focal Length
of camera  182
when scaling  301
with QTVR  440

Focus
of camera  183

Fog  533
environment  232
material  508
shader  535
visible light  195

Folding
commands  37

Fonts
with the text object  142

Foreground
object  233

Format
in Picture manager  635

Formula Object  154, 266

Formula Spline
types of formula  641

Fractal
landscapes  119
turbulence  530

Frame
view in Time Line  600

Frame Rate
for playing animation in the editor

604
for project  56
setting for movie material  497

Frames
number to render  407
show safe  17

Free Form Deformations. See FFD

Freehand Selection  319

Freehand Spline  131

Freeze Selection. See Set Selection

Fresnel  503

Friction
of particles  242

Frontal Mapping  541

Frozen Layers
DXF option  78

Functions
mathematical  641

Functions Menu  383

G
General Settings  29, 43–55, 92

Generate Backup Copies  44

Generate UVW coordinates  481

Generators  90
stopping effect  473

Genlock. See also Alpha Channel
in Material Manager  511

GI
accuracy  467
objects generating  467

Glass
rendering  403

Global Illumination. See also GI
and materials  518

Glow  219
editor  221
material  516
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Gouraud Shading  22
in preferences  68

Graphics Tablet  43

Gravity
affecting particles  240
in explosions  261

Grid
background, in time control  601
quantize points to  341
snap to  380
using spline as  378
when slicing an object  99
with quantize  341
world  379
world, cf construction plane  180

Grid Lines
for textures  306

Grid Points
construction plane  378
for Bézier NURBS  171
with explosion deformer  265

Grid Spacing
construction plane  180
for world grid  379

Group
commands to palette  37
expand objects  478
objects  95, 478
tabs  34

Groups
preserve when beveling  356
preserve when disconnecting  337
when extruding  362

Grow Selection  323

GUI  8. See User Interface

H
Hard Interpolation  343

Hard Shadows  193

Heading  310
axis  310
changing with the mouse  298
with IK tag in Object Manager  471

Height Bias  137

Helix  137

Help  453

Help text
configuring  54

Hermite. See Bézier

Hexahedron  108, 116

Hide
deselected points/polygons  324
object with backface culling  17
objects in Object Manager  477
other than frozen selection  327
points/polygons  324
selected points/polygons  324

Highlight. See Specular

Hole Splines  160

Holes
in a spline  124

Hotkeys  7

HPB System  310
example  298, 310
option  43

HSV Model  48

Hull
of metaball  178

Hyper NURBS  158
and bones  249

Hypocycloid  150

I
Icon

lock  38
size of  36

Icon Editing. See Command Manager

Icon Palette
new  42, 445

IFF  643

IK. See Inverse Kinematics

IK Expression  474

IK Tag  471

Illumination
model  520

Illustrator  79
load object  475

Image
dpi  410
formats  643
to splines  144

Image Formats  643

Import
ASCII cloud  629
file  74

Import/Export
settings  30, 76

Improvements
in Release 7  5

Inactive Object
displaying  17

Indirect light  417

Information
about current scene  479
about MAXON  453
about selected object in Object

Manager  478
about selection  448
about sound file  589
about structure  448
in Browser  68
on CINEMA 4D  453
on selected object  448

Initialisation files
New.c4d  70
Template.c4d  7
Template.cat  70
Template.l4d  70

Input Fields
introduction  11

Insert Points. See Add Points

Instance Object  176

Interactive
rotation  300

Interactive Control
of camera  184
of NURBS  158
of objects  97
of splines  131
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Interface
color  54
configuration  53
language  53
scheme  53

Interlace  407

Interpolation
adaptive  131, 134
circle  494
for animation  559
hard  343
linear  165
natural  130, 133
spline  129, 133
uniform  130, 134

Inverse Kinematics
anchor tag  471
and animation  308
example  308
expression  308
figure  117
IK tag  471
track in Time Line  582
with a null object  95

Inverse Kinematics Tool  307

Invert Selection  322

Isoparms  23

J
Join

with mirror and weld  179

Join Segment
of a spline  345

Joint
inverse kinematic  307, 471
of bone  255

JPEG  644

K
Key

new, in Time Line  594

Key Light  226

Keyboard Shortcuts  39
adding your own  39

Keyframes
and PLA  601
autokeying  603
automatic  565
hierarchy  602
keyframes to spline  606
parameter keys  602
position, scale, rotation keys  601
recording  603

Keyframing  564

Keys
and Bake Object  606
autokeying in Time Line  603
creating in Time Line  564
editing animation  309
for quick navigation  299
hierarchy in Time Line  602
hotkeys  7
parameter keys in Time Line  602
recording in Time Line  601
using cursor keys  299

Knife  364

L
Landscape Object  118

Language
of interface  53

Lathe NURBS  161

Latitude
and wrap object  284
in the Sun Light object  229

Launching  7
CINRMA 4D  73

Layer
and the texture tag  468
DXF option  79
in the Time Line  560

Layers
frozen, DXF option  78
texture  549
when rendering  433

Layout
load  60, 445
reset  60

save  45
save as  61, 446
save default  445

Layouts
working with  60

Lemniscate  147

Length
bone  255

Lens Effects  218–292
edit  223
option when rendering  425

Level of Detail
view  22
when rendering  432

Level of detail  56

Lifetime
of particles  237

Light
bias of shadow  204
direct and indirect  417
glow  219
lens effects  218
settings  187

Light maps  226

Lighting  186
ambient light  202
area  192
auto  228
brightness  199
caustics  209
clipping  201
color  187
contrast  199
distant  190
dust in visible light  215
falloff  200
key light  226
memory needed  188
noise  188, 196, 217
omni  189
outline shadow  208
parallel  191
radiation option  188
render time needed  189
shadow map  193
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shadow types  204
shadows  187
show clipping range  188
show illumination range  188
show visible light  188
soft shadow  206
spot  190
sun light  228
target light  228
texture mapping  226
visible  195, 212
volumetric  195, 214

Lights
displaying in editor  186

LightWave  79, 646

Line Height
of text  143

Line up
points  350

Linear
interpolation  165

Linear Spline  126

Lines
antialiased by OpenGL  50

Live Selection  321
smart  51

Load
catalog  64
layout  60, 445
manager settings  44
material  73
materials  488
object  475
point cloud  629
scene  73

Lock
axis  295
icon  38
layers in Time Line  560

Loft NURBS  163

Log File  430

Longitude
and wrap object  284

Luminance
apply diffusion map  500
material  501

M
Macintosh

configuration tab  55
settings  55
simulating right mouse button  7

Magnet  366–367
options  366

Magnify  300

Make Editable  316, 353

Make Tab  42

Manager Settings
loading  44

Managers
command  30
docking/undocking  42
introduction  9
menu  30
pin icon  42

Manual
online  453

Mapping
camera  544
clip  511
decal  545–552
different on same object  551
frontal  541
MIP  495
MIP/SAT, tips for  498
of textures  537
restrict to selection  551
RTTM  24
SAT  495
shrink wrapping  544
spherical  540
texture, disable  17
types  539–552
UVW  542

Mapping Types  539–552

Marble  526

Marker
in Time Line  562
new, in Time Line  595

Marquee
selection  318

Material
blur reflection  506
blur transparency  504
bump map  509
caustics  519
color  493
copy  489
cut  489
cylindrical mapping  540
delete  490
diffuse falloff  520
diffusion  500
displacement map  517
edit  491, 492
environment  507
fog  508
fresnel  503
global illumination  518
glow  516
illumination model  520
load  73
luminance  501
mixing  496
morphing  590
movie, setting frame rate  497
natural-looking  502
new  488
paste  490
perspective correction of previews

52
radiosity  518
redraw preview  490
reflection  505
relief map  509
remove duplicate  491
remove unused  491
rename  491
render  490
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save  489
search  538
specular  514
texture  493
using movies  497

Material Editor  492–499, 500

Material Manager  446, 487
introduction  11
redo  489

Materials
cubic mapping  541
load  488
sort  491
transparency  502

Melt Object  267

Memory
needed by lighting  188

Menu Manager  30, 40, 450
revert to original  41

Menus
configuring  54
editing  40
introduction  10

Metaball Object  177

Metaballs
and particles  246
hull  177
tag  468

Metal
specular on material  514

Metal Shader  534

Microphone
DDS  290
DTS  290
mono  287
SDDS  291
stereo  289

Microphone object  287, 289

MIP Mapping  495
tips  498

MIP Maps Option  50

Mirror  368

Missing solution file  399

Missing Textures  399, 493

Mix
material attributes  496
with other textures  549

Mixed Textures  551

Model
edit  304
scale hotkey  7

Model Tool  304

Modeling
quadrangles vs triangles  317
with grids  379

Modeling Objects  174–292

Mono microphone  287

Morph
between materials  590
example  584

Motion Blur
object  429
object tag  473
scene  427

Motion capture  77

Motion Sequencing  571
example  574

Mouse  7
restricting movement  380
right mouse button, Macintosh  7
use when moving objects  295
use when rotating objects  298
use when scaling objects  297
wheel  7

Move
active object  295
along normals  365
and duplicate  386
camera  300
cells in Structure Manager  627
grid  380
hotkeys  7
in Time Line with Powerslider  561
points  302

quick navigation  299
with drag-and-drop on Time Line

568

Movie. See also AVI; QuickTime
as a material  497
creating (rendering)  408
displaying in Browser  67
formats  441
QTVR  438
render as  408
render formats  408
sequence option in Material

Manager  497
using in a material  497

Multi target kinematics  307

Multi-Pass
in Picture manager  637
render settings  433

Multiple undo  85

N
n-Side Object  139

Natural
making material look  502

Navigation services
under Mac OS 9  55

Network rendering  6

New
3D shader  488
camera  181
catalog  64
command palette  35
expression  473
icon palette  42, 445
key in Time Line  594
line in Structure Manager  629
marker, in Time Line  595
material  488
points  353
polygon  359
render settings  401
scene/document  73
sequence in Time Line  594
spline curve  125
spline point  125
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spline segment  125
submenu  41
tag in Object Manager  463
texture tag  468
things in Release 7  5
track in Time Line  579
view panel  446

New.c4d  70, 73

Noise
in lighting  188, 196, 217

Normalize Axes  389

Normals  24
align  78, 371
and decal mapping  545
displaying  16
flip  161, 162, 166, 170
general information  371
move points along  336
move surfaces along  365
reverse  372
rotate polygons around  366
scale polygons along  365

Null Object  95
and particles  96

Numerical
object manipulation  457

NURBS
bézier  171
extrude  160
hyper  158
lathe  161
loft  163
sweep  166

NURBS Objects  157–292

O
Object

array  174
background  233
bend  248
bone  249
boolean  175
bridge  357
bulge  257
capsule  110

chain of ik target objects  307
circle  136
cone  98
coordinate system  295
copy shape  385
cube  101
cylinder  102
delete  88
disc  105
duplicate  386
edit  301, 478
editing  316
empty polygon  96
environment  232
exploding  259
extrude NURBS  160
FFD  265
figure  117
fixing  474
floor  228, 230
flower  156
foreground  233
formula  154, 266
freezing selections  326
generators  90
group  95
instance  176
landscape  118
load  475
loudspeaker  285
manipulating numerically  457
melt  267
metaball  177
microphone  287, 289
motion blur  429
mouse controls  295, 297, 298
move  295
move  hotkey  7
moving with the mouse  295
n-side  139
null  95
oil tank  112
parametric  96
paste  476
plane  106
polygon  107

polygon reduction  268
primitive  96
pyramid  115
quadrangle  106
rectangle  140
relief  121
reset coordinate system  389
rotate hotkey  7
rotating with the mouse  298
rotation  298
scale  296
scale hotkey  7
scaling with the mouse  297
selection  317
shatter  276
shear  277
simple explosion  263
sky  231
sound  285
sphere  108
spline  123
star  141
stop tag  473
Sun Light  228
symmetry  179
taper  278
torus  109
transfer  391
tube  113
twist  280
use shading property  24
visibility  477
wind  281
wrap  283

Object Axis  303
editing  303

Object buffer  468

Object Group
connect  385

Object Hierarchy  462

Object Manager  461
drag-and-drop  461
introduction  11
redo  476
texture menu  481
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Object Tag
edit  481

Object tool  297

Objects
arrange along a path  383
casting shadows  466
center  384
controling display  477
expand group  478
group  478
seen by camera  466
seen by GI  467
select all  89

Octahedron  116

Odd/Even fields  408

Oil Tank Object  112

OK
button  53

Omni Light  189

Online manual  453

Open
catalog  64
file  73
in Picture manager  635
scene/file  73

OpenGL  50, 51
antialiasing lines  50

Operators (mathematical)  641

Optimize
structure  372
when using poly reduction  270

Options
in Time Line  559

Oren-Nayar shading  520

Organize
the Time Line  562

P
Palette. See also Command Palettes

edit  30, 445
grouping  37

Palette Command
delete  38

Palettes
edit  38

Parallel Light  191

Parallelogram  146

Parametric objects  96

Particle System  235–292
and metaballs  246
attractor  240
bake particles  236
birth rate  237
deflector  241
destructor  244
display  238
emitter  237
emitter type  239
examples  245
friction  242
gravity  240
lifetime  237
rotation  238, 243
seeding  238
speed  237
turbulence  243
visibility  237
wind  244

Particles
and the null object  96
save  44

Paste  41, 88
cells in Structure Manager  630
from Clipboard  88
into Time Line  598
material  490
object  476

Path
align to in Time Lime  581
arrange objects along  383
curves in Time Curve  601
for WAV file  595
of animation, editing  309
texture, option  55
to textures  493

Paths
catalog  65

Perfect Sphere  108

Perspective
correction of material previews

previews  52

Perspective View  18

Phong shading  520

Photons
in surface caustics  210
in volume caustics  211

PICT  644

Picture Manager  635
alpha channel  636
channels  637
dpi  636
filter RGB  637
fit image to size  638
format image  635
multi-pass manager  637
open image  635
zoom  638

Picture Sequence
render  409

Picture Viewer  447. See Picture
manager

render to  400

Pin icon  34

Pin Menu  42

Pipeline
drawing  89

Pitch  310
axis  310
changing with the mouse  298
with IK tag in Object Manager  471

Pixel Ratio  45
in render settings  406

Plane Object  106

Plastic
specular on material  514

Platonic Objects  116

Plug-ins  395
organizing  395

Plugins
programming  642
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Point
cloud  629
delete  302
duplication  331, 333
reorder first  346
visibility  324

Points
add  353
align  350
aligning  341
chamfer  347
creating polygons from  359
deselect all  322
edit  302
line up  350
mirror  368
move along normals  336
reverse sequence  346
select from polygons  324
selecting  317
weld  343

Polygon  315
coordinate system  316
create  359
select from points  324
selecting  317
selection  320
visibility  324

Polygon Object  107
empty  96

Polygon reduction  268–275
for quality  272
for speed  273

Polygons
creating from triangles  107
deselect all  322
editing  303
exploding  259
invisible with backface culling  371
select connected  322

Position Track  579
to spline  606

Powerslider  561

Preferences
Browser  67

general  29, 43
project  29, 56
saving  73
snap  375

Preserve Groups
when beveling  356
when disconnecting  337
when extruding  362

Preview
redraw material  490

Previews
deselect all in Browser  67

Primitive objects  96

Primitives
editing  316
spline  133

Priority
assigned to CINEMA 4D  43

Profile  156

Programming
in C.O.F.F.E.E.  642

Programming Interface. See API

Project
save  75
splines  351

Project Settings  29, 56, 92

Projection
changing type  17
modes  18–21

Property
smoothing  97

Pyramid Object  115

Q
Quadrangles

and polygons  315
and regular subdivision  173
keep when creating polygon  360
vs triangles  317

Quality
of object mesh  269
when reducing polys  272

Quantize  341
points  341

Quick Navigation  299

Quick Shading  22

QuickDraw 3D  80

QuickDraw3D  646

QuickTime  44, 644
QTVR  438

Quit  7

R
Radial Bias  137

Radiosity  414
accuracy  467
and stochastic samples  419
for a material  518
generate  518
receive  518

Radius
bone  255

Rail Splines
with sweep NURBS  167

Random
object placement  388

Randomize Function  388

Ray Depth
in render settings  431

Rays
seeing objects  466

Raytracing
range for 2D sound rendering  596
range for 3D sound  597
samples in metal shader  533

Real Time Texture Mapping  24
save  44

Realtime preview
how it works  89

Recent File List  45

Recent Files  82

Recording
autokeying in Time Line  603
keyframes automatically  565
using keyframes  564
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Recover
last saved file  74

Rectangle
selection in Time Line  599

Rectangle Object  140

Rectangle Selection  318

Rectangles
and triangles  374

Redo  86
in Material Manager  489
in Object Manager  476
in Structure Manager  630
in Time Line  597
view  15

Redraw
material preview  490

Redraw Limit  45

Reduction
of polygons  268

Reflection  404
apply diffusion map  501
as a lens effect  218
blur  506
material property  505
when rendering  404

Reflection Depth
when rendering  431

Refraction
when rendering  403

Refractive Index  505

Region
render  400

Registration  453

Regular Subdivision  173

Relative
values in Coordinate manager  457

Release 7
improvements  5

Relief Map  121
for materials  509

Relief Object  121

Remove
unused materials  491

Rename
material  491

Render
a region  400
active object  399
alpha channel  410
antialiasing  412
as movie  408
batch  400
cancel  400
current view  399
dither  411
edges filter  425
film format  406
layers  433
lens effects  425
picture sequence  409
QTVR movie  438
separate alpha  411
settings  29
sound  285
stop  636
straight alpha  411
tag  466
time needed by lighting  189
to Picture Viewer  400
with refraction  403

Render Active Object  399

Render Menu
depth of field option  424

Render Safe
show in view  49

Render Settings  401–402
and caustics  420
antialiasing  402, 412
blur  430
comic render  425
delete  402
lens effects  425
level of detail  432
multi-pass  433
name of  402
new  401
number of frames  407
pixel ratio  406

radiosity  414
ray depth  431
reflection  404
reflection depth  431
resolution  406
save formats  408
shadow  405
shadow depth  432
threshold  432
transparency  403

Rendering
with CINEMA 4D NET  6

Reorder First Point  346

Reset
bones  479
layout  60
object coordinate system  389
settings  54

Resize
window  31

Resolution
when rendering  406

Restore
object coordinate system  389

Restriction tag  465

Reverse Normals  372

Reverse Sequence  346

Revert to Original Menus  41

Revert to Saved  41, 74

RGB Model  47

Right Mouse Button
on a Macintosh  7

Rotate
active object  298
hotkeys  7
polygons around normals  366

Rotation
in explosions  262
interactive  300
of particles  238, 243
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Rotation Grid. See Quantize

Rotation Track  580

Round Spline  350

Rounding
a spline  139
for NURBS  171
when filleting  99

RTTM. See Real Time Texture
Mapping

Ruler
in Time Line  562

S
Safe Frames

activating  17

SAT Mapping  495
tips  498

Save
active object  475
all files  75
default layout  61, 445
file  74
layout as  61, 446
layout at program end  45
material  489
particles option  44
preferences  73
project  75
RTTM textures  44
scene  74
settings, general  29
when rendering  408

Save as  75

Scale
active object  296
hotkeys  7
polygons along normals  365

Scale Axes
option in general settings  50

Scale Track  580

Scene
camera  185
load  73

Scene Motion Blur  427

Scene Objects  181–292

Scheme
choosing for interface  53

SDDS microphone  291

SDK  642

Seamless tiles  549

Search
active object  479
active object in Time Line  605
for material  538
in Browser  69
paths  55, 399, 592

Seeding
of particles  238

Segments
break spline  346
of a spline  124

Select
adjacent polygons  324
hide  324
in Time Line  568
invert  322
points from polygons  324
polygons  303
polygons from points  324

Select All
catalog images in Browser  67
objects  89
points/polygons  322

Select Connected  322

Selection
freehand  319
freeze. See Set Selection
grow  323
information  448
live  321
polygon  320
rectangular, in Time Line  599
rectangular marquee  318
restrict material over  551
set  325
shrink  323
smart  51

split  342
tolerant  318, 319, 320
within the Structure manager  627

Selection Menu  315, 317

Selections
freezing  326

Selective UVW Mapping  544

Separate Alpha  411

Sequence
move down  346
move up  347
new, in Time Line  594

Serial number  453
final  453
initial  453

Set
selection  325

Set Selection  325. See also Freeze
Selection

Setting
ray depth  431
render resolution  406

Settings
Browser  30
default  70
for Macintosh  55
general  92
import/export  30, 76
light  187
project  92
render  29
reset  54
save  29
snap  30, 375, 449
viewport  29

Shader - 2D
checkerboard  522, 526
cloud  522, 531
cyclone  531
fire  524
flame  523
galaxy  525
gradient  523, 525
neptune  526
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noise  527
saturn  527
saturnring  528
stars  529
sunburst  529
turbulence  530
uranus  530
water  531

Shader - 3D
earth  532
fog  533, 535
metal  534
terrain  534, 535
venus  536
wood  534, 536

Shaders  520

Shading  16
model  520
objects, property of  24

Shading mode  29

Shadow Bias  204

Shadow Depth
and materials  506
when rendering  432

Shadows  187
and objects  466
area  194
color  204
density  204
hard  193
outline  208
soft  193, 206, 405
transparency  205
when rendering  405

Shatter Object  276

Shear Object  277

Shortcuts  60
keyboard  39

Show
background picture  17
normals  16

Shrink Selection  323

Shrink Wrap Mapping  544

Simplify
with polygon reduction  268

Size
in Picture manager  638
of icon  36

Skeleton Display  23

Skin
and loft NURBS  163
and metaballs  177

Sky
and reflections  404

Sky Object  231

Slice
regular grid option  99

Smart selection  51

Smells Like Almonds  5

Smooth shift  370

Smoothing  97, 463
and surface normals  372
how it works  464
tag in Object Manager  463

Snap
settings  30
to spline  380

Snap Grid  380

Snap Settings  375, 449
introduction  12

Snapping
using quantize  341

Soft Shadows  193, 405

Solution file missing  399

Sort Materials  491

Sorting
in Browser  69

Sound
applying a sound file  589
waveforms in browser  68

Sound objects  285

Sound rendering  285

Source Development Kit. See SDK

Specular
apply diffusion map  501
metal  514
plastic  514

Speed
of particles  237
when reducing polys  273

Sphere Object  108

Spherical Mapping  540

Spline
empty  123

Spline Curves
creating  125
creating predefined  131

Spline Grid  380

Spline Object  123
morphing  584

Spline Primitives  133–292

Spline Segments
creating  125
information window  448

Splines
adding points  354
adding points to  125
Akima  126
align to... animation track  581
animation from position track  606
arrange objects along  383
as a snap grid  380
B-spline  127
bézier  127
break segment  346
chamfer  347
close  129
convert image to  144
convert to position track  606
create outline  348
cubic  126
disconnect  337
edit  343
editing primitives  353
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editing with the magnet  366
explode segments  338
freehand  131
hole  160
holes  124
information window  448
intermediate points  129
interpolation  129
join segments  345
knife  364
magnet  366
mirroring  368
move down sequence  346
move up sequence  347
optimize  372
point level animation  586
polyline  76
projecting onto other objects  351
reorder first point  346
reverse points  134
reverse sequence  346
round  350
rounding  350
segments  124
select connected  322
set value  341
snapping  376
snapping to  380
tangents  127
text  124
using formulas  641
weld  343

Split
surfaces  342

Split Object. See Disconnect

Spot Light  190

Square  140
interpolation  495
spot light  190

Stage Object  232

Star Object  141

Starting  7
CINEMA 4D  73

Stereo microphone  289

Stochastic samples
and radiosity  419

Straight Alpha  411

Streak
editor  222

Strength
bone  256

Strophoid  147

Structure
information  448
optimize  372

Structure Manager  447, 627, 629
delete cells  630
moving cells  627
new line  629
pasting  630
redo  630

Subdivide  373

Subdivision  373
and hyper NURBS  158
for NURBS  173
of polygon  107
of spline  129

Sun Expression  229, 475

Sun Light Object
latitude  229

Support
for C.O.F.F.E.E.  643

Surface
duplication  331, 333
editing  331
extrude  361
extrusion with smooth shift  370
split  342

Surface caustics  209, 422

Surface Normals  24. See Normals

Surfaces
disconnect  337
mirror  368

Sweep NURBS  166
and banking  167
and rail splines  166

Symmetry Object  179

T
Tabs  34

converting to windows  34
create  42
grouping  34
introduction  10

Tag
anchor  471
display  463
IK  471
metaball  468
motion blur  473
new  463
render  466
restriction  465
smoothing  463
stop  473
texture  468
url  473

Tangents
of a spline  127

Taper Object  278

TARGA  644

Target Camera  185

Target Expression  475

Target Light  228

Technical Support  648

Template.c4d  7, 70, 73

Tetrahedron  116

Text
as a spline  124
line height  143
position for command  36

Text Object
fonts  142

Texture
animated  497
applying to one side only  545
color depth  493
configuration  52
editing  306
error  430
grid lines  306
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layers  549
menu in Object Manager  481
of material  493
paths  493
soften with blur  496
stretching  544
tag  468
tag, new  468
tiling  548

Texture Axis
adapt to object axis  483
adapt to view  484
adapt to world axes  483
edit  306
mirror  484

Texture Error  430

Texture Geometry Dialog  537

Texture Mapping  537
light maps  226

Texture Paths  55

Texture Tool  306

Textures
camera mapping  542, 544
disabling display  17
displaying  24
missing  399
mixing  551
show  52
view all  25

Thread priority  43

Threshold  467
when rendering  432

Thumbnails
in Browser  62, 67

TIFF  643

Tiled Textures  548

Tiles
seamless  549

Time Line  446
all frames option  604
autokeying  565
creating a track manually  566
delete marker  563
deselect all elements  598

edit markers  563
framing the view  600
inverse kinematics track  582
layers  560
markers  562
new key  594
new marker  595
new sequence  594
new track  579
options  559
pasting  598
powerslider  561
redo  597
ruler  562
search for active object  605
selecting elements  568
selection of elements  599

Time Manager  558

Tips
for MIP/SAT mapping  498

Title safe
show in view  49

Tolerance
in spline curves  132

Tolerant Selection  318, 319, 320

Tools
axes  310
camera  300
Inverse Kinematics  307
Multi target kinematics  307

Torus Object  109

Track
inverse kinematics  582
new, in Time Line  579
position  579
rotation  580
scale  580

Transfer  391

Transparency
blur  504
for materials  502
option in lighting  205
when rendering  403

Transparent Axes  50

Trapezium  146

Triangle
create polygons from  107

Triangles
and polygons  315
vs quadrangles  317

Triangulate  374

Tube Object  113

Turbulence
of particles  243
shader  530

Twist Object  280

U
Undo  86

buffer  85
depth of  45
in Material Manager  489
in Object Manager  476
in Structure Manager  630
in Time Line  597
multiple  85
view  15

Undo depth  85

Undock
manager  42

Unfolding
command groups  38

Unhide  324

Units
for display  43

Unlock
layers in Time Line  560

Untriangulate  374

URL
tag  473

Use Textures  52

User Interface  31

UVW coordinates
generate  481

UVW Mapping  542
and deformers  247
selective  544
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V
Vectorizer  144

Vertex
maps  321
weights  321

Vertex painting  321

View
all textures  25
arrangement  26
cameras  18
configure  16
framing the Time Line  600
level of detail  22
refresh active  49
render  399
show action safe  49
show render safe  49
show title safe  49
undo/redo  15

View Icons  15

View Panels  15
new  446

Viewport
color  52
settings  29

Virtual rotation circle  300

Visibility
of object  477
of particles  237
of points/polygons  324

Visible Light  195, 212
dithering  215
dust  215
preventing contouring  215
show option  188

Volume Caustics  211, 422

Volume Shader  531

Volumetric Lighting  195, 214

VRML  76, 80, 647

W
Water

rendering  403

Waveform
of sound in browser  68

Wavefront  648

Web Browser
and the URL object tag  473
MAXON online  453

Weld
option for mirror  179
points  343

Wind
applied to particles  244
in explosions  263

Wind Object  281

Window
arranging  32
change size  10
re-sizing  31

Window Menu  445
Browser  448
Coordinates Manager  447

Windows
docking/undocking  10, 33

Wireframe  23

Wood  536

Workflow  59
World

coordinate system  295

World Grid  379
cf construction plane  180
dynamic grid option  379

Wrap Object  283
longitude and latitude  284

X
X-ray mode

activating  16

XML  76

Z
Zoom. See Magnify

in Picture manager  638
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